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1. Установка и первые шаги 
 

1.1. Установочный файл и файл лицензии REAPER 
 
Установочный файл REAPER можно скачать со страницы http://www.cockos.com/reaper/download.php. Перед 
загрузкой обратите внимание на операционную систему и разрядность версии скачиваемого файла согласно 
конфигурации вашего компьютера. Пробная версия программы работает в полнофункциональном режиме в 
течении 60 дней. Приобрести лицензию REAPER можно на странице http://www.cockos.com/reaper/purchase.php.
  

1.2. Установка REAPER на OS X Mac 
 
1. Дважды щелкните по dmg файлу REAPER. 
2. Если Вы принимаете условия соглашения, нажмите Agree. 
3. Перетащите ярлык REAPER в папку Applications. 
4. Если Вы хотите установить функцию ReaMote, перетащите этот ярлык также в папку Applications, хотя это 
можно сделать в любое другое время. 
 
Чтобы прикрепить ярлык REAPER на панель Docker, просто перетащите его с папки Applications на панель. 
Настоятельно рекомендуется на странице параметров System Preferences установить правую кнопку мыши в 
качестве вторичной кнопки. 
 

1.3. Установка REAPER на PC Windows 
 
1. Через проводник найдите установочный файл, имя которого включает и номер текущей версии, например, 
reaper5.60-install.exe и запустите его двойным щелчком. 
2. Нажмите кнопку I Agree, чтобы принять условия соглашения и продолжить процесс установки. 
4. В контексте типичной установки, оставьте директорию REAPER по умолчанию (см. также Примечание ниже) - 
например, C:\Program Files\REAPER. 
5. Если необходимо установить портативную версию, отметьте опцию Portable install (см. также Примечание 
ниже) и нажмите кнопку Next. 
6. Выберите элементы для установки. Если вы не уверены в выборе элементов оставьте список как есть (см. 
также Параграф 1.4 ниже), и нажмите Install. 
7. При поступлении соответствующего запроса, нажмите кнопку Close, чтобы закрыть программу установки. При 
поступлении запроса на запуск программы на данном этапе выберите No. 
 

Примечание: если вы устанавливаете REAPER впервые, или хотите заменить более раннюю версию 
REAPER устанавливаемой версией, оставьте директорию REAPER по умолчанию и не отмечайте опцию 
Portable install. Если вы хотите установить данную версию наряду с текущей версией, выберите другую 

директорию и отметьте опцию Portable install. Это гарантирует, что параметры текущей версии будут 
сохранены отдельно от устанавливаемой. 
 

Совет: если вы на данном этапе не хотите устанавливать какие-либо элементы или опции REAPER, их 
можно установить позже в любое время, повторно запустив мастер установки.  
 

 
1.4. Элементы (опции) установки (только для пользователей Windows) 

 
В процессе установки REAPER можно выбрать определенные элементы. Большинство из них по умолчанию 
отмечены. 
 
Required files: необходимые программные файлы REAPER. У вас просто нет выбора, кроме как установить их. 
Optional Functionality:  
JSFX library - всесторонний набор аудиоэффектов (хорусы, фильтры, лимитеры, и т.д.) и MIDI эффектов 
(секвенсоры, арпеджиаторы, хордайзеры и т.д.), которые могут использоваться с треками и клипами. 
Рекомендуется их установить. 
VST/x64 VST bridging/firewalling - эти опции обеспечивают дополнительную функциональность VST плагинов. 
Например, использовать 32-битные плагины в 64-битной версии REAPER. Если сомневаетесь, лучше 
установите их. 
ReaMote, ReWire, ReaRoute - эти опции обеспечивают различные функции расширенной маршрутизации 
REAPER, например, управление передачей аудио/MIDI материала между REAPER и другими приложениями. 
Соответствующие плагины можно установить в любое время. 
Desktop Icon: если эта опция отмечена ярлык REAPER будет помещен на Рабочий стол 
Start Menu Shortcuts: если эта опция отмечена ярлык REAPER будет добавлен в меню Пуск. 
Associate with RPP Files: если эта опция отмечена любой файл проекта REAPER можно открыть из проводника 
или щелчком по ярлыку проекта на Рабочем столе. 
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1.5. Запись в формате mp3 
 
Если вы намереваетесь записывать и/или объединять в один аудиофайл (mixdown) ваши записи или 
конвертировать другой записанный материал в формат MP3, необходимо установить MP3 кодек. 
Рекомендуемый бесплатный кодек - LAME, который включен в инсталляционный пакет.  

 
Примите во внимание: если вы используете 32-х битную версию REAPER даже на 64-х битном 
компьютере, необходимо загрузить 32-х битный кодек, а не 64-х битный.  
 

Пользователям Mac: после загрузки файла необходимо распаковать файл и перетащить файл динамической 
библиотеки (примерно именованный libmp3lame.dylib) в папку с установленной программой.  
Пользователям Windows: файл необходимо скопировать в папку с установленной программой REAPER по 
умолчанию, например, C:\Program Files \REAPER. Данный кодек можно скопировать в другие приложения, 
которые в нем нуждаются (например, Audacity). 
 

1.6. Обновление REAPER 
 
REAPER обновляется регулярно и часто с исправлениями, новыми функциями и другими улучшениями. 
Проверить текущую на данный момент версию можно в любое время на сайте http://www.reaper.fm. При этом 
необязательно предварительно деинсталлировать предыдущую версию. В процессе обновления текущие 
настройки и параметры будут перенесены в новую версию автоматически. 
 

Совет: опция Automatically check for new versions of REAPER on Startup на странице Options > 
Preferences > General > Startup Settings отмечена по умолчанию и позволяет автоматически проверять 
обновления при каждом запуске программы (при условии активного интернет-соединения).  

 
1.7. Запуск REAPER 

 
Чтобы запустить REAPER, просто дважды щелкните по ярлыку REAPER на Рабочем столе. Для запуска 
REAPER можно назначить горячую клавишу. Для пользователей Windows это делается в области Быстрый 
вызов на вкладке Ярлык диалогового окна Свойства ярлыка, доступ к которому осуществляется щелчком 
правой кнопкой мыши по ярлыку REAPER. 
 

1.8. Советы по запуску REAPER 
 
По умолчанию, REAPER открывается с последним 
используемым проектом (опция Last active project в 
меню Open Project(s) on Startup в секции Startup 
Settings на странице Options > Preferences > General). 
Это поведение можно изменить. Доступные опции: 
 
Last project tabs: открыть последнюю вкладку проекта 

New project (ignore default template): открыть новый проект (игнорируя шаблон проекта по умолчанию) 
New project: открыть новый проект 
Prompt: выбор пользователя 
 
Кроме того, при запуске REAPER можно использовать горячие клавиши для игнорирования параметров запуска 
по умолчанию: 
 
Чтобы открыть пустой проект REAPER: запустите программу с клавишей Shift 
Чтобы открыть REAPER, не загружая шаблон проекта по умолчанию: запустите программу с горячей 
клавишей Ctrl+Shift 
 

1.9. Выбор фрагментов в Reaper, контроллеры и команды 
 
Работа в REAPER обуславливает выделение фрагментов и применение к ним различных команд. Например, 
чтобы скопировать фрагмент, его необходимо выбрать (обычно щелкнув по нему мышью) и применить команду 
копирования (Copy). В других случаях, вы будете использовать команды, затрагивающие проект целиком, не 
выбирая отдельные фрагменты. В целом, есть четыре основных способа доступа к командам REAPER: 
 
Главные меню: как и в большинстве других приложений, запуск команд (опций) в этих меню осуществляется 
щелчком левой кнопкой мыши или нажатием соответствующих горячих клавиш. 
Контекстные меню: открываются щелчком правой кнопкой мыши по клипу или по определенной области 
экрана. 
Кнопки панелей инструментов: щелчок по любой кнопке на панели инструментов запускает соответствующую 
команду. 
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Горячие клавиши: большинство команд и действий имеют свои горячие клавиши, которые можно изменить в 
любое время на ваши собственные. Подробнее об этом в Главе 15. В некоторых случаях, для платформ PC и 
Mac используются разные клавиши-модификаторы. В данном руководстве пользователя примеры применения 
горячих клавиш основаны на платформе PC Windows. Пользователям Mac необходимо это учесть и обратить 
внимание на сводный список сходств и различий ниже: 
 
Клавиши-модификаторы PC (Windows)                          Эквивалент Клавиш-модификаторов Mac (OS X) 
Shift                                                                                             Shift 
Control                                                                                         Command 
Alt                                                                                                Option 
Windows                                                                                      Control 
 

1.10. Главное окно программы 
 
В REAPER можно выбрать тему оформления. Скриншоты, используемые в данном руководстве в основном 
сделаны на основе темы по умолчанию REAPER 4. При использовании других тем, могут наблюдаться 
некоторые визуальные различия. В данном руководстве пользователя в некоторых случаях в тему по 
умолчанию были внесены некоторые изменения для увеличения четкости при печати градации серого цвета. 
После запуска REAPER открывается в главном окне, схожем с тем, что вы видите на рисунке ниже (но не 
обязательно идентичном), в котором отображен очень простой открытый проект.  
 

 
 
Давайте вкратце рассмотрим основные элементы главного окна: 
 
Строка меню (Menu Bar): включает главные меню - File, Edit, View, Insert, Item, Track и т.д. Как и в других 
приложениях эти меню используются для выбора команд (опций). 
Главная панель инструментов (Main Toolbar) REAPER: расположена ниже строки меню и по умолчанию 
состоит из двух рядов по семь кнопок на каждом. В зависимости от темы оформления REAPER кнопки могут 
выглядеть по разному.  

 
Как и в других приложениях, при наведении курсора мыши на любую кнопку всплывает 
подсказка.  
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По мере необходимости и появления по ходу руководства эти кнопки будут обсуждаться более подробно  
и суммируются в конце Главы 5. В Главе 15 объясняется, как можно настроить вашу собственную панель 
инструментов. 
Шкала времени (Timeline): расположена справа от главной панели инструментов и под строкой меню  
и отображает продолжительность вашего проекта, а также помогает идентифицировать позицию различных 
клипов. На рисунке выше формат шкалы времени измеряется в «тактах.долях/минутах.секундах» 
(Measures.Beats/Minutes.Seconds). 
Область аранжировки (Arrange Area): расположена справа от панели треков, где располагаются фактические 
клипы (Media Item) (аудио и/или MIDI), из которых состоят ваши треки. На рисунке выше отображено два трека 
по одному клипу на каждом.  
Панели треков (Track Control Panel): включают контроллеры аудио и MIDI треков - в данном примере 
отображено два трека - Vocals и Guitar. Количество треков ограничивается только аппаратными ресурсами.  
У каждого трека свой собственный набор контроллеров (фейдеры, регуляторы и кнопки). В Главе 2 и Главе 4 мы 
рассмотрим функциональность и применение этих контроллеров. Для каждого из контроллеров также доступны 
всплывающие подсказки. 
Индикаторы уровня (VU Meters): у каждого трека, включая мастер-трек есть индикаторы уровня, которые 
используются в качестве визуального мониторинга громкости трека. Они расположены как на панели трека, так 
и на панели микшера. 
Транспортная панель (Transport Bar): используется для управления записью и воспроизведением - например, 
чтобы начать и остановить запись. Транспортная панель будет подробно обсуждаться в Главе 2. 
Панель микшера (Mixer Control Panel): в данном примере расположена в нижней части главного окна 
REAPER. Треки в микшере отображены по-другому (в виде канальных модулей). В данном примере отображены 
те же самые треки, что и на панели треков. Заметьте, что здесь присутствует и канальный модуль мастер-трека 
(Master). Выходной сигнал мастер-трека - это то, что вы фактически слышите при воспроизведении треков и 
клипов. Микшер и мастер-трек подробно объясняются в Главе 11. 
 

1.11. Трек и его контроллеры 
 
На рисунке ниже изображены наиболее часто используемые контроллеры трека.  
 

 
 
1 - кнопка активирования записи (record arm) 
2 – имя трека 
3 – регулятор громкости (контроллер Volume) 
4 – контроллеры управления маршрутизацией сигнала 
5 – регулятор панорамирования (контроллер Pan) 
6 – кнопка мьютирования трека (Mute) 
7 – кнопка солирования трека (Solo) 
8 – кнопка управления эффектами трека (FX) 
9 – номер трека 
10 – индикаторы уровня 
11 – кнопка изменения фазировки (Phase) 
12 – контроллеры огибающих/автоматизации 
13 – контроллеры управления записью 
14 – кнопка активирования мониторинга входного сигнала 
15 – эффекты, применяемые ко входному сигналу (In FX) 
16 – кнопка выбора источника входного сигнала 
 
Точное расположение некоторых из этих контроллеров будет зависеть от размеров панели трека. При 
наведении курсора мыши на любой контроллер также всплывает подсказка. В большинстве случаев чтобы 
применить контроллер нужно просто его затронуть (например, нажать кнопку Mute чтобы мьютировать любой 
трек, или повернуть контроллер Volume, чтобы отрегулировать уровень громкости). Щелчок правой кнопкой 
мыши по контроллеру открывает соответствующее контекстное меню с командами, опциями и/или параметрами.  
В зависимости от компоновки треков громкостью управляет либо регулятор (как показано на рисунке выше), 
либо горизонтальный фейдер.  
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Кроме того, при определенных настройках рядом с контроллером Pan может 
располагаться регулятор Width (ширина стереополя).  
 
 

Эти контроллеры будут подробно объяснены по ходу данного руководства. 
 

1.12. Конфигурация аудиопараметров 
 
Прежде, чем что-либо записать или воспроизвести в REAPER, необходимо сконфигурировать аудиопараметры - 
выбрать аудиоустройство и определить способ его применения. В конфигурации аудиопараметров на 
платформах Mac и Windows есть определенные различия. Кроме того, желательно отключить системные 
звуки. Для пользователей OS X это делается в диалоговом окне System Preferences. Пользователям Windows 
необходимо перейти Панель Управления > Звук > Звуки > Звуковая схема > Без звука. 
 
1.12.1. Конфигурация аудиопараметров на платформе PC Windows 
 
На платформе PC Windows конфигурация параметров вашего аудиоустройства выполняется на странице 
Options > Preferences > Audio > Device. Если вы планируете использовать встроенную звуковую карту 
компьютера, необходимо ознакомиться с ее программным обеспечением. Это особенно важно для 
предотвращения смешивания предварительно записанного материала с новым записанным материалом при 
добавлении треков. Полезно рассмотреть использование бесплатных драйверов ASIO4ALL. Дополнительную 
информацию можно подчерпнуть на странице en.wikipedia.org/wiki/Audio_Stream_Input/Output. А теперь 
рассмотрим опции страницы Options > Preferences > Audio > Device более подробно: 
 

 
 
Меню Audio system: остальные элементы секции Audio device settings будут меняться в зависимости от 
выбранного в этом меню аудиодрайвера. Настоятельно рекомендуется использовать ASIO драйверы, если они 
поддерживаются вашей звуковой картой или Firewire (USB) устройством. Если в меню Audio System вы 
выбрали ASIO драйвер, в меню ASIO Driver ниже выберите конкретный драйвер вашего устройства. 
Опция Enable inputs: если вы хотите использовать REAPER для записи эта опция должна быть отмечена. 
Меню Input range: если ваше устройство поддерживает несколько входных портов (до 512), назначьте первый 
(first) и последний (last) из них. В данном примере доступны два входных порта, обеспечивая подключение до 
двух микрофонов или инструментов (в любой комбинации) для одновременного их использования при записи. 
Меню Output range: если ваше устройство поддерживает несколько выходных портов (до 512), также назначьте 
первый (first) и последний (last) из них. Как правило, выходной сигнал мастер-канала направляется на одну 
пару выходных портов, но вы можете использовать и другие пары. 
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Опции Request sample rate/Request block size: частоту дискретизации и размер аудиобуфера вы можете 
установить либо здесь, либо в настройках вашей аудиокарты. Если вы не уверены в выборе, начните со 
значений 44100 и 512 соответственно. 
Кнопка ASIO Configuration: щелчок по этой кнопке обеспечивает прямой доступ к параметрам вашей звуковой 
карты или другого выбранного аудиоустройства. 
Опция Pre-zero output buffers, useful on some hardware (higher CPU use): эта опция обнуляет буферы 
выходного сигнала перед его рендерингом. В некоторых случаях это помогает уменьшить "заикание" звука на 
некоторых аппаратных устройствах. 
Опция Ignore AS 10 reset messages (needed for some buggy drivers): Эта опция может понадобиться для 
некоторых "глючных" ASIO драйверов для их надлежащего функционирования. 
Меню Audio thread priority: приоритет процесса обработки аудио перед другими процессами (например, 
обработки графики). 
Опция Allow projects to override device sample rate: если эта опция отмечена, аудиоустройство будет 
использовать частоту дискретизации проекта (которая выбирается в диалоговом окне свойств проекта). 
 
1.12.2. Конфигурация аудиопараметров (Mac OS X) 
 
Аудиоустройства на Mac OS X выбираются и конфигурируются в диалоговом окне Audio MIDI Setup. Но сначала 
убедитесь, что вы загрузили и установили последние обновления на Mac, а также проверьте конфигурацию 
аудиопараметров в REAPER. Чтобы сконфигурировать ваше аудиоустройство, выберите его из списка на 
странице Options > Preferences > Audio > Device в колонке слева. На рисунке ниже установлено USB 
устройство Focusrite Saffire Pro 40.  
 

 
 
Аудиокарта Saffire была выбрана в виду использования ее как входных, так и выходных портов. Вы можете (как 
показано на рисунке выше), установить частоту дискретизации (Request Sample Rate) и размер аудиобуфера 
(Request Block Size), которые помогают скорректировать время ожидания (задержку) здесь или открыть панель 
управления устройства и установить эти параметры там. Если вы не уверены в выборе, начните со значений 
44100 и 512 соответственно. Если вы намереваетесь использовать встроенную звуковую карту Mac компьютера, 
вам, возможно, придется предпринять некоторые шаги для предотвращения смешивания текущего материала с 
повторно записанным на дополнительных треках, добавленных позже. Для этого необходимо совокупное 

устройство. Чтобы создать такое устройство, откройте OS X Audio MIDI Setup и щелкните по символу  в 
нижнем левом углу окна. Добавьте к этому совокупному устройству входной и выходной каналы встроенной 
карты как показано на рисунке ниже.  
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Если вы хотите их переименовать, дважды щелкните по области Aggregate Device. Затем, на странице Options 
> Preferences > Audio > Device в REAPER, выберите ваше совокупное устройство и нажмите кнопку Apply. 
  

 
 
После этого вы можете использовать наушники, подключенные к выходному аудиоразъему компьютера и 
микрофон, подключенный к входному аудиоразъему компьютера. 
 

1.13. Функция Input Aliasing - переименование (назначение псевдонимов) входных портов 
 
REAPER поддерживает функцию Input Aliasing - способность переименовывать (назначать псевдонимы) 
входные порты вашей аудиокарты. Эта функция может использоваться для сокращения длинных имен, которые 
система зачастую сама дает портам, особенно когда ваше устройство поддерживает мультиканальную систему. 
Примером использования этой функции может служить переименование портов Analog In 1 Delta 1010 (1), 
Analog In 2 Delta 1010 (1) на Mic/Line 1, Mic/Line 2. Доступ к функции Input Aliasing можно получить через 
опцию Input Channel Name Aliasing/Remapping в диалоговом окне Options > Preferences > Audio.  
 

 
 

1.14. Функция Output Aliasing –  
переименование (назначение псевдонимов) выходных портов 

 
REAPER также поддерживает функцию Output Aliasing - переименование (назначение псевдонимов) выходных 
портов вашей аудиокарты. Это особенно эффективно, если ваша звуковая карта или другое аудиоустройство 
поддерживает мультиканальную систему. Например, одна пара выходных портов может быть связана с 
мониторами в аппаратной, другая с мониторами в студии, а третья пара с мультиканальным хабом наушников.  
По умолчанию, ваши выходные порты именованы приблизительно так, как на рисунке ниже.  
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Ясно, что эти имена не очень эффективны. Переименовав выходные порты, можно гарантировать, что всякий 
раз, когда появится необходимость их перечислить (например, при назначении выходных портов с мастер- 
канала) будут отображаться данные вами имена вместо имен, данных системой. 
 
Пример: 
 

1. Перейдите Options > Preferences > Audio > 
Channel Naming/Mapping и отметьте опцию 
Output Channel Name Aliasing. 
2. Нажмите кнопку Edit Names/Map 
редактируемого элемента. 
4. Дважды щелкните по колонке Aliased Names 
каждого элемента, который вы хотите 
переименовать. В каждом случае, после 
переименования нажмите кнопку OK, чтобы 
возвратиться к окну Output Channel 
Alias/Mapping. 
5. Нажмите кнопку OK, чтобы закрыть диалоговое 
окно и возвратиться к диалоговому окну 
Preferences. 
6. Нажмите кнопку OK, чтобы закрыть диалоговое 
окно Preferences. 

 
После этого ваши имена будут автоматически использоваться в REAPER. Тема фактического назначения 
выходных портов треков будет затронута начиная с Главы 2. 
 

1.15. Конфигурация MIDI параметров 
 
Если вы намереваетесь использовать спецификацию MIDI, необходимо сконфигурировать доступные MIDI 
устройства. Большинство PCI звуковых карт, Firewire и USB аудиоустройств имеют входной и выходной MIDI 
порт (для использования, например, с MIDI клавиатурой). Перейдите Options > Preferences > Audio > MIDI 
Devices.  
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Чтобы активировать MIDI устройство, щелкните правой кнопкой 
мыши по его названию, и в контекстном меню отметьте опцию Enable 
Input/Output.  
Чтобы отобразить параметры конфигурации MIDI устройства, 
дважды щелкните по названию устройства или в контекстном меню 
выберите опцию Configure MIDI Input.  
 
 

 
Параметры окна Configure MIDI Input включают функцию 
переименования (т.е. назначения псевдонимов) 
устройства (Alias Name) и дополнительные опции 
синхронизации (при необходимости) в секции Advanced 
MIDI Event timestamp options. Если вы хотите 
использовать устройство в качестве входного MIDI 
устройства, отметьте опцию Enable input from this 
device. Если кроме этого вы хотите использовать это 
устройство в качестве MIDI контроллера отметьте опцию 
Enable input for control messages. См также Главу 15.  
 
 
 
 
 
 
 
 
 
 
 
 

Если у вас есть джойстик, который вы хотите 
использовать с REAPER, нажмите кнопку Add 
joystick MIDI, а затем выберите само 
устройство (меню Device) и сценарий обработки 
(меню Processing script). Здесь же можно 
определить, как вы хотите использовать 
джойстик - в качестве виртуальной MIDI 
клавиатуры (Send to Virtual Midi Keyboard 
input) и/или в качестве MIDI контроллера (Send 
as MIDI control/leam).  
 
 
 
 
 
 
 
 

 
Если вы хотите использовать с REAPER внешний аппаратный контроллер, например, Behringer BCF2000 или 
BCR2000, в диалоговом окне Configure MIDI Input устройства оставьте отмеченной только опцию Enable input 
for control message. Использование внешних устройств управления будет объяснено в Главе 11 и Главе 13. 
 
1.15.1. Опции сброса (Reset options)  
 
Внизу диалогового окна Options > Preferences > MIDI Devices доступны опции сброса: Reset by (all-notes-off 
and/or pitch/sustain, и Reset on (play and/or stop/stopped seek), которые затрагивают только внешние аппаратные 
устройства. 
 

 
 
Нажатие кнопки Reset all MIDI devices закрывает и повторно открывает все MIDI устройства и ресканирует 
новые доступные устройства. 
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1.15.2. Другие опции диалогового окна Options > Preferences > Audio 
 
Есть и другие страницы конфигурации аудиопараметров, которые мы еще не затрагивали: Options > 
Preferences > Audio > Buffering/Playback/Recording. С ними мы познакомимся позже, в частности в Главе 22. 
На данном этапе оставьте параметры этих страниц как есть.  
 
По завершению настроек, нажмите кнопку OK чтобы закрыть окно Preferences.  
 
В данной главе мы рассмотрели общие вопросы конфигурации вашей системы для работы с MIDI. Подробнее 
специфические параметры и опции проекта мы рассмотрим в Главе 2. В частности, если вы работаете прежде 
всего с MIDI материалом, можно изменить параметр timebase (представление времени) проекта по умолчанию. 
Это также объясняется в Главе 2. 
 

1.16. Использование VST плагинов 
 
Перед началом работы с REAPER полезно посетить еще одну страницу – Options > Preferences > Plug-ins > 
VST. Как и в случае со страницей Audio, страница Plug-ins включает несколько дополнительных страниц, но на 
данном этапе мы рассмотрим только те параметры, которые связаны с VST/VSTi плагинами.  

 
Примите во внимание: VST3 плагины должны находиться в отдельной папке от других плагинов.  
 

 

 
 
Кнопка Auto-detect позволяет программа попытаться самой определить папку с плагинами, но, если плагины у 
вас разбросаны по разным папкам, REAPER может их и не найти. В этом случае, нажмите кнопку Add и 
определите папки с плагинами вручную. Остальные параметры на данный момент оставьте как есть. На 
платформе OS X используется две “встроенные” папки для установки плагинов - ~/Library/Audio/Plug-Ins и 
~/Users/<your account>/Library/Audio/Plug-Ins. По умолчанию REAPER сканирует именно эти папки. Однако, 
примите во внимание, что эти папки автоматически определяются как путь к вашим VST плагинам. Если на 
вашем компьютере это не так, определите путь вручную. На платформе Windows каждую папку с плагинами 
необходимо определить вручную через кнопку Add. После выбора папок с плагинами нажмите кнопку Re-scan. 
REAPER также автоматически сканирует папки с VST плагинами при каждом запуске. Подробнее о VST 
плагинах в Главе 22. 
 

Важная заметка по VST и VST3 плагинам: REAPER сканирует ваши директории VST плагинов 
согласно вашему списку, слева направо. Если программа находит два или более плагина с идентичными 
именами, она выберет последний найденный. Если VST3 плагин именован даже совмем немного по-

другому в отличие от его VST эквивалента, будут установлены обе версии, и обе версии будут доступны в 
REAPER. Однако, если оба типа именованы идентично, будет установлен только последний найденный. 
Поэтому может иметь смысл поместить вашу директорию с VST3 плагинами последней в списке (как на рисунке 
выше). 
 

1.17. Местоположение папок и файлов REAPER 
 
Местоположения, куда устанавливаются различные ресурсы REAPER, будут зависеть от системной платформы 
и даже от версии системы. Например, Windows 7 ведет себя по-другому в отличии от XP. Чтобы найти 
местоположение ресурсов, перейдите выберите Options > Show REAPER resource path in explorer/finder.  
К некоторым из этих файлов мы обратимся в других параграфах Руководства пользователя.  
 
Реестр (только для Windows):  
 

Примечание для пользователей Windows: REAPER НЕ хранит установочные данные или 
предварительные параметры в Реестре Windows.  
 

Windows устанавливает элемент REAPER в ветке реестра HKEY_ LOCAL_MACHINE Software, но этот элемент 
не содержит никаких данных кроме журнала ведения учета перемещений файлов в таких областях реестра, как 
MUICache и информации о создании файловых ассоциаций, чтобы можно было открыть RPP файлы (например, 
в проводнике Windows) двойным щелчком по их ярлыкам. 
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Директория REAPER - OS X: на OS X REAPER устанавливается в папку Applications. Скопируйте любые PDF 
файлы (например, это руководство пользователя), к которым вы хотите получить доступ из меню Help в папку: 
<имя пользователя> /Library/Application Support/REAPER. В некоторых версиях (например, Lion) вам, 
возможно, придется нажать клавишу Options, при отображении меню Go, чтобы сделать этот путь доступным. 
Директория REAPER - Windows: по умолчанию, на Windows REAPER устанавливается в папку C:\Program 
Files\REAPER. Скопируйте в эту директорию любые PDF файлы (например, это руководство пользователя), к 
которым вы хотите получить доступ из меню Help.  
Некоторые дополнительные элементы установки сохраняются в подпапках директории C:\Program 
Files\REAPER. Это VST плагины COCKOS ReaPlug и (если установлены) SWS расширения. Все что 
сохраняется в директории REAPER доступно для всех пользователей REAPER на этом компьютере. 
Большинство функций REAPER (например, файлы конфигурации и собственные параметры) сохраняются в 
папке AppData (Applications Data). Местоположение этой папки будет зависеть от используемой версии 
Windows. 
Директория Application Data/Support Data: чтобы получить доступ к папке REAPER в папке AppData или 
Application Support, перейдите Options > Show REAPER resource path in explorer/ finder. 
Подпапки (Subfolders): большинство из них расположены в директории REAPER. Это такие подпапки, как Color 
Themes, Configurations, Cursors, Data, Effects, FXChains, KeyMaps, MenuSets, Presets, Project Bays, 
ProjectTemplates, QueuedRenders, Scripts, TrackTemplates. Многие из них очевидны, особенно те, которые 
содержат различные файлы и клипы, создаваемые вами. Например, созданные вами цепочки эффектов будут 
храниться в подпапке FXChains. Данные пользовательских меню и панелей инструментов хранятся в подпапке 
MenuSets, и так далее. Содержимое папки Data включает символы трека и символы панели инструментов. В 
папке Effects хранятся JS эффекты. 
Файл preset-vst-plugname.ini: для каждого VST плагина используется отдельный такой файл для хранения 
любых созданных или импортированных им пресетов. 
Файл REAPER.ini: включает все опции, предварительные настройки, информацию о последнем расположении 
диалоговых окон, и историю последних используемых проектов. 
Файлы reaper-dxplug-ins.ini и reaper-vstplug-ins.ini: эти файлы хранят информацию об установленных 
плагинах. 
Файлы reaper-reginfo.dat и reaper-reginfo.ini: эти файлы хранят регистрационные данные продукта 
Файл reaper-recentfx.ini: этот файл хранит список последних используемых эффектов, на основании которого 
формируется подменю Recently Used FX в микшере. 
Файл screensets.ini: этот файл хранит детали отображения диалоговых окон. Примите во внимание, что 
параметры отображения диалоговых окон трека сохраняются с соответствующим проектом (RPP файл). 
Назначение пути по умолчанию для сохранения новых проектов, записей и файлов рендеринга: страница 
Options > Preferences > General > Paths может использоваться для назначения пути по умолчанию для 
сохранения новых проектов и записанных клипов. Однако помните, что любой путь, назначенный в диалоговом 
окне параметров проекта (Project Settings), будет иметь приоритет над этими путями. Здесь же можно 
определить путь по умолчанию для peak файлов сигналограмм и файлов рендеринга проекта. 
 

 
 
Есть еще одно, что может вас заинтересовать. Все предварительные настройки, параметры и пользовательские 
файлы имеют текстовый формат. Любой из них можно открыть и изменить в текстовом редакторе, например, в 
Блокноте. Это же относится и к файлам проекта REAPER с расширением RPP. Но не пытайтесь открыть в 
текстовом редакторе файлы с расширением app, dmg, exe или dll. 
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1.18. Локализация и языковые пакеты 
 

При выборе языкового пакета, 
REAPER будет использовать 
этот язык для всех меню, 
диалоговых окон, всплывающих 
подсказок, и так далее. Язык по 
умолчанию - американский 

английский язык (U.S. English). Доступ к языковым пакетам можно получить в меню Options > Preferences > 
General > Language. 
Чтобы отобразить и загрузить доступные языковые пакеты нажмите на ссылку Download language packs. На 
языковом веб ресурсе обратите внимание на ссылку REAPER Stash. После загрузки, закройте окно Preferences 
и перейдите Options > Show REAPER resource path in Explorer/Finder. Затем, перетащите загруженный файл 
в папку LangPack. После этого загруженный языковой пакет будет доступен в меню Language. Чтобы 
изменения вступили в силу, необходимо перезапустить REAPER. 
 

1.19. Резервная копия пользовательских настроек 
 
В любое время можно создать резервную копию ваших предварительных настроек и параметров REAPER. Это 
может пригодиться, например, при случайных сбоях системы и зависаниях программы и в случае если вы 
захотите поделиться своими настройками с другими пользователями. Процедура создания резервной копии 
объясняется в Главе 22 в параграфе «Кнопки Import Configuration и Export Configuration». Не забудьте сохранить 
копию резервного файла ReaperConfig.zip на внешний носитель. 
 

1.20. Запуск REAPER с флэшки 
 
REAPER можно установить на флэш-карту или любой другой внешний носитель. Прежде, чем установить 
REAPER на флэш-карту, имеет смысл сначала установить программу на жесткий диск. После этого при 
переносе REAPER на внешнее устройство все ваши параметры, предварительные настройки и т.д. будут 
сохранены. Способ установки отличается для пользователей OS X и Windows. 
 
OS X 
 
1. Вставьте флэш-карту в порт USB. Создайте новую папку на флэш-карте, например, REAPER5. В этой папке 
создайте пустой текстовый файл с названием reaper.ini 
2. Откройте папку с образом REAPER - dmg файл. 
3. Дважды щелкните по этому файлу, чтобы открыть его. Перетащите символ REAPER в новую папку на флэш-
карте. 
 
Windows 
 
1. Вставьте внешнее устройство в доступный USB порт. 
2. Дважды щелкните по установочному файлу REAPER, чтобы запустить процесс установки. 
3. Нажмите кнопку I Agree, чтобы принять лицензионное соглашение. 
4. В диалоговом окне Choose Install Location отметьте опцию Portable install. 
5. Нажмите кнопку Browse. Выберите вашу флэш-карту и нажмите кнопку Make New Folder. Дайте имя папке 
(например, REAPER5) и нажмите кнопку Enter. 
 

1.21. Программные опции REAPER в меню Пуск (только на Windows) 
 
Обычно, чтобы запустить REAPER достаточно просто дважды щелкнуть по ярлыку программы на рабочем столе 
Windows. В этом случае REAPER запустится в соответствии с текущими предварительными настройками и 
параметрами. Тем не менее нелишним будет помнить и о других опциях, доступных в меню Пуск. Перейдите 
Пуск > Все Программы > REAPER: 
 
Install REAPER to USB key: эта опция может использоваться для установки REAPER на флэш-карту или другое 
внешнее устройство. Однако, метод, описанный выше более прост! 
ReaMote Slave: использование опции ReaMote выходит за рамки данного руководства пользователя. Кратко об 
этой функции в Главе 24. 
REAPER: запускает REAPER с последним проектом. 
REAPER (create new project): запускает REAPER с новым пустым проектом. 
REAPER (reset configuration to factory defaults): запускает REAPER и сбрасывает все параметры, опции и 
предварительные настройки в их фабричные значения по умолчанию. 
REAPER (ReWire slave mode): открывает REAPER в качестве подчиненного ReWire приложения. 
Использование этой функции выходит за рамки данного руководства пользователя. Кратко об этой функции в 
Главе 17. 
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REAPER (show audio configuration on startup): запускает REAPER на странице Options > Preferences > Audio. 
REAPER License: отображает информацию о лицензии. 
Uninstall REAPER: деинсталлирует REAPER. 
Whatsnew.txt: открывает текстовый файл с историей нововведений и изменений каждой версии REAPER. 
 

1.22. Типы файлов REAPER 
 
Как и любая другая программа, REAPER создает собственные файлы. Некоторые из основных типов файлов и 
их предназначение описываются ниже, наряду с другой полезной информацией. 
 
RPP: файл проекта REAPER 
Alone.RPP: этот файл - ядро вашего проекта. Он включает всю информацию о треках, клипах с их параметрами. 
RPP файлы имеют текстовый формат. 
RPP-bak: резервный файл проекта 
Alone. RPP-bak: при сохранении проекта, предыдущая версия проекта сохраняется с расширение RPP-bak. 
Открыв резервный файл можно возвратить проект с его предыдущего состояния. 
RPP-UNDO: файл истории отмен (Undo history) 
Alone. RPP-UNDO: этот файл создается в том случае, если вы выбираете опцию сохранения истории отмен с 
файлом проекта в секции Options > Preferences > General > Undo Settings и более подробно объясняется в 
Главе 2. 
reapeaks: peak файлы REAPER 
Vox.wav.reapeaks: эти файлы включают информацию, необходимую для прорисовки сигналограмм в REAPER в 
клипах. 
reapindex: peak файл REAPER 
Vox.wav.reapindex: эти файлы включают информацию об индексах отдельных клипов. 
 

1.23. Информация о пользовательской лицензии 
 
По умолчанию заголовок окна REAPER отображает информацию о лицензии, в частности имя 
зарегистрированного пользователя. Доступны опции управления этой информацией на вкладке Purchase окна, 
которое открывается при выборе команды Help > License and user agreement. Окно Reaper можно установить в 
полноэкранный режим (без отображении информации о лицензии) - эта функция активируется/отключается на 
Windows клавишей F11, на OS/X клавишей Cmd+F11. 
 

1.24. Щелчки и обратные отчеты 
 
Прежде, чем вы начнете работать с REAPER, следует принять во внимание некоторые моменты, связанные с 
типичной проблемой нежелательных щелчков и выпадений отчетов (щелчков наоборот), которые могут быть 
слышны при воспроизведении в REAPER. Это компьютерная проблема, а не проблема REAPER, и больше 
вероятности, что она возможна на платформе PC нежели на Mac. Если вы столкнулись с этой проблемой при 
воспроизведении в REAPER, то, наиболее вероятно, что конфигурация аудиопараметров для вашего 
компьютера выполнена не корректно. Попробуйте настроить размер аудиобуфера, начав со значения 128 и 
поднимая выше: 256, 512, 768 или 1024 и найдите самое низкое значение, при котором воспроизведение не 
будет сопровождаться щелчками и обратными отчетами. Подробнее об этом в Параграфе 22.4. 
 

1.25. Деинсталляция REAPER 
 
Чтобы установить новую версию REAPER предыдущую версию деинсталлировать необязательно. Текущие 
параметры будут обновлены автоматически. Тем не менее, если по какой-то причине вы хотите 
деинсталлировать REAPER, пользователям OS X достаточно просто перетащить ярлык REAPER в корзину и 
удалить папку ~/Library/Application Support/REAPER. Пользователи Windows должны следовать за этой 
процедурой: 
 
1. Перейдите Пуск > Все Программы > REAPER и выберите опцию Uninstall REAPER. 
2. В диалоговом окне REAPER Uninstall Wizard нажмите кнопку Uninstall. 
3. По окончании процесса деинсталляции нажмите кнопку Close. 
4. При поступлении соответствующего запроса если вы хотите увидеть какие файлы остались на жестком диске 
нажмите кнопку Yes, в противном случае нажмите кнопку No. 

 
Совет: если вы захотите повторно установить REAPER, не удаляйте эти оставшиеся файлы. Это 
гарантирует, что ваши предыдущие настройки и будут сохранены при повторной установке программы. 
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2. Базовые составляющие проекта REAPER 
 

2.1. О чем пойдет речь в этой главе 
 
В данной главе мы рассмотрим базовые составляющие работы с проектом REAPER. Будут рассмотрены темы 
открытия и закрытия проектов, навигации рабочей среды REAPER, работа с треками и аудиоэффектами, и 
многое другое. Большинство рассмотренных здесь тем будет подробно описано позже в данном руководстве 
пользователя. 
 

2.2. Открытие текущего проекта 
 
Чтобы открыть текущий проект REAPER, перейдите File > Open Project (Ctrl+O). Как и в других приложениях 
Windows, необходимо перейти к соответствующей папке с проектом. Команда File > Recent Projects открывает 
список из 100 последних используемых проектов. Страница Options > Preferences > General включает 
дополнительные опции.  
 

 
 
Например, вы можете: 
 
- отредактировать параметры функции отмены Undo (секция Undo Settings). 
- выбрать опцию Last active project в меню Open projects on startup чтобы REAPER запускался с последним 
открытым проектом. Другие опции запуска подробно объясняются в Главе 22. 
- отметить опцию Automatically Check for New Versions of REAPER on Startup в секции Startup Settings, 
чтобы при запуске REAPER обновления проверялись автоматически. 
- определить количество последних открытых проектов в списке Recent project (опция Maximum projects in 
recent projects list). 
 
Другие параметры вкладки General будут подробно обсуждаться в Главе 22. Обратите внимание на опцию 
Continuous scrolling в меню Options. Если эта опция не отмечена (по умолчанию), указатель текущей позиции 
при воспроизведении будет следовать слева направо по ходу прокрутки проекта. Если эта опция отмечена, 
указатель текущей позиции по ходу прокрутки проекта будет оставаться на месте. 
 

Примечание: примеры, приведенные в данном руководстве пользователя основаны на проекте  
All Through The Night.RPP, который можно загрузить со страницы 
www.cockos.com/wiki/index.php/REAPER User Guide. Это поможет вам при изучении REAPER с помощью 

данного руководства пользователя. Скопируйте этот файл и работая с ним, вы сможете свободно 
экспериментировать, не рискуя повредить ваши собственные важные проекты. 
 
 
 
 

http://www.cockos.com/wiki/index.php/REAPER
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2.3. Параметры проекта. Диалоговое окно Project Settings 
 
Для каждого отдельного проекта можно настроить его собственные параметры. Чтобы открыть диалоговое окно 
свойств проекта (Project Settings) перейдите File > Project Settings (Alt+Enter). Диалоговое окно Project 
Settings включает пять страниц параметров - Project Settings, Media, Video, Advanced и Notes. Если вы не 
уверены в понимании каких-либо параметров, оставьте большинство из них как есть, по крайней мере на 
данном этапе.  
 
2.3.1. Диалоговое окно Project Settings: вкладка Project Settings 
 

 
 
Опция Project Sample Rate: частота сэмплирования проекта, например, 44100 Hz (CD стандарт) или 48000 Hz 
(DVD стандарт). 
Опция Force project tempo/time signature changes to occur on whole samples: если эта опция отмечена, 
изменения темпа/музыкального размера будут происходить на целых звуковых отсчетах. 
Опции Project BPM/Time signature: темп проекта в «ударах в минуту» (BPM) и музыкальный размер проекта 
соответственно. 
Меню Timebase for items/envelopes/markers/Timebase for tempo/time signature envelopes: представление 
времени для клипов/огибающих/маркеров и представление времени для огибающих темпа/музыкального 
размера соответственно. 
Опции Project start time/Project start measure: время начала проекта и такт, с которого начинается проект 
соответственно. На данном этапе оставьте эти параметры как есть. В Главе 11 мы обсудим, когда, почему и как 
их изменить. 
Меню Playback resample mode/Render resample mode: режимы ресэмплирования при воспроизведении и 
рендеринге соответственно. 
Меню Default pitch shift mode/Pitch shifter parameter: режим транспонирования по умолчанию и качество 
транспонирования соответственно. Подробнее об этом в Главе 10. 
 
2.3.1.1. Настройка представления времени проекта  
 
Представление времени проекта (project timebase) во вкладке Project Settings управляет поведением клипов, 
огибающих и маркеров проекта при изменении темпа проекта. По возможности настройте эти параметры 
непосредственно перед записью или импортированием любых клипов.  
 
Timebase beats (position, length, rate): представление времени по умолчанию. Клипы проекта сохраняют свою 
позицию и продолжительность измеряемую в долях. Скорость воспроизведения клипов убыстрится при 
увеличении темпа и замедляется при уменьшении темпа. 
Timebase beats (position only): клипы проекта сохраняют свою позицию измеряемую в долях, но 
продолжительность клипов останется постоянной если измеряется в секундах. 
Timebase time: клипы проекта сохраняют свою позицию и продолжительность измеряемую в секундах. Позиция 
и продолжительность клипов изменятся при измерении в долях, если изменяется темп. Это было 
представлением времени проекта по умолчанию до версии 4.25. 
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Для огибающих темпа/музыкального размера представление времени по умолчанию - значение Beats (доли), 
независимо от представления времени проекта. Это поведение можно также изменить во вкладке Project 
Settings. 
Представление времени для отдельных треков и клипов можно установить независимо от представления 
времени проекта. У MIDI клипов представление времени всегда измеряется в значении Timebase beats 
(position, length, rate). Представление времени для отдельных MIDI клипов можно привязать к определенному 
темпу независимо от темпа проекта в диалоговом окне свойств источника клипа. 
 
Стоит также заметить, что вы можете отменить представление времени проекта для отдельных треков в 
пределах вашего проекта. Для этого выберите трек (и) и выберите опцию Set track timebase из контекстного 
меню панели трека. Чтобы сделать это для отдельного клипа, выберите клип, затем нажмите F2, чтобы 
отобразить диалоговое окно свойств клипа Item Properties. 
 
2.3.2. Диалоговое окно Project Settings: вкладка Media 
 

 
 
Опции Path to save media files (can be relative, leave blank for same path as project file)/Secondary recording 
path (blank for none, can be enabled per-track): путь (основной и дополнительный соответственно) для 
сохранения медиафайлов. Например, если вы назначили папку Audio, ваши клипы будут сохранены в этой 
папке, так как она является частью папки проекта. Если область будет оставлена пустой, REAPER будет 
использовать папку с проектом. 
Секция Recording и меню Audio format for new recordings: формат для записанных в REAPER клипов. Как 
правило это форматы WAV или MP3, но доступны и другие, например, AIFF, DDP, FLAC, OGG Vorbis Video 
(GIF) и WavPack. Каждый из этих форматов включает свой собственный набор опций и параметров. 
Меню Media format for Apply FX, Glue, Freeze: выбор медиаформата при применении эффектов, склейки 
(glue), "заморозки" (frozen) и рендеринге клипов.  
Опция Default media format for projec/region: медиаформат по умолчанию, применяемый при рендеринге 
проекта и выделенных областей проекта. Варианты форматов те же, что и для определения формата при 
записи (меню Audio format for new recordings). 
 
2.3.3. Диалоговое окно Project Settings: вкладка Advanced 
 
Меню Item Mix Behavior: определяет поведение REAPER при наложении клипов друг на друга. 
Меню Track mixing bit depth: если вы не уверены в понимании опций этого меню, оставьте как есть. 
Опция Allow feedback in routing: маршрутизация обратной связи может быть полезна при некоторых 
продвинутых методах микширования, но может значительно снизить производительность аудиооборудования. 
Если вы сомневаетесь, не отмечайте эту опцию. 
Опция External timecode synchronization: обеспечивает синхронизацию временного кода проекта с 
временным кодом внешнего устройства. 
Опция Limit project length, stop playback/recording at: время в минутах/секундах/долях которым будет 
ограничена продолжительность проекта или когда будет остановлены воспроизведение/запись 
Pan law/Pan mode: определяет правило панорамирования/режим панорамирования для ваших треков. Правило 
панорамирования (pan law) определяет соотношение относительной громкости к панорамированию трека. 
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Подробнее правила панорамирования и опция Gain compensation boost pans будут осуждаться позже в 
данной главе. Подробнее режимы панорамирования (pan modes) будут обсуждаться в Главе 11.   
 

 
 
2.3.4. Диалоговое окно Project Settings: вкладка Video  
 

 
 
Опции этого диалогового окна будут подробно обсуждаться в Главе 20. 
 
2.3.5. Диалоговое окно Project Settings: вкладка Notes 
 

 
 
Эта вкладка позволяет создавать любые текстовые заметки и комментарии для вашего проекта. Можно сделать 
так, чтобы заметки автоматически отображались каждый раз при открытии проекта (опция Show notes on 
project loads). 
 

Совет: все параметры можно сохранить в качестве параметров по умолчанию, и они будут 
использоваться для будущих новых проектов (кнопка Save as default project settings). Конечно же, эти 
параметры по умолчанию для каждого отдельного проекта можно изменить в любое время. 
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2.4. Маршрутизация выходного аудиосигнала 
 

По умолчанию выходной аудиосигнал с мастер-канала 
направляется в первую доступную пару выходных портов 
вашей аудиокарты (обычно это выходные порты 1 и 2), и 
только в эту пару. Если ваша аудиокарта имеет несколько 
пар выходных портов, и вы хотите их поменять, это можно 
сделать через матрицу маршрутизации (View > Routing 
Matrix или Alt+R). Доступные аппаратные выходные порты 
отображаются наверху матрицы, и вы можете выбрать и/или 
исключить любой из доступных выходных портов. 
 
 
 
 
 
 
 
 
 
 
 
 

 
2.5. Транспортная панель 

 
Если в главном окне REAPER транспортная панель не видна, перейдите View > Transport (Ctrl+Alt+T) чтобы ее 
отобразить.  
 

 
 
Транспортная панель может выглядеть как на рисунке выше, ее можно открепить в плавающее окно, или 
прикрепить на панель Docker ниже области аранжировки. На данном этапе, точное расположение транспортной 
панели не особо важно. Расположение основных контроллеров транспортной панели может отличаться в 
зависимости от размеров главного окна REAPER. Первые пять транспортных кнопок достаточно стандартны - 
Go to Start (Перейти к началу) (1), Go to End (Перейти в конец) (2), Stop (Останов) (3), Play 
(Воспроизведение) (4), и Pause (Пауза) (5). Кнопка Stop останавливает воспроизведение и возвращает 
указатель в позицию, в которой он находился, когда было запущено воспроизведение. Кнопка Pause ставит 
воспроизведение на паузу, не затрагивая указатель текущей позиции. Кнопка Record (6) начинает и 
останавливает запись, не останавливая воспроизведение. Нажатие кнопки Stop в процессе записи 
останавливает и воспроизведение, и запись. Кнопка Toggle Repeat (7) активирует/отключает опцию 
зацикливания любой выделенной области проекта. Функция Global Automation Override (8) будет объяснена в 
Главе 18. Правее отображены временные параметры текущей выделенной области (область Selection) (9). Эта 
тема будет затронута позже в этой главе, а также в Главе 6 и Главе 8. Под транспортными кнопками расположен 
дисплей текущей позиции указателя (10). Рядом отображается транспортный статус (11) – Playing (Идет 
воспроизведение), Paused (Поставлено на паузу) или Stopped (Остановлено). Далее расположены 
редактируемые области темпа (12) и музыкального размера (13) проекта. Чтобы изменить значение щелкните 
по области и введите новое значение. В зависимости от параметров предварительных настроек мыши (Глава 
22) для редактирования этих значений можно также использовать колесо мыши. И наконец параметр Playback 
rate (скорость воспроизведения) (14), который регулируется горизонтальным фейдером. Если внесены 
изменения в скорость воспроизведения проекта, цвет фейдера окрашивается в зеленый цвет. Двойной щелчок 
на фейдере сбрасывает его в значение 1.0 (нормальное воспроизведение). Еще три эффективные горячие 
клавиши транспортной панели - Ctrl+стрелка влево (перемотка назад в небольших приращениях), 
Ctrl+стрелка вправо (перемотка вперед в небольших приращениях), и Alt+Пробел (воспроизведение с 
пропуском области лупа). Щелчок правой кнопкой мыши на транспортной панели открывает ее контекстное 
меню:  
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И пусть обилие опций этого меню вас не пугает - мы подробно рассмотрим эти опции в Главе 9. 
 

2.6. Контроллеры трека 
 

 
 
Если вы воспроизведете проект All Through The Night.RPP, вы заметите, что с обоих динамиков слышен 
одинаковый по громкости звук, а инструменты и вокал размещены в одной плоскости пространства. Все потому, 
что в этом проекте громкость и панорама треков не отрегулирована. Точное расположение контроллеров 
громкости (1) и панорамы (2), а также их тип (фейдер или регулятор) зависит от ширины и высоты панелей 
треков и от расположения самих треков. Если вы видите второй контроллер панорамирования (3), на данном 
этапе не обращайте на него внимания. Он используется с некоторыми режимами панорамирования и управляет 
шириной стереополя. Подробнее этот контроллер будет обсуждаться в Главе 10 и Главе 11. Пока что мы будем 
работать только с одним контроллером панорамирования. В любом случае, чтобы отрегулировать любой 
горизонтальный, вертикальный фейдер или регулятор в REAPER: 
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 - щелкните по нему и удерживая кнопку мыши переместите мышь в нужном направлении. Для регуляторов, 
поворот по часовой стрелке увеличивает значение, против часовой стрелки уменьшает значение. Чтобы 
изменить значение в более точных приращениях, удерживайте клавишу Ctrl. 
 - наведите курсор мыши на фейдер и поверните колесо мыши (вверх-увеличение значений, вниз – уменьшение 
значений). Чтобы активировать эту опцию, перейдите Options > Preferences > Editing Behavior > Mouse и 
снимите флажок с опции Ignore mousewheel on track panel faders (игнорировать колесо мыши на фейдерах 
панели трека). Подробнее о предварительных настройках поведения мыши в Главе 22. 
 
По умолчанию индикатор уровня громкости трека отображает уровень сигнала, после того, как он отрегулирован 
фейдером громкости. При необходимости можно вместо этого отобразить уровень перед фейдером, выбрав из 
меню Options команду Pre-fader track metering. 
 
Щелчок правой кнопкой мыши на контроллере громкости открывает диалоговое окно маршрутизации.  
 

 
 
Значения для громкости можно вводить в децибелах (например -6dB), и в процентах для панорамы и ширины 
стереополя (например, 25R для 25% вправо) непосредственно в соответствующей области. По умолчанию, 
контроллеры громкости/панорамы затрагивают выходной аудиосигнал трека. Если вы хотите использовать эти 
контроллеры и для управления MIDI сигналом в контекстном меню панели трека перейдите MIDI track controls 
> Link track volume pan to all MIDI channels (см. Главу 13). 
 

Совет 1: чтобы временно услышать изменения, удерживайте клавишу Alt при редактировании фейдера 
мышью. Когда вы отпустите мышь, контроллер возвратится в его начальную позицию. 
Совет 2: чтобы отредактировать параметры громкости/панорамы нескольких треков, удерживая клавишу 

Ctrl, щелкните по номерам нужных треков, а затем отпустите клавишу Ctrl. После этого редактирование 
контроллера любого из выбранных треков приведет к изменению такого же параметра всех выбранных треков. 
Направо от фейдера Width на панели трека расположена кнопка Mute (4), которая мьютирует выбранный 
трек(и) и кнопка Solo (5), которая солирует выбранный трек(и). 

 
Примечание: кнопки Mute и Solo могут также использоваться с клавишами модификаторами, например, 
Alt и Ctrl для выполнения различных функций.  
 

По умолчанию, при солировании трека воспроизводится выходной сигнал самого трека и выходной сигнал 
любых посылов, исходящих с этого трека. Если вы хотите слышать только выходной сигнал трека без сигнала 
посылов, при солировании трека удерживайте клавишу Alt. Обратите также внимание на кнопку Phase control 
(6), которая используется для реверсирования фазы трека. 
 

2.7. Правила и режимы панорамирования 
 
Для отдельных треков можно выбрать так называемое правило панорамирования (Pan Low).  
 

Щелчок правой кнопкой мыши на фейдере панорамирования трека 
открывает окно, где можно выбрать значение из списка, отметив опцию 
Override default track pan low (в диапазоне от 0.0 dB до -6.0 dB) или 
ввести свое собственное значение. При выборе отрицательных 
значений по мере панорамирования громкость сигнала будет 
уменьшаться. Если отмечена опция Gain compensation (boost pans) 
громкость сигнала будет повышаться по мере его панорамирования. 
Также вы можете выбрать предпочтительный режим панорамирования 
(меню Pan mode). Это достаточно сложная тема и подробнее она будет 
объяснена в Главе 11 при рассмотрении панорамирования 

стереосигнала.  
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По умолчанию выбран режим Stereo balance/mono pan, который эквивалентен режиму панорамирования, 
используемому в REAPER до версии 4. Если вы выберете режим REAPER 3.x balance, Stereo pan или Dual 
pan, автоматически добавится контроллер Width. Различные режимы панорамирования подробнее 
объясняются в Главе 11. 
 

2.8. Опции навигации и масштабирования 
 
2.8.1. Навигация панели трека 
 
Следующие горячие клавиши могут использоваться при навигации в пределах панели трека: 
 
Переход к следующему треку: Ctrl+Alt+стрелка вниз 
Переход к предыдущему треку: Ctrl+Alt+стрелка вверх 
 
2.8.2. Регулировка ширины панели мышью 
 
Чтобы отрегулировать ширину панели трека, поместите курсор мыши на вертикальную границу, отделяющую 
область панели трека от главной области окна REAPER, пока курсор мыши не изменится на горизонтальную 
двухстороннюю стрелку . Щелкните по границе и удерживая кнопку мыши, переместите мышь влево/вправо.  

 
Примите во внимание: двойной щелчок по вертикальной границе любого трека отображает/скрывает 
панели треков. 
 

2.8.3. Регулировка высоты панели трека мышью 

Регулировка высоты одного трека: захватите нижнюю границу трека  и переместите мышь вверх/вниз 
Регулировка высоты нескольких выбранных треков: захватите нижнюю границу трека и переместите мышь 
вверх/вниз с нажатой клавишей Alt 
Регулировка высоты всех треков: захватите нижнюю границу любого трека и переместите мышь вверх/вниз с 
нажатой клавишей Ctrl или щелкните между символами + и - вертикальной полосы прокрутки и удерживая 
кнопку мыши, переместите мышь вверх/вниз  
 
2.8.4. Переключение высоты трека с клавиатуры или мышью 
 
Минимизация высоты всех треков или если треки уже минимизированы восстановление в предыдущую высоту: 
клавиша Ё в русской раскладке. 
Переключение между нормальной и максимизированной высотой текущего выбранного трека: клавиша ~ 
(Shift+Ё). 
Расширение высоты выбранных треков, минимизируя остальные: повторный щелчок возвращает все треки в 
одинаковую высоту: клавиша ! (символ восклицательный знак) (Shift+1). 
Минимизирование всех треков: клавиша @ (Shift+2). 
Переключение высоты всех треков между минимизированным, нормальным и максимизированным 
состояниями: двойной щелчок по вертикальной полосе прокрутки 
 
2.8.5. Горячие клавиши параметров масштабирования 
 
Следующие горячие клавиши могут использоваться при масштабировании в пределах проекта: 
 
Уменьшение масштаба по вертикали, с уменьшением высоты трека: клавиша Page Down 
Увеличение масштаба по вертикали, с увеличением высоты трека: клавиша Page Up 
Масштабирование выделенной области: Ctrl+знак плюс на цифровой клавиатуре 
Уменьшение масштаба продолжительности проекта целиком: Ctrl+Page Down 
Уменьшение масштаба по горизонтали: - (символ минус) 
Увеличение масштаба по горизонтали: + (символ плюс) 
Уменьшение масштаба прорисовки сигналограммы клипов: Shift +стрелка вниз 
Увеличение масштаба прорисовки сигналограммы клипов: Shift +стрелка вверх 
 
2.8.6. Горячие клавиши прокрутки 
 
Следующие горячие клавиши могут использоваться при прокрутке в пределах проекта: 
 
Прокрутка представления вниз: Alt +стрелка вниз 
Прокрутка представления вверх: Alt +стрелка вверх 
Прокрутка представления влево: Alt +стрелка влево 
Прокрутка представления вправо: Alt +стрелка вправо 
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2.8.7. Масштабирование и прокрутка колесом мыши 
 
Колесо мыши может также использоваться для масштабирования проекта. 
 
Горизонтальное масштабирование: модификатор не применяется 
Вертикальное масштабирование: Ctrl 
Горизонтальная прокрутка: Alt 
Вертикальная прокрутка: Ctrl+Alt 

 
Примечание: параметры секции zoom center (Options > Preferences > Editing Behavior) определяют 
точное поведение масштабирования. См. Главу 22. 
 

Вы можете изменить любые горячие клавиши и назначения колеса мыши по умолчанию. Например, можно 
использовать только стрелки вверх и вниз (без горячей клавиши Ctrl+Alt) для перехода к 
следующему/предыдущему треку, или использовать колесо мыши без модификатора для прокрутки, но не 
масштабирования. Можно также использовать собственные модификаторы для мыши при масштабировании, 
особенно в пределах шкалы времени и области аранжировки. Подробнее модификаторы мыши описываются в 
Главе 15. 
 

Совет: масштабирование и навигация - это действия, которые выполняются многократно. Поэтому вы 
можете создать вашу собственную панель навигации/масштабирования. Это не так сложно, как может 
показаться на первый взгляд. Как создавать собственные панели инструментов объясняется в Главе 15. 

 
2.9. Горячие клавиши и модификаторы мыши по умолчанию 

 
Выбор команды Help > Keybindings and Mouse Modifiers (Shift +F1) открывает html страницу со списком 
модификаторов мыши и горячих клавиш REAPER. Как вы увидите в Главе 15, можно определить собственные 
модификаторы мыши, горячие клавиши и клавиши действия так, чтобы поведение мыши и клавиатуры 
определялось контекстом, в котором вы их используете. 
 

 
 

2.10. Панель навигатора 
 
Панель навигатора REAPER (Navigator) обеспечивает дополнительные опции навигации/масштабирования 
проекта. Чтобы отобразить панель навигатора, перейдите View > Navigator (Ctrl+Alt+V).  

 
Наведите курсор мыши на область на панели навигатора, которая 
представляет область на экране вашего проекта и удерживая 
кнопку мыши, переместите мышь, чтобы прокрутить дисплей. 
Другие способы использования панели навигатора: 
 
Определение новой области, которая будет показана в окне 
REAPER: удерживая правую кнопку мыши, перетащите мышь и 
отпустите кнопку мыши 
Репозиционирование прямоугольника выделения и отображение 
области окна: щелчок левой кнопкой мыши 
Репозиционирование указателя текущей позиции: Ctrl + щелчок 

левой кнопкой мыши 
Использование в окне REAPER для прокрутки и/или масштабирования: колесо мыши 
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2.11. Основы использования эффектов трека 
 
Эффекты трека (JS, VST, VST3, Direct X, VSTi, VST3i и DXi, а, для пользователей Mac, еще и AU) можно 
добавить к любому треку, непосредственно вставив их в цепочку эффектов (FX Chain) этого трека. C REAPER 
поставляется обширная коллекция эффектов, включая плагины компаний Jesusonic и Cockos. Подробнее 
использование эффектов мы рассмотрим позже, в частности в Главе 5 и Главе 16. REAPER также включает 
коллекцию программируемых видеоэффектов, которые мы рассмотрим в Главе 20. Чтобы использовать любой 
из эффектов: 
1. Нажмите кнопку  на панели трека, к которому вы хотите добавить эффекты. В окне эффектов трека (FX) 
перейдите к окну выбора эффектов (Add FX). Если это окно не открылось автоматически, нажмите кнопку 

 
 

 
 
2. Выберите категорию, например, All Plug-ins, DX, VST, JS, Cockos. 
3. Дважды щелкните по нужному эффекту. 
4. Чтобы добавить другие эффекты, нажмите кнопку Add, а затем повторите шаги 2 и 3. 

 
Примечание: при добавлении плагина в цепочку эффектов любого трека, этот плагин будет также 
отображаться в браузере эффектов в папке Recently Used. 
 

2.12. Использование пресетов эффектов 
 
Тема использования эффектов достаточно объемна, и мы ее коснемся в Главе 16, Главе 17 и Главе 18. 
Наиболее подробная информация и более продвинутые примеры вы найдете в книге ReaMix: Breaking the 
Barriers with REAPER, которая доступна на странице Bookstore  REAPER: 
http://stores.lulu.com/store.php?fAcctID=1374784.  
 

Тем не менее, в контексте 
ознакомления вы можете 
рассмотреть использование 
пресетов, которые поставляются 
с эффектами. Дважды щелкните 
по имени плагина и в окне 
плагина выберите пресет из 
списка.  
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Чтобы установить любой пресет в качестве пресета по умолчанию для этого эффекта: 
 
1. Выберите пресет из списка. 

2. Нажмите кнопку  направо от списка и выберите опцию Save preset as default из меню. 
3. Дайте пресету имя и нажмите кнопку OK. Дополнительные пресеты можно загрузить со страницы 
http://stash.reaper.fm/ используя ссылку FX Preset Libraries. 
 
Чтобы импортировать загруженные пресеты в REAPER: 
 
1. Вставьте плагин в трек. 

2. Нажмите кнопку  (слева от кнопки  в окне эффектов). 
3. Нажмите кнопку Import Preset Library. 
4. Выберите нужный файл и нажмите кнопку Open. 
 
Чтобы выбрать пресет при загрузке эффекта: 
1. Откройте окно эффектов трека и нажмите кнопку Add. 
2. Выберите нужную категорию (например, Cockos). 
3. Щелкните правой кнопкой по имени эффекта (например, ReaEQ). 
4. Из контекстного меню выберите presets и выберите нужный пресет (например, Intimate female vocal). 
 

2.13. Управление эффектами трека 
 
REAPER включает множество инструментов управления эффектами трека. Например, вы можете: 
 
- изменить порядок, в котором будут применяться эффекты; 
- скопировать или переместить любые эффекты с одного трека в другой; 
- сохранить (и загрузить) любую последовательность эффектов в цепочку, которую можно легко вставить в 
другие треки; 
- обойти (временно отключить) отдельные эффекты или всю цепочку эффектов; 
- определить набор эффектов по умолчанию, которые будут автоматически вставлены в новые треки вашего 
проекта; 
 
Чтобы закрепить цепочку эффектов на панели Docker: в окне эффектов перейдите FX > Dock FX Window in 
Docker. 
Чтобы отрегулировать значения параметров эффектов трека: захватите контроллер мышью, или 
прокрутите колесо мыши на контроллере, который управляет значением параметра, который вы хотите 
изменить. Для изменения значений параметра эффекта в более точных приращениях, удерживайте клавишу 
Ctrl. Альтернативно, выберите контроллер мышью, а затем используйте клавиши со стрелками вверх/вниз. 
Чтобы отрегулировать баланс (wet/dry mix) любого эффекта: выберите плагин в цепочке эффектов, а затем 

отрегулируйте маленький контроллер рядом с кнопкой UI  в окне эффектов REAPER. Значение 100 % 
означает максимальную степень (wet). Значение 0 % означает практическое отсутствие применения эффекта 
(dry). 
Чтобы изменить порядок расположения эффектов трека: захватите имя эффекта и перетащите его в 
пределах окна эффектов трека. 
Чтобы открепить окно интерфейса эффекта в плавающее окно: дважды щелкните по имени эффекта в окне 
эффектов. Заголовок плавающего окна отобразит имя трека, имя эффекта, и его место в цепочке эффектов 
трека. Например, VST: ReaEQ, Track 1 “Vocal” [2/3], то есть 2-й эффект в цепочке из 3 эффектов. 
Чтобы закрепить окно интерфейса эффекта или окно Add FX поверх остальных окон: нажмите на символ  на 
правой стороне заголовка окна. 
Чтобы закрыть плавающее окно эффектов: дважды щелкните по заголовку окна. 
Чтобы скопировать эффект с одного трека в другой: удерживая клавишу Ctrl, перетащите эффект из окна 
эффектов трека-источника на панель трека-адресата. Чтобы скопировать огибающие автоматизации с 
эффектами, используйте Shift+Ctrl+перетаскивание. 
Чтобы переместить эффект с одного трека в другой: удерживая клавишу Alt, перетащите эффект из окна 
эффектов трека-источника на панель трека-адресата. 
Чтобы переименовать эффекторный слот: выберите эффект в цепочке и нажмите клавишу F2. 
Чтобы обойти эффект: либо снимите флажок слева от имени эффекта в окне эффектов трека, либо снимите 
флажок в верхнем правом углу окна эффектов. 
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Чтобы заменить один эффект другим эффектом: выберите плагин в цепочке и нажмите Ctrl+R. В окне 
Replace FX (то же, что и окно Add FX) дважды щелкните по плагину, которым вы хотите заменить текущий 
эффект. При этом любая текущая конфигурация маршрутизации сохраняется. 
Чтобы сделать текущий плагин эффектом по умолчанию для новых треков: в окне эффектов трека 
перейдите FX > Save Chain as default for new tracks. 
Чтобы удалить эффект с трека: выберите плагин в окне эффектов трека и нажмите кнопку Remove. 
Чтобы удалить все эффекты с трека: нажмите кнопку  с нажатой клавишей Alt на панели трека. 
Чтобы найти эффект: введите название в области фильтра внизу окна эффектов. 
 

 
 
Чтобы сохранить текущую последовательность эффектов трека в качестве цепочки: в окне эффектов 
трека перейдите FX > Save FX Chain. Параметры эффектов сохраняются с цепочкой. 
Чтобы сохранить выделенные эффекты трека в цепочку: выберите эффекты, которые будут включены в 
цепочку (используя клавишу Ctrl), а затем перейдите FX > Save Selected FX as Chain. 
Чтобы загрузить ранее сохраненную цепочку эффектов: в окне эффектов трека перейдите FX > Add FX 
Chain, или на панели трека щелкните правой кнопкой мыши по кнопке  и выберите опцию Add FX Chain из 
меню. 
Чтобы загрузить цепочку эффектов по умолчанию: в окне эффектов трека, перейдите FX > Load Default 
Track Chain. 
Чтобы получить доступ к диалоговому окну FX Preferences: в окне эффектов трека, перейдите  
Options > FX Plug-in Settings. Параметры этого окна будут обсуждаться в Главе 22. 
Чтобы обойти все эффекты трека: на панели трека нажмите кнопку . Повторный щелчок реверсирует 
обход. 
 

2.14. Окно эффектов и горячие клавиши 
 
Для вашего удобства при работе в окне эффектов 
обеспечивается доступ к различным горячим клавишам, 
включая горячие клавиши навигации (например, клавиши со 
стрелками вверх/вниз выбирают следующий/предыдущий 
эффекты в цепочке) и горячие клавиши (например, клавиша 
Ctrl+S для сохранения цепочки эффектов). В меню 
отображены горячие клавиши опции эффектов. Вы могли бы 
предпочесть вместо этого использовать эти клавиши в 

области аранжировки, даже когда вы работаете в окне эффектов так, чтобы (например), горячая клавиша Ctrl+S 
могла использоваться для сохранения проекта, а клавиши со стрелками вверх/вниз для масштабирования по 
горизонтали. В этом случае необходимо отметить опцию Ignore FX chain keyboard shortcuts (send to main 
window). 
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2.15. Создание цепочки эффектов по умолчанию 
 
Если вы до этого пользовались другим хостом, например, Sonar, вы могли привыкнуть к ситуации, когда в 
каждый создаваемый трек автоматически вставлялся эквалайзер. Это можно сделать и в REAPER, создав 
цепочку эффектов по умолчанию, которая автоматически будет вставлена в каждый новый созданный трек. 
Конечно же, эта цепочка может включать любые эффекты. 
 
1. Откройте окно выбора эффектов любого трека. 
2. Добавьте нужные эффекты. 
3. В окне эффектов перейдите FX > Save chain as default for new tracks. 
 

Совет: если вы переключите эффект в состояние обхода до сохранения цепочки эффектов, эта 
цепочка будет также сохранена в состоянии обхода. Это означает, что эффекты в новых треках не 
будут использовать ресурсы компьютера до тех пор, пока вы не откроете окно эффектов и не 

активируете эффекты. 
 
Пример: 
 
В данном примере, мы создадим цепочку эффектов по умолчанию, которая состоит из плагинов ReaEQ и 
ReaComp, оба установленных в обход. 
 
1. Откройте любой проект и добавьте новый трек. Этот трек мы будем использовать для создания нашей 
цепочки эффектов. 
2. Нажмите кнопку FX этого трека, чтобы открыть окно эффектов. 
3. В первой (левой) колонке окна Add FX, нажмите Cockos. 
4. Выберите ReaEQ (Cockos) и ReaComp (Cockos). В каждом случае, либо нажмите кнопку OK, чтобы добавить 
плагин в цепочку эффектов трека, либо перетащите плагины в цепочку мышью. 
5. Убедитесь, что перед именем обоих эффектов сняты флажки (состояние обхода). 
6. Щелкните правой кнопкой по одному из эффектов и выберите из контекстного меню опцию Save chain as 
default for new tracks. 
7. Закройте окно эффектов. 
8. Теперь можно выйти в REAPER не сохраняя проект. 
9. Вновь откройте REAPER и откройте любой проект. 
10. Вставьте новый трек. 
11. Откройте окно эффектов нового трека. Теперь вы видите, что плагины ReaEQ и ReaComp уже вставлены в и 
находятся в состоянии обхода. 
 

Совет 1: если вы хотите заменить плагины в цепочке эффектов по умолчанию, просто повторите 
описанный выше процесс, на сей раз выбрав другие плагины. 
Совет 2: если при открытии проекта вы удерживаете Ctrl+Shift, проект будет открыт с отключенными 

эффектами. Это может быть полезно в том случае, если вы хотите сэкономить ресурсы компьютера или если 
вставленный плагин вызывает проблемы с производительностью. 
 

2.16. Шина эффектов 
 
Если вы до этого момента пользовались другим хостом, или аналоговой консолью для записи и микширования, 
вы скорее всего уже познакомились с термином Шина (Bus). У этого термина может быть несколько вариаций, 
но обычно (и в данном случае), шина используется для подключения одного плагина к нескольким трекам, 
позволяя тем самым значительно сократить использование ресурсов компьютера. Примите во внимание, что 
когда вы таким образом используете шину: 
 
- выходной сигнал с каждого трека все еще направляется в мастер-канал. 
- кроме того, копия сигнала с каждого трека направляется в шину. 
- на определенной стадии выходной сигнал шины микшируется с оригинальным сигналом. Как правило (и в 
данном примере) это достигается маршрутизацией выходного сигнала с шины в мастер-канал, хотя возможны и 
другие, более сложные схемы маршрутизации.  
 
Трек-шину можно вставить в любом месте проекта. В данном примере, мы поместим ее после последнего трека. 
Откройте файл All Through The Night.RPP и сохраните копию проекта с другим именем, например, All Through 
The Night with Bus.RPP. В данном примере, мы собираемся создать шину и вставить в нее эффект Chorus. 
Затем мы убедимся, что эффект Chorus используют оба наших гитарных трека. Вы поймете, что REAPER 
отличается от других хостов тем, что он не делает различия между шиной и треком. Различие заключается 
только в самом способе использования трека. 
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Чтобы создать шину и добавить в нее эффект: 
 
- выберите трек 4 (на панели треков). 
- чтобы вставить новый трек либо перейдите Track > Insert New Track, либо нажмите Ctrl+T, либо дважды 
щелкните по пустой области панели треков ниже последнего трека. 
- чтобы переименовать новый трек, щелкните в области имени трека, напечатайте FX Bus и нажмите Enter. 
- чтобы вставить эффект Chorus в эту шину, нажмите кнопку FX трека-шины. Из списка типов плагинов слева 
выберите JS, затем в списке дважды щелкните по плагину JS: Guitar/Chorus. Закройте окно эффектов шины. 
 
Чтобы создать посылы с двух гитарных треков в шину: 
 
- выберите два гитарных трека на панели трека (щелчок с нажатой клавишей Ctrl).  
- щелкните правой кнопкой мыши по кнопке  любого из этих треков и выберите Sends > Track 5: FX Bus из 
контекстного меню. 
 

Примите во внимание: для каждого посыла есть свой эквивалент адресата и наоборот. Например, если 
вы теперь откроете окно Routing трека 5 (щелчком по кнопке ), вы увидите, что там два адресата 
(Receive from…) - с каждого трека гитары. Подробнее о маршрутизации в REAPER мы поговорим позже 

в этой главе, а также в Главе 5 и Главе 17. 
 
2.16.1. Внесение изменений 
 
Теперь при воспроизведении проекта All Through The Night with Bus.RPP вам, вероятно, покажется что на 
гитарных треках слишком много хоруса. Доступно четыре основных способа отредактировать параметры 
плагина: 
 
1. Отрегулируйте параметры плагина Chorus в его окне. В данном случае, можно изменить баланс Wet/Dry 
эффекта: 
 

 
 
2. Отрегулируйте уровни одного или обоих адресатов в окне маршрутизации шины: 
 

 
 
3. Откройте окно маршрутизации любого гитарного трека и отрегулируйте уровень посыла (Send to track…) 
этого трека: 
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4. Отрегулируйте фейдер громкости шины: 
 

 
 
Несколько советов: 

 
- чтобы включить/отключить посыл с трека в мастер-канал: удерживайте клавишу Alt при нажатии кнопки 

. Это работает как с одним, так и с несколькими выбранными треками. 
- чтобы быстро создать посыл с одного трека в другой: перетащите кнопку  трека-источника на панель трека-
адресата. Это также можно сделать и в микшере. См. Главу 11. 
- чтобы создать посыл выходного сигнала трека непосредственно на любой выходной порт аудиокарты: 
щелкните правой кнопкой мыши по кнопке  и выберите аудио или MIDI порт. Это также может 
использоваться с несколькими выбранными треками независимо от основного статуса посыла трека. 
 

2.17. Анализ производительности эффектов 
 
Плагины эффектов могут значительно нагружать процессор компьютера. Чтобы попытаться это преодолеть 
можно использовать индикатор производительности (Performance Meter) и произвести мониторинг 
производительности эффектов: 
 
- можно отследить, какой процент производительности процессора используется эффектами треков и 
эффектами мастер-канала. 
- можно активировать/отключить цепочки эффектов отдельных треков быстро, легко и удобно в одном месте. 
- можно включить/отключить статус мьютирования треков, опять же в одном удобном месте. Чтобы отобразить 
индикатор производительности, нажмите Ctrl+Alt+P, или перейдите View > Performance Meter. 
 
Пример: 

 
На рисунке слева, мастер-трек с одним плагином использует 
ресурсы процессора на 0.14 %, а трек Vox, также с одним 
плагином, использует ресурсы процессора на 0.05 %. Если 
какой-либо трек показывает неожиданно высокий показатель, 
можно отследить производительность эффектов на этом треке 
и идентифицировать причину завышения показателя. Чтобы 
открыть цепочку эффектов трека, дважды щелкните по имени 
трека или по его номеру в окне индикатора. Эта функция 
полезна в том случае, если у вас в проекте много треков. 
Индикатор производительности можно использовать для 
мониторинга проекта, отслеживая трек за треком без 
необходимости прокручивать или переходить 
непосредственно к представлению треков. Можно, конечно, 
активировать кнопку  любого трека, нескольких выделенных 
треков, или всех треков в представлении микшера или 
представлении треков.  
 
 
 
 
 
 
 
 
 
 
 
 

 
Список ниже суммирует эти опции: 
 
Чтобы активировать/отключить статус обхода (bypass) для одного трека: нажмите кнопку  этого трека. 
Чтобы активировать/отключить статус обхода для нескольких треков: выделите треки (Ctrl+щелчок) и 
нажмите кнопку  любого из этих треков. 
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Чтобы активировать/отключить статус обхода для всех треков: удерживая клавишу Ctrl, нажмите кнопку  
любого трека. 
 
Кроме того, у индикатора производительности есть два контекстных меню.  

 
Доступ к первому меню можно получить щелчком правой кнопкой 
мыши по области списка треков: 
 
Чтобы открыть окно эффектов этого трека: щелкните правой 
кнопкой мыши по имени трека и выберите Show FX Dialog из 
контекстного меню. 
Чтобы активировать/отключить статус обхода для одного 
трека: щелкните правой кнопкой мыши на имени трека и 
выберите Toggle FX Bypass из контекстного меню. 
Чтобы активировать статус мьютирования для этого трека: 
щелкните правой кнопкой мыши по треку и выберите Toggle 
Track Mute из контекстного меню. 
Чтобы показать/скрыть список треков в окне индикатора 
производительности без эффектов: щелкните правой кнопкой 

мыши по треку и выберите опцию Show track FX when empty из контекстного меню. 
Чтобы показать/скрыть мастер-трек/мониторинг без эффектов в окне индикатора производительности: 
щелкните правой кнопкой мыши по любому треку и выберите опцию Show master FX when empty и/или Show 
monitoring FX when empty из контекстного меню. 
 

Другое контекстное меню используется главным образом для 
выбора информации, которая будет отображаться в окне. 
Чтобы открыть меню, щелкните правой кнопкой в любом 
месте главной области индикатора производительности. Это 
меню можно также использовать для прикрепления окна 
индикатора производительности на панель Docker (Dock 
parformance meter in Docker). 
 
 
 
 
 
 
 
 
 
 
 
 

 
Совет: можно выбрать несколько треков, используя горячую клавишу Ctrl+щелчок, а затем щелкнуть 
правой кнопкой мыши по любому из выделенных номеров треков в окне индикатора производительности 
и активировать/отключить статус обхода и/или активировать статус мьютирования для всех выбранных 

треков. 
 
Примечание: подробнее об индикаторе производительности REAPER в Главе 22. 
 
 

 
2.18. Окно Big Clock 

 
Команда View > Big Clock 
(Alt+C) активирует окно с 
увеличенным представлением 
текущей позиции указателя. 
Вы можете изменить размер 
этого окна и переместить его в 
любое местоположение или 
прикрепить на панель Docker.  
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Щелчок правой кнопкой мыши по окну Big Clock открывает его контекстное меню, включая опции изменения 
формата отображения. 
 

 
 
 

2.19. Выделение области и определение области лупа 
 
Зачастую у вас будет возникать необходимость работать только с определенной частью вашего проекта 
(выделенной областью). Для начала обратите внимание на опцию Loop Points Linked to Time Selection в меню 
Options. Если она отмечена, процесс выделения области и процесс определения области лупа будут одним 
действием. Если эта опция не отмечена, это будут два разных действия.  

 
В любом случае, область лупа можно выделить на шкале времени: щелкните по шкале 
времени и не отпуская кнопку мыши выделите область, которая подсветится и 
ограничится двумя треугольниками.   
 
 
 

 
Если, при выделении области ее границы не попадают в границы рисуемой вами области, значит активирована 
функция привязки (Snapping). Параметры привязки будут обсуждаться в Главе 7, а на данном этапе можно 
использовать горячие клавиши Alt+S для активирования/отключения функции привязки. Теперь, когда вы 

воспроизведете проект и при условии, что кнопка  (Toggle Repeat) на транспортной панели активирована, 
воспроизведение выделенной области будет зациклено. 
 

Совет: чтобы подогнать область лупа к продолжительности клипа, дважды щелкните по нему с нажатой 
клавишей Ctrl. Чтобы подогнать выделенную область к продолжительности клипа, дважды щелкните по 
клипу с нажатой клавишей Shift.  

  
Если границы лупа привязаны к выделенной области, временная позиция начала, окончания и общая 
продолжительность выделенной области будет также отображаться на транспортной панели в секции Selection. 
Клавиша R активирует/отключает функцию зацикливания (активирует/отключает кнопку Toggle Repeat). Если 
опция Stop playback at end of loop if repeat is disabled на странице Options > Preferences > Playback > 
Playback settings активирована, воспроизведение будет остановлено в конце лупа, при условии, что кнопка 
Toggle Repeat отключена. Чтобы выделить другую область лупа, просто повторите вышеописанную процедуру. 
Чтобы отменить область лупа целиком, не определяя новой, просто нажмите клавишу ESC.  
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Если границы лупа не привязаны к выделенной области, ее можно выделить в области между клипами или в 
области ниже клипов на заднем плане области аранжировки. Щелчок правой кнопкой мыши по шкале времени 
открывает контекстное меню с опциями управления выделенной области, включая опции ее масштабирования. 
Это меню также можно использовать для выбора представления времени на шкале времени.  
 

 
 
Кстати, чтобы уменьшить масштаб выделенной области и восстановить проект целиком, нажмите Ctrl+Page 
Down. Подробнее об обозначении области лупа и выделенной области в Главе 6 и Главе 8. 
 

2.20. Управление выделенной областью и областью лупа 
 
В предыдущем параграфе вы узнали, как выделить область. В зависимости от статуса опции Loop Points 
Linked to Time Selection выделенная область будет определять или нет область лупа. По мере знакомства с 
данным руководством пользователя, вы увидите, что выделенная область играет важную роль в REAPER, 
например, когда дело доходит до редактирования клипов.  
 

Чтобы изменить продолжительность области лупа, используя мышь, перетащите начальную 
или конечную границу лупа (треугольники) на шкале времени. Смещение влево от начальной 
границы лупа расширяет область влево, смещение вправо сокращает ее.  

Смещение вправо от конечной границы лупа расширяет область лупа вправо, смещение влево от конечной 
точки сокращает ее. Если при изменении границ вы удерживаете клавишу Ctrl, будет проигнорирована функция 
привязки. Чтобы переместить область лупа целиком, на шкале времени захватите ее мышью и удерживая 
клавишу Shift сместите область влево или вправо.  
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Чтобы изменить размеры выделенной области можно 
щелкнуть по ней и прокрутить колесо мыши в области 
Selection на транспортной панели.  
 
 

 
Прокрутка в области Start time of selection изменяет начальную границу области лупа, прокрутка в области End 
time of selection изменяет конечную границу области лупа, прокрутка в области Length of selection 
перемещает по шкале времени выделенную область целиком. Если хотите, можно ввести фактические 
временные значения в каждой из перечисленных областей. Доступны несколько горячих клавиш для управления 
выделенной областью. Если область лупа привязана к выделенной области, она будет также изменена: 
 
Смещение выделенной области целиком влево: клавиша с символом «запятая» 
Смещение выделенной области целиком вправо: клавиша с символом «точка» 
Расширение выделенной области влево смещением левой границы: Ctrl + клавиша с символом запятая 
Сокращение выделенной области справа смещением левой границы: Ctrl+ клавиша с символом точка 
Сокращение выделенной области справа, смещением правой границы вправо: Ctrl+Alt+ клавиша с символом 
запятая 
Расширение выделенной области слева, смещением правой границы влево: Ctrl+Alt+ клавиша с символом 
точка 
Смещение выделенной области влево на ее размер: Shift+ клавиша с символом запятая 
Смещение выделенной области вправо на ее размер: Shift+ клавиша с символом точка 
Копирование выделенных клипов в выделенной области: Ctrl+Shift+C 
Удаление выделенной области: клавиша Esc 
 
Альтернативно, для выделения области вместо мыши можно использовать клавиатуру. Сначала необходимо 
поместить курсор в начало или в конец лупа, а затем: 
 
Чтобы переместить курсор влево, выделяя область: Shift +клавиша стрелка влево 
Чтобы переместить курсор вправо, выделяя область: Shift +клавиша стрелка вправо 
 
Следующие горячие клавиши могут использоваться для изменения масштаба при работе с выделенной 
областью: 
 
Увеличение масштаба выделенной области: Ctrl+Page Up 
Уменьшение масштаба выделенной области: Ctrl+Page Down 
 

Совет: если поместить курсор в точную позицию у вас не получается, значит активирована функция 
привязки (Snapping). Горячая клавиша Alt+S отключает/активирует функцию привязки. 
 

 
2.21. Навигация "перескоком" 

 
Вы можете перескочить в любую точку на шкале времени, используя команду View > Go To > Jump To (Ctrl+J).  
 

 
 
В определении точки перескока необходимо использовать тот же формат представления времени, который 
используется шкалой времени. В данном примере шкала времени использует формат такты (Measures), а ниже 
формат минуты и секунды (Minutes/Seconds).  
Если в вашем проекте используются маркеры и/или регионы, область маркеров/регионов можно использовать 
для перескока непосредственно к любому маркеру или региону. Например, если вы введете M1 указатель 
текущей позиции перескочит к маркеру 1, если вы введете R2 указатель текущей позиции перескочит к началу 
региона 2, и так далее. Подробнее маркеры и регионы будут обсуждаться в Главе 9. 
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Совет: другой легкий способ открыть диалоговое окно Jump to - дважды щелкнуть по области текущей 
позиции курсора на транспортной панели. 
 

 
2.22. Использование транспортной панели в работе с выделенной областью и областью 

лупа 
 
Доступно два способа использования транспортной панели с областью лупа или выделенной областью: 
  
Цикличное воспроизведение выделенной области: выделите область, убедитесь, что кнопка Toggle Repeat на 
транспортной панели активирована, поместите указатель текущей позиции в область и нажмите клавишу 
Пробел. 
Воспроизведение проекта с пропуском выделенной области: выделите область и поместите указатель 
текущей позиции перед ее начальной границей. Нажмите Alt+Пробел. 
 

2.23. Закрепление окна поверх других окон 
 
Маленький символ булавки  на правой стороне заголовка большинства окон может использоваться для 
закрепления окна поверх других окон. 
 

2.24. Название клипов, кнопки и символы 
 
В зависимости от параметров диалогового окна Options > Preferences > Appearance > Media вы можете (или 
нет) видеть названия клипов, которые отображаются выше, а не на нем самом. Можно отобразить также 
некоторые символы клипов (или кнопок). Подробнее об этом в Главе 7. 
 

2.25. Основы маршрутизации в REAPER 
 
В этом параграфе мы затронем одну из наиболее важных базовых функций REAPER - маршрутизация 
(Routing) - путь прохождения сигнала клипов (аудио и/или MIDI). Тема маршрутизации затрагивалась ранее, 
когда мы рассматривали создание и использование шины эффектов. Маршрутизация может быть как очень 
простой, так и чрезвычайно сложной. На данном этапе мы затронем только основы маршрутизации. Более 
сложные опции маршрутизации будут охвачены позже в этой главе, а также в Главе 4 и Главе 17.  

 
На панели каждого трека присутствует кнопка Route . При наведении мыши на эту 
кнопку отображается всплывающая подсказка с любыми посылами и/или адресатами, 
связанными с этим треком.  
 
 

Щелчок по этой кнопке открывает окно маршрутизации трека.  
 

 
 



 Специально для сайта musicmanuals.ru  48 48 

Чтобы закрыть окно маршрутизации трека, нажмите клавишу ESC или нажмите кнопку  в верхнем правом 
углу окна, или щелкните в любом месте за пределами окна. Фактическое содержание окна маршрутизации трека 
будет зависеть от структуры проекта и конфигурации параметров в хосте. Обратите внимание на следующие 
опции и параметры: 
 
Опция Master/parent send: если эта опция отмечена, выходной сигнал трека будет направлен в мастер-канал. 
Если вы не уверены в выборе, оставьте эту опцию отмеченной. 
Секция Sends: на примере шины эффектов, описанном ранее в этой главе мы создали посылы. Выходной 
сигнал трека можно направить через посыл с любого трека в любой другой трек или треки. Эта тема подробнее 
будет затронута позже. 
Секция Audio Hardware Outputs: в дополнение к (или вместо) маршрутизации выходного сигнала в мастер-
канал, выходной сигнал любого трека можно направить напрямую в выходной порт вашего аудиоустройства.  
Если ваше аудиоустройство поддерживает мультиканальную систему, можно, например, создать отдельный 
микс в наушниках, или серию отдельных миксов на несколько наушников. 
Секция MIDI Hardware Output: используйте эту опцию для маршрутизации выходного MIDI сигнала на внешнее 
устройство или в программный синтезатор Microsoft GS Wavetable Synth. 
Секция Receives: для каждого посыла (источника) трека есть трек-получатель (адресат). Обратите внимание, 
что при создании посыла, он сопровождается контроллерами громкости и панорамирования, которые могут 
использоваться для управления посылом. Вы можете также определить, какой тип сигнала следует направить - 
аудио, MIDI, или оба. Всякий раз, когда вы выбираете любой из перечисленных треков, в качестве 
маршрутизации трека будут использоваться выходные порты аудио или MIDI устройства, а такие контроллеры, 
как громкость и панорама будут добавлены автоматически. При создании нового проекта, по умолчанию 
выходной сигнал каждого нового трека направляется в мастер-трек и оттуда направляется на выходной порт 
вашей аудиокарты. Если это все, что вам нужно, нет необходимости подробнее изучать опции маршрутизации 
именно сейчас. Однако, понимание возможностей маршрутизации REAPER почти наверняка позволит вам на 
определенной стадии извлечь максимальную пользу из программы. На рисунке ниже изображен пример окна 
маршрутизации трека, для которого были созданы и посыл и адресат. Как это сделать вы вскоре увидите далее 
в этом руководстве, начиная с Главы 5. Более сложные примеры маршрутизации вы увидите в других местах 
этого руководства пользователя, особенно в Главе 17.  
 

 
 

Примечание: источники и адресаты могут быть трех типов - Post Fader (Post Pan), Pre-Fader (Post FX) 
и Pre FX. Различия между ними будут подробно обсуждаться в Главе 18. Тем временем, если вы не 
уверены в выборе, оставьте опцию по умолчанию - Post-Fader (Post Pan). 
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2.26. Матрица маршрутизации (The Routing Matrix) 
 

Матрица маршрутизации 
(Routing Matrix) REAPER - это 
место, где вы можете управлять 
и перестраивать всю структуру 
маршрутизации проекта, 
например, добавлять и удалять 
посылы и адресаты, а также 
управлять их громкостью и 
панорамой. Чтобы отобразить 
матрицу маршрутизации нажмите 
Alt+R. На примере проекта All 
Through The Night with Bus 
обратите внимание на ячейку, где 
ряд Gtr Body пересекается с 
колонкой FX Bus. Эта ячейка 
содержит две маленькие капли.  
Щелчок правой кнопкой мыши на 

ячейке отображает контроллеры, определяющие направление сигнала с трека Gtr Body в шину эффектов (окно 
Controls for track 2 «Gtr Body») 
. 
2.26.1. Оптимизация окна матрицы маршрутизации 
 
Если ваша звуковая карта поддерживает мультиканальную систему, то по умолчанию, матрица маршрутизации 
отобразит несколько вариаций пар выходных портов, включая те, в которых вы не нуждаетесь. По умолчанию 
REAPER позволяет использовать любые два последовательно пронумерованных выходных аудиопортов в 
качестве стереопары. Весьма вероятно, что вы будете использовать, например, выходные порты 1 и 2 в 
качестве одной пары (например, для выхода на динамики) и выходные порты 3 и 4 в качестве другой пары 
(например, для наушников). Согласитесь, что было бы нелогично использовать выходные порты 2 и 3 в качестве 
пары. Можно воспрепятствовать отображению подобных нежелательных комбинаций. Для этого перейдите 
Options > Preferences > Audio > Channel naming и отметьте опцию Show non-standard stereo channel pairs. 
 

2.27. Прикрепление на панель Docker и отстыковка в плавающее окно 
 
Слишком много открытых окон на экране создает ощущение беспорядка. В этом случае может оказаться 
полезной панель Docker. Щелчок правой кнопкой мыши на заголовке окна или на заднем плане большинства 
окон открывает контекстное меню с опциями управления этим окном. Помимо прочих здесь присутствует и 
опция Dock in Docker (прикрепить окно на панель Docker).  

 
Когда на панель Docker прикрепляются несколько окон, они образуют 
вкладки, которые используются для открытия/скрытия этих окон.  

 
Заметьте, что: 
 
- если вы закрываете окно, в следующий раз, когда вы его открываете, статус прикрепления этого окна будет 
тем же самым, что и при его закрытии. 
- чтобы открепить окно, щелкните правой кнопкой мыши по фоновой области или области вкладки окна и 
снимите флажок Dock in Docker. 
 - саму панель Docker можно присоединить к главному окну или открепить в плавающее окно. Чтобы 
присоединить панель Docker к главному окну, щелкните по значку  в нижнем левом углу панели и выберите 
опцию Attach Docker to Main Window.  
 - по умолчанию панель Docker расположена внизу главного окна, но используя то же самое меню можно 
расположить панель на левой стороне (Attached Docker position: left), наверху (Attached Docker position: top) 
или на правой стороне (Attached Docker position: right). 
 - щелчок по значку  после отстыковки панели Docker обеспечивает доступ к функции Set Opacity, которая 
может использоваться для изменения прозрачности панели, когда она будет отстыкована в плавающее окно. 
Доступные значения между 25 % и 100 %. 
 

 
Совет: горячая клавиша Alt +D может использоваться для отображения/скрытия панели Docker. 
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В качестве альтернативы прикрепления окон на панель Docker, можно рассмотреть опцию View > Show/hide all 
floating windows (показать/скрыть все плавающие окна) которая также помогает справиться с беспорядком на 
экране. Обратите внимание также на опцию View > Cascade all floating windows (расположить все плавающие 
окна каскадом). 
 

2.28. Окно истории Undo 
 
Функция Undo (отмена последнего действия) в REAPER удобна и эффективна. Команда View > Undo History 
(Ctrl+Alt+Z) открывает/закрывает окно истории функции Undo (Undo History).  
 

 
 
Двойной щелчок на любом событии в этом окне возвращает проект к этой точке. Страница предварительных 
параметров Options > Preferences > General включает секцию Undo Settings с опциями поведения истории 
Undo.  
 
В частности, вы можете: 

 
- определить максимальный объем 
памяти, выделенный для функции 
Undo (Maximum undo memory use).  
Значение 0 фактически отключает эту 
опцию. 
- определить какие элементы будут 
включены в историю (Include 
selection): клипы, треки, узлы 

огибающих и/или выделенная область и/или изменения указателя текущей позиции: 
- сделать так, что в случае заполнения выделенного участка памяти для этой функции, в истории будут 
сохранены только самые последние действия (When approaching full undo memory, keep newest undo states). 
- сохранить файл истории и гарантировать, что этот файл будет загружаться с проектом (Save undo history with 
project files (in RPP-UNDO file). Это означает, что даже после восстановления проекта в более поздний срок, 
можно будет все еще вернуть проект в более раннее состояние. 
- в пределах окна истории можно сохранить даже определенные последовательности команд и действий, а 
затем переключаться между ними! (Store multiple redo paths when possible (can use a lot of RAM) 
 

Совет: на странице Options > Preferences > Appearance можно активировать/отключить опцию Show 
last undo point in menu bar. Если эта опция отмечена, ваше последнее действие будет отображаться 
после последней команды в строке меню (см. рисунок ниже). Можно щелкнуть по этому элементу в 

любое время, чтобы открыть окно истории Undo. Повторный щелчок закрывает окно. 
 

 
 

Примите во внимание: окно истории можно прикрепить на панель Docker. Для этого (как в случае с 
большинством других окон), щелкните правой кнопкой мыши по заголовку окна и выберите опцию Dock 
in Docker из контекстного меню. 

 
2.29. Меню вызываемые щелчком правой кнопкой мыши 

 
Вскоре вы обнаружите, что зачастую для вызова команды в REAPER доступно несколько способов REAPER - 
например, из главного меню, с помощью горячей клавиши, или щелчком по ярлыку панели инструментов. Какой 
способ вы будете использовать, является в основном вопросом предустановок. В качестве совета, если Вы не 
уверены в выборе, можно щелкнуть правой кнопкой мыши по клипу или области с которой вы работаете, чтобы 
отобразить контекстное меню команд и действий, относящихся к этому клипу или области. Например, вы 
можете щелкнуть правой кнопкой мыши по клипу, панели управления трека, транспортной панели, шкале 
времени, и так далее. 
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2.30. Управление несколькими вкладками проектов 
 
REAPER может хранить открытыми несколько проектов одновременно, используя вкладки проектов. Это 
облегчает переход между различными проектами или перемещение/копирование клипов с одного проекта в 
другой. Чтобы создать новую вкладку проекта, в то время, когда у вас уже есть один открытый проект, 
перейдите File > New Project Tab (Ctrl+Alt+N). Добавится новая вкладка, маркированная Unsaved, а 
предыдущий проект также останется открытым на другой вкладке. Чтобы переключиться между проектами, 
щелкните по соответствующей вкладке. Чтобы открыть проект в определенной вкладке, выберите эту вкладку, а 
затем используйте опцию File > Open Project как обычно. Чтобы открыть проект в новой вкладке, выберите 
опцию File > Open Project при открытии проекта. Количество открытых проектов неограниченно. Щелчок правой 
кнопкой мыши по любой вкладке проекта открывает контекстное меню с опциями:  

 
New project tab (создать новую вкладку). 
Close project (закрыть текущий проект и его 
вкладку). То же самое можно сделать щелчком 
по кнопке  на левой стороне вкладки. 
Close all projects but current (закрыть все 
вкладки кроме текущей). 
Close all projects (закрыть все открытые 
проекты). 
Always show project tabs (отобразить 
вкладки проекта, даже если в настоящее 
время открыт только один проект) (опция 
переключаема - т.е. меняет состояние с 
каждым щелчком). 
Show project tabs on left side of window 
(отобразить вкладки на левой стороне окна). 
Опция переключаема. 
Hide background project FX/MIDI windows: 
гарантирует, что, когда выбирается одна из 
нескольких открытых вкладок проекта, любые 
открытые окна эффектов, и т.д. 

принадлежащие другим открытым проектам скрываются. 
Run background projects: позволяет воспроизводить проект в одной вкладке, работая над другим проектом. 
Run stopped background projects: запускает воспроизведение проектов в остальных вкладках, кроме 
выбранных в настоящий момент. 
Play stopped background projects with active project: принуждает фоновые проекты (открытые в других 
вкладках) воспроизводиться с текущим проектом. Если эта опция активирована, можно выбрать опцию 
Synchronize play start times w/play background, которая гарантирует, что все открытые проекты будут 
воспроизводиться/останавливаться синхронно. Эти команды и команда Offline background project media 
являются взаимоисключающими. 
Force project tabs visible when monitoring FX in use (отображать вкладки, когда активно окно мониторинга 
эффектов) 
Monitoring FX: открывает одноименное окно с опциями мониторинга аппаратных выходных портов: см. Главу 6. 

 
Совет: вкладки проектов можно менять местами.  
 
Примите во внимание: маленькую кнопку , которая по обыкновению закрывает вкладку проекта и 
расположена на левой стороне вкладки, можно поместить на правую сторону вкладки и обратно: просто 
перетащите ее в нужном направлении. 

 
2.31. Открытие одновременно нескольких вкладок проектов 

 
Можно открыть несколько проектов сразу, каждый в его собственной вкладке, при условии, что все RPP файлы 
находятся в одной папке. Просто используйте команду File > Open project, а затем перейдите к нужной папке. 
Используйте Ctrl+щелчок для выбора последовательности проектов (опция Open in new project tab в этом 
диалоговом окне должна быть отмечена), а затем нажмите Open. 
 
 

2.32. Управление указателем текущей позиции 
 
По умолчанию, при воспроизведении проекта, щелчок по кнопке Stop (или по клавише Пробел) останавливает 
воспроизведение и возвращает указатель текущей позиции (курсор воспроизведения) в его исходную позицию. 
Щелчок по кнопке Pause (или по клавише Enter) ставит воспроизведение на паузу в текущей позиции курсора. 
Можно сделать так, чтобы указатель текущей позиции перемещался в позицию щелчка по шкале времени, по 
пустой области любого трека или по пустой области ниже треков. Эти три опции можно активировать/отключить 
в секции Seek playback when clicked (Options > Preferences > Audio > Seeking). 
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3. Запись аудио и MIDI в REAPER 
 
В данной главе мы рассмотрим все аспекты записи в REAPER.  
 

3.1. Создание нового проекта 
 
Чтобы создать новый проект, перейдите File > New Project (Ctrl+N). Диалоговое окно Options > Preferences > 
Project может использоваться для определения поведения REAPER при создании нового проекта.  
 

 
 
Среди прочего вы можете: 
 
- использовать любой проект в качестве шаблона для новых проектов. Все треки, эффекты, шины, 
маршрутизация и т.д. будут скопированы в новый файл с этого файла-шаблона (опция When creating new 
projects, use the following project file as a template) 
- если отмечена опция Prompt to save on new project, при создании нового проекта сразу же поступит запрос на 
его сохранение. 
- если отмечена опция Open properties on new project, при создании нового проекта будет всплывать окно 
свойств проекта (Project Settings), которое можно использовать для выбора формата записи и настройки других 
параметров проекта. 
- автоматически создавать резервную копию при каждом сохранении и перезаписи файла проекта (When 
overwriting project file, rename old project to rpp-bak). 
- автоматически сохранять файл проекта в файл с временными метками (timestamped file) в папку с проектом 
(Save to timestamped file in project directory) или в любую другую папку (Save to timestamped file in additional 
directory). Это поможет защитить вас от последствий таких непредвиденных обстоятельств, как отключение 
электричества или компьютерный сбой. Можно также определить интервал автоматического сохранения (в 
минутах), которое будет происходить тогда, когда не производится запись (when not recording), когда 
остановлена запись (when stopped), или в любое время (any time). 
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3.2. Параметры проекта 
 
После создания проекта можно открыть окно Project Settings (Alt+Enter) и отредактировать параметры проекта.  
 

 
 
Например, выбрать формат для записи (Media>Recording>Audio format for media recordings). Если вы не 
уверены в выборе формата, для СD качества выберите формат WAV, с параметрами как на рисунке ниже.  
 

 
 
Как правило, предпочтительнее значение битрейта для записи - 24 bit. Если необходимо сделать запись в DVD 
формат, а не в CD формат, выберите частоту дискретизации (Project sample rate) 48000 вместо 44100 на 
одноименной вкладке диалогового окна Project Settings. Некоторые пользователи предпочитают частоту 
дискретизации 88200 для CD качества и 96000 для DVD качества. Однако помните, что увеличение частоты 
дискретизации увеличивает и размер файла и замедляет его обработку. Если впоследствии вы захотите 
использовать другой формат (например, MP3), можно сконвертировать ваши файлы в этот формат.  
Можно сделать запись в любом доступном сжатом формате, включая MP3, OGG и WavPack. Выбор любого из 
этих форматов открывает доступ к дополнительным опциям, соответствующим выбранному формату. 
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3.3. Сохранение проекта 
 
Чтобы сохранить проект перейдите File > Save Project (Ctrl+S) и в стандартном диалоговом окне сохранения 
дайте проекту имя. При сохранении нового файла обратите внимание на дополнительные опции внизу окна:  
 

 
 
Create subdirectory for project (создать подпапку для проекта).  
- если отмечена опция Copy all media into project directory (скопировать все клипы в папку с проектом) 
становятся доступными дополнительные опции выбора формата для этих конвертируемых клипов.  
- если отмечена опция Move all media into project directory (переместить все клипы в папку с проектом), то 
по умолчанию все медиафайлы, используемые проектом, будут перемещены в подпапку в директории проекта.  
- если отмечена опция Copy rather than move source media if not in old project media path в случае, если ваш 
проект использует файлы из библиотеки сэмплов, эта опция гарантирует, что сэмплы из библиотеки удалены не 
будут. 
 

3.4. Создание и переименование треков 
 
После создания нового проекта вероятнее всего следующим вашим шагом будет создание трека или нескольких 
треков. Количество создаваемых треков неограниченно. Чтобы добавить трек (и), перейдите Track > Insert New 
Track (Ctrl+T). Альтернативно, можно просто дважды щелкнуть в любом свободном месте панели треков. 
Желательно именовать треки перед началом записи, дважды щелкнув в области имени трека. При записи 
созданному клипу присваивается удобное имя, соответствующее имени трека. Перейдите Options > 
Preferences > Audio > Recording и используя опцию Filename format for recorded files выберите элементы, 

которые будут автоматически включены в имена файлов трека, нажав кнопку . Возможны любые 
комбинации. Подробнее параметры записи мы обсудим позже в этой главе. REAPER поддерживает также и 
мультитрековую запись. Количество одновременных источников записи ограничивается только количеством 
активированных входных портов (Options > Preferences > Audio> Device > Input Channels) вашей аудиокарты.  
 
Прежде, чем начать запись, для каждого трека необходимо: 
 
- активировать его для записи; 
- назначить входной порт; 
- отрегулировать уровень входного сигнала. 
 
Дополнительно: 
 
- выбрать формат записи; 
- активировать мониторинг входного сигнала. 
 

Примечание: при создании трека необязательно определять будет ли он монотреком или стереотреком. 
При назначении входного порта трека, можно использовать либо один входной монопорт, либо 
стереопару портов. Примите во внимание, что панорамируются как стерео, так и монотреки. Тема 

панорамирования подробно освещается в Главе 5. 
 

3.5. Подготовка и запись на один трек 
 
1. Перейдите в меню Options и убедитесь, что выбран режим записи Record mode: Normal. Другие режимы мы 
обсудим позже в этой главе. 

 
2. Нажмите кнопку Record Arm этого трека (слева), которая подсветится 
красным цветом. 
 
 
 

3. Нажмите кнопку Input этого трека (ниже фейдера панорамирования) и выберите нужный входной порт из 
меню. Точные опции этого меню будут зависеть от возможностей и конфигурации вашей аудиокарты или 
аудиоустройства. 
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4. Отметьте опцию Monitor Input (первый 
элемент контекстного меню кнопки Record arm), 

или нажмите кнопку Record monitoring .  
 
 

Местоположение кнопки Record monitoring может меняться в зависимости от расположения элементов 
интерфейса и ширины панели треков. Если ваша звуковая карта поддерживает прямой мониторинг (direct 
monitoring), вероятнее всего вы будете использовать именно этот тип мониторинга (обратитесь за 
информацией к документации вашей звуковой карты). Если ваша звуковая карта не поддерживает прямой 
мониторинг, необходимо активировать мониторинг входного сигнала в REAPER. Подробнее о мониторинге 
входного сигнала в Параграфе 3.14 и Параграфе 3.15. 
5. Установите громкость аудиоустройства на максимум, но исключая клиппирование. Примите во внимание, что 
фейдер громкости трека не управляет уровнем записи, он управляет только уровнем воспроизведения. 

6. Нажмите кнопку Record  на транспортной панели, или нажмите Ctrl+R. 
7. Чтобы остановить запись, либо:  

- нажмите кнопку Stop  на транспортной панели 
- нажмите клавишу Пробел на клавиатуре  

- нажмите кнопку  еще раз  
- нажмите Ctrl+R.  

- нажмите кнопку Record Arm , чтобы деактивировать запись трека. 
 

Совет: меню Input включает опцию Input: None, которая может использоваться для предотвращения от 
случайной записи на трек. 
 

 
Примечание 1: если вы остановили запись, нажав кнопку Record или Ctrl+R, записанный клип 
сохранится автоматически. Если вы нажали клавишу Пробел или кнопку Stop, появится диалоговое окно 
с опциями сохранения или удаления любых новых записанных клипов. 

 

 
 

Примечание 2: REAPER поддерживает функцию "записи на лету”. Это означает, что после того, как 
запись началась можно активировать дополнительные треки. Запись на эти треки начнется с момента их 
активирования. Точно так же, если вы записываете на несколько треков, можно остановить запись 

одного трека, продолжая запись остальных щелчком по кнопке Record Arm этого трека. 
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Совет: страница Options> Preferences> Track/Send Defaults может использоваться для настройки 
записи по умолчанию для будущих треков и проектов, включая активирование мониторинга входного 
сигнала и выбор входных поров по умолчанию. Подробнее в Главе 22. 

 
Совет: при записи убедитесь, что поступающий сигнал не слишком громкий. В противном случяае можно 
повредить аппаратуру.  
 

3.6. Подготовка и запись нескольких треков 
 
Чтобы подготовить несколько треков для записи можно было бы повторить все необходимые шаги, описанные 
выше несколько раз, но согласитесь, это утомительно и кроме того, слишком легко ошибиться с выбором портов 
- получить один записанный входной сигнал несколько раз, а остальные сигналы случайно пропустить. Чтобы 
избежать подобных сценариев, выполните следующее: 
 

1. Перейдите Insert > Multiple tracks и в диалоговом окне Insert tracks 
выберите нужное количество треков (Insert how many tracks). Здесь же 
можно определить будут ли они вставлены после последнего трека, к 
которому вы обратились (After the last touched track) или после всех 
треков (At end of project). Дайте имя новым трекам (Named) и нажмите 
OK. 
 
 
 
 
 
 

2. Выберите треки для записи (Ctrl+щелчок). Нажмите кнопку Record Arm любого из выбранных треков, чтобы 
активировать для записи все выбранные треки. 
 

3. Один из способов использования матрицы маршрутизации 
(Routing Matrix) (Alt+R): в данном примере (на рисунке слева), 
необходимо записать четыре трека одновременно. По умолчанию, все 
четыре трека сначала назначаются на первый входной порт. Если бы в 
этой ситуации вы начали запись, один и тот же сигнал с первого входного 
порта был бы записан четыре раза! Заметьте также, что по умолчанию, 
входной порт 1 также назначен на трек 5 - шину эффектов (FX Bus) - но 
поскольку шина не активирована, запись на нее выполняться не будет. 
 
 
 
 
 
 
 
 
 
 
 
 
4. Щелкните по соответствующим ячейкам матрицы, чтобы назначить 
входной порт. На рисунке слева порт Input 1 назначен на трек 1 (Vox), 
порт Input 2 назначен на трек 2 (Gtr Body) и так далее. Можно также 
выбрать входные MIDI порты - они перечислены ниже аудиопортов. 
Можно также щелкнуть правой кнопкой мыши по любой красной ячейке, 
чтобы получить доступ к меню с опциями записи. 
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3.6.1. Использование панели треков для подготовки к записи нескольких треков 
 
Для конфигурации и записи нескольких треков можно использовать панель треков: 
 
1. Чтобы назначить одинаковые параметры записи для нескольких треков, выберите треки, щелкните правой 
кнопкой мыши по кнопке Record Arm любого из выбранных треков, а затем выберите нужную опцию из меню. 
Если при этом удерживать клавишу Shift, выбор опций в меню затронет только этот трек. Входные порты можно 
назначить на несколько треков схожим способом нажатием кнопки Input. 
2. Чтобы назначить последовательную серию входных монопортов на последовательную серию треков, 
выберите треки, затем нажмите кнопку Input любого из выбранных треков. Отметьте опцию Assign inputs 
sequentially и выберите нужные входные порты - например, в вышеупомянутом примере (на рисунке выше), это 
порты Mono, Input 1- Input 4. 
3. Чтобы вставить новый трек в конце проекта, можно просто дважды щелкнуть в области панели треков ниже 
последнего трека. 
 

3.7. Автоматическое активирование треков для записи 
 
Можно сделать так, чтобы при выборе трека (щелчком на нем) он автоматически активировался для записи, а 
при выборе другого трека предыдущий трек деактивировался. Выберите трек (и), щелкните правой кнопкой 
мыши по кнопке Record Arm любого выделенного трека и выберите переключаемую опцию Automatic record 
arm when track selected. Чтобы все треки в проекте активировались автоматически, перейдите Track > Set all 
tracks to automatic record arm when selected. 
 

3.8. Использование метронома 
 
Во время записи в REAPER можно активировать Метроном (Metronome) и настроить его параметры. Для этого, 

сначала щелкните правой кнопкой мыши по кнопке Metronome  на панели инструментов, или перейдите 
Options > Metronome/pre-roll > Metronome/preroll settings, чтобы настроить его параметры. Нажмите кнопку 
Metronome или перейдите Options > Metronome/pre-roll > Metronome enabled чтобы активировать/отключить 
метроном. 
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Кнопка I/O: расположена справа от опции Enable Metronome и позволяет направить сигнал метронома на 
выбранное устройство (например, в наушники). Если используются какие-либо эффекты при мониторинге 
входного сигнала, становится доступной опция Play metronome thru Monitor FX (воспроизвести сигнал 
метронома с эффектами). 
Run metronome during playback: активирует метроном во время воспроизведения. 
Count-in before playback: активирует предварительный отсчет перед воспроизведением. 
Run metronome during recording: активирует метроном во время записи. 
Count-in before recording: активирует предварительный отсчет перед записью. 
Count-in length (Measures): определяет количество тактов предварительного отсчета. Если это будет самое 
начало проекта, будет отсчитано установленное количество тактов перед началом записи. 
Primary beat volume: громкость основной (первой) доли метронома. 
Secondary beat gain: громкость вторичных долей метронома. 
Beat pattern: можно оставить паттерн метронома по умолчанию - AABB - или назначить ваш собственный.  
В качестве звуков метронома можно использовать ваши собственные сэмплы. 
Primary beat sample: сэмпл для основной доли - например, в размере 4/4, этот сэмпл будет соответствовать 
первой доле. 
Secondary beat: сэмпл для вторичных долей. Например, в размере 4/4, этот сэмпл будет соответствовать 
второй, третьей и четвертой долям. Чтобы использовать ваши собственные сэмплы для метронома во всех 
проектах, необходимо выбрать эти сэмплы, сохранить проект без треков, а затем перейти Options > 
Preferences > Project и отметив опцию When creating new projects, use the following project file as a template 
и определить сохраненный проект в качестве шаблона по умолчанию для использования во всех новых 
проектах. По умолчанию, REAPER использует синтезируемый метроном. Можно определить частоту долей в 
герцах - Frequency of first beat (частота основной доли) и Frequency of Subsequent beats (частота 
вторичных долей). 
Beat click length xx ms: продолжительность щелчка каждой доли в миллисекундах. 
Start shape: острота (громкость) атаки щелчка.  
 
Параметры секции Pre roll могут использоваться для определения количества тактов, которые будет 
воспроизводить метроном перед фактической записью или воспроизведением. 
Опция Recording during audio pre-roll: чтобы сделать запись аудио во время предварительного отчета 
метронома, сначала необходимо отметить опцию Preferences > Recording > Recording audio during pre-roll. 
Затем в окне Options > Metronome/pre-roll settings отметить опцию Enable metronome и опции Run 
metronome during recording и Pre-roll before recording. После окончания записи, захватите левый край 
записанного клипа и перетащите край влево, чтобы отобразить записанное. 

 
Совет: Временные параметры метронома можно выбрать в окне свойств проекта. Чтобы открыть окно 
используйте горячую клавишу Alt+Enter. 
 

3.9. Запись стереотреков 
 
Можно сделать запись с двух входных портов напрямую на стереотрек, например, если вы загрузили ранее 
записанный материал в REAPER, или записываете стереопару микрофонов. Следуйте за процедурой в 
Параграфе 3.5 и выберите входной стереопорт вместо монопорта.  
 

 
 
Сигнал с пары входных стереопортов можно записать в один стереоклипа на одном треке. Как было объяснено 
в Главе 2, рекомендуется на странице конфигурации аудиопараметров деактивировать опцию Show Non-
Standard Stereo Channel Pairs. Это сократит количество стереопар входных портов до более логического 
выбора. 
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3.10. Мультиканальная запись 
 
Это достаточно продвинутая тема, не для новичков. Если вы определите трек в качестве мультиканального 
(например, с 4, 6 или 8 каналами), контекстное меню входного порта для этого трека будет включать опцию 
многоканальной записи.  
 

 
 
Можно, например, записать четыре, шесть или восемь микрофонов одновременно, и каждый на отдельный 
канал и все на одном треке. Подобный метод используется для четырехканальной записи микрофонов в 
процессе записи в формате surround. Для мультиканальных треков в контекстном меню кнопки Record Arm 
доступна переключаемая опция Track VU meter > Show peaks from all track channels (not just 1+2) (показать 
пиковые уровни всех каналов трека). 
 

3.11. Шаблоны трека 
 
После подготовки трека (треков) для записи, этот трек можно использовать в качестве шаблона для всех 
последующих новых треков.  
 
Чтобы создать шаблон трека на основе текущего трека (или нескольких выделенных треков): 
 
1. Выберите трек или треки. 
2. Перейдите Track > Save tracks as track template. 
 

 
 
3. При поступлении соответствующего запроса (на рисунке выше), введите имя шаблона. Если отмечена опция 
Include track items in the template, в шаблон будут включены все клипы, присутствующие на треке. Можно 
также отметить опцию Include envelopes in template (включить в шаблон огибающие). Подробнее тема 
огибающих будет обсуждаться в Главе 18. 
4. По окончании нажмите Save. 
 
Чтобы импортировать текущий шаблон трека в проект: 
 
1. Перейдите Track > Insert track from template. 
2. В зависимости от того, как хранятся ваши шаблоны, либо выберите нужный шаблон из меню, либо выберите 
Open template, а затем выберите нужный шаблон и нажмите кнопку Open. Подменю Insert track from template 
включает опцию Offset template items by edit cursor. Если она отмечена, любые клипы и/или огибающие, 
сохраненные с оригинальным шаблоном, будут вставлены в позицию курсора редактирования. 
 

Примечание: в шаблоне также сохраняются свойства и параметры трека, включая его имя, 
конфигурацию входных и выходных портов, любые плагины эффектов (с любыми их параметрами, 
модуляциями и контроллерами трека), посылы и адресаты. Однако, если трек, включенный в шаблон, 

будет включать какие-либо посылы или будет получать посылы с какого-либо трека или треков, не включенных 
в шаблон, эти посылы и адресаты сохранены в шаблон трека не будут. 
 

Совет: чтобы найти местоположение шаблонов трека, перейдите Options > Show REAPER resource 
path (см. Главу 1). Здесь же можно создать подпапки в пределах папки TrackTemplates для хранения 
ваших собственных шаблонов трека. Ваши подпапки и их содержимое автоматически отображается в 

подменю Insert track from template. 
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3.12. Импорт проекта в текущий проект 
 
Команда Track > Insert Track from Template > Open Template может использоваться для импорта проекта 
REAPER в ваш текущий проект. При этом будут импортированы все элементы оригинального проекта - треки и 
их параметры, клипы, эффекты, маршрутизация, и т.д. Однако, не специфичные для трека элементы (например, 
маркеры) импортированы не будут. Выберите в качестве типа файла Project Files в диалоговом окне Open 
Track Template, перейдите к файлу, который вы хотите импортировать и нажмите кнопку Open. Треки 
импортируемого проекта будут вставлены после текущих выбранных треков. 
 

3.13. Шаблон проекта 
 
Шаблон проекта - это дальнейшее развитие шаблона трека в плане создания проекта целиком, основываясь 
на структуре и параметрах файла шаблона. Например, параметры проекта (включая параметры клипов) 
сохраняется с шаблоном проекта наряду с компоновкой элементов интерфейса, открытыми окнами с их 
размерами, параметрами пристыковки на панель Docker и т.д. Однако, в отличие от процесса создания 
шаблона трека, здесь необходимо сначала удалить медиаклипы перед сохранением проекта в шаблон, иначе 
каждый раз при использовании этого шаблона для создания нового проекта, эти элементы будут автоматически 
вставлены в проект. Если, конечно, эти медиаклипы вы не хотите видеть в шаблоне специально. 
 
Чтобы создать шаблон проекта на основе текущего открытого проекта, перейдите File > Project 
Templates > Save As Project Template. В диалоговом окне дайте шаблону имя и нажмите кнопку Save. 
Чтобы создать новый файл, основанный на шаблоне проекта, перейдите File > Project Templates, а затем 
выберите нужный шаблон. 
Чтобы использовать текущий проект в качестве шаблона для всех новых проектов: 
 
1. Перейдите Options > Preferences > Project. 
2. Нажмите кнопку Browse опции When creating new projects, use the following file as a template. 
3. Выберите нужный файл в папке шаблонов, а затем нажмите кнопку Open. 
4. Нажмите кнопку OK, чтобы закрыть окно Preferences. 
 

3.14. Запись наслоением (layering recording) 
 
Термин layering (наслоение) относится к способу записи, при котором два или более инструмента и/или голоса 
записываются для одной песни, но не одновременно. Треки могут быть записаны по одному. Для начала 
монтируется начальный трек т.е. трек-ориентир, который к концу записи обычно удаляется. Затем каждый 
следующий трек записывается музыкантом или исполнителем, который слышит через наушники микс своего 
голоса/инструмента+сигнал с трека-ориентира. Чтобы использовать запись наслоением: 
 
1. Установите режим записи в Normal и запишите трек-ориентир. 
2. После записи, убедитесь, что выходной сигнал с этого трека направлен в мастер-канал. Убедитесь также, что 
трек-ориентир деактивирован. 
3. Убедитесь, что сигнал с мастер-канала направлен на аппаратный выходной порт, куда подсоединены 
наушники. 
4. Добавьте следующий трек и дайте ему имя. Активируйте этот трек для записи. Выберите входной порт, 
используемый микрофоном или линейный вход, который будет использоваться для записи нового трека. 
5. Убедитесь, что выбрана опция Record: input (audio or MIDI) и активирована функция Input Monitoring этого 
трека (см. выше). Это позволит исполнителю и звукорежиссеру слышать в наушниках микс трека-ориентира с 
новым материалом. 
6. Отрегулируйте уровни ранее записанного трека (используя фейдер трека) и уровень поступающего сигнала 
(используя аппаратный микшер или аудиоустройство). 
7. Нажмите Ctrl+R, чтобы начать запись, и повторно нажмите Ctrl+R чтобы остановить запись. Опять же, по 
окончании записи деактивируйте трек. 
8. Повторите эту процедуру для всех остальных треков. В шаге 6 можно направить в мастер-канала микс всех 
ранее записанных треков до этого момента. 
 

Примечание: если вы заметили эхоподобную задержку в наушниках, это может быть следствием 
завышенного времени ожидания. Понижение значения параметра block size (см. Параграф 1.12) до 
значения 256 или 128 может улучшить ситуацию. Однако на дешевых встроенных звуковых картах это 

может вызвать щелчки и звуковые отсчеты. Для пользователей Windows эту проблему может решить 
использование драйверов ASIO4ALL. 
 

Совет: большинство звуковых карт, а также USB или Firewire аудиоустройств поставляются с 
программным обеспечением, позволяющим использовать мониторинг входного сигнала с нулевой 
задержкой, особенно в мультиканальных устройствах. Если вы используете такое программное 

обеспечение для мониторинга входного сигнала, необходимо отключить мониторинг входного сигнала в 
REAPER. 
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Примечание 1: опция Monitor Input (Tape Auto Style) отличается от типичного мониторинга входного 
сигнала тем, что мониторинг осуществляется только тогда, когда останавливается воспроизведение или, 
когда идет запись. Во время воспроизведения вы будете слышать только сигнал с предыдущих 

записанных треков, а не входной сигнал. 
Примечание 2: при мониторинге активированного для записи трека и когда текущий трек использует плагин 
(например, ReaFir), у которого есть задержка, можно активировать опцию Preserve PDC delayed monitoring in 
recorded items в контекстных меню кнопок Arm record и Record monitoring. Эта более продвинутая тема 
будет объяснена более подробно позже в данной главе. 
 

3.15. Запись наложением (overdubbing) и автозапись (punch recording) 
 
Иногда возникает необходимость перезаписать только определенный фрагмент, не затрагивая весь записанный 
материал трека. Для этого можно использовать функцию автозаписи (или запись-вставку) - punch recording. Вы 
должны определить начальную (входную) и конечную (выходную) точки автозаписи, установить указатель 
текущей позиции до начальной точки автозаписи и начать запись. Как только указатель текущей позиции 
достигнет начальной точки, непосредственно начнется сама запись, которая закончится в конечной точке, а 
указатель текущей позиции возвратится в начальную точку. При записи вы будете слышать в наушниках ранее 
записанный материал наряду с любыми другими треками. Эта функция может работать как с аудио, так и с MIDI 
клипами. Тема MIDI будет обсуждаться позже в этой главе при рассмотрении записи зацикленного фрагмента. 
 

3.16. Неразрушающая автозапись 
 
По умолчанию, функция автозаписи не является разрушающей: создается новая копия, не удаляя оригинала. 
Чтобы использовать функцию автозаписи: 
 
1. Перейдите Options > Record mode: time selection auto punch. Вид кнопки записи на транспортной панели 

изменится - . Отключите кнопку Toggle Repeat  на транспортной панели. 
2. Выберите трек и активируйте его для записи. Перейдите в меню Options и убедитесь, что опция Show all 
takes in lanes (when room) не отмечена. Дорожки трека мы рассмотрим кратко. Кроме того, для данного 
примера, убедитесь, что опция Loop points linked to time selection в меню Options также не отмечена. 
3. Убедитесь, что выходной сигнал трека направлен в мастер-канал и активирована функция Input Monitoring. 
4. Убедитесь, что выходной сигнал мастер-канала направлен на аппаратный выходной порт, к которому 
подсоединены наушники. 
5. Щелкните по клипу, чтобы выбрать его. Выделите область на заднем плане области аранжировки (между 
клипами), которая будет перезаписана. 
6. Установите указатель текущей позиции перед начальной точкой автозаписи. Это можно сделать щелчком по 
шкале времени. 
7. Нажмите Ctrl+R. Нажмите Пробел, чтобы остановить запись. Сохраните записанный клип.  
По окончании записи вернитесь в режим записи Normal. После этого ваш трек будет включать два клипа. А что 
же произошло с первоначально записанным фрагментом? Он все еще там, и вы все еще можете его 
использовать. Нажмите Ctrl+L для переключения отображения всех копий или только активной копии. Вскоре вы 
узнаете об этом подробнее. 
 

 
 

Примечание: если отмечена опция Monitor track media when recording items в контекстных меню 
кнопок Arm record и Record monitoring, при автозаписи, скажем, гитары или вокала, вы будете 
слышать текущую запись и новый материал до начала автозаписи, а в процессе автозаписи только 

новый материал.  Если активирована опция Monitor Input (tape auto style) в тех же контекстных меню, до 
автозаписи вы услышите только предыдущий материал, а в процессе автозаписи только новый материал. 
 

Совет: если при записи наложением вы допустили ошибку или передумали, можно использовать 
горячие клавиши Ctrl+Z для отмены действия, или выбрать ненужный клип и нажать клавишу Delete 
чтобы удалить его. Понимание различных режимов записи REAPER и в особенности как они работают в 

комбинации с другими опциями (такими как мониторинг входного сигнала) может сбить с толку новичков. Глава 
25 включает сводную таблицу «Решение проблем с режимами записи и мониторингом». 
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3.17. Разрушающая автозапись 
 
Доступна также опция разрушающей автозаписи - т.е. фактического удаления при автозаписи ранее 
записанного материала - Options > New recording that overlaps existing media items > Trims existing items 
behind new recording. Используйте эту опцию с осторожностью! Эту опцию можно реверсировать, выбирав 
команду Splits existing items and creates new takes из того же меню. 
 

3.18. Фейдинг и кроссфейдинг 
 

В REAPER доступна функция автоматического 
кроссфейдинга (перекрестное наложение кривой 
затухания и кривой возрастания сигнала) и 
автоматического фейдинга (кривые затухания и 
нарастания) записанных клипов. Эти функции 
можно активировать/отключить/настроить на 

странице Options > Preferences > Project> Media Item Defaults. Активируются они опцией Create automatic 
fade-in/fade-out for new items, length. 
 

Щелчком по изображению кривых можно выбрать тип кривой фейдинга (Default fade-in/fade-
out shape) и кроссфейдинга (Default crossfade shape), а также их продолжительность.  
 
 
 
 
 
 
 
 
 

 
Как вы увидите в Главе 7, можно легко изменить тип фейдинга по умолчанию и/или его продолжительность для 
отдельных клипов. Если вы не хотите использовать автоматический фейдинг/кроссфейдинг, просто не 
отмечайте опцию Create automatic fade-in/fade-out for new items. 
 

3.19. Запись нескольких копий 
 
Функция записи нескольких копий REAPER может помочь в том случае, когда вы хотите записать несколько 
версий трека и выбрать наиболее удачную. Для этого: 
 
1. Установите режим записи в Normal. 
2. Убедитесь, что опция Enable track free item positioning (FIPM) в контекстном меню панели треков для 
записываемых треков не отмечена. Опцию FIPM мы рассмотрим позже в этой главе. 
3. Запишите первую копию трека. 
4. Переместитесь в начало и запишите следующие копии нужное количество раз. 
 

 
 
На примере выше, был записан вокальный трек, затем были сделаны три копии трека с бэк вокалом. Обратите 
внимание на текстовую метку в названиях клипов трека Harmony Vox - Take 3/3 (третья копия из доступных 
трех). 
 

Примечание: на странице Options > Preferences > Appearance > Peaks/Waveforms доступна опция 
Automatically color any recording pass that adds new takes to existing items (автоматически окрашивать 
новые копии, добавленные к текущему клипу). При записи нескольких копий на двух или более треков 

одновременно, активирование этой опции может помочь визуально идентифицировать записанные копии. 
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3.20. Отображение копий на дорожках треков 
 
Когда вы записали несколько копий, их можно отобразить на дорожке трека. Это, конечно, займет определенное 
пространство экрана, но поможет визуально идентифицировать копии на различных треках. Чтобы 
активировать/отключить эту опцию, перейдите Options> Show all takes in lanes (when room) (Ctrl+L).  
 

 
 
В первом примере (на рисунке выше), сделаны три копии вокального дуэта. Первая и вторая - полные копии, 
третья копия сделана при помощи автозаписи только среднего фрагмента. В данном случае, опция Display 
empty take lanes (меню Options > Take lane behavior) была отмечена, гарантируя, что короткий добавленный 
фрагмент помещен на его собственную дорожку. Это облегчает визуальное отслеживание копий. Для обоих 
треков выделена вторая копия (за исключением добавленного фрагмента), которая и будет воспроизводиться.  
 

 
 
Во втором примере (рисунок выше) на разных треках были выделены разные копии.  
 

 
 
На третьем рисунке (выше) высота трека была сокращена так, чтобы была видна только выбранная копия. 
Однако, пока опция Show All Takes in Lanes остается отмеченной, дорожки трека будут восстанавливаться 
автоматически. 
 

3.21. Использование цветной маркировки копий 
 
Опция Item > Item and take colors обеспечивает множество интересных способов использования цветной 
маркировки при работе с копиями и клипами. Подробнее эту тему мы рассмотрим в Главе 7, а пока обратите 
внимание на опцию Set active takes to one random color (окрасить активные копии в один случайный цвет). 
Если вы выделили несколько копий какого-либо трека и дважды щелкнули по этому треку на панели треков, все 
клипы этого трека будут выделены. Активирование опции Set active take to one random color сделает так, как 
показано на рисунке ниже, при условии, что опция Show take color будет отмечена на странице Options > 
Preferences > Appearance > Peaks/Waveforms. 
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3.22. Работа с несколькими копиями 
 
Если клип включает несколько копий, можно щелкнуть правой кнопкой мыши по любой копии и использовать 
подменю Take для управления несколькими копиями.  
 

 
 
Подменю Take довольно обширно - подробнее мы обсудим большинство его опций в Главе 8. На данный 
момент, обратите внимание на следующие три опции, особенно если ваши копии не отображаются на дорожках 
трека. 
 
Next take (T) (следующая копия). 
Previous take (Shift +T) (предыдущая копия). 
Explode All Takes to New Tracks: создать отдельный трек для каждой копии (см. рисунок ниже). 
 

 
 
Опция Explode All Takes to New Tracks отличается от опции Show All Takes in Lanes тем, что позволяет 
рассмотреть каждую копию отдельно на отдельном треке (как на рисунке выше). Трек Vox Harmony включает 
две копии, которые расположены на собственных дорожках. После размещения этих копий на новые треки мы 
имеем (в дополнение к оригинальному треку), два новых дополнительных трека - каждый трек для каждой из 
копий. 
 

Предостережение: подменю Take включает опции удаления и вырезания активных копий. Рекомендуем 
не использовать их, пока мы не дойдем до Главы 8. В частности, избегайте использования клавиши 
DELETE с выбранными копиями. Есть вероятность, что вы удалите и другие копии, а не только копию, 

которую вы хотите удалить! 
 
Попробуйте! Откройте проект All Through The Night LAYERS.RPP (сохраненный ранее) и добавьте трек с 
вокальной гармонией в этот проект. Используйте этот трек для записи трех копий - тогда сохраните файл. 
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3.23. Запись клипов наложением  
 
Мы уже затрагивали две из трех функций записи наложением в подменю Options > New recording that overlaps 
with existing media: это Splits existing items and create new takes (default) (разделить текущие клипы и создать 
новые копии) и Trims existing items behind new recordings (tape mode) (обрезать текущие клипы за новыми 
записанными). Третья опция - Create new media items in separate lanes (layers) (создать новые клипы на 
отдельных дорожках (слоях).  
 

 
 

 
 
На первом рисунке (верхний) записан фрагмент трека. На втором рисунке (ниже), мы возвратились к этому треку 
с отмеченной опцией Create new media items in separate lanes (layers) и перезаписали последнюю часть 
вместе с новым материалом. В данном случае, вторая копия - это отдельный клип. Вы можете выбрать, какие из 
этих клипов будут воспроизводиться, а какие нет. Опция Options > Show overlapping media items in lanes 
позволяет отобразить добавленные клипы на дорожках трека. Максимальное количество дорожек трека можно 
установить на странице Options > Preferences > Appearance > Maximum number of lanes, when showing 
overlapping items in lanes. Эта тема будет обсуждаться в Главе 4, Главе 5 и Главе 7. 
 

3.24. Запись нескольких дополнительных клипов 
 
Мы уже обсуждали, как можно использовать REAPER для записи нескольких копий на одном треке. Позже, в 
Главе 8, мы обсудим, как отредактировать их, чтобы оставить лучшие фрагменты с каждой из копий, а затем 
соединить их вместе в одну копию. В качестве альтернативы использования нескольких копий, можно сделать 
запись дополнительных клипов на текущий трек с возможностью наложения. Это пример того, как функция 
свободного позиционирования клипов (FIPM) может обеспечить дополнительную гибкость. По умолчанию, эта 
функция отключена. Чтобы записать дополнительные клипы (но не дополнительные копии) на текущий трек: 
 
1. Установите режим записи в Normal. 
2. Убедитесь, что опция Free Item Positioning (FIPM) в контекстном меню панели этого трека отмечена. 
3. Запишите первый клип. 
4. Поместите указатель текущей позиции в точку, где вы хотите записать второй клип и запишите его. 
5. Повторите Шаг 4 нужное количество раз. 
 

 
 

 
 

 
 
На первом рисунке трек Lead - основной вокальный трек, а трек Vox Harmony трек с бэк-вокалом. На втором 
рисунке опция Free item positioning (FIPM) была отмечена для трека Vox Harmony.  
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Обратите внимание на хэндл под курсором мыши, который может использоваться для регулирования высоты 
этих клипов. На третьем рисунке, второй бэк-вокал записан на треке Vox Harmony с наложением на первый бэк-
вокал. Обратите внимание, что это не альтернативная копия первого бэк-вокала, а дополнительный клип. 
 

3.25. Запись пустых событий 
 
Пустые события (Empty Events) могут быть полезны при записи наслоением или наложением. Если вы точно 
знаете регионы, где начнется и закончится запись, можно определить эти регионы вставкой пустых событий. 
Затем, когда начнется запись, будут записаны только эти регионы, обозначенные пустыми событиями. 
Давайте возьмем пример с уже записанным вокальным треком, где мы хотим записать бэк-вокал только для 
припева: 
 
1. Вставьте новый трек, который будет использоваться для бэк-вокала. В идеале сразу же дайте треку имя. 
2. Активируйте трек для записи. Назначьте входной порт. Активируйте мониторинг этого трека, и убедитесь, что 
выходной сигнал с мастер-канала направлен в наушники. 
3. В меню Options отметьте опцию Record mode: auto punch selected items. Обратите внимание как 

изменилась кнопка записи на транспортной панели - . 
4. Чтобы создать пустое событие, сначала убедитесь, что новый трек выбран, затем выделите область и 
выберите опцию Insert > Empty item. Повторите эту процедуру нужное количество раз. При необходимости 
отрегулируйте начальные и конечные границы пустых клипов. 
 

 
 
5. Выделите нужные события, щелчком по ним с нажатой клавишей Ctrl. Если необходимо изменить позицию 
курсора перед записью, щелкните по шкале времени в нужной точке. Активируйте трек для записи. 
6. Нажмите Ctrl+R, чтобы начать запись. Нажмите Ctrl+R чтобы остановить запись. Сохраните файлы. Пустые 
клипы будут заменены записанным материалом. Деактивируйте трек. 
 

3.26. Запись с предварительно установленными эффектами 
 
Обычно аудиоэффекты добавляются в трек к уже записанному материалу. Мы обсуждали это в Главе 2, а 
подробнее обсудим в Главе 16. Тем не менее REAPER позволяет добавлять эффекты до записи. Используйте 
эту возможность с осторожностью, поскольку, как только эффект будет добавлен к записываемому клипу, его 
потом будет очень сложно удалить/отредактировать. Процедура записи с предварительно установленными 
эффектами следующая: 
 
1. Активируйте трек для записи и выберите входное аудио или MIDI устройство как обычно. 
2. Щелкните правой кнопкой мыши по кнопке Record Arm и выберите опцию Track input FX chain из 
контекстного меню.  
3. В окне Add FX to Track выберите эффект и нажмите кнопку OK. Отрегулируйте параметры этого эффекта. 
4. При необходимости используйте кнопку Add для добавления других эффектов. 
5. Закройте окно эффектов. 
6. При необходимости прослушайте версию с эффектами (см. комментарий ниже), а затем запишите трек как 
обычно. 
 
Эффекты, помещенные в цепочку входного сигнала, потребляют ресурсы компьютера только тогда, когда трек 
активируется для записи, и разрушающе применяются к клипу при записи. Наиболее вероятно, прежде, чем 
сделать запись вы захотите прослушать инструмент или голос с эффектом, чтобы отрегулировать его 
параметры. Для этого, оставьте трек активированным и активируйте мониторинг, а в процессе прослушивания, 
настройте параметры эффекта. Мониторинг входного сигнала объясняется в другой главе данного руководства, 
например, в параграфах, объясняющих запись наслоением и наложением. 
 
 
 
 
 
 
 
 
 
 



 Специально для сайта musicmanuals.ru  67 67 

3.27. Опция Preserve PDC Delayed Monitoring in Recorded Items 
 
Если вы прослушиваете активированный для записи трек с 
любым плагином, у которого присутствует задержка 
(например, ReaFir), то эта задержка будет присутствовать и 
в выходном сигнале. В этом случае вы возможно захотите, 
чтобы записанный звук с выходного порта точно 
соответствовал слышанному при записи. Для этого, 
например, вы могли бы сыграть ноты раньше, чтобы 
компенсировать задержку. С активированной опцией 

Preserve PDC Delayed Monitoring in Recorded Items воспроизведение будет соответствовать вашему 
исполнению, если эта опция не отмечена воспроизведение будет запаздывать. 
 

3.28. Запись выходного сигнала трека 
 
Причин записать выходной сигнал трека много. Один из примеров - запись выходного сигнала с внешнего 
синтезатора непосредственно на аудиотрек в виде сигналограммы. Для этого: 
 
1. Убедитесь, что MIDI клавиатура подключена к компьютеру. 
2. Создайте новый трек, дайте ему имя и активируйте его для записи. Активируйте мониторинг. 
3. Из контекстного меню кнопки Arm record перейдите Record: output, а затем выберите нужную опцию. 
Наиболее вероятно это будет Record: output (mon, latency compensated). 
4. Из контекстного меню кнопки Arm record перейдите Input: MIDI, а затем выберите ваше устройство ввода. 
5. Отрегулируйте нужные параметры (например, параметры синтезатора) при мониторинге. 
6. Начните запись и остановите ее. 
 

3.29. Запись выходного сигнала шины эффектов 
 
Можно записать выходной сигнал и с шины эффектов. Это открывает креативные возможности микширования. 
Например, можно записать выходной сигнал шины ревербератора на аудиотрек в режиме стерео, а затем 
использовать стерео или двухканальное панорамирование для настройки позиционирования этого эффекта в 
вашем миксе. Для этого: 
 
1. Добавьте трек как шину эффектов (FX Bus), выберите его, и активируйте для записи. 
2. Можно определить адресаты (Receives) трека, чтобы получить хороший мощный сигнал - громкость всегда 
можно снизить при воспроизведении позже. 
3. Активируйте мониторинг входного сигнала трека и выберите режим записи. Вероятнее всего, это будет  
Output > Stereo. 
4. Воспроизведите песню и отрегулируйте уровень сигнала. 
5. Поместите указатель текущей позиции в начало и нажмите кнопку Record. 
6. Остановите запись. 
 

3.30. Запись MIDI 
 
Для записи MIDI доступно несколько опций, в зависимости от наличия у вас оборудования и его конфигурации. 
В любом случае принцип одинаков: 
 
- используйте либо виртуальную клавиатуру REAPER, либо MIDI устройство ввода, например, MIDI клавиатуру, 
подключенную ко входному порту MIDI In вашей звуковой карты или другого аудиоустройства. 
- создайте трек (или назначьте текущий) для записи MIDI. 
- назначьте устройство вывода для трека. 
- назначьте канал для MIDI клипа. 
- активируйте мониторинг, чтобы слышать собственное исполнение.  
 
На виртуальной MIDI клавиатуре REAPER можно играть, используя клавиатуру компьютера или мышь. Чтобы 
отобразить виртуальную MIDI клавиатуру, перейдите View > Virtual MIDI Keyboard (Alt +B). 
 
Процедура записи нового MIDI трека: 
 
1. Вставьте новый трек в проект и активируйте его для записи. 
2. Убедитесь, что MIDI клавиатура подключена ко входному MIDI порту вашей звуковой карты или 
аудиоустройства и включена в сеть. В данном примере, мы будем использовать виртуальную MIDI клавиатуру 
REAPER. Щелкните правой кнопкой по любой клавише, которая должна стать центральной (базовой) нотой. 
3. На треке щелкните правой кнопкой мыши по кнопке Arm Record и убедитесь, что опции Monitor Input и 
Record Input отмечены, и что в качестве устройства Input: MIDI выбрано Virtual MIDI Keyboard. Для данного 
примера, выберите опцию All Channels. Эти параметры можно настроить в матрице маршрутизации. 
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4. Убедитесь, что выходной сигнал трека направлен в мастер-канал, а выходной сигнал с мастер-канала 
направлен в выходной порт аудиоустройства, к которому подключены колонки или наушники. 
5. В данном примере мы будем использовать программный синтезатор. Откройте окно эффектов трека и 
вставьте плагин. В данном примере, мы будем использовать VSTi ReaSynth (Cockos), который поставляется с 
REAPER. В настоящее время, оставьте параметры ReaSynth как есть. 
6. Нажмите Ctrl+R, чтобы начать запись. Наиграйте простую мелодию на виртуальной MIDI клавиатуре. 
Используйте мышь, или клавиатуру компьютера - например, клавиши zxcvbvcxz. Нажмите Ctrl+R, чтобы 
остановить запись. При появлении запроса, сохраните клип. В Главе 13 мы увидим, как редактируются MIDI 
данные во встроенном MIDI редакторе. 
 
Процедура воспроизведения MIDI клипа: 
 
Воспроизведите трек. При необходимости при воспроизведении можно настроить параметры синтезатора.  

Нажмите кнопку  в окне эффектов и выберите опцию Save Preset, чтобы сохранить ваши настройки в 
качестве пресета. После этого ваш пресет можно будет загрузить из выпадающего списка Preset в любое 
время. Таким образом можно создать и использовать пресеты для всех плагинов эффектов и синтезаторов. 
 

Примечание: пример выше демонстрирует важное различие между спецификациями MIDI и аудио.  
В случае с аудио записываются фактические звуки инструментов или голоса. Можно использовать такие 
эффекты, как эквалайзер и компрессор для изменения звука аудиоклип при воспроизведении, в то 

время как сам аудиоклип остается не тронутым. В случае с MIDI вы по сути записываете ряд инструкций, 
которые не содержат никакого звука. Музыка создается тогда, когда эти инструкции отсылаются в синтезатор. 
Изменяя параметры синтезатора - или даже меняя синтезатор - мы можем создавать абсолютно разный звук. 
Несмотря на эти различия, как аудио, так и MIDI клипы можно включить в один трек. 
 

Примечание: перед записью можно назначить последовательные входные каналы на несколько MIDI 
треков одним действием. Выделите треки, а затем нажмите кнопку Input любого из них. Из меню 
выберите сначала Assign inputs sequentially, а затем MIDI (sequential inputs or channels). Затем 

выберите MIDI устройство и после этого выберите каналы (например, для четырех треков, возможно каналы 1 - 
4). 
 

3.31. Другие режимы записи MIDI 
 
При записи MIDI, необходимо выбрать один из шести режимов записи. В вышеупомянутом примере мы 
использовали режим Record Input, при котором сохраняются любые текущие события: новый материал будет 
записан в качестве новой копии. Другие четыре из пяти режимов: 
 

 
 
Record MIDI overdub: новые ноты будут добавлены наряду с текущими клипами, оставляя их как есть. 
Record MIDI replace: новые ноты будут заменять текущие. 
Record MIDI touch-replace: текущие MIDI ноты будут заменены любыми новыми нотами, сыгранными на них на 
том же самом канале, что и оригинальный материал. Весь остальной текущий материал останется как есть. 
Record MIDI latch-replace: текущий MIDI материал остается неизменным, пока вы не возьмете первую ноту. 
После этого весь старый материал будет заменен нотами, сыгранными на том же самом канале, что и 
оригинальный материал, пока запись не будет остановлена. 
Record Output > Record: output (MIDI): схож с режимом Record Input, но записывает MIDI сигнал цепочки 
эффектов. Примите во внимание: эти опции могут использоваться при записи выделенной области (см. 
Параграфы с 3.16 до 3.18), и при записи зацикленного фрагмента проекта (см. ниже). 
 

3.32. Запись виртуальных инструментов 
 
Чтобы использовать виртуальный инструмент (VSTi или DXi) для записи MIDI трека, перейдите Insert> Virtual 
instrument on new track или щелкните правой кнопкой мыши по свободной области панели треков и выберите 
эту опцию из контекстного меню. В появившемся списке доступных виртуальных инструментов дважды 
щелкните по нужному элементу. Будет создан трек, который будет активирован для записи, именован и 
откроется интерфейс выбранного инструмента.  
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В данном примере (на рисунке выше) синтезатор ReaSynDr требует четыре выходных порта. Если выбранный 
элемент требует несколько выходных портов, REAPER создаст начальный трек и отобразит окно запроса. Если 
вы нажмете Yes, будет построена вся цепочка выходных портов, которая конечно будет зависеть от плагинов, 
которые вы выбрали. 
 

3.33. Использование программного синтезатора Microsoft GS Wavetable SW Synth 
 
Можно использовать встроенный системный синтезатор Microsoft GS Wavetable Synth, если он включен в вашу 
версию Windows. Это может быть особенно эффективно для воспроизведения любых MIDI файлов, которые вы 
импортировали в REAPER. Подробнее об импортировании файлов в Главе 4. Чтобы активировать синтезатор 
Microsoft GS Wavetable SW: 
 
1. Перейдите Options > Preferences > MIDI Devices > MIDI Outputs. 
2. Щелкните правой кнопкой мыши по элементу Microsoft GS Wavetable SW Synth и выберите Enable output. 
3. Нажмите Apply, затем OK. После этого синтезатор Microsoft GS Wavetable SW Synth будет доступен в 
качестве выходного устройства MIDI Hardware Output.  
 
Теперь вы можете использованию Microsoft GS Wavetable SW Synth как устройство вывода вместо того, чтобы 
использовать программный синтезатор. 
 

 
 

3.34. Запись наложением области лупа и выделенной области 
 
Запись наложением области лупа позволяет сделать повторяемые наложения на фрагмент записанного 
материала без необходимости неоднократно начинать и останавливать запись. Этот метод может 
использоваться как с аудио, так и с MIDI клипами. В обоих случаях, перейдите на страницу Options > 
Preferences > Audio > Loop Recording.  
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Установите опцию When recording and looped add recorded media to project (при записи и зацикливании 
добавить записанные клипы в проект) в значение On stop (при остановке). Отметьте опцию In loop recording, 
discard incomplete first or last takes if at least one full loop was recorded (при записи в режиме лупа 
анулировать незавершенные первую или последнюю копии если по крайней мере один луп записан 
полностью). Необходимо также (в главном меню Options REAPER) отключить опцию Loop points linked to time 
selection и отметить опцию Record mode: Time selection auto-punch. Теперь активируйте трек для записи, 
выберите опции записи и на шкале времени выделите область лупа, которая будет и выделенной областью, как 
показано на рисунке ниже.  
 

 
 
Убедитесь, что кнопка Toggle Repeat на транспортной панели активирована (подсвечена). Если в контекстном 
меню кнопки Arm record отмечена опция Record input (audio or MIDI), аудио и MIDI клипы по сути будут вести 
себя схожим образом. В процессе записи, новый материал будет записываться в пределах выделенной области 
с добавлением MIDI клипа для каждого прохода по области до тех пор, пока вы не нажмете кнопку Stop на 
транспортной панели. Область лупа используется для прослушивания материала до и после записываемого 
фрагмента. Например, если в контекстном меню кнопки Arm record вы выбрали опцию Monitor input и Record 
Input (audio or MIDI), а в качестве входного MIDI устройства (Input MIDI) ваше MIDI-устройство, результат будет 
схож как на рисунке выше. Аудиоматериал, записанный с порта Input MONO, а не с порта Input MIDI, привел бы 
к схожему результату, за исключением того конечно, что клипом будет аудио вместо MIDI. Однако вы получите 
существенно отличающиеся результаты, если будете использовать любую из опций Record: MIDI 
overdub/replace при записи области лупа. В каждом случае новые копии создаваться не будут. Вместо этого 
будет отредактирована текущая копия. Например,  
 
Record: MIDI Overdub: с каждым проходом новый материал будет добавлен к текущему материалу в пределах 
выделенной области.  
Record: MIDI Replace: с каждым проходом весь предыдущий материал в пределах выделенной области будет 
заменен новым материалом. Например, первый проход заменит текущие события в пределах выделенной 
области. Во второй раз новый материал заменит материал, записанный в первом проходе новыми событиями, и 
так далее. Т.е. сохраняется только новый материал. 
Record: MIDI Touch-replace: с каждым нажатием ноты в пределах выделенной области любой текущий 
материал одновременно с этой нотой будет заменен новым материалом на том же самом канале. Например, 
если вы все сыграли правильно за исключением одной ноты в первый раз, можно исправить только эту ноту во 
втором проходе. 
Record: MIDI Latch-replace: каждый проход весь текущий материал в выделенной области будет заменен 
новым материалом на том же самом канале с момента взятия первой ноты. Этот метод может быть полезным, 
например, если вы заменяете текущий материал постепенно. 
 

3.35. Запись с использованием внешних аппаратных эффектов 
 
В REAPER можно записать трек с использованием внешнего аппаратного устройства (модуля) эффектов почти 
также, как и при использовании внешнего устройства в качестве вставки при записи на аналоговой консоли. Для 
этого используйте плагин ReaInsert. Если вы хотите попробовать эту процедуру шаг за шагом, создайте новый 
проект REAPER, вставьте трек, и подготовьте внешнее устройство. 
 
Пример: 
 
1. Соедините любой неиспользованный выходной аудиопорт с входным портом модуля. Соедините выходной 
порт модуля с любым неиспользованным входном аудиопортом. 
2. Создайте новый проект REAPER и добавьте один аудиотрек. Дайте этому треку подходящее имя. Давайте 
запишем вокал с эффектом на этом треке. 
3. Подсоедините микрофон к любому неиспользованному входному аудиопорту. Включите модуль эффектов. 
4. Активируйте трек для записи. 
5. Выберите устройство ввода (линейный или микрофонный), выберите Monitor Input и определите выходной 
порт в Record Output, а затем выберите нужную опцию (например, Mono, Latency Compensated), так же, как 
мы сделали это в параграфе "Запись выходного сигнала трека". 
6. Теперь откройте окно эффектов этого трека, и добавьте плагин FX VST: ReaInsert. 
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7. Определите фактические посылы и адресаты в меню Hardware Sends и Returns, которые вы установили в 
Шагах 1. и 3. 
8. Убедитесь, что баланс эффекта в модуле установлен в значение 100% Dry, а в пределах плагина ReaInsert 
активируйте опцию Automatic device latency adjustment. Это позволит REAPER вычислить необходимую 
компенсацию задержки. 
9. С выходным сигналом трека, направленным в наушники, отрегулируйте необходимую громкость и уровни 
эффекта, включая баланс Wet/Dry. 
10. Когда будете готовы, нажмите кнопку Record. 
11. По окончании, не забудьте деактивировать трек и установить статус плагина ReaInsert в значение Bypass. 
 

3.36. Предварительные настройки записи 
 
Страница Options > Preferences > Audio > Recording может использоваться для настройки параметров записи 
REAPER: 
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Scroll track view while recording (if enabled for playback in options menu) (прокручивать представление 
треков при записи)  
Show preview of recording items while recording, update frequency (показать прорисовку сигналограммы 
клипов по ходу записи). Это полезно для подтверждения того, что вы действительно записываете и, например, 
не забыли активировать трек или несколько треков для записи. Здесь же можно также определить частоту 
обновления экрана. 
Build peaks for recorded files (прорисовывать сигналограмму для записанных файлов) со значениями: на лету 
(On the fly), после записи (After recording) и вручную (Manually). 
Always show full track control panel on armed tracks (при активировании трека для записи показывать всю 
панель контроллеров трека (включая индикаторы уровня) 
Prompt to save/delete/rename new files (активировать запрос на сохранение/удаление/переименование 
файлов, когда запись будет остановлена). Если эта опция отключена, файлы будут сохранены автоматически. 
Здесь же можно определить, когда показать запрос – при остановке записи (on stop) или при выходе из 
автозаписи/воспроизведении (on punch-out/play). Если эта опция отключена, файлы записанные таким образом 
будут сохранены автоматически. 
Start new files every (начать запись нового файла каждые...) в мегабайтах. Это может помочь защитить 
данные при записи продолжительного исполнения. 
Prevent recording from starting when no tracks armed (не начинать запись, если нет активированных для 
записи треков). Эту опцию можно использовать при записи наслоением. 

 
Filename format for recorded files (формат имени записываемого файла). Нажав 
кнопку Wildcards можно использовать любую комбинацию номера трека, имени 
трека, имени проекта, года, месяца, дня, часа, минуты, секунды и временной 
отметки. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Check free disk space on record start, warn if less than (проверить свободное дисковое пространство перед 
записью, и предупредить, если объем меньше…) в мегабайтах.  
Show free disk space in menu bar (показать объем свободного места на диске в строке меню)  
Show primary recording path in menu bar (показать основной путь для сохранения записанного материала в 
строке меню). 
Use audio driver reported latency (компенсировать задержку аудио драйвера). Эта опция автоматически 
регулирует позицию клипа, компенсируя задержку аудио драйвера. Здесь же доступны опции для введения 
значений задержки вручную. Новичкам особенно рекомендуется отметить эту опцию в их настройках по 
умолчанию. 
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3.37. Предварительная настройка параметров трека для записи 
 
Параметры трека по умолчанию включают несколько элементов, которые могут облегчить процесс записи. Эти 
параметры можно найти на странице Options > Preferences > Project > Track/Send Defaults: 
 

 
 
Track volume fader default gain (уровень по умолчанию регулятора громкости трека). 
Send default gain (уровень громкости по умолчанию для посылов) 
Hardware output default gain (уровень громкости по умолчанию для выходного порта аппаратных устройств) 
Default track height in new projects (высота треков по умолчанию в новых проектах). 
Record arm (активировать для записи новые треки автоматически). 
Record config (режим по умолчанию для новых треков в контекстных меню кнопок Record Arm и Record 
Monitoring). 
 
Заметьте также, на странице Options > Preferences > Appearance > Track Control Panels в секции VU meters 
доступны параметры, которые вкупе определяют вид и поведение индикаторов уровня трека.  
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Show track input when record armed (показать пики входного сигнала, когда трек будет активирован для 
записи)  
Make obvious that track input is clickable: отключение этой опции может улучшить четкость отображения 
индикаторов уровня.  
Активирование опций Show db scales on record armed track meters (отобразить шкалу индикаторов 
активированного для записи трека в децибелах) и Sticky Clip Indicators (задерживать пиковые уровни на 
индикаторах) поможет лучше визуально контролировать пиковые уровни.  
Пользователи MIDI могут отметить опцию Show MIDI velocity on track VU (отобразить значения velocity на 
индикаторах трека) и/или Show MIDI output activity on track VU (отобразить активность выходного MIDI 
сигнала на индикаторах трека).  
Если опция Reset peak indicators on play/seek отмечена, числовые индикаторы пиковых уровней трека и 
индикаторы уровня мастер-трека будут сбрасываться, когда воспроизведение будет перезапущено, или 
указатель текущей позиции будет перемещен в указанную точку. 
 

3.38. Проекты с разными аудиоформатами 
 

REAPER позволяет использовать 
различные аудиоформаты для 
различных треков в одном проекте. 
Формат по умолчанию для нового трека 
выбирается в параметрах проекта 
(опция Set recording audio format). 
Чтобы изменить эти параметры для 
любого трека, просто щелкните правой 
кнопкой по индикатору уровня трека, а 
затем из меню выберите опцию Track 
Recording Settings.  
Доступные форматы: WAV, AIFF, DDP, 
FLAC, MP3, OGG Vorbis, Video (GIF) 
или WavPack lossless compressor. В 
зависимости от выбранного формата, 
соответственно меняются и опции. 
 
 
 
 
 
 
 
 
 
 

 
3.39. Чек-лист записи аудио в REAPER 

 
Представленный ниже чек-лист предназначен исключительно для ознакомления и в качестве помощи при 
записи. В некоторых случаях можно изменить предложенный порядок (например, можно включить компьютер и 
запустить REAPER прежде, чем подключить микрофон или инструменты. В других случаях порядок важен 
(например, нужно всегда подключать микрофон к предусилителю перед включением фантомного питания). 
Если вы не уверены в своих действиях, придерживаетесь краткой последовательности, обрисованной ниже: 
 
Подготовка: сконфигурируйте все необходимое внешнее записывающее оборудование (микрофоны, консоли 
и т.д.). Все фейдеры и контроллеры громкости в микшере и/или на аудиоустройстве установите в минимум. 
Отключите фантомное питание (при наличии). Подсоедините все необходимое оборудование (например, 
микрофон к микшеру или к аудиоустройству). Включите оборудование, но убедитесь, что громкость на 
динамиках не слишком высока. Подключите наушники к предусилителю или к аудиоустройству. Если 
необходимо фантомное питание (для конденсаторного микрофона), включите его. 
Мероприятия по подготовке компьютера: включите компьютер и откройте REAPER с нужным файлом 
проекта. Сохраните файл. 
Параметры проекта: проверьте формат записи и параметры, например, 24 bit WAV at 44100 Hz. При 
необходимости выберите другой формат для этого трека. Убедитесь, что режим записи установлен в значение 
Normal. 
Параметры трека: проверьте, именован и активирован ли трек для записи? Активирован/отключен ли 
мониторинг входного сигнала трека? Используйте прямой мониторинг входного сигнала аудиокарты при 
наличии в предварительных настройках REAPER. Выбран ли входной порт для записи и правильно ли он 
выбран?  
Тест уровней записи: установите уровень записи. Запишите небольшой сэмпл, чтобы проверить уровни. 
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Запись: нажмите Ctrl+R, чтобы сделать запись и нажмите повторно чтобы остановить запись. Сохраните 
клип. Нажмите Ctrl+S, чтобы сохранить файл проекта. 
Оценка результатов: деактивируйте треки для записи прежде, чем воспроизвести их. Особенно при 
прослушивании через наушники, отключите мониторинг входного сигнала чтобы препятствовать 
проникновению посторонних звуков в записанный материал. 
 

3.40. Чек-лист записи MIDI с MIDI клавиатуры 
 
При записи с MIDI клавиатуры у новичков иногда возникают проблемы, поэтому ниже приведен чек-лист 
записи MIDI с MIDI-клавиатуры: 
 
- передает ли MIDI клавиатура сигнал на нужный MIDI канал? 
- активирована ли MIDI клавиатура на странице Options > Preferences > MIDI Devices?  
- выбрана ли MIDI клавиатура в качестве устройства ввода для трека? 
- правильный ли выбран MIDI канал с MIDI клавиатуры? 
- направлен ли входной сигнал в правильный MIDI канал (при необходимости)? 
- активирован ли трек для записи (при необходимости)? 
- активирован ли мониторинг входного сигнала? 
 

3.41. Запись аудиопотока с интернета 
 
REAPER можно использовать для записи аудиопотока с интернета. Для начала убедитесь, что не нарушаете 
чьи-либо авторские права. Способ записи будет зависеть от конфигурации вашей аппаратной части, включая 
настройку параметров аудиокарты, с соответствующим программным обеспечением для их редактирования. 
Кратко опишем необходимые шаги: 
 
1. Настройте параметры звуковой карты. Вероятно, понадобится отключить входной сигнал с других источников 
(микрофон, линия, и т.д.). 
2. Откройте веб-браузер и перейдите на страницу с элементом, который вы хотите записать. 
3. Откройте REAPER, создайте новый проект и добавьте трек. 
4. Следующий шаг предполагает некоторое экспериментирование. В зависимости от используемого 
оборудования, возможно придется изменить параметры диалогового окна Options > Preferences > Audio > 
Devices > Direct Sound. 
5. Активируйте трек для записи, убедившись в правильности выбора входного порта. 
6. Нажмите Ctrl+R чтобы начать запись. В браузере, воспроизведите элемент, который Вы хотите записать.  
По окончании, остановите запись и сохраните файл. 
 

Примечание: не забудьте по окончании записи восстановить опции управления записью звуковой карты 
и предварительные настройки параметров аудиоустройств REAPER в их предыдущие значения. 
 

 
3.42. Конвертирование аудиоклипов 

 
На сегодняшний день все более набирает обороты сотрудничество музыкантов по всему миру, это же касается 
и использования REAPER. Предположим, у вас есть фрагмент записанного проекта, включающий 50 или более 
wav файлов в формате 24 bit. Это приблизительно 3 Гб, и вы хотите поделиться с ними с другом у которого 
медленный интернет. Одно из решений могло бы состоять в конвертировании файлов в сжатый формат и 
отправки их в этом формате другу. Есть быстрый способ сделать это, используя опцию File > Save project as. 
Выберите эту опцию и следуйте за шагами, описанными ниже: 
 
1. Если хотите, перейдите к нужной корневой папке. 
2. Активируйте следующие три опции: Create subdirectory for project, Copy all media into project directory, и 
Convert media. 
3. Нажмите кнопку Format, чтобы отобразить окно параметров. 
4. В окне параметров активируйте опцию Set format to save as. 
5. Выберите нужный формат (например, FLAC, MP3 или, как показано на рисунке ниже, OGG Vorbis). 
6. Настройте параметры формата. 
7. Нажмите OK, затем Save. 
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После этого все аудиоклипы проекта будут сконвертированы в указанный формат по ходу их копирования. 
Исходный формат клипов останется неизменным. Можно импортировать и экспортировать только выбранные 
клипы из одного формата в другой без необходимости конвертирования проекта целиком. Эта тема 
затрагивается в Главе 21. 
 

3.43. Запись в реальном времени выходного сигнала Windows 
 

Пользователи Windows (Vista/7/8) могут использовать 
драйверы WASAPI для записи выходного сигнала 
Windows в реальном времени (например, видео с 
YouTube). Для этого требуется использование функции 
цепи обратной связи, поэтому с этого момента будьте 
осторожны. Тема не для новичков. Во-первых, создайте 
новый проект. Откройте окно параметров проекта 
(Alt+Enter), и на странице Advanced активируйте опцию 
Allow feedback routing. Затем, перейдите Options > 
Preferences > Audio > Device и выберите драйвер 
WASAPI в меню Audio system. Выберите режим Shared 
loopback в меню Mode (как на рисунке слева). Размер 
блока (Block size) и частота дискретизации (Samplerate) 
должны соответствовать таковым на вашей аудиокарте, 
которые устанавливаются на панели управления 
Windows. Наконец, просто добавьте новый трек и 

активируете его для записи. Нажмите Ctrl+R, чтобы начать запись, независимо от того, что в настоящий момент 
воспроизводится в Windows, например, видео с YouTube. 
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4. Импорт клипов: браузер клипов 
 

4.1. Введение и краткий обзор 
 
Чтобы отобразить браузер клипов, перейдите View > Media Explorer (Ctrl+Alt+X). Его интерфейс показан на 
рисунке ниже. Опция Insert > Media File может использоваться для добавления текущих клипов (MP3, MIDI и 
WAV файлов) в проект REAPER, но зачастую для этой цели легче и удобнее использовать браузер клипов 
REAPER. Браузер включает несколько дополнительных функций, облегчающих поиск нужных клипов. Прежде, 
чем изучить его функциональность, обратите внимание на следующие элементы его интерфейса:  
 

 
 
Панель Explorer/Shortcuts (1): может использоваться для навигации по папкам и файлам, как в проводнике 
Windows. Кроме того, здесь можно добавить ярлыки к часто посещаемым папкам. Щелчок правой кнопкой мыши 
по панели и выбор опции Sort shortcuts позволяет инвертировать порядок сортировки.  
Кнопки Browsing History (2): быстрый способ просмотра вашей истории навигации.  
Выпадающее меню Browsing History (3): хранит (и может отобразить) список недавно посещаемых папок. Из 
этого списка можно выбрать и открыть любую папку.  
Область Filter (4): используется для набора текста, который помогает отфильтровать список файлов.  
Выпадающее меню List/Details (5): можно выбрать, показывать ли полную детализацию файлов (Details) (как 
показано на рисунке выше), или только списком имен файлов (List).  
Транспортная панель (6): транспортные контроллеры для работы с клипами: кнопки Play, Pause, Stop и 
Repeat.  
Кнопка Route (7): щелчок по этой кнопке позволяет направить выходной сигнал на любой выходной аудиопорт, 
или воспроизвести любой трек, выбранный в области аранжировки.  
Регулятор Pitch (8): позволяет изменить высоту тона выбранного клипа. Используйте контекстное меню 
браузера клипов для определения диапазона регулятора Pitch (+- 12 полутонов) (Pitch shift knob range) и его 
поведения (Pitch shift knob behavior).  
Меню Tempo (9): позволяет скорректировать (подогнать) темп, или удвоить/ополовинить темп.  
Фейдер Volume (10): управляет громкостью выбранного клипа. 
 

Примечание: хотя обычно браузер клипов используется для поиска и вставки медиафайлов, он может 
также использоваться для поиска и открытия текущих файлов проекта. 
 
Примечание: браузер клипов можно прикрепить на панель Docker. Для этого в контекстном меню 
браузера отметьте опцию Dock media explorer in docker. 
 

 
4.2. Функции поиска в браузере клипов 

 
Хотя в некотором отношении браузер клипов схож с проводником Windows, он включает несколько 
дополнительных функций, облегчающих поиск. 
 
4.2.1. Поиск по папкам 
 
Используйте панель Explorer/Navigate вместе с главной панелью. Например, щелкните по значку Мой 
компьютер (Windows) или Home (Mac) на панели проводника, а затем используйте главную панель для 
просмотра и открытия ваших папок.  
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Для пользователей Windows в контекстном меню браузера клипов доступна опция Use Windows Explorer for 
browsing (использовать проводник системы для поиска). Если она отмечена, кроме того, что меняется 
отображение результатов поиска, щелчок правой кнопкой мыши по любому заголовку колонки отображает 
список дополнительных колонок, таких, как Author, Title, Artist и т.д. 
 
4.2.2. Поиск в истории просмотров 
 
В меню Browsing History будут отображены все папки и директории, которые вы посетили и открыли во время 

текущей сессии. Дополнительно, кнопки, расположенные налево от меню , могут использоваться для 
пошаговой навигации списка истории просмотров. 
 
4.2.3. Поиск с использованием фильтра  
 

 
 
Введите любую текстовую строку (например, bass) в немаркированной области фильтра (слева от 
выпадающего списка List/Details), чтобы отфильтровать список найденных файлов. Поддерживается и поиск с 
использованием логических операторов (AND, OR, NOT). Используйте символы ^, $ и кавычки которые 
соответствуют началу/окончанию/полностью слова - ^bass, bass$, “bass“. Чтобы очистить фильтр, удалите 
набранную текстовую строку. 
 
4.2.4. Управление отображением папок/файлов 
 
Щелкните по любому заголовку столбца чтобы отсортировать список этого столбца. Повторный щелчок 
инвертирует порядок сортировки. Щелчок правой кнопкой мыши на заголовке столбца позволяет 
скрыть/отобразить этот столбец через его флажок. Чтобы поменять порядок столбцов, перетащите заголовок 
влево/вправо. 
 
4.2.5. Опции ограничения поиска 
 
Контекстное меню браузера клипов включает несколько переключаемых опций для ограничения поиска файлов: 
 
Show all files (показать все файлы) 
Show leading paths (показать путь к файлам) 
Search in subfolders (искать в подпапках) 
Search in folder names (искать по именам папок) 
Search in search fields (искать в областях поиска, т.е. в областях Title, Artist, Album, Year, Genre, 
Comment) 
Search in leading paths (искать в путях) 
Search in metadata (искать в метаданных) 
Include matching subfolders (включить соответствие подпапок): отображает имена подпапок в результатах 
поиска 
Update searches only when the ENTER key is pressed (обновлять поиск только когда нажата клавиша Enter. 
 
4.2.6. Добавление папок в список Shortcuts 
 
Щелкните правой кнопкой по имени папки на главной панели, а затем выберите опцию Add to shortcut list из 
меню. Теперь эта папка будет отображаться на панели Explorer/Shortcuts. Можно в любое время щелкнуть по 
этому ярлыку, чтобы отобразить содержимое папки. 
 
4.2.7. Удаление ярлыка  
 
Щелкните правой кнопкой по имени ярлыка (на панели Explorer/Shortcuts) и выберите опцию Remove selected 
shortcut из меню. 
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4.3. Прослушивание клипов 
 
Прежде чем вставить клип в проект его можно прослушать в браузере клипов. По умолчанию, щелчок по клипу 
автоматически запускает его воспроизведение. Доступно несколько опций, определяющих поведение 
предварительного прослушивания. 

 
Опция Auto play (автоматическое воспроизведение щелчком по клипу) ниже 
регулятора Pitch. Доступна также опция Start on bar (начать с начала такта). 

 
В контекстном меню браузера клипов доступна опция Auto advance to next file after preview (автоматически 
переходить к следующему клипу). Она будет работать только в том случае, если функция повторения (кнопка 

) на транспортной панели браузера отключена.  
 
Другие переключаемые опции предварительного прослушивания: Autostop preview after adding media 
(автоматически останавливать воспроизведение при добавлении клипа), и Display preview position in tenths 
of seconds (отображать позицию воспроизведения в десятичных долях секунд). 
 

Кнопки транспортной панели: Play, Pause, Stop и Toggle Repeat.  
 

 
Горизонтальный фейдер регулирует громкость воспроизведения. 
 

Щелчок в любом месте сигналограммы запускает воспроизведение с этой точки.  
Используйте колесо мыши для масштабирования сигналограммы по горизонтали.  
Чтобы отрегулировать высоту сигналограммы, перетащите верхний край области сигналограммы вверх/вниз. 
Сигналограмму можно прокрутить влево/вправо с нажатой клавишей Shift (курсор при этом меняется на символ 
руки).  
В области отображения сигналограммы можно выделить любой фрагмент и перетащить его по области 
влево/вправо, с нажатой клавишей Alt. 
Отображение сигналограммы можно активировать/отключить с помощью опции Always show waveform peaks 
for selected media в контекстном меню браузера клипов. 
Другие опции воспроизведения/сигналограммы: Display preview position in tenths of second (отображать 
позицию воспроизведения в десятых долях секунд) и Auto stop preview after adding media (автоматически 
останавливать воспроизведение при добавлении клипа). 
Если в контекстном меню браузера клипов отмечена опция Auto advance to next file after preview, все файлы, 
отображенные в главном окне браузера клипов, будут воспроизводиться последовательно, при условии, что 

кнопка  на транспортной панели будет отключена. 

Нажатие кнопки  (рядом с транспортной панелью), открывает окно, где вы можете направить сигнал 
прослушиваемого клипа в любой выходной аудиопорт.  
 

 
 
Контекстное меню браузера клипов также включает опцию Play the previewed item through a selected track 
(воспроизвести прослушиваемый клип через выбранный трек). 
Контроллер Pitch регулирует высоту тона прослушиваемого клипа. Двойной щелчок на регуляторе сбрасывает 
его в значение по умолчанию.  
Опция Pitch shift knob range в контекстном меню браузера клипов позволяет установить диапазон регулятора в 
+/-2, 6 или 12 полутонов и определить его поведение: Continuous (непрерывно, т.е. не скачкообразно), Quarter 
tones (по целым тонам) или Semitones (по полутонам). 
Контекстное меню браузера клипов включает две переключаемые опции: Preserve pitch when tempo matching 
(сохранять высоту тона при подгонке темпа) и Reset pitch shift when changing media (сбрасывать 
изменение высоты тона при замене клипа). 
 

Чтобы избежать возможных несоответствий темпа, можно использовать опцию Tempo 
Match Off (подгонка темпа отключена) и Tempo Match On (подгонка темпа 
активирована) из выпадающего списка в области предварительного прослушивания. 
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4.4. Вставка аудиофайла в качестве новой копии или клипа 
 
Выбранные в главном окне браузера клипы можно вставить в текущий проект щелчком правой кнопки мыши по 
имени файла и выбором нужной опции: 
 

 
 
Insert into project (вставить в проект на текущем выбранном треке, в текущей позиции курсора) 
Insert at time selection (stretch/loop to fit) (вставить в выделенную область и подогнать ее 
(растянуть/зациклить), если эта область в настоящий момент активна).  
Insert into project on a new track (вставить в проект в новый трек в текущей позиции курсора) 
Insert as take in selected item (вставить как копию в выбранный клип). Перед этим необходимо выделить 
клипы. 
Use as media source for selected item (использовать в качестве медиа источника выбранный клип) вместо 
текущего медиаисточника этого клипа 
Use as media source for selected item (stretch/loop to fit) (использовать в качестве медиаисточника 
выбранный клип и подогнать его (растянуть/зациклить) вместо текущего медиаисточника этого клипа 
Preview (воспроизвести клип, не вставляя его в проект). 
Show in explorer (показать в проводнике) 
 
Быстрый способ - дважды щелкнуть по имени файла, либо щелкнуть по нему и нажать Enter, либо просто 
перетащить - но это не так просто, как кажется! Использование любого из этих способов автоматически 
применит выбранное действие по умолчанию. Эти действия по умолчанию можно определить в контекстном 
меню браузера клипов - Default action (double-click or Enter key). Сначала это может показаться странным, 
потому что применяется действие как для медиафайлов, так и для файлов проекта, у обоих из которых 
наиболее вероятно будут различные потребности. Необходимо определить действия в каждом из четырех 
секций этого меню. Выберите либо Insert media (вставить клип в проект) - если действие требуется для 
клипа, либо Open project (открыть проект) - если действие требуется для проекта, либо Start preview 
(начать воспроизведение), либо Do nothing (ничего не делать). Выберите также для клипа либо Insert media 
on selected track (вставить клип в выбранный трек), либо Insert media on new track (вставить клип в новый 
трек). Определите нужна ли вам опция Enable looping when inserting selected portion of media 
(активировать зацикливание, при вставке выделенного фрагмента клипа). Выберите опцию для проекта - 
Open projects in current tab (открыть проект в текущей вкладке), либо Open projects in new tab (открыть 
проект в новой вкладке). Так же как (или вместо) импорта отдельных клипов, браузер клипов включает 
несколько других опций: 
 
Insert part of a media item into a project (вставить фрагмент клипа в проект): выделите нужный фрагмент 
сигналограммы в области предварительного прослушиваниях. Щелкните правой кнопкой по выделенной 
области и выберите эту опцию из контекстном меню.  
клип можно зациклить. Его можно вставить в текущую выделенную область в проекте, в новый трек, или в 
качестве новой копии в выбранный клип. Альтернативно, нужный фрагмент можно просто перетащить в проект. 
Insert multiple items at once (вставить несколько клипов одновременно): используйте Ctrl+щелчок для 
выбора клипов в браузере. (см. также заметку ниже). Щелкните правой кнопкой по одному из выбранных клипов 
и выберите эту опцию из меню. Альтернативно, можно просто перетащить выделенную область в проект. Если 
вы не изменяли настройки по умолчанию, поступит запрос - хотите ли вы вставить клипы на один трек или на 
отдельные треки. 

 
Примечание: страница Options > Preferences > Media включает параметры поведения по умолчанию 
при вставке нескольких клипов: 
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Insert in one track (advancing time) (вставить каждый клип один за другим на одном треке). 
Insert across tracks (вставить каждый клип на отдельный трек). Но запускаться они будут вместе. 
Decide automatically: если файлы имеют одинаковую длину (размер файла), они будут размещены на 
отдельные треки. В противном случае они будут вставлены последовательно на одном треке. 
Prompt user - запрос на выбор действия. Если вы сомневаетесь, выберите опцию Prompt User. Другая 
полезная опция - Copy imported media to project media directory (копировать импортированные клипы в 
директорию проекта). Подробнее об этом в Главе 22. 
 

4.5. Создание и использование базы данных браузера клипов 
 
На панели Shortcuts браузера клипов можно создать свою собственную базу данных (или базы данных) и 
определить организацию и отображение ваших сэмплов и медиафайлов. Одно из преимуществ базы данных – 
файлы, которые могут храниться в разных папках, здесь можно отобразить вместе. Например, у вас могут быть 
разные папки для различных типов сэмплов барабана (малый барабан, бочка, хэт, и т.д.). Настанет момент, 
когда вы захотите просмотреть содержимое этих папок вместе. Для этого, вы могли бы создать базу данных под 
названием “Drums Various” и добавить все эти папки в эту базу данных. Базы данных создаются и управляются, 
используя контекстное меню столбца Shortcuts. 
 

 
 
Чтобы создать новую пустую базу данных: выберите опцию Create new database. Введите имя и нажмите 
Enter. 
Чтобы добавить содержимое папки в базу данных: выберите базу данных в столбце Shortcuts. Щелкните 
правой кнопкой по ее имени и выберите опцию Add path to database. Перейдите к нужной папке, выберите ее и 
нажмите OK. Повторите процедуру для добавления других папок. 
Чтобы создать новую базу данных на основе папки: в главном окне браузера клипов щелкните правой кнопкой 
по папке и выберите опцию Make database from folder. 
Чтобы удалить содержание папки от базы данных: выберите базу данных в столбце Shortcuts. Щелкните 
правой кнопкой по ее имени и выберите Remove path from database из меню. Перейдите к нужной папке, 
выберите ее и нажмите OK. 
Чтобы переименовать базу данных: выберите базу данных в столбце Shortcuts и выберите опцию Rename 
database из контекстного меню. 
Чтобы обновить содержимое базы данных и отразить изменения в содержимом папки: выберите базу данных 
в столбце Shortcuts. В контекстном меню выберите опцию Scan database for new files, чтобы найти и добавить 
новые файлы, и опцию Remove missing files from database чтобы очистить удаленные файлы. 
Чтобы переименовать элемент базы данных: щелкните по нему правой кнопкой мыши и выберите опцию 
Rename Shortcut. 
Чтобы удалить базу данных: щелкните правой кнопкой по базе данных в столбце Shortcuts и выберите опцию 
Remove database. 
Базы данных браузер клипов могут быть включены в параметры кнопки Export configuration (Options > 
Preferences > General). Подробнее об этом также в Главе 22. 
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4.6. Замена источников клипа 
 
Можно выбрать клип в браузере и использовать его для замены источника текущего клипа (или нескольких 
клипов) в текущем проекте. Это можно сделать из контекстного меню браузера клипов, или простым 
перетаскиванием.  
 
Чтобы заменить медиаисточник используя контекстное меню браузера: 
 
1. Выберите клип (или клипы) в проекте. 
2. В браузере клипов, выберите нужные клип для замены. 
3. Щелкните правой кнопкой по этим клипам и выберите либо опцию Use as media source for selected items 
(использовать в качестве медиаисточника для выбранного клипа), либо Use as media source for selected 
items (stretch/loop to fit) (использовать в качестве медиаисточника для выбранного клипа и подогнать - 
растянуть/зациклить). 
 
Чтобы заменить медиаисточник перетаскиванием: 
 
1. Выберите клип в браузере клипов. 
2. Удерживайте Ctrl+Alt при перетаскивании источника в клип, который необходимо заменить. 
3. Появится диалоговое окно, показанное на рисунке ниже.  
 

 
 
Insert new media item that overlaps target media item (вставить новый клип, который будет наложен на текущий 
клип) 
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Add source media as new take in target media item (добавить источник в качестве новой копии в текущий клип) 
Replace target media with source media (заменить текущий клип источником) или (если несколько клипов),  
Replace all x occurrences of the target media with source media (заменить все события текущего клипа 
источником). 
 
4. Выберите одну из опций: Adjust target media item length to fit source media (подогнать 
продолжительность текущего клипа под продолжительность источника), Stretch source media to fit target 
media item (растянуть по времени медиаисточник и подогнать под текущий клип), Loop source media to fit 
target media (зациклить источник и подогнать под клип). 

 
Примечание: вышеописанный способ может использоваться для замены текущих клипов фрагментами 
других клипов. После выбора клипа для замены в браузер клипов, в области представления 
сигналограммы выделите фрагмент клипа, а затем выполните шаги 2-4, описанные выше. 

 
4.7. Клипы автоматизации 

 
Клипы автоматизации можно рассмотреть и вставить в проекты из медиабраузера. Подробнее об этом в Главе 
18. 
 

4.8. Импорт MIDI файлов 
 
Чтобы прослушать MIDI файл в браузере клипов, сначала создайте пустой трек в проекте и вставьте 
виртуальный инструмент или синтезатор в цепочку эффектов этого трека. Затем можно выбрать любой MIDI 
файл в браузере клипов и прослушать его. Для импорта можно также выбрать любой фрагмент MIDI файла, 
используя способы, описанные ранее в этой главе. Щелкните правой кнопкой мыши по имени файла, чтобы 
выбрать опцию вставки, или просто перетащите файл на трек. MIDI файлы можно импортировать, перетащив их 
из проводника системы, или используя команду Insert > Media file. 
 
4.8.1. Типы MIDI файлов 
 
Есть два основных типа MIDI файлов - Type 0 и Type 1. REAPER распознает оба. В файлах Type 0 все MIDI 
события и данные расположены на одном треке, но данные отдельных каналов сохраняются. Один трек с MIDI 
файлом Type 0 может включать до 16 каналов на одном треке. Файлы Type 1 могут включать любое количество 
треков, где каждый трек содержит данные на одном или более каналах. Type 1 больше подходит для больших 
аранжировок, чем Type 0. Например, можно использовать несколько партий ударных на одном канале, но на 
отдельных треках. 
 
4.8.2. Импорт MIDI файлов Type 1 
 
Чтобы понять, как REAPER управляет импортированными MIDI клипами, давайте рассмотрим несколько 
довольно простых примеров. Мы возьмем простой MIDI файл с Type 1 с двумя треками. Трек 1 содержит 
данные только канала 1, а трек 2 содержит данные двух разных инструментов на каналах 2 и 3. Есть несколько 
способов импорта этого файла в наш проект REAPER: 
 
 Мы можем импортировать каждый трек/комбинацию каналов в отдельный трек (на три трека). 
 Мы можем сохранить исходную структуру и импортировать файл на два трека. 
 Мы можем импортировать все три канала в один трек. 
 
Данный пример предполагает, что вы выбрали значение Always prompt (всегда спрашивать) опции Import 
multichannel MIDI files на странице Options > Preferences > Media > MIDI.  
 
1. Поскольку вы импортируете мультитрековый MIDI файл type 1 в REAPER, последует запрос - хотите ли вы 
сконвертировать MIDI треки в новые треки Reaper (Expand the MIDI tracks to new REAPER tracks). 
2. Если вы активируете эту опцию и нажмете кнопку OK, становятся доступны две дополнительные опции. 
3. Если вы выберете опцию Single-channel items on multiple tracks, для каждого MIDI файла будет создан 
отдельный трек/комбинация треков REAPER с MIDI данными - в данном примере - три (потому что наш MIDI 
файл в качестве примера включает данные каналов 1, 2 и 3). Импортированный файл будет выглядеть 
примерно так, как на рисунке ниже (пример 1):  
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Если вы выберете опцию Multichannel item on a single track, вы получите файл как на рисунке ниже (пример 2) 
- файл с треками/структурой каналов импортированного MIDI файла:  
 

 
 
Давайте теперь вернемся к шагу 1. Если мы не отмечаем опцию Expand the MIDI tracks to new REAPER tracks, 
а выбираем опцию Multichannel items on a single track, мы получаем результат, как на рисунке ниже (пример 
3) - все MIDI клипы помещаются в их правильные каналы на одном треке:  
 

 
 
Можно щелкнуть правой кнопкой по клипу и выбрать опции Item processing > Explode multichannel audio или 
MIDI items to new one channel items. В результате мы получим то, что вы видите на рисунке ниже следующее 
(пример 4):  
 

 
 
Первоначально импортированный MIDI клип остался тем же, но был мьютирован, и его трек становится трек-
папкой, которая содержит недавно сконвертированные MIDI клипы (по одному для каждого MIDI канала). Тема 
трек-папок подробно объяснена в Главе 5: на данный момент просто обратите внимание на то, что вы можете 
вставить виртуальный инструмент и/или другие плагины, такие как ReaControlMIDI (см. Главу 13) в цепочку 
эффектов этой трек-папки и использовать их для управления и воспроизведения всех MIDI клипов. 
 
4.8.3. Импорт MIDI файлов Type 0 
 
В этом примере мы рассмотрим опции импорта однотрекового MIDI файла type 0 в REAPER. Предположим, что 
этот файл содержит MIDI данные на 3 каналах. При импорте MIDI файла type 0 в проект, запроса о 
конвертировании MIDI треков не поступит: файл по определению содержит только один трек. Вместо этого 
поступит запрос, хотите ли вы поместить мультиканальный клип на один трек (Multichannel item on a single 
track) или одноканальный клип на несколько треков (Single channel items on multiple tracks). В качестве 
иллюстрации независимо от того, сколько каналов содержат MIDI данные, выбор опции Multichannel item on a 
single track привел бы к результату, как на рисунке ниже (пример 5):  
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Как и в примере 4, этот клип можно сконвертировать в трек-папку, содержащую отдельный трек для каждого 
канала. Если вы выберете опцию Single channel items on multiple tracks, вы получите отдельный трек для 
каждого канала, содержащего MIDI данные. Таким образом клип, содержащий данные трех каналов, привел бы к 
результату, как на рисунке ниже: 
 

 
 

4.9. Импорт мультиканальных аудиофайлов 
 
Мультиканальные аудиофайлы импортируются в REAER точно также, как и любой другой клип. Пример такого 
файла (в данном случае шестиканального) показан на рисунке ниже.  
 

 
 
Такой файл можно разделить на отдельные каналы по одному треку на канал. Это позволяет отредактировать 
каждый канал независимо от других. Для этого щелкните правой кнопкой мыши по клипу и выберите опцию Item 
processing > xplode multichannel audio или опцию MIDI items to new one channel items. Это приведет к 
результату, как на рисунке ниже: 
 

 
 

4.10. Форматы импорта 
 
Медиафайлы могут быть импортированы в REAPER в любой из следующих форматов: 
 
CD Audio (.CDA) 
DDP (.DAT) 
FLAC (.FLAC) 
MIDI (.MID) 
MIDI System Exclusive Message (.SYX) 
MIDI Karaoke (. KAR) 
MPEG Audio (, MP2, .MP3) 
OGG Vorbis (. OGG, MOGG) 
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Recycle (. RX@, REX, RCY) 
AVI Video (.AVI) 
MPEG Video (.MG, .MPEG) 
WMV/WMA Video (.WMA, .WMV) 
MK Video (.MKV) 
LCF Capture Video (. LCF) 
Quicktime (. MOV, QT, .M4V, .MP4) 
WebM (. WebMD) 
WAV (. WAV, W64, BWF) 
AIFF (.AIF, .AIFF) 
WAVPACK (. WV) 
 

4.11. Импорт клипов с CD диска 
 
Браузер клипов можно использовать для импорта в проект файлов с компакт-диска. Для этого: 
 
1. Вставьте компакт-диск в CD-привод компьютера. 
2. Откройте браузер клипов, выберите Мой компьютер на левой панели, а затем дважды щелкните по лейблу 
CD-привода. 
3. Будет открыто содержимое компакт-диска. 
4. Чтобы воспроизвести любой трек с компакт-диска, щелкните правой кнопкой по этому треку и выберите опцию 
Preview из контекстного меню. В зависимости от программного обеспечения на вашем компьютере, можно 
увидеть некоторые не относящиеся к REAPER опции. 
5. Чтобы вставить содержимое трека в проект в качестве клипа, щелкните правой кнопкой по треку и выберите 
одну из опций.  
 

 
 
Функционал каждой из этих опций был объяснен ранее. Альтернативно, можно дважды щелкнуть по клипу, 
чтобы вставить его в текущий выбранный трек, или перетащить его, чтобы вставить в текущий трек или в новый 
трек. 
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5. Основы построения проекта 
 

5.1. Управление треками 
 
В Главе 2 мы познакомились с некоторыми основными контроллерами трека REAPER, такими как Volume, Pan, 
Mute и Solo. В этой главе мы обсудим выполняемые ими функции более детально, а также познакомимся с 
некоторыми другими, включая способы перемещения и удаления треков, использование трек-папок, а также 
группировку треков и их параметров. Большинство опций и действий управления треком доступны из 
контекстного меню, вызываемого щелчком правой кнопкой мыши по любому номеру трека.  
 

 
 
Помните, что в любое время можно использовать горячие клавиши Ctrl+Z для отмены последнего действия. 
Возможности функции Undo REAPER более подробно описываются позже в этой главе. 
 

Совет: перед тем, как продолжить, откройте пример-проект All Through The Night.RPP и сохраните его с 
новым именем, например, All Through The Night EDITS.RPP. После этого можно использовать этот 
файл для экспериментов с функциями, представленными в этой главе. 

 
5.1.1. Основы управления треком 
 
 Чтобы переместить трек вверх или вниз по списку треков: захватите трек и перетащите его вверх или вниз. 
Все клипы перемещаются вместе с треками. 
 Чтобы переместить два или более смежных трека вверх или вниз: щелкните по номеру одного из треков, а 
затем удерживая клавишу Shift, щелкните по номеру другого трека. При этом будут выделены все треки в этом 
диапазоне. После этого можно переместить группу треков, как один трек. Все клипы перемещаются вместе с 
этими треками. 
Чтобы удалить трек: щелкните по номеру трека или около него и нажмите клавишу Delete, либо щелкните 
правой кнопкой мыши и выберите опцию Remove tracks из контекстного меню. Все клипы удаляются вместе с 
треком. 
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Чтобы удалить два или более трека: щелкните по нужным трекам с нажатой клавишей Ctrl, а затем нажмите 
клавишу Delete, либо щелкните правой кнопкой мыши по одному из выбранных треков и выберите опцию 
Remove tracks из контекстного меню. Все клипы удаляются вместе с треками. 
Чтобы продублировать трек и вставить его следующим треком: щелкните правой кнопкой мыши по номеру 
трека и выберите опцию Duplicate selected tracks из контекстного меню. Все клипы дублируются вместе с 
треком. То же самое можно сделать и с несколькими треками. 
 Чтобы скопировать трек в определенное местоположение: щелкните по номеру трека и нажмите Ctrl+C. 
Выберите местоположение и нажмите Ctrl+V. Все клипы дублируются вместе с треками. То же самое можно 
сделать и с несколькими треками. 
Чтобы отобразить мастер-трек в списке треков: щелкните правой кнопкой мыши в любом месте панели 
трека, ниже последнего трека и выберите опцию Show master track (Ctrl+Alt+M). 
Чтобы расширить/сузить панель трека: захватите правую/левую границу между панелью трека и областью 
аранжировки. При сужении панели трека, некоторые контроллеры могут исчезнуть из панели, а фейдеры могут 
измениться на регуляторы. 
 

5.2. Клавиши-модификаторы управления треком 
 
Четыре основных контроллера, используемые при прослушивании треков - это Volume (громкость), Pan 
(панорамирование), Mute (мьютирование/приглушение) и Solo (солирование). С этими контроллерами мы 
познакомились в Главе 2.  
 

Контроллер Width отображается только в том случае, если вы выбираете правило 
панорамирования stereo pan или dual pan (в контекстном меню фейдера 
панорамирования). Подробнее мы обсудим это в Главах 10 и 11.  
 

 
По умолчанию, фейдеры громкости и панорамирования управляют выходным аудиосигналом. Если вы хотите 
вместо этого использовать эти контроллеры для управления данными и на MIDI каналах любого трека (ов), 
необходимо сначала выделить нужные треки, а затем щелкнуть правой кнопкой мыши по номеру одного из 
выделенных треков и выбрать опцию MIDI track controls, а затем выбрать одну из опций Link track volume/pan 
to MIDI из меню (см. Главу 13).  
 
Контроллеры Volume и Pan: 
 

Клавиша-модификатор С контроллером громкости С контроллером панорамирования 

Alt 
Когда отпускается кнопка мыши, 
фейдер возвращается в его исходную 
позицию 

Когда отпускается кнопка мыши, фейдер 
возвращается в его исходную позицию 

Ctrl+Shift 
С несколькими выделенными 
треками, затрагивает только текущий 
трек 

С несколькими выделенными треками, 
затрагивает только контроллер текущего 
трека 

Ctrl 
 

Обеспечивает более точное 
управление фейдером 

Обеспечивает более точное управление 
фейдером 

Двойной щелчок Сброс в ноль.  Сброс в центральную позицию 
 
Контроллеры Mute и Solo: 
 

Клавиша-модификатор С кнопкой Mute С кнопкой Solo 

Shift 
 

С несколькими выделенными 
треками, переключает только текущий 
трек 

С несколькими выделенными треками, 
переключает только текущий трек 

Ctrl 
 

Снимает статус мьютирования со 
всех мьютированных треков 

Снимает статус солирования со всех 
солированных треков 

Alt 
 

Размьютирует выбранный трек (и), и 
мьютирует остальные 

Солирует только выбранные треки, 
исключает выходной сигнал с любых 
посылов 

Ctrl+Alt 
Мьютирует выбранный трек (и), 
размтютирует остальные 

Солирование в монопольном режиме: 
Солирует выбранный трек (и), снимая 
статус солирования остальных 

Ctrl+Shift 
 

Не применяется  
 

Переключает на режим Solo Defeat для 
трека или нескольких треков. См. 
примечание ниже 

 
Примечание: когда трек мьютируется, на его индикаторе уровня отображается маленький красный 
символ M. Символ !S указывает, что трек приглушен, потому что другой трек или треки солируются. 
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Функция Solo Defeat: функция Solo Defeat позволяет прослушивать трек, даже когда другой трек или несколько 
выделенных треков солируется в монопольном режиме. 

 
Контекстные меню кнопок Mute и Solo: опции, описанные выше, 
доступны также щелчком правой кнопкой мыши по кнопкам Mute и 
Solo соответственно. Опции контекстных меню можно применить к 
одному треку или к нескольким трекам. 
 
 
 
 
 
 
 

 
Функция Bulk Track Mute/Solo: чтобы мьютировать или солировать несколько треков одним действием, на 
панели трека захватите кнопку Mute или Solo первого из выбранных треков и перетащите ее на ту же самую 
кнопку последнего из выделенных треков, а затем отпустите кнопку мыши. Повторите это действие чтобы 
размьютировать/снять статус солирования со всех мьютированных или солированных выбранных треков. 
Фейдеры громкости и панорамирования: щелчок правой кнопкой по фейдеру громкости любого трека или 
трек-папки открывает окно с отображением фейдеров громкости и панорамирования не только конкретно для 
этого трека, но и для любого адресата и посыла, связанного с этим треком.  
 

 
 

Щелчок правой кнопкой на фейдере панорамирования открывает окно, 
которое может использоваться для выбора правила панорамирования 
(Pan Low) этого трека. Эта тема затрагивалась в Главе 2. 
 
 
 
 
 
 
 
 
 

Совет: по умолчанию, двойной щелчок на номере трека на панели трека выделяет все клипы на этом 
треке. Это поведение можно изменить на странице Options > Preferences > Mouse Modifiers. 
Подробнее о модификаторах мыши в Главе 15. 
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5.3. Функция Solo In Front 
 
Функция Solo in front позволяет прослушивать другие треки в фоновом режиме, когда один трек или несколько 
выбранных треков солируются. Чтобы активировать/отключить эту функцию, перейдите Options > Solo In Front.  

 
Уровень громкости при воспроизведении 
фоновых треков можно установить на 
странице Options > Preferences > Audio. 
Этот параметр (на рисунке, установленный 
в 18 dB) определяет степень, до которой 
уменьшится громкость фонового микса. Это 
означает, что чем выше это значение, тем 
тише будет фоновый микс и наоборот. 
 
 
 
 
 
 
 

5.4. Автопереименование нескольких треков 
 
Одним действием можно создать и автоматически переименовать любое количество треков, предназначенных 
для одной цели - например, несколько треков бэк вокала или треки перкуссии. Для этого, перейдите Insert > 
Multiple tracks.  
 

 
 
В данном примере, мы создали три трека бэк вокала (B Vox) в конце текущего списка треков, которые 
автоматически будут именованы B Vox 1, B Vox 2 и B Vox 3. 
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5.5. Поиск параметров предварительных настроек 
 
Мы уже сталкивались с некоторыми предварительными настройками REAPER. Например, мы рассматривали 
параметры страниц Devices, MIDI Devices, Recording и Projects. Чем больше вы будете работать с REAPER, 
тем быстрее вы поймете, насколько много он включает параметров. Есть и такие параметры, которые бывает 
трудно запомнить и страницу, на которой они находятся.  

 
Обратите внимание на текстовую область и кнопку Find внизу окна Preferences. В области 
можно ввести любое слово или фразу и нажать кнопку Find. Справа появится часть этого 

слова или фразы. Если это не тот элемент, который вы ищете, повторное нажатие кнопки Find будет 
отображать следующие похожие словосочетания. Найденные элементы окантовываются красной рамкой.  
 

 
 
В данном примере, поиск слова sends привел к определенной информации о различных опциях по умолчанию 
для посылов трека при создании последних. 

 
Совет: по умолчанию, двойной щелчок на номере трека выделяет все клипы на этом треке. Это 
поведение можно изменить, и/или добавить собственные модификаторы мыши на странице Options > 
Preferences > Editing Behavior > Mouse Modifiers. Например, вы можете назначить горячую клавишу Alt 

+двойной щелчок для изменения масштаба трека до максимальной высоты. Подробнее об этом в Главе 15. 
 

5.6. Цветовая идентификация треков 
 
В качестве эффективного средства помощи визуальной идентификации различных треков можно использовать 
цветовую палитру. Для этого, выберите трек (или треки) на панели треков, затем щелкните правой кнопкой 
мыши и выберите опцию Track Color, а затем используйте любую из нижеперечисленных опций в подменю: 
 

 
 
Set tracks to custom color: открывает диалоговое Color Selection, позволяющее выбрать цвет для клипов 
трека. 
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Set tracks to random colors: клипы каждого выбранного трека буду окрашены в произвольные цвета. 
Set tracks to one random color: клипы всех выбранных треков буду окрашены в один произвольный цвет. 
Set tracks to default color: восстанавливает цвет трека в значение по умолчанию для текущей темы. 
 
На странице Options > Preferences > Appearance > Track Control Panels можно выбрать опцию окраски фоновую 
область трека (Set track label background to custom track colors), фоновую область панели трека (Tint track panel 
backgrounds), или то и другое (отметив обе опции). Какого цвета будут клипы трека, зависит от опций на 
странице Options > Preferences > Appearance > Peaks/Waveforms. Здесь же можно установить интенсивность 
цвета для фоновой области выбранных клипов (Tint strength (0-4) for selected media item background) между 
значениями 0 и 4 и для выделенных и невыделенных (Unselected) треков. Подробнее об этих и других опциях 
страницы Appearance в Главе 22. 
 

5.7. Темы оформления 
 
REAPER включает несколько тем, которые могут улучшить визуальное восприятие ваших проектов. Чтобы 
выбрать тему оформления, перейдите Options > Themes.  
 

 
 
Выбрав действие Show theme tweak/configuration window из редактора действий REAPER можно изменить 
цвет и другие характеристики темы. Подробнее об этом в Главе 10, Главе 11 и Главе 13. Кроме того, очень 
большое количество бесплатных тем доступно на странице stash.reaper.fm. Дополнительные темы можно найти 
на пользовательских форумах REAPER. Примите во внимание: изменение темы может привести к изменениям в 
таких областях, как позиция панели трека. 
 

5.8. Символы идентификации трека 
 
Символы к трекам можно добавлять по вашему усмотрению. Можно перетащить ваш собственный PNG или JPG 
файл из проводника Windows на любой трек, или щелкнуть правой кнопкой мыши по номеру трека и перейти 
Track Icon > Set track icon, чтобы использовать любой символ из предоставленных в REAPER в диалоговом 
окне Load Image Resource.  
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Сделайте свой выбор и нажмите Открыть. На рисунке ниже представлен пример проекта с использованием 
символов трека.  
 

 
 
Помните, что, если вы создаете шаблон трека на основе определенного трека, который включает символ, этот 
символ будет сохранен с шаблоном. Чтобы эти символы отображались и в микшере, откройте микшер, откройте 
его контекстное меню и выберите опцию Show Track Icons in Mixer. Чтобы удалить символы с любого трека или 
нескольких треков, сначала выберите треки (на панели трека или в микшере), а затем щелкните правой кнопкой 
мыши по любому выбранному символу трека и выберите опцию Remove Track Icon из меню. Дополнительные 
символы можно найти на странице stash.reaper.fm 
 

5.9. Компановка треков 
 
Различные пользователи и различные проекты имеют различные потребности. Это одна из причин, почему  
в теме REAPER по умолчанию доступны несколько типов компоновки треков. Подробнее об этом в Главе 12.  
В качестве ознакомления сначала выберите трек (или треки), а затем щелкните правой кнопкой мыши по панели 
трека. В контекстном меню перейдите Set track layout > Track panel. Время от времени разрабатываются и 
добавляются новые компоновки. Некоторые примеры компоновок:  

 
Default: компоновка по умолчанию. 
 
 
 
Default + value readouts: параметры громкости и 
панорамирования отображаются текстом. 
 
 
 

Small: использует минимум места на экране. 
 
 

Large: облегчает считывание значений, но занимает 
больше свободного места на экране. 
 
 
 

Standard media: контроллер громкости отображается 
горизонтальным фейдером (а не регулятором). 
 
 
 

5.10. Мониторинг через наушники 
 
При прослушивании и оценке различных записанных клипов рекомендуется использовать студийные мониторы. 
Однако, время от времени можно также использовать и наушники, возможно для тех случаев, когда необходимо 
сфокусироваться на определенном треке или клипе. При условии, что у вас звуковая карта PCI или другое 
аудиоустройство (Firewire или USB), которое поддерживает несколько выходных портов сделайте следующее: 
 
1. Назначьте псевдонимы на выходные порты, как описывалось в Главе 1. 
2. Отобразите матрицу маршрутизации и направьте выходной сигнал с мастер-трека на динамики. 
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3. Подключите наушники. 
4. При воспроизведении песни, щелкните по соответствующим ячейкам матрицы трека, на каналах которых вы 
хотите сфокусироваться в наушниках.  
 

 
 
На примере выше, весь микс (с мастер-трека) прослушивается через динамики, но только трек 1 Vox также 
прослушивается и через наушники. Помните, что можно щелкнуть правой кнопкой мыши по ячейке и отобразить 
ее контроллеры посыла (например, громкость), как на рисунке выше. При микшировании вы можете отказаться 
от отображения всей доступной информации о маршрутизации - которая может показаться довольно сложной, 
сделав окно матрицы максимально упрощенным. Например, если вы просто фокусируетесь на микшировании, 
возможно, не обязательно отображать все назначения входных портов. Щелчок правой кнопкой мыши в области 
матрицы позволяет настроить ее вид.  

 
На примере выше и на рисунке слева не отметив опцию 
Show audio hardware as sources, мы упростили 
отображение матрицы. Если вы установили плагин 
ReaRoute, можно также отключить опции Show 
ReaRoute as destinations и Show ReaRoute as sources. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
5.11. Создание микса в наушниках 

 
Если ваша звуковая карта имеет по крайней мере две пары выходных портов, можно облегчить процесс 
мониторинга в наушниках, создав некий микс: 
 
1. Подсоедините наушники к предусилителю, а предусилитель к одной из пар выходных портов. 
2. Создайте новый трек и именуйте его Headphone Mix. Создайте посылы в этот трек с любых треков, которые 
вы хотите прослушать через микс. 
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3. Перейдите Options > Preferences > General > Advanced UI/System tweaks. Отметьте опцию Allow track 
envelope/routing windows to stay open. 
4. Нажмите кнопку OK, затем еще раз OK, чтобы закрыть окно Preferences. 
5. Выберите трек Headphone Mix и откройте матрицу маршрутизации. Добавьте выходной порт 
аудиоустройства в парные выходные порты, к которым подсоединен предусилитель. Отключите опцию 
Master/Parent Send для этого трека. 
 

 
 
6. Теперь вы можете использовать фейдеры громкости и панорамирования для адресатов, вместе с кнопками 
Mute для управления вашим миксом. 
 

5.12. Отображение линий сетки 
 
В проектах REAPER можно по-разному отобразить линии сетки. В данной главе мы рассмотрим три примера 

использования линий сетки. Чтобы отобразить/скрыть линии сетки, либо нажмите кнопку Grid  на панели 
инструментов, либо перейдите Options > Snap/grid > Show grid (Alt +G). Чтобы перейти к параметрам линий 
сетки либо щелкните правой кнопки мыши по кнопке Grid, либо перейдите Options > Snap/grid > Snap/grid 
settings (Alt +L).  
 

 
 
Примеры ниже иллюстрируют эффект при выборе различных параметров сетки, включая опции отображения 
линий маркеров. Маркеры будут подробно объяснены в Главе 9. 

 
Отображение сетки отключено 
 
 
 
 
 
 
 

Отображение сетки активировано: 
интервал - 1 доля, минимум 10 пикселей. 
Линии сетки проходят сквозь клипы, линия 
маркеров под клипами. Точечные линии 
сетки выделены. 
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Отображение сетки активировано: 
интервал - 1 доля, минимум 5 пикселей. 
Линии сетки проходят под клипом, линии 
маркеров над клипом. Точечные линии 
сетки не выделены. 
 
 
 

 
Отображение сетки активировано: 
интервал - 1 доля, минимум 5 пикселей. 
Линия сетки проходит над клипом, линии 
маркеров под клипом. Точечные линии 
сетки не выделены. 
 
 
 

 
Примите во внимание: можно определить интервал линий сетки отличный от интервала по долям. Это 
может быть полезным при работе с видеоклипами. (частота кадров устанавливается в параметрах 
проекта, см. Главу 2). Позже в данном руководстве (Глава 6 и Глава 7), мы рассмотрим использование 

параметров сетки для автоматической привязки различных объектов и клипов. 
 

5.13. Термины «посыл», «шина», «подмикс» и «трек-папка» 
 
Вы уже видели, что выходной сигнал каждого трека в ваших проектах по умолчанию направляется в мастер-
трек, а оттуда аудиосигнал направляется в выходной порт вашего аудиоустройства, например, на динамики или 
наушники.  
 

Поток сигналов в пределах REAPER можно представить на 
рисунке слева, который отображает простой проект с тремя 
треками.  
 
 
 
 
 
 
 
 
 
 

 
 
 В Главе 2 мы обсудили как использовать трек в 
качестве шины эффектов, например, чтобы добавить 
один эффект реверберации к нескольким трекам. Поток 
сигналов с шиной эффектов можно представить на 
рисунке слева. Посылы, которые вы создаете для 
каждого трека, направляют сигнал в трек-шину, которая 
включает эффекты, а затем трек-шина перенаправляет 
обработанный (wet) эффектами сигнал в мастер-трек. 
Вместе с тем, до тех пор, пока опция Send 
Master/Parent остается активированной, 
необработанный (dry) эффектами сигнал каждого трека 
также направляется в мастер-канал. И наконец здесь 
он смешивается с обработанным сигналом с шины, а 
затем направляется на динамики и/или наушники. Эти 
два примера использования маршрутизации вы можете 
применить в любом хосте.  

А теперь мы поговорим о тех существенных отличиях REAPER от другого программного обеспечения, которые 
вы, возможно, использовали прежде. Это касается создания и использования подмиксов. В большинстве 
программ чтобы создать подмикс вы должны создать шину, добавить посыл с каждого трека, который должен 
быть включен в подмикс, а затем отключить прямые посылы в мастер-треке с каждого из этих треков. Этот 
способ можно использовать и в REAPER. Щелчок по кнопке Route  трека с нажатой клавишей Alt 
активирует/отключает прямой посыл в мастер-трек.  
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Если посыл выходного сигнала трека в мастер-трек активирован, загорается первый из маленьких зеленых 

светоиндикаторов на кнопке . Если посыл выходного сигнала трека в мастер-трек отключен, светоиндикатор 
тухнет. Это различие иллюстрировано на рисунке ниже.  
 

 
 
В первом (верхнем) треке активирован посыл выходного сигнала с трека в мастер-трек. Во втором (нижнем) 
треке посыл выходного сигнала в мастер-трек отключен. Если на этом треке нет других посылов и адресатов, 
слово ROUTE подсвечивается красным цветом. Однако, более интеллектуальный и потенциально более 
мощный способ создания подмикса заключается в использовании трек-папки. На данном этапе мы рассмотрим 
этот термин вкратце. Трек-папка создается также, как и любой другой трек, который затем вы определяете в 
качестве трек-папки (folder). После этого у вас будет свой подмикс (как показано на рисунке ниже).  

 
Посыл прямого выходного сигнала с отдельных "дочерних" треков в пределах трека-папки в мастер-трек 
отключается автоматически. Вместо этого сигналы проходят через трек-папку. Примите во внимание: нельзя 
вручную отключить мастер/родительский посыл для дочерних треков в пределах трек-папки, в противном случае 
их выходной сигнал не будет направлен в трек-папку (мастер-трек). Все, что вы применяете к трек-папке, будет 
применено ко всему подмиксу. Например, если вы регулируете громкость, также будет регулироваться и 
громкость подмикса. Если вы добавляете эффект, например, компрессор к трек-папке, этот эффект будет 
применен и к подмиксу. Прежде, чем приступить непосредственно к конфигурации трек-папки и ее дочерних 
треков, рассмотрим еще один сценарий. Даже когда у вас есть трек-папка, которая включает подмикс других 
треков, можно использовать шины непосредственно самой трек-папки или отдельных треков в этой трек-папке 
(см. рисунок ниже).  

 
В данном случае наша трек-папка (подмикс) все еще включает те же самые три трека, как и прежде. Кроме того, 
однако, с трек-папки в шину эффектов будет создан посыл, возможно, чтобы добавить реверберацию к 
подмиксу. Скоро мы рассмотрим этот сценарий более подробно. Есть три типа посыла - Post-Fader (Post Pan), 
Pre-Fader (Post FX) и Pre FX. Подробно они объясняются в Главе 17 и иллюстрируются блок-схемами в конце 
Главы 6. На данном этапе оставьте опцию по умолчанию - Post-Fader (Post Pan). 
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5.14. Основы использования трек-папок 
 
Когда несколько треков сгруппированы в одну трек-папку, вы, вероятно, захотите использовать как отдельные 
контроллеры треков, так и контроллеры самой трек-папки. Например, можно использовать контроллер Volume 
отдельных треков в пределах трек-папки, чтобы установить уровни громкости различных треков относительно 
друг друга. Затем можно использовать контроллер громкости непосредственно самой трек-папки, чтобы 
отрегулировать общий суммарный относительный уровень громкости треков в этой трек-папке. Другой пример - 
контроллеры Mute и Solo трек-папки затронут трек-папку в целом. Тем не менее эти же контроллеры будут все 
еще доступны для каждого дочернего трека. Рисунок ниже отображает трек-папку под названием Instruments, 
которая содержит три дочерних трека.  
 

 
 
Затененное изображение сигналограммы, которые вы видите на дорожке трек-папки в области аранжировки 
представляет комбинированное содержимое дочерних треков. Это отображение можно отключить на странице 
Options > Preferences > Appearance > Peaks/waveforms, сняв флажок с опции Draw faint peaks in folder 
tracks. Обратите внимание на небольшие символы ниже номера каждого трека. Они используются для 
определения статуса трека. Обычно, это может быть одним из четырех статусов: 
 
Обычный трек высшего уровня (значение по умолчанию). Символ отображается расплывчатым символом трек-
папки. Наведите курсор мыши на этот символ, и он изменится на символ +. 
 

Трек-папка. На рисунке изображена треком Instruments. Наведите курсор мыши на 
этот символ, и он изменяется на символ X. 
 
 

 
Дочерний трек в пределах трек-папки. Трек 
встраивается в трек-папку, а символ отображается 
расплывчатым изображением трек-папки. Наведите 
курсор мыши на этот символ, и он изменяется на 
символ + 
 
 
 

 
Последний трек в трек-папке. Трек встроен в трек-папку со значком папки. Наведите курсор мыши на этот 
символ, и он превратится в стрелку вниз. Щелчок по этому символу позволяет установить статус трека. Давайте 
рассмотрим пример: 
 
1. Откройте файл All Through the Night.RPP и сохраните его под именем All Through the Night Folder.RPP 
2. Убедитесь, что трек Vox является первым треком, трек Gtr Body вторым треком, Gtr Neck третьим треком и 
Bouzouki четвертым треком. 
3. Нажмите Alt +Enter, чтобы открыть страницу параметров проекта. В качестве режима панорамирования 
проекта выберите Stereo Pan. Заметьте, что при этом к каждому треку добавляется регулятор Width. 
4. Выберите трек 1. Нажмите Ctrl+T, чтобы сразу вставить новый трек ниже этого трека, который становится 
треком 2. Именуйте этот трек Instruments. 
5. Щелкните по символу трек-папки этого трека. Трек становится трек-папкой, а треки ниже него расположатся с 
отступом. 
6. Мы хотим, чтобы трек Bouzouki был последним треком в трек-папке. Дважды щелкните по этому треку, чтобы 
установить это. Отрегулируйте панораму этих трех дочерних треков по вашему усмотрению. 
7. Выберите трек Bouzouki и нажмите Ctrl+T. Новый трек добавится за пределами трек-папки. 
8. Именуйте этот трек Reverb и вставьте плагин ReaVerbate в его цепочку эффектов. Перетащите поочередно 
кнопку Routing трека Vox и кнопку Routing трек-папки Instruments в трек Reverb для создания двух посылов. 
9. Убавьте громкость трека Reverb до значения - 10.0 db (как на рисунке ниже) и сохраните файл. 
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10. Воспроизведите файл. Поэкспериментируйте с контроллерами трек-папки. Например, обратите внимание, 
что мьютирование трек-папки будет мьютировать все инструменты. Солирование трек папки будет солировать 
также все инструменты. Отрегулируйте громкость каждого дочернего трека и общую громкость подмикса 
инструментов. 
11. Используйте контроллер Width трек-папки, чтобы приблизить или отдалить различные инструментальные 
треки одновременно. Используйте контроллер Pan, чтобы переместить весь инструментальный микс влево или 
вправо. Чтобы вернуть трек-папку в нормальный трек, щелкните по символу папки несколько раз чтобы перейти 
к нужному статусу. 
 
5.14.1. Создание трек-папки перетаскиванием 
 
Другой способ создания трек-папки - использование функции drag and drop. Определите трек, который должен 
стать трек-папкой, и треки, которые должны стать ее дочерними элементами, а затем выберите дочерние треки 
и перетащите их в трек-папку. Вероятно, этот способ покажется более быстрым, но поначалу может показаться 
несколько сложным. Давайте проиллюстрируем этот процесс:  
 

 
 
На рисунке выше тот же самый файл проекта, как и прежде (за исключением того, что на сей раз уже добавлен 
трек Reverb). Выбраны три трека, которые мы перетаскиваем. Обратите внимание на толстую горизонтальную 
синию полосу, выше первого из этих треков, занимающую всю ширину панели трека. Осторожно и медленно 
перетащите треки немного выше, и вы заметите, что горизонтальная полоса теперь располагается немного с 
отступом. Теперь отпустите кнопку мыши, и вы увидите, что три трека были помещены в качестве дочерних 
треков в недавно созданную трек-папку Instruments.  
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Если навести курсор мыши на символ папки трека Bouzouki, 
вы увидите подтверждение, что это последний трек в трек-
папке.  
 
 
 
 
 
 
 
 

 
Функция drag and drop может также использоваться для добавления треков в текущую трек-папку, и/или 
удаления их из трек-папки. Однако, к этому способу нужно немного привыкнуть.  

 
Обратите внимание на маленькую стрелку, направленную вниз 
выше номера трек-папки (в данном случае трека Instruments). 
Она может использоваться для переключения отображения 
дочерних треков в трек-папке между нормальным 

расположением (как показано на рисунке ниже), минимизированном и свернутом (как показано на нижнем 
рисунке слева). 
 

Обратите внимание, что в матрице маршрутизации, дочерние треки обозначены 
буквой F в столбце master/parent 
 
 
 
 
 
 
 
 
 
 

 
Родительский адресат также обозначается 
всплывающей подсказкой 
 
 
 
 
 

 
Родительский трек также отображается в окне 
маршрутизации трека. 
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5.14.2. Многоуровневые трек-папки 
 
REAPER позволяет создавать многоуровневые трек-папки (Nested Folders), помещая любое количество трек-
папок в текущую трек-папку. Эта функция, вероятно, больше подойдет для достаточно опытных пользователей 
хостов, нежели новичкам. Чтобы создать многоуровневую трек-папку, сначала создайте пустой трек в пределах 
текущей трек-папки верхнего уровня, затем используйте символ папки, чтобы превратить этот трек в трек-папку. 
Поскольку сам трек помещен в текущую трек-папку верхнего уровня, он автоматически превращается в трек-
папку второго уровня. На рисунке ниже изображен проект-пример использования этой функции. Обратите 
внимание на следующее: 
 

 
 
- трек-папка высшего (первого) уровня, Instruments, содержит две подпапки Drum Kit и Guitars. 
- трек-папка второго уровня, Instruments, содержит две подпапки (Drum Kit и Guitars). 
- две трек-папки второго уровня, которые являются подпапками трек-папки Instruments, содержат собственные 
дочерние треки. 
- другая трек-папка высшего уровня (Reverbs), непосредственно содержит две шины реверберации. 
 
Любое действие, примененное к трек-папке, затрагивает все ее содержимое. Например, если бы в этом случае 
вы мьютировали трек-папку Instruments, автоматически мьютировалось бы содержимое трек-папок Other 
Instruments и Acoustic Guitar. Количество уровней в трек папке неограниченно. 
 

5.15. Группировка треков и их параметров 
 

Примечание: наравне со стандартной группировкой, REAPER поддерживает VCA группировку (Voltage 
Controlled Amplifier). VCA группировку мы рассмотрим в отдельном параграфе этой главы. 
 

Тема группировки треков и их параметров огромна и включает обширный диапазон опций, особенно полезных 
при микшировании и аранжировке. Группировка основана на следующем принципе: вы определяете групповые 
отношения между различными треками и их контроллерами, гарантируя, что, когда вы производите изменение в 
одном треке группы, изменения коснутся и в остальных треках группы. У каждого пользователя будут свои 
собственные различные способы группировки треков REAPER. Давайте рассмотрим некоторые возможные 
примеры, которые были выбраны прежде всего для того, чтобы понять суть группировки.  
 
- например, у вас есть два трека, громкость которых должна изменяться пропорционально относительно друг 
друга. 
- например, у вас есть два трека, которые должны быть панорамированы в разные каналы. В этом случае, 
можно гарантировать, что при панорамировании одного трека в одном направлении, другой трек будет 
автоматически панорамирован в другом направлении. 
- например, у вас есть два трека или более треков, которые вы хотите обработать как группу так, чтобы они 
всегда солировались или мьютировались вместе. 
 
Есть два основных способа создания и управления группами. Это можно сделать с использованием панели 
треков или матрицы группировки треков. 
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Способ 1-  использование диалогового окна Grouping (рисунок ниже), доступ к которому можно получить в 
контекстном меню панели трека или панели микшера. 
 

 
 
- на панели трека или на панели микшера, выберите треки, параметры которых вы хотите сгруппировать. 
- щелкните правой кнопкой по номеру любого выделенного трека и выберите опцию Track grouping parameters 
из контекстного меню (или нажмите Shift +G). 
- в диалоговом окне определите параметры, которые вы хотите сгруппировать, а затем нажмите Close. 
- убедитесь при этом, что отмечена опция Track grouping enabled в контекстном меню панели трека или панели 
микшера. 
 
Этот же самый способ можно использовать позже для изменения параметров в сгруппированных треках. 
Возможно, сначала этот способ покажется сложным, поэтому есть смысл рассмотреть второй способ.  
 
Способ 2 - использование матрицы группировки треков. Матрица группировки треков, которая может быть 
прикреплена на панель Docker, может использоваться для управления до 32 различными группами. Чтобы 
отобразить матрицу группировки треков, перейдите View > Track Grouping Matrix (Ctrl+Alt+G).  
 

 
 
На рисунке выше показаны только две группы. Мы можем создать специальный файл проекта для данного 
примера. Потом можно сгруппировать любое количество треков: в данном примере мы будем работать с двумя 
из трех треков, включенных в трек-папку. Примите во внимание: необязательно помещать треки в трек-папку, 
чтобы их сгруппировать. 
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5.15.1. Основа группировки треков 
 
Пример: 
 
В последующих примерах показан дополнительный контроллер Width, но он не включен в группы. Будет ли он 
присутствовать, зависит от компоновки треков. Подробнее об этом в Главе 10 и Главе 11. 
 
1. Откройте файл All Through the Night.RPP и сразу сохраните его под именем All Through the Night 
GROUPS.RPP 
2. Выберите трек 1 (Vox) и нажмите Ctrl+T, чтобы создать новый трек ниже трека Vox. Именуйте новый трек 
Instruments. Используя способы, описанные ранее в этой главе, определите этот трек в качестве трек-папки. 
Включите в трек-папку два трека гитары и трек Bouzouki. Сделайте Bouzouki последним треком в трек-папке. 
Сохраните этот файл. Во-первых, убедитесь, что в меню Track отмечена опция Track grouping enabled. 
3. Перейдите View > Track Grouping Matrix, чтобы отобразить матрицу группировки треков. 
4. Панорамируйте один трек гитары приблизительно на 50 % влево, а другой трек гитары на 50% вправо. 
5. В группе 1 в матрице группировки треков, щелкните по ячейкам Gtr Body и Gtr Neck в столбце Volume. 
6. Щелкните по ячейкам Gtr Body и Gtr Neck в столбце Pan. В этом же столбце, щелкните также по ячейке Pan 
Reverse для одной из гитар, как показано на рисунке ниже. 
 

 
 
7. Теперь регуляторы громкости этих двух гитарных треков будут сгруппированы так, чтобы при регулировании 
громкости любого из этих треков, оба фейдера громкости двигались одновременно в одном направлении. 
8. Теперь, когда вы перемещаете контроллер панорамирования влево или вправо любого из этих треков, 
фейдер панорамирования другого трека будет перемещаться в противоположном направлении. 
9. Сохраните файл. 
10. Теперь щелкните по ячейкам двух треков гитар в столбцах Mute и Solo и снова сохраните файл. Теперь 
контроллеры Mute и Solo этих двух треков также будут привязаны друг к другу. 
11. Чтобы временно отключить группировку, при регулировании контроллера одного из треков гитары 
удерживайте клавишу Shift. 
12. Чтобы временно отключить группировку в целом, щелкните там, где показано на рисунке ниже на 
контроллере группы 1. 
 

 
 
13. Щелкните по этой же самой ячейке снова, чтобы снова активировать группировку. Сохраните файл.  
 

Примечание: группировка клипов может принимать статусы master (M), slave (S) или master/slave (по 
умолчанию). В данном примере вся группировка производилась в статусе master/slave. 
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5.15.2. Основные действия в матрице группировки треков 
 
Чтобы поместить треки в другую группу: откройте матрицу группировки треков. Выберите по крайней мере 
один параметр (например, Pan) каждого трека в группе. 
Чтобы отрегулировать все привязанные фейдеры группы: в микшере или в области аранжировки, 
отрегулируйте фейдер любого трека в группе. 
Чтобы отрегулировать фейдер только для одного трека в группе: в микшере или в области аранжировки, 
отрегулируйте фейдер, удерживая клавишу Shift. 
Чтобы определить отношение панорамы или громкости в противоположных значениях для треков в пределах 
группы: в строке трека, щелкните по перекрестной ячейке Pan Reverse или Volume Reverse соответственно. 
Чтобы изменить отношение текущего переключаемого параметра (такого как Solo, Mute или Record Arm) 
в противоположное значение: в окне микшера, удерживая клавишу Shift, щелкните по соответствующей кнопке 
(например, Solo или Mute) отдельного трека. Используйте повторно клавишу Shift, чтобы восстановить 
позитивную связь. 
Чтобы привязать несколько параметров треков в текущей группе: щелкните по перекрестным ячейкам там, 
где нужный столбец параметра пересекает строки трека. 
Чтобы добавить трек к текущей группе: щелкните по перекрестной ячейке, где нужный столбец параметра 
пересекает строку трека, который необходимо добавить. 
Чтобы удалить трек из текущей группы: щелкните один, два или три раза по соответствующей перекрестной 
ячейке пока она не окажется пустой. Если привязаны несколько параметров, выполните вышеописанные шаги 
для каждого параметра. 
Чтобы активировать/отключить группировку: щелкните по области Enable/Disable группы. 
Чтобы выбрать все треки в группе: щелкните по названию группы. 
Чтобы гарантировать, что режим автоматизации дочерних треков автоматически будет следовать за режимом 
автоматизации мастер-трека: используйте столбец Automation Mode для треков в группе. 
Чтобы точно настроить поведение групп, которые используют общие треки: используйте параметры 
настройки Flag: No Slave-Master, чтобы гарантировать, например, что трек, который является мастер-треком в 
группе 1 и дочерний трек в группе 2, не будет мастер-треком в группе 1, работая дочерним в группе 2. 
 
5.15.3. Индикаторы уровня в мультиканальных треках 
 
Если трек включает более двух каналов, становится доступной опция отображения выходного сигнала всех 
каналов на индикаторах уровня трека на панели трека и в микшере. Эта переключаемая опция (Multichannel 
track metering) для любого трека или нескольких выбранных треков выбирается в контекстном меню панели 
трека. На рисунке ниже - четырехканальный трек с аудиосигналом в микшере, а также темой и компоновкой по 
умолчанию. 
 

 
 
5.15.4. Отношения мастер-группы и дочерних групп 
 
Каждый параметр, вовлеченный в групповые отношения, может принимать один из трех статусов - Master/Slave 
(по умолчанию), Master only, или Slave only. Ниже перечислены различные ситуации, которые влияют на 
поведение этого параметра: 
 
- master/slave элемент может управлять другими master/slave и slave only элементами, но не master only 
элементами. Master/slave элементом могут управлять другие master/slave и master only элементы. 
- master only элемент может управлять другими master/slave и slave only элементами, но не master only 
элементами. Master only элементом не могут управлять другие элементы. 
- slave only элемент не может управлять никакими другими элементами, но им могут управлять master/slave и 
master only элементы. 
 
Не волнуйтесь, это не так сложно, как кажется. Чтобы понять смысл всего вышесказанного, давайте разберем 
несколько примеров. В предыдущем примере у всех элементов в группе был статус master/slave. Это означало, 
например, что, когда вы регулировали панораму или громкость любого из двух треков гитары, эквивалентный 
параметр на другом треке гитары перемещался согласно выставленному между ними отношению. Теперь 
давайте рассмотрим другие сценарии. 
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Пример: 
 
1. Откройте файл All Through The Night GROUPS.RPP, который вы создали в последнем примере. Мы 
собираемся добавить регулятор громкости трека Bouzouki к этой группе со статусом slave only. 
2. Откройте матрицу группировки треков. Щелкните по строке Bouzouki столбца Volume для группы 1, чтобы 
добавить трек в группу. Статус этого трека по умолчанию назначается в master/slave. 
3. Щелкните по той же самой ячейке еще раз. Отображение ячейки изменится на букву М. Теперь у этого трека 
статус master only. Щелкните еще раз, и отображение ячейки изменится на букву S и соответственно статус на 
slave only (рисунок ниже). 
 

 
 
4. Понаблюдайте за этим треком на панели трека или на панели микшера. Вы увидите только одну цветную 
полоску на регуляторе громкости трека (вместо двух). На панели трека она будет справа, на панели микшера 
она будет в нижней части, указывая на статус slave only трека. 
5. Воспроизведите песню. Громкость любого трека гитары сначала повысьте, а потом понизьте. Заметьте, что в 
виду статуса slave only громкость трека Bouzouki будет регулироваться в соответствии с громкостью трека 
гитары. 
6. Теперь сначала повысьте, а потом понизьте громкость трека Bouzouki. В виду его статуса, он не может 
управлять никаким другим треком. Фейдеры громкости треков гитары не будут перемещаться по мере 
изменения громкости трека Bouzouki. 
7. Теперь, давайте изменим статус контроллера громкости трека Bouzouki на master only. Щелкните по этой 
ячейке несколько раз до появления буквы М. 
8. Это является противоположностью того, что произошло в шаге 3. Во-первых, цветная полоска для этого 
элемента теперь отображается только на левой стороне вместо правой. Это подтверждает его статус master 
only (рисунок ниже). 
 

 
 
9. Воспроизведите песню. Если теперь вы будете регулировать фейдер громкости трека Bouzouki, фейдеры 
двух треков гитары будут регулироваться также. Однако, если вы будете регулировать громкость любого трека 
гитары, другой трек гитары будет регулироваться также, а фейдер трека Bouzouki нет. 
10. Сохраните файл по окончании. 
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5.15.5. Окно группировки треков 
 
Ранее мы познакомились с окном группировки треков, и узнали, что интерфейс окна обеспечивает различные 
способы работы с группировкой треков и их параметрами. Теперь давайте рассмотрим, как окно группировки 
треков отображает информацию о группе и о различных параметрах любого выбранного трека или нескольких 
выбранных треков. Имеет смысл использовать окно группировки треков с отдельными треками, по одному. 
Опять же вам будет понятней, если мы будем работать с примерами. 
 
Пример: 
 
1. В открытом проекте All Through The Night GROUPS.RPP выберите трек Gtr Body на панели треков или в 
контекстном меню панели выберите опцию Track Grouping Parameters (Shift +G). Откроется окно группировки 
выбранного трека. 
 

 
 
2. На панели трека, выберите трек Bouzouki. Дисплей окна группировки треков изменится (рисунок ниже), 
отображая текущие сгруппированные параметры для трека Bouzouki - в данном случае, только основной 
контроллер громкости трека. 
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5. В этом диалоговом окне, выберите опции Mute Master, Solo 
Master, Mute Slave и Solo Slave. Теперь эти групповые 
параметры будут также выбраны для этого трека, что 
подтверждается отображением в матрице группировки треков 
(рисунок слева). 
6. Еще одно, что мы можем сделать - переименовать группу. 
Нажмите кнопку Rename, напечатайте Instruments и нажмите 
Enter. 
7. Закройте диалоговое окно. Обратите внимание на матрицу 
группировки треков. Сохраните файл. 
 
 
 
 
 

 
В проекте можно назначить до 32 групп. В примере ниже, была добавлена вторая группа, чтобы помочь при 
регулировании баланса громкости между треком вокала и инструментальным миксом. 
 

      
             

 
 
Примечание: можно щелкнуть правой кнопкой по пустой фоновой области матрицы и открыть меню, 
которое позволяет активировать (рисунок наверху слева)/отключить (рисунок наверху справа) опцию 
Show individual group details (показать детали отдельной группы). 

 
5.15.6. Окно группировки треков Основные контроллеры и действия 
 
Чтобы определить треки в новую группу: выберите треки на панели треков, нажмите Shift +G, а затем 
выберите по крайней мере один параметр. 
Чтобы переименовать группу: нажмите Shift +G, выберите номер группы и нажмите Rename. 
Чтобы отрегулировать одновременно все привязанные фейдеры группы: отрегулируйте фейдер любого трека в 
группе. 
Чтобы отрегулировать фейдер только для одного трека в группе: удерживая клавишу Shift, отрегулируйте этот 
фейдер. 
Чтобы определить отношение панорамы или громкости в противоположном направлении для треков в пределах 
группы: выберите трек на панели треков и нажмите Shift +G. Нажмите Reverse Volume или Reverse Pan. 
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Чтобы изменить отношение текущего переключения параметра (такого как Solo, Mute или Record Arm) в 
противоположное состояние: удерживая клавишу Shift, нажмите соответствующую кнопку (например, Solo или 
Mute) отдельного трека. 
Чтобы привязать несколько параметров треков в текущей группе: откройте диалоговое окно группировки 
для этой группы и выберите нужные параметры. 
Чтобы сбросить контроллеры Volume, Pan или Width в их значения по умолчанию и отрегулировать параметры 
других членов группы соответственно: дважды щелкните по контроллерам Volume, Pan или Width на панели 
трека. 
Чтобы добавить трек к текущей группе: выберите трек на панели треков и нажмите Shift +G. Откройте 
выпадающий список групп и выберите нужную группу. Выберите нужные параметры. 
Чтобы удалить трек из текущей группы: выберите трек на панели треков и нажмите Shift +G. Снимите 
флажки у всех выбранных элементов кроме Group enabled 
Чтобы активировать/отключать группу: нажмите Shift +G, выберите группу из выпадающего списка, а затем 
щелкните по области Group enabled. 

 
Совет: при воспроизведении песни, в ходе редактирования время от времени вы можете захотеть 
сбросить пиковые уровни индикаторов уровня, без остановки и перезапуска воспроизведения. Чтобы 
очистить один пиковый уровень, просто щелкните по показателю уровня на правой стороне индикатора 

на панели трека или наверху индикатора в микшере. Чтобы сбросить все пиковые уровни, щелкните на 
показателе уровня на правой стороне индикатора на панели трека или наверху индикатора в микшере с нажатой 
клавишей Ctrl. 
 

5.16. Индикаторы уровня мультиканальных треков 
 

Если у трека больше двух каналов, на индикаторах уровня трека становится доступной опция 
отображения выходного сигнала всех каналов на панели трека и в микшере. Чтобы 
активировать/отключить эту функцию для любого трека или нескольких выбранных треков, в 
контекстном меню панели трека отметьте опцию Multichannel track metering. На рисунке слева - 
четырехканальный аудиотрек в микшере с использованием темы по умолчанию. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.17. VCA группировка 
 
Источники VCA (Управляемые напряжением усилители) предшествуют цифровому аудио. Сегодня, 
современная реализация управляемых напряжением усилителей REAPER открывает интересные возможности 
микширования. Проводя аналогию, VCA в REAPER - это форма группировки треков, которая позволяет 
сгруппировать дочерние треки в один мастер-трек. Дочерние VCA треки имеют свой контроллер громкости 
вдобавок к контроллеру громкости VCA мастер-трека. Таким образом, группировка VCA - это аддитивный 
процесс. В случае со стандартной группировкой (как было объяснено в Параграфе 5.15) ничего не добавляется, 
треки просто привязываются друг к другу. VCA группы можно создать и управлять ими в той же самой матрице 
группировки треков, с которой мы познакомилась ранее в этой главе. С опытом и экспериментированием вы 
приедете к осознанию, что VCA группировка может оказаться очень полезным инструментом микширования. 
Для начала, мы будем придерживаться простых примеров для понимания VCA группировки. Основная 
процедура создания VCA группы: 
 
1. Добавьте новый трек в проект и дайте ему подходящее имя, например, VCA Control. Обычно, этот трек не 
должен содержать клипов. 
2. Откройте матрицу группировки треков и выберите неиспользуемую в настоящий момент группу. 
Дополнительно, можно дать этой группе имя. 
3. Установите статус VCA в этой группе для VCA трека в М (для мастер-трека). 
4. Установите статус VCA в этой группе для любых треков, которые вы хотите добавить в группу в S. 
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Пример: 
 
1. Откройте файл All Through the Night.RPP и сохраните его под именем All Through the Night VCA.RPP. 
2. Панорамируйте первый из гитарных треков приблизительно на 35 % влево, а другой приблизительно на 35% 
вправо. 
3. Добавьте новый трек (трек 5) и именуйте его VCA Control 
4. Отобразите матрицу группировки треков (Ctrl+Alt+G). Убедитесь, что другие треки находятся в том же самом 
порядке в матрице как показано на рисунке ниже. 
 

 
 
5. В матрице группировки треков, щелкните правой кнопкой по текстовой области и, чтобы открыть диалоговое 
окно группировки. Нажмите кнопку Rename, затем введите VCA и нажмите кнопку OK, после этого закройте 
диалоговое окно. 
 

 
 
6. Сконфигурируйте эту группу так, чтобы трек 5 стал VCA мастер-треком, а треки 2, 3 и 4 дочерними VCA 
треками. Для этого щелкните по соответствующей ячейке каждого из этих треков, чтобы добавить их к группе, а 
затем щелкните еще раз, чтобы сделать трек мастер-треком (M) и (для треков 2, 3 и 4) щелкните еще раз, чтобы 
изменить их статус на S. 
7. Воспроизведите песню. По мере повышения громкости VCA трека, повышается громкость трех 
инструментальных треков. По мере уменьшения громкости трека 5, инструменты становятся тише. 
8. Заметьте, что уровни индикатора на дочерних инструментальных треках при этом не меняются. Происходит 
это потому, что громкость фактического сигнала каждого из этих отдельных треков, не изменяется. Это 
громкость инструментальных треков, добавленных к VCA треку, сигнал с которого отсылается в мастер-трек. 
Таким образом, при редактировании фейдера громкости VCA трека изменяются уровни индикатора мастер-
трека. 
9. Вы можете отрегулировать громкость какого-либо отдельного инструментального трека, не затрагивая 
остальные треки в группе. Сохраните файл. 
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10. Теперь давайте попробуем что-нибудь другое. Убедитесь, что для всех треков установлено правило 
панорамирования Stereo balance/mono pan. Делается это щелчком правой кнопкой мыши по контроллеру 
панорамирования трека и выбором правила панорамирования из выпадающего списка Pan law. 
 

 
 
11. Щелкните по ячейке Bouzouki в VCA матрице, чтобы удалить ее из группы. 
12. Теперь снова воспроизведите песню. Отрегулируйте параметр панорамирования VCA трека. Вы обнаружите, 
что панорамирование трех инструментальных треков будет отрегулировано соответственно. Сохраните файл. 
 
5.17.1. Параметры VCA группировки 
 
Список ниже суммирует опции и параметры матрицы VCA группировки: 
 
Volume: отрегулируйте фейдер громкости VCA мастер-трека, чтобы отрегулировать громкость всех дочерних 
треков в VCA группе. Примите во внимание, что фейдеры самого дочернего трека не регулируются. 
Pan: если в качестве правила панорамирования были выбраны опции Stereo balance/mono pan или Stereo pan, 
при изменении панорамы VCA мастер-трека будет изменяться и панорама всех дочерних треков в группе. 
Фейдеры панорамирования дочерних треков при этом не регулируются. 
Pre FX Slave: если в матрице группировки треков для какого-либо дочернего VCA трека выбрана опция Flag: 
VCA pre-FX slave, громкость сигнала будет регулироваться до его добавления в цепочку эффектов трека. 
Automation: изменения контроллеров Volume, Pan, и Width дочерних треков можно автоматизировать, добавив 
соответствующие огибающие к треку управления VCA. Огибающие будут применены ко всем дочерним трекам в 
группе. У дочерних треков могут быть также и свои собственные огибающие автоматизации. Подробнее об этом 
в Главе 18. 
Mute: огибающую мьютирования можно добавить к VCA мастер-треку. Эта огибающая будет применена ко всем 
дочерним VCA трекам в группе. Огибающие автоматизации объясняются в Главе 18. 
 

Примечание: определение трека в качестве VCA мастер-трека заставит фейдеры громкости и панорамы 
этого трека управлять громкостью и панорамированием всех его дочерних треков. Имейте в виду, что 
трек управления VCA - это не трек-папка или подмикс. Никакой аудиосигнал не проходит через VCA 

мастер-трек/трек управления. Таким образом, например, не имело бы никакого смысла добавлять любой 
аудиоэффект непосредственно к треку управления VCA. 
 
5.17.2. Дополнительные примеры моделей VCA группировки 
 
Вот еще некоторые примеры ситуаций, в которых VCA группировка может оказаться полезной. Несомненно, со 
временем вы пойдете дальше и возможно найдете свои собственные более сложные применения. 
 
5.17.2.1. VCA с огибающими автоматизации 

 
Чтобы понять суть написанного 
в этом параграфе необходимо 
иметь представление об 
огибающих автоматизации. 
Огибающие автоматизации 
подробно объясняются в Главе 
18. Проблемы могут возникнуть 
при использовании огибающих 
автоматизации со стандартными 
группами. Например, 
огибающая громкости или 
панорамирования мастер-трека 

в стандартной группе будет при воспроизведении регулировать громкость или панораму только этого одного 
трека, а не его дочерних треков. С VCA группировкой, огибающая трека будет применена к суммированному 
общему количеству его дочерних треков.  
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Кроме того, у вас могут быть отдельные огибающие автоматизации и огибающие VCA мастер-трека и любого из 
его дочерних треков в пределах группы. На рисунке выше показан тот же самый проект, как и в предыдущем 
примере, с теми же самыми группами как прежде, но с огибающими громкости, добавленными к VCA мастер-
треку и одному из его дочерних треков (Bouzouki). Суммированные уровни обеих огибающих дочернего и 
мастер-трека, при воспроизведении отсылаются в мастер-трек. 
 
5.17.2.2. Действия управления VCA огибающими 
 
Есть два действия, обеспечивающие дополнительную функциональность VCA огибающих - Envelope: apply all 
VCAs from selected tracks to grouped tracks and reset volume/pan/mute и Envelope: apply all VCAs to 
selected tracks and remove from VCA groups. Эти действия подробно объясняются в Главе 15, но, если 
вкратце, можно назначить ваши собственные горячие клавиши на эти действия, и/или добавить их в меню 
REAPER. Эффект этих действий иллюстрируется ниже.  

    
 
Треки 2 и 3 являются дочерними трека 4 в VCA группе. К VCA мастер-треку добавлена огибающая громкости. 
Этот трек выделен (рисунок слева). Применение опции Envelope: apply all VCAs from selected tracks to 
grouped tracks and reset volume/pan/mute добавит идентичную огибающую к каждому из дочерних треков 
группы и удалит ее из мастер-трека (рисунок справа). Параметры VCA группы остаются нетронутыми. 
Применение опции Envelope: apply all VCAs from selected tracks to grouped tracks and remove from VCA 
group также добавит идентичные огибающие громкости к каждому из дочерних треков группы, но эти треки 
будут удалены из VCA группы, а огибающие VCA мастер-трека (в данном примере, трек 4), останутся 
нетронутыми. Примите во внимание: если какой-либо из дочерних VCA треков уже будет содержать огибающую 
громкости, то значения огибающей VCA мастер-трека будут добавлены к этим значениям огибающей дочернего 
трека. Вышеперечисленные опции можно применять к огибающим панорамирования, ширины стереополя, 
громкости и мьютирования VCA мастер-трека. 
 
5.17.2.3. VCA с многоуровневыми группами 

 
Стандартная группировка не полностью учитывает 
перекрывающийся состав группы. Например, на рисунке 
слева фейдеры громкости треков 1 - 3 сгруппированы 
как мастер-треки и дочерние треки в одной группе, треки 
4 - 6 во второй группе. Мы можем сгруппировать, 
скажем, фейдеры громкости треков 1 и 6 так, чтобы они 
могли перемещаться вместе при необходимости. VCA 
группировка делает это возможным. Мы добавляем трек 
управления VCA (трек 7), и создаем третью группу как 
показано на рисунке ниже: теперь вы можете 
отрегулировать громкость треков 1 и 6 вместе, 
редактируя фейдер громкости трека 7 - трека 
управления VCA. Остальные треки не затрагиваются. 
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5.17.2.4. VCA для управления миксом 
 

Это более сложный и тонкий пример: новичкам работы  
с секвенсорами или с REAPER настоятельно 
рекомендуется избежать этого примера, пока ваши 
знания и опыт не достигнут соответствующего уровня.  
В данном примере используется VCA группировка  
в проекте, который включает как треки, так и трек-папки. 
Созданы три VCA группы, каждая с ее собственным 
мастер-треком. Расположение треков (на рисунке 
слева) необходимо интерпретировать вместе с 
матрицей группировки треков, как на рисунке ниже.  
 
 
Группы: 
 
Группа 1: Vocals VCA Control, трек 14 (управляет 
треком Lead Vocal и трек-папкой Harmonies). 
Группа 2: DrumsBass VCA Control, трек 15 (управляет 
трек-папкой Drums и треком Bass). 
Группа 3: Guitars VCA Control, трек 16 (управляет трек-
папкой Guitars и Bouzouki). 
 
Использование этих трех мастер треков VCA может 
помочь в микшировании, облегчающем достижение 
необходимого баланса звучания между вокалом и 
инструментами в этом миксе. Микс эффективно 
разделен на три группы. Громкость и панорама 
отдельных треков можно все еще регулировать как 

обычно, но кроме этого контроллеры VCA могут использоваться для регулирования баланса между этими тремя 
группами. Эта конфигурация иллюстрируется в матрице группировки треков на рисунке ниже. 
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5.18. Функции Jogging и Scrubbing 
 

Функции джоггинг (Jogging) и скраббинг (Scrubbing) появились в дни, когда вся 
запись выполнялась на магнитную ленту. Эти функции помогают перемещаться 
по проекту, или треку, или группе треков, прослушивать или определять 
местоположение определенного фрагмента. В REAPER обычно это делается 
тогда, когда проект остановлен. Чтобы промотать определенный фрагмент песни, 
просто захватите треугольник наверху указателя текущей позиции, как показано 
на рисунке слева - при этом курсор мыши изменится на символ руки - и 
перетащите его в любом направлении. По умолчанию, если при перетаскивании 

удерживать клавишу Ctrl, активируется режим Scrub. В этом режиме воспроизведение замедляется. Параметры 
функций jog/scrub можно настроить на странице Options > Preferences > Audio > Playback. Заметьте в 
особенности что: 
 
- можно ограничить максимальную частоту (скорость) промотки не больше, чем при нормальной скорости 
воспроизведения (Limit jog rate/Limit scrub rate to 1/0x). Это облегчает идентификацию аудиоматериала при 
джоггинге и скраббинге. 
- можно также активировать режим jog/scrub, чтобы заменить им нормальное воспроизведение (Engage scrub 
when playing). 
- если отмечена опция Only play selected tracks, при джоггинге и скраббинге будут слышны только выбранные 
треки. Поведение режимов jog/scrub с использованием модификаторов можно изменить на странице Options > 
Preferences > Mouse Modifiers.  
 
Параметры по умолчанию показаны на рисунке ниже.  
 

 
 
Опция Looped segment mode может использоваться для прослушивания фрагмента в режиме зацикливания.  
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Можно также назначить модификаторы 
для режимов jog/scrub на среднюю 
кнопку мыши в области аранжировки. 
Подробнее о модификаторах мыши см. в 
Главе 22. 
 
 
 
 
 
 
 
 
 

 
5.19. Кнопки панели инструментов по умолчанию 

 
Панель инструментов REAPER по умолчанию располагается в верхнем левом углу экрана. С различными 
инструментами и их функциями мы знакомились по ходу этого руководства по мере необходимости: кроме того, 
ниже представлен рисунок с описаниями кнопок. Фактическое появление отдельных символов будет зависеть от 
выбранной темы оформления, которую можно выбрать с помощью опции Options > Themes. Отображенные на 
рисунке символы используются темами оформления по умолчанию как для REAPER 5, так и для REAPER 4. 
 

 
 
1 – создать новый проект 
2 – открыть текущий проект 
3 – сохранить проект 
4 – параметры проекта 
5 – функция Undo 
6 – функция Redo 
7 - метроном 
8 – функция Auto Crossfade 
9 – группировка клипов 
10 – функция Ripple Editing 
11 – опции огибающих 
12 – опции сетки 
13 – опции привязки 
14 – опции фиксирования 
 
Горячие клавиши панели инструментов (эквивалент левого щелчка мыши): 
 
(1) Создать новый проект: Ctrl+N 
(2) Открыть проект: Ctrl+O 
(3) Сохранить проект: Ctrl+S 
(4) Параметры проекта: Alt +Enter 
(5) Функция Undo: Ctrl+Z, чтобы отменить последнее действие. Щелкните правой кнопкой мыши, чтобы 
отобразить историю отмен 
(6) Функция Redo: Ctrl+Shift+Z, чтобы восстановить последнее действие. Щелкните правой кнопкой мыши, 
чтобы отобразить историю отмен 
(7) Метроном: щелкните левой кнопкой мыши, чтобы активировать/отключить метроном. Щелкните правой 
кнопкой мыши для отображения диалогового окна параметров 
(8) Автоматический кроссфейдинг: используйте Alt +X, чтобы активировать/отключить 
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(9) Группировка клипов: используйте Alt +Shift+G, чтобы активировать/отключить. Щелкните правой кнопкой 
мыши для вызова меню 
(10) Функция Ripple Editing: используйте Alt +P, чтобы активировать/отключить. Щелкните правой кнопкой 
мыши для отображения контекстного меню 
(11) Огибающие, перемещение точек с клипами: щелкните левой кнопкой, чтобы активировать/отключить. 
Щелкните правой кнопкой мыши для вызова контекстного меню 
(12) Отображение линий сетки: используйте Alt +G, чтобы активировать/отключить. Щелкните правой кнопкой 
мыши для отображения диалогового окна параметров 
(13) Функция привязки (Snap): используйте Alt +S, чтобы активировать/отключить. Щелкните правой кнопкой 
мыши для отображения диалогового окна параметров 
(14) Функция фиксирования (Locking): используйте клавишу L, чтобы активировать/отключить. Щелкните 
правой кнопкой мыши для отображения диалогового окна параметров 
 
Панель инструментов можно отредактировать, например, добавить больше инструментов для других опций и 
действий. Можно также создать дополнительные собственные панели инструментов. Эта тема затрагивается в 
Главе 15. 
 

5.20. Расширение SWS 
 
По мере знакомства с REAPER, вы обнаружите, что есть множество действий редактирования, которые вы 
хотите использовать наиболее часто. Большинство этих действий доступны через пакет расширений SWS 
Extensions: 
 
1. Перейдите на страницу http://www.standingwaterstudios.com 
2. Следуйте инструкциям, чтобы загрузить правильную версию для вашей операционной системы. 
3. После загрузки, запустите программу установки, а затем запустите REAPER как обычно. 
 
Содержимое этого пакета включает не только сотни полезных действий редактирования и других, но также и 
целые модули, которые обеспечивают дополнительную функциональность REAPER, включая снимки 
микширования управление маркерами. Для SWS расширений доступен отдельный мануал в формате PDF. 
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6. Управление эффектами трека 
 
Мы уже рассматривали основные способы использования эффектов (Direct X и VST) с треками REAPER. Теперь 
мы рассмотрим некоторые опции, которые помогут управлять и использовать плагины более эффективно. 
Отдельные эффекты более подробно мы рассмотрим в Главе 16, а в этой главе мы, главным образом, 
сосредоточимся на проблемах управления и организации плагинов. 
 

6.1. Группировка эффектов в папки 
 
Эффекты можно сгруппировать в любое время по вашему усмотрению. Например, если вы часто используете 
эффекты Chorus Delay и Reverb, можно создать одну папку с названием Chorus/Delay, и другую с названием 
Reverb. Часто используемые плагины можно скопировать в специальные группы. Количество создаваемых 
папок неограниченно, а один и тот же плагин можно поместить в разные папки. Например, вы можете поместить 
плагин Bootsy EpicVerb и в папку Reverb и в папку Bootsy. 
 
Чтобы создать групповую папку эффектов: 
 
- перейдите View > FX Browser (Shift +F), чтобы открыть браузер эффектов. 
- щелкните правой кнопкой мыши по лейблу My Folders и выберите опцию Create new folder.  
 

 
 

 
 
Введите имя и нажмите Enter. 
 
Чтобы добавить эффект в папку: 
 
- выберите категорию All Plug-ins в левой колонке окна эффектов. 
- перетащите нужный эффект с правой панели в нужную папку. Чтобы добавить несколько эффектов, щелкните 
по нужным плагинам с нажатой клавишей Ctrl и перетащите их в папку. 
 
Чтобы создать "умную" папку: 
 
Если при создании новой папки отметить опцию Smart folder, все плагины, имена которых включают любую 
введенную вами последовательность символов, будут автоматически включены в эту папку. 
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На примере выше мы создали папку с названием Dynamics для всех плагинов с символами comp OR lim в 
области фильтра. Нажмите кнопку OK. Теперь в созданной папке все плагины с текстом, включающим comp или 
lim в их именах автоматически будут добавлены в эту папку. При необходимости можно добавить и другие 
эффекты в эту папку вручную. 
 

 
 
Чтобы изменить порядок отображения папок эффектов: 
 
- щелкните правой кнопкой мыши по имени папки, которая должна 
быть перемещена. 
- в контекстном меню выберите опции Move to top (переместить 
на самый вверх), Move up (переместить выше), Move down 
(переместить ниже), или Move to bottom (переместить на 
самый низ). 
 
 
 
 
 
 

 
Чтобы отобразить эффекты и вставить их в трек: 
 
- на левой панели окна эффектов, щелкните по имени любой группы эффектов, чтобы отобразить ее 
содержимое на правой панели. 
- дважды щелкните по названию эффекта в пределах этой группы, чтобы добавить этот эффект в текущий трек. 

 
Совет: если вы оставляете браузер эффектов открытым, можно добавить любой эффект к любому треку 
простым перетаскиванием его на панель нужного трека или на панель микшера. 
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Совет: эффект можно добавить из папки в любой трек непосредственно на панели трека или на панели 
микшера. Щелкните правой кнопкой по кнопке FX и выберите сначала папку, а затем эффект. 
 

 
 

6.2. Сохранение цепочек эффектов и пресетов эффектов 
 
Цепочки эффектов и пресеты плагинов можно сохранить и загрузить, используя кнопки Export/Import 
configuration в диалоговом окне Options > Preferences > General. Подробнее о импорте/экспорте параметров 
конфигурации в Главе 22. 
 

 
 

6.3. Использование фильтра для поиска эффектов 
 
Набрав текстовую строку в области Filter 
list в нижнем левом углу окна Add FX, 
можно вывести на экран список 
эффектов, соответствующих вашим 
критериям. Но перед этим необходимо 
выбрать либо категорию All Plugins в 
левом списке, либо любую 
определенную папку, если вы хотите 
ограничить поиск именно этой папкой.  
В данном примере в строке фильтра мы 
набрали слово chorus, чтобы отобразить 
доступные плагины хоруса. Область 
фильтра поддерживает поиск с 
использованием операторов, например, 
если вы введете comp OR lim в списке 
будут отображены как плагины 
компрессоров, так и плагины лимитеров. 
Строка eq (cockos OR melda) найдет все 
плагины эквалайзера компаний Cockos и 
Melda. Строка blue cat NOT (flange OR 
phase) найдет и перечисляет все 
плагины компании Blue Cat, кроме 
флэнджеров и фейзеров. Обратите 
внимание на пробелы перед и после 

круглых скобок. Строка (chorus OR delay) NOT (DX: OR JS:) найдет все плагины хоруса и дилея, кроме 
плагинов Direct X и JS. Кнопка Clear Filter может использоваться для очистки строки фильтра и восстановления 
отображения всех доступных плагинов. Доступны также две опции (в меню Options браузера эффектов), 
которые в случае их активирования, гарантируют, что фильтры будут очищаться автоматически: Auto clear 
search field on folder change (при смене папки автоматически очищать область поиска) и Auto clear search 
field on close (автоматически очищать область поиска при закрытии). Последняя опция относится к 
закрытию окна браузера эффектов, не закрывая REAPER. Программа запоминает предыдущие фильтры. 
Доступ к выпадающему списку последних используемых фильтров можно получить щелчком по кнопке со 
стрелкой вниз, расположенной направо от области Filter. 
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6.4. Меню Options браузера эффектов 
 
Меню Options браузера эффектов включает следующие команды: 

 
Auto-float new FX windows: если эта опция отмечена, 
при добавлении эффекта, он будет открыт и выведен на 
экран в собственном отдельном окне, а не в пределах 
браузера эффектов. 
FX Plug-ins settings: открывает страницу Options > 
Preferences > Plug-ins settings (см. Главу 22). 
Show in left pane list: открывает в виде подменю список 
категорий плагинов, которые вы хотите отобразить (или 
не отображать). Выбранные плагины будут перечислены 
на левой панели окна браузера эффектов. Доступные 
типы плагинов: DX, DXi, VST, VSTi, VST3, VST3i, AU, AUi, 
JS, Rewire и Cockos. Выбор опции Instruments откроет 
список всех виртуальных инструментов: они также будут 
перечислены в их собственных папках (VSTi, DXi, и т.д.). 

Выбор опции Recent откроет список последних используемых плагинов, так же в их собственных папках. Выбор 
опции VST folders откроет список всех папок, содержащих VST плагины на левой панели ниже My folders. 
Выбор опции FX Chains откроет список доступных цепочек эффектов. 
Show in FX List: позволяет отобразить в виде списка пресеты по умолчанию (если таковые имеются, наряду с 
названием эффекта), описание пресета или название файла, или описание и название для эффектов, и/или 
плагины, имя которых начинается с символа #. Если имя плагина начинается с символа #, он не будет 
отображаться в списке эффектов браузера эффектов. Доступны также две опции автоматической очистки 
области поиска (фильтра) Auto clear search field (filter) когда вы изменяете выбранную папку, и/или когда вы 
закрываете браузер эффектов. Активирование опции Auto-clear folder view on close гарантирует, что при 
следующем открытии окна Add FX, опция All Plugins будет выбрана на левой панели. 
 

6.5. Замена одного плагина в цепочке эффектов трека другим 
 
1. Отобразите цепочку эффектов трека и выберите в цепочке эффект, который вы хотите заменить. 
2. В главном меню окна эффектов перейдите FX > Replace FX. 
3. В окне Add FX выберите эффект и нажмите OK. 
 

6.6. Копирование эффектов с одного трека в другой 
 
Любой эффект трека (отдельный эффект или цепочку) можно скопировать с одного трека в любой другой, или в 
несколько треков. При этом также копируются и параметры эффектов. Для этого можно использовать 
стандартные горячие клавиши Windows: Ctrl+C и Ctrl+V, но самый простой способ скопировать всю цепочку  -
удерживая клавишу Ctrl, перетащить ее на кнопку FX любого другого трека. Это можно сделать как на панели 
треков, так и на панели микшера. Вы также можете выбрать один или несколько плагинов в цепочке эффектов 
одного трека и удерживая клавишу Ctrl, перетащить их в другой трек. Это также можно сделать как на панели 
треков, так и на панели микшера Чтобы скопировать огибающие автоматизации с эффектами, используйте 
Shift+Ctrl+перетаскивание. 
 
Пример: 
 
Для данного примера, откройте файл All Through The Night Folder.rpp, который вы сохранили ранее. Если вы 
не сохраняли этот файл, используйте любой другой проект с несколькими треками. 
 
1. Нажмите кнопку FX трека Gtr Neck, чтобы открыть окно эффектов трека. 
2. Вставьте плагин ReaEQ VST (Cockos) в это окно. 
3. Захватите текстовую строку VST ReaEQ в окне плагина и перетащите ее на трек Gtr Body. 
4. Отпустите мышь. Теперь плагин ReaEQ будет скопирован в этот трек.  
 
Чтобы скопировать несколько плагинов одновременно с одного трека в другой: 
 
1. Щелкните по первому плагину и удерживая клавишу Ctrl, щелкните поочередно по каждому дополнительному 
плагину, который вы хотите скопировать. Альтернативно, если вы хотите скопировать всю цепочку эффектов, 
щелкните по первому плагину, а затем щелкните по последнему плагину в цепочке с нажатой клавишей Shift. 
2. Далее перетащите выделенные плагины, как один плагин, как описано выше. 

 
Совет: эффект можно скопировать с цепочки эффектов любого трека в отдельные клипы или копии в 
любом месте проекта. Работа с функциями эффектов клипа и копий будет обсуждаться в Главе 6 и 
Главе 7. 
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6.7. Добавление разработчиков 
 
Для создания группы разработчиков, щелкните правой кнопкой мыши по лейблу Developers на левой панели 
окна Add FX, нажмите кнопку Add developer и введите имя (например, Sony). Перетащите плагин из главного 
окна, чтобы добавить его в группу. 
 

6.8. Дисплей Quick FX 
 

Эффекты трека перечисляются в контекстном меню кнопки FX. Окно любого из этих 
эффектов можно открыть прямо из этого меню. 
 
 
 
 
 
 

 
6.9. Перемещение эффектов с одного трека в другой 

 
Чтобы переместить (а не скопировать) плагин или цепочку с одного трека в другой, перетащите эффект или 
цепочку с нажатой клавишей Alt. 

 
Совет: если навести курсор мыши на кнопку FX трека всплывает подсказка с перечислением плагинов 
вставленных на этом треке, даже если цепочка эффектов установлена в обход. 
 

 
6.10. Управление параметрами эффектов 

 
Окно интерфейса каждого плагина REAPER включает кнопку Param, которую можно использовать для 
управления различными параметрами эффекта. Щелкните по любому контроллеру в окне эффекта, а затем 
нажмите кнопку Param.  
 

 
 
Всплывающее меню включает пять опций: Show in track controls, Show track envelope, Parameter modulation/MIDI 
link, Learn и Alias Parameter. 

 
Show in track controls: добавляет контроллер 
для выбранного параметра как на панель трека, 
так и на панель микшера. Выбор этой опции 
отображает список параметров для выбранного 
эффекта. Выберите любой элемент (ы) из списка, 
чтобы добавить соответствующий регулятор на 
панель трека. В данном примере использовались 

два параметра плагина ReaComp. Чтобы удалить добавленные контроллеры, щелкните правой кнопкой мыши 
по регулятору и выберите опцию Remove from list из меню.  
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Это контекстное меню также обеспечивает доступ к четырем другим инструментам управления параметром: 
Learn, Modulate (Parameter modulation), Envelope (Show track envelope) и Alias (Alias parameter). 
 
Show track envelope: тема огибающих и автоматизации с огибающими подробно затрагивается в Главе 18. На 
данном этапе отметьте, что эту опцию можно использовать для добавления огибающих автоматизации треков 
для любых параметров эффекта. Пример показан ниже.  
 

 
 
Огибающие можно отобразить на их собственных панелях (как показано на рисунке) или поверх клипа. 
Подробнее об этом в Главе 18. 
 
Parameter Modulation: это достаточно сложная тема. Модуляция параметра позволяет определять отношения 
между двумя параметрами так, чтобы один параметр управлял другим. Например, можно сделать так, чтобы 
значение параметра Ratio автоматически увеличивалось, по мере уменьшения значения параметра Threshold. 
Подробнее об этом в Главе 19. 
 
Learn: если вы используете внешний аппаратный MIDI контроллер, можно назначить параметры эффекта на 
контроллеры (такие как регуляторы или фейдеры) на этом внешнем устройстве. Подробнее об этом в Главе 11 
и Главе 13. 
 

Alias parameter: позволяет изменить имя (присвоить 
псевдоним) параметра (только для одного данного экземпляра 
плагина). Пример показан на рисунке слева. 
 
 
 
 
 

 
6.11. Переименование плагина 

 
Чтобы изменить имя по умолчанию любого Direct X или VST плагина (но не JS плагина): 
 
- откройте окно браузера эффектов (View > FX Browser) (Shift+F) 
- щелкните правой кнопкой мыши по плагину и выберите опцию Rename FX из меню. 
- введите новое имя и нажмите Enter. 
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6.12. Переименование отдельно взятого экземпляра плагина трека 
 
Можно переименовать отдельно взятый экземпляр плагина так, чтобы ваше имя использовалось для этого 
эффекта как на панели трека, так и в микшере. Как правило это можно использовать для описания цели 
эффекта. Например, можно переименовать экземпляр плагина ReaEQ, который был добавлен к треку вокала 
как Add warmth “добавляет теплоту” или More presence “больше эффекта присутствия” и так далее. Для 
этого просто выберите плагин и нажмите F2, или: 
 
- щелкните правой кнопкой мыши по плагину в окне цепочки эффектов или в списке эффектов в микшере. 
- из меню выберите Rename FX instance. 
- введите свое собственное имя и нажмите Enter. 
 
Примите во внимание: выбранное вами имя будет применено только к этому единственному экземпляру 
плагина в пределах только этого трека. Другие экземпляры не затрагиваются. 
 

6.13. Использование параметров эффектов по умолчанию 
 
Любые настройки параметров плагина можно сохранить в качестве настроек по умолчанию всякий раз, когда 
этот эффект будет применяться к любому треку или клипу. После того, как вы настроили параметры, нажмите 

кнопку  и выбираете опцию Save preset as default из меню. Далее необходимо ввести имя для пресета 
параметров по умолчанию. Использование пресетов подробно объясняется в Главе 15. 
 

6.14. Мониторинг выходного сигнала эффектов 
 
Чтобы открыть окно FX: Monitoring, выберите одно из нижеперечисленных действий: 
 
- выберите опцию Monitoring FX из контекстного меню любой вкладки проекта 
- важмите кнопку  в конце панели вкладок проектов (если вы используете вкладки проекта) 
- выберите опцию View > Monitoring FX из главного меню 
- удерживая клавишу Shift, нажмите кнопку FX мастер-трека. Окно мониторинга эффекта такое же, как и любое 
окно эффекта трека. Здесь можно подключить любой эффект к аппаратному выходному порту. Эти эффекты не 
распознаются при конвертировании файла, не затрагивают метроном и не сохраняются в файле проекта.  
 
Примеры, когда можно использовать эту функцию: 
 
- при анализе эффекта. 
- для компенсации отсутствия определенных акустических характеристик (эквалайзера или ревербератора) 
отдельного помещения. 
 
Примите во внимание, что: 
 
- в контекстном меню кнопки Monitor FX можно получить доступ к любому плагину, назначенному для 
мониторинга выходного сигнала или добавить другие эффекты. 
- щелчок по правой стороне этой кнопки  устанавливает статус обхода (bypass). При этом кнопка подсветится 
красным цветом . 
- в пределах окна FX: Monitoring, можно нажать кнопку Param, затем выбрать опцию Learn, чтобы назначить 
контроллер любого выбранного параметра эффекта на внешний контроллер. 
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6.15. Оптимизация ресурсов системы при использовании эффектов 
 
Некоторые плагины довольно ресурсоемки. В особенности это касается эффектов задержки - Delay, Chorus, и 
особенно Reverb. REAPER обеспечивает множество опций, которые можно использовать для оптимизации 
ресурсов системы при использовании этих эффектов. Эти опции можно найти на странице Options > 
Preferences > Audio > Buffering.  
 

 
 
Подробнее эта страница будет обсуждаться в Главе 22. Параметры этой страницы - не панацея "на все случаи 
жизни". То, что вам подойдет, зависит от различных факторов, включая тип процессора(ов) и какие плагины вы 
используете. На данном этапе обратите внимание на следующие опции: 
 
- оставьте параметры секции Media Buffering как есть. Настроить их можно позже. 
- Allow live FX multiprocessing: попробуйте активировать эту опцию, если ваш компьютер поддерживает 
мультипроцессорную систему. 
- Anticipative FX processing: если эта опция отмечена, это может снизить нагрузку на процессор, но слишком 
высокие значения могут вызвать щелчки при воспроизведении. При использовании плагинов UAD-1, должны 
быть отмечены опции Synchronous FX и UAD-1 Synchronous. Опция Anticipative FX должна быть отключена. 
Однако плагины UAD-2 совместимы с опцией Anticipative FX, поэтому при использовании этой версии плагинов 
эту опцию рекомендуется отметить.  
- Optimize buffering for low latency hardware: если вы обнаружили, что отдельный плагин или цепочка 
эффектов вызывают проблемы с буферизацией или режимом Anticipative FX, можно отключить одну из них или 
обе для отдельных треков, используя диалоговое окно Track Performance Options, вызываемое щелком правой 
кнопкой мыши по панели трека. 
 

6.16. Заметки и комментарии к эффектам 
 

Окно FX Chain включает область Comments. Нажмите на кнопку  в правом верхнем углу окна, чтобы 
добавить комментарии, которые привязываются к отдельным экземплярам определенных плагинов.  
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В данном примере отображены только комментарии при выборе четырехполосного эквалайзера для трека 2 
(Vox Lead). Примечания можно добавить для всех или одного эффекта трека, но только один комментарий 
будет отображаться в окне эффектов трека. Комментарии можно открыть в собственном отдельном окне, 

щелчком на кнопке . Количество окон с комментариями неограниченно. 
 

6.17. Wet/Dry баланс и статус обхода 
 
Управление балансом эффекта мы затрагивали в Главе 2. Щелкните и держите кнопку мыши на маленьком 
регуляторе в верхнем правом углу окна плагина, и вы увидите баланс этого эффекта в виде текстовой 
подсказки.  
 

   
 
При значении wet 100 % (по умолчанию) эффект применяется к треку в полном объеме. В значении dry (0%) 
эффект не применяется совсем. Не отпуская кнопку мыши поверните регулятор, чтобы изменить значение 
баланса. В значении 50 % wet/dry сигналы (обработанный и необработанный) смешиваются в равных 
пропорциях. Обратите внимание на маленький флажок справа от этого контроллера – это функция обхода 
(bypass). Если флажок отмечен, эффект будет применен к треку. Если флажок снят, эффект затрагивать трек 
не будет. 
 

6.18. Компенсация задержки, вызываемой плагинами 
 
По умолчанию, REAPER применяет компенсацию задержки, вызываемой плагинами для синхронизации 
(выравнивания) аудиосигнала.  
 

Значение задержки на любом треке отображается в нижнем левом углу окна 
цепочки эффектов этого трека. Например, значение 256/512 spls означало 
бы, что один из эффектов требует компенсации в 256 сэмплов: REAPER 
округляет это значение до нескольких блоков, основанных на вашем размере 

буфера. Все остальные треки будут скорректированы, чтобы соответствовать треку с самой большой 
задержкой.  
 

Если вы столкнулись с обстоятельствами, при которых компенсация задержки 
плагина создает проблемы (например, выпадение отчетов или чрезмерная 

задержка), эту опцию можно отключить в контекстном меню кнопки pin connector (на рисунке маркированной “2 
in 2 out”).  
 

 
 
Отметьте также, что компенсация задержки плагина отключается при использовании маршрутизации обратной 
связи. 
 

6.19. Открытие файла в режиме восстановления 
 
Любая компьютерная программа подвержена аварийному сбою. REAPER достаточно стабильная программа, но 
тем не менее могут быть и случаи аварийного сбоя. Это может быть вызвано проблемой с некоторым сторонним 
VST, VSTi, DX или DXi плагинами. Если это произошло, необходимо активировать опцию Open with FX offline 
(recovery mode) в окне открытия проекта и открыть проект как обычно через команду Open project. При этом 
файл откроется со всеми эффектами в режиме offline (не активированными). Активируя эффекты по одному, 
можно идентифицировать проблемный плагин. Чтобы решить проблему, необходимо удалить этот плагин и 
заменить его другим эквивалентной функциональности. Другой способ - удерживать Ctrl+Shift при открытии 
файла из меню File > Recent projects. 
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6.20. Функция Stem Rendering 
 
Stem Rendering - функция, которая может применяться для оптимизации работы процессора. клип 
конвертируется в новый трек, но вместе с тем остается и оригинальный трек, который автоматически 
мьютируется, а его эффекты принимают статус bypass. Если вы впоследствии захотите заменить эффект в 
сконвертированном треке, можно удалить сконвертированный трек, размьютировать оригинал, и в нем 
произвести изменения. Чтобы создать сконвертированный (stem) трек: 
 
1. Щелкните правой кнопкой мыши по номеру трека. 
2. Из меню выберите опцию Render/freeze tracks, а затем отметьте одну из опций Render tracks to … stem 
tracks (and mute originals) - mono (клип конвертируется в монофайл), stereo (клип конвертируется в 
стереофайл) или multichannel (клип конвертируется в мультиканальный файл).  
 
При выборе последней опции количество сконвертированных каналов соответствует количеству каналов трека. 
По умолчанию, треки REAPER двухканальные: в этом случае, опции stereo и multichannel приведут к единому 
результату. Так же, как и эффекты трека, любой аудио или MIDI сигнал, полученный с посылов других треков, 
будет также включен в сконвертированный файл. Функция Stem Rendering схожа с функцией Freezing (см. 
параграф ниже). Одно главное между ними отличие - функция Stem Rendering оставляет как 
сконвертированные, так и не сконвертированные треки в проекте.  
 

 
 
Если вы хотите сконвертировать только эффекты трека, не оставляя оба трека в проекте, рассмотрите 
использование одного из действий функции Render/freeze. Подробнее об этих действиях мы поговорим ниже.  
Функция Stem Rendering включает обширный диапазон дополнительных опций, таких как формат выходного 
файла или качество рендеринга, доступ к которым осуществляется выбором команды File > Render > Render to 
File. Подробнее об этом в Главе 21. 
 

6.21. Рендеринг сгруппированных треков в один трек 
 
В данном примере используется диалоговое окно Render to File, которое подробно объясняется в Главе 21. Вы 
можете применить функцию Stem Rendering к группе треков так, чтобы они были сконвертированы в один 
аудиофайл. Для этого: 
 
1. Поместите нужные треки в трек-папку. 
2. На панели трека, выберите трек-папку. Не выделяйте никакой другой трек. 
3. Перейдите File > Render. 
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4. Убедитесь что в меню Source выбрана опция Stems (selected tracks), а вменю Channels выбрана опция 
Stereo или Mono. По усмотрению, также отметьте опцию Add rendered items to new tracks in project 
(добавить сконвертированные клипы на новые треки в проекте). 
5. В меню Output format выберите нужный формат конечного файла (например, WAV), а в меню Bitrate нужное 
значение (например, 24 bit). 
6. Нажмите кнопку Render 1 file.  
 
При работе с мультиканальными треками можно также конвертировать выходной сигнал в мультиканальном 
формате. При этом необходимо выбрать нужное количество каналов в меню Channels. Подробнее о рендеринге 
файлов, включая мультиканальный рендеринг, в Главе 21. 
 

6.22. Функции Freeze и Unfreeze 
 
Опции Freeze tracks (команда Render/freeze tracks из контекстного меню трека) используются для 
конвертирования любого трека на месте с заменой его содержимого одним объединенным аудиоклипом.  
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Первая опция (Render tracks to mono stem tracks (and mute original) создает моноклип для каждого 
сконвертированного трека, вторая (Render tracks to stereo stem tracks (and mute original) создает стереоклип, 
и третья (Render tracks to multichannel stem tracks (and mute original) создает мультиканальный аудиоклип 
(согласно количеству каналов трека). Если выбрано несколько треков, каждый будет сконвертирован отдельно. 
Активные эффекты применяются к сконвертированному клипу, поскольку это контент любых сигналов, 
посланных в сконвертированные каналы с других треков. Там, где присутствуют MIDI данные или клипы, они 
будут сконвертированы в аудио. Но при этом активные эффекты и адресаты удаляются из трека. Примите во 
внимание: пустой MIDI клип (без назначенного синтезатора) конвертируется в тишину. Если назначен 
синтезатор, будет сконвертирован выходной сигнал синтезатора. После того, как трек был уже сконвертирован, 
в вышеупомянутом меню становится доступной функция Unfreeze tracks, которая может использоваться для 
возврата трека в его первоначальное состояние в той точке, с которой произошло конвертирование. И цепочка 
эффектов, и любые адресаты будут восстановлены. Другие моменты, которые необходимо отметить: 
 
- после конвертирования к треку все еще можно добавлять эффекты и адресаты. В этом случае, если вы опять 
конвертируете трек, эти эффекты (наряду с аудио и или MIDI материалом с новых адресатов) будут 
сконвертированы вместе с текущим конвертированным материалом в другой новый аудиоклип. 
- каждая опция Unfreeze tracks удаляет предыдущее конвертирование этого трека и возвращает его в 
первоначальное состояние в той точке, с которой произошло конвертирование. Таким образом, если трек был 
сконвертирован, а потом к нему добавились эффекты, вы должны будете вернуть (разморозить) трек дважды, 
если хотите восстановить его первоначальное состояние до первого конвертирования. 
 
6.22.1. Использование функции Freeze в окне менеджера треков 
 
Функцией Freeze можно управлять из окна менеджера треков. Перейдите View > Track Manager. Выберите 
любой трек (и) из списка (на рисунке ниже, это треки 3 и 4), а затем нажмите кнопку Freeze и выберите нужную 
опцию из меню Freeze tracks (mono, stereo или multichannel).  
 

 
 
Количество процессов конвертирования для любого трека (максимум 8) отображается в колонке Freeze. В 
данном примере треки 3 и 4 были с конвертированы один раз. Опция Unfreeze tracks будет добавлена в меню 
Freeze, когда это меню будет открыто с уже сконвертированным и выбранным треком. Кроме того, это меню 
будет также включать опцию отображения деталей конвертирования для этого трека (см. выше). Подробнее о 
менеджере треков в Главе 12. 
 
6.22.2. Использование функции Freeze с выбранными эффектами 
 
Опции, доступные в окне цепочки эффектов трека позволяют сконвертировать трек до его последнего или 
выбранного активного эффекта. В данном примере (на рисунке ниже) выбраны только первые два эффекта 
(ReaComp и ReaEQ). В этом случае опция Freeze track to stereo, up to last selected FX (сконвертировать 
трек в стерео включая последние выбранные эффекты) сконвертирует компрессор и эквалайзер. Эти два 
эффекта будут удалены из цепочки эффектов трека. Третий эффект (JS) сконвертирован не будет. Он 
останется как есть, и его можно настраивать или удалить. Еще одна полезная опция (доступная из окна Action 
List REAPER) - View > Show track freeze details. Она может использоваться для отображения истории 
конвертирования и деталей любого сконвертированного трека. В Главе 15 подробно объясняются назначение 
опций на панели инструментов или на ваши собственные горячие клавиши. 
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6.23. Вертикальное/горизонтальное отображение древа эффектов 
 
Древо эффектов можно отобразить вертикально (по умолчанию) или горизонтально (как на рисунке ниже). Для 
этого дважды щелкните по границе между двумя секциями, на курсоре с двумя стрелками (как на рисунке). 
 

 
 

6.24. Добавление комментариев к эффектам 
 

В верхнем правом углу каждого окна эффектов трека есть маленькая кнопка с тремя точками . Щелчок по ней 
открывает окно, где можно ввести любые комментарии о текущем выбранном эффекте и его параметрах. 
 

 
 

6.25. Установка дополнительных JS плагинов 
 
Дополнительные JS плагины доступны бесплатно на странице stash.reaper.fm/tag/JS-Effects. Чтобы установить 
любой из них: 
 
1. Скачайте эффект и (при необходимости) разархивируйте файл. 
2. Если у файла JS плагина расширение txt, удалите это расширение. 
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3. Скопируйте эффект в папку AppData > Roaming> REAPER  > Effects (на win7). Местоположение папки можно 
найти через Options > Show REAPER resource path. Если хотите, эти эффекты можно поместить в подпапку в 
пределах папки Effects. 
4. Закройте и перезапустите REAPER. Некоторые JS эффекты поставляются с другими файлами (например, с 
файлами данных или графическими файлами). Как правило, файлы с данными помещаются в AppData > 
Roaming> REAPER  > Data, а другие файлы помещаются относительно файла JS эффекта. В большинстве 
случаев, там, где это необходимо, разработчик JS эффекта будет сопровождать эффект особыми 
инструкциями. 
 

6.26. Пересмотренные шаблоны трека 
 
Не забывайте, что кроме собственно сохранения самих цепочек эффектов, их можно включать наряду с другими 
параметрами трека (такими как имя, панорама, громкость, и т.д.) в шаблоны трека. Помните также, что 
использование команды Track > Save tracks as template сохраняет все выбранные треки в шаблон одного 
трека. См. также Главу 3. 
 

6.27. Дополнение к руководству пользователя ReaEffects 
 
В руководстве пользователя ReaEffects вы найдете множество примеров использования различных эффектов 
COCKOS, особенно в Главе 16. Кроме того, бесплатный PDF файл Reaper COCKOS Effects Summary можно 
скачать на странице: http://www.cockos.com/~glazfolk/ReaEffectsGuide.pdf. Обратите внимание: эта ссылка 
чувствительна к регистру. 
 

6.28. Добавление эффектов перетаскиванием из браузера эффектов 
 
Удобный способ добавить эффект на любой трек или клип - перетащить его из браузера эффектов. Для этого 
откройте окно браузера эффектов (Shift +F или View > FX Browser) и перетащите любой эффект из окна Add 
FX (браузера эффектов) на нужный трек или на клип. 
 

 
 

Совет: можно использовать Ctrl+щелчок и выбрать несколько эффектов, как на рисунке выше. Кроме 
того, если вы до этого создали цепочку эффектов, ее можно выбрать из браузера эффектов и 
перетащить на любой трек или клип. 
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6.29. Схема прохождения сигнала: мастер-трек 
 
Данная схема иллюстрирует поток аудиосигнала мастер-трека. 
 

 
 

6.30. Схема прохождения сигнала: треки и трек-папки 
 
Две нижеприведенные схемы иллюстрируют, как аудиосигналы проходят через треки REAPER в мастер-канал и 
на выходные порты аудиоустройств. Некоторые из элементов, показанных в этих схемах (например, параметры 
Item/Take) еще не обсуждались в этом руководстве пользователя. Они будут рассмотрены позже, главным 
образом в Главе 7. 
 

Примечания: 1. Кнопка Mute трека показана в нескольких местах (в начале и в конце цепочки). Это 
потому, что она не только мьютирует сигнал в начале цепочки (так, чтобы, например, все клипы были 
эффективно мьютированы), она также мьютирует сигнал и в конце цепочки (так, чтобы, например, 

синтезатор в цепочке эффектов трека, через который запитываются MIDI данные через адресата с другого 
трека, был также мьютирован). 
2. Если активированы обе кнопки трека - Mute и Solo - режим солирования имеет приоритет над режимом 
мьютирования. 
3. Если солируется мастер-трек, прямые выходные сигналы в аудиоустройство с треков/трек-папок не 
обрабатываются. 
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7. Редактирование треков и клипов 
 
Примечание: в некоторых рисунках области аранжировки в этой главе, используется тема оформления 
по умолчанию и цветовая схема REAPER 4. Тем не менее информация и инструкции, применимы и для 
темы оформления REAPER 5. 

 
7.1. Использование внешнего редактора для обработки файлов 

 
Вы можете назначить до двух сторонних программ (таких как Adobe Audition, Audacity, Wavosaur или Sound 
Forge), которые вы хотите объединить с REAPER для редактирования ваших аудиоклипов. Для этого: 
 
1. Перейдите Options > Preferences > External Editors. 
2. Нажмите кнопку Add. 
 

 
 
3. Используйте кнопки Browse, чтобы найти и выбрать аудиоредактор. 
4. Нажмите кнопку OK, затем снова кнопку OK, чтобы закрыть окно Preferences. Заметьте, что можно 
определить различные редакторы для различных типов файлов, например, отдельно для WAV и MP3. 
 
Есть два основных способа доступа к выбранному внешнему редактору из REAPER: 
 
1. Щелкните по клипу и нажмите Ctrl+Alt+E. 
2. В пределах проекта REAPER щелкните правой кнопкой по клипу, который вы хотите отредактировать, 
перейдите Open Items in editor и выберите либо опцию Open the item itself (открыть в редакторе сам клип), 
либо Open a copy of the item (открыть в редакторе копию клипа). 
 

 
 
В отличие от версий REAPER ранее версии 4.0, по умолчанию двойной щелчок по аудиоклипу не открывает его 
в основном внешнем редакторе. Это поведение можно изменить на странице Preferences> Editing Behavior> 
Mouse Modifiers. Эта тема затрагивается в Главе 15. Если внешний редактор применяет к вашему файлу 
разрушающее редактирование, безопаснее открыть в редакторе копию файла (Open a copy of the item). 
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7.2. Редактирование клипов в REAPER 
 
Тема редактирования клипов в REAPER довольно объемная. REAPER обеспечивает широкий диапазон 
способов редактирования клипов в пределах проекта. Если вы работали с другими аудиопрограммами, вы 
поначалу можете счесть способы редактирования REAPER немного странными. Первый вопрос, который вы 
могли бы задать, когда смотрите на экран “Где все инструменты редактирования?” Ответ – «их просто нет!» По 
крайней мере, по началу нет многих из них! Но как вы убедитесь позже, это не означает, что REAPER нет до 
этого дела. Вы можете получить доступ только к тем функциям редактирования, в которых вы действительно 
нуждаетесь, не захламляя экран. К тому же, вы можете создать и добавить неограниченное количество 
собственных инструментов редактирования. Мы доберемся до этого в Главе 15. Есть некоторые 
фундаментальные понятия о принципах проектирования и структуре REAPER, которые необходимо знать 
прежде, чем мы изучим отдельные способы редактирования. Например: 
 
- редактирование клипов в REAPER не является разрушающим и применяется только к клипу на треке, не 
изменяя фактический исходный файл (источник). Можно свободно экспериментировать, зная, что исходные 
записанные файлы останутся в безопасности. 
- редактирование клипов в REAPER в основном состоит из выбора клипа (щелчок по нему) или его части 
(выделение области), и последующего применения команд редактирования - например, разделения, удаления, 
копирования или перемещения. 
- иногда для достижения определенной задачи редактирования может потребоваться несколько шагов. В этом 
случае можно назначить одну единственную горячую клавишу для выполнения всей последовательности шагов. 
Как это сделать, мы рассмотрим в Главе 15. 
- если вам действительно не хватает инструментов редактирования, можно довольно легко создать ваши 
собственные инструменты и панели инструментов. Эта тема также затрагивается в Главе 15. 
- поведение REAPER при редактировании можно определить на странице Options > Preferences > Editing. 
Подробнее эту страницу мы рассмотрим далее в этой главе.  
 
Прежде чем мы начнем, не забывайте, что при редактировании, доступна не только команда отмены Edit > 
Undo, но и окно истории отмен Undo History (Глава 2). Окно Undo History может использоваться для возврата 
файла проекта в любое из ранних состояний. 
 

7.3. Интеллектуальные функции редактирования REAPER 
 
Интеллектуальные функции редактирования REAPER позволяют выполнить многие необходимые задачи 
быстро и легко. В этой главе мы рассмотрим интеллектуальные способы редактирования для таких действий как 
перемещение, копирование и удаление клипов, выбора клипа и его фрагмента. Чтобы использовать эти 
способы, убедитесь, что опция Loop Points Linked to Time Selection в меню Options не отмечена. Список ниже 
иллюстрирует поведение REAPER по умолчанию для различных действий мыши. Можно изменить любое из 
них, используя контексты Media item и Left drag на странице Options > Preferences > Mouse Modifiers. 
 
Чтобы переместить клип или несколько клипов, игнорируя выделенную область: просто перетащите клип 
Чтобы переместить клип или несколько клипов, игнорируя привязку и выделенную область: перетащите клип с 
нажатой клавишей Shift. 
Чтобы скопировать клип или несколько клипов: перетащите клип с нажатой клавишей Ctrl. 
Чтобы скопировать клип или несколько клипов, игнорируя привязку: перетащите клип с нажатыми клавишами 
Shift+Ctrl. 
Чтобы переместить содержимое клипа (в пределах клипа): перетащите клип с нажатой клавишей Alt. 
Чтобы точно отрегулировать высоту тона клипа: перетащите клип с нажатыми клавишами Shift+Alt. 
Чтобы сконвертировать клип в новый файл: перетащите клип с нажатыми клавишами Ctrl+Alt. 
Чтобы скопировать клип, объединив исходные MIDI данные: перетащите клип с нажатыми клавишами 
Shift+Ctrl+Alt. 
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Рисунок выше является примером того, как можно изменить любую из этих действий. В данном примере мы 
находимся в процессе изменения поведения перетаскивания по умолчанию от Move item ignoring time 
selection (переместить клип, игнорируя выделенную область) до Move item: just move (просто 
переместить клип). Это позволяет нам переместить любую выделенную область клипа простым 
перетаскиванием. Подробнее об этом в Главе 15. 
 

Совет: если вы случайно переместили клип, его можно вернуть в исходную позицию выбрав опцию Item 
processing > Move item to source preferred position в контекстном меню клипа. 
 

7.4. Стандартные действия редактирования Windows 
 
Большинство основных задач редактирования, которые вы будете выполнять в REAPER, вовлекают 
использование достаточно интуитивных стандартных процедур Windows для выделения и управления клипами. 
Но есть также и некоторые дополнительные: 
 
7.4.1. Выбор клипов 
 
- выберите клип щелчком по нему. 
- выберите несколько несмежных клипов щелчком по ним с нажатой клавишей Ctrl. 
- выберите смежные клипы щелчком по первому и с нажатой клавишей Shift по последнему клипу в группе. 
- выделите группу клипов, нарисовав правой кнопкой мыши выделяющую рамку (Marquee) вокруг клипов.  
 

 
 
При выделении рамки необязательно охватывать ею клип целиком, чтобы включить его в выбор. Выделяющая 
рамка может вести себя по-разному с использованием любой клавиши-модификатора (см. список 
модификаторов выделяющей рамки ниже). 
 
Вышеперечисленные процедуры могут использоваться в REAPER в нескольких контекстах - например щелчок с 
нажатой клавишей Ctrl и выделяющая рамка могут использоваться для выделения нескольких нот в MIDI 
редакторе (см. Главу 13). 
 
7.4.2. Разделение клипов 
 
Разделение клипов используется в нескольких способах редактирования REAPER. 
 
- если никакой клип не выбран, нажатие клавиши S не произведет никакого эффекта. 
- если клип (ы) выбран, нажатие клавиши S разделит выбранный клип (ы) в позиции курсора редактирования. 
- если выделена область, нажатие клавиши S с клавишей Shift разделит выбранный клип (ы) по границам 
выделенной области.  
- если разделяется клип с эффектами, оба получившиеся клипа будут включать эффекты. Это поведение можно 
изменить на странице Options > Preferences > Media, отключив опцию Duplicate take FX when splitting items. 
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7.4.3. Объединение разделенных клипов (функция Heal)  
 
- выберите разделенные клипы на треке. 
- щелкните правой кнопкой по любому из них и выберите из меню опцию Heal splits in items.  
 
Функция Heal отличается от функции Glue. Если коротко, функция Heal возвращает клипы в их исходное 
состояние, тогда как функция Glue конвертирует клипы в новый файл. Функция Glue будет обсуждаться позже в 
этой главе. Отметьте также, что, если были объединены несколько ранее разделенных клипов, каждый из 
которых включал цепочку эффектов, сохранится только цепочка эффектов первого из клипов. 
 
7.4.4. Вырезание/копирование клипов 
 
Кроме функций интеллектуального редактирования (см. предыдущий параграф) есть и другие способы 
копирования или вырезания клипов в REAPER. Они основаны на стандартных действиях Windows: 
 
 - горячая клавиша Ctrl+C позволяет скопировать, а горячая клавиша Ctrl+X вырезать любой выбранный клип 
(ы) целиком в буфер обмена. Обратите внимание, что, если выделена область, горячие клавиши 
Shift+Ctrl+C/Shift+Ctrl+X будут копировать/вырезать соответственно только эту выделенную область, а не весь 
клип. Чтобы изменить это поведение можно использовать редактор действий (Глава 15). 
- щелкните правой кнопкой мыши по клипу и выберите опцию Copy items или Cut items из меню. 
- выберите клип, а затем перейдите Edit > Copy items/tracks/envelope points ignoring time selection 
(копировать клипы/треки/точки огибающих, игнорируя выделенную область) или  
Cut items/tracks/envelope points ignoring time selection (вырезать клипы/треки/точки огибающих, игнорируя 
выделенную область) из меню. 
 

Примечание: копирование MIDI клипов в области аранжировки: примите к сведению разницу между 
копированием MIDI клипов и аудиоклипов в области аранжировки. Эти различия объясняются в Главе 13. 
 

7.4.5. Вставка клипов 
 
- используйте горячую клавишу Ctrl+V для вставки клипа в позиции курсора. Если выбран трек, клип будет 
вставлен в этот выбранный трек. Если трек не выбран, клип будет вставлен в последний трек на панели треков. 
Если сфокусировано главное окно области аранжировки, перед вставкой будет создан новый трек. 
- выберите трек и используйте команду Edit > Paste, чтобы вставить клип в текущей позиции курсора 
редактирования. 
 
7.4.6. Копирование/вставка выделенной области клипа 
 
В случае, если вы предпочитаете не использовать интеллектуальное редактирование, можно использовать 
буфер обмена Windows. 
 
- выберите клип, а затем выделите область этого клипа. 
- чтобы скопировать или вырезать выделенную область, сначала убедитесь, что главное окно области 
аранжировки сфокусировано, а затем перейдите Edit > Copy items/tracks/envelope points within time selection 
или щелкните правой кнопкой мыши по клипу и выберите опцию Copy selected area of items из меню или 
нажмите Ctrl+C, или  
- чтобы вырезать выделенную область, перейдите Edit > Cut items/tracks/envelope points within time selection 
или щелкните правой кнопкой мыши по выделенной области и выберите опцию Cut selected area of items из 
меню или нажмите Ctrl+X. 
- выберите трек на панели треков, поместите курсор в область аранжировки и выберите Edit > Paste из меню. 
 
7.4.7. Удаление клипов 
 
Функция Delete полностью удаляет клип из трека. Обратите внимание: при этом не удаляется сам медиафайл 
из директории проекта. Есть несколько способов удалить клипы. Если у клипа есть несколько копий, любое из 
этих действий удалит все копии, а не только активную. Работа с отдельными копиями обсуждается в Главе 8. 
- используйте клавишу Delete, чтобы удалить выбранный клип(ы). 
- щелкните правой кнопкой по выбранному клипу и выберите опцию Remove items. При этом удаляются любые 
выделенные клипы или перейдите Item > Remove items в главном меню. 
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7.4.8. Отображение скрещенных клипов на дорожках треков 
 
Возможно вам понадобится поместить несколько скрещенных клипов на один трек. При этом обратите внимание 
на опцию плавного наложения (кроссфейдинг). Кроссфейдинг можно применить вручную или автоматически 
(активировав кнопку Auto Crossfade на панели инструментов). Поведением кроссфейдинга можно управлять в 
редакторе кроссфейдинга, который будет обсуждаться позже в этой главе. Можно активировать опцию Show 
overlapping media items in lanes (показывать скрещенные клипы на дорожках треков) в меню Options. 
Максимальное количество дорожек можно определить на странице Options > Preferences > Appearance (опция 
Maximum number of lanes, when showing overlapping items in lanes). 
 
7.4.9. Перемещение клипов: специальные функции 
 
Горячие клавиши применяются для перемещения клипов тогда, когда эти действия затруднены мышью. 
Например: 
 
Клавиша 1 на цифровой клавиатуре: сдвигает клип немного влево 
Клавиша 3 на цифровой клавиатуре: сдвигает клип немного вправо 
Клавиша 4 на цифровой клавиатуре: перемещает клип немного влево 
Клавиша 6 на цифровой клавиатуре: перемещает клип немного вправо 
Клавиша 8 на цифровой клавиатуре: перемещает клип вверх на один трек 
Клавиша 2 на цифровой клавиатуре: перемещает клип вниз на один трек 

 
Примечание: эта функция часто упоминается как “nudge”. В REAPER функция nudge привязана к 
масштабированию. Например, если вы значительно увеличите масштаб клипа, применение функции 
nudge влево или вправо будет перемещать или сдвигать клип назад или вперед на куда меньшую 

единицу времени, чем если бы окно было масштабировано в размер целого проекта. 
 

 
Совет: двойной щелчок по номеру трека на панели треков выделяет все клипы на этом треке. 
 

 
7.4.10. Модификаторы выделяющей рамки 
 
Клавиши модификаторы применяются для изменения поведения выделяющей рамки (щелчок правой кнопкой и 
выделение рамки) 
 
Выделение рамки правой кнопкой мыши (без модификатора): рамка выделяет клипы. 
- с клавишей Shift: рамка добавляет клипы к уже выбранным. 
- с клавишей Ctrl: рамка переключает на выделенные клипы 
Выделение рамки правой кнопкой мыши с клавишей Alt: рамка выделяет клипы и область 
Выделение рамки правой кнопкой мыши с клавишами Shift+Alt: выделяет клипы и область, игнорируя привязку. 
 
Вы можете изменить любой из этих модификаторов и/или добавить другие по вашему усмотрению, используя 
страницу Options > Preferences > Mouse Modifiers. Подробнее об этом в Главе 15. 
 

7.5. Настройки поведения REAPER при редактировании 
 
Ознакомьтесь с основными параметрами поведения REAPER при редактировании и вы значительно облегчите 
себе жизнь! Эти параметры находятся на странице Options > Preferences > Editing Behavior и подробно будут 
объяснены в Главе 22, но если коротко, вот некоторые самые полезные: 
 
Move edit cursor to start of time selection on time selection change (переместить курсор редактирования в 
начальную границу выделенной области при ее изменении)  
Move edit cursor when pasting/inserting media (переместить курсор редактирования при вставке клипа) 
Link loop points to time selection (привязать границы области лупа к границам выделенной области). 
- какой фокус использовать в качестве центра при масштабировании по горизонтали и (Horizontal zoom center) 
и по вертикали (Vertical zoom center). Последние две важные опции вовлекают вас в управление поведением 
масштабирования REAPER. Наведение курсора мыши позволяет просто указать точку и масштабировать 
колесом мыши. 
 
Опция перемещения курсора редактирования при выборе клипа больше не находится на этой странице, но ее 
можно установить в контекстном меню Media item > left click на странице Mouse modifiers. Поведение по 
умолчанию для этой опции - Select item and move edit cursor (выделить клип и переместить курсор 
редактирования), которое можно изменить на Select item (просто выделить клип). 
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7.6. Отделение области лупа от выделенной области 
 
Опция Link loop points to time selection (на странице Options > Preferences > Editing Behavior) определяет, 
будут ли по умолчанию границы области лупа привязываться к границам выделенной области. Если так, то при 
выделении области кроме той, что уже выделена в настоящее время, будет изменяться и область лупа.  
В любое время это поведение можно изменить с помощью опции Loop points linked to time selection в меню 
Options. Даже когда эта опция отключена (т.е. не отмечена), все еще можно использовать клавишу Alt, во 
время выделения области на шкале времени, чтобы обозначить одновременно и выделенную область, и 
область лупа. 
 
Пример: 
 
Для данного примера предположим, что опция Loop points linked to time selection отключена.  
 

Здесь мы выделили область на шкале времени, 
чтобы создать область лупа.  
 
 
 

 
Теперь мы выделяем область в районе трека, 
чуть ниже клипа. В пределах области лупа теперь 
создана новая выделенная область, но исходная 
область лупа осталась неизменной.  
 

 
Затем, мы щелкнули правой кнопкой мыши по 
области и выбрали опцию Split items at time 
selection из меню. Теперь у нас есть отдельный 
клип (который, например, мы можем мьютировать 
или добавить к нему эффект), но исходная 

область лупа все еще остается выделенной.  
 

Здесь мы добавили эффект к новому клипу. 
Теперь мы можем выделить другую область, 
которую мы можем также отредактировать при 
необходимости.  
 

Заметьте, что мы можем продолжать работать с различными выделенными областями, но наша исходная 
область лупа остается нетронутой. Можно воспроизводить эту зацикленную область раз за разом, работая над 
другими выделенными областями в пределах этой области лупа. 
 

7.7. Привязка с комбинированными параметрами окна Snap/Grid Settings 
 
Вы уже научились (в Главе 5) редактировать параметры сетки, которые определяют, будут ли отображаться на 
экране линии сетки на дорожках треков, и если будут, то как. Окно Snap/Grid Settings (на рисунке в конце 
главы) может также использоваться для определения автоматической привязки различных действий (включая 
выделение области и определение области лупа) и/или клипов к позиции согласно вашим настройкам. 
Например, к ближайшей доле. Доступ к диалоговому окну Snap/Grid Settings можно получить через команду 

Options > Snap/Grid Settings (Alt+L), или щелчком правой кнопкой мыши по кнопке  на панели 
инструментов REAPER.  
 
Горячая клавиша Alt+S используется для активирования/отключения привязки. В секции Snap Settings можно 
определить к чему будет применяться привязка: 
 
Swing grid: Опция позволяет приспосабливать все или только выбранные клипы к изменениям колебания сетки. 
Доступна также опция Use the same grid division in arrange view and MIDI editor. Подробнее о колебании сетки 
в Главе 13. 
Меню Media Items snap at: гарантирует, что при создании, перемещении или редактировании клипа, он будет 
привязываться к выбранным здесь параметрам – только к его началу (Only snap at start), к его началу и к его 
окончанию (Snap both start/end), или к позиции курсора (Mouse-position dependent). 
Опции Selection: определяют, должны ли привязываться действия выделения области лупа и выделенной 
области к выбранным клипам/маркерам/курсору (selections/markers/cursor) или к сетке (grid). 
Опции Cursor: определяет, должен ли привязываться курсор к выбранным клипам/маркерам/курсору 
(selections/markers/cursor) или к сетке (grid). 
Snap cursor to edge of media items on any track (привязывать курсор к границам клипов на любом треке). 
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Snap to project sample rate: позволяет курсору, маркерам, границам лупа и огибающим привязываться к 
сэмплам.  
Обратите внимание на параметр Snap to grid at any distance. Он обеспечивает более гибкую привязку. 
Например, можно установить интервал сетки, скажем в 50 пикселей, определить расстояние привязки, скажем, в 
5 пикселей и отключить опцию Snap to grid at any distance. Это гарантирует, что привязка к сетке произойдет 
только тогда, когда вы щелкнете в пределах 5 пикселей одной из линий сетки. В противном случае, курсор будет 
помещен в точное место щелчка. Обратите также внимание на опцию Snap relative to grid (привязываться 
относительно сетки). 
 

 
 

7.8. Привязка с разделенными параметрами Snap и Grid 
 
На примерах предыдущей главы REAPER был настроен так, чтобы использовать один и тот же набор 
параметров привязки как для отображения сетки, так и для самой привязки. Другими словами, привязка 
применялась к ближайшей позиции сетки. Теперь давайте посмотрим, что мы можем сделать, если отключим 
опцию Grid snap settings follow grid visibility. Мы также изменим параметры minimum pixels для grid line 
spacing, в данном случае в значение 20 пикселей, оставив параметр grid snap spacing в значении одной 
шестнадцатой доли (точка, где курсор показан на снимке экрана).  
 

 
 
Если достаточно заметно увеличить масштаб проекта, линии сетки будут видны для каждой четвертной доли, но 
привязка будет применяться между ними, а также на линиях сетки в каждой шестнадцатой доле.  
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Обратите внимание также на опцию Media items snap to (привязать клипы к…) со значениием Snap both 
start/end, Only snap at start/snap offset или Mouse position dependent (т.е. в какую бы позицию ни был 
помещен курсор мыши, привязка будет применена к ближайшей точке - к позиции курсора, к началу или к 
окончанию). 
 

Совет: когда привязка активирована, ее можно временно отключить при выделении области лупа на 
шкале времени удерживая клавишу Ctrl. 
 

7.9. Функция Trim Behind 
 
Переключаемая опция Options > Trim content behind media items when editing может использоваться для 
эффективной замены текущего материала новым материалом, который в результате определенного действия 
редактирования помещается поверх текущего. Эта опция также доступна в контекстном меню кнопки Auto 
Crossfade на главной панели инструментов. Самый легкий способ понять, в чем заключается эта функция, 
состоит в рассмотрении примера того, что произойдет, когда вы перемещаете один клип на другой с 
активированной и отключенной функцией “trim behind”. В данном примере мы предположим, что функция Auto 
Crossfade отключена. Давайте сначала посмотрим, как REAPER ведет себя с отключенной функцией trim 
behind (по умолчанию). 

 
1. На рисунке два трека гитары. 
 
 
 
 
 
2. Мы перемещаем клип со второго трека на 
первый. 
 
 
 

 
3. Если теперь мы активируем свободное расположение клипов на треке и увеличим высоту трека, то при 
перетаскивании клипа выше исходного клипа, мы увидим, что и оригинал и новый клип теперь расположены 
вместе на этом треке.  
 

Давайте теперь посмотрим на то, что 
произойдет, если мы повторим эти действия, 
но на сей раз с активированной опцией Trim 
content behind media items when editing. 
Шаги 1 и 2, казалось бы, совпали с прежними.  
 

Но посмотрите, что теперь происходит в шаге 3:  
 
На этот раз, когда мы активируем 
свободное расположение клипов на треке 
и перетаскиваем новый клип, исходный 
клип заменяется новым. Этот пример 
предназначен исключительно в качестве 

иллюстрации. Это не означает, что есть необходимость активировать свободное расположение клипов на треке, 
если вы хотите работать с активированной функцией “trim behind”. 
 

7.10. Эффекты применяемые к фрагментам клипа 
 
REAPER позволяет применять эффекты не только к отдельным трекам, но и к отдельным фрагментам клипов в 
пределах трека. Предположим, например, что вы хотите добавить эффект (такой как ревербератор или дилей) 
только к определенному фрагменту трека. Можно разделить клип на треке на несколько частей и применить 
эффект только к некоторым из них. Если в секции Media Item Buttons (Options > Preferences > Appearance > 
Media) вы отметили опции Per take FX и No FX, можно нажать кнопку FX любого фрагмента клипа, чтобы 
открыть его окно эффектов. Подробнее эта тема будет обсуждаться далее в этой главе. Альтернативно можно 
выбрать клип и использовать горячую клавишу по умолчанию Shift+E. Чтобы добавить плагин к клипу: 
 
- выберите клип. 
- нажмите кнопку FX или нажмите Shift+E, чтобы открыть окно эффектов клипа.  
- в окне Add FX to Item дважды щелкните по плагину. 
- отрегулируйте параметры эффекта, а затем закройте окно эффектов.  
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 Если теперь вы наведете мышь на кнопку FX клипа, вы увидите, что 
всплывающая подсказка отображает цепочку эффектов. Если вы 
находите этот метод слишком "навороченным", попробуйте другой - 
просто перетащите плагин из окна браузера эффектов прямо на клип, 
на любое его место. Когда эффект добавляется к клипу, названия 
эффектов отображаются в области аранжировки наряду с именем 
клипа. 

 
Важное примечание: если клип включает несколько копий, убедитесь, что вы выбрали правильную 
копию перед тем, как открыть цепочку эффектов клипа. Это вызвано тем, что эффекты назначаются 
также и на отдельные копии. 

 
Совет: чтобы добавить эффект к клипу или открыть текущий эффект для редактирования, в контекстном 
меню кнопки FX выберите соответствующую опцию. 
 

Суммарный список опций управления эффектами клипа: 
 
Чтобы добавить плагин к цепочке эффектов клипа: перетащите его из окна браузера эффектов на клип. 
Чтобы открыть и просмотреть цепочку эффектов клипа: выберите клип и нажмите Shift+E. 
Чтобы удалить цепочку эффектов клипа целиком: щелкните по первому плагину в цепочке, затем нажмите 
клавишу Shift и щелкните по последнему плагину в цепочке. Будут выделены все плагины в этом диапазоне. 
После этого нажмите Delete. 
Чтобы скопировать цепочку эффектов клипа в другой клип: выберите плагины, а затем перетащите их с 
одного клипа в другой. Если кнопка FX видна, просто захватите кнопку FX и перетащите ее на нужный клип. 
Чтобы скопировать огибающие автоматизации с эффектами, используйте Shift+Ctrl+перетаскивание. 
 

 
 
Параметры на рисунке выше определяют отображение различных кнопок для отдельных клипов. Мы 
возвратимся к этой теме более подробно позже в этой главе, но на данный момент просто заметим, что 
доступные значки элементов (кнопок) включают их статус блокировки (Locked/Unlocked), мьютирования 
(Muted/Unmuted), их цепочку эффектов (FX/No FX), их заметок (Notes/No Notes) и свойств (Properties). Если на 
странице Options > Preferences > Appearance > Media опция Draw labels above the item rather than within the 
item активирована, кнопки будут отображаться (с именем клипа) выше самого клипа. Если отмечена опция 
When media item height is less than label height надпись будет перемещена во внутреннюю часть клипа. Если 
вы отключите эти опции, надписи (если будут отображены) будут всегда располагаться на самих клипах. 
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7.11. Окно Nudge/Set Items 
 
Окно Nudge/set items можно открыть из контекстного меню клипа. Это действие можно назначить на горячую 
клавишу в редакторе действий или назначить на кнопку на панели инструментов в редакторе меню/панелей 
итнструментов (Customize Menus/Toolbars). Использование редактора действий и редактора меню/панелей 
итнструментов объясняется в Главе 15.  
 

 
 
Однажды открытое окно Nudge/set items остается открытым до тех пор, пока вы его не закроете. Можно 
выбрать любой клип (или несколько клипов) и использовать это окно для пошагового перемещения или 
определения точной позиции клипа. Конкретное поведение параметров этого окна будет зависеть от других 
параметров (например, от параметров привязки, и от того, определен или нет клип в качестве лупа). Основные 
опции и параметры этого окна описаны в списке ниже, слева направо: 
 

Меню Action: доступные опции -  Nudge или Set. Выбранная здесь опция определяет, как REAPER 
будет интерпретировать информацию о единице времени (параметры Unit Value и Unit Type). Если 
выбрана опция Nudge, клип будет смещаться согласно единице времени, определенной суммой 
параметров Unit Value и Unit Type. 

 
На рисунке выше, позиция клипа была смещена на 10 мс влево или вправо (в зависимости от того, какая из 
кнопок Nudge нажата). Если выбрана опция Set, клип будет смещен в назначенную позицию, определенную 
параметром Position. 
 

Меню Nudge/Set Definition: здесь вы можете точно определить на что будет пошагово 
смещаться или перемещаться клип: 
 
Position - клип будет физически перемещен целиком 
Left Trim - клип будет обрезан слева 
Left Edge - left edge - будет перемещена левая граница клипа 
Right Edge - right edge - будет перемещена правая граница клипа 
Contents - сам клип остается на месте, но его содержимое будет перемещено в пределах клипа 
Duplicate - создает дубликат клипа(ов) 

Edit Cursor - будет перемещен курсор редактирования 
 
Перемещение влево или вправо будет зависеть от того, какая нажата кнопка Nudge Left или Nudge Right. Если 
в меню Nudge/Set Definition выбраны опции Duplicate и Nudge, вы сможете определить количество копий 
(единиц) 
 

Область Unit Value: определяет значение единицы, на которое будет 
смещаться клип. Этот параметр работает в паре с меню Unit Type.  
В примере, показанном слева, в качестве типа единицы выбраны 
миллисекунды, и значение единицы равняется 10 
Меню Unit Type: доступные значения: миллисекунды, секунды, линии 
сетки, такты/доли, сэмплы, кадры, пиксели, продолжительность клипа, 
область лупа/ выделенная область и ноты. Если выбрано значение нот 
(notes), появляется дополнительный выпадающий список, включающий 
различные длительности нот (от 1/256 до целой) 
 
 

Флажок Snap to Unit: активирует/отключает функцию привязки 
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Кнопки Nudge left/Nudge right: эти кнопки появляются только тогда, когда в меню 
Action выбрана опция Nudge. Они определяют направление пошагового смещения 

клипа (ов) влево или вправо 
 

Кнопки Get cursor/Apply move: эти кнопки появляются только тогда, когда в меню 
Action выбрана опция Set. Кнопка Get Cursor возвращает текущую позицию курсора 

и вписывает ее в область “to”. Кнопка Apply Move перемещает клип согласно различным опциям и параметрам, 
включая позицию, определенную в области “to”. 
 

7.12. Свойства клипа (окно Media Item Properties) 
 
Для всех клипов доступна страница параметров их свойств, которая помогает определить точное поведение 
этого клипа. Зачастую, редактирование в REAPER заключается в выборе клипа (или создания нового) и 
изменении его свойств. Чтобы отобразить окно свойств клипа, выберите клип и нажмите клавишу F2, или 
щелкните правой кнопкой мыши по клипу и выберите опцию Item Properties из меню, или щелкните по его 
кнопке свойств (если отображена) или для аудио (но не для MIDI) клипов дважды щелкните по клипу. Окно 
Media Item Properties остается открытой до тех пор, пока вы ее не закроете. Если вы оставите ее открытой, ее 
содержимое будет отображать свойства следующего выбранного клипа. Поэтому необязательно для каждого 
выбранного клипа открывать окно его свойств. Давайте рассмотрим основные параметры этого диалогового 
окна: 
 

Область Position: точные числовые 
значения, соответствующие начальной 
позиции клипа. 
Область Length: продолжительность 
клипа. Значения областей Position и 
Length будут меняться в зависимости от 
выбранной опции отображения: время 
(time), доли (beats) или часы: минуты: 
секунды: кадры (HMSF). 
Области Fade In и Fade Out: длина 
фейдингов (нарастающего и 
затухающего), длина кривой фейдинга 
(Curve) и тип кривой (щелчком на области 
справа). 
Область Snap offset: интервал смещения 
от позиции привязки по умолчанию, если 
функция привязки активирована. 
Меню Item timebase: представление 
времени клипа. По умолчанию привязана 
к представлению времени проекта, но 
может быть изменена отдельно. 
Меню Item mix behavior: при наложении 
клипов определяет будет ли клип 
объединяться или заменять текущий. 
Значения по умолчанию как в проекте 
(Project default item mix behavior). 
Опция Loop source: определяет, 
зацикливать ли клип. 
Опция Mute: определяет статус 
мьютирования клипа. 
Опция Lock: определяет статус 
блокировки клипа. 
Опция No autofades: определяет будет 
ли применяться автоматический 
кроссфейдинг в начале и в конце 
скрещенных клипов. 
Опция Play all takes: определяет должны 
ли воспроизводиться все копии клипа. 
Очевидно, это применяется только тогда, 
когда у клипа две и более копий. 
Область Take name: действующее имя 

клипа. REAPER по умолчанию будет использовать имя файла клипа, но здесь это имя можно изменить 
Область Pitch adjust (semitones): высота тона клипа 
Область Start in source: временная начальная позиция источника клипа. 
Область Playback rate: скорость воспроизведения клипа. 
Опция Preserve pitch when changing rate: определяет сохранять ли высоту тона клипа при изменении скорости 
воспроизведения клипа. 
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Слайдеры Volume/Pan: громкость/панорама клипа 
Кнопка Normalize: щелчок по этой кнопке позволяет нормализовать громкость клипа 
Селектор Channel mode: будет обсуждаться позже. 
Опция Invert phase: если флажок отмечен, фаза будет инвертирована. 
Кнопка Take envelopes: открывает дополнительное окно где можно определить какие огибающие будут 
отображаться для клипа. 
 

 
 

Меню Pitch shift/time stretch mode: алгоритм изменения высоты тона/растяжения 
по времени клипа. 
 
 
 
 
 
 
 
 
 

Область Stretch marker fade size: время затухания по умолчанию. 
Опция Optimize for tonal content: определяет оптимизировать ли тональный контент 
Секция Take media source: выбор медиаисточника копии 
Опция Section: использовать в качестве копии только фрагмент. В соответствующих областях выставляется 
временные параметры фрагмента. 
Опция Reverse: определяет реверсировать ли клип 
Кнопка Properties: щелчок по этой кнопке открывает дополнительное окно, где вы можете посмотреть исходную 
папку файла клипа. 
 

 
 
Кнопка Choose new file: щелчком по этой кнопке можно выбрать новый файл, который будет использоваться в 
качестве файла для этого клипа. 
Кнопка Rename file: щелчок по этой кнопке позволяет переименовать текущий клип 
Кнопка Nudge/Set: щелчок по этой кнопке обеспечивает доступ к одноименному диалоговому окну для этого 
клипа. 
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Кнопка Take FX: обеспечивает доступ к цепочке эффектов этого клипа /копии. 
 
После внесения любых изменений нажмите кнопку Apply, чтобы внести изменения и оставить окно открытым, 
или нажмите OK, чтобы внести изменения и закрыть окно или нажмите Cancel, чтобы закрыть окно, не внося 
изменений. Доступна также опция (щелчком правой кнопкой по строке заголовка) Apply changes after 2 seconds 
of inactivity (внести изменения после 2-х секунд бездействия). Некоторые из вышеперечисленных опций - 
такие как Loop Source и Channel Mode - также доступны в меню Item Settings. Кроме того, для большинства из 
опций доступны горячие клавиши, и которые можно определить вручную. Тема назначения горячих клавиш 
освещается в Главе 15, посвященной редактору действий. 
 

Совет: чтобы изменить свойство (например, playback rate) нескольких клипов одновременно, просто 
выделите все необходимые клипы, и в окне Media Item Properties любого их них внесите изменения. 
 

7.13. Значки клипов 
 
Для некоторых параметров в диалоговом окне Item Properties доступны значки (кнопки), который могут 
использоваться в качестве быстрого доступа к этим часто используемым функциям. Отображение кнопок 
активируется/скрывается на странице Options > Preferences > Appearance > Media в секции Media item 
buttons.  
 

 
 
Значки перечислены на двух строках. Отметка флажков в первой строке означает, что значки будут отображены 
только тогда, когда клип будет активирован (горячей клавишей, меню или в диалоговом окне Item Properties).  
 

 
 
Отметка флажков во второй строке означает, что значки будут отображаться только в том случае, если будет 
активирована соответствующая опция. Например, если вы отметили флажок Mute в первой строке, но не 
отметили флажок Not muted во второй, то кнопка Mute будет просто отображаться, когда клип будет 
мьютирован. Кнопка указывает на статус мьютирования трека и может также использоваться для его 
размьютирования. Если вы отметите флажки в обеих строках, кнопка Mute будет отображаться всегда (если для 
этого будет достаточно места) на всех клипах, и может использоваться в качестве переключателя. 
Активирование опции Properties (resampled only) означает, что эта кнопка будет отображаться только в том 
случае, если клип будет ресэмплирован.  
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На рисунке слева - два клипа, оба с 
отображенными кнопками Mute, 
Lock, Notes и FX. Первый клип 
мьютирован, а второй клип 
блокирован. Расположены ли ваши 
значки выше клипа или на самом 
медиа клипе, зависит от опции Draw 

labels above item rather than within item на странице Options > Preferences > Appearance > Media. Обратите 
внимание на то, что, даже если вы активировали эту опцию, она будет применена только в том случае, если для 
этого будет достаточно места на панели трека (достаточная высота трека). Подробнее о других параметрах 
страницы Options > Preferences > Appearance > Media в Главе 22. 
 

7.14. Примечания для клипа 
 
Кнопка Notes  (или команда Item settings > Item notes из контекстного меню) может использоваться для 
добавления любых текстовые примечаний для этого клипа. После добавления примечания на клипе появляется 
маленький значок Notes. Если навести мышь на этот значок отображается всплывающая подсказка с заметкой.  
 

 
 
Щелкните по значку, чтобы открыть и отредактировать окно Notes. В окне Notes нажмите кнопку Load, чтобы 
загрузить любой .PNG или.JPG файл.  
 

 
 
Опция Use as item background может использоваться для отображения этого изображения со значком.  
 

 
 

Дополнительно, можно выбрать опцию Stretch to fit item. Пример клипа с 
изображением показан на рисунке слева. Значки можно вставить в клип, 
перетащив их из проводника. 
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7.15 Раскраска отдельных клипов 
 
Можно изменить цвет отдельного клипа (или нескольких выбранных клипов) сначала выбрав эти клипы, а затем 
в контекстном меню перейти Item and take colors и выбрать одну из дополнительных опций: Set items to 
custom color (выбрать цвет для клипов) или Set items to random colors (установить для клипов цвет в 
случайном порядке) или Set items to one random color (установить для клипов один цвет, выбранный в 
случайном порядке).  
 

 
 
Различные опции окраски сигналограмм клипов и/или фона можно найти на странице Options > Preferences > 
Appearance > Peaks/Waveforms. Некоторые темы (включая тему по умолчанию) не позволяют изменять 
пользователю эти опции, в этом случае вы не сможете их изменить.  
 
Примеры: 
 

 
 
На рисунке выше, трек вокала разделен на несколько отдельных фрагментов. Предположим, что это два запева 
и два припева, и мы хотим выделить припевы. Мы можем выделить клипы припева, затем щелкнуть правой 
кнопкой по любому клипу и в подменю Item and take colors выбрать опцию Set items to custom color. Эти 
команды также доступны в главном меню Edit. Затем мы можем выбрать любой цвет из диалогового окна 
Colors и нажать кнопку OK. Теперь эти клипы будут окрашены в выбранный цвет. Другие схожие команды: Set 
items to random color (установить цвет для выбранных клипов в случайном порядке) и Set items to one 
random color (установить цвет для выбранных клипов в один цвет, выбранный в случайном порядке). Чтобы 
изменить выбранный цвет на цвет по умолчанию, выберите опцию Set items to default color. 
 

7.16. Управление громкостью клипа 
 
Помимо использования огибающих (до которых мы доберемся в Главе 18) есть три основных способа настройки 
громкости отдельных клипов: 
 
- использование хэндла или регулятора громкости клипа. 
- использование фейдера громкости на странице Item Properties. 
- нормализация. 
 
7.16.1. Регулятор громкости/хэндл громкости клипа 
 
Страница Options > Preferences > Appearance > Media включает опцию, определяющую какой тип контроллера 
использовать для регулирования громкости клипа - регулятор (Item volume knob) или хэндл (Top edge of media 
item). Результат выбора опции Item volume knob показан на рисунке ниже.  
 

 
 
Чтобы сбросить регулятор в значение в 0.0 дБ, дважды щелкните по нему. Чтобы отрегулировать громкость 
несколько клипов одновременно, выделите нужные клипы и отредактируйте регулятор любого из них.  
 
Хэндл - горизонтальная планка наверху каждого клипа. Она не видна до тех пор, пока вы не наведете мышь на 
вершину клипа, и не покажется двухсторонняя вертикальная стрелка. Чтобы понизить громкость, захватите 
планку и переместите мышь вниз.  
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Чтобы повысить громкость клипа выше 0 дБ, захватите планку и поднимите ее с нажатой клавишей Shift. Чтобы 
отрегулировать громкость в более точных приращениях, при редактировании хэндла или регулятора 
удерживайте клавишу CTRL. 
 

 
 
Совет: верхнюю границу диапазона хэндла (которая по умолчанию установлена 0.0 dB можно изменить 
на странице Options > Preferences > Media с помощью опции Media item adjustment range, установив 
значение -inf. + 6 дБ. 

 
7.16.2. Фейдеры Volume и Pan 
 
Диалоговое окно Item Properties включает два горизонтальных фейдера (Volume и Pan) налево от кнопки 
Normalize.  
 

 
 
Они могут использоваться для регулирования громкости и панорамы соответственно. После установки 
соответствующего уровня нажмите Apply чтобы внести изменения. Этот метод особенно полезен в том случае, 
если вы вносите изменения как в громкость, так и в панорамирование одновременно или если вы не хотите, 
чтобы отображался хэндл громкости клипа. 
 
7.16.3. Нормализация клипов 
 
Нормализация - это установка громкости клипа (или несколько клипов) в стандартное значение. Это может 
быть особенно полезно, если некоторые ваши треки были, возможно, записаны на слишком низком уровне. Для 
этого: 
 
1. Выберите любой клип (или несколько клипов). 
2. Щелкните правой кнопкой по любому клип из выделенных. 
3. В меню перейдите Item processing > Normalize items или Normalize items (common gain). 
 
Опция Normalize items (common gain) используется в том случае, если вы хотите, чтобы уровень всех клипов 
был поднят до уровня самого громкого клипа среди выделенных. Если вы хотите, чтобы каждый выбранный 
клип был нормализован независимо, выберите опцию Normalize items. Любой отдельный клип можно также 
нормализовать, нажав кнопку Normalize в его окне Item Properties. 
 

7.17. Изменение режима канала клипа 
 
Страница Item settings (вызываемая в контекстном меню клипа) для стереоклипа включает несколько 
канальных режимов (channel mode). Этот же параметр доступен в диалоговом окне Item Properties: 

 
Normal: оставляет или возвращает стереоклип в его исходное 
состояние каналов. 
Reverse Stereo: обменивает левый и правый каналы. 
Mono (Downmix): объединения левый и правый каналы в один 
моноканал. 
Mono (Left): создает один моноканал, используя выходной сигнал 
только левого канала. 
Mono (Right): создает один моноканал, используя выходной сигнал 
только правого канала. Для многоканальных клипов (см. Главу 3) 
доступна также опция конвертирования в моно или стерео в другие 
каналы, кроме 1 и 2. 
 
 

Примеры: 
 
Некоторые примеры иллюстрированы ниже. Обратите внимание на то, что эти изменения не разрушающие. 
Режимы можно переключать любое количество раз. Например, чтобы быстро и легко сконвертировать 
стереоклип в два моноклипа, можно просто скопировать его, а затем установить один в режим Mono (left), а 
другой в Mono (right). 
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Mode: 
Normal 
 
 
 
Mode: 
Reverse 
Stereo 
 
 
Mode: 
Mono 

(Downmix) (т.е. смешанный в один монотрек) 
 

7.18. Свойства источника копии 
 

 
 
Секция Take media source диалогового окна Media Item Properties может использоваться для просмотра 
свойств текущей выбранной копии или для ее изменения, или для переименования ее исходного файла. Если 
клип состоит только из одной копии, термины “take media source” (медиа источник копии), и “item media 
source” (медиаисточник клипа) становится синонимами. Чтобы изменить содержимое клипа нажмите кнопку 
Choose New File, или чтобы переименовать его используйте опцию Rename File. Можно нажать кнопку 
Properties, чтобы отобразить информацию о формате исходного аудиофайла или MIDI записи, которая 
является источником клипа. В случае с MIDI клипами можно также изменить некоторые свойства, такие как 
ограничение используемых каналов. Примеры показаны ниже: 
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7.19. Примеры редактирования и прослушивания в REAPER 
 
Новички в освоении любой программы по обработке цифрового аудио поначалу не дружат с редактированием, 
особенно если они привыкли к другой программе, которая использует другие подходы. Лучший способ понять 
программу - работать с ней через примеры. Данные примеры предполагают, что опция Link loop points to time 
selection в меню Options активирована. Откройте файл All Through The Night.RPP и используя команду File > 
Save Project As сохраните его под именем All Through The Night EDITS.RPP. Дальнейшие примеры призваны 
помочь вам в изучении и понимании REAPER. Они не предназначены для охвата каждой функции REAPER и 
при этом не предполагается, что они обеспечат достаточно хорошую аранжировку этой песни. Для начала 
установите панораму двух треков гитары влево и вправо на 33% соответственно. 
 
1. Мы собираемся сделать копию трека Bouzouki, а затем разобраться со звуком. На панели трека щелкните 
правой кнопкой по имени или номеру трека Bouzouki, а затем из меню выберите Duplicate tracks. 
2. Переименуйте новый трек в Bouzouki Copy. Нажмите Ctrl+S, чтобы сохранить файл проекта. 
 

 
 
3. На панели треков щелкните по номеру первого трека Bouzouki, затем удерживая клавишу Ctrl щелкните по 
номеру второго трека Bouzouki. Теперь выбраны оба трека. 
4. Нажмите кнопку Solo любого из выделенных треков, чтобы солировать оба. 
5. В то время как оба трека все еще выбраны отрегулируйте фейдер громкости любого из треков в значение - 7 
дБ. 
6. Удерживая клавишу Shift, переместите фейдер Pan первого трека Bouzouki приблизительно на 55% влево,  
и, опять же удерживая клавишу Shift, переместите фейдер Pan второго трека Bouzouki приблизительно на 55% 
вправо. 
7. Щелкните правой кнопкой мыши по клипу второго трека Bouzouki и выберите опцию Item properties из меню. 
Измените параметр Start in Source на - 0:00.007. Нажмите Apply, затем OK. Это заставит этот клип пошагово 
сместиться на 7 миллисекунд вправо, добавляя очень небольшой эффект задержки, что сделает звук 
инструмента более объемным. 
8. Нажмите Ctrl+S. Воспроизведите песню. 
9. Во время воспроизведения, нажмите кнопку Solo любого из треков Bouzouki с нажатой клавишей Ctrl. Это 
снимет статус солирования с обоих треков. 
10. Щелкните правой кнопкой мыши ниже панели треков и выберите опцию Show master track. 
11. Отрегулируйте панораму и громкость различных треков примерно, так как нарисунке ниже. Нажмите Ctrl+S. 
 

 
 
12. Возможно вы довольны итоговым балансом различных треков, но все же общая громкость мастер-трека 
может быть немного повышеной в некоторых местах. 
13. Нажмите кнопку FX мастер-трека и вставьте плагин JS/Utility Limiter. Установите максимальную громкость 
лимитера в значение -0.5. Закройте окно эффектов и убедитесь, что фейдер Volume мастер-трека установлен в 
значение 0dB. Теперь песня будет воспроизводиться без клиппирования. 
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14. Обратите внимание на пустое место в конце песни, которую мы можем удалить. Поместите указатель 
текущей позиции туда, где закончился полезный материал и начинается тишина. Убедитесь, что никакой трек не 
выделен, а затем нажмите клавишу S, чтобы разделить все треки в позиции курсора. 
 

 
 
15. Обратите внимание на то, что, если до последнего действия каждый трек состоял из одного клипа, то теперь 
каждый клип разделен на два. Новые созданные клипы (на правой стороне) должны быть все еще выделены. 
Если они не выделены, щелкните правой кнопкой и нарисуйте вокруг них рамку, чтобы их выделить. 
16. Нажмите клавишу Delete, чтобы удалить эти клипы. Нажмите Ctrl+S, чтобы сохранить проект. 
17. Теперь мы собираемся мьютировать определенный фрагмент клипа. Сначала необходимо создать 
отдельный клип, содержащий область, которая будет мьютирована. 
18. Выберите клип трека Vox. Поместите курсор редактирования приблизительно на 56-ой секунде. 
19. Нажмите горячую клавишу Shift+клавиша тильда, чтобы максимизировать текущий трек. Нажмите 
Ctrl+Alt+стрелка вверх или Ctrl+Alt+стрелка вниз, пока не появится трек Vox. При таком уровне 
масштабирования вы заметите, что в запись попали некоторые нежелательные звуки, когда вокалист не поет. 
Скорее всего, это проникший сигнал с наушников. Мы собираемся избавиться от него. 
20. Если вы сначала хотите услышать его, можно солировать этот трек и воспроизвести его. Не забывайте снять 
статус солирования по окончании. 
21. Отобразите окно Big Clock (View > Big Clock). В позиции курсора около 56-й секунды неоднократно нажмите 
клавишу +, пока область, с которой мы хотим иметь дело, не займет значительную часть экрана. 
 

 
 
22. Щелкните по клипу, чтобы выбрать его. 
23. Чуть ниже шкалы времени выделите область, с которой мы будем работать. 
 

 
 
24. Щелкните правой кнопкой по клипу и выберите опцию Split items at time selection. Это создаст новый клип, 
и этот новый клип будет выбран. Нажмите клавишу Esc, чтобы снять выделенную область. 
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25. Если кнопка Mute клипа видна, щелкните по ней. В противном случае, щелкните правой кнопкой по этому 
новому клипу и перейдите Item settings > Mute. 
26. Нажмите клавишу ~, чтобы возвратить нормальное отображение треков. Отрегулируйте высоту треков по 
вашему усмотрению. 
27. Воспроизведите песню. Заметьте, что теперь трек Vox будет мьютирован в области, с которой мы работали. 
 

 
 
28. Нажмите Ctrl+S, чтобы сохранить проект. Вскоре мы возвратимся к этому примеру. 
 

7.20. Редактирование нескольких клипов 
 
Можно использовать различное способы редактирования REAPER (включая интеллектуальное редактирование) 
с несколькими клипами. Просто выберите клипы, а затем выполните редактирование. 
 
1. То же самое можно сделать с несколькими смежными треками одновременно при помощи выделяющей рамки 
(щелкните правой кнопкой и выделите рамку). 
2. То же самое можно сделать с клипами в несмежных треках. Выделите диапазон, затем выберите первый 
клип, а затем удерживая клавишу Ctrl, щелкните по каждому из клипов. На первом рисунке (ниже) треки 1 и 4 
были выделены именно таким образом.  
 

 
 
На втором рисунке та же самая выделенная область вырезана из обоих клипов.  
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7.21. Slip-редактирование 
 
К нежелательным фрагментам можно применить slip-редактирование с любой границы клипа. Для этого: 
 

1. Наведите курсор мыши на нижнюю часть левой или правой границы клипа 
так, чтобы появилась двойная горизонтальная стрелка с квадратной скобкой 
(как показано на рисунке слева). Направление скобки зависит от того, куда вы 
поместили курсор - в начало клип или в конец. 
 
 
 

2. Захватите границу и переместите мышь влево или вправо, а затем отпустите кнопку 
мыши. 
 
 
 
 
 

 
7.21.1. Slip-редактирование нескольких клипов 
 

Выделите нужные клипы, а затем примените slip-редактирование к 
любому из выделенных клипов. Изменение затронет все выделенные 
клипы пропорционально. Это еще один пример того, где можно 
настроить параметры мыши REAPER, чтобы изменить ее поведение 
по умолчанию. Например, вы можете сделать так, что, даже когда 
выделено несколько клипов, только один клип будет отредактирован. 
Это можно сделать на странице Options > Preferences > Mouse 
Modifiers. Эта тема подробно затронута в Главе 15. Будьте 

осторожны при slip-редактировании смежных клипов, особенно когда они затрагивают друг друга. Если вы 
редактируете один из клипов так, чтобы между двумя клипами создалось пространство, то slip-редактирование 
будет обычным. Однако, если вы редактируете клипы так, чтобы их скрестить, вы создадите кроссфейдинг. 
Когда будет воспроизводиться фрагмент с кроссфейдингом, прослушиваться будут оба клипа. Это 
проиллюстрировано на рисунке ниже.  
 

 

Это поведение можно изменить двумя способами. Отключение функции auto-crosssfade (щелчок по кнопке  
на панели инструментов) отменит кроссфейдинг, но оба клипа по-прежнему будут прослушиваться. 
Активирование опции Trim content behind media items when editing в меню Options гарантирует, что при 
кроссфейдинге будет прослушиваться только slip-отредактированный клип.  
 

Другой способ использования slip-редактирования заключается в перемещении границы между 
двумя смежными клипами (возможно, после того, как исходный клип был разделен). Выберите оба 
клипа и наведите курсор мыши на границу между клипами, чтобы появился символ как на рисунке 
слева. Затем можно перетащить мышь влево или вправо, чтобы переместить границу. 
 

7.22. Настройка фейдинга 
 
Если вы выбрали какой-либо клип на треке и достаточно увеличили масштаб, вы заметите, что в конце этого 
клипа присутствует кривая постепенного затухания (фейдинг). Вы можете изменить форму и длину этой кривой, 
используя мышь или через окно Item Properties. 
 

1. Выберите самый правый клип на одном или более треках. На рисунке слева выбраны два 
трека. В данном примере выбранные клипы выровнены вертикально: так быть не должно. 
2. Наведите мышь на вертикальную белую линию, которая отмечает начало затухания. 
Курсор изменится на отображение искривленной формы. 
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3. Захватите линию и перетащите ее влево, чтобы увеличить длину фейдинга 
(см. рисунок слева), а затем отпустите мышь. Заметьте, что кривая фейдинга 
теперь более поката. Если бы к одному из этих клипов было применено slip-
редактирование, фейдинг сохранил бы свою форму и длину - он просто бы 
начался раньше. 
4. Убедитесь, что клипы все еще выбраны. 
 
 

 
5. Щелкните правой кнопкой по вертикальной линии, которая отмечает начало 
затухания. Отобразится меню с различными формами (кривыми) фейдинга (рисунок 
слева). Можно выбрать любую из них. Если хотите, вместо того, чтобы использовать 
мышь, можно нажать F2 (с выбранными клипами) и в окне Items Properties внести 
соответствующие изменения.  
 
 
 
 
 
 
 
 
 
 
 

Обратите внимание на страницу Options > Preferences > Project Defaults, где вы можете определить значение 
по умолчанию фейдинга и кроссфейдинга, их длину, нахлест, и характеристики форм кривой.  
 

 
 
Подробнее об этом в Главе 22. Кроме того, страница Options > Preferences > Mouse Modifiers обеспечивает 
дополнительную функциональность при выборе клавиш-модификаторов с мышью для работы с фейдингом и 
кроссфейдингом. Например, удерживая клавишу Shift при перетаскивании мыши влево или вправо область 
кроссфейдинга будет также перемещаться влево или вправо. Подробнее о клавишах-модификаторах при 
работе с мышью в Главе 15. 
 

7.23. Кроссфейдинг и редактор кроссфейдинга 
 

Обычно кроссфейдинг используется для сглаживания переходов 
с одного клипа к другому, когда эти клипы скрещиваются. На 
рисунке слева скрещены два клипа с применением 
кроссфейдинга. Горячая клавиша Alt+X активирует/отключает 
режим автоматического кроссфейдинга. Когда режим 
автоматического кроссфейдинга активирован, это гарантирует, 

что наложение одного клипа на другой автоматически создаст кроссфейдинг. Параметры кроссфейдинга по 
умолчанию (включая форму кривой фейдинга и кроссфейдинга) устанавливаются на странице Options > 
Preferences > Media Item Defaults. Различные параметры кроссфейдинга (такие как форма, начальная и 
конечная точки) можно редактировать мышью почти так же, как и простой фейдинг. Однако редактор 
кроссфейдинга обеспечивает более детальное управление его параметрами. Чтобы открыть редактор, 
перейдите View > Crossfade Editor, или дважды щелкните по кроссфейдингу. На рисунке ниже изображен тот 
же самый кроссфейдинг, как и прежде, но в открытом редакторе. Область кроссфейдинга была выделена 
щелчком в любом месте кривой кроссфейдинга. Редактор включает информацию о параметрах выбранного 
фейдинга клипов. Давайте рассмотрим параметры кроссфейдинга: 
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Меню Units: единицы измерения: секунды (seconds) или доли (beats).  
 
 
 

Область Shape: форма кривой затухания (секция Left side fade-out) и нарастания 
(секция Right side fade-in). Доступно 7 форм для обоих фейдингов. После выбора 
формы кроссфейдинг можно отредактировать мышью непосредственно на клипе. 
Для этого захватите либо края фейдингов, либо точку пересечения фейдингов. Для 
более детального редактирования кроссфейдинга можно использовать 
контроллеры диалогового окна редактора (см. ниже).  
 
 
 
 
 
 
 

Меню Equal gain/power: значение Equal gain обеспечивает линейный 
фейдинг. Значение Equal power обеспечивает логарифмический фейдинг.  
Значение Equal gain предпочтительно, когда оба клипа содержат схожий 
материал. Equal power можно выбрать, когда кроссфейдинг объединяет два 

различных типа звука или два разных инструмента.  
 

Назначение большинства контроллеров Curve (форма кривая), Center (центр), Start 
(начальная точка), End (конечная точка), Length (продолжительность), Contents 
(смещение) и Volume (громкость) очевидно. Контроллер Curve редактирует форму 
левой, правой или (если они привязаны друг к другу) обе кривые. В зависимости от 
других настроек это может заставить точку пересечения фейдингов сместиться влево 
или вправо. Отметьте также, что, с помощью контроллера Length можно определить 
позицию, на которую будет равняться кроссфейдинг - центр, начало, или окончание. 
Контроллер Contents может использоваться для смещения клипа влево/вправо. 
Контроллер Volume может использоваться для регулирования громкости скрещенных 
клипов. Значения параметров можно ввести непосредственно в соответствующей 
области редактирования.  
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Правые/левые границы фейдингов можно привязать 
(флажок Link) или зеркально отразить (флажок Mirror). За 
исключением параметров Start и End, привязка и 
зеркальное отражение - взаимоисключающие опции. 
Например, если привязаны параметры Shape, изменение 
формы любого из параметров заставит оба измениться 

одинаково. Если этот же параметр зеркален, выбор формы для одного фейдинга вызовет противоположную 
(если доступно) форму другого. Если параметры Start и End привязаны и зеркальны, регулирование одного из 
этих контроллеров изменит начало и конец продолжительности кроссфейдинга одинаково, с сохранением на 
месте центральной точки. Если привязываются параметры Length, изменение любого фейдинга изменит 
продолжительность обоих фейдингов одинаково. Если этот же параметр зеркален, растяжение одного фейдинга 
заставит другой сократится равнозначно. Если привязывается параметр Contents, оба клипа будут смещаться 
влево или вправо вместе. Если этот же параметр зеркален, клипы будут смещаться в противоположном 
направлении. Если привязан контроллер Volume, громкость обоих клипов будет регулироваться одновременно. 
Если этот же параметр зеркален, повышение громкости на одной стороне понизит громкость на другой. Если 
флажок Edit grouped items отмечен, изменения будут применены ко всем сгруппированным клипам. Если 
отметить флажок Audition для редактирования становятся доступными области Pre-roll и Post-roll в которых 
можно определить позиции для прослушивания до и после кроссфейдинга соответственно. Если флажок 
Audition отмечен область кроссфейдинга (вместе с позицией pre-roll/post-roll) зацикливается. Если нажать 

кнопку  на транспортной мини панели редактора воспроизведение начнется с начальной точки Pre-roll и 

закончится в точке Post-roll и возвратится в точку Pre-roll, где и остановится. Если нажать кнопку  
воспроизведение с точки Pre-roll до точки Post-roll будет воспроизводиться циклически. При этом будут 
сохранены любые другие текущие параметры зацикливания в проекте. Если отмечен флажок Solo track, трек 
будет солирован. Если отмечены флажки Mute left side или Mute right side будет мьютирована левая или 
правая сторона кроссфейдинга соответственно. Щелчок правой кнопкой по редактору открывает его контекстное 
меню.  
 

Транспортная мини панель внизу окна может использоваться для воспроизведения, паузы, 
остановки зацикливания кроссфейдинга.  

 
Кнопки Previous и Next служат для выбора предыдущего или следующего кроссфейдинга 
соответственно.  

 
Кнопка  наверху окна редактора может использоваться для сохранения текущих параметров 
редактора кроссфейдинга в пресет. Дополнительно, в пресет можно включить продолжительность 

кроссфейдинга. Сохраненные пресеты можно загрузить из выпадающего списка налево от этой кнопки. Если 
выбрано несколько кроссфейдингов, редактор применит параметры ко всем выбранным кроссфейдингам. 
 
7.23.1. Действия редактирования и клавиши модификаторы при работе с 
фейдингом/кроссфейдингом 
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И пересечение фейдинга клипов и настройку параметров фейдинга/автоматического кроссфейдинга с помощью 
клавиш-модификаторов (на рисунке выше) можно назначить отдельно на действия щелчка левой кнопкой мыши 
(left click), щелчка левой кнопкой мыши+перетаскивание (left click+dragging) и двойного щелчка (double click). 
Во большинстве случаев более интересны будут модификаторы с щелчком левой кнопкой 
мыши+перетаскивание. Эти модификаторы могут использоваться при работе с фейдингом или кроссфейдингом, 
например для активирования или отключения различных опций (таких как, игнорирование привязки и/или выбор 
клипов /их группировку, и растяжение клипов по времени) или для назначения действий (таких как 
редактирование кривой фейдинга). Доступны также опции, позволяющие редактировать кривую фейдинга 
мышью. В списке действий (Action List) REAPER щелчок левой кнопкой мыши и двойной щелчок может 
использоваться для применения любых из дополнительных действий пересечения фейдингов или 
автоматического кроссфейдинга. Эти действия включают изменение формы фейдинга/кроссфейдинга, 
изменение кривых только по горизонтали или по горизонтали и по вертикали и редактирование кривой фейдинга 
различными способами. Полный список смотрите в редакторе действий. Подробнее об использовании клавиш- 
модификаторов с мышью и о редакторе действий в Главе 15. Отметьте также, что страница Options > 
Preferences > Appearance > Fades/Crossfades включает различные опции, определяющие как и когда будут 
отображаться хэндлы редактирования фейдинга/кроссфейдинга (см. Главу 22). 
 

7.24. Группировка клипов 
 
При условии, что опция Grouping активирована - команда Options > Item Grouping Enabled (Alt+Shift+G) или 

активирована кнопка  на панели инструментов - клипы можно сгруппировать, чтобы облегчить работу с 
ними. Например, потом можно переместить их вместе, присвоить им один цвет, мьютировать и размьютировать, 
и так далее). Выберите клипы и нажмите клавишу G чтобы сгруппировать их. На рисунке ниже три из шести 
клипов сгруппированы.  
 

 
 
Заметьте, что на сгруппированных клипах отображается значок Grouped, при условии, что опция Grouped Items 
на странице Options > Preferences > Appearance > Media > Media items buttons отмечена. Даже когда этот 
флажок снят, вы увидите тонкую цветную полоску выше и ниже всех сгруппированных клипов.  
В группу можно добавить и дополнительные клипы. Щелкните по любому клипу в группе, а затем нажмите 
Ctrl+G, чтобы выделить всю группу. С нажатой клавишей Ctrl, щелкните по клипам, которые вы хотите добавить 
к группе, а затем отпустите клавишу Ctrl и нажмите клавишу G.  
 

 
 
Обратите внимание на клавишу U, которая удаляет выбранные клипы из группы. Для управления группой можно 
также использовать команды подменю Group в контекстном меню клипа. 
 
Пример: 
 
Загрузите файл All Through The Night EDITS.RPP, и сохраните его под именем All Through The Night GROUP 
ITEMS.RPP 
1. Выберите трек Vox и разделите этот трек на несколько клипов так, чтобы он напоминал изображение на 
рисунке выше. Чтобы удалить лишние клипы, выберите их и нажмите Delete. 
2. Убедитесь, что в меню Options опция Item Grouping активирована. Если это не так, отметьте ее. По 
умолчанию, горячая клавиша Alt+Shift+G активирует/отключает функцию группировки клипов. 
3. Выберите второй из клипов на треке Vox. Удерживая клавишу Ctrl, щелкните по четвертому и последнему 
клипам этого трека. 
4. Нажмите клавишу G, чтобы сгруппировать выбранные клипы. Выберите любой клип в группе и нажмите 
Ctrl+G, чтобы выбрать все клипы в группе. 
5. Если значки клипов видимы, нажмите кнопку Mute любого из клипа в группе. В противном случае, щелкните 
правой кнопкой мыши по клипу и выберите опцию Item Settings > Mute из меню. Повторите это действие, чтобы 
размьютировать клипы. 
6. Со всеми выбранными клипами в группе, щелкните правой кнопкой по любому из них и выберите опцию Item 
and take colors > Set items to custom color. Выберите цвет и нажмите Enter. 



 Специально для сайта musicmanuals.ru  157 157 

7. Теперь захватите первый из клипов и перетащите его немного вправо. Все клипы в группе будут двигаться 
вместе с ним. Нажмите Ctrl+Z, чтобы отменить перемещение. 
8. Теперь щелкните по любым другим клипам, находящимся вне группы. Это отменит выбор всех клипов в 
группе. Сохраните файл. 
9. Щелкните по любому клипу в группе и нажмите Ctrl+G. Опять же, будут выбраны все клипы группы. 
10. Нажмите клавишу U. Теперь эти клипы разгруппированы. Сохраните файл. 
 

7.25. Сохранение и загрузка групп клипов 
 
Различные группы клипов можно сохранить и загрузить, используя вкладки Item Groups окна Project Bay. Окно 
Project Bay будет подробно обсуждаться в Главе 12. На данный момент обратите внимание, что окно Project 
Bay можно открыть через команду View > Project Media > FX Bay, а затем выбрать вкладку Item Groups. Чтобы 
создать и сохранить несколько групп: 
 
1. Откройте окно Project Bay и выберите вкладку Item Groups. 
2. Выберите клипы для первой группы, а затем щелкните правой кнопкой по одному из них и выберите опцию 
Group > Group items из меню. Группа будет автоматически создана в окне Project Bay. Можно щелкнуть правой 
кнопкой по названию группы и выбрать опцию Rename group, чтобы переименовать созданную группу. 
3. Повторите шаг 2, чтобы создать другие группы.  
 
В данном примере показан проект с двумя группами клипов. Чтобы выбрать все клипы в группе, можно щелкнуть 
правой кнопкой по названию группы в окне Project Bay и выбрать опцию Select group из меню. Чтобы удалить 
группу, используйте команду Delete group, keep items в том же самом меню. 
 

Совет: чтобы отрегулировать громкость всех клипов в выбранной группе, удерживая Ctrl+Alt, 
отредактируйте регулятор громкости или хэндл громкости любого из клипов в этой группе. 
 

 
7.26. Объединение клипов с созданием нового файла (функция Glue) 

 
Когда на треке присутствует несколько клипов, которые вы хотите рассмотреть как один клип, обратите 
внимание на команду Glue items. При "склеивании" клипов, они становятся одним вновь созданным клипом. 
Например, два склеенные MIDI клипа будут автоматически и всегда открываться вместе в одном и том же окне 
MIDI редактора. Два склеенных аудиоклипа будут совместно использовать один набор параметров. Склеенные 
клипы, можно разделить любым удобным для вас способом. Это может быть полезно в случае, если 
необходимо отредактировать одно или несколько свойств части склеенного клипа. Чтобы склеить несколько 
смежных клипов на треке: 
 
1. Выберите все клипы, которые вы хотите склеить. 
2. Щелкните правой кнопкой мыши по любому из выделенных клипов и выберите опцию Glue items из 
контекстного меню. 
 
Пример: 
 
На рисунке ниже трек включает шесть отдельных клипов. Поместив мышь на первый клип, а затем щелкнув 
правой кнопкой мыши и нарисовав выделяющую рамку прежде, чем отпустить кнопку мыши, мы гарантируем, 
что все клипы будут выбраны.  
 

 
 
Затем мы щелкнем правой кнопкой мыши по любому из выделенных клипов и выберем опцию Glue selected 
items из меню. В результате клипы будут объединены в один клип, как показано на рисунке ниже.  
 

 
 
Одно из применений склеенных клипов заключается в объединении нескольких клипов в новый источник лупа. 
Подробнее об использовании лупов мы поговорим в Главе 9. Другой пример использования склеенных клипов 
заключается в рендеринге клипов, например, включив параметр усиления клипа и эффекты копии клипа в новый 
клип, и установив эффекты в обход. Когда таким образом склеены два или более клипов, эффекты и другие 
параметры будут применены к соответствующим фрагментам нового клипа. 
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Примечание: при склеивании MIDI клипов, любой клип, который включает эффекты копии, такие как 
VSTi синтезатор, будут сконвертированы в аудиофайл. 
 

 
7.27. Создание и копирование клипов в режиме карандаша 

 
REAPER включает дополнительный режим карандаша, который может использоваться для создания новых 
клипов или копирования текущих. Принцип работы этого режима определяется на странице Options> 
Preferences> Mouse Modifiers> Track left drag.  
 

 
 
В Главе 15 мы подробно рассмотрим эти параметры. Например, вы можете назначить клавишу модификатор 
Shift, который будет использоваться для рисования нового клипа. На данный момент мы оставим параметры как 
есть. По умолчанию следующие модификаторы могут использоваться при использовании функции drag-and-
drop на пустом месте в области аранжировки: 
Ctrl - добавляет копию текущего выбранного клипа. Если активирована привязка, она будет применяться. 
Ctrl+Shift - добавляет копию текущего выбранного клипа без привязки. 
Ctrl+Alt - добавляет копию текущего выбранного клипа используя источник MIDI данных с привязкой (если 
активирована). 
Shift +Ctrl+Alt - добавляет копию текущего выбранного клипа используя источник MIDI данных без привязки. 
 

 
 
Рисунок выше приведен в качестве примера. Первый из двух клипов на треке выделен. Удерживая клавишу Ctrl, 
щелчок и перемещение мыши вдоль этого трека копирует этот клип. 
 

7.28. Альтернативное копирование клипов. Функция Propagating. 
 
Две команды контекстного меню клипа - Propagate item to similarly named items on track и Propagate item to 
similarly named items (all tracks) - могут использоваться для копирования параметров одного клипа в другие 
клипы на том же самом треке и с тем же самым именем. Давайте рассмотрим два примера: 
 
Пример 1: 
 
1. В этом примере мы импортировали сэмпл в проект и поместили его в новый трек: 
 

*  
 
2. Затем мы скопировали его нужное количество раз: 
 

 
 
3. Некоторое время спустя мы решили внести изменения в первый клип: отрегулировать громкость, некоторые 
эффекты и фейдинг. 
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4. Наконец, мы щелкнули правой кнопкой мыши по этому первому клипу и выбрали опцию Item processing > 
Propagate item to similarly named items on track, чтобы скопировать сделанные нами изменения в другие 
клипы. При этом любые экземпляры этого клипа на других треках затронуты не будут. 
 

 
 
Пример 2: 
 
1. В следующем примере исходный клип был скопирован на два трека. Заметьте, что у каждого трека свои 
индивидуально настроенный параметры: различные настройки панорамы и эффекты. У исходного клипа также 
свои собственные эффекты, огибающая громкости и настройка высоты тона. 
 

 
 
2. Команда Item processing > Propagate item to similarly named items использовалась для копирования 
функций исходного клипа ко всем клипам в проекте со схожим именем. 
 

 
 

Совет: вы можете присвоить одно имя нескольким клипам одним действием. Выделите все клипы, 
нажмите F2, чтобы открыть диалоговое окно Item Properties, введите имя в области take name и 
нажмите OK. 

 
7.29. Объединение клипов в один трек 

 
Если несколько клипов, которые были одним целым разделены и помещены на несколько треков (как показано 
на рисунке ниже), их можно выделить, щелкнуть правой кнопкой по любому из выделенных треков и выбрать 
опцию Item processing > Implode items across tracks into items on one track (собрать клипы с разных треков 
на один трек).  
 

 
 
После этого все они будут объеденены (собраны вместе) на одном треке. 
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7.30. Вставка тишины 
 
Команда Insert > Empty space in selection может использоваться для вставки тишины (пустого места).  
Перед использованием этой команды выделите область. Команда применяется ко всем трекам (как показано на 
рисунке ниже). Текущий материал смещается вправо. Впоследствии на этом пустом месте можно создать клипы 
на любых треках. 
 

 
 

7.31. Режим редактирования Ripple Editing 
 
Обычно, когда вы удаляете часть клипа, на месте этого удаленного фрагмента остается пустое место. В режиме 
Ripple Editing материал будет соединен, заполняя этот промежуток. Это иллюстрировано на трех рисунках 
ниже.  

 
На первом рисунке (слева) клип с выделенной 
областью.  
 
 
Если режим Ripple Editing отключен, при удалении 
выделенной области эффект будет как на рисунке 
слева.  
 
С активированным режимом Ripple Editing, 
удаление выделенной области будет иметь эффект 
как на рисунке слева.  
 

Чтобы получить доступ к режиму Ripple Editing, выберите команду Options > Ripple editing, или используйте 

горячую клавишу Alt+P или активируйте кнопку  на главной панели инструментов. Контекстное меню кнопки 
Ripple Editing включает опции:  
 

 
 
Ripple edit per-track (применить редактирование к выбранному треку) 
Ripple edit all tracks (применить редактирование ко всем трекам) 
Ripple edit all affects tempo map (все режимы редактирования затрагивают темпокарту)  
Add edge points when ripple editing or inserting time (добавить граничные точки при редактировании или при 
вставке временного интервала).  
 
В режиме Ripple edit all tracks маркеры и автоматизация клипов привязываются, поэтому при перемещении 
клипов будут перемещаться и маркеры и автоматизация. Использование этого режима на нескольких треках 
очень полезно для редактирования мультитрековой записи живого материала - все остается в синхронизации 
при редактировании. Например, если вы разделили клип в нескольких местах (получив таким образом три 
клипа), а затем удаляете среднюю часть, остальные части будут объединены, но в отличие от типичного 
стереоредактора, это объединение можно отрегулировать, перетащив граничные точки клипов соответственно. 
Если вы хотите переместить материал с одного места в другое, его можно разделить в точке вставки, 
перетащить материал вправо от вставки, а затем сделать вставку и перетащить перемещенный материал. Все 
клипы направо от перетаскиваемого клипа останутся вместе, а маркеры и автоматизация переместятся 
корректно.  
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На рисунке показан пример в режиме Ripple 
Editing All Tracks. На первом рисунке перед 
полезным материалом выбрана тишина. Затем 
была применена команда Cut selected area of 
items. Выделенная область вырезана на всех 
треках, а оставшийся материал перемещен в 
начало проекта. 
 
 
 
 
 
 
 
 

 
Примечание: осложнения могут возникнуть в случае, если блокированные клипы включены в 
выделенную область, которая должна быть отредактирована в режиме Ripple Editing. В частности, 
необходимо указать REAPER, будет ли редактирование применяться к блокированным клипам. 

Параметр Locked item ripple editing behavior на странице Options > Preferences > Editing Behavior включает 
опции определяющие это поведение - см. Главу 22. 
 

Совет: далее в этой главе мы рассмотрим использование клавиш-модификаторов с мышью для 
определения поведения REAPER при перетаскивании клипа или нескольких клипов, включая опции 
выбора и применения любых из трех режимов Ripple Editing при перетаскивании клипа(ов). 

 
7.32. Обрезка клипа по границам выделенной области 

 
Если вы хотите обрезать клип или трек по границам выделенной области: 
 
1. Выделите клип (ы). 
2. Выделите область трека, которую вы хотите оставить. 
3. Щелкните правой кнопкой по выбранным клипам и выберите опцию Trim items to selected area.  
 
Если режим Ripple Editing активирован, обрезанная область будет также удалена из шкалы времени, в 
противном случае останется пустое место.  
Если параметры Snap/Grid будут установлены в опцию Media Items, то при условии, что привязка 
активирована, привязка будет применяться при выделении области, которая будет обрезана. 
 

7.33. Свободное расположение клипов 
 
Выбор опции Free Item Positioning (свободное расположение клипов) позволяет беспрепятственно перемещать 
клипы в пределах трека или треков. Это может быть полезно например в том случае, если вы хотите, чтобы два 
или более клипов воспроизводились одновременно или наложились на том же самом треке. Чтобы 
активировать эту функцию: 
 
1. Выберите трек (и), для которых вы хотите активировать свободное расположение. 
2. Щелкните правой кнопкой по панели трека и выберите опцию Enable track free item positioning из 
контекстного меню. 
 
Рисунки ниже демонстрируют пример того, как эта функция может использоваться.  

 
На первом рисунке ведущий вокал (Vox Lead) и 
бэк вокал (Vox Hmy) расположены на разных 
треках. Мы могли бы счесть удобным поместить 
их вместе на один трек.  
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На втором рисунке мы активировали свободное 
расположение клипов для трека Vox Main. 
Обратите внимание на маленький хэндл (под 
курсором мыши), который может 
использоваться для регулирования высоты этих 
клипов.  
 
 
 
 
На третьем рисунке клип трека Vox Hmy был 
перемещен на трек Vox Lead. Теперь, когда 
этот трек будет воспроизводиться, оба клипа 
будут воспроизводиться вместе. Каждый клип 
независим от другого. Оба клипа можно 
мьютировать и размьютировать, добавить к ним 
эффекты, изменить высоту тона и/или скорость 
воспроизведения, и так далее. Для этого можно 
использовать окно Media Item Properties (F2) 
и/или контекстное меню клипа. 

 
Совет: при перемещении клипов в режиме свободного расположения клипов, они могут наложиться друг 
на друга: это может затруднить редактирование. Если это имеет место, выберите клипы, щелкните 
правой кнопкой мыши и выберите опцию Item processing > Auto-reposition items in free item 

positioning mode. 
 

7.34. Страница Mouse Modifiers 
 
Вы уже сталкивались со многими примерами того, как REAPER использует мышь с модификаторами и без для 
выполнения целого ряда задач. До сих пор задачи включали создание области лупа и выделение области, 
копирование и перемещение клипов, slip-редактирование, использование режима карандаша и так далее. 
Параметры по умолчанию для модификаторов мыши можно найти на странице Options > Preferences > Editing 
Behavior > Mouse Modifier.  
 
1. Из меню Context выберите нужный клип.  
2. После этого откроется список всех соответствующих действий мыши по умолчанию, относящихся к этому 
клипу меню.  
3. Затем можно дважды щелкнуть по любому клипу в столбце Modifier, чтобы назначить действие на этот 
модификатор.  
 
Показанный здесь пример действий по умолчанию, связан с различными модификаторами мыши для 
перетаскивания (left drag) клипа (Media item). Например, по умолчанию, перетаскивание клипа переместит его, 
игнорируя любую выделенную область (Move item ignoring time selection).  
Если при этом удерживать клавишу Ctrl, клип будет копирован (Copy item). Еще например - вы можете 
определить горячую клавишу Shift+Win в качестве модификатора, чтобы ограничить перемещение клипа только 
перемещением по вертикали, при его перетаскивании или копировании. Горячую клавишу Ctrl+Win можно 
назначить для регулирования громкости клипа и так далее. Чтобы назначить модификатор, необходимо дважды 
щелкнуть по нему в списке, затем выбрать команду и предлагаемое действие. 
 
7.34.1. Модификаторы действий контекстов Media item (left click, left drag and double-click), 
Media item bottom half (left click, left drag and double-click), Media item (left drag and double-
click), Media item fade/crossfade (left click, left drag and double-click)  
 
Большинство элементов меню Context включает связанную с ними опцию: если опция доступна, она 
отображается ниже таблицы, чуть выше кнопки OK. В данном примере, доступна опция, определяющая 
рассматривать или нет область меток выше клипа в качестве пустого пространства трека. Обратите внимание 
также на кнопку Import/export. Она может использоваться для сохранения и загрузки действий модификаторов 
или для текущего выбранного элемента меню Context или для всех элементов меню. 
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. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7.34.2. Модификаторы действий контекста Media Item Left Click 
 

На рисунке слева вы видите 
действия по умолчанию, когда вы 
щелкаете левой кнопкой мыши по 
клипам. Обратите внимание, что 
поведение по умолчанию для 
простого щелчка - Select item and 
move edit cursor (выбор клипа и 
перемещение курсора 
редактирования). С другой 
стороны, модификатор Alt+Click 
выберет клип, игнорируя 
группировку. При необходимости 
можно поменять местами эти 
назначения так, чтобы простой 
щелчок выбирал клип, не 
перемещая курсор 
редактирования. Для этого просто 
дважды щелкните в списке по 
действию, которое вы хотите 
изменить, затем выберите 
модификатор из списка справа. 
Подробнее о модификаторах 
мыши в Главе 15.  
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7.34.3. Модификаторы действий контекста Media Item Edge Left Drag 
 
На рисунке слева вы видите 
настройки модификатора мыши 
по умолчанию, которые 
используются при 
перетаскивании границы любых 
клипов. Глава 15 включает 
пошаговый пример, 
показывающий, как можно 
изменить эти модификаторы. 
 
 
 
 
 
 
 

 
Обратите внимание, что можно назначить 
различные модификаторы, которые будут 
использоваться при щелчке по нижней части 
клипа и модификаторы, которые будут 
использоваться при щелчке по верхней его 
части. В данном примере, действие по 
умолчанию для простого щелчка по нижней 
половине клипа изменено на Toggle item 
selection (переключение выбора клипа). 
 
 
 
 
 
 
 
 
 
 
 

 
7.35. Динамическое разделение - удаление фрагментов тишины 

 
Динамическое разделение в REAPER - мощная функция, которая может использоваться для любых целей. Она 
может пригодиться, например, при работе с темпом. Одно из применений этой функции заключается в очистке 
трека и удалении тех фрагментов, которые вы определяете в качестве тишины. Это может быть удобно, 
например, при работе с вокальным треком, где необходимо автоматически подчистить фрагменты между 
запевами, которые могут содержать нежелательные фоновые шумы, такие как дыхание, шуршание и т.д. 
Предположим, что вы записали такой вокальный трек. С функцией динамического разделения можно 
эффективно указать REAPER просканировать трек и удалить все фрагменты, где вокалист не поет. Для этого 
сначала выберите клипа, затем щелкните правой кнопкой мыши по нему и выберите команду Item processing > 
Dynamic split items. После этого необходимо установить правильные параметры. При редактировании 
параметров вы будете видеть все сделанные вами изменения. Каждая точка разделения обозначается цветной 
вертикальной линией, а области, отмеченные для удаления, будут затенены. Подробнее о функции 
динамического разделения мы поговорим в Главе 9 в контексте записи, основанной на темпе. Начните с 
настроек как на рисунке ниже и отталкивайтесь от них. 
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7.36.1. Сводный список параметров динамического разделения 
 
При использовании динамического разделения в качестве шумоподавителя необходимо указать REAPER, 
насколько часто и где разделить клипы и какие фрагменты должны быть удалены. 
 

At transients: не отмечайте эту опцию, когда 
функция динамического разделения используется в 
качестве шумоподавителя. 
When gate opens/When gate closes: обе эти опции 
должны быть активированы, чтобы REAPER мог 
решить где начало и где конец каждого фрагмента, 
который должен быть удален. 
Reduce split: в большинстве случаев при 
использовании функции динамического разделения 
в качестве шумоподавителя эту опцию отмечать нет 
необходимости. 
Min slice length: устанавливает наименьшую длину 
любого слайса. Вероятнее всего необходимо будет 
поэкспериментировать с этим параметром. Обычно, 
этот параметр устанавливается в низкие значения.  
К счастью, интерфейс динамического разделения 
REAPER обеспечивает непосредственную 
визуальную обратную связь. На экране вы будете 
наблюдать результат ваших действий. На рисунке 
ниже представлен эффект, когда значение 
параметра Min slice length слишком высокое. 
Заметьте, что это может привести к удалению 
полезного сигнала. 
 
 
 
 
 
 
 
 

 

 
 
Constrain slice length: в большинстве случаев в контексте данного применения функции этот параметр не 
имеет значения. Если сомневаетесь, попробуйте оба, и отследите изменения визуально. 
Gate threshold: это важный параметр, имеющий разумный диапазон приемлемых значений. Если значение 
слишком низкое, вы можете пропустить нежелательные звуки через шумоподавитель. Если значение слишком 
высоко, вы рискуете удалить записанный материал. Отправная точка для редактирования этого параметра -
50dB. 
Min silence length: еще один параметр, требующий точной настройки. Если значение установлено слишком 
высоко, шумоподавитель не распознает все периоды тишины 
Hysteresis: этот параметр может использоваться для настройки уровня, при котором гейт будет закрываться 
относительно значения, при котором гейт будет открываться. В примере, показанном выше, гейт закроется в 
значении -62.5 дБ и откроется в значении -50 дБ. 
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Action to perform: в контексте данного применения можно выбрать либо Split selected items или Split selected 
and grouped items. Другие опции Write stretch markers to selected items и to selected items and 
grouped items включают использование stretch маркеров, которые будут объяснены в Главе 10. 
Add transient guide markers to items: эта опция добавляет направляющие линии транзиентов (вертикальные 
прерывистые линии) к выбранному клипу (клипам) без разделения. 
Remove silence: эта опция должна быть активирована. 
Fade Pad: активирование этой опции сглаживает переходы. 
 
Остальные параметры оставьте как на рисунке. 
 

7.36. Действие Item: Auto trim/split items 
 
Список действий REAPER содержит буквально сотни опций и действий, многие из которых не отображаются ни 
в одном из меню. Подробнее о действиях в Главе 15. В данном контексте стоит обратить внимание на два 
действия: Item: Auto trim/split items (remove silence), и Transient detection sensitivity/threshold (adjust).  
Эти два действия могут работать сообща. Действия запускаются в следующем порядке: сначала вы переходите 
Actions > Show actions list в главном меню, затем выбераете нужное действие (щелчком по нему) и нажимаете 
кнопку Run. Два момента, на которые необходимо обратить внимание: меню Actions включает опцию Show 
recent actions on menu (показать последние выбранные действия в меню), и в рамках списка действий можно 
использовать область Filter для облегчения поиска нужного действие. Действие Auto Trim/Split Items схоже с 
динамическим разделением для удаления тишины, за исключением того, что это действие включает некоторые 
дополнительные опции. Выбор клипа и запуск этого действия открывают диалоговое окно, показанное на 
рисунке ниже.  
 

 
 
Параметры Threshold и Hysteresis управляют шумоподавлением и определяют порог, ниже которого будут 
удалены фрагменты и степень чувствительности - то же самое что и с динамическим разделением. Точно так же 
контроллеры Ignore silence, Make non-silent clips no shorter than, контроллеры Pad и Auto adjust snap 
идентичны таковым при динамическом разделении. Главный элемент интереса - меню Mode, включающее 
четыре опции - Split and remove silent areas, Split and keep silent areas, Split only before non-silence и Split 
only before silence. При работе с несколькими сгруппированными клипами доступна опция Split grouped items 
at times of selected item splits.  
Отметив опцию Run signal through track FX for detection можно установить гейт, который будет применен 
после эффектов. Если вы запустите действие Transient detection sensitivity/threshold, появится пара 
полупрозрачных горизонтальных линий, обеспечивая визуальную обратную связь ваших настроек гейта (как 
показано нак рисунке ниже).  
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Другая полезная опция при разделении - Use zero crossings, которая может предотвратить щелчки при 
воспроизведении. 
 

7.37. Спектральный дисплей (Spectral Peak Display) 
 
По умолчанию аудиоклип в области аранжировки отображаются только в виде сигналограмм. Вы можете 
изменить их вид на спектральное отображение, где клип окрашен, отображая информацию о его звуковых 
частотах, и в особенности на наиболее доминирующую частоту которая изменяется на протяжении времени. 
Пример этого показан на рисунке ниже.  
 

 
 
Перед рассмотрением деталей использования этого представления, стоит потратить время на рассмотрение 
предназначения и основ его использования. Во-первых, это диагностический инструмент, разработанный в 
помощь при идентификации и решения проблем в вашем миксе. Это не стопроцентное решение проблем, и он 
не предназначен для мгновенного решения всех ваших проблем. И при этом он также не предназначен для того, 
чтобы ваши глаза заменили ваши уши! Рассматривая сигналограммы в качестве палитры цветов, можно с 
большей увереностью идентифицировать критические частоты, особенно там, где ваши уши слышат проблему. 
Простой пример показан на рисунке выше. Здесь два трека гитары (треки 6 и 7), которые на самом деле 
являются записью одной гитары с двух микрофонов. Вы можете визуально идентифицировать различия в 
частотах между этими двумя треками. Пики спектра могут быть полезными и в распознавании содержимого. 
Например, низкие и высокие регистры кларнета будут отображаться разными цветами. Флейта опять же будет 
отличаться по цвету. Подробнее об этом здесь: 
www.mat.ucsb.edu/~b.sturm/MAT201A/presentations/Fri/OhnandPark.pdf.  
 
Некоторые другие возможные применения: 
 
- Идентификация и точное определение нежелательных шумов или частотных скачков, которые можно 
услышать на протяжении трека. 
- Точная идентификация конкретного события на протяжении трека, такого как звук перкуссионного инструмента. 
- Точная идентификация местоположения ноты, где это не очвидно (например, когда была записана дисторшн 
гитара). 
- Выявление частоты, при которой достигается пиковый уровень трека: и не находится ли это в противоречии с 
другими треками? 
- Помощь в точной идентификации частот, которые, возможно, должны быть эквализованы. 

http://www.mat.ucsb.edu/%7Eb.sturm/MAT201A/presentations/Fri/OhnandPark.pdf
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- Выявление (например), нот баса, которые по отдельности более тихи или громче, чем нужно. 
- Идентификация нежелательных звуков (например, на вокалах), таких как дыхание или высокочастотный 
резонанс. 
- Помощь в идентификации и изолировании низкочастотного гула или, там, где он присутствует (например, на 
электрическом басе). 
 
- Используйте команду View > Peaks Display Settings, чтобы открыть окно, как на рисунке ниже. 
- Используйте опцию Show spectral peaks для активирования/отключения спектрального дисплея и прочь. Если 
эта опция уже отмечена, когда Вы открываете файл, вам, возможно, продется отключить ее и включить снова. 
- Слайдер Display gain используется для увеличения или уменьшения высоты пиков, не затрагивая громкость. 
- Фейдер Opacity используется для увеличения или уменьшения степени визуального цветного контраста, 
отображающего в клипе трека спектральные пики. 
- Щелчок правой кнопкой мыши по цветному дисплею обеспечивает доступ к контекстному меню. Опция Fade 
non tonal content to theme peaks color по умолчанию отмечена. 
- Все параметры в этом окне можно сбросить, выбрав опцию Reset to defaults из контекстного меню. Помните, 
что активирование спектрального дисплея примерно удваивает размер peak файла и создание этих пиков 
требует значительного объема оперативной памяти. Использование оперативной памяти может удвоиться, если 
спектральные пики отображаются во время записи. 
  
7.37.1. Контроллеры спектрального дисплея 
 
Чтобы использовать этот инструмент эффективно, необходимо понять и усвоить различные его контроллеры. 
Например, если Вы соредоточились на низкочастотном гуле, Вы, вероятно, захотите, чтобы дисплей 
фокусировался на низкочастотном спектре. Имея дело с высокочастотным резонансом, Вы захотите 
сконцентрироваться на высоких частотах. Ниже представлена сводка доступных контроллеров, большинство из 
которых редактируются щелчком на них и перетаскиванием мыши. Понимание их функционала сначала может 
показаться затруднительным, на всегда есть опция Reset to defaults! Помните, что клип состоит из всего 
диапазона частот (это можно увидеть, например, поместив, скажем, плагин ReaEq в цепочку эффектов трека). 
Пики спектра используются для идентификации только наиболее доминирующей частоты в любой временной 
точке. 
Frequency Range (20hz-10khz): дисплей разделен на семь частотных полос. Чтобы настроить разделение 
частотного диапазона между этими полосами, перетащите мышь влево или вправо на границе между любыми 
двумя полосами. Перемещение вправо помогает сосредоточиться на высоких частотах, влево на низких 
частотах. Чтобы настроить все цвета, используемые на дисплее, щелкните выше цветного дисплея и 
перетащите мышь влево или вправо. Чтобы настроить только нижние цвета, щелкните на левом крае дисплея и 
перетащите мышь вверх /вниз. Чтобы отрегулировать только верхние цвета, щелкните на правом крае дисплея 
и перетащите мышь вверх /вниз. По умолчанию палитра распределена по всему частотному диапазону. Вы 
можете изменить это, например, для использования всей цветовой гаммы для каждой отдельной октавы: это 
может быть полезно в том случае, если необходимо сосредоточиться на куда меньших частотных изменениях. 
Это и другие соответствующие опции доступны в контекстном меню (рисунок ниже).  
 

 
 
Здесь же доступна опция Reverse spectrum (реверсировать спектр). 
 
Variance и Noise Threshold: чтобы отрегулировать эти параметры перетащите их вверх или вниз. Шумовой 
порог определяет степень чувствительности, которая будет применена при внесении цветовых изменений на 
различных частотах. 
Presets: команды Save spectral view и Load spectral view позволяют сохранить и загрузить до десяти 
конфигураций в качестве пресетов. Первые пять из них могут быть загружены, используя действия и поэтому 
могут быть добавлены к пользовательским панелям инструментов и/или меню, и/или их можно назначить на 
горячие клавиши. 
Preferences: много опций, затрагивающих поведение спектральных пиков, находятся на странице Preferences > 
Media, включая опцию Always generate spectral peak information. Примите во внимание: активирование этой 
опции может значительно увеличить объем используемой оперативной памяти. 
Опция Per Track: пики спектра можно активировать/отключить на основе трека через опцию Track performance 
в контекстном меню трека. 
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7.38. Спектральное представление 
 

Спектральное представление - это визуальное представление 
всех звуковых частот клипа изменяющихся во времени, т.е. на 
всем протяжении этого клипа. Наиболее заметное различие 
между спектральным представлением и пиковым спектральным 

представлением заключается в том, что последнее отражает только доминирующую частоту, которая 
варьируется во ремени. Спектральное представление можно активировать глобально, либо выбрав команду 
Show spectogram из меню Options > Peaks display mode, либо выбрав Spectogram в окне Peaks Display 
Settings. Однако использование глобальной опции может увеличить нагрузку на ресурсы компьютера. 
Возможно вам понадобится переключиться в режим отображения пиков Show normal peaks. Команду Item 
settings > Show spectogram из контекстного меню любых клипов можно использовать для отображения этих 
клипов в спектральном представлении. 
 
Примечания: 
 
1. Спектральный дисплей отражает тональные изменения в диалоговом окне Item Properties или в тональной 
огибающей копии, но не в VST плагине, таком как ReaPitch. 
2. В работе со спектральными пиками или спектрограммами может возникнуть необходимость восстановить 
пики. Для этого доступны следующие действия: 
Peaks: Build any missing peaks Peaks: Rebuild all peaks 
Peaks: Rebuild peaks for selected items Peaks: Remove all peak cache files 
Peaks: Decrease peaks gain (изменение вниз) Peaks: Increase peaks gain (изменение) 
Peaks: Toggle spectral peaks Peaks: Toggle normal peaks 
Peaks: Toggle spectogram Peaks: Toggle spectogram and peaks. 
Track: Prevent spectral peaks/spectogram Spectogram: Toggle show spectogram for selected items 
 
Любое из этих действий можно назначить на горячие клавиши или на панели инструментов - подробности в 
Главе 15. 
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8. Работа с копиями клипов 
 
В Главе 3 мы узнали, как создавать копии. В частности, убедитесь, что вы ознакомились с параграфами 
"Отображение копий на дорожках трека", "Использование цветной маркировки копий" и "Работа с несколькими 
копиями". Способы аранжировки и редактирования, рассмотренные в Главе 7, могут быть применены и к 
редактированию проекта с несколькими копиями. В частности, вы можете: 
 
- распределить копии на новые треки (функция Explode). Затем можно отредактировать каждый трек по 
отдельности и (если захотите) объединить копии назад в один трек, или 
- продолжить редактирование различных копий в пределах одного трека, на котором они были записаны. Позже 
мы подробнее рассмотрим данный метод в этой главе. 
 
Обратите внимание на то, что, если это не будет оговорено отдельно, инструкции в этой главе предполагают, 
что опция свободного расположения клипов для треков отключена. Подробнее о свободном расположении 
клипов в Главе 3. 
 

8.1. Применение эффектов клипа к отдельным копиям 
 
В Главе 7 мы рассмотрели добавление эффектов к отдельным клипам. Если на треке присутствует несколько 
копий, к каждой копии можно добавить ее собственные эффекты и цепочку эффектов.  
 

Например, можно вставить отдельные плагины эффектов на отдельные 
копии, как показано на рисунке слева.  
 
 
 
 
 
 

Выберите копию, а затем нажмите Shift+E, чтобы открыть окно добавления эффектов копии. Если отмечены 
опции Display media item take name (отображать имя копии клипа) и Draw labels above the item 
(отображать информацию выше клипа) на странице Options > Preferences > Appearance > Media, любая 
цепочка эффектов текущей выбранной копии будет включена во всплывающую подсказку при наведении на 
копию курсора мыши. На рисунке выше, активна Копия #2 и отображены названия добавленных к ней 
эффектов. При необходимости можно вставить те же самые эффекты в каждую копию и определить различные 
параметры для каждого из эффектов. 
 

8.2. Распределение копий на несколько треков (функция Explode) 
 
Предположим, что мы записали три копии вокального трека. Мы можем щелкнуть правой кнопкой по клипу и 
перейти Take > Explode all takes to new tracks (распределить копии на отдельные треки).  
 

 
 
При этом создается (в данном случае) три дополнительных трека (пока без имени) - но исходный трек с его 
тремя копиями останется. Теперь предположим, что после прослушивания мы выбрали фрагменты каждой 
копии, которые мы хотим использовать. На следующем рисунке мы отредактировали различные копии и 
оставили только фрагмент каждой копии. Это было сделано с использованием различных способов 
редактирования, рассмотренных в Главе 7.  
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Наконец, мы выделили различные клипы треков #3 и #4 и нажали клавишу «8» на цифровой клавиатуре, чтобы 
скомпоновать выбранные клипы на треке #2. После этого трек #1 мьютируется и его можно скрыть, а треки #3 и 
#4 можно удалить.  
 

 
 
Теперь Вы можете выделить все клипы на треке #2 и использовать команду Glue Items для их объединения в 
один клип. Обратите внимание на то, что исходный мьютированный трек с тремя его копиями все еще доступен.  
 

8.3. Кроссфейдинг копий 
 
Если вы хотите скрестить (наложить) клипы, необходимо сначала решить, нужен ли в таком случае 

автоматический кроссфейдинг, который активируется/отключается кнопкой  на панели инструментов 
(Alt+X).  

 
Если автоматический кроссфейдинг активирован вы можете отредактировать 
кривые кроссфейдинга. Кроссфейдинг можно расширить в любом 
направлении, перетащив вертикальные линии его границ. Если при этом 
удерживать клавишу Shift, можно переместить саму область кроссфейдинга 

влево или вправо.  
 
Щелчок правой кнопкой мыши по кроссфейдингу отобразит меню выбора различных 
форм кроссфейдинга.  
 
 
 
 
 
 
 
 
 
 
 

Для редактирования кроссфейдинга доступны различные опции поведения мыши с клавишами-
модификаторами на странице Options > Preferences > Editing Behavior > Mouse Modifiers (см. также Главу 
15). Для более продвинутого редактирования кроссфейдинга можно использовать редактор кроссфейдинга (см. 
Главу 7). 
 

8.4. Распределение копий на одну дорожку трека. Функция Explode. 
 
Команда Take > Explode all takes (in place) размещает все копии трека на одну дорожку этого трека. 
Рассмотрим пример применения этой опции. На рисунке ниже трек включает три копии ведущего вокала. Вы 
выбрали лучшие фрагменты каждой копии и определили в каждой копии их индивидуальные свойства 
(например, громкость). 
 

 
 
Команда Take > Explode all takes (in place) помещает выбранные клипы поверх других копий на одной дорожке 
трека, а все копии будут воспроизводиться вместе. 
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8.5. Опция Play All Takes 
 

 
 
Давайте рассмотрим действительно интересный трюк, который можно проделать с копиями. На рисунке выше 
показан вокальный трек с коротким фрагментом наложенного бэк-вокала. Обе копии в этой точке 
панорамированы по-разному и имеют разные огибающие громкости, а к цепочке эффектов второй копии 
добавлен дилей и возможно плагин изменения высоты тона. Выделите эти клипы, щелкните правой кнопкой 
мыши по любому из них и перейдите Item settings > Play all takes. Таким образом мы можем прослушать 
одновременно и основной вокал, и бэк-вокал на одном треке! Эта опция также доступна в окне Item Properties. 
 

8.6. Редактирование и компиляция нескольких копий 
 
Чтобы управлять несколькими копиями необязательно их раскладывать на отдельные треки. В этом параграфе 
мы рассмотрим некоторые способы управления копиями в пределах одного трека. По сути это сводится к 
выделению лучших фрагментов каждой копии и компиляции этих фрагментов в одну копию. 
 
8.6.1. Прием Slice and Dice 
 
При выборе опции Show all takes in lanes (when room) (показать все копии на дорожках (если хватает 
места) в меню Options применяется прием, известный как Slice and Dice, который помогает вам 
комбинировать лучшие фрагменты каждой копии для воспроизведения их на одном треке. Для этого просто 
разделите трек в нужных местах нужное количество раз (разделите трек на слайсы), а затем выделите в каждом 
слайсе нужный фрагмент. Различные способы разделения объяснены в Главе 7. Не лишним будет окрасить все 
выделенные фрагменты определенным цветом. Для этого сначала выделите фрагменты, а затем в контекстном 
меню одного их них перейдите Item and take colors > Set active take to custom color или Set active take to one 
random color. Эти команды также доступны из контекстного меню клипа. Пример того, как эта функция может 
использоваться, показан ниже.  
 

 
 
Обратите внимание, что вторая из этих копий состоит из наложения только небольшого фрагмента песни. 
Опция Options > Take lane behavior > Display empty take lanes (отображать пустые дорожки копий) может 
помочь в идентификации копий. Пустой фрагмент копии (который мы видим в копии #2 на рисунке) не может 
быть выделен, если не активирована опция Options > Take lane behavior > Allow selecting empty take lanes. 

 
Примечание: альтернативно, чтобы не отображались пустые дорожки копий, их можно скрыть, отключив 
опцию Display empty take lanes (Options > Take lane behavior). 
 

 
8.6.2. Выборки (Comp sets) 
 

 
 
Выделенные фрагменты можно сохранить в выборки (Comp sets). Эта функция доступна как для отдельных 
треков (рисунок выше), так и для групп треков (рисунок ниже).  
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Последний пример - проект с двумя вокальными треками, каждый из которых нарезан на слайсы и окрашен в 
произвольный цвет. Выделив нужные клипы (используя выделяющую рамку), можно сохранить их в отдельную 
выборку, щелкнув правой кнопкой мыши по выбранным клипам и выбрав команду Comps > Save as new comp. 
После чего необходимо дать выборке имя. Теперь эта выборка будет добавлена в меню Comps и ее можно 
будет загрузить из этого меню в любое время. Одно из преимуществ этой функции заключается в том, что она 
облегчает сравнение различных комбинаций слайсов различных копий, чем и достигается наилучший результат. 
Количество сохраняемых выборок неограниченно. Чтобы загрузить выборку, выделите клипы (все копии) 
соответствующих треков в области аранжировки, а затем щелкните правой кнопкой мыши по выделенным 
клипам и перейдите Comps > Comp name. Ниже приведен список других команд подменю Comps: 
 
Save as new comp (сохранить как новую выборку с возможностью переименования). 
Rename active comp (переименовать текущую выборку). 
Remove active comp (удалить текущую выборку и удалить ее из меню Comps). При этом копии и клипы из 
самого проекта не удаляются. 
Crop list to active comp (удалить все выборки из меню Comps, кроме активной). 
Move active comp to top lane (переместить все выделенные копии на верхнюю дорожку их трека). Это 
действие относится как к группировке клипов, так и к функции отмены 
 

Выборки перечисляются в конце меню Comps (см. рисунок налево). Щелчок 
на имени выберет соответствующую выборку. 
 
 
 
 
 
 

 
В данном примере мы 
создали вторую выборку и 
окрасили ее в зеленый цвет. 
Теперь мы можем 
переключаться между 
выборками.  
 
 
В этом примере с 
выделенной выборкой, мы 
использовали команду Move 
active comp to top lane. Не 
забывайте также, что при 
использовании горячей 
клавиши Ctrl+L вы можете 

отобразить/скрыть дорожки, как показано на рисунке ниже. 
 
 
 
 
 
 
 

 
Совет: когда вы используете дорожки и делаете нарезку на слайсы, можно использовать клавиши 
цифровой клавиатуры 1 и 3 чтобы сместить клипы влево или вправо, если их позиция не 
синхронизирована с другими копиями. Точная степень смещения выбранных клипов при использовании 

этих клавиш будет зависеть от выбранного масштаба. 
 
 
 
Как правило, на более ранних стадиях работы, наиболее вероятно, что вы захотите создать и сохранить 
выборки для отдельных треков, а не для групп треков. Это обеспечит большую гибкость в “микшировании и 
подгонке” ваших треков. Примите во внимание также, что выборки сохраняются при разделении клипов. Однако 
по мере продвижения микса к завершению, можно найти, что более выгодно сохранить выборки для группы 
треков так, чтобы их можно было загрузить и использовать вместе. 
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8.6.3. Опции подменю Take Lane Behavior 
 
Наконец, напомним о четырех переключаемых опциях поведения копии в меню Options, подменю Take Lane 
Behavior: 
 

 
 
Show all take in lanes (when room) (показать все копии на дорожках)  
Display empty take lanes (показать пустые дорожки копий)  
Allow selecting empty take lanes (разрешить выбор пустых дорожек копий) 
Select takes for all selected items when clicking take lanes (выбрать копии всех выбранных клипов при щелчке 
на дорожках копий). Отключение этой опции позволяет работать с копиями на отдельных треках в рамках 
выбранных треков, не теряя выбор треков. 
 
Список ниже суммирует другие доступные команды меню Take: 
 
Next take (T): делает следующую копию активной для всех выбранных клипов. 
Previous take (Shift+T): делает предыдущую копию активной для всех выбранных клипов. 
Delete active take (X): удаляет текущую выбранную копию во всех текущих выбранных клипов. 
Crop to active take (Alt+Shift+T): удаляет все неактивные копии из текущих выбранных клипов. 
Duplicate active take: добавляет дубликат активной копии к клипу в качестве новой копии. 
Lock to active take: это переключаемая команда. Она блокирует текущие активные выбранные копии. Когда к 
клипу применяется блокирование копий, его активная копия не может быть изменена, пока блокировка не будет 
снята. 
Show FX chain for active take: открывает браузер эффектов, позволяя добавить эффекты к активной копии для 
выбранных клипов. 
Remove FX for active take: удаляет эффекты, ранее добавленные к цепочке эффектов копии. 
 

Take envelopes: открывает окно, где можно добавить огибающие 
громкости, панорамы, мьютирования и/или изменения высоты тона, 
и/или параметры эффекта любой копии. Огибающие автоматизации 
объясняются в Главе 18. 
 

 
Explode all takes to new tracks (поместить каждую копию на новый трек). 
Explode all takes in place (расместить выбранные копии на том же самом треке друг на друга так, чтобы они 
проигрывались вместе). 
Explode all takes (in order) (расместить выбранные копии на том же самом треке последовательно одну за 
другой). Пример применения этой команды: 
 

 
 
Implode items across tracks into takes: копирует все выбранные клипы в один трек серией копий. Пример 
применения этой команды: 
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Implode items on same track into takes: перемещает все выбранные клипы в ту же начальную позицию, что и 
серия копий того же самого трека. Пример применения этой команды: 
 

 
 
Paste to takes in items: вставляет ранее выбранные/вырезанные/скопированные копии в выбранные треки в 
качестве нового клипа. 
 

8.7. Суммарный список команд меню Take 
 
Список ниже суммирует другие команды меню Take: 
 
Next take (T): Делает следующую копию активной для всех выбранных клипов. 
Previous take (Shift+T): Делает предыдущую копию активной для всех выбранных клипов. 
Delete active take (X): Удаляет текущую выбранную копию во всех текущих выбранных клипах. 
Crop to active take (Alt+Shift+T): Удаляет все неактивные копии из текущих выбранных клипов. 
Duplicate active take: Добавляет копию активной копии к клипу в качестве новой копии. 
Lock to active take: Это переключаемая команда. Она блокирует текущую выбранную активную копию. Если 
блокировка копии была применена к клипу, его активная копия не может быть изменена, пока не поступит 
команда разблокировки. 
Show FX chain for active take: Открывает браузер эффектов, позволяя добавлять эффект к активной копии в 
выбранном клипе. 
Remove FX for active take: Удаляет ранее добавленный эффект в цепочке эффектов копии. 

 
Take envelopes:. Открывает окно, где вы можете добавить громкость, 
панораму, функцию мьютирования и/или настройку высоты тона, и/или 
любую огибающую автоматизации параметра эффекта. Автоматизация 
огибающих объяснена в Главе 18. 
 

Explode all takes to new tracks: Копирует каждую копию в новый трек. 
Explode all takes in place: Помещает выбранные копии на тот же самый трек друг на друга в целях 
одновременного их воспроизведения. 
Explode all takes (in order): Размещает выбранные копии на том же самом треке последовательно, одну за 
другой. Эта команда превращает это: 
 

  
 
в это: 
 

 
 
Implode items across tracks into takes: Копирует все выбранные клипы на один трек в виде серии копий. Эта 
команда превращает это: 
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… в это: 
 

 
 

8.8. Дополнительные команды и действия для копий 
 
Третья сверху секция контекстного меню клипа включает ряд команд создания новой копии из текущего клипа.  
 

 
 
Эти команды открывают для вас много интересных и творческих возможностей. Первые четыре из них 
обеспечивают применение эффектов трека к текущему клипу и в принципе довольно схожи - первые три 
создают новую аудиокопию, а четвертая создает новую MIDI копию. Список ниже суммирует эти команды: 
 
Apply track/take FX to items as new take: создает новую стереокопию выбранного клипа. Одно из применений 
этой команды призвано освободить ресурсы процессора. Рассмотрите пример трека с некоторыми эффектами в 
его цепочке, скажем, с эквалайзером и компрессором: 
 

 
 
Apply track/take FX to items as new take (mono output): создает новую монокопию выбранного клипа. 
Apply track/take FX to items as new take (multichannel output): создает новую копию выбранного клипа, с тем 
же самым количеством каналов, что и в окне маршрутизации трека. После применения эффектов трека 
появляется новая копия с примененными к ней эффектами. Исходную цепочку эффектов можно после этого 
установить в обход: 
 

 
 
Apply track/take FX to items as new take (MIDI output): создает новую MIDI копию выбранного MIDI клипа. Это 
уменьшает нагрузку на процессор и открывает новые творческие возможности - например, можно выбрать 
команду Play all takes, затем использовать огибающие громкости и панорамы для копий по всей песне. 
Render items as new take: эта команда - еще один экономайзер процессора. Она конвертирует текущий клип в 
новую копию. Любые MIDI клипы с эффектами будут сконвертированы в аудиофайл. 
Reverse items as new take: эта команда добавляет новую копию к клипу с полностью измененным материалом. 
Вот пример: начав с этого  
 

 
 
мы закончили этим: 
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Нижеперечисленные команды списка действий REAPER (см. Главу 15) можно использовать с пустыми 
дорожками копий: 
 
 
Item: Remove all empty take lanes (удалить все пустые дорожки копий) 
Item: Remove the empty take lane after the active take (удалить пустые дорожки копий после активной копии) 
Item: Remove the empty take lane before the active take (удалить пустые дорожки копий перед активной копией) 
 

Примечание: страница Options > Preferences > Appearance > Peaks/ Waveforms включает множество 
параметров раскраски различных элементов трека, клипов и копий.  
 

 

 
 
Примечание: эти опции могут быть проигнорированы некоторыми темами оформления, включая тему по 
умолчанию. Там, где эти опции доступны, их порядок очередности не очевиден. В примере, показанном 
здесь, мы активировали отображение цвета сигналограммы клипа как для трека, так и для копии. Видно, 

что одновременно это невозможно. В подобных случаях как этот для конкретных клипов, если копия не 
окрашена, будет использоваться цвет трека. Если, цвет был определен для копии, он будет иметь приоритет 
над цветом трека. 
 

8.9. Управление выборками в окне Project Bay 
 
Копиями и выбоками можно также управлять из окна Project Bay. Окно Project Bay - это универсальный центр, 
обеспечивающий удобное управление клипами проекта, эффектами, группами клипов, копиями и выборками. 
Подробнее об этом в Главе 12. Чтобы открыть окно Project Bay, перейдите View > Project Media/FX Bay. 
Щелкните по вкладке Take Comps, чтобы отобразить секцию управления копиями и выборками. Щелчок по 
кнопке Options отобразит меню, которое подробнее будет рассмотрено в Главе 12. На данный момент обратите 
внимание на опцию Mirror selection in Bay and project.  
 

 
 
В активированном состоянии она позволяет выбирать любые клипы или фрагменты щелчком по ним как в 
самом проекте, так и в окне Project Bay. В пределах этого окна (см. ниже) можно щелкнуть правой кнопкой 
мыши по любой выборке, чтобы отобразить ее контекстное меню. Доступные команды - Activate comp 
(активировать выборку), Rename comp (переименовать выбоку) и Delete comp (keep takes) (удалить 
выборку, сохранив копии). Можно также создать новую выборку из текущих выбранных копий, нажав кнопку 
Actions и выбрав опцию Create new comp из меню Actions.  
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Пример проекта с открытым окном Project Bay и выбранным окном Take Comps показан выше.  

 
Рисунок слева показывает, как в пределах выборок можно выбрать и 
управлять отдельными копиями и клипами. Например, можно 
активировать или деактивировать отдельные копии или удалить их из 
выборки в целом. 
 
 
 
 
 

 
8.10. Альтернативное копирование копий (функция Propagating) 

 
В Главе 7 мы рассматривали копирование свойств и характеристик клипов во все схожие клипы на том же 
самом треке или на всех треках. По тому же самому сценарию можно скопировать свойства копии, используя 
команды Item processing > Propagate take to similarly named active takes on track или Propagate take to 
similarly named active takes (all tracks). Рассмотрим пример.  
 

 
 
В данном примере мы имеем три копии клипа, которые также разделены на три фрагмента. Все три копии 
используют одно имя (Vox.mp3). Заметьте, что к первому фрагменту активной копии добавлены эффекты 
вместе с огибающей и фейдингом. При выборе опции Item processing > Propagate take to similarly named 
active takes on track из контекстного меню, мы гарантируем, что эти свойства будут скопированы в другие 
активные копии на этом треке:  
 

 
 
Обратите внимание, что, хотя и копируется сама огибающая, границы огибающей не копируются. 
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9. Лупы, маркеры и регионы 
 

9.1. Создание лупов 
 
Любой клип может быть зациклен. Более того, по умолчанию клип REAPER активирован для зацикливания. Эту 
функцию можно отключить для отдельных клипов в диалоговом окне Item Properties (опция Loop source), или 
глобально (для MIDI клипов и импортированных клипов) на странице Options > Preferences > Project > Media 
Item Defaults (опции Loop source). Границы лупа определяются продолжительностью файла источника. Если у 
клипа продолжительность 4 такта, он будет зацикливаться каждые 4 такта, если это будут 8 тактов, он будет 
зацикливаться каждые 8 тактов и т.д. Обратите внимание на то, что в следующих примерах, если вы в качестве 
представления времени (timebase) используете доли (beats), клип должен иметь точную продолжительность в 
долях, в противном случае клип будет зацикливаться не точно. При необходимости, отрегулируйте скорость 
воспроизведения (параметр Playback rate) в диалоговом окне Item Properties с сохранением высоты тона 
(отмеченный флажок Preserve pitch when changing rate). 
 
9.1.1. Зацикливание клипа целиком 

 
1. Наведите мышь на край клипа пока курсор не изменится на двухстороннюю стрелку 
 
 

 
2. Перетащите край, чтобы расширить клип. Каждая точка лупа 
обозначается меткой по краям клипа. 
3. При расширении клипа во всплывающей подсказке отображается его 
продолжительность, начальная и конечная временная позиция (граница). 

 
9.1.2. Обрезка и зацикливание 
 
Если вы хотите зациклить только фрагмент клипа, один из методов предполагает сначала обрезать клип, а 
затем его склеить. 

 
1. Убедитесь, что функция привязки (snapping) активирована.  
 
 

 
Наведите мышь на край клипа пока курсор не изменится на 
двухстороннюю стрелку. Захватите край и укоротите клип так, 
чтобы осталась только часть клипа, которую вы хотите 
использовать в качестве лупа. Отпустите кнопку мыши. 

 
2. Щелкните правой кнопкой по клипу и выберите опцию Glue items. 
 
 

 
3. Теперь захватите край клипа и расширьте его. Каждая 
точка лупа будет обозначена меткой по краям клипа. 
Расширьте луп по необходимости. 
 

 
9.1.3. Изменение скорости воспроизведения 
 
Иногда может возникнуть необходимость изменить скорость воспроизведения клипа, например, чтобы его 
синхронизировать. Беря за основу пример выше, сначала откройте окно Item Properties, и убедитесь, что опция 
Preserve pitch when changing rate отмечена. После этого можно изменить параметр Playback rate. Эффект 
будет примерно таким, как на рисунке ниже. Исходный клип (зацикленный) имел свою скорость 
воспроизведения (как на рисунке слева), а на рисунке справа она была изменена. 
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9.1.4. Создание области лупа из выделенной области 
 

1. Выберите исходный клип, затем выделите область, которая будет зациклена.  
 
 
 

Нажмите Ctrl+Alt+L или щелкните правой кнопкой и выберите опцию Copy loop of selected area of item. 
 

2. Выберите трек и позицию, в которую вы 
хотите вставить скопированный клип. 
3. Нажмите Ctrl+V, чтобы вставить 
скопированный клип, который будет 

зациклен. 
4. Захватите край клипа, как и прежде, чтобы создать луп. 
 

9.2. Создание маркеров и навигация марекров 
 
Маркеры можно сравнить с закладками. Они могут помочь вам при навигации, аранжировке и редактировании 
проектов. Маркеры могут быть вставлены в текущую позицию курсора редактирования, независимо от того, 
проигрывается проект или нет. 
 
Insert > Marker (M): вставляет пронумерованный маркер в текущую позицию. 
Insert > Marker (prompt for name) (Shift +M): вставляет пронумерованный маркер в текущую позицию и 
открывает диалоговое окно с запросом на переименование маркера.  
Опция Set color используется для раскраски маркера. 
Щелчок правой кнопкой по маркеру: отображает меню с опциями редактирования или удаления маркера. 
 
9.2.1. Горячие клавиши и кнопки мыши 
 
Следующие горячие клавиши и кнопки мыши используются по умолчанию для создания маркеров и навигации: 
 
Переход от маркера #1 до маркера #10: клавиши с 1 до 0 на основной клавиатуре, а не на цифровой. 
Перемещение маркеров #1 - 10 в позицию курсора или создание нового маркера, если нет маркера с этим 
номером: от Ctrl+1 до Ctrl+9 и Ctrl+0. 
Переход к следующему маркеру/в конец проекта, или к предыдущему маркеру/в начало проекта: клавиши ] или [ 
Переход к любому маркеру: Ctrl+J открывает диалоговое окно Jump To. Напечатайте в этом окне букву "m" и 
номер маркера - например, m2 чтобы перейти к маркеру #2. 
Переход к маркеру используя транспортную панель: щелкните правой кнопкой по транспортной панели и 
выберите опцию Jump to marker. 
Открыть диалоговое окно редактирования маркера (например, чтобы добавить или изменить имя маркера или 
его цвет): Shift +двойной щелчок на номере маркера. Введите новое имя или нажмите Set color. 
Выделить область лупа в области аранжировки или в представлении виртуальной клавиатуры в MIDI 
редакторе: двойной щелчок по линейке между двумя маркерами 
Выделение области между двумя маркерами: двойной щелчок по шкале времени между маркерами 
Перемещение маркера: захватите и перетащите маркер по шкале времени 
Удаление маркера: Alt+щелчок по маркеру 
 
Пример: 
 
Данный пример иллюстрирует использование маркеров. Прежде чем начать, в меню Options активируйте 
опцию Loop points linked to time selection. 
 
1. Откройте файл проекта All Through the Night.RPP и сохраните его под именем All Through the Night 
MARKERS.RPP 
2. Воспроизведите песню перед началом вокальной партии. Нажмите Shift+M. В окне запроса введите имя 
Verse 1 Start (начало запева #1) и нажмите Enter. 
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3. В конце первого запева опять нажмите Shift+M, введите имя Verse 1 End (конец запева #1) и нажмите Enter. 
4. Создайте схожие маркеры для начальной и конечной позиции запева #2 и запева #3. Они будут 
приблизительно в метках 1:00, 1:38, 1:46 и 2:35. Сохраните файл. 
5. Нажмите клавишу 1 на основной клавиатуре (а не на цифровой). Обратите внимание, что курсор 
редактирования перескочил к началу запева #1. 
6. Нажмите клавишу 2. Обратите внимание, что курсор редактирования перескочил в конец запева #2. 
7. Дважды щелкните по шкале времени (не на линейке маркеров) между маркерами 2 и 3. Обратите внимание, 
что теперь эта область зациклена и будет проигрываться циклично. 
8. Щелкните правой кнопкой по шкале времени и выберите опцию Zoom selection. Теперь вы можете тонко 
отредактировать любой клип в этой выделенной области. 
9. Нажмите Esc, чтобы снять выделенную область, а затем нажмите Ctrl+Page Down, чтобы восстановить 
масштаб в проект целиком. Сохраните файл. 
 

Примечание: не используйте в именах обычных маркеров обозначения =START или =END. Эти 
обозначения должны использоваться только при создании специальных маркеров, которые обозначают 
начальную и конечную точки проекта. Эта информация будет использоваться REAPER при рендеринге 

проекта целиком в аудиоклип (см. также Главу 21). 
 

9.3. Граничные маркеры выделенной области 
 
REAPER рассматривает начальную/конечную позиции любой выделенной области в качестве граничных 
маркеров. Горячие клавиши для опций Go to next marker (перейти к следующему маркеру) и Go to previous 
marker (перейти к предыдущему маркеру) - клавиши ] и [. Эти клавиши также используются для перехода 
указателя текущей позиции к начальной/конечной границам выделенной области. Альтернативно щелкните 
правой кнопкой мыши по кнопке Go to start и отметьте опцию Use transport home/end for markers. После этого 
кнопки Go to start и Go to end будут использоваться для перехода к следующему/предыдущему маркеру, а если 
выделена область, они будут использоваться для перехода к начальной/конечной точкам выделенной области. 
 

9.4. Привязка к маркерам 
 
Дополнительно, можно сделать так, что при выделении области, границы этой области будут автоматически 
привязываться к соседним маркерам по краям области (если таковые назначены). Посмотрите на рисунок ниже:  
 

 
 
Заметьте, что привязка активирована с дистанцией в 10 пикселей. С отключенной привязкой, выделить область 
точно между маркерами очень трудно. При попытке выделить область, это может закончится так, как на рисунке 
ниже: 
 

 
 

Если привязка активирована, результат будет как ни рисунке слева 
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Пример: 
 
На первом рисунке (ниже), проект включает два маркера, один в начале, а другой в конце проекта.  
 

 
 
Предположим, что вы хотите изменить позицию маркера #2 в начало второго запева. Поместите курсор 
редактирования в эту позицию и нажмите Ctrl+2.  
 

 
 
Теперь давайте предположим, что вы хотите создать маркер #4 в конце песни, резервируя маркер #3 для еще 
не указанной позиции. Поместите курсор редактирования в конце песни и нажмите Ctrl+4. 
 

 
 

9.5. Удаление маркеров 
 
Есть два основных способа удаления нежелательных маркеров. Чтобы удалить один маркер, поместите курсор 
мыши на флажок маркера и удерживая клавишу Alt, щелкните левой кнопкой мыши.  
 

Альтернативно, можно щелкнуть правой кнопкой по флажку маркера и 
выбрать опцию Remove Marker из контекстного меню.  
 
 
 

 
Чтобы удалить несколько маркеров, 
выделите область, включающую 
нужные для удаления маркеры. 
Щелкните правой кнопкой мыши по 
области чуть выше флажков 
маркеров в пределах выделенной 
области и выберите опцию Remove 
all markers from time selection из 
контекстного меню. 
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9.6. Действия, относящиеся к маркерам 
 
Большинство действий доступные в списке действий призваны помочь вам в управлении маркерами. Это такие 
действия как Markers: Delete marker near cursor (удалить маркер ближе к курсору) и Markers: Renumber all 
markers in timeline order (перенумеровать все маркеры на шкале времени по порядку). Подробнее об этом в 
Главе 15. 
 

9.7. Создание и использование регионов 
 
Регионы по сути используют продвинутую концепцию маркеров. Можно создать регионы в проектах, облегчив 
идентификацию, выбор и работу с различными фрагментами песни. 
 
Чтобы создать новый регион из текущей выделенной области: нажмите Shift +R или щелкните правой 
кнопкой мыши и выберите опцию Create Region from Selection 
Чтобы изменить имя или другие свойства региона: Shift +двойной щелчок по значку региона. 
Чтобы определить цвет для региона: Shift +двойной щелчок по значку региона и выберите опцию Set color. 
Чтобы сделать область региона текущей выделенной областью: дважды щелкните по значку региона или 
щелкните правой кнопкой по значку региона и выберите опцию Select Region 
Чтобы отрегулировать границы региона: захватите границу и перетащите в соответствующем направлении. 
Чтобы скопировать регион и его содержимое: захвтите регион и перетащите его с нажатой клавишей Ctrl. 
Чтобы переместить регион с его содержимым: захвтите регион и перетащите его. 
Чтобы переместить регион, не перемещая его содержимое: захвтите регион и перетащите его с нажатой 
клавишей Alt. 
Чтобы удалить регион: Alt+щелчок по значку региона 
 
Чтобы создать регион между двумя маркерами: 
 
1. Убедитесь, что опция Loop points linked to time selection в меню Options отмечена. 
2. Дважды щелкните по шкале времени (не на линейке маркеров) между маркерами, чтобы выделить область. 
3. Щелкните правой кнопкой по области и выберите опцию Create region from selection. 
 

 
 
Чтобы создать регион с нуля: 
 
1. Выделите область. 
2. Щелкните правой кнопкой по области и выберите опцию Create region from selection. 
 
Пример работы с регионами: 
 
1. Убедитесь, что опция Loop points linked to time selection в меню Option отмечена. 
2. В файле All Through the Night MARKERS.RPP, дважды щелкните по шкале времени между первыми двумя 
маркерами. Это выделит область между маркерами. 
3. Щелкните правой кнопкой по шкале времени между маркерами и выберите опцию Create Region from 
Selection. 
4. Удерживая клавишу Shift, дважды щелкните по значку нового региона, чтобы отобразить диалоговое окно 
Edit Region. Введите имя Verse 1 и нажмите Enter. 
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5. Дважды щелкните по шкале времени между маркерами #3 и #4, чтобы 
выделить эту область. Нажмите Shift +R, чтобы создать регион. Щелкните 
правой кнопкой по значку этого региона и выберите опцию Edit Region, 
введите имя Verse 2 и нажмите Enter. 
 
 
 
 
 
 
 
 

 
6. Повторите этот процесс, используя область между маркерами #5 и #6, чтобы создать регион Verse 3. 
Оставьте этот регион выделенным. 
7. Нажмите клавишу Ctrl и клавишу + на цифровой клавиатуре, чтобы увеличить масштаб этого региона. 
8. Нажмите Ctrl+PgDn, чтобы вернуть масштаб в отображение проекта. 
9. Нажмите Esc, чтобы снять с области выделение. 
10. Сохраните этот файл. 
 
В списке действий доступны множество удобных действий, облегчающих создания и управления регионами. 
Например, Markers: Insert region from time selection (вставить регион из выделенной области) и Markers: 
Insert region from selected items (вставить регион из выделенных клипов), а также Regions: Go to next region 
after next region finishes playing (перейти к следующему региону, после того, как закончится 
воспроизведение предыдущего). Подробнее об этом в Главе 15. 
 

9.8. Менеджер регионов/маркеров 
 
Команда View > Region/Marker Manager открывает окно, которое может использоваться для управления 
регионами и маркерами.  
 

 
 
Список ниже иллюстрирует, как менеджер регионов управляет маркерами и регионами, используя его кнопки, 
контроллеры и контекстное меню (отображаемое щелчком правой кнопкой мыши по его заголовку или по его 
фоновой области.) 
 

 
 
Чтобы перенумеровать маркеры и регионы по порядку на шкале времени: выберите опцию Renumber in 
timeline order из контекстного меню. 
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Чтобы перейти к маркеру или региону и прокрутить окно: активируйте опцию Seek playback when selecting 
a marker or region в контекстном меню. 
Чтобы автоматически проиграть любой регион в выделенной области менеджере регионов: активируйте 
опцию Play region thru then repeat or stop when selecting a region в контекстном меню. 
Чтобы отредактировать имя маркера/региона: дважды щелкните по строке имени маркера/региона в столбце 
Name, а затем отредактируйте имя. 
Чтобы отредактировать другие данные маркера/региона: дважды щелкните по строке номера (столбец #), 
начальной позиции (столбец Start), конечной позиции (столбец End) или продолжительности (столбец Length). 
Чтобы отсортировать строки в любом порядке: щелкните по любому заголовку столбца, например, по 
столбцу Name или Start time. 
Чтобы удалить маркер или регион: выберите маркер или регион в списке и нажмите Delete. При этом 
удаляется сам регион, но не мультимедийный контент. 
Чтобы отобразить/скрыть регионы или маркеры в менеджере регионов: отметьте/снимите опции Regions и 
Markers. 
Чтобы изменить порядок столбцов: перетащите заголовок столбца влево или вправо. 
Чтобы скрыть/ отобразить столбцы: щелкните правой кнопкой мыши по любому заголовку, и 
отметьте/снимите галочку с элемента списка. 
 

 
 
Чтобы открыть диалоговое окно Edit region/marker: дважды щелкните по имени маркера или региона. 
 

 
 
Чтобы изменить цвет региона или маркера: щелкните по маленькому цветному значку налево от номера 
маркера/региона. 
 

 
 
Чтобы масштабировать регион или маркер: дважды щелкните по номеру маркера или региону. 
Чтобы сконвертировать каждый регион в отдельный файл (на всех треках): из контекстного меню выберите 
опцию Mark all regions to be rendered или щелкните по столбцу Render, чтобы выбрать нужные регионы и 
выберите опцию Mark selected regions to be rendered из контекстного меню, а затем используйте кнопку 
Render Matrix, чтобы открыть одноименное окно. См. Главу 21. 
Чтобы сконвертировать только выбранные треки в пределах регионов в отдельные файлы: после выбора 
региона, который будет сконвертирован, щелкните левой кнопкой мыши в столбце Render Matrix, чтобы 
выбрать треки. Подробнее в Главе 21. 
Чтобы экспортировать список маркеров/регионов в файл формата txt или csv: отметьте опции Regions и/или 
Markers, выберите опцию Export regions/markers из контекстного меню, а затем введите имя файла, выберите 
тип файла и нажмите Save. 
Чтобы импортировать регионы/маркеры с файл формата csv (заменив текущие): используйте команду 
Import regions/markers (replace existing) в контекстном меню, выберите файл, а затем нажмите Open. 
Чтобы импортировать регионы/маркеры файл формата csv (объединив с текущими): используйте команду 
Import regions/markers (merge with existing) в контекстном меню, выберите файл, а затем нажмите Open. 
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9.9. Наложение регионов 
 
REAPER позволяет накладывать регионы друг на друга. Создайте регионы обычным способом. Используя 
контекстное меню шкалы времени перейдите Ruler layout > Display project regions in lanes и/или Display 
markers in lanes. Чтобы после этого они отображались корректно, вы можете щелкнуть на границе между 
панелью инструментов и панелью трека и раздвинуть область для создания достаточного пространства, чтобы 
отобразить несколько маркеров/регионов), как показано на рисунке ниже. Кроме того, Список действий REAPER 
включает действия, позволяющие установить высоту шкалы времени по умолчанию, а параметры страницы 
Mouse Modifiers позволяют настроить поведение мыши. Подробнее об этом в главе Опции отображения шкалы 
времени. 
 

9.10. Построение проекта с помощью регионов 
 
Регионы могут использоваться в качестве мощного инструмента для построения проекта, особенно когда вы 
создаете проект из сэмплов и/или лупов. Две особенно мощных функции регионов: 
 
- перетаскивание регионов по шкале времени с содержимым региона. 
- перетаскивание региона с нажатой клавишей Ctrl чтобы скопировать содержимое региона. 
 

 
 
Чтобы это проиллюстрировать, посмотрите на рисунок выше. Мы начали построение проекта, со вступления, 
затем идет запев (1 Verse 1) (который был превращен в регион), припев (3 Chorus 1 ) (также регион) и второй 
запев (2 Verse 2). Удерживая клавишу Ctrl при перетаскивании значка региона Chorus вправо, до конца запева 
#2, мы можем скопировать весь припев в эту точку (см. ниже).  
 

 
 
Заметьте, что любые маркеры и маркеры музыкального размера, которые были в регионе, будут также 
скопированы или перемещены вместе с регионом. 

 
Примечание: можно выбрать несколько клипов и создать отдельные регионы для каждого клипа выбрав 
опцию Markers: Insert separate regions for each selected item. Это действие можно выбрать из списка 
действий, и/или назначить на горячую клавишу, и/или добавить на панель инструментов и/или добавить 

в одно из меню REAPER. Подробнее об этом в Главе 15. 
 
 

9.11. Маркеры и медиаметки 
 
Если появилась необходимость использовать ваши медиафайлы в других приложениях, которые используют 
медиаметки (например, Sound Forge), можно преобразовать маркеры в эти метки. Тема рендеринга 
рассматривается в Главе 21. В REAPER доступна опция отображения медиаметок в меню View (активирована 
по умолчанию), если они доступны в импортированных клипах. Кроме того, можно использовать команду Item 
Processing, чтобы создать маркеры в пределах REAPER для этих меток. 
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Пример: 
 
1. В рисунке ниже, наш проект включает несколько маркеров: 
 

 
 
2. Мы можем выбрать соответствующие треки и сконвертировать их в файл (используя команду File > Render), 
выбрав опцию Stems (selected tracks) из выпадающего списка Render, моноканалы, и определить комбинацию 
маркеров и регионов, которые будут включены в конечные файлы в качестве медиаметок. В этом примере была 
выбрана опция Markers only (только маркеры). 
 

 
 
3. Если эти сконвертированные файлы импортировать назад в REAPER, мы увидим, что клипы включают метки, 
которые соответствуют исходным маркерам (как проиллюстрировано ниже). Обратите внимание на серию 
вертикальных пунктирных линий, которые указывают на позиции меток. 
 

 
 
4. Если теперь мы выберем какие-либо из этих клипов, затем щелкнем правой кнопкой мыши и выберем Item 
processing > Import media cues from items as project markers, для проекта будут автоматически созданы 
серия маркеров и регионов. 
 

9.12. Изменение представления времени проекта 
 
В качестве представления времени для огибающих, событий и маркеров можно выбрать либо значение Time, 
либо Beats (position, length, rate), либо Beats (position only). Для этого: 
 
1. Нажмите Alt+Enter, чтобы отобразить окно Project Settings. Щелкните по вкладке Project Settings. 
2. Выберите значение из выпадающего списка Timebase for items/envelopes/markers, а затем нажмите OK. 
Можно также изменить долю, щелкнув в области BPM (на транспортной панели) и ввести номер. 
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9.13. Производство музыки с темповой основой 
 

REAPER включает множество функций, которые 
представляют его с выгодной стороны для 
производства музыки с темповой основой. 
Некоторые из этих функций (например, создание 
лупов и различные свойства клипа) уже 
упоминались в контексте другого использования. 
Другие еще не были упомянуты. В этом параграфе 
мы объединим эти клипы, чтобы помочь понять, 
как REAPER может использоваться для 
производства музыки с темповой основой. 
Создание такой музыки - процесс, который в 
основном состоит из создания и распределения 
лупов из аудиосэмплов. Они становятся 
кирпичиками, из которых создается произведение. 
По отдельности их можно изменить по длине от 
одной единственной ноты до полного ритмического 
паттерна. Одно из преимуществ сэмплирования - 
качество звука, которое выгодно отличает их от 
MIDI. Есть множество исполнительских приемов и 
тонких изменений, которые очень трудно или 
неневозможно смоделировать с MIDI. Однако до 
недавнего времени MIDI интерфейс имел одно 
большое преимущество над сэмплированием. MIDI 
трек можно легко переместить, не изменяя темп, а 
его темп можно изменить, не затрагивая высоту 
тона. Это не всегда было возможно с 
аудиоматериалом. Возьмем пример с лупами 
барабанов. Одна из наиболее острых проблем при 
использовании сэмплеров заключается в том, что 
при изменении темпа изменялась и высота тона 
барабанных лупов. Сэмплеры изменяя высоту 
тона, замедляли или ускоряли темп. Это означало, 
что в зависимости от диапазона, в котором была 

нажата клавиша, необходимо было одновременно решать проблему изменения ритма. Было почти невозможно 
получить точный темп, без необходимости открывать сэмплер и вносить изменения в лупы. Сегодня доступно 
множество инструментов, которые могут сделать все это за вас. Инструменты изменения временных 
параметров и высоты тона, которые поставляются с REAPER, используют высококачественные алгоритмы, 
которые обеспечивают все опции, необходимые для изменения или поддержки таких факторов как 
продолжительность и интонация. Таким образом стало возможным изменять сэмплы более точно, не искажая их 
характеристик. ReCycle - одна из программ, которая стала популярной в виду того, что ее грувы в формате REX 
автоматически подстраиваются под темп проекта при их импортировании. Возьмите несколько клипов, 
представляющих слайсы в ритмичном груве, установите их представление времени в значение beats и 
измените темп - волшебство! Их можно перемещать как угодно, но они всегда остаются ритмически точны 
согласно темпу. Используя REX файлы, вы можете воспроизвести лупы в различных значениях темпа, не 
изменяя высоту тона.  
 
9.13.1. Параметры проекта 
 
Прежде, чем написать любую музыку, необходимо убедиться, что параметры проекта выставлены корректно. 
Чтобы отобразить окно параметров проекта, нажмите Alt+Enter или перейдите File > Project Settings. В 
частности, обратите внимание на следующие параметры: 
 
- во вкладке Project Settings определить темп в области BPM, музыкальный размер в области Time signature, 
представление времени для событий в меню Timebase. Доступные значения в меню Timebase: Time, Beats 
(position, length, rate) и Beats (position only). Если выбрано значение Beats (position, length, rate) клипы будут 
привязаны к шкале времени так, чтобы изменения темпа изменяли размер и скорость воспроизведения клипов. 
Если выбрано значение Beats (position only), начальная позиция клипа будет привязываться к доле, но 
содержимое клипа не будет затронуто изменениями темпа. 
- во вкладке Project Setting определите по умолчанию режим изменения высоты тона в меню Default pitch shift 
mode и его параметр в меню Parameter pitch shift mode.  
Помните, что можно изменить представление времени для отдельных треков (щелчком правой кнопкой мыши по 
треку и выбором опции Set track timebase), и для отдельных клипов (F2). 
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9.13.2. Свойства аудиоклипа 
 
Вы можете записать ваши собственные клипы или импортировать их из вне. Вы можете изменять различные 
свойства клипа, такие как скорость воспроизведения и высоту тона. Можно отредактировать параметры как для 
отдельных клипов так и для нескольких клипов. Например, если вы хотите изменить высоту тона или скорость 
воспроизведения нескольких клипов, выберите их и нажмите F2 (или щелкните правой кнопкой мыши по любому 
из выбранных клипов и выберите команду Item Properties).  
 

 
 
На примере выше мы увеличили скорость воспроизведения выбранных клипов на 5% с сохранением исходной 
высоты тона. Заметьте, что можно изменить режим изменения высоты тона проекта по умолчанию. Вы можете 
обнаружить, что различные алгоритмы работают лучше с различными типами аудиоклипов (например, с 
вокалом, малым барабаном, бочкой или бас-гитарой). Дополнительную информацию о функции растяжения по 
времени (time stretching) можно найти в параграфе "Манипуляции с временными параметрами и высотой тона". 
 
9.13.3. Создание области лупа из выделенной области 
 
Помните, что вы можете выделить любой фрагмент клипа и использовать его для создания лупа. Эта тема 
рассматривалась ранее в этой главе. В Главе 15 рассматривается список действий, который может 
использоваться для назначения горячих клавиш на большинство действий, которые могут быть полезными при 
работе с областью лупа и выделенной областью. 
  
9.13.4. Создание лупа на основе транзиентов 
 
Другой способ выделить область для создания лупа заключается в использовании транзиентов (резких 
изменениях в характере звука) в текущих клипах. Нижеперечисленные действия - всего лишь некоторые из 
многих, которые можно найти в списке действий (Глава 15). Если на действие не назначена горячая клавиша, ее 
можно назначить самостоятельно. 
 
Навигация клипов: Чтобы переместить курсор в ближайший транзиент в клипе: Ctrl+Tab 
Навигация клипов: Чтобы переместить курсор к следующему транзиенту в клипе: Tab 
Навигация клипов: Чтобы переместить курсор к предыдущему транзиенту в клипе: Shift +Tab 
Область выделения: Чтобы расширить область до следующего транзиента: предположим, что вы 
используете горячие клавиши по умолчанию, показанные выше, и что горячая клавиша Ctrl+Alt+Tab была 
назначена на опцию Extend time selection to next transient in items (расширить область до следующего 
транзиента). Можно выбрать клип, перейти точно от транзиента к транзиенту и выделить точную нужную 
область. Можно выбрать клип, скопировать и вставить его в другом месте, затем щелкнуть по нему правой 
кнопкой мыши и выбрать опцию Copy loop of selected areas of items из контекстного меню. Другие опции: 
 
Copy selected area of items (скопировать выделенную область с клипами) 
Trim items to selected area (обрезать клипы по границам выделенной области) 
Split items at prior zero crossings (разделить клипы согласно точке нулевого пересечения) 
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9.13.5. Параметры распознавания транзиентов 
 
Команда View > Transient Detection Settings открывает окно, которое показано на рисунке.  
 

 
 
Это окно может использоваться для редактирования параметров распознавания транзиентов. Активирование 
опции Use zero crossings (not as precise but prevents clicks) поможет предотвратить нежелательные щелчки. 
 
9.13.6. Распознавание долей 
 
REAPER включает множество действий, которые могут помочь вам в распознавании долей и с их коррекцией.  
Есть действия распознавания темпа, создания тактов из выделенной области, расширения или обмена местами 
выделенной области до следующего транзиента, и другие. Некоторые из действий можно найти в контекстном 
меню, но все они находятся в списке действий. На любое действие можно назначить горячую клавишу, 
запустить из самого окна списка действия и/или добавить к меню Actions. Подробнее о списке действий в Главе 
15. Каким образом вы упорядочите эти действия остается за вами. Вот некоторые из них:  
 
Tab: Навигация клипа: перемещает курсор к следующему транзиенту в клипах. 
Ctrl+Alt+Tab: Выделенная область: поменять левый край выделенной области до следующего транзиента в 
клипах 
Ctrl+Shift+Alt+Tab: Выделенная область: расширить выделенную область до следующего транзиента в клипах. 
 
Пример: 
 

В данном примере, мы использовали наши горячие клавиши, чтобы 
создать и расширить выделенную область.  
 
 
 
 
 
 

 
Затем мы выбрали опцию Create measure 
from time selection (detect tempo) (создать 
такт из выделенной области с 
распознаванием темпа). Мы можем это 
сделать либо из контекстного меню шкалы 
времени, либо используя горячие клавиши.  
 
 
 

 
Затем мы использовали наши горячие клавиши, чтобы получить 
следующую требуемую выделенную область, опять же используя 
эту выделенную область для создания такта с автоматическим 
распознаванием темпа.  
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Этот процесс повторяется до тех пор, пока мы не 
достигнем точки, где необходимо изменить 
музыкальный размер.  
 
 
 
 
 
 

 
Щелкнув правой кнопкой мыши по шкале времени, мы открываем контекстное 
меню и выбираем команду Create measure from time selection (new time 
signature). Открывается диалоговое окно Edit Time Signature, где мы можем 
отредактировать музыкальный размер. Этот процесс можно повторить нужное 
количество раз. 
 
 
 
 
 
 
 
 
 
 

 
9.13.7. Квантизация клипов 
 
REAPER включает функции выравнивания аудиоклипов. По сути это означает выстраивание их в линию 
согласно темпу или музыкальному размеру проекта. Может возникнуть ситуация, когда вы скопировали и 
несколько раз вставили сэмпл в пределах трека (или в несколько треков), и вам необходима гарантия, что они 
будут выровнены. Чтобы выровнять все клипы к доле: 
 
1. Дважды щелкните по треку на панели треков, чтобы выделить все клипы этого трека. 
2. Щелкните правой кнопкой по любому из выделенных клипов, а затем перейдите Item Processing > Quantize 
item positions to grid. 
 

 
 
3. В диалоговом окне Quantize Item Positions отредактируйте нужные параметры, включая выравнивание по 
длительностям нот (Quantize to) - 1/8, 1/4, 1/2, 1, 2, и т.д. и определитесь, хотите ли вы расширить клипы 
(Quantize item ends and stretch item to fit) 
4. Нажмите Process для выполнения команды квантизации.  
 

9.14. Динамическое разделение 
 
Динамическое разделение - очень мощная функция, у которой много применений. Вы уже видели (в Главе 7), 
как она может использоваться для удаления тишины. Например, вы записали довольно хорошую партию бас 
гитары в темпе 96 BPM. Возможно в некоторых местах "хромает" ритмичность, но в целом вы довольны 
результатом. Проблемы появятся тогда, когда вы захотите использовать эту партию в проекте с темпом 120 
BPM. Вот другой пример. Возможно, вы записали убийственный трек слайд гитары. Вам он нравится, но вы 
считаете, что было бы неплохо изменить темп мелодии один или два раза. Динамическое разделение - ответ на 
обе эти проблемы. Эта функция работает по принципу разделения любых клипов согласно критериям, которые 
вы определяете. В основном это работает так: 
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1. Сначала вы выбираете клип (ы), которые должны быть разделены. 
2. Затем щелкнув правой кнопкой мыши по клипу, вы переходите Item processing > Dynamic split items. 
3. В диалоговом окне Dynamic split items вы определяете критерии, по которым должно произойти разделение 
ваших клипов. Обычно это либо разделение трека в его транзиентах или использование шумоподавителя для 
разделения в точках, где громкость падает ниже указанного порога. Как вы вскоре увидите, для каждой из этих 
функций предусмотрено свое отдельное использование. 
4. Затем REAPER "как бы" разделяет выбранный клип (ы). То есть на дисплее отображается то, что будет если 
применить функцию динамического разделения. 
5. Затем в режиме реального времени вы вносите нужные корректировки параметров. 
6. И в заключении вы применяете разделение клипов. 
 
После разделения каждый слайс исходного клипа будет установлен в текущее представление времени. Однако 
для любого из разделенных клипов можно установить и свое представление времени. Динамическое 
разделение  - процесс не разрушающий. Это означает, что ваши исходные аудиофайлы (WAV, MP3, AIF) 
остаются не тронутыми. Тем не менее, если вы собираетесь использовать этот метод для создания сэмпловой 
библиотеки, хорошая идея - поработать над копией исходного трека. Давайте теперь рассмотрим примеры. 
 
9.14.1. Разделение клипов на сэмплы 
 
В примерах, проведенных ниже, выбрана запись гитары резонатора. Затем в контекстном меню мы выбрали 
команду Item processing > Dynamic split items. В каждом из примеров должна быть активирована опция At 
transients.  
 
Примеры: 
 
В данном примере использовалось минимальное количество опций. Если вы определите достаточно низкую 
минимальную продолжительность слайса, REAPER будет распознавать транзиенты с высокой степенью 
чувствительности. Это приведет к тому, что клип будет разделен на очень большое количество клипов. Это 
могло бы нам пригодиться в том случае, если мы намеревались бы внести изменения темпа в песне. Чем 
больше сэмплов и чем они короче, тем более чувствительный и непосредственный будет отклик трека на любые 
изменения темпа. Обратите внимание, (на рисунке ниже) что в качестве режима ограничения 
продолжительности слайса выбрана опция Best to worst. Эта опция, вероятно, будет предпочтительна при 
разделении на транзиентах. Заметьте также, что мы определили, что хотим сохранить позицию долей 
неизменной, даже если изменяется темп. 
 

 
 
Теперь давайте посмотрим на то, что произойдет, если мы будем использовать другие опции. В случае, что на 
рисунке выше, мы установили великоватую минимальную длину слайса, поэтому в итоге наш клип довольно 
большой. Это бы нам подошло, если бы мы создавали сэмплы, которые использовались бы с программным 
синтезатором. Однако мы хотим сделать еще более точную настройку. В следующем примере (на рисунке 
ниже), мы увеличили минимальную длину слайса и применили опцию Reduced splits для еще большего 
сокращения количества разделений.  
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В данном случае эти параметры могли быть применены для создания нашей сэмпловой библиотеки с данного 
трека бас-гитары. Прежде, чем применить разделение не мешало бы в некоторых случаях рассмотреть 
параметры шумоподавителя для удаления тишины. Применять или нет шумоподавитель зависит в основном от 
инструмента и природы мелодии и аранжировки. Если на инструменте исполнитель играет непрерывно и 
генерирует звуковой сигнал, как на рисунке ниже, то может быть не имеет смысла использовать 
шумоподавитель. На рисунке ниже мы можем увидеть, как теперь наш клип выглядит после разделения.  
 

 
 
Следующий пример (на рисунке ниже) иллюстрирует разделение в транзиентах с шумоподавителем, 
используемым для удаления нежелательные сторонних сопровождающих звуков, например, дыхание в 
вокальном треке. В данном примере, если бы мы установили порог гейта слишком низким, просачивалось бы 
слишком много нежелательных звуков. Если мы установим порог слишком высоко, мы рискуем удалить часть 
более тихого, но полезного вокального материала. Чтобы добиться наилучших результатов, необходимо 
поэкспериментировать с этим параметром. 
 

 
 
Опции ограничения продолжительности слайса 
 
Опция Left to right означает, что клип будет считываться слева направо, и каждый раз, когда транзиент будет 
пересекать порог, будет создана точка разделения. После этого минимальная продолжительность слайса 
определяет насколько близко будет следующая точка разделения. Опция Best to worst означает что клип будет 
считываться полностью, а как будет распознан наиболее устойчивый транзиент, там будет создана точка 
разделения. Затем следующий самый устойчивый транзиент, и так далее. Различие между этими опциями 
заключается в том, что опция Left to right может привести к пропуску некоторых устойчивых транзиентов. 
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9.14.2. Изменение темпа проекта 
 

После того, как клип был динамически разделен, можно 
создать маркеры музыкального размера для изменений 
темпа, на которые будет реагировать трек при 
воспроизведении. Для этого: 
 
1. Щелкните правой кнопкой по шкале времени и выберите 
опцию Insert tempo/time signature marker из контекстного 
меню. 
2. Введите новое значение в области Beats per Minute или 
Time signature. При необходимости можно выбрать опцию 
постепенного перехода темпа между маркерами (Gradually 
transition tempo to next marker). 
3. Нажмите OK. Можно дважды щелкнуть по любому маркеру 
музыкального размера, чтобы отредактировать его 
параметры, а также можно перетащить его вдоль шкалы 
времени, чтобы сменить его позицию. 
 
 
 
 
 
 

 
9.14.3. Создание хроматического MIDI клипа 
 
При выполнении динамического разделения можно выбрать опцию Create chromatic MIDI item from slices 
(создать хроматический MIDI клип из слайсов). Она создает MIDI клип в виде одного MIDI события для каждого 
слайса в хроматическом гаммообразном порядке вверх. Одно их распространенных применений этой опции 
заключается в воспроизведении сэмплов.  
 

 
 
Предположим, у вас есть грув, который вы собрали из различных клипов с разных источников. Вы можете 
создать хроматический MIDI клип из этих клипов, а затем загрузить эти клипы в плеер сэмплов, где каждый клип 
будет назначен последовательно на ноты. MIDI клип затем воспроизведет грув. Перемещение MIDI нот изменит 
грув. Другой пример - замена звука барабана. Вы можете динамически разделить партию ударных, создав 
хроматический MIDI клип из этой партии. После этого у вас будет по одной velocity чувствительной MIDI ноте 
для каждого удара. Затем непосредственная задача - удалить плохой звук и использовать MIDI ноту для 
воспроизведения сэмпла барабана. Поочередно, можно использовать весь MIDI трек для воспроизведения 
сэмплов барабана, чтобы удвоить записанную партию (таким образом, делая ее объемнее). Хроматический 
MIDI клип может, конечно, редактироваться, как и любой другой MIDI клип в MIDI редакторе и использоваться 
для воспроизведения на любом синтезаторе или плеере сэмплов. MIDI редактор подробно обсуждается в Главе 
13. 
 
Параметры Leading Pad, Trailing Pad и Fade Pad 
 
Для примеров, используемых в этом параграфе, не применялся ни один из этих трех параметров. Параметр 
Leading pad - значение в миллисекундах (мс), на которое точка разделения сдвигается влево от транзиента или 
точки открытия гейта, когда вы применяете разделение. Это работает как с разделениями по транзиентам, так и 
с разделениями с использованием гейта. Динамическое разделение решает, где разделить клип, а затем 
растягивает влево на выбранное значение в миллисекундах. Параметр Trailing pad сдвигает фактическую точку 
разделения вправо на выбранное значение в миллисекундах, и на то же значение вправо от точки закрытия 
гейта при разделении с помощью гейта. Фактические разделения в этом случае будут происходить налево и 
направо от темных границ области, если вы будете использовать обе опции - When gate opens и When gate 
closes. Параметр Fade pad применяет фейдинг по длине этих вставок. 
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9.14.4. Сохранение и использование сэмплов 
 
После разделения можно сохранить любой из отдельных слайсов в качестве сэмпла. Для этого просто 
щелкните правой кнопкой по слайсу и выберите опцию Glue items из контекстного меню. Файл сэмпла можно 
затем импортировать для использования с любым сэмплером, например, с ReaSamplOmatic5000. Помните 
также, что, если вы сохранили исходный файл с разделенными клипами, можно возвращаться к нему любое 
количество раз, когда вы захотите использовать его для создания дополнительных сэмплов. 
 

9.15. Параметры отображения шкалы времени 
 
Команда Ruler Display в контекстном меню 
шкалы времени позволяет выбрать параметры 
отображения различных показателей на шкале 
времени. Опции, относящиеся к регионам и 
маркерам обсуждены ранее в этой главе и 
включают: 
 
 
 
 

 
Display project regions in lanes / Display project markers in lanes/Display tempo changes/Display time 
signature changes/Display tempo and time signature changes in separate lanes. 

 
Активирование всех трех вышеперечисленных опций 
затрагивают темпомаркеры и маркеры музыкального размера, 
которые отображены в данном примере (на рисунке слева).  
По умолчанию линии сетки отображаются как для маркеров 
региона проекта, так и для маркеров музыкального размера: их 
отображение можно отключить на странице Appearance в 
предварительных настрйках. 
 
Высоту шкалы времени можно отегулировать, используя любой 
из следующих способов: 
 
- захватить границу между панелью инструментов и панелью 

трека и перетащить ее вверх/вниз. 
 - если вы активировали соответствующую опцию на странице Editing Behavior > Mouse в предварительных 
настройках, можно захватить границу между шкалой времени и областью аранжировки и перетащить ее 
вверх/вниз. 
 - другие опции заключаются в использовании одного или нескольких действий, относящихся к шкале времени в 
списке действий:  
 
Ruler: Set to default height/Ruler: Set to maximum height/Ruler: Set to minimum height.  
 
Они, как и любые другие действия, могут быть назначены на горячие клавиши и/или в виде кнопок на панель 
инструментов.  
 
Некоторые общие советы по управлению маркерами (регионы/маркеры проекта и музыкального 
размера/темпомаркеры): 
 
 - щелчок с нажатой клавишей Alt на маркер удаляет его. 
 - двойной щелчок по маркеру позволяет отредактировать его параметры. 
 - чтобы переместить маркер, просто захвтите его и переместите влево/вправо. 
 
На странице Mouse modifiers в предварительных настройках вы найдете различные действия (щелчок левой 
кнопкой мыши+перетаскивание), которые можно использовать (или изменить) в работе с маркерами/регионами 
проекта или маркерами изменения музыкального размера/ темпа. Подробные инструкции управления 
маркерами музыкального размера/темпа можно найти в главе "Маркеры изменения темпа//музыкального 
размера». 
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9.16. Поддержка rex файлов 
 
Rex файлы состоят из слайсов грува. Они создаются в программе Recycle и экспортируются оттуда для 
использования в записи музыки с темповой основой. Эти файлы можно импортировать в REAPER, используя 
команду Insert > Media или просто перетащить их из браузера клипов. После этого, они автоматически 
располагаются согласно текущему выбранному темпу. После того как вы импортировали rex файлы в REAPER, 
ими можно управлять и использовать их точно так же, как и другие клипы, к которым применялось динамическое 
разделение в пределах REAPER. Например, позицию импортированных REX слайсов можно привязать к доле, 
даже если темп проекта изменяется. На странице Options > Preferences Media > Video/REX/Misc есть 
несколько опций для определения поведения rex файлов. При импортировании rex файлов можно определить 
их как бит слайсы, динамически подстраивающиеся под темп (Beat slices that dynamically adjust to tempo 
change) или как отдельные зацикливаемые клипы в текущем темпе проекта (A single loopable item at the 
current project tempo) или указать REAPER всегда открывать при импортировании окно запроса (Always 
prompt). Можно также определить поведение хвостов REX файлов - сохранять все хвосты слайсов (Preserve all 
slice tails) или обрезать все хвосты, кроме последнего (Chop all but the final slice tail), или обрезать только 
последний хвост (Chop only the final slice tail) или обрезать все хвосты (Chop all slice tails). Список действий 
также включает полезное действие Item: explode REX item into beat slices (разложить rex клип на бит 
слайсы), которое можно назначить на его собственную горячую клавишу. 
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10. Управление высотой тона и растяжением по времени 
 

10.1. Изменение частоты воспроизведения проекта 
 
Частоту воспроизведения проекта целиком можно изменить, используя транспортную панель. При этом будут 
применен режим изменения высоты тона проекта по умолчанию. Для этого: 
 
- щелкните в окне редактирования Rate и напечатайте новое значение (например, чтобы убыстрить темп на 
10%, напечатайте 1.1) 
- щелкните мышью в окне редактирования и прокрутите колесо мыши, чтобы увеличить или уменьшить 
значение частоты воспроизведения. 
- используйте горизонтальный фейдер рядом с окном редактирования. 
 
В дополнение к этим способам вы можете щелкнуть правой кнопкой мыши по окну редактирования или по 
фейдеру и выбрать одну из опций из меню: 
 
- cбросить частоту воспроизведения в нормальное значение 1,0 (Set the playrate to 1.0). 
- увеличить или понизить темп воспроизведения в любым доступном значении (Increase/decrease by...). 
- активировать/отключить опцию Preserve pitch in audio items when changing master playrate (Сохранить 
высоту тона аудиоклипа при изменении основного значения частоты воспроизведения). 
- примените частоту воспроизведения к текущему значениию тмпа (Apply play rate to the current BPM). 
- установить диапазон фейдера согласно любому из доступных параметров. 
 

Примечание: Если фейдер не отображается на транспортной панели, вы можете отобразить его 
щелчком правой кнопкой мыши по любой свободной части транспортной панели и выбрать опцию Show 
play rate control. 

 
10.2. Изменение высоты тона отдельных клипов 

 
Высоту тона (Pitch) любого клипа можно изменить в окне Item Properties. Высота тона измеряется в полутонах. 
Можно использовать либо целое число: 1, либо дробное: 1.5. Обратите внимание на выпадающий список 
алгоритмов изменения высоты тона/растяжения: 
 

 
 
Project default (алгоритм взятый с одноименного меню свойств проекта). 
SoundTouch 1.9.0 (позволяет растянуть скорость до 1,000 раз и до 64 каналов). 
Dirac LE (качество лучше, но и больше нагрузка на процессор). 
Simple windowed 
Elastique 2.28 или 3.1.4 Pro (лучший алгоритм). 
Elastique 2.28 или 3.1.4. Efficient (меньше нагрузка на процессор, чем при использовании алгоритма Elastique 
Pro). 
Elastique 2.28 или 3.1.4. SOLOIST (подходит для моноклипов). 
 
При выборе одного из алгоритмов Elastique, необходимо также выбрать параметр из соседнего меню.  
 

 
 
Подробнее об этих и других функциях алгоритмов Elastique на сайте zplane: http://www.zplane.de/index.php. 
Чтобы открыть диалоговое окно Item Properties любого клипа, сначала выберите клип, а затем нажмите F2. 
Алгоритм по умолчанию определяется алгоритмом выбранным в одноименном меню проекта.  
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Горячие клавиши позволяют легко и быстро изменить высоту тона любого выбранного клипа или группы клипов 
без необходимости открывать окно Item Properties: 
 
Shift +9: понижение высоты тона на один полутон. 
Shift +7: понижение высоты тона на один цент. 
Shift +0: повышение высоты тона на один полутон. 
Shift +8: повышение высоты тона на один цент. 

 
Для изменения высоты тона можно также использовать огибающую высоты 
тона копии. Щелкните правой кнопкой по копии (или по клипу, если доступна 
только одна копия) и перейдите Take > Take pitch envelope.  
 
 

Для более продвинутого изменения высоты тона можно использовать один из соответствующих плагинов, 
которые предоставляются с REAPER. Просто откройте окно эффектов трека, нажмите Add, а затем в области 
фильтра напечатайте pitch, чтобы отобразить список доступных плагинов.  
 

 
 
На рисунке выше выбран плагин JS Pitch: Octavedown. Другие плагины JS: fft-ps, mdct-shift, octaveup, pitch2, 
pitchdown и superpitch. Каждый из них предназначен для выполнения определенных задач, но самый мощный из 
доступных плагинов изменения высоты тона - ReaPitch. 
 

10.3. Использование плагина ReaPitch 
 
Просто вставьте VST плагин ReaPitch в цепочку эффектов трека, и у вас в распоряжении появится мощный 
инструмент управления высотой тона клипов. Например, ReaPitch можно использовать для создания бэк-
вокала.  
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На рисунке выше изображен плагин ReaPitch, вставленный в цепочку эффектов вокального трека. В качестве 
алгоритма выбран Elastique Soloist, а качестве параметра Monophonic. Заметьте, что высота тона была 
понижена на 25 центов, а панорама смещена на 50% вправо.  
 

На этом рисунке мы добавили 
второй плагин, на этот с 
повышенной высотой тона на 
25 центов и смещенной 
панорамой на 50% влево. 
Таким образом мы создали 
дополнительный голос. 
Обратите также внимание что 
на втором рисунке мы также 
отрегулировали панораму и 
баланс сигналов, чтобы 
улучшить общий эффект. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
10.3.1. Изменение высоты тона и разделение каналов 
 
Если вы намереваетесь уделить этой работе много внимания, необходимо внимательно изучить возможности 
разделения каналов REAPER. Эта тема подробнее рассматривается в параграфе "Дополнительные примеры 
маршрутизации REAPER" (и в других местах). Особенно обратите внимание на пример "Разделение каналов и 
настройка высоты тона". С помощью функции разделения каналов можно, например, не только создать 
несколько голосов, но и применить различные плагины эффектов или цепочки эффектов к каждому голосу. 
 

10.4. Использование плагина ReaPitch с несколькими треками 
 

Мы уже рассматривали 
возможности REAPER по 
пересылке аудиопотока с одного 
трека в другой. Давайте теперь 
рассмотрим использование этой 
функции с плагином ReaPitch. На 
рисунке ниже, вы видите 
посылы, которые используются 
для передачи сигнала с трека 
основного вокала в два других 
трека. У каждого из этих других 
треков своя собственная цепочка 
эффектов, которая включает 
плагин ReaPitch, и конечно же 
фейдерами громкости и 
панорамы этих треков можно 
управлять независимо друг от 
друга и независимо от трека 
основного вокала. В Главе 17 мы 
рассмотрим, как настроить 
параметры прохождения схожих 
сигналов. 
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10.5. Тональная подстройка с плагином ReaTune 
 

ReaTune - плагин, который может 
использоваться для корректировки 
высоты тона записанных клипов. 
Обычно это применяется к вокальным 
трекам. Однако ReaTune может также 
использоваться и для подстройки 
инструментов. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
10.6. Исправление высоты тона с ReaTune 

 
ReaTune может использоваться как в ручном, так и в автоматическом режиме. В любом режиме алгоритм 
Elastique SOLOIST является наиболее подходящим.  
 

 
 
Автоматический режим иллюстрирован на рисунке выше. Чтобы его применить:  
 
- вставьте плагин ReaTune в окно эффектов трека. 
- перейдите на вкладку Correction. 
- отметьте опцию Automatic pitch correction. 
- выберите нужный алгоритм и параметр. 
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- определите правильную тональность и воспроизведите трек.  
 
Остальное ReaTune сделает за вас!  
 

 
 
Ручной режим иллюстрирован на рисунке выше. Чтобы его использовать:  
 
- вставьте плагин ReaTune в окно эффектов трека. 
- перейдите на вкладку Manual Correction. 
- отметьте опцию Manual pitch correction и по необходимости другие опции. 
- отметьте при необходимости опции Prevent octave shifts и Prevent overlapping segments, а также нажмите 
кнопку Update. 
- Используйте мышь для корректировки высоты тона. 
 

10.7. Функция растяжения по времени 
 

Секции Take properties и Take pitch 
shift/time stretch mode окна Item 
Properties (F2) могут использоваться для 
растяжения клипа по времени. Для этого 
необходимо отредактировать параметр 
Playback Rate. На рисунке ниже, 
скорость воспроизведения увеличена на 
2%, и отмечена опция Preserve Pitch. В 
качестве алгоритма выбран Elastique 3 
Pro.  
 
Чтобы открыть окно Item Properties 
любого клипа, выберите клип и нажмите 
клавишу F2. Чтобы сделать это для 
нескольких клипов: 
 
 

 
1. Выберите нужные клипы. 
2. Нажмите клавишу F2. 
3. Диалоговое окно Item Properties включает параметры, изменения которых затронут несколько клипов сразу, 
включая параметры изменения высоты тона, и настройка скорости воспроизведения. 
4. Внесите изменения и нажмите OK.  
 
Когда окно Item Properties открывается для нескольких клипов, некоторые опции будут затенены и, 
следовательно, не доступны. (например, опции Take envelopes и Rename file). Однако большинство опций 
доступно. 
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Другой способ настройки скорости воспроизведения любого клипа (или группы выбранных клипов): 
 
1. Выделите нужные клипы. 
2. Наведите курсор мыши на окончание одного из клипов, чтобы курсор изменился на изображении руки. 
Удерживая клавишу Alt, захватите конец клипа и перетащите мышь влево (чтобы увеличить скорость 
воспроизведения) или вправо (чтобы замедлить ее). 
3. Отпустите кнопку мыши по окончании.  
 
Если активирована опция Options > Preferences> Appearance> Media> Display media item pitch/playrate if set, 
любые изменения высоты тона или скорости воспроизведения будут отображаться на или выше клипа в 
области аранжировки. 
 

 
 
 

10.8. Stretch маркеры 
 
Stretch маркеры могут использоваться для убыстрения или замедления фрагмента клипа или выделенной 
области, или группы выделенных клипов. Они могут быть вставлены в текущей позиции курсора 
воспроизведения или по границам выделенной области. В отличие от стандартных маркеров проекта (которые 
относятся к проекту в целом), stretch маркеры применяются только к клипу (клипам), выбранным в тот момент 
времени, когда они вставляются. Перетаскивая эти маркеры влево или вправо, можно постепенно изменить 
темп клипов или фрагмента клипов. Чтобы создать stretch маркеры: 
 
- поместите курсор воспроизведения в точку, где вы хотите вставить stretch маркер или выделите область, по 
границам которой вы хотите вставить два stretch маркера. 
- выберите клип или клипы, к которым вы хотите добавить stretch маркер (маркеры) 
- перейдите в главное меню Item (или щелкните правой кнопкой мыши по клипу, чтобы отобразить контекстное 
меню и там перейдите Stretch markers > Add stretch marker at current position (вставить один маркер в 
позиции курсора) или Add stretch markers at time selection (вставить маркеры по краям выделенной 
области).  
 
Наведите мышь на stretch маркер, пока курсор не изменится на вертикальную или горизонтальную двойную 
стрелку как показано на рисунках ниже. После этого stretch маркеры можно перетащить влево или вправо. При 
перетаскивании первого из пары маркеров с нажатой горячей клавишей Shift +Alt перемещаются оба маркера, 
сохраняя дистанцию и темп между ними. Другие клавиши модификаторы перечислены в списке ниже. Между 
тем обратите внимание на некоторые примеры, иллюстрирующие как можно управлять stretch маркерами. Во-
первых, наведите курсор мыши на stretch маркер, чтобы он изменился на горизонтальную двухстороннюю 
стрелку, как на рисунках ниже.  

 
В первом примере stretch маркер вставлен в ткущей позиции курсора 
воспроизведения.  
 
 

 
При перетаскивании маркера влево, темп убыстряется до него 
(влево от него) и замедляется после него (вправо от него).  
 
 
 
Во втором примере stretch маркеры добавлены к выделенной 
области.  
 
 
 
При перетаскивании левого маркера вправо темп убыстряется в 
области между маркерами, замедляя темп в области до него 
(слева от него). Обратите внимание, что при добавлении маркеров 
к выделенной области автоматически добавились новые stretch 
маркеры налево от области и в начале клипа.  
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Тот же самый маркер перетаскивается влево с нажатой горячей 
клавишей Shift+Alt. Темп перед маркером изменяется, а темп между 
исходными двумя маркерами не изменяется, поскольку и маркеры, и 
область между ними перемещаются вместе. 
 

Stretch маркеры можно привязать к сетке, используя опции Snap stretch markers to grid (привязать маркеры к 
сетке) или Snap stretch markers within time selection to grid (привязать маркеры к сетке внутри выделенной 
области) из подменю Stretch markers. Чтобы удалить stretch маркер, щелкните по нему с нажатой клавишей 
Alt. Альтернативно чтобы удалить маркер, используйте любую из команд подменю Stretch markers - Remove all 
stretch markers (удалить все маркеры) или Remove all stretch markers within time selection (удалить 
маркеры в пределах выделенной области). При удалении stretch маркеров темп клипа возвращается к 
состоянию, которое было до добавления маркеров. Чтобы сделать любые изменения в клипе на постоянной 
основе, вместо того, чтобы удалить stretch маркеры вручную, можно "склеить" клип (опция Glue из контекстного 
меню клип или из главного меню Item). Если выделены несколько клипов, маркеры будут добавлены к ним. До 
тех пор, пока они остаются выделенными, перемещение одного маркера также переместит и другие. Чтобы 
временно обойти эту привязку, отредактируйте маркер одного из выделенных клипов с нажатой клавишей Ctrl. 
Если клипы сгруппированы, маркеры, добавленные к одному клипу в группе, будут также добавлены к другим 
клипам в этой группе. По умолчанию если перемещается один маркер, перемещаются все соответствующие 
маркеры в группе. Чтобы временно обойти эту привязку, отредактируйте маркер одного из выделенных клипов с 
нажатой клавишей Ctrl. Группировка клипов обсуждается в Главе 7. Следующий пример иллюстрирует, как 

stretch маркеры могут использоваться со сгруппированными клипами.  
На рисунке слева сгруппированы два клипа. Выбор одного клипа и 
добавление к нему stretch маркеров добавит маркеры к другому.  
 
 
 
 
 

 
Редактирование позиции маркера одного клипа по умолчанию 
соответственно изменяет позицию соответствующего маркера других 
клипов в группе.  
 
 
 
 

 
Различные клавиши модификаторы могут использоваться вместе с кнопками мышью (щелчок левой кнопкой 
мыши+перетаскивание) для изменения поведения при перетаскивании stretch маркеров. Эти действия по 
умолчанию можно изменить на странице Options > Preferences >  Mouse Modifiers выбрав в меню Context 
опцию Media item stretch markers (см. Главу 15). 
 
Модификаторы по умолчанию для действия "щелчок левой кнопкой мыши+перетаскивание" для опции Media 
item stretch markers меню Context:  
 
(без модификатора): перемещает stretch маркер 
Shift: перемещает stretch маркер, игнорируя привязку. 
Ctrl: перемещает stretch маркер, игнорируя выделенные/сгруппированные клипы. 
Shift +Ctrl: перемещает stretch маркер игнорируя привязку и выделенные/сгруппированные клипы. 
Alt: перемещает содержимое под stretch маркером. 
Shift +Alt: перемещает оба stretch маркера. 
Ctrl+Alt: перемещает содержимое под stretch маркером, игнорируя привязку. 
Shift +Ctrl+Alt: перемещает оба stretch маркера, игнорируя привязку. 
 
Другие модификаторы, применяемые со stretch маркерами доступны при выборе опции Media item stretch 
marker rate из меню Context, включая активирование/отключение возможности применения к обоим stretch 
маркерам. Чтобы изменить скорость изменения темпа можно также использовать модификаторы с функцией 
мыши "щелчок левой кнопкой мыши+перетаскивание» stretch маркера. Во-первых, наведите курсор мыши на 
stretch маркер, чтобы он изменился на вертикальную двухстороннюю стрелку, как на рисунках ниже.  
 

В данном примере, по мере перемещения маркера вверх 
повышается и темп.  
 
 
 

Модификаторы по умолчанию для действия "щелчок левой кнопкой мыши+перетаскивание" для опции Media 
item stretch marker rate в меню Context. 
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(без модификатора): изменяет темп, оставляя остальные маркеры на уровне. 
Shift: изменяет темп, с изменением позиций остальных маркеров. 
Ctrl: изменяет темп, перемещая содержимое под маркером. 
Shift +Ctrl: изменяет темп, оставляя остальные маркеры на уровне, перемещая содержимое под маркером. 
Alt: изменяет темп по обе стороны, оставляя маркеры на уровне. 
Shift +Alt: изменяет темп по обе стороны. 
Ctrl+Alt: изменяет темп по обе стороны, перемещая содержимое под маркером. 
Shift +Ctrl+Alt: перемещая содержимое под маркером, перемещая содержимое под маркером, оставляя 
маркеры на уровне. 
 
Другие модификаторы опции Media item stretch marker rate включают действия игнорирования выбранных 
клипов/сгруппированных клипов. В дополнение к командам и действиям мыши, объясненным выше, обратите 
внимание вот на что: 
 
- окно Item Properties включает опцию Optimize stretch markers for tonal content (оптимизировать stretch 
маркеры под тональный контент) 
- окно Dynamic Split Items (см. Главу 9) включает опцию Replace stretch markers, которая заменяет текущие 
stretch маркеры в клипе (клипах) динамическими разделениями. 
- доступны несколько действий перемещения stretch маркеров, например, перейти к ближайшему, следующему 
или предыдущему stretch маркеру. Подробнее о модификаторах REAPER и списке действий в Главе 15. 
 
Двойной щелчок по stretch маркеру сбрасывает его значение в 1.0. Ctrl+двойной щелчок на stretch маркере 
открывает диалоговое окно (на рисунке ниже) с опциями ручного редактирования начального значения темпа 
(Start rate), конечного значения темпа (End rate) или привязки обоих опций друг к другу (Link start/end rate). 
 

 
 

10.9. Использование темпомаркеров и маркеров музыкального размера 
 
Темп и музыкальный размер по умолчанию для любого проекта определяются параметрами в окне Project 
Settings любым из нижеописанных способов: 
 
- Откройте окно Project Settings (Alt+Enter) или нажмите клавишу W чтобы возвратить курсор редактирования к 
началу проекта, а затем... 
 

Напечатайте значения в окне BPM (как на рисунке слева) или в окне Time Signature 
на транспортной панели или наведите мышь на окно BPM и прокрутите колесо мыши 
вверх или вниз. 
 

- Выделите фрагмент и используйте опции контекстного меню шкалы времени, как на рисунке ниже. 
 

 
 
Для изменения музыкального размера и/или темпа проекта можно использовать либо огибающую темпа 
проекта, либо соответствующие маркеры. Для этого сначала убедитесь, что параметр timebase окна Project 
Settings установлен в значение Beats (position, length, rate). Огибающая темпа проекта объяснена в Главе 18. 
Она работает по сути как и любая другая огибающая автоматизации. Однако примите во внимание, что 
редактирование одновременно нескольких узлов этой огибающей заставит каждый узел редактироваться 
пропорционально, а не на постоянные значения BPM. Эта глава сосредоточена на вставке маркеров 
музыкального размера и/или темпомаркеров на шкале времени для внесения соответствующих изменений в 
проект. Пример показан ниже. Эти изменения вносятся сразу после вставки маркера. Прежде, чем мы перейдем 
к рактике, стоит отметить следующее: 
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- Маркеры музыкального размера и темпомаркеры - это два отдельных элемента, но оба вставляются на шкалу 
времени одинаковым способом. 
- Темп и музыкальный размер можно изменить в любой точке шкалы времени как по отдельности, так 
одновременно. По умолчанию изменения музыкального размера также отображаются  линиями сетки в окне 
аранжировки. Это поведение можно изменить на странице Appearance в предварительных настройках 
программы. 
- Если вы используете маркеры музыкального размера или темпомаркеры, желательно активировать 
соответствующие опции компановки шкалы времени (Глава 9), чтобы гарантировать их отображение. Используя 
маркеры одновременно, полезно рассмотреть также активирование опции отображения обоих типов в 
отдельных линейках, которые можно найти выбором опции Ruler layout в контекстном меню шкалы времени.  
А теперь рассмотрим способы вставки маркера музыкального размера или темпомаркера. 
 
1. Поместите курсор в нужное место проекта. В контекстном меню перейдите Insert > Time signature/tempo 
change marker (или нажмите Shift+C). 
2. Установите нужные значения в диалоговом окне (как на рисунке ниже).  

 
 
Параметры для BPM включают опции Gradually transition 
tempo to next marker и/или Set time signature и Allow a 
partial measure before this marker и (если активирован 
метроном и используется паттерн долей) Set metronome 
pattern. 
3. Нажмите OK. 
 
Помните!, вы можете использовать маркеры для установки 
музыкального размера, не измененяя темп (или наоборот). 
Маркеры можно изменить, например, дважды щелкнув по 
маркеру и открыв диалоговое окно), или простым их 
перемещением (см. списоук ниже). Примите также во 
внимание, что: 
 
- Маркеры темпа/музыкального размера всегда вставляются 
в позиции доли, а не временной позиции. 
- Чтобы вручную отредактировать маркеры музыкального 
размера необходимо поместить их в начало такта. 
- С активированной привязкой (Глава 7), изменения 
музыкального размера привязываются к тактам, темп 
привязывается к долям. 
- С отключенной привязкой (Глава 7), перемещение 

маркеров музыкального размера изменяет предыдущий темп, гарантируя, что проект будет содержать только 
полные такты. 
- Изменения музыкального размера, которые усекают предыдущий такт, отмечены звездочкой. 
- Изменения музыкального размера могут вызвать проблемы, если проект содержит линейные переходы темпа. 
- Один маркер темпа/музыкального размера не может быть перемещен мимо другого. 
- Маркеры окрашиваются в красный цвет при перемещении. 
 
Чтобы переместить тот или иной маркер: захватите его с нажатой клавишей Ctrl и перетащите.  
Чтобы переместить маркер музыкального размера с изменением предыдущего темп при необходимости, 
сохраняя относительную позицию последующих изменений темпа: захватите маркер с нажатой клавишей Ctrl и 
перетащите. 
Чтобы переместить темпомаркер, изменяя его значение и значение предыдущих темпомаркеров, сохраняя 
позицию последующих изменений темпа: захватите его с нажатой клавишей Ctrl+Shift и перетащите. 
Чтобы переместить маркер, игнорируя привязку: захватите его с нажатой клавишей Shift и перетащите. 
 
Примечания: 
- действия Project tempo/time sig marker left drag в вышеупомянутом списке можно настроить на странице 
Preferences > Mouse modifiers . 
- После добавления в проект маркеров музыкального размера или темпа, вы больше не сможете установить 
темп проекта из выбранного фрагмента в рамках этого проекта. 
- Страница Preferences > Audio Seeking включает переключаемую опцию Playback position follows project 
timebase when changing tempo (Позиция воспроизведения следует за временной разверткой проекта при 
изменении темпа). Подробнее об этом в Главе 22. 
- Контекстное меню кнопки Ripple edit  на панели инструментов включает опцию Ripple edit all affects tempo 
map (редактирование в режиме Ripple затрагивает темпокарту). 
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11. Микшер и мастер трек 
 

11.1. Введение 
 
До этого момента основной упор делался на работе в области аранжировки. Это не удивительно, так как здесь 
вы проведете большую часть своего времени (по крайней мере, при работе с аудиоматериалом) и проделаете 
большую часть работы. Однако по мере прогресса работы над вашим миксом вы обнаружите, что микшер 
REAPER становится все более и более важным. Содержание этой главы должно помочь вам в ознакомлении с 
микшером REAPER и его различными функциями и возможностями. Вы также узнаете, как получить 
набольшую отдачу от мастер-трека REAPER. Чтобы отобразить/скрыть окно микшера, перейдите View> Mixer 
(Ctrl+M). 
 

Примечание: в некоторых рисунках этой главы используются темы оформления, которые отличаются от 
темы оформления по умолчанию REAPER 5. Тем не менее команды и действия одинаковы, независимо 
от используемой вами темы. 

 
11.2. Команды микшера 

 
Контекстное меню микшера (на рисунке 
слева) отображается щелчком правой 
кнопкой мыши по строке заголовка или в 
любой свободной области окна микшера, или 
щелчком по лейблу “Master” мастера трека, 
или (если окно прикреплено) щелчком правой 
кнопкой мыши по вкладке Mixer на панели 
Docker. Это меню обеспечивает множество 
гибких опций показа/скрытия элементов окна 
микшера. Например, можно выбрать, 
отображать или нет эффекты и посылы в 
микшере. Основные элементы меню микшера 
перечислены ниже. С окна микшера можно 
получить доступ к контекстному меню 
области трека, щелкнув правой кнопкой по 
любому лейблу трека или его номеру. 
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11.3. Компоновка элементов окна микшера и скринсеты 
 
Команды контекстного меню микшера позволяют выбрать элементы, которые 
будут отображаться в окне микшера. Глава 12 затрагивает тему компоновки 
элементов окна (панели трека и панели микшера) более подробно, но на 
данный момент обратите внимание на следующее: 
 
- компоновка элементов окна создается и сохраняется с отдельными темами, 
не в пределах REAPER. Пример альтернативной компоновки элементов 
микшера (сессия микшера) показан на рисунке слева. Темы можно загрузить со 
страницы stash.reaper.fm. Чтобы выбрать установленную тему, перейдите 
Options> Themes. 
- к различным компоновкам элементов окна микшера можно получить доступ в 
контекстном меню области трека, выбрав опцию Set Track Layout > Mixer 
Panel или перейти Options > Layouts, или перейти View > Screensets/Layouts 
> Layouts. 
- компоновки элементов окна микшера привязаны к трекам. Используя 
контекстное меню, необходимо сначала выбрать треки, для которых вы хотите 
выбрать компоновку.  
 

Используя окно Screensets/Layouts можно применить компоновки глобально или только к выбранным трекам. 
Перед тем как вплотную заняться компоновками не лишним будет ознакомиться с командами контекстного меню 
микшера поближе 
 

11.4. Опции контекстного меню микшера 
 
Master Track: включает подменю переключаемых опций мастер трека: 
 

 
 
Show in mixer (отобразить в микшере) 
Show on right side of mixer (отобразить на правой стороне микшера) 
Show in separate window (отобразить в отдельном окне) 
Show in docker (отобразить на панели Docker) 
 
Команда View > Floating Mixer Master может также использоваться для открытия окна мастер-трека в его 
собственном плавающем окне. 
 
Show folders (показать трек-папки). 
Show normal top level tracks (показать типичные треки высшего уровня в трек-папках). 
Show tracks that are in folders (показать треки в трек-папках). 
Show tracks that have receives (показать треки с адресатами). 
Scroll view when track activated: если в окне микшера на хватает свободные места для отображения всех 
треков, щелчком по треку на панели трека окно микшера прокрутится к этому треку. 
Auto-arrange tracks in Mixer: порядок треков в микшере будет следовать за любыми изменениями в порядке 
треков на панели трека. Отключите эту опцию, если вы хотите расположить треки в разном порядке на панели 
микшера и на панели трека. 
Group folders to left: помещает трек папки на левой стороне окна микшера. Иногда может оказаться полезным 
отобразить все дополнительные трек-папки, но в других случаях можно запутаться в разделении трек-папок от 
их дочерних треков. 
Group tracks that have receives to left: помещает все треки с их адресатами на левой стороне окна микшера. 
Это особенно полезно, если только треки с адресатами являются шинами. 
Clickable icon for folder tracks to show/hide children: позволяет развернуть/свернуть трек-папки, чтобы 
показать/скрыть их дочерние треки. 
Show multiple rows of tracks where size permits: отображает максимальное количество треков в трех строках, 
когда они не помещаются в одну строку, а у окна микшера достаточная высота. 
Show maximum rows even where tracks would fit in less rows: отображает треки в таком количестве строк, 
сколько впишется в высоту трека, независимо от количества треков. 
Show sends when size permits: отображает лоток (bin) посылов выше контроллеров трека, если позволяет 
размер панели контроллеров трека. 
Show FX inserts when size permits: отображает цепочку эффектов выше контроллеров трека, если позволяет 
размер панели контроллеров трека 
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Show FX parameters when size permits: отображает контроллеры параметров эффектов, если позволяет 
размер панели контроллеров трека. Щелкните правой кнопкой по любому из них, чтобы назначить контроллер 
на параметр эффекта. 
Show track icons in Mixer: отображает значки треков (если таковые используется) на канальных модулях в 
микшере. 
Show icon for last track in folder: отображает последний трек на значке трек-папки. 
Dock Mixer in Docker: прикрепляет окно микшера на панель Docker. 
Close: закрывает окно микшера. 

 
Совет: дважды щелкните по любой панели трека в микшере, чтобы масштабировать этот трек на панели 
трека. Это поведение можно изменить на странице Mouse Modifiers (см. Главу 15). Эту же страницу 
можно использовать для добавления собственных действий. Например, можно назначить горячую 

клавишу Ctrl+двойной щелчок на действие Track: Set to custom color (установить цвет для трека). 
Подробности в Главе 15. 
 

11.5. Типы треков в микшере 
 

 
 
Возьмем в качестве примера проект на рисунке выше. В этом проекте две трек-папки - Vocals и Instruments, 
включающих два и три дочерних трека соответственно, плюс один трек высшего уровня - Reverb. С двух трек-
папок есть посылы в трек Reverb (который функционирует в качестве шины), а у дочерних треков также 
присутствуют эффекты. Четыре команды “Show…” в контекстном меню микшера используются для 
определения какие типы треков будут отображены на панели микшера.  
 

 
 
В данном примере мы, возможно, достигли той стадии нашего микширования, где мы довольны балансом в 
пределах подмикса из трек-папок и хотим сфокусироваться на получении баланса между подмиксами и 
уровнями трек-папок Vocals и Instruments и шины Reverb. В этом случае мы можем выбрать опцию 
отображения не тех треков, которые находятся в трек-папках, а только отображение самих трек-папок, треков с 
адресатами и мастер-трека (как на рисунке выше и ниже). В данном примере используется компоновок 
элементов окна микшера в виде боковой панели.  
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Данный пример простой, но вообразите, насколько полезной могла быть эта функция, если бы проект включал 
90 отдельных треков, дюжину подмиксов из трек-папок и еще полудюжину шин! В этом случае вы могли бы 
найти одну или несколько команд Show… и Group… контекстного меню микшера очень удобными.  
В контекстного меню микшера нет способа определенно скрыть или отобразить именованные отдельные треки. 
Однако это можно сделать в менеджере треков, который подробно будет обсуждаться в Главе 12. 
 

 
 

11.6. Работа с эффектами в микшере 
 
Окно микшера обеспечивает практически все средства управления эффектами. Вы можете добавить эффекты к 
трекам, переместить или скопировать их с одного трека в другой, открыть окно любого плагина или открыть 
цепочку эффектов трека для более детального управления эффектами. Тем не менее чтобы все это стало 
возможным, необходимо в контекстного меню микшера активировать опцию Show FX inserts when size permits. 
Список ниже суммирует эти и другие действия: 
 
Чтобы изменить порядок плагинов в цепочке эффектов: захватите эффект и перетащите его вверх или вниз 
по списку. 
Чтобы скопировать эффекты с одного трека в другой: перетащите список эффектов с одного трека в другой. 
Чтобы отобразить контекстное меню эффекта: щелкните правой кнопкой по имени плагина. 
Чтобы отобразить окно добавления эффектов: щелкните в любой свободной области списка эффектов. 
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Чтобы отобразить цепочку эффектов и окно контроллеров этого плагина: щелкните по имени плагина с нажатой 
клавишей Ctrl. 
Чтобы переместить эффект с одного трека в другой: перетащите его с нажатой клавишей Alt в другой трек. 
Чтобы открыть окно контроллеров плагина и отобразить его в плавающем окне: щелкните по имени плагина. 
Чтобы удалить плагин из цепочки эффектов: щелкните по имени плагина с нажатой клавишей Alt. 
Чтобы удалить все плагины из цепочки эффектов трека: нажмите кнопку FX трека с нажатой клавишей Alt. 
Чтобы переключить плагин в статус offline: щелкните по имени плагина с нажатой клавишей Ctrl+Shift. 
Чтобы переключить плагин в статус обхода: щелкните по имени плагина с нажатой клавишей Shift. 

 
Кроме того, щелчок правой кнопкой 
по списку эффектов любого трека в 
микшере открывает контекстное 
меню как на рисунке слева. Если 
щелкнуть правой кнопкой мыши по 
пустой области списка эффектов, 
некоторые команды (такие как Float 
FX configuration) будут не 
доступны. Если вы щелкните правой 
кнопкой мыши по имени плагина, 
откроется полное меню команд:  
 
Add FX: открывает браузер 
эффектов, позволяя добавить 
любой установленный плагин 
эффектов 
Quick Add FX: отображает подменю 
недавно используемых эффектов: 
можно выбрать любой элемент из 
этого меню, чтобы добавить его к 
цепочке эффектов трека 
Add FX Chain: отображает меню 
цепочек эффектов, любую из 
которых можно выбрать и вставить 
в этот трек 
Replace FX: открывает браузер 
эффектов, где вы можете заменить 
эффект: при этом любая 
конфигурация маршрутизации будет 
сохранена 
Quick replace FX: открывает 
подменю недавно используемых 
эффектов, из которого можно 

выбрать любой клип и заменить выбранные эффекты 
Copy FX: копирует эффект в буфер обмена так, чтобы его можно было вставитьв другой трек или клип. 
Обратите внимание на опцию include automation, позволяющую включить огибающие автоматизации. Вы 
можете также использовать горячую клавишу Ctrl+перетаскивание для копирования эффекта с одного трека в 
другой или горячую клавишу Ctrl+Shift+перетаскивание чтобы скопировать эффект и его огибающие 
автоматизации. 
Paste FX/ Paste Replace FX: вставляет эффект из буфера обмена в выбранный трек/вставляет эффект из 
буфера обмена в выбранный трек с заменой текущего эффекта. 
Float FX configuration: открывает собственное окно выбранного плагина 
Show FX chain: открывает цепочку эффектов трека: то же самое что и щелчок по кнопке FX трека 
Bypass chain: устанавливает цепочку эффектов этого трека в обход. То же самое что и щелчок по правой 
стороне кнопки FX 
Bypass FX: устанавливает отдельный плагин в обход 
Offline FX: устанавливает отдельный плагин в статус offline  
Delete FX: удаляет этот плагин из цепочки эффектов этого трека 
Rename FX instance: позволяет переименовать конкретный экземпляр плагина, но не сам плагин 
 
Панель микшера можно превратить в собственный микшерный пульт, добавив ваши собственные контроллеры 
непосредственно на панели треков микшера для этих параметров эффектов. Подробнее об этом в Главе 12.  
Давайте рассмотрим, как создать консоль микшера как на рисунке ниже. Обратите внимание на регуляторы для 
полосы 2 и 4 параметра Gain эквалайзера на каждом треке. 
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Пример: 
 
Для этого примера можно использовать один из ранее сохраненных файлов проекта. 
 
1. Откройте один из файлов проекта, например, All Through the Night MARKERS и сохраните его с именем All 
Through the Night MIXER. 
2. Откройте окно микшера. Открепите его от панели Docker (снимите флажок с опции Dock Mixer in Docker) и 
отрегулируйте ширину и высоту окна по усмотрению. 
3. В контекстном меню микшера отметьте опции Show FX inserts when size permits (показать инсерты, если 
позволяет размер) и Show FX parameters when size permits (показать параметры эффекта, если позволяет 
размер). 
4. Вставьте в первый трек плагин ReaEQ. 
5. Выберите полосу 3 (вкладки с номерами ниже дисплея). 
6. Щелкните по фейдеру Gain этой полосы, а затем нажмите кнопку Param, чтобы отобразить одноименное 
меню. 
7. Отметьте опцию Show in track controls. 
8. Выберите полосу 2 на странице параметров и щелкните по фейдеру Gain этой полосы. 
9. Нажмите кнопку Param, чтобы отобразить одноименное меню. Нажмите Show in track controls. Закройте 
окно плагина. 
 

 
 
10. Теперь в микшере вы увидите эти два контроллера для трека 1. Перетащите плагин ReaEQ с трека 1 в 
каждый из треков. Сохраните файл. 
 

Примечание 1: эти контроллеры можно также назначить и в самом микшере. Щелкните правой кнопкой 
по кнопке контроллера, а затем выберите плагин и параметр из контекстного меню (см. выше). Выберите 
All parameters, если вы хотите добавить контроллер каждого из параметров эффекта. 
 
Примечание 2: контроллеры добавляются на панель трека, а также на панель микшера. 
 
 
Примечание 3: когда мы будем рассматривать эту тему в Главе 12, вы увидите, что у нас в 
распоряжении есть несколько опций, позволяющих автоматически добавлять контроллеры в новые 
треки при их создании. 
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11.7. Работа с посылами в микшере 
 

Опция Show sends when size permits (показать посылы если позволяет 
размер) в контекстном меню микшера отображает текущие посылы с 
маленьким регулятором уровня громкости посыла непосредственно на 
панели микшера. Щелчок правой кнопкой мыши по посылу открывает 
контекстное меню (рисунок слева). Щелчок правой кнопкой мыши по 
пустой области посылов трека открывает меню с одной командой - Show 
track routing window (показать окно маршрутизации трека). 
Контекстное меню посылов можно отобразить щелчком по пустой области 
посылов трека.  

 
Show send parameters: открывает маленькое окно с параметрами посыла (громкость, панорама, и т.д.). 
Mute send: активирует/отключает статус мьютирования посыла. 
Remove send: удаляет посыл. 
Show track routing window: открывает окно маршрутизации трека. 
Go to send destination track (перейти к адресату посыла). 
Кроме этого меню, есть много других способов создания, редактирования и управления вашими посылами. 
Чтобы создать посыл можно перетащить кнопку Routing с одного трека в другой (как на панель трека, так и на 
панель микшера), но использование области посылов канального модуля микшера включает больше опций:  
 
Чтобы добавить посыл с одного трека в другой: перетащите посыл или кнопку Routing с одного трека в 
другой. В последнем случае откроется окно контроллеров посыла. 
Чтобы добавить посыл с одного трека в другой и открыть окно контроллеров этого посыла: Перетащите 
посыл или кнопку Routing с одного трека в другой с нажатой клавишей Ctrl. 
Чтобы добавить посыл с одного трека в другой и отключить посыл с первого трека в мастер-трек: 
перетащите посыл или кнопку Routing с одного трека в другой с нажатой клавишей Alt. Используйте этот способ 
для создания посылов с нескольких исходных треков в тот же самый трек-адресат, чтобы создать типичный 
подмикс. 
Чтобы добавить несколько посылов в один трек одним действием: выберите все треки с посылами. 
Захватите любой посыл на одном из выбранных треков и перетащите с нажатой клавишей Shift в трек-адресат. 
Чтобы добавить несколько адресатов в трек одним действием: выберите все треки, из которых должны 
прийти посылы. Удерживая клавишу Shift захватите кнопку Routing трека-адресата и перетащите ее на любой 
из выбранных треков. 
Чтобы скопировать посыл с одного трека в другой: перетащите посыл на другой трек. 
Чтобы удалить посыл: щелкните по посылу с нажатой клавишей Alt. 
Чтобы отобразить контекстное меню посыла: щелкните правой кнопкой мыши по посылу 
Чтобы открыть окно маршрутизации трека полностью: щелкните по посылу с нажатой клавишей Ctrl или 
щелкните по пустой области посылов или нажмите кнопку Routing. 
Чтобы открыть окно контроллеров посыла: щелкните по посылу. 
Чтобы отрегулировать уровень громкости посыла: используйте регулятор посыла. 
Чтобы активировать/отключить статус мьютирования посыла: щелкните по посылу с нажатой клавишей Shift. 
 
Обратите внимание на то, что в вышеупомянутом списке, действия с кнопкой Routing можно выполнить как на 
панели трека, так и на панели микшера. 
 

11.8. Отображение значков трека в микшере 
 

Опция Show track icons in Mixer (в контекстном меню микшера) позволяет отобразить 
любые значки трека. Значки трека выбираются с помощью команды Custom track 
icons> Set track icon в контекстном меню панели трека. Доступ к меню можно 
получить из микшера, щелкнув правой кнопкой по имени трека. 
 
 
 
 
 

 
11.9. Управление окном микшера 

 
Примечание: пример компоновки, используемый в рисунках в этой главе представлен исключительно 
для иллюстрации в целях изучения предмета обсуждения и не обязательно выглядит точно так же, как и 
ваша компоновка. 

 
Вы можете столкнуться с некоторыми проблемами компоновки элементов, когда захотите отобразить инсерты 
эффектов трека, посылы и так далее одновременно для всех треков, особенно если у вас их много.  
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Одна из опций отображения большего количества треков заключается в активировании опции Show multiple 
rows of tracks where space exists. Показанный здесь пример (рисунок ниже) иллюстрирует то, что может 
произойти при активировании этой опции. В данном примере недостаточно места для отображения всех 
эффектов и посылов трека.  
 
Есть две основные опции это исправить – изменить компоновку окна вручную или использовать более 
компактное расположение элементов микшера. 
 

 
 
11.9.1. Внесение изменений в компоновку окна вручную 
 

В данном примере если вы наведете курсор мыши на границу между областью эффектов и 
скрытой областью посылов какого-либо трека, курсор изменится на двухстороннюю 
стрелку, как показано на рисунке слева. Найти точную позицию курсора поначалу будет не 
легко, поэтому потерпите. Затем можно либо перетащить границу вверх или вниз для этого 
одного трека или удерживая клавишу Ctrl перетащить границу, чтобы изменить ее для 
всех треков. Результат показан на рисунке ниже. 
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Чтобы отрегулировать относительную высоту элементов только 
текущего трека: перетащите границу вверх/вниз 
Чтобы отрегулировать относительную высоту элементов всех 
выбранных треков: перетащите границу вверх/вниз с нажатой 
клавишей Alt. 
Чтобы отрегулировать относительную высоту элементов для 
всех треков: перетащите границу вверх/вниз с нажатой 
клавишей Ctrl.  
 
На рисунке слева мы отрегулировали границы между 
различными элементами (контроллерами трека и инсертами 
эффектов), чтобы отобразить все эффекты. Например, у трека 
#5 нет посылов, но дополнительное место было выделено для 
отображения полного списка эффектов трека. Затем мы внесли 
дальнейшие корректировки вручную - например, была поднята 
высота индикатора уровня громкости мастер-трека 
перетаскиванием его верхней границы. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

11.9.2. Темы оформления и компоновки элементов микшера 
 
Тема оформления по умолчанию REAPER включает несколько компоновок, пример некоторых из них показан в 
этой главе. Перечисленные на рисунке ниже компоновки включены в тему по умолчанию REAPER 5.  
 

 
 



 Специально для сайта musicmanuals.ru  215 215 

Кроме того, доступны и другие темы, у которых есть их собственные компоновки. Дополнительные темы можно 
загрузить со страницы stash.reaper.fm и установить, перетащив файл ReaperThemeZip в область аранжировки 
REAPER. Установленные темы можно выбрать из главного меню, используя команду Options > Themes. Затем, 
чтобы выбрать компоновку элементов микшера для треков: 
 
1. Выберите треки, компоновку которых вы хотите изменить.  
2. Щелкните правой кнопкой по имени любого из выбранных треков и выберите Set track layout > Mixer Panel и 
выберите элемент из меню. На рисунке ниже выбрана компоновка Strip Full Controls темы по умолчанию для 
Reaper 5. 
 

 
 

11.10. Контекстное меню панели канальных модулей микшера 
 
Функции, доступны на панели контроллеров трека обычно доступны и на панели канального модуля в микшере. 
Подробно эти функции рассмотрены в Главе 2. Например: 
 
- щелчок правой кнопкой мыши в свободной области или по имени трека на панели любого канального модуля в 
микшере отображает контекстное меню трека. 
- треки можно активировать для записи и в микшере. 
- щелчок по кнопке ROUTING трека отображает окно маршрутизации трека. Щелчок правой кнопкой мыши по 
кнопке ROUTING отображает контекстного меню маршрутизации этого трека. 
- щелчок по кнопке FX трека отображает цепочку эффектов этого трека. Щелчок правой кнопкой мыши по кнопке 
FX отображает контекстное меню. 
- щелчок правой кнопкой мыши по фейдерам Volume или Pan открывает окно Volume Control или Pan Law 
соответственно. 
- кнопки Record Arm, Record Monitoring и Select Record Mode на канальном модуле в микшере выполняют те 
же функции, что и на панели треков. 
- треки можно мьютировать или солировать и в окне микшера. Обе кнопки используют те же модификаторы 
мыши и имеют те же контекстные меню, что и на панели трека. 
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11.11. Знакомство со скринсетами окна 
 
Скринсеты (Screensets) окна могут использоваться для сохранения и загрузки компоновок элементов 
различных окон REAPER, включая компоновку области аранжировки, окна микшера, навигатора, матрицы 
маршрутизации/группировки, и других. Подробнее возможности скринсетов и примеры из применения мы 
обсудим в Главе 12. Использование скринсетов для сохранения различных комбинаций параметров микшера 
может оказаться полезным шагом к пониманию самой функциональности скринсетов. Они могут сэкономить 
время, потому что, чем больше вы используете REAPER, тем скорее вы придете к необходимости иметь три или 
четыре различных компоновок для использования их при различных обстоятельствах. Это будет зависеть, 
главным образом, от следующих факторов: 
Количество треков: ваша компоновка элементов микшера, вероятнее всего, будет отличаться для проекта с 
тремя или четырьмя треками от проекта с 20 или 30 треками. Для больших проектов, более вероятна 
необходимость отображения нескольких строк треков. 
Стадия проекта: информация, которую вам необходимо видеть в микшере, может изменяться соответственно, 
например, на стадии записи, стадии микширования и заключительном этапе работы над проектом. Скринсеты 
окна на глобальном уровне доступны во всех проектах. Они сохраняются в файле screensets.ini в папке 
Application Data\REAPER. Это означает, что можно использовать любой проект для создания скринсета, а 
затем использовать этот же скринсет с любым другим проектом. 
 
Чтобы создать скринсет: скомпонуйте окна, включая панель микшера и его различные элементы по 
усмотрению. Перейдите View > Screensets/Layouts (Ctrl+E) и выберите вкладку Windows. Щелкните по любому 
номеру, а затем нажмите кнопку Save, чтобы открыть окно Save Windows Screeenset.  
 

 
 
Отметьте нужные опции, например, позицию главного окна (Main window position), позицию главной панели 
инструментов (Tool window position) и т.д. и нажмите кнопку Save. Для загрузки скринсета можно назначить 
любую клавишу (например, F7 для загрузки скринсета № 1), или нажать Edit shortcuts, чтобы открыть список 
действий и назначить вашу собственную горячую клавишу. Список действий подробнее объясняется в Главе 15. 
 
Чтобы загрузить скринсет окна: Либо используйте горячую клавишу (если таковая назначена), либо 
перейдите View > Screensets/Layouts (Ctrl+E), выберите вкладку Windows и дважды щелкните по имени 
скринсета. 
 

11.12. Предварительные параметры отображения окна микшера 
 

На странице Preferences нет специального раздела Mixer, но есть несколько 
мест, где опции затрагивают как поведение самого микшера, так и его 
интерфейс. Одно из таких мест - окно Theme development/tweaker, доступное 
в списке действий. Перейдите Actions > Show action list, введите тег theme в 
строке фильтра, а затем выберите и запустите действие Theme development: 
Show theme tweak/configuration window (показать настройки 
темы/конфигурации окна). Список действий подробно объясняется в Главе 15.  
Щелкните по любому элементу в списке, выберите новый цвет из окна Color 

picker и нажмите OK. Используйте кнопку Save Theme, если вы хотите сохранить изменения.  
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На странице Options > Preferences > Appearance > Track Control Panels вы найдете несколько опций, которые 
можно использовать для настройки вида микшера с помощью цветовой кодировки. Это такие опции как Set track 
label background to custom track colors и Tint track panel backgrounds. Любые цвета выбранные с 
использованием команды контекстного меню Custom track colors (см. Главу 5), будет применены к канальным 
модулям в микшере. Примите во внимание, что эти опции не доступны при использовании некоторых тем 
оформления. Показанный ниже пример использует цвет и параметры темы по умолчанию.  
 

 
 
Если вы хотите изменить эти и другие элементы, один из способов заключается в использовании темы, 
позволяющей это сделать. Пример (который во многом напоминает тему по умолчанию) можно найти на 
странице http://stash.reaper.fm/theme/1621/Default%205.0%20Nitpicky%20Edition. Обратите внимание еще на одну 
опцию - Show in mixer на странице Options > Preferences > Project > Track/Send Defaults, которая по 
умолчанию отмечена. Это означает, что при добавлении новых треков они автоматически появятся и в 
микшере. 
 

11.13. Stereo и Dual панорамирование 
 
Два контроллера панорамирования - Stereo и Dual - обеспечивают расширенное управление 
панорамированием стереотрека. Правило (или режим) панорамирования (Pan Low) по умолчанию - stereo 
balance/mono pan - предусматривает один контроллер, который просто перемещает звук влево и вправо. 
Принимая во внимание, что  стереотрек состоит из двух каналов - левого и правого, выходной сигнал одного 
канала (верхняя часть сигналограммы) обычно панорамируется влево на 100%, сигнал второго канала (нижняя 
часть сигналограммы) панорамируется на 100% вправо. Используя контроллеры Dual или Width этот расклад 
можно изменить двумя способами.  

 
Контроллер Dual понять легче. Каждый из двух слайдеров управляет своим каналом.  
 

Контроллер Stereo в некотором отношении более тонкий.  
 

Контроллер Width можно использовать для настройки панорамы двух отдельных каналов 
стереоклипа, трек-папки или подмикса, а контроллер Pan для панорамирования общего 
микса влево или вправо. 
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11.13.1. Разница между контроллерами Dual и Stereo 
 
Чтобы отобразить контроллеры Dual или Stereo, щелкните правой кнопкой по фейдеру панорамирования и 
выберите соответствующий режим панорамирования.  
 

 
 
Скорее всего Вы захотите сделать это для трека, который содержит стереоклип, или который является трек-
папкой или функционирует в качестве шины или подмикса. 
 
Пример: 
 
В этом примере мы сначала создадим стереофайл, чтобы помочь нам в эксперименте с контроллером Width. 
Затем мы будем использовать его в подмиксе. 
 
1. Откройте файл All Through the Night.RPP и сохраните его с именем All Through the Night WIDTH.RPP. 
2. Мьютируйте все треки кроме треков Guitar Body и Bouzouki. 
3. Панорамируйте трек Guitar Body влево на 100%, а трек Bouzouki вправо на 100%. 
4. Перейдите File > Render. Убедитесь, что в области Channel выбрано значение Stereo, в меню Source 
выбрано значение Master mix и в меню Bounds выбрано значение Entire project. В качестве выходного 
формата в меню Output format выберите MP3 и отметьте флажок Add rendered items to new tracks in project. 
5. Нажмите кнопку Render 1 File. 
6. После нескольких секунд сконвертированный файл будет добавлен в качестве нового трека. Дайте треку 
подходящее имя. 
7. В этом сконвертированном треке гитара представляет аудиосигнал на одном канале, а греческая гитара на 
другом канале. 
8. Нажмите кнопку Solo и проиграйте этот трек. 
9. Поверните, не спеша контроллер Pan сначала полностью влево, затем полностью вправо, а затем назад в 
центр. Оцените результат.  
10. Выберите этот трек на панели треков, щелкните правой кнопкой по регулятору Pan и выберите режим Dual 
Pan из меню Pan mode. 
11. Проиграйте песню. Медленно переместите верхний слайдер на 100% вправо. Вы услышите оба инструмента 
только в правом динамике. 
12. Переместите нижний слайдер на 100%% влево. Теперь вы услышите гитару только в правом канале, а 
греческую гитару только в левом канале - противоположность того, с чего мы начали. 
13. Поэкспериментируйте с этими слайдерами. По окончании переместите верхний слайдер влево на 100%, а 
нижний слайдер на 100% вправо. Сохраните файл. 
14. Теперь измените режим панорамирования этого трека на Stereo Pan. 
15. Проиграйте песню. Сначала вы услышите в левом динамике только гитару, а в правом динамике только 
греческую гитару. Медленно переместите регулятор Width от 100% к центру (0W). Чем ближе будет позиция 
регулятора к центру, тем больше эти два инструмента будут смешиваться вместе. 
16. В значении регулятора Width 0W переместите регулятор Pan полностью влево. Теперь микс, который 
получился у нас в предыдущем шаге будет слышен только в одном динамике. Переместите регулятор Pan в 
центр и сохраните файл. 
 
Теперь попробуйте вот что: 
 
1. Не солируйте и не мьютируйте стереотрек. 
2. Создайте трек-папку с названием Instruments после трека Vocal. Выберите режим Stereo Pan для этой трек-
папки. 
3. Сделайте два трека гитары, и трек греческой гитары дочерними треками этой трек-папки. Отрегулируйте 
громкость и панораму отдельных треков и самой трек-папки по вашему усмотрению. Панорамируйте различные 
треки по максимуму. 
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4. Поэкспериментируйте с контроллером Width трек-папки, чтобы сблизить инструменты или отдалить их. 
Используйте контроллер Pan, чтобы переместить общий микс влево или вправо. При этом можно все еще 
регулировать панораму отдельных дочерних треков в пределах трек-папки. 
 

Совет: эта методика может делать чудеса при микшировании вокалов, включая вокальные дуэты и 
многоголосия! 
 

 
11.13.2. Режимы панорамирования 
 
По умолчанию ширина стереополя применяется перед контроллером панорамы/баланса. Чтобы выбрать другой 
режим панорамирования, щелкните правой кнопкой либо по регулятору Pan, либо по регулятору Width и 
выберите режим из меню: 
 

Stereo balance/mono pan: трек рассматривается как моно, даже если он 
содержит стереоклип. Центральная позиция контроллера гарантирует, 
что вы будете слышать тот же самый сигнал одинаково в обоих 
динамиках. Если повернуть регулятор до конца вправо, вы услышите 
сигнал только в правом динамике и наоборот. 
Stereo pan: позволяет управлять панорамированием и шириной 
стереополя раздельно. Панорамирование подразумевает, что 
стереополе установлено более влево или вправо, а ширина определяет 
насколько далеко друг от друга находятся левый и правый каналы в 
стереополе. В центральной позиции регулятора Pan и в значении 100% 
регулятора Width, вы услышите, что левый канал расположен в левом 
динамике, а правый канал в правом динамике. В центральной позиции 
регулятора Pan и в значении 0% регулятора Width, вы услышите оба 
канала одинаково в левом и в правом динамиках. В крайней правой 
позиции регулятора Pan вы услышите оба канала одинаково в правом 

динамике, независимо от позиции регулятора Width. 
Dual Pan: позволяет управлять обоими каналами раздельно. Левый регулятор (верхний слайдер) устанавливает 
левый канал более влево или вправо, а правый регулятор (нижний слайдер) устанавливает правый канал более 
влево или вправо. Когда левый регулятор повернут до конца влево, а правый регулятор повернут до конца 
вправо, вы услышите левый канал в левом динамике, а правый канал в правом динамике. Когда оба регулятора 
установлены в центр, вы услышите оба канала одинаково в левом и правом динамиках. Когда оба регулятора 
установлены до конца вправо, вы услышите оба канала одинаково в правом динамике. 
 

11.14. Опции и параметры мастер-трека 
 

Контроллеры мастер-трека в микшере выполняют те же функции, что и на панели 
треков. Обратите внимание на кнопку Output (по умолчанию на рисунке слева 
маркированную Mono): 
 
- щелкните левой кнопкой мыши по кнопке Output чтобы переключиться между 
режимами Stereo и Mono. 
- щелкните правой кнопкой мыши по кнопке Output, чтобы установить любой из четырех 
доступных режимов Mono (рисунок слева). 

- щелкните левой кнопкой мыши по кнопке FX, чтобы отобразить цепочку эффектов мастер-канала. 
- щелкните правой кнопкой мыши по кнопке FX, чтобы открыть контекстное меню добавления эффектов. 
- если цепочка эффектов мастер-канала в зоне видимости, можно использовать все и любую из горячих клавиш 
управления эффектом. 

 
щелкните правой кнопкой мыши по области индикатора выходного 
сигнала, чтобы отобразить параметры, которые можно 
использовать для управления тем, что будет отображаться на 
индикаторах и как (рисунок слева), включая опцию отображения 
выходного сигнала в мультиканальном режиме (например, работая 
со surround звуком). Отключение этой опции обеспечивает 
двухканальное представление. 
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11.15. Аппаратные выходные порты мастер-канала 
 

Выходной сигнал с мастер-трека можно направить на один 
или более доступных аппаратных выходных портов. Это 
можно сделать в матрице маршрутизации. Кнопка Routing 
мастер-канала (в микшере) может использоваться для 
настройки и управления аппаратными выходными портами 
или выходным сигналом. 
 
- щелкните правой кнопкой по кнопке ROUTING, чтобы 
отобразить меню опций аппаратных выходных портов. 
- щелкните левой кнопкой по кнопке ROUTING, чтобы 
отобразить окно выходных портов мастер-канала, которое 
может использоваться для управления уровнями и 
панорамой сигналов в аппаратных выходных портах. 
 
Заметьте, что для каждого выходного канала можно 
независимо установить любой из следующих параметров: 
 
- статус мьютирования.  
- инвертирование фазы. 
- уровень громкости.  
- позицию панорамы. 
 

 
11.16. Каналы мастер-трека 

 
Тема маршрутизации и разделения каналов встречается всюду в этом руководстве пользователя. По началу 
сама концепция относительно проста, но при кажущейся простоте она может превратиться во что-то более 
сложное. Каналы можно использовать для передачи двух копий одного сигнала в два различных 
местоположения. Затем к каждому сигналу отдельно можно применить разные вещи перед их последующим 
объединением. Ниже приведен относительно простой пример использования нескольких каналов (две 
стереопары) нашего мастер-трека. Эту конфигурацию можно использовать для подключения эффектов 
(например, ревербератора) в нашу цепочку сигнала, а затем направить эффект (и только эффект) в наушники 
(чтобы его оценить), и направив общий финальный микс в динамики. Чтобы работать с этим примером, нужна 
звуковая карта по крайней мере с четырьмя выходными аудиопортами. 
 
Пример: 
 

 
 
Этот пример почти наверняка окажется слишком сложным для новичков, и как таковой рекомендуется для более 
опытных пользователей. В противном случае, вы можете возвратиться к нему после изучения Главы 17. Схема 
выше иллюстрирует то, чего мы собираемся достигнуть. Сначала мы создадим дополнительные каналы для 
мастер-трека. Аудиосигнал, входящий в мастер-трек с микса, будет разделен между Каналами 1/2 и каналами 
3/4. В сигнал, который передается на каналы 3/4, будет вставлен плагин ревербератора, а затем 
непосредственно направлен в наушники. Этот сигнал будет также отправлен назад в компрессор, где будет 
смешан с исходным входным сигналом. После этого сигнал заключительного микса будет отправлен на 
динамики. 
 
1. Откройте файл All Through The Night. rpp и сохраните его под именем All Through The Night MASTER.RPP. 
2. Панорамируйте два трека гитары влево и вправо примерно на 40% соответственно. Панорамируйте трек 
Bouzouki влево приблизительно на 15%, и трек Vox вправо приблизительно на 10%. Быстро отрегулируйте 
уровни громкости каждого трека, избегая клиппирования мастер-трека. Сохраните файл. 
3. В контекстном меню микшера активируйте опции Show FX inserts when size permits (показать инсерты, 
если позволяет размер) и Show sends when size permits (показать посылы, если позволяет размер). 
4. Убедитесь, что динамики и наушники подключены к разным парам выходных портов звуковой карты. 



 Специально для сайта musicmanuals.ru  221 221 

5. Щелкните правой кнопкой по кнопке ROUTING мастер-трека и убедитесь, что выходной сигнал направлен и в 
динамики, и в наушники. 
6. Чтобы создать необходимые каналы, щелкните левой кнопкой мыши по кнопке ROUTING мастер-трека и 
установите количество каналов в 4 (как показано на рисунке ниже). 
 

 
 
7. Направьте выходной сигнал с каналов 1/2 на студийные динамики, а сигнал с каналов 3/4 в наушники.  
Ваши параметры должны выглядеть схожим образом как на рисунке, но конечно не идентично. 
8. Воспроизведите песню. На данный момент лучше прослушать результат в динамиках. 
9. В цепочку эффектов мастер-трека добавьте плагин ReaEQ и, в контексте данного примера, увеличьте 
параметр усиления (Gain) на 2 дБ на полосе 2, понизьте на 1 дБ на полосе 3, и увеличьте на 1 дБ на полосе 4. 
10. В цепочке эффектов мастер-трека щелкните чуть ниже ReaEQ и добавьте плагин ReaVerbate. Оставьте его 
параметры как есть, но отрегулируйте выходные сигналы с этого плагина так, чтобы они были направлены 
только на каналы 3 (левый канал) и 4 (правый канал) (рисунок ниже). 
 

 
 
11. Теперь воспроизведите песню. При воспроизведении через динамики сигнал будет включать эффект 
эквалайзера, но не ревербератора. Напротив, если вы будете прослушивать песню через наушники, вы 
услышите только ревербератор. 
12. Теперь щелкните в цепочке эффектов мастер-трека и добавьте плагин ReaComp после плагина ReaVerbate. 
Отрегулируйте параметры входного сигнала (Input Settings) этого плагина так, чтобы каналы 1 и 3 стали 
основными входными каналами для левого сигнала, а каналы 2 и 4 для правого сигнала, как показано на 
рисунке ниже. 
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13. Воспроизведите песню. Можно отрегулировать баланс ревербератора в миксе, используя вертикальные 
фейдеры Wet и Dry в окне плагина ReaVerbate. Можно также отрегулировать параметр Threshold 
(вертикальный фейдер слева) и параметры Ratio плагина ReaComp, если захотите. 
14. Ваши динамики будут теперь воспроизводить выходной сигнал цепочки эффектов мастер-трека с 
ревербератором. Ваши наушники будут все еще воспроизводить прямой сигнал плагина ReaVerbate. 
15. Сохраните файл. 
 

11.17. Предотвращение утечки канала 
 
Необходимо знать, что при использовании нескольких каналов для мастер-трека, любой сигнал, направленный 
параллельно с любыми каналами между треками, будет также отсылаться в мастер-трек. Например, вы можете 
использовать каналы 3/4 в одном или нескольких треках для какой-то другой цели. В этом случае, если бы вы 
также использовали каналы 3/4 для цели, обрисованной в вышеупомянутом примере, то сигнал на каналах 3/4 
ваших треков был бы также запитан в сигнал, направленный в плагин ревербератора. Этой утечки канала можно 
избежать просто, резервируя для мастера трек пару или несколько пар каналов, не используемых в другом 
месте проекта - в данном примере, вы могли бы использовать каналы 5/6 или каналы 11/12. Так как доступно до 
64 каналов, это не должно составить проблему. 
 

11.18. Сброс пиковых значений уровней индикаторов громкости 
 
Обратите внимание, что при воспроизведении, индикаторы громкости как на панели треков, так 
и на панели микшера отображают пиковый уровень, записанный для каждого отдельного трека 
(см. рисунок слева). Чтобы сбросить пиковые уровни любого отдельного трека, щелкните по 
области, где отображается пиковое значение. Чтобы сбросить пиковые показатели всех треков, 
щелкните по области, где отображается пиковое значение с нажатой клавишей Ctrl. При 
необходимости можно отключить опцию Options > Preferences > Appearance > VU 
Meters/Faders > Reset meter peak indicators on play/seek (сбрасывать пиковые значения 
индикатора при воспроизведении/переходе в назначенную позицию). После этого, текущие 
пиковые уровни будут фиксироваться, даже когда вы остановите воспроизведение. Когда вы 
возобновите воспроизведение, они будут сохранены как пиковые уровни до воспроизведения. 
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12. Функции глобального управления проектом 
 

12.1. Введение 
 
В этой главе мы прежде всего рассмотрим глобальные функции REAPER, которые используются для 
управления проектом в целом, не фокусируясь на отдельных треках или клипах. Эти функции включают 
использование диалогового окна Media/FX Bay, функции блокировки (Locking), изменения цветовой темы, 
использование менеджера треков, скринсеты и другие. А начнем мы с того, как можно изменить начальную 
позицию проекта. 

 
Примечание: некоторые рисунки в этой главе используют тему оформления REAPER 4 и ее цветовую 
тему. Тем не менее информация и инструкции, верны и для REAPER 5. 

 
12.2. Установка начальной позиции проекта 

 
Во многих проектах вы можете заметить, что перед фактическим началом песни есть несколько секунд тишины. 
Это может создать две досадные проблемы: 
 
- временные позиции на шкале времени и в окне Big Clock не совпадают с временными позициями песни. 
- когда вы перейдете в начало проекта, всегда будут несколько секунд тишины, которые мешают началу 
фактической песни.  
 

 
 
В примере, показанном выше фактическая песня начинается в позиции 0:04.701. Мы хотим сбросить эту 
позицию в 0. Для этого: 
 
1. поместите курсор в точку, которую вы хотите отметить как начало песни - в примере, показанном выше, это 
будет отметка 04.607. 
2. Нажмите Alt+Enter, чтобы отобразить окно Project Settings. 
3. Выберите вкладку Project Settings. 
4. Нажмите кнопку Set 0:00 to edit cursor (см. рисунок ниже). REAPER автоматически определит правильную 
позицию в области Project start time. 
 

 
 
5. Нажмите OK, чтобы закрыть окно Project Settings. 
 
Если вы хотите отметить эту точку, нажмите клавишу М, чтобы создать маркер на шкале времени под номером 
1. Если необходимо обновить информацию о маркерах, обратитесь к Главе 9. Теперь позиция маркера 
установлена в значение 0:00.000, и вы можете перейти прямо к этой точке в любое время, нажав клавишу 1 на 
клавиатуре (см. рисунок ниже). 
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При необходимости можно дважды щелкнуть по маркеру, чтобы открыть диалоговое окно Edit marker, где 
можно дать ему имя. 
 

12.3. Обрезка проекта по границам выделенного фрамента 
 
При записи зачастую перед самим сонгом вставляется период тишины, и/или период тишины вставляется в 
конце треков. Вы можете это исправить пошаговым редактированием треков по-отдельности, а затем 
перетащить их в начало шкалы времени. Более быстрый способ заключается в использовании опции Crop 
project to selection, который позволяет удалить лишнее место. Для этого сначала выделите область, которую 
вы хотите оставить. Затем щелкните правой кнопкой мыши по шкале времени и выберите опцию Crop project to 
selection из меню. При необходимости используйте клавишу Esc, чтобы снять выделение с области. 
 

Совет: если сразу же после обрезки (и перед тем, как нажать Esc) вы щелкните правой кнопкой мыши 
по шкале времени и выберите опцию Zoom selection из контекстного меню (или используйте горячие 
клавиши Ctrl+клавиша "плюс" на цифровой клавиатуре), ваш проект расширится по горизонтали под 

ширину окна трека. 
 

12.4. Блокировка клипов (функция Locking) 
 
Позиции отдельных клипов можно блокировать в целях предотвращения их случайного перемещения или 
удаления, оставляя возможность управлять другими параметрами клипа. Чтобы использовать эту функцию, 
перейдите Options > Preferences > Appearance > Media и убедитесь, что отмечены значки Locked и Not locked 
для клипа (наряду с любыми другими значками клипа, которые вы хотите использовать).  
 

 
 

Где будут отображаться эти значки - поверх клипа или выше 
его (как на рисунке слева) будет зависеть от статуса опции 
Draw item labels above rather than within the item 
(отображать информацию о клипе выше него) на той же 

странице. Чтобы активировать/отключить непосредственно блокировку отдельных клипов, щелкните по 
маленькому символу замка в верхнем левом углу клипа. В примере выше изображен трек с двумя клипами. 
Первый клип блокирован (сам клип затенен, а символ замка яркий). Теперь он не может быть удален или 
перемещен, пока не будет разблокирован. Также вы не сможете использовать хэндл громкости наверху клипа, 
не сможете добавить к клипу фейдинг и не сможете применить к нему slip-редактирование. Тем не менее можно 
внести изменения в большинство его параметров в диалоговом окне Item Properties или в контекстном меню 
клипа. Второй клип на рисунке не блокирован (сам клип яркий, а символ замка затенен). Его можно перемещать 
или удалять, или добавить фейдинг. Клип для редактирования можно открыть в MIDI редакторе (для MIDI 
клипов) или во внешнем редакторе (для аудиоклипов). Блокировать/разблокировать можно несколько клипов. 
Для этого с нажатой клавишей Ctrl выделите нужные клипы, а затем щелкните по значку замка любого из 
выделенных клипов. 
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12.5. Блокировка контроллеров трека 
 
Переключаемая команда Lock Track Controls (в контекстном меню панели контроллеров трека) может 
использоваться для блокировки/разблокировки контроллеров любого трека или нескольких выбранных треков в 
целях предотвращения случайных изменений любого контроллера трека (например, регуляторов Volume или 
Pan).  
 

 
 
На рисунке выше изображены два трека, контроллеры верхнего трека блокированы. Можно навести мышь на 
контроллер блокированного трека, чтобы посмотреть его текущее значение во всплывающей подсказке (как на 
рисунке выше). 
 

12.6. Параметры блокировки проекта 
 
Функция блокировки REAPER может использоваться для эффективной "заморозки" определенных аспектов 
проекта в целях предотвращения их случайных изменений или удаления. Для этого: 
 
1. Выберите, какие именно клипы проекта вы хотите блокировать. 
2. Активируйте блокировку с помощью флажка Enable locking в окне Lock Settings и отключите ее клавишей L. 

 
Чтобы отобразить окно Lock Settings (на рисунке слева), нажмите 
горячую клавишу Shift +L или щелкните правой кнопкой мыши по кнопке 

 (последняя кнопка на главной панели инструментов). Список ниже 
суммирует элементы, изменение которых можно предотвратить. 
Отметьте соответствующие флажки, элементы которых вы хотите 
блокировать, а затем отметьте флажок Enable locking. 
 
 
 
 
 
 
 
 
 
 
 

Time selection: блокирует выделенную область. С блокированной области можно снять выделение, нажав 
клавишу Esc, а затем в окне запроса нажать Yes. 
 

 
 
Loop points: блокирует выбранные в настоящее время границы лупа. 
Items full: если эта опция отмечена, в любой из существующих клипов внести любые изменения нельзя будет 
вообще. Например, вы не сможете мьютировать клипы, добавить к ним эффекты, удалить их, переместить, 
применить slip-редактирование, и даже получить доступ к диалоговому окну Item Properties или контекстному 
меню любого из ваших клипов. 
Items (prevent left/right movement): эта опция позволяет вносить любые изменения, кроме перемещения 
клипов влево или вправо. 
Items (prevent up/down movement): эта опция позволяет вносить любые изменения, кроме перемещения 
клипов вверх или вниз. 
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Item edges: эта опция предотвращает slip-редактирование. 
Item fade/volume handles: эта опция предотвращает любые изменения хэндла громкости или регулятора 
любого клипа. 
Item stretch markers: эта опция предотвращает любые изменения или перемещения со stretch маркерами 
любого клипа. 
Item envelopes/Track envelopes: эта опция предотвращает любые изменения огибающих клипов/трека. 
Например, вы не сможете переместить или добавить узлы, или изменить форму огибающей. Но вы можете 
добавить новые огибающие для фейдеров и параметров плагинов, но без возможности их редактирования. 
Подробнее об огибающих в Главе 18. 
Regions: эта опция предотвращает любые изменения текущих регионов. Тем не менее создавать новые 
регионы можно. 
Markers: эта опция предотвращает любые изменения текущих маркеров. Тем не менее создавать новые 
маркеры можно. 
Time Signature Markers: эта опция предотвращает любые изменения текущих маркеров музыкального размера. 
 
Пример: 
 
Предположим, мы выстроили наши клипы, и не хотим, чтобы какой-то из клипов был случайно смещен или 
перемещен влево, или вправо. Для этого мы можем заблокировать их горизонтальную позицию. 
 
1. Нажмите Shift +L, чтобы открыть окно Locking Settings. 
2. Отметьте только опцию Items (prevent left/right movement). 
3. Если флажок Enable Locking не отмечен, отметьте его. 
4. Теперь попробуйте перетащить любой из клипов влево или вправо. Он не переместится. 
5. Нажмите клавишу L, чтобы снять блокировку. 
 

12.7. Выбор тем оформленияи настройка цветов и шрифтов 
 
В Главе 15 подробно рассматривается список действий REAPER. Одно из действие, которое вы могли бы счесть 
полезным - Actions > Show action list > Theme development: Show theme tweak/configuration window. В 
списке действий в области фильтра введите слово theme, а затем выберите и запустите (кнопка Run) действие 
Theme development: Show theme tweak/configuration window.  
 

 
 
Темы состоят прежде всего из трех типов элементов: файлов изображений, определений цветов/шрифтов и 
параметров окна. Файлы изображений обеспечивают, например, значки элементов управления трека и 
медиаэлементов. Определения относятся к таким элементам, как шрифт, используемый для имен трека и 
цвета, используемые для медиаэлементов, панели трека и панели микшера, курсоров воспроизведения и 
редактирования, маркеров, индикаторов уровней, огибающих, и так далее. Если вы не уверены в выборе 
перечисленных элементов, можно использовать поисковик Theme element. Чтобы отобразить его, ведите строку 
theme в окне фильтра списка действий, а затем выберите и запустите действие Theme development: Show 
theme element finder.  
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В дополнение к установленным темам в REAPER, много тем доступно на странице stash.reaper.fm. Чтобы 
установить загруженный ReaThemeZip файл, перетащите его из проводника системы в область аранжировки 
REAPER. Кнопка Load Theme (в диалоговом окне Theme development/tweaker) может использоваться для 
выбора любой доступной темы. Прокрутите список Theme color/font settings и ознакомьтесь со всеми 
элементами, которые можно изменить. Щелкните по любому элементу, чтобы открыть (при необходимости) его 
палитру цветов или диалоговое окно изменения шрифта. Наконец, выбрав шрифт и цвет, можно сохранить 
отредактированную тему в новую, нажав кнопку Save theme и дав теме новое имя. 
 

12.8. Диалоговое окно Project Media/FX Bay 
 
12.8.1. Общий обзор 
 
Диалоговое окно Project Media/FX Bay - это универсальный центр, который можно использовать для 
управления эффектами и клипами проекта. Чтобы открыть окно Project Media/FX Bay, перейдите View > Project 
Media/FX Bay.  
 

 
 
Окно включает пять вкладок (страниц). Со страницами Item Groups (Глава 7) и Take Comps (Глава 8) мы уже 
встречались. Другие три страницы: 
 
Source Media: перечисляет клипы, доступные для использования или уже используемые в проекте.  
В этом списке каждый клип перечислен только один раз. Если этот клип используется несколько раз  
в проекте, он будет обозначен номером в столбце Usage. 
Media Items: перечисляет только те клипы, которые фактически используются в проекте (т.е., активные).  
В этом списке клип перечисляется столько, сколько он используется в проекте. 
FX: перечисляет плагины эффектов, которые используются в проекте. 
 
Вы можете перетащить медиафайлы (например, из браузера клипов REAPER (Media Explorer) или из 
проводника системы) или эффекты (например, из браузера эффектов) в окно Project Bay. Клип, вставленный 
таким образом, добавляется на страницу Source Media. Если клип будет затем использоваться в проекте, он 
будет добавлен на страницу Media Items. Эффекты добавляются на страницу FX. В пределах окна Project Bay 
можно переименовать клипы, выбрать все копии медиафайла или эффекта в пределах проекта, и заменить 
клипы/эффекты в проекте любыми другими клипами/эффектами из окна Project Bay. Можно также 
мьютировать/солировать клип и установить/снять статус обхода эффектов. Страницы Media Items и FX 
включают столбец Retain. Когда вы перетаскиваете клип или эффект в окно Project Bay, они помечаются 
значком + в столбце Retain. Эта означает, что запись останется в окне Project Bay даже если эти клипы или 
эффекты не будут использоваться в проекте. Когда вы добавляете клип (записав или вставив) в проект, он 
вносится в список страниц Media Items и Source Media с не активированным статусом сохранения (retain 
status). Эти записи будут автоматически удалены из окна Project Bay, если они будут удалены из самого 
проекта. Если вы хотите, чтобы записи остались в окне Project Bay, даже если они будут удалены из проекта, 
необходимо активировать их статус сохранения на странице Source Media. Эффекты на странице FX включают 
столбец Preset. Если вы измените пресет (stock) в этом столбце (из контекстного меню), все копии этих 
эффектов в проекте с предыдущим выбранным пресетом будут изменены на новый пресет. Кроме того, можно 
сохранить эффект с определенным пресетом или несколько копий того же самого эффекта с различными 
пресетами. Окно Project Bay включает кнопки Actions и Options. Щелчок по любой из них открывает 
соответствующее меню. Рассмотрим меню Options. Большинство команд этого меню требует разъяснения. 
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Mirror selection in bay and project: если эта 
опция отмечена, клип, выбранный в проекте 
также будет выбран в окне Project Bay и 
наоборот (зеркальный выбор).  
Zoom/scroll to selected media items when 
mirroring selection: если эта опция 
отмечена, REAPER перейдет и масштабирует 
выбранный клип при зеркальном выборе.  
Use last selected item as source for “draw a 
copy” mouse action: позволяет использовать 
режим карандаша для создания копий 
последнего выбранного клипа.  
Space bar previews media: позволяет 
использованию клавишу Пробел для 
воспроизведения текущих выбранных клипов 
или их источников.  
Loop media preview: позволяет применить 
любой луп, маркированный в проекте.  
Preview through selected track: позволяет 
воспроизвести клип, например, с любыми 
эффектами в цепочке эффектов конкретного 
трека или любыми огибающими трека.  

Filter On: фильтр может использоваться в поиске имени, пути к файлу или комментарию.  
Clear bay when changing projects: если эта опция отмечена, у каждого проекта будет свое собственное окно 
Project Bay. Если эта опция не отмечена, клипы текущей страницы будут использоваться в другом открытом 
или созданном проекте.  
Automatically retain media items when they are removed from project: если эта опция отмечена, статус 
сохранения будет назначен автоматически при удалении клипа из проекта.  
Dock project bay: прикрепляет окно Project Bay на панель Docker.  
Close window: закрывает окно Project Bay.  
 
Теперь давайте рассмотрим команды меню Actions. Они могут использоваться с клипами или эффектами и 
относиться к ним на любой странице окна Project Bay, где эти клипы в настоящий момент выбраны. 
 

 
 
New project bay window: открывает новое окно Project Bay. Это окно затем можно использовать, например, 
для загрузки других сохраненных окон Project Bay, оставляя исходное окно открытым в исходном окне.  
Create new folder: создает папку в пределах списка. Отдельные элементы списка окна Project Bay можно затем 
перетащить в эту папку или из этой папки. На рисунке ниже была создана папка Gtr, куда были помещены 
соответствующие клипы). Папки можно использовать для исходных клипов (как показано на рисунке ниже), 
клипов в проекте или эффектов. Чтобы развернуть/свернуть папку, щелкните по значку слева от имени. 
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Force refresh: обновляет отображение окна Project Bay.  
Select all items: выделяет все клипы текущей вкладки.  
Retain all items: активирует статус сохранения всех клипов текущей вкладки, даже когда они удаляются из 
проекта. 
Remove all items from project: удаляет все клипы из проекта.  
Remove all items that are not used in project: удаляет из вкладки Media Items все клипы, которые не 
используются в проекте.  
 
Кнопка Media Explorer (внизу слева от списка) открывает браузер клипов, откуда можно перетащить клипы в 
окно Project Bay (в качестве источника клипа) или в сам проект. Регулятор Volume (внизу справа) управляет 
громкостью любого прослушиваемого клипа, если опция прослушивания через выбранный трек отключена. 
Кнопка Bay (внизу слева) выполняет три основные функции. Ее можно использовать для создания нового окна 
Project Bay, заменить содержимое текущего окна содержимым ранее сохраненного окна или объединить 
содержимое ранее сохраненного окна с текущим.  
 
12.8.2. Страницы Source Media и Media Items 
 
Действия с клипами на обеих страницах очень похожи. Основные отличия: 
 
1. Клипы, добавленные в окно Project Bay, помещаются только на страницу Source Media до тех пор, пока они 
фактически не будут добавлены в проект. Затем они автоматически добавляются на страницу Media Items. 
2. Только активные клипы (и тем самым включенные в проект) отображаются на странице Media Items. 
3. Активными клипами можно управлять с любой из этих страниц. Доступными клипами можно управлять только 
со страницы Source Media. 
 
Чтобы изменить порядок столбцов: перетащите заголовок столбца влево/вправо. Это действие доступно на 
любой из пяти страниц окна Project Bay. 
Чтобы скрыть/отобразить столбцы: щелкните правой кнопкой по любому заголовку и отметьте/снимите 
флажок с любого названия заголовка. 
Чтобы добавить клип на страницу Source Media: перетащите клип из проводника системы или браузера 
клипов. Можно перетащить как клип целиком (используя браузер клипов), так и выделенную область клипа. 
Чтобы прослушать клип: выберите клип и нажмите клавишу Пробел. 
Чтобы добавить клип со страниц Source Media или Media Items в проект: либо перетащите его со страницы 
в область аранжировки проекта, либо выберите трек и установите позицию курсора в области аранжировки и 
щелкнув правой кнопкой мыши по имени клипа на странице выберите опцию Insert into project (вставить в 
проект) из контекстного меню. Если статус сохранения этого клипа был не активирован, после этого действия 
он активируется. 
Чтобы удалить клип из проекта: в области аранжировки или на странице Media Items выберите клип и 
нажмите клавишу Delete. 
Чтобы удалить неактивный клип со страницы Source Media: выберите клипы и нажмите клавишу Delete, или 
щелкните правой кнопкой по клипу в столбце Retain (налево от имени клипа) и выберите опцию Remove from 
bay. 
Чтобы удалить все неиспользуемые клипы со страницы Media Items: щелкните правой кнопкой по строке 
заголовка и выберите опцию Remove all items that are not used in project из контекстного меню. 
Чтобы снять статус сохранения с активного клипа: выберите клип на странице, щелкните правой кнопкой 
мыши в столбце Retain и выберите опцию Remove from bay if removed from project. 
Чтобы удалить все копии клипа из проекта: щелкните правой кнопкой по клипу в столбце Retain и выберите 
опцию Remove from project. 
Чтобы переназначать статус сохранения активному клипу: выберите клип на странице, щелкните правой 
кнопкой мыши в столбце Retain и выберите опцию Retain из меню. 
Чтобы определить местоположение клипа, перечисленного на страницах Source Media или Media Items в 
проекте: щелкните по клипу в списке, а затем нажмите кнопку Usage. Щелкните по любому клипу в том списке, 
чтобы перейти и выбрать этот клип. 
 

 
 
Чтобы мьютировать клип в проекте: щелкните правой кнопкой по клипу и выберите опцию Mute из 
контекстного меню (опция переключаемая). 
Чтобы переименовать любой клип: выберите клип на странице и нажмите кнопку Rename или используйте 
соответствующую команду контекстное меню. 
Чтобы добавить комментарий к клипу: дважды щелкните по столбцу Comments клипа. 
Чтобы отфильтровать список клипов: введите строку в области Filter (например, Vox, чтобы отобразить 
только те клипы, которые включают слово Vox в их имени), а затем нажмите кнопку Refresh. 
Чтобы очистить фильтр: нажмите кнопку Clear Filter. 
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Чтобы заменить клип на страницах Source Media или Media Items другим клипом: выберите клип на 
странице, щелкните правой кнопкой мыши по нему и выберите опцию Replace in project. Затем выберите из 
меню, например, All instances (все копии) или любую одну копию для замены. Формат данных (например, MP3, 
WAV) не обязательно должен быть одинаковым для обоих клипов. 
Чтобы сохранить список клипов страницы (например, для возможного применения в других проектах): 
выберите клипы, а затем нажмите кнопку Save и выберите одну из доступных опций: Save selected items to a 
new project bay (сохранить выбранные клипы в новом окне Project Bay) или Save all items as a new project bay 
(сохранить все клипы в новом окне Project Bay). Доступна также опция Save and merge selected items to an 
existing project bay file (сохранить и объединить выбранные клипы в текущий ReaBay файл). В этом случае 
необходимо выбрать нужный файл из списка. 
Чтобы загрузить ранее сохраненный список клипов: нажмите кнопку Bay, выберите ReaBay файл из списка. 
Вы можете загрузить и объединить список с текущим списком, или заменить текущий список. 
Чтобы отсортировать список клипов: щелкните по любому заголовку столбца. 
 
12.8.3. Страницы FX Bay и FX Parameter Bay 
 
Большинство команд страницы FX совпадают с таковыми на странице Media Items, например, определение 
статуса сохранения, применение фильтров, создание и использование папок, и удаления клипов. В данном 
примере показаны три папки, используемые для организации эффектов. Список ниже выделяет те аспекты, 
которые по большей части подходят и для страницы FX. 
 

 
 
Чтобы добавить эффект со страницы FX в трек или в клип в проекте: либо выберите трек или клип в 
области аранжировки, щелкните правой кнопкой мыши по имени плагина на странице FX и выберите опцию 
Insert into project. Либо перетащите плагин со страницы FX на панель трека или на клип. 
Чтобы открыть окно браузера эффектов: нажмите кнопку FX Browser. 
Чтобы добавить эффект на страницу FX: перетащите эффект с браузера эффектов. 
Чтобы определить местоположение и открыть окно эффектов любой копии эффекта: щелкните правой 
кнопкой по имени трека, или номеру в столбце Track, а затем щелкните по копии. Для этого можно использовать 
кнопку Usage. 
Чтобы переключить любые эффекты в статус обхода или статус offline: выберите эффект, а затем 
выберите опции Bypass или Offline из контекстного меню соответственно, или используйте кнопку Bypass (Shift 
+щелчок для команды Offline). 
Чтобы выбрать пресет для эффекта (см. примечание ниже списка): щелкните правой кнопкой мыши по 
столбцу Preset для эффекта и выберите пресет из меню. 
Чтобы управлять любым параметром эффекта: щелкните правой кнопкой мыши по имени эффекта и 
перейдите FX parameters > FX parameters list, выберите функцию, а затем выберите параметр из списка. 
Подробнее об этом в Главе 19. 
Чтобы сменить пресет для копии эффекта: щелкните правой кнопкой мыши по столбцу Preset эффекта и 
выберите пресет из меню. 
Чтобы заменить эффект другим эффектом: щелкните правой кнопкой мыши по имени эффекта, выберите 
опцию Replace in project, а затем выберите из выпадающего меню эффект. Можно заменить как все копии, так 
и одну копию. 
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Примечание: некоторые имена эффектов могут встретиться несколько раз в списке. На примере выше, 
плагин ReaComp встречается дважды. Это вызвано тем, что на один из этих экземпляров был назначен 
пресет. Это позволяет вам управлять этими эффектами по отдельности. Пресет Modern vocal был 

применен к одному экземпляру эффекта ReaComp на треке Vox. 
 
Рядом с вкладкой FX в окне Project Bay присутствует вкладка FX Parameters. Она используется для 
управления различными функциями параметров эффекта, такими как огибающие, режим Learn и модуляция 
параметров. Подробнее эту страницу мы рассмотрим в Главе 19, обсуждая модуляцию параметров. 
 

12.9. Менеджер треков 
 
Менеджер треков (View > Track Manager) выглядет как таблица со списком всех треков проекта.  
 

 
 
Если таблица пуста, нажмите кнопку Show All. Щелчок по кнопке Options или щелчок правой кнопкой мыши по 
строке заголовка открывает меню, которое включает опцию Mirror track selection. Если эта опция активирована, 
выбор любого трека в менеджере треков автоматически выберет его на панели треков и наоборот (зеркальный 
выбор). Если отмечена опция Scroll to selected track when mirroring selection и при условии, что отмечена 
опция Mirror track selection щелчок на имени трека в менеджере треков сфокусирует этот трек на Панели 
треков в области аранжировки и Панели канальных модулей в микшере. Если проект включает трек-папки с 
дочерними треками, эта иерархия сохраняется в пределах менеджера треков. Обратите внимание на опцию 
Indent tracks in folders. Если она отмечена, имена дочерних треков в трек-папках будут отображаться в 
менеджере треков сдвинутыми вправо (на рисунке треки Bouzouki и Gtr Neck). Сравните:  
 

  
 
Другие элементы меню кнопки Options будут объяснены в их контексте и контексте списка возможных действий 
в окне менеджера треков ниже. 
 
Чтобы изменить порядок столбцов: перетащите заголовок столбца влево или вправо 
Чтобы скрыть/отобразить столбцы: щелкните правой кнопкой мыши по любому заголовку, и 
отметьте/снимите флажок с элемента в списке. 
Чтобы отрегулировать ширину столбца: перетащите левую или правую границу между заголовками 
столбцов, 
Чтобы отфильтровать список треков по имени: введите слово в области фильтра: например, «vo», чтобы 
перечислить в менеджере только те треки, имя которых включает буквенное сочетание vo. Поддерживается 
использование операторов NOT и OR: например, строка “bass OR guit” отобразит все треки либо с именем 
bass, либо с именем guit в качестве части их имени трека.  
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С областью фильтра используются две соответствующие команды меню Options: Hide filtered-out tracks in 
TCP (скрыть все остальные треки, кроме определенных в области фильтра на Панели трека) и/или Hide 
filtered-out tracks in mixer (скрыть все остальные треки, кроме определенных в области фильтра в 
микшере). Кнопка Clear очищает область фильтра.  
Доступна также опция Display child tracks if folder parent is displayed (показать дочерние треки, если 
отображается родительская трек-папка).  
Если вы отметили опцию Close track manager on enter key in filter box (закрыть менеджер треков нажатием 
клавиши Enter в области фильтра) в меню Options, щелчок по кнопке Enter в области фильтра автоматически 
закроет менеджер треков. 
Чтобы изменить порядок треков как в менеджере, так и на панели треков: перетащите треки вверх или вниз. 
Это поведение можно отменить, отключив опцию Allow reordering tracks via track manager из контекстного 
меню. 
Чтобы удалить трек: щелкните по строке трека и нажмите клавишу Delete. Подтвердите действие в окне 
запроса. 
Чтобы отобразить/скрыть мастер-трек: используйте опцию Show master track in track manager в меню 
Options. 
Чтобы отобразить/скрыть треки в столбцах TCP/MCP: щелкните по строке трека в столбцах TCP/MCP. 
Можно использовать переключаемую опцию Link TCP/Mixer visibility для синхронизации отображения треков. 
Поддерживается функция Swipe (см. последнюю строку списка). 
Чтобы прокрутить трек в окне: дважды щелкните по номеру трека в столбце #. 
Чтобы установить/изменить цвет трека: щелкните по цветному квадрату в столбце слева от номера трека. 
Чтобы открыть/отобразить цепочку эффектов трека: столбец FX отображает количество эффектов в 
цепочке каждого трека. Чтобы отобразить цепочку, дважды щелкните по этой ячейке. 
Чтобы добавить эффекты в трек или открыть окно эффектов: щелкните правой кнопкой по FX трека и 
используйте контекстное меню. 
Чтобы открыть/отобразить цепочку предварительно установленных эффектов трека (см Параграф 3.26): 
столбец IN-FX отображает количество предварительно установленных эффектов. Чтобы отобразить цепочку, 
дважды щелкните по этой ячейке. 
Чтобы отследить компенсацию задержки плагина: любая компенсация задержки плагина, используемая 
эффектами трека, будет обозначена (в мс) в ячейке столбца PDC трека. Щелчок по этой ячейке 
активирует/отключает статус обхода эффектов трека. 
Чтобы активировать для записи/деактивировать трек: щелкните по ячейке трека в столбце R любого трека 
(треков). Активированные треки обозначаются буквой R. Щелкните еще раз, чтобы деактивировать трек. 
Поддерживается функция Swipe. Щелчок правой кнопкой мыши по любой ячейке в этом столбце отображает 
контекстное меню с опциями записи этого трека. 
Чтобы мьютировать/размьютировать трек: щелкните по ячейке трека в столбце M. Все клавиши-
модификаторы, используемые на панели трека, могут использоваться и здесь - например, щелчок с нажатой 
клавишей Ctrl размьютирует все треки. Щелчок правой кнопкой мыши на ячейке столбца M открывает 
контекстное меню с опциями мьютирования - см. Главу 5. Поддерживается функция Swipe. 
Чтобы солировать/снять статус солирования трека: щелкните по ячейке трека в столбце S. Все клавиши-
модификаторы, используемые на панели трека, могут использоваться и здесь - например, щелчок по ячейке с 
нажатой горячей клавишей Ctrl+Alt позволяет солировать трек в монопольном режиме. Щелчок правой кнопкой 
мыши на ячейке столбца S открывает контекстное меню с опциями солирования - см. Главу 5. Поддерживается 
функция Swipe. 
Чтобы зафиксировать/разблокировать контроллеры трека: щелкните по ячейке трека в столбце Lock. 
Зафиксированные треки отображаются со значком +. Поддерживается функция Swipe. 
Чтобы открыть доступ к управлению MIDI клипами: дважды щелкните по ячейке MIDI трека, чтобы открыть 
MIDI клипы трека в новом окне MIDI редактора. Если клип уже открыт, дважды щелкните, чтобы закрыть окно.  
Щелкните правой кнопкой по ячейке трека столбца MIDI, чтобы открыть контекстное меню опций: Open in new 
MIDI editor (открыть в новом окне MIDI редактора), Open in existing MIDI editor (открыть в текущем окне 
MIDI редактора), Open in existing MIDI editor (clear editor first) (открыть в текущем окне MIDI редактора и 
предварительно очистить редактор) или Remove from MIDI editor (удалить из MIDI редактора). 
Чтобы переключить свободное расположение клипов: щелкните по ячейке трека в столбце FIPM. 
Активированные треки помечаются значком +. Поддерживается функция Swipe. 
Чтобы заморозить/разморозить треки: выделите трек (треки) в менеджере, а затем выберите действие из 
меню кнопки Freeze. См. также Главу 6. 
Чтобы отсортировать список треков: щелкните по любому заголовку столбца. 
Чтобы управлять группами треков: менеджер треков поддерживает параметры группировки треков (Глава 5). 
Как и в случае с матрицей группировки треков, можно использовать клавишу Shift, чтобы временно отменить 
группировку. 
Чтобы применить функцию Swipe к нескольким смежным трекам: например, чтобы активировать для записи 
несколько смежных треков, или мьютировать несколько смежных треков, щелкните по ячейке определенного 
столбца одного трека и не отпуская кнопку мыши переместите мышь вверх/вниз. 
В примере, показанном ниже, только треки и трек-папки Vocal и Acoustic Guitar отображаются на панели трека. 
Все треки отображаются в микшере. Контроллеры трек-папки Vocals зафиксированы. Треки Vox Lead и Vox 
Harmy солированы и для них активировано свободное расположение клипов. Трек Reverb использует 
компенсацию задержки в 512 мс. Треки 2, 3, 5, 6, и 11 заморожены, трек 11 дважды. 
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Совет: можно использовать окно Screensets, чтобы сохранить различные установки параметров 
менеджера треков в качестве представления треков, любой из которых можно загрузить в любое время. 
Скринсеты объясняются позже в этой главе. 

 
12.10. Скринсеты треков 

 
Скринсеты (ScreenSets) позволяют сохранить несколько различных окон проекта так, чтобы можно было легко 
выбрать и загрузить их при редактировании или компоновке. Есть два типа скринсетов - скринсеты треков (Track 
Views Screen Sets) и скринсеты окон (Windows Screen Sets). Скринсеты треков создаются и сохраняются на 
уровне проекта - данные скринсета хранятся в файле проекта и их можно загрузить только если вы работаете с 
этим файлом проекта. Использование скринсетов треков может быть особенно полезным случае 
редактирования или при тесной работе с клипами. Скринсеты окна - глобальны и сохраняются в папке 
Application Data в файле screensets.ini. Их можно загрузить и применить в любом файле проекта. Процедура 
создания скринсетов треков: 
 
1. Перейдите View > Screensets/Layouts, чтобы отобразить окно Screen Sets (Ctrl+E).  
 

 
 
Окно Screen Sets можно прикрепить/открепить на панель Docker, чтобы оно всегда было поверх других окон. 
 
2. Настройте расположение треков по усмотрению. 
3. Выберите номер на странице Track views окна Screen Sets. 
4. Нажмите кнопку Save и дайте скринсету имя.  
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На один проект можно создать до 10 скринсетов треков. Чтобы загрузить скринсет треков, дважды щелкните по 
его имени. На отдельные скринсеты можно назначить горячие клавиши. По умолчанию, клавиши с Shift+F4 по 
Shift+F6 используются для сохранения первых трех скринсетов треков, а клавиши с F4 по F6 назначены для 
загрузки каждого из этих первых трех скринсетов треков. Если вы хотите изменить их или назначить горячие 
клавиши на другие скринсеты треков, нажмите кнопку Edit shortcuts в окне Screensets, чтобы открыть редактор 
действий, который подробно объясняется в Главе 15. Обратите внимание на опцию Autosave when switching 
screensets. Если она активирована, это гарантирует, что при переключении с одного скринсета на другой, будут 
сохранены любые изменения, внесенные в предыдущий из этих скринсетов. Кнопка Edit fields может 
использоваться для “настройки” предыдущего скринсета так, чтобы автоматически сохранялись только 
определенные опции. 
 
Пример: 
 
1. Откройте файл All Through the Night.RPP и сохраните его с именем All Through the Night TRACK 
VIEWS.RPP. 
2. Отрегулируйте высоту трека Vox как показано на рисунке ниже. 
 

 
 
3. На странице Track View окна Screen Sets щелкните по номеру 1, а затем нажмите кнопку Save, чтобы 
открыть окно Save Track View. 
 

4. Напечатайте: Vox View, но пока не нажимайте клавишу 
Enter. 
5. Обратите внимание на пять опций. Вскоре мы 
рассмотрим их. Только в контексте данного примера 
убедитесь, что отмечена опция Track control panel status. 
6. Нажмите кнопку Save. 
7. Теперь отрегулируйте высоту треков так, чтобы все 
треки были минимизированы кроме двух треков гитары. 
Масштабируйте эти два трека так, чтобы были отображены 
все их контроллеры. 
8. На странице Track View щелкните по номеру 2. 
9. Нажмите кнопку Save, чтобы открыть окно Save Track 
View. 
10. Опять же убедитесь, что отмечена только опция Track 
control panel status, и введите Guitars View. Нажмите 
Enter. 

11. Чтобы переключиться между этими скринсетами, дважды щелкните по их имени в окне Screen Sets. 
Поскольку мы отметили только опцию Track control panel status, расположение треков проекта было 
единственной информацией при сохранении этого скринсета.  
 
Обратите внимание на пять опций, которые можно включить или исключить из скринсета трека: 
 
Track Cursor Position (позиция курсора на треке) 
Track Scroll Position (позиция прокрутки трека) 
Horizontal Zoom (горизонтальное масштабирование) 
Track Control Panel Status (статус панели управления трека) 
Track Mixer Status (статус канальных модулей в микшере) 
 
Давайте теперь разберем еще один пример с другими опциями, кроме высоты трека. 
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Пример: 
 
1. Горизонтально масштабируйте проект так, чтобы были отображены только первые 45 секунд. Поместите 
курсор в отметку 46 секунд. 
2. На странице Track View окна Screen Sets щелкните по номеру 3, а затем нажмите кнопку Save. 
3. Убедитесь, что отмечены только опции Track cursor position и Horizontal zoom. 
4. Введите имя для скринсета: Verse 1 (запев 1). 
 
5. Нажмите кнопку Save. Теперь можно в любое время использовать скринсет 3 для масштабирования запева 1 
и расположения курсора в этой позиции, а любой из двух предыдущих скринсетов для масштабирования по 
вертикали треков вокала или гитары. Чтобы удалить любой скринсет, который вы не хотите сохранять, просто 
выберите его и нажмите кнопку Clear. 
 
12.10.1. Опция Track Mixer Status 
 
Обратите внимание на опцию Track Mixer Status. Эта опция может использоваться для сохранения любых 
настроек отображения канальных модулей в микшере, сделанных в менеджере треков. Переключение 
различных скринсетов будет автоматически выбирать различные наборы треков, отображаемых в микшере. Не 
путайте эту опцию с опцией Mixer flags в скринсетах окон, которая позволяет выбирать не треки, а элементы 
микшера и опции (инсерты, посылы, и т.д.). 
 

Примечание: при регулировании высоты и/или ширины панели трека, область отображения 
контроллеров трека уменьшается или увеличивается. Некоторые контроллеры могут исчезать и 
появляться вновь. Пример показан ниже. 

 

 
 

12.11. Скринсеты окон 
 
В отличие от скринсетов треков, скринсеты окон не привязаны к определенному проекту, и могут быть 
применены к любому проекту. Они сохраняются в папке Application Data в файле screensets.ini. В окне 
Screensets/Layouts (Ctrl+E), процедура создания скринсета окон следующая: 
 
1. Решите, какие окна и представления вы хотите видеть в скринсете и расположите их на экране по 
усмотрению. 
2. В окне Screen Sets перейдите на страницу Windows, выберите номер, а затем нажмите кнопку Save. Введите 
имя, а затем отметьте нужные опции (см. ниже). Нажмите кнопку Save. 
 

 
 
Чтобы загрузить и открыть любой скринсет: просто дважды щелкните по его имени. 
Чтобы изменить скринсет, откройте его, внесите изменения, а затем сохраните его. Для скринсетов окон 
можно использовать горячие клавиши. По умолчанию, клавиши с Shift F7 по Shift F9 назначены для сохранения 
скринсетов окон с 1 по 3, а клавиши с F7 по F9 назначены для их загрузки. Эти назначения можно изменить в 
редакторе действий (см. Главу 15).  
 
 
 
 



 Специально для сайта musicmanuals.ru  236 236 

Опции скринсета окон: 
 
Main Window Position (позиция главного окна) 
Tool Window Positions (позиция инструментальных окон) 
Docker Selected Tab (вкладки панели Docker) 
Mixer Flags (тэги микшера) 
Layouts (компоновки) 
Last Focus (последний фокус) 
 
Кроме того, отметьте что опция Tool window position сохраняет позицию тех окон, которые определены 
скринсетом как инструментальные элементы (например, VST эффекты и MIDI редактор) для сохранения и 
загрузки с этим скринсетом. Однако в случае какого-то конкретного проекта, эта опция будет применима только 
в том случае, если это конкретное окно будет присутствовать в этом проекте. Эта опция полезна, например, 
если вы используете ряд стандартных плагинов в мастер-треке, и хотите легко открыть и закрыть все эти окна 
эффектов в любом проекте. Активирование опции Docker Selected Tab гарантирует, что при сохранении 
скринсета если какое-либо окно было открыто на панели Docker, при загрузке этого скринсета это окно будет 
также открыто. Опция Mixer Flags позволяет сохранить со скринсетом различные опции контекстного меню 
микшера (инсетры, посылы, трек-папки, высокоуровневые треки, позицию мастер-трека, и т.д.). Эти опции 
подробно обсуждались в Главе 11. С компоновками мы встречались в Главе 11 в контексте описания микшера. 
Подробнее о компоновках мы поговорим далее в этой главе. Активирование этой опции гарантирует, что ваши 
комопоновки будут сохранены со скринсетом. Выбор опции Last Focus гарантирует, что при загрузке скринсета 
будет автоматически фокусировано конкретное окно. 
 

12.12. Автосохранение скринсетов 
 
Доступна опция автоматического сохранения изменений в скринсетах. Для этого просто отметьте опцию Auto-
save when switching screensets выбрана (см. рисунок ниже). Она гарантирует, например, что, если вы 
изменили выбранную вкладку на панели Docker прежде, чем переключиться на другой скринсет окон, и когда вы 
возвратитесь к первому скринсету, REAPER запомнит, какая вкладка была выбрана в последний раз. Используя 
функцию автосохранения, обратите внимание на кнопку Edit fields. Нажмите ее и выберите элементы, для 
которых вы хотите внести изменения и которые будут автоматически сохранены (см. рисунок ниже). Доступные 
опции - все опции, используемые  при создании скринсета. 
 

 
 

12.13. Скринсеты групп элементов 
 
Используя скринсеты элементов можно создать различные группы элементов в пределах проекта и выделить 
все элементы любого скринсета в проекте простым выбором имени скринсета. Процедура следующая: 
 
1. Перейдите View > Screensets/Layouts. 
2. В окне Screensets выберите вкладку Selection sets. 
3. В пределах проекта выделите элементы, которые будут включены в группу. Они могут быть на одном треке 
или на нескольких треках. 
4. Выберите номер скринсета, а затем нажмите кнопку Save. 
5. Дайте группе имя и нажмите Enter. Теперь можно в любое время загрузить эту группу, дважды щелкнув по ее 
имени, или выбрав имя скринсета и нажать кнопку Load. В примере, показанном ниже, были созданы два 
скринсета групп элементов, один для запева, а другой для припева.  
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12.14. Компоновки треков, микшера, транспортной панели и огибающих 
 
Компоновки в целом и компоновки микшера в частности обсуждались в Главе 11. Компоновки создаются, 
сохраняются и загружаются с отдельными темами. Во вкладке Layouts окна Screensets/Layouts можно выбрать 
любую тему из выпадающего списка тем.  
 

 
 
Темы можно загрузить со страницы stash.reaper.fm. Компоновки, связанные с выбранной темой, будут доступны 
из различных выпадающих списков в этом окне. Для более ранних тем, которые не включают компоновки, 
доступны несколько стандартных компоновок. На рисунке ниже - пример, когда двойным щелчком отображен 
выпадающий список компоновок панели микшера и произведен выбор компоновки.  
 

 
 
Когда выбран один из этих выпадающих списков (двойным щелчком на имени списка), можно навести курсор 
мыши на любой элемент списка и сразу увидеть, как компоновка смотрится в окне. Ниже приведен суммарный 
список основных доступных компоновок: 
 
Global Layout: выбор темы по умолчанию для всех элементов компоновки. 
Transport: выбор компоновки транспортной панели. 
Envelope Panel: выбор компоновки панели огибающей трека. См. Главу 18. 
Master Mixer Panel: выбор компоновки мастер-трека на панели микшера. 
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Mixer Panel: выбор компоновки для всех треков и трек-папок на панели микшера. 
Master Track Panel: выбор компоновки мастер-трека на панели трека. 
Track Panel: выбор компоновки для всех треков и трек-папок на панели трека. 
Selected track panel: выбор компоновки для выделенных треков на панели трека. 
Selected track mixer panel: выбор компоновки для выделенных треков на панели микшера. 
 
На рисунке ниже показан пример компоновки панели трека Standard Media. Среди прочего здесь используются 
горизонтальные фейдеры (а не регуляторы) для настройки громкости.  
 

 
 
Чтобы выбрать компоновку проекта необязательно открывать окно Layouts. Можно использовать команду 
Options > Layouts из главного меню или команду Set track layout из контекстного меню панели трека или 
панели микшера. 
 
12.14.1. Назначение действий для выбора компоновок 
 
Во вкладке Layouts окна Screensets/Layouts можно назначить до 20 действий для быстрой загрузки любой 
компоновки. Это могут быть горячие клавиши и/или пользовательские панели инструментов. В примере, 
показанном на рисунке ниже, действие #1 было назначено на выбор компоновки Tracking панели трека, а 
действие #2 назначено на выбор другой компоновки Vertical панели трека (вертикальные индикаторы).  
 

 
 
Можно затем нажать кнопку Edit shortcuts и назначить горячие клавиши на два действия: Layout: apply custom 
layout #01 и Layout: apply custom layout #02. Можно также использовать редактор Customize toolbar для 
создания ярлыков для этих действий на одной из панелей инструментов. Подробнее о назначении горячих 
клавиш и ярлыков инструментов в Главе 15. 
 

12.15. Дальнейшее управление параметрами трека 
 
В Главе 2 и Главе 5 мы рассмотрели некоторое использование кнопки Param в окне плагина эффектов 
REAPER. В Главе 17 и Главе 18 вы увидите, как эта кнопка может использоваться для создания огибающих 
автоматизации и модуляции параметров. Между тем, давайте рассмотрим некоторые другие способы ее 
использования. Если вы затронете мышью какой-либо контроллер эффекта (например, фейдер) а затем 
нажмете кнопку Param, откроется меню со следующими опциями: 
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Show in track controls: добавляет регулятор на панель трека и 
(дополнительно) на панель микшера для настройки параметра. См. 
Главу 11 и ниже. 
Show track envelope: добавляет огибающую для автоматизации 
этого параметра - см. Главу 18. 
Parameter modulation: активирует модуляцию для этого параметра 
- см. Главу 19. 
Learn: позволяет назначить на этот параметр контроллер с 
внешнего аппаратного устройства, например, фейдер или кнопку на 
аппаратном устройстве - смотрите опцию Learn ниже. 
Alias parameter: позволяет назначить псевдоим на экземпляр этого 
параметра, который будет использоваться, например, для любого 
контроллера трека или огибающей, которую вы создаете для этого 
параметра. 
FX parameter list: меню, перечисляющее все контроллеры этих  
эффектов. Использование этого меню - еще один способ 

назначения (или отмена назначения) любой из этих опций на любой параметр, вместо того, чтобы затронуть 
параметр мышью - рисунок ниже.  
 

 
 
Большинство этих опций доступно только с эффектами в цепочке эффектов трека (включая мастер-трек). 
Однако опция Learn также доступна с предварительно установленными эффектами и эффектами мониторинга. 
Контроллеры Learn и Show track envelope доступны с эффектами копии. 
 
12.15.1. Опция MIDI Learn 
 
Давайте подробнее рассмотрим опцию Learn. Когда вы затрагиваете мышью контроллер в окне эффектов, а 
затем нажимаете кнопку Learn, открывается одноименное окно.  
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Если вы затронете контроллер (например, фейдер или регулятор) на внешнем устройстве в окне Command 
появится информация о канале и назначении аппаратного контроллера на этот программный контроллер. Эта 
информация захватывается внешним аппаратным контроллером. Выбор режима контроллера в меню CC mode 
(абсолютный или относительный) будет зависеть от назначаемого параметра и вашего управляющего 
устройства. В большинстве случаев подходит режим с мягким управлением (soft takeover), но вам, возможно, 
придется поэкспериментировать. Если отмечена опция Soft takeover, затронутый параметр не будет изменен 
перемещением MIDI регулятора или фейдера до тех пор, пока MIDI регулятор/фейдер не будет равен по 
значению. Например, если текущее значение параметра (скажем) 100, а аппаратного управляющего слайдера 
(скажем) 30, то с отмеченной опцией soft takeover перемещение фейдера не вызовет изменений в значении 
параметра до тех пор, пока значение фейдера не приблизится к 100. Если затем фейдер будет перемещен 
(скажем) на значение 120, значение параметра будет также перемещено в значение 120. 
Активирование опции Enable only when effect configuration is focused означает, что назначение с внешнего 
аппаратного устройства будет использоваться только тогда, когда фокусируется конкретный плагин. Это 
позволяет вам назначить, например, один и тот же фейдер внешнего аппаратного устройства на любое 
количество различных функций в различных плагинах. Например, один фейдер, используемый для управления 
усилением эквалайзера, можно также использовать для управления порогом компрессора. Когда на один или 
несколько параметров плагина назначен контроллер с внешнего аппаратного устройства, вы увидите 
дополнительную команду в меню Param - Default controller mappings. Она открывает меню (на рисунке ниже), 
которое можно использовать для сохранения этих настроек в качестве настроек по умолчанию для этого 
плагина так, чтобы эти контроллеры автоматически были доступны каждый раз, когда этот плагин будет 
загружен в другие треки.  
 

 
 
Другие опции этого меню (если настройки были сохранены как настройки по умолчанию) - Clear default или Use 
default. 
Show in track controls: когда контроллеры трека отображаются на панели трека и панели микшера, они не 
только управляют отдельными параметрами, но и служат шлюзом к управлению вашей консолью. Чтобы 
отобразить их в микшере, необходимо активировать опцию Show FX parameters when size permits в 
контекстном меню микшера. Щелкните правой кнопкой по любому контроллеру на панели трека или на панели 
микшера, чтобы открыть меню (см. рисунок ниже). Это меню включает опцию Remove from list, которая удаляет 
контроллер из панели трека и панели микшера.  
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Опции Learn, Modulate, Envelope и Alias совпадают с таковыми в меню кнопки Param в окне эффекта. 
Например, отсюда можно добавить поддержку управления с внешнего аппаратного устройства на любой из 
пользовательских контроллеров трека выбрав опцию Learn. 
Меню Plug-in: (на рисунке выше для плагинов ReaEQ и ReaDelay) перечисляет плагины в цепочке эффектов 
трека, вместе с выпадающем меню всех их параметров. Это меню можно использовать для добавления 
контроллеров любого из этих параметров: меню включает опцию All parameters. На панели микшера, когда 
активирована опция Show FX parameters when size permits, можно щелкнуть правой кнопкой мыши по этой 
области в любом треке для добавления контроллеров в этот трек. Фактическое меню будет, конечно, зависеть 
от эффектов, включенных в цепочку эффектов трека. 
 
12.15.2. Шаблоны трека 
 
В Главе 3, когда мы знакомились с параметрами записи, мы упомянули шаблоны трека и насколько полезными 
они могут быть. Теперь, когда вы больше узнали о REAPER, взглянем на эту тему более пристально. Шаблоны 
трека могут быть незаменимы при конфигурации проекта. Шаблон трека может состоять из любого трека или 
нескольких треков. Например, у вас есть трек-папка Drums. Она может включать серию дочерних треков - Kick, 
Snare, Toms, Hi hat, и т.д. – где у каждого из треков есть их собственные эффекты с их собственными 
настройками, разное значение громкости и панорамы. Вы можете сохранить всю трек-папку с ее дочерними 
треками и всеми их настройками в качестве шаблона трека и назвать его Drum Kit. Клипы, включенные в 
шаблоны трека: имя трека, параметры контроллеров трека, свойства трека (цвет, значок, и т.д.), эффекты трека 
(вместе с их параметрами), контроллеры трека, псевдоимена эффектов и псевдоимена параметров эффектов, 
модуляция параметров, параметры эффектов, посылы и адресаты, и т.д. Чтобы сохранить трек (или несколько 
треков) в качестве шаблона, перейдите Track > Save tracks as track template в главном меню. Чтобы вставить 
треки из шаблона в проект, выберите опцию Insert track from template из того же меню. 
 

12.16. Справочная информация на панели трека и в главном меню 
 
Полезная справочная информация может быть выбрана и отображена щелчком правой кнопкой мыши ниже 
панели управления и в главном меню. Опции контекстного меню ниже панели треков: 
 

Selected track/item/envelope details (информация о выбранных 
треках, клипах, огибающих) 
CPU/RAM usage, time since last save (информация об 
использовании ресурсов процессора/оперативной памяти) 
Track/item count (информация о количестве треков, клипов, 
эффектов) 
REAPER tips (подсказки REAPER) 
No information display (чистая область, без отображения 
информации) 
Show mouse editing help (подсказка о редактировании мышью) 
 

 
Первые пять из этих опций взаимоисключающие: вы можете выбрать только одну из них.  
В главном меню (в правом верхнем углу), можно выбрать дополнительные опции: 

 
Show free disk space (показать свободное 
место на диске) 
Show recording path (показать путь к файлу 
проекта) 
Show recording volume name (показать имя 
диска, где расположен файл проекта) 
Show recording format (показать формат 
записанных клипов) 
Show audio device information (показать 
информацию об аудиоустройстве) 
 
 
 
 
 
 
 

Это меню также обеспечивает доступ к странице Audio Device, странице Media Settings в окне свойств проекта 
и окну Monitoring FX. 
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12.17. Использование нескольких панелей Docker 
 
В Главе 2 мы рассматривали панель Docker как помощь в навигации окон и представлений REAPER. Однако вы 
не ограничены всего лишь одной панелью Docker: можно создать до 16 таких панелей. На рисунке ниже две 
панели Docker, присоединенные внизу главного окна и одна плавающая панель.  
 

 
 
Первая панель Docker (внизу слева) содержит вкладки для отображения матрицы маршрутизации, микшера и 
браузера клипов. Вторая панель справа используется для отображения скринсетов, менеджера треков или окна 
истории отмен.  
Плавающее окно - третья панель Docker, которая содержит вкладки для отображения цепочек эффектов 
четырех треков в текущем проекте. Это – конечно же, всего лишь пример. Данные инструкции предполагают, что 
вы уже знакомы с основными способами прикрепления и открепления окон, как объяснялось в Главе 2. Любую 
панель Docker можно прикрепить к главному окну в любой из четырех позиций. Одну и ту же позицию можно 
выбрать для нескольких панелей Docker (например, можно присоединить две панели на правой стороне 
главного окна). 
Чтобы присоединить панель Docker к главному окну: щелкните по значку  (восклицательный знак на левой 
стороне панели) и в меню выберите опцию Attach docker to main window, а затем выберите позицию (внизу 
(bottom), слева (left), наверху (top) или справа (right). К любой из этих позиций можно привязать несколько 
панелей. Перетащите границу между двумя панелями, прикрепленными в ту же самую позицию, чтобы 
отрегулировать позицию границы между ними (и, следовательно, относительный размер этих двух панелей). 
Также используйте это меню чтобы сменить позицию панели, например, сверху влево. 
 
Чтобы прикрепить окно: щелкните правой кнопкой по строке заголовка окна и выберите команду Dock in 
Docker. 
Чтобы создать новую панель Docker: перетащите любую вкладку с текущей панели в область аранжировки. 
Чтобы переместить окно с одной панели Docker в другую: перетащите вкладку с одной панели в другую. 
Чтобы переупорядочить вкладки на любой панели Docker: перетащите вкладки на панели влево или вправо. 
Чтобы закрыть прикрепленную вкладку: щелкните по вкладке с нажатой клавишей Alt или нажмите кнопку 
вкладки. 
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12.18. Сохранение новых версий проекта 
 
Список действия REAPER включает действие File: Save new version of project (automatically increment project 
name), которое по умолчанию назначено на горячую клавишу Ctrl+Alt+Shift+S. Это действие создает новый. 
RPP файл при сохранении проекта. Таким образом, если, например, у вас открыт файл WinterBlues. RPP, то 
после выполнения этого действия этот проект в своем текущем состоянии будет сохранен с именем 
WinterBlues_1. RPP. Повторное выполнение этого действия сохранит проект под именем WinterBlues_2. RPP, и 
так далее. 
 

12.19. Несколько резервных версий проекта 
 
Страница Options > Preferences > Project включает опцию которая позволяет при сохранении проекта 
создавать несколько rpp-bak файлов резервных копий. Для этого активируйте опцию Keep multiple versions 
(сохранять несколько версий), с или без (по усмотрению) их собственных историй отмен. Если эта опция 
активирована, использование опции File > Save project as для сохранения проекта создаст новую резервную 
версию. Открытие RPP файла будет всегда открывать последнюю сохраненную версию. Однако открытие RPP-
BAK файла откроет диалоговое окно Choose version from backup file, где можно выбрать версию для загрузки. 
При работе с несколькими вкладками проекта у вас может быть несколько одновременно открытых версий. 
 

12.20. Ассоциация сконвертированных WAV файлов с исходными файлами проекта 
 
При использовании команды File > Render для конвертирования проекта (или части проекта) в WAV файл(ы), 
доступна опция Include project file name in BWF data. Рендеринг подробно обсуждается в Главе 21. Если эта 
опция активирована, название файла проекта встраивается в конвертируемый файл(ы). Это гарантирует, что 
RPP файл останется привязанным к конвертированному WAV файлу(ам). Если какой-либо файл, 
конвертированный с этой активированной опцией, впоследствии вставляется в другой проект, ниже команды 
Open items in editor появляется команда Open associated project in tab: xxx.RPP (где “xxx” представляет 
связанное имя проекта) в контекстном меню клипа.  
 

 
 
Эта команда может использоваться для создания новой вкладки проекта, в которую откроется связанный RPP 
файл. 
 

12.21. Проекты и подпроекты 
 
Очень мощная функция REAPER - способность построения основного проекта с использованием любого 
количества подпроектов, в противоположность сохранению всех отдельных треков, трек-папок и клипов в 
пределах одного проекта. Эта функциональность имеет множество применений, но, вероятно, особенно полезна 
при работе с проектами с очень большим количеством треков или с проектами саунд-дизайна, где вы можете 
использовать подпроекты для создания одного общего аудиоклип. Чем больше подпроектов, включает клипы, 
которые нуждаются в сложном редактировании или используют такие функции, как автоматизация, модуляция 
параметров и эффектов, тем больше потенциальная выгода (с точки зрения управления проектами), которая 
может быть получена от использования подпроектов. Более продвинутое применение заключается в 
использовании одного подпроекта в нескольких проектах так, чтобы при его обновлении, автоматически 
обновлялись все основные проекты. Прежде чем мы рассмотрим работу с подпроектами, необходимо понимать 
основные функции создания проекта REAPER, такие как запись аудио и MIDI, браузер клипов, редактирование 
клипов, эффекты трека и клипа и их автоматизация, и так далее. В принципе подпроекты понять не трудно. 
Вскоре мы рассмотрим пример. Итак, основные шаги использования подпроектов следующие: 
 
1. Создайте новый проект как обычно (Ctrl+N) и сохраните его. При этом желательно отметить опцию Create 
subdirectory for project. Рассмотрите также опции копирования или перемещения всех клипов в директорию 
проекта. 
2. Создайте (записав или импортировав) один или несколько треков для этого проекта. Хотя делать это 
необязательно прежде, чем добавить любые подпроекты, но зачастую сделать это имеет смысл. 
3. Создайте трек, который будет включать ваш подпроект. Вскоре вы поймете почему. Дайте имя этому треку: 
например, если это трек для барабанов, назовите его Drums. 
4. Выберите этот трек и перейдите Insert > New subproject. При необходимости можно установить начальную 
продолжительность проекта, выделив область до применения команды Insert > New subproject. В окне запроса 
дайте подпроекту имя (например, DrumsSub) и нажмите кнопку Save. 
5. Обратите внимание на короткие клипы, вставленные в позиции курсора. Они и представляют подпроект. 
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6. Дважды щелкните по этому клипу, чтобы открыть подпроект в новой вкладке. При этом автоматически 
создаются два маркера (=START и =END) в начале и в конце подпроекта соответственно. Они определяют 
конвертируемую часть подпроекта, и могут быть перемещены или удалены в любое время. 
 

 
 
7. Создайте свой подпроект, записав или импортировав клипы. Различные опции, которые управляют 
поведением воспроизведения при работе с несколькими открытыми проектами, доступны в контекстном меню 
вкладки проекта. Вскоре мы вернемся к их объяснению. 
8. По окончании нажмите Ctrl+S, чтобы сохранить подпроект. Клипы будут сконвертированы в один файл, 
который появится в виде одного клипа на его собственном треке в основном проекте. 
9. Откройте основной проект (выбрав его вкладку). Возможно, придется увеличить продолжительность клипа в 
треке подпроекта, чтобы отобразить его содержимое. Теперь можно закрыть подпроект, если хотите. Его может 
вновь открыть, дважды щелкнув по клипу в основном проекте.  
10. Когда вы воспроизведете основной проект, его выходной сигнал будет включать сконвертированный контент 
вашего подпроекта. 
 
Пример: 
 
Давайте теперь рассмотрим пример того, как это можно применить на практике. Чтобы облегчить понимание, 
данный пример будет сведен к простому проекту. После изучения этого примера вы можете подумать о 
дальнейшем примере с использованием ваших собственных проектов. 
 
1. Мы создали новый проект под именем WaitingMain. RPP и сохранили его в его собственную подпапку. Мы 
записали ведущий трек и добавили второй трек с именем Drums. 
 

 
 
2. Выбрав трек Drums, мы перешли Insert > New subproject, чтобы вставить подпроект, который мы назвали 
DrumsSub. RPP и сохранили его. Обратите внимание на короткие клипы, которые автоматически добавлены в 
трек и новую вкладку проекта выше панели инструментов. 
 

 
 
3. Мы выбрали подпроект DrumsSub щелчком на его вкладке проекта или дважды щелкнув по клипу.  
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Мы щелкнули правой кнопкой мыши по вкладке этого проекта и отметили опции Synchronize any parent 
projects on playback (синхронизировать любой основной проект при воспроизведении), Run background 
projects (запускать фоновые проекты), Run stopped background projects (запускать остановленные 
фоновые проекты), Play stopped background projects with active project (запускать остановленные фоновые 
проекты с активным проектом) и Synchronize play start times w/play background projects 
(синхронизировать начальное время с воспроизведением фоновых проектов).  
4. Мы создали наши треки ударных как обычно. Ради простоты этого примера мы только что добавили два 
трека, но конечно у нас может быть неограниченное количество. Каждый раз, когда мы воспроизводим их, 
ведущий трек в основном проекте воспроизводится также. Громкость трека и его панорама отрегулированы, 
добавлены эффекты и огибающие и так далее. По окончании мы переместили =END маркер в конец треков. 
 

 
 
5. Теперь мы сохраняем этот файл. Заметьте, что при сохранении выходной сигнал был конвертирован. Мы 
возвращаемся к основному проекту. На первый взгляд ничего, кажется, не изменилось.  
 

 
 
6. Однако, когда мы расширяем клип вправо, мы видим сконвертированные барабаны. 
 

 
 
7. Если мы закроем проект DrumsSub и воспроизведем файл основного проекта, сконвертированные барабаны 
можно ясно услышать наряду с ведущим треком. 
8. Любые дальнейшие изменения, которые мы вносим в проект DrumsSub, будут включены в 
сконвертированный аудиофайл при сохранении подпроекта. Таким образом, когда будет открыт основной 
проект, аудиоклип на треке Drums будет включать эти обновления. 
9. Теперь мы можем добавить подпроекты в данном примере по одному для вокала и ритм-секции.  
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Ведущий трек больше не требуется: его можно мьютировать и скрыть. Мы можем также сделать дальнейшие 
редактирование, добавить эффекты, и т.д. к конвертированным трекам подпроекта. На практике подпроекты 
являются наиболее полезными при работе со сложными приложениями, такими как саунд-дизайн фильма, 
радиопередачи, большие оркестровые аранжировки, саунд-дизайн игр/видео и запись электронной музыки.  
Другое возможное применение - завершающий этап записи альбома, где каждая песня вставлена как отдельный 
подпроект в рамках основного проекта. 
 
12.21.1. Работа с подпроектами. Некоторые полезные советы и подсказки 
 
Испытывая что-то новое легко оступиться и сделать (иногда элементарные) ошибки. Эти комментарии не 
панацея, но они призваны помочь вам. 
 
12.21.1.1. Создание подпроекта 
  
- еще не конец света, если вы забыли поместить курсор редактирования в основном проекте в точную позицию 
перед созданием подпроекта. Всегда можно переместить клип в пределах основного проекта позже. 
- можно определить позицию и продолжительность подпроекта, выделив область перед его созданием.  
- обычно имеет смысл поместить основной проект в новую папку, а все подпроекты сохранить в эту же папку.  
- не давайте имя текущего файла в той же самой папке, что и имя подпроекта. Если вы это сделаете, вы 
перезапишете этот файл с новым пустым файлом. 
 - отдельные клипы текущего проекта можно импортировать в подпроект обычным способом (например, 
применив команду Insert > Media item, или через браузер клипов). 
 - текущий проект можно импортировать в основной проект в качестве нового клипа подпроекта. Или перетащить 
RPP файл из браузера клипов на пустой трек основного проекта, и в окне запроса выбрать опцию Insert project 
as media item, или выбрать пустой трек и использовать команду Insert > Media file. 
 

 
 
 - текущий клип (или клипы) в основном проекте можно извлечь из основного файла и переместить в новый 
подпроект. Для этого щелкните правой кнопкой по выбранному клипу (клипам) и выберите опцию Move items to 
new subproject. Выбранные клипы на том же самом треке будут перемещены в один подпроект. Клипы с разных 
треков будут перемещены в отдельные подпроекты.  
- подпроект полностью доступен для редактирования: его содержимое отображается в основном проекте в виде 
одного клипа, который будет обновляться при каждом сохранении подпроекта. 
- трек или несколько выбранных треков в основном проекте можно сконвертировать в подпроект, выполнив 
следующие шаги: 
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1. На панели треков выберите трек или несколько треков. Если выбранные клипы принадлежат трек-папке, 
включите эту трек-папку в выбор. 
2. В главном меню перейдите Track > Move tracks to new subproject. Треки (включая любые трек-папки) будут 
перемещены и сохранены в новый подпроект: их выходной сигнал появится в основном файле в качестве 
сконвертированного единственного клипа на одном треке. Отметьте, однако, что любые посылы/адресаты 
между выбранными треками и любыми другими треками в основном проекте будут удалены. 
 
12.21.1.2. Работа с подпроектами 
 
 Если ваши компоновки основных проектов/подпроектов становятся очень сложными, и вы хотите сохранить их, 
без необходимости ожидания рендеринга, щелкните по одной из вкладок проекта и активируйте опцию Defer 
rendering of subprojects (render on tab switch rather than on save). Новый подпроект получит некоторые 
параметры основного проекта (например, темп, музыкальный размер). Однако изменения в параметрах 
основного проекта не будут автоматически применены к подпроектам. Для работы с подпроектом 
необязательно открывать основной файл (или другой файл). Файл будет автоматически переконвертирован, 
когда вы сохраните изменения, и именно это повторно сконвертированная версия будет открыта, когда вы 
откроете основной файл. Однако зачастую вы захотите иметь основной проект открытым, чтобы дать вашему 
подпроекту (подпроектам) соответствующий контекст. =START и =END маркеры могут использоваться для 
выбора фрагмента подпроекта, который будет сконвертирован и возвращен в основной файл при сохранении 
проекта (как показано на рисунке ниже). Если вы удалите эти два маркера, будет сконвертирован весь проект от 
начала (нулевая отметка на шкале времени) до окончания последнего клипа при сохранении файла. Это может 
привести к потере хвостов ревербератора. 
 

 
 
 При воспроизведении подпроект с активированными опциями Run background projects, и Synchronize any 
parent projects on playback, копии клипов в основном проекте, которые соответствуют этому подпроекту, будут 
автоматически мьютированы и остаются такими до тех пор, пока этот подпроект будет оставаться активным. 
Это препятствует тому, чтобы один и тот же материал воспроизводился дважды. Если при работе над 
подпроектом вы хотите слышать только содержимое этого файла при воспроизведении, необходимо отключить 
опцию Synchronize any parent projects on playback в контекстном меню вкладки проекта. Если подпроект был 
отредактирован в рамках основного проекта опция Synchronize any parent projects on playback может не 
привести к тем же самым результатам, что и при воспроизведении основного проекта. Вы уже знаете, что при 
сохранении подпроекта, его содержимое конвертируются в аудиофайл. Этот процесс использует параметры 
рендеринга проекта этого файла в реальном времени. Таким образом, при необходимости можно использовать 
различные настройки рендеринга для различных файлов подпроекта.  
Подпроект можно прослушать в браузере клипов. Для этого перейдите к нужной папке и выберите проект как 
обычно. Будет воспроизведен сконвертированный файл. Это позволяет воспроизвести подпроект в браузере 
клипов, без необходимости открывать его. В пределах браузера клипов меню Options включает опцию Auto-
render proxy to preview REAPER.RPP projects. Если она активирована, это гарантирует, что при выборе окна 
подпроекта для предварительного просмотра, если необходим будет рендеринг, он будет применен 
автоматически. В пределах основного проекта можно создать новую копию любого клипа подпроекта. Просто 
щелкните правой кнопкой по клипу, и из контекстного меню выберите опцию Open items in editor, а затем Open 
item copies in subproject tab. Теперь у вас будет два подпроекта для этого трека. Эти два файла можно 
отредактировать независимо друг от друга и отобразить в основном проекте как две отдельных копии. Ими 
можно управлять и редактировать их точно так же, как и любую другую копию. 
 

 
 
Ваши подпроекты, как любые другие проекты, могут включать маркеры и регионы. При сохранении любые 
регионы будут идентифицируемыми в пределах сконвертированных клипов этого подпроекта в основном 
проекте. 
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12.21.1.3. Сводка опций вкладок основного проекта и подпроекта 
 
Основной проект: 
 
Если вы активируете опцию Run background projects (запускакть фоновые проекты), вы можете точно 
настроить поведение второстепенных проектов, выбрав любую из опций: Run stopped background projects 
(запускать остановленные фоновые проекты), Play stopped background projects with active project 
(воспроизводить остановленные фоновые проекты с активным проектом) и Synchronize play start times 
w/play background projects. 
 
Подпроект: 
 
Если вы активируете опцию Run background projects, вы можете точно настроить поведение второстепенных 
проектов выбрав любую из опций: Synchronize any parent projects on playback (синхронизировать при 
воспроиведении любые основные проекты), Run stopped background projects (запускать остановленные 
фоновые проекты), Play stopped background projects with active project (воспроизводить остановленные 
фоновые проекты с активным проектом) и Synchronize play start times w/play background projects. Как для 
основного проекта, так и для подпроекта, доступна опция Defer rendering of subprojects (render on tab switch 
rather than save). 
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13. Управление и редактирование MIDI клипов 
 

13.1. Введение 
 
REAPER включает множество способов управления и редактирования MIDI клипов. Если вкратце, то: 
 
- многие команды контекстного меню клипа могут использоваться с MIDI клипами также, как и с аудиоклипами - 
например, можно создавать и управлять несколькими копиями, добавлять MIDI эффекты в цепочку эффектов 
копии, вырезать, копировать и перемещать клипы, и так далее. 
- кроме того, некоторые команды контекстного меню применяются только к MIDI клипам.  
- можно открыть любые MIDI клипы в MIDI редакторе REAPER для детального их редактирования. Можно 
решить открыть ли один клип, несколько клипов вместе в том же самом окне MIDI редактора, или использовать 
отдельное окно для каждого клипа. 
- в целях быстрого редактирования MIDI клипа можно использовать оперативный редактор, без необходимости 
открывать отдельное окно MIDI редактора. Эта функция объясняется ближе к концу данной главы. Перед 
детальным обсуждением функций редактирования, давайте рассмотрим несколько других важных аспектов 
использования MIDI. 
 

13.2. Мониторинг сигнала с внешнего синтезатора 
 
Мониторинг с внешнего синтезатора может осуществляться, используя MIDI или входной аудиопорт. 
 
Мониторинг с использованием входного MIDI порта: вставьте трек и дайте ему имя. Активируйте его для 
записи и активируйте мониторинг входного сигнала. Установите режим записи в значение Disable input 
monitoring only. Выберите Input: MIDI, затем выберите устройство, а затем канал (каналы). Откройте окно 
маршрутизации трека и выберите выходной канал MIDI устройства. 
Мониторинг с использованием входного аудиопорта: вставьте трек и дайте ему имя. Активируйте его для 
записи и активируйте мониторинг входного сигнала. Установите режим записи в значение Disable input 
monitoring only. Выберите нужный моно или входной аудиостереопорт из аудиоинтерфейса синтезатора. 
 

13.3. Использование контроллеров трека с MIDI 
 
Как упоминалось в Главе 5, контроллеры громкости и панорамы трека по умолчанию управляют аудиосигналом 
трека. Если вы хотите использовать эти контроллеры для управления MIDI сигналом, щелкните правой кнопкой 
по номеру трека на панели треков или на панели микшера и выберите опцию MIDI Track Controls, а затем 
выберите одну из опций Link track volume/pan to MIDI из меню.  
 

 
 
Можно выбрать все каналы или любой отдельный канал. Можно также использовать плагин ReaControl MIDI с 
любым треком. Этот плагин подробно объясняется в Главе 16. 
 

13.4. Управление посылами MIDI данных 
 
Посылы и адресаты REAPER могут использоваться с 
аудиоклипами, MIDI клипами, или с теми и другими. 
Тема посылов/адресатов уже обсуждалась в Главе 5, и 
более подробно будет обсуждаться в Главе 17. Между 
тем обратите внимание на кнопку справа, которая 
гарантирует, что фейдеры посыла будут 
использоваться для управления MIDI данными. Если 
эта кнопка активирована, сообщения MIDI контроллера 
#007 Громкость (127, макс.) и контроллера #010 

Панорама (64, центр) отсылаются на выбранные каналы (по умолчанию - на все каналы). Если на отсылающем 
треке присутствуют какие-либо MIDI клипы (даже пустые), эти параметры будут отсылаться, когда запускается 
или останавливается воспроизведение, или при изменении позиции воспроизведения. Однако, помните, что не 
все синтезаторы и плагины распознают эту функцию. 
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13.5. Конфигурация MIDI редактора и доступ к нему 
 

Примечание: большинство иллюстраций, используемых в этой главе, основаны на теме по умолчанию 
REAPER 4. Тем не менее инструкции и действия применимы и для REAPER 5.  
 

MIDI редактор можно открыть только при наличии в проекте MIDI клипа. Если вы хотите открыть редактор с 
“чистого листа”, необходимо сначала создать новый пустой MIDI клип. Для этого выберите нужный трек и (по 
желанию) выделите область, чтобы определить продолжительность клипа. Затем перейдите Insert > New MIDI 
Item в главном меню. Созданные таким образом MIDI клипы по умолчанию активируются для зацикливания. Это 
поведение можно изменить для отдельных клипов в пределах их диалоговых окон Item Properties, или 
глобально на странице Options > Preferences > Project> Media Item Defaults. MIDI редактор можно открыть 
любым из нижеперечисленных способов с использованием одного единственного MIDI клипа (записанного или 
пустого): 
 
1. Если вы не изменяли модификаторы мыши по умолчанию (см. Главу 15), дважды щелкните по MIDI клипу 
2. Выберите MIDI клип и нажмите Ctrl+Alt+E. 
3. Щелкните правой кнопкой по клипу и выберите опцию Open in built-in MIDI editor из меню.  
 
Однако точное поведение MIDI редактора при его открытии будет зависеть от параметров в предварительных 
настройках (Preferences). Поэтому прежде чем разбираться в самом MIDI редакторе, необходимо исследовать 
эти параметры. Для этого перейдите Options > Preferences> MIDI Editor. Более подробно предварительные 
настройки MIDI редактора будут рассматриваться в Главе 22. На данный момент давайте приглядимся к рисунку 
ниже.  
 

 
 
Во-первых, можно определить то, что по умолчанию будет открываться с MIDI редактором. Это может быть 
только MIDI клип, по которому щелкнули (Open the clicked MIDI Item Only), все выбранные MIDI клипы 
(Open all selected MIDI items), все MIDI клипы на этом треке (Open all MIDI on the same track) или все MIDI 
клипы в проекте (Open all MIDI in the project). Значение по умолчанию - все выбранные MIDI клипы (Open all 
selected MIDI items). Параметры по умолчанию можно изменить в любое время в MIDI редакторе, щелкнув 
правой кнопкой по клипу (или группе клипов) и выбрав опцию Open items in editor, а затем в подменю выбрав 
одну из опций: Open items in built in MIDI editor (открыть в MIDI редакторе, исходя из выбранного значения в 
меню), Open MIDI item in editor (Открыть в MIDI редакторе) Open item copies in built-in MIDI editor 
(Открыть копии клипов в MIDI редакторе, исходя из выбранного значения в меню).  
 

 
 

Можно также определить поведение при открытии нескольких 
MIDI клипов: отдельный экземпляр MIDI редактора на каждый 

клип, на трек или для целого проекта. 
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13.6. Окно MIDI редактора 
 
В этой главе мы сфокусируемся на работе в MIDI редакторе с одним единственным клипом. Позже мы 
рассмотрим работу в MIDI редакторе с несколькими клипами, и с клипами на нескольких треках. Когда вы 
откроете клип в MIDI редакторе, вы увидите дисплей, схожий с дисплеем на рисунке ниже. Давайте рассмотрим 
его элементы: 
 

 
 
Главное меню (1): главное меню, его различные команды и действия мы подробно рассмотрим позже, т.к. 
сначала необходимо обсудить некоторые аспекты и навигацию интерфейса. 
Панель инструментов (2): при наведении мыши на любую кнопку всплывает подсказка. Панель инструментов 
можно редактировать по вашему усмотрению (см. Главу 15). Кнопки панели инструментов по умолчанию слева 
направо:  
 

 
 

Представление Piano roll (Виртуальная MIDI клавиатура) (по умолчанию), Named note 
(Представленние маркированных нот), Event list (Список событий) и Musical notation 
(Представление музыкальной нотации). Первые три представления будут подробно 

объяснены в этой главе. Представление музыкальной нотации будет объяснено в следующей главе. 
 

Кнопка Filter: активирование этой кнопки открывает окно Filter Events, где вы можете определить 
элементы, которые будут отображаться в MIDI редакторе.  

 
Если отмечен флажок Show only events that pass filter, в MIDI редакторе будут отображаться только те 
элементы, которые пропустит фильтр. Если отмечен флажок Invert, будут отображены все ноты, кроме тех, 
которые определены параметрами фильтра (отфильтрованы). Если отмечен флажок Solo воспроизводиться 
будут только те события, которые определены фильтром. Можно выбрать все каналы (активировав опцию All в 
секции Channel) или любую комбинацию каналов, отметив соответствующие флажки.  
 

Выпадающий список Event Type позволяет выбрать любой тип событий, 
которые будут отфильтрованы. Значение по умолчанию - All events (все 
типы событий). Содержимое параметров ниже зависит от выбранного типа 
события. Например, для событий Note параметры будут определять 
диапазон нот, которые будут пропущены через фильтр (дополнительно 
можно использовать для этого виртуальную клавиатуру окна редактора, 
отметив флажок Use Piano Key), для параметра Velocity можно ввести 
диапазон значений, для параметров Position in measure и Length можно 
выбрать диапазон нотных длительностей. Однако выбор Program Change 

(PC) в качестве типа событий позволяет отфильтровать только номер программы и/или позицию в такте.  
События Pitch можно отфильтровать на низких/высоких значениях или в позиции в такте. Позиция в такте будет 
меняться в зависимости от типа события.  
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Например, если тип события - Note, позиция в такте позволяет ограничить отображение в диапазоне, который 
вы определяете между значениями 0 и 127. Для событий PC, CC или Pitch, низкие и высокие значения позиции 
в такте устанавливается в любой диапазон в пределах длительностей от 1/32 до 1 (целая нота). Кнопка Set 
selection применяет настройки фильтра, а кнопка Add to selection позволяет добавить события к текущему 
выбору фильтра. Например, можно создать фильтр для событий Note (нот), а затем добавить к нему событие 
изменения высоты тона (Pitch). Кнопка Remove from Selection удаляет текущий добавленный фильтр. Кнопка 
Set filter from selection автоматически создает новый фильтр, основанный на текущем выборе ноты в MIDI 
редакторе.  

 
Кнопка Filter включает контекстное меню с опциями: Show only 
events that pass filter (показать только те события, которые 
пропустил фильтр), Invert filter (инвертировать фильтр) и/или 
Solo (солировать). 
 
 
 

 
Кнопка Track List: открывает панель списка треков. Подробнее об этом в этой главе в Параграфе 
«Работа с несколькими треками/клипами». На данный момент оставьте эту кнопку отключенной. 
 

Направо от кнопки Track List расположены шесть кнопок: Quantize, CC selection 
follows note selection, Show grid, Snap to grid, Step Sequencing и Dock editor.  
 

Щелчок правой кнопкой мыши по кнопке Snap to Grid позволяет 
установить поведение активированной привязки: Always snap notes 
to the left (всегда привязывать ноты влево), Snap notes to end of 
grid (привязывать ноты к концу сетки) (значение по умолчанию), 
или Snap relative to grid (относительно привязывать к сетке).  
 
 

 
Примечание: если на странице Options > Preferences > Media > MIDI опция Create new items 
установлена в значение as .MID files, а опция Import existing MIDI files as установлена в значение MID 
file reference, на панели инструментов MIDI редактора слева появятся две кнопки - File > Save MIDI file и 

File > Revert to saved MIDI file. 
 

Совет: опция View > Piano Roll Timebase включает опции beats (доли), project beats (доли проекта) и 
project time (время проекта). MIDI данные всегда определяются на основании долей, но в режиме 
представления времени сетка отображает любые изменения темпа в проекте. Если не будет никаких 

изменений темпа, представления долей и времени будут идентичны. Доступна также опция Project synced, 
которая синхронизирует Шкалу времени проекта и MIDI клипы, гарантируя, что оба представления будут 
синхронизированы при таких действиях, как изменение масштаба и прокрутка. 
 
Шкала времени (3): MIDI редактор использует параметры области аранжировки. Например, если в меню 
Options главного окна активирована опция Loop points linked to time selection, на шкале времени MIDI 
редактора можно выделить область, как на шкале времени в области аранжировки, которая будет также и 
областью лупа. 
Транспортная панель (4): расположена внизу окна MIDI редактора и включает транспортные кнопки и 
несколько выпадающих меню. Первые шесть кнопок (слева направо): перемотка в начало, старт, пауза, останов, 
перемотка вперед, кнопка активирования режима лупа. Область лупа можно установить на шкале времени как в 
MIDI редакторе, так и в области аранжировки. Выпадающие меню слева направо: 
 

Меню Grid: определяет деление сетки в нотных длительностях. 
 
 
 
 
 
 
 
 
 
 

Меню Grid spacing type: тип деления сетки: простой, триоль, нота с точкой или swing. Если выбран 
тип swing, становятся доступными несколько других параметров. Они будут обсуждаться позже в 
контексте квантизации. 
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Меню Notes: используется для выбора длительности ноты по умолчанию, которая используется 
при добавлении новых нот. Если в меню Options MIDI редактора отмечена опция Drawing or 
Selecting a Note Sets Note Length, щелчок на ноте или прорисовка новой ноты определит 
длительность добавляемых нот. 
 
 
 
 
 
 

 
Меню Scale и кнопка Chord: активирование привязки к тональности позволяет 
выбрать тональность, лад и аккорд из двух выпадающих списков. Можно также 
использовать кнопку Chords и далее Load (маркированную “Major”) для загрузки 
reascale файла. 
 
 
 
 
 
 
 
 

Меню Color: это меню используется для выбора цвета различных элементов MIDI 
редактора. 
 
 
 
 
 

 
Список треков: если в проекте используется несколько треков, в этом списке можно выбрать 
трек, который должен быть активным в MIDI редакторе. Эта кнопка также используется для 
отображения/скрытия панели списка треков. 
 
 
Меню Channel: это меню используется для выбора канала. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Совет: подменю Piano Roll Timebase (представление времени) для виртуальной клавиатуры MIDI 
редактора) в меню View MIDI редактора включает опции source beats (доли источника), project beats 
(доли проекта) и project time (время проекта). MIDI данные всегда определяются на основе долей, но в 

режиме представления времени сетка отражает любые изменения темпа в проекте. Если не будет никаких 
изменений темпа, представления долей и времени будут идентичны. Опция Project synced синхронизирует 
шкалу времени проекта и MIDI клипы и гарантирует, что оба окна будут синхронизированы во время таких 
действий как изменение масштаба и прокрутка. 
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Главное окно (5): по умолчанию состоит из двух панелей. Большая (главная) панель отображает MIDI ноты и 
используется для их редактирования. Представление по умолчанию - Piano Roll (виртуальная клавиатура). 
Вторая панель поменьше (внизу) - дорожки MIDI контроллеров, которые используется для отображения 
различной информации, например, для отображения значений velocity или высоты тона нот. Поместите курсор 
мыши на область главного окна (где отображены ноты), и курсор мыши изменится на карандаш, который 
указывает на текущую позицию редактирования, например, для вставки нот. Обе позиции - на шкале времени и 
на виртуальной клавиатуре отображаются в двух областях в верхнем левом углу окна редактора, ниже панели 
инструментов. 
Полосы прокрутки (6): окно MIDI редактора включает вертикальные и горизонтальные полосы прокрутки, 
которые могут использоваться для навигации и масштабирования. 
Дорожки MIDI контроллеров (7): по умолчанию отображается информация параметра Velocity. Чтобы 
изменить информацию: 

 
Используйте выпадающее меню (направо), или 
 
 
 
 
 
 
 

 
Щелкните по маленькой кнопке  рядом с меню, чтобы добавить дорожки. 
 

Щелчок правой кнопкой по затененной полоске наверху дорожки открывает меню, 
которое может использоваться для скрытия дорожки (Hide line), ее очистки (Clear line), 
изменения ее содержимого (Set lane) или добавления дополнительной дорожки (Add 
line).  
 
 
 
 
 

 
 

Чтобы удалить дорожку, щелкните по маленькому значку "минус" рядом со значком + .  
 

Наведите курсор мыши на ноту до появления двойной вертикальной стрелки. Щелкните и 
переместите мышь вверх или вниз чтобы изменить значение выбранного на дорожке 
контроллера для выбранной ноты (нот). При этом на нотах отображается значение MIDI 
контроллера. 
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Если высота дорожки достаточно высока, сообщения MIDI контроллера можно 
также заметить на MIDI клипе в главном окне 
 
 
 
 
 

 
13.7. MIDI-сообщения о смене контроллера (Control Change Messages) 

 
MIDI-сообщения о смене контроллера (Control Change Messages) используются для изменения статуса MIDI 
параметра. При использовании аппаратного MIDI-устройства, эти сообщения могут использоваться для 
физического управления педалями ножного управления, регуляторами громкости, колесами модуляции и 
другими контроллерами. В пределах REAPER MIDI-сообщения о смене контроллера могут моделировать этот 
эффект при воспроизведении MIDI данных через программный синтезатор. Данные контроллеров используются 
в различных целях. Различные потоки данных контроллеров пронумерованы от 0 до 127. Некоторые из этих 
номеров стандартны. Например, контроллер #7 обычно используется для управления громкостью, а контроллер 
#10 для панорамы. MIDI-сообщения о смене контроллера состоят из двух частей. Первая часть - номер 
изменения контроллера, который определяет параметр. Вторая часть - значение этого параметра. Например, 
сначала вы можете отправить сообщение CC#7, определив, что вы хотите отрегулировать громкость. Затем, вы 
отправляете значение, которое устанавливает фактический требуемый уровень громкости. MIDI-сообщение о 
смене контроллера может функционировать в качестве устанавливающего параметра для точного 
определенного значения или в качестве настройки параметра на определенное значение. 
 
13.7.1. Старший байт (MSB) и младший байт (LSB) 
 
MSB и LSB обозначают старший байт и младший байт соответственно. MSB MIDI сообщения о смене 
контроллера обычно действуют в качестве грубых настроек, в то время как сообщения LSB обычно 
обеспечивают более точные настройки. Некоторые MIDI-сообщения о смене контроллера включают как MSB, 
так и LSB версии. Большинство MIDI-устройств, включающих звуки/патчи отвечают, как на сообщения старшего 
байта для выбора банка, так и на MIDI-сообщения младшего байта для выбора подбанка или патча. Некоторые 
наиболее используемые параметры MIDI контроллеров перечислены ниже.  
 
Bank Select MSB/Bank Select LSB: большинство MIDI-устройств поддерживают в общей сложности более 128 
инструментов, в этом случае эти инструменты сгруппированы в банки. Таким образом, в зависимости от 
устройства, MIDI-сообщения о смене контроллера может состоять из пяти частей – CC#0 (выбор банка старшим 
байтом), сопровождаемый значением MSB банка звуков, затем CC#32 (выбор банка младшим байтом), 
сопровождаемый значением LSB, а затем наконец номер Program Change сообщения. Номера Program change 
сообщений будут подробно обсуждаться в дальнейших параграфах. 
Velocity: сила (скорость) нажатия на клавишу. Доступна также дорожка для MIDI контроллера Note Off Velocity. 
Mod Wheel: может использоваться для добавления вибрато или других модификаций звука. 
Breath: варьируется от 0 до 127 (максимальная сила). 
Portamento: определяет гладкость скольжения от ноты к ноте 
Balance: обычно используется для настройки громкости стереоклипов, не затрагивая панораму. 
Expression: используется для создания относительных изменений громкости (экспрессия). 
Sound Timbre: свойство звука, придающее ему его уникальный “тембр”. 
Sound Release: управляет затуханием звука. 
Sound Attack: управляет атакой звука. 
Sound Brightness: настройка управляет яркостью звука 
 

13.8. Основы управления каналами 
 
Сообщения MIDI Data Control Channel (CC) могут быть записаны через MIDI клавиатуру и отредактированы или 
введены вручную с использованием дорожки MIDI контроллеров, которая расположена внизу окна MIDI 
редактора. Данные отображаются горизонтально согласно их позиции на шкале времени, и вертикально 
согласно значению данных. У большинства MIDI контроллеров значение 0 внизу дорожки, а значение 127 
наверху дорожки. На рисунке ниже отображен параметр Velocity.  
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Исключения составляют MIDI контроллеры Pitch, Pan и Pan Position, которые отображаются положительными 
или отрицательными изменениями от центральной линии (рисунок ниже).  
 

 
 

MIDI контроллеры выбираются из выпадающего меню в левом нижнем углу окна 
редактора.  
 
 
 
 

Данные MIDI контроллеров вводятся или редактируются мышью. Чтобы удалить событие, щелкните по нему и 
нажмите Delete. Страница Options > Preferences > Mouse Modifiers включает возможность настроить 
поведение для щелчка левой кнопки мыши+перетаскивание и двойного щелчка при работе с событиями MIDI 
контроллеров. 
 

13.9. Работа с дорожками MIDI редактора 
 
Есть несколько особо интересных элементов, которые можно отобразить на дорожке или дорожках, и которые 
не включены в вышеупомянутый список. Они заслуживают особого внимания, так как могут ускользнуть из 
вашего внимания. Это сообщения System Exclusive messages (системные привилегированные MIDI-
сообщения), Text Events (текстовые сообщения), и Bank/Program Select (выбор банка/патча). 
 
13.9.1. Системные привилегированные MIDI-сообщения 
 

Сообщения System exclusive (Sysex) - 
это MIDI данные, которые могут 
пониматься только определенной 
моделью устройства, с помощью 
которого они были созданы. Например, 
все синтезаторы должны отвечать на 
сообщения MIDI контроллеров Volume 
или Pan, но Sysex сообщения, 
созданные синтезатором Roland, не 
будут поняты, скажем, синтезатором 
Yamaha. Для управления Sysex 
сообщениями можно добавить дорожку, 
как показано на рисунке направо.  
В данном примере дорожка Sysex 
отображена в дополнение к дорожке 
Velocity. Некоторое аппаратные MIDI 
устройства, особенно более старые, 
принимают Sysex сообщения в качестве 
способа инициализации или изменения 
настроек устройства. Sysex сообщения - 
это необработанные MIDI данные, 
представленные списком 
шестнадцатеричных байтов.  
Sysex события могут быть добавлены, 

отредактированы, перемещены или удалены таким же образом, как и текстовые события (см. ниже). Двойной 
щелчок по дорожке открывает диалоговое окно Add Sysex Event, где можно ввести сообщение и нажать OK. 
Sysex событие можно переместить мышью. Дважды щелкните по любому текущему Sysex событию, чтобы 
отредактировать его, или щелкните правой кнопкой мыши, чтобы удалить его. 
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13.9.2. Текстовые события 
 
Опция Text Events 
позволяет открыть 
дорожку, которая может 
использоваться для 
отображения текста на 
дорожке ниже MIDI нот. 
Это может быть, 
например, слова к 
песне или 
информацией о 
маркере или любым 
другим текстом. Просто 
дважды щелкните по 
любой точке на 
дорожке, чтобы открыть 
диалоговое окно Edit 

Text Event, введите текст, определите его тип и нажмите OK. Как и в случае с system exclusive событиями, 
двойной щелчок по любому событию текста позволяет его отредактировать. Текстовые сообщения также можно 
перетащить мышью. Щелчок правой кнопкой мыши удаляет текстовое сообщение. 
 
13.9.3. События выбора банка и патча 
 

При выборе дорожки MIDI контроллера Bank/Program Select, 
можно дважды щелкнуть по любой точке, чтобы открыть 
одноименное диалоговое окно, где можно выбрать любую 
комбинацию банка/программы и назначить эту комбинацию на 
любой канал. Доступные комбинации банка/программы будут 
зависеть от инструментов, которые вы используете (см. рисунок 
направо). Используя синтезатор, у которого есть его собственные 
инструментальные файлы, можно загрузить файл в MIDI редактор, 
нажав на кнопку Load File, затем перейти к его каталогу и выбрать 
сам файл.  
 
 
 
 
 
 
 
 

 
Пример использования program change события показан на рисунке ниже.  
 

 
 
Чтобы отредактировать любое сообщение program change, дважды щелкните по его дорожке и в окне 
Bank/Program Select внесите изменения. Program change сообщения можно перетащить мышью. Двойной 
щелчок на program change сообщении позволяет его отредактировать. Щелчок правой кнопкой мыши на 
program change сообщении удаляет его. 
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13.10. Дорожки MIDI контроллеров: советы и рекомендации 
 
Дорожки MIDI контроллеров REAPER включают несколько дополнительных функций. Вот некоторые, которые вы 
могли бы счесть полезными: 
 
13.10.1. Типичные способы редактирования дорожек 
 
Большинство типов сообщений MIDI контроллеров, таких как Mod Wheel, Breath, Portamento, Pan, Volume и 
т.д. могут быть выражены непрерывным диапазоном значений, а не дискретными элементами (например, как 
текстовые сообщения). Для таких типов сообщений есть стандартные способы ввода, редактирования или 
удаления. 

 
Чтобы ввести одно сообщение на соответствующей дорожке: щелкните по нужной точке и в 
нужной позиции (чем ближе щелчок к вершине дорожки, тем выше значение) и мягко переместите 
мышь вверх или вниз. 
 
 

Чтобы изменить значение текущего сообщения: потяните его вверх или вниз. 
Чтобы удалить сообщение: щелкните по нему правой кнопкой мыши.  

 
Чтобы удалить несколько сообщений, щелкните перед ними и проведите по ним с 
нажатой клавишей Alt. 
 
 

 
Чтобы вставить (нарисовать) последовательность сообщений: щелкните по нужной точке и в нужной 
позиции и переместите мышь влево или вправо и вверх, и вниз. На рисунке ниже таким способом нарисована 
последовательность сообщений MIDI контроллера Pan.  
 

 
 
13.10.2. Выделение рамки правой кнопкой мыши 

 
В пределах любой дорожки можно выделить рамку правой кнопкой мыши вокруг 
нескольких событий. После этого можно работать с ними как на дорожке MIDI 
контроллеров, так (если это возможно) в представлении виртуальной клавиатуры. 
Например, если на дорожке выбран MIDI контроллер Velocity, то в представлении 
виртуальной клавиатуры для каждой ноты будет отображено одно событие на 

дорожке. Выделение событий на дорожке выделит соответствующие ноты в представлении виртуальной 
клавиатуры. После этого Вы можете работать с этими выделенными событиями в MIDI редакторе или на самой 
дорожке. Например, вы можете: 
 
- удалить сообщения. 
- настроить их значения (щелчок на сообщении и перемещение мыши вверх или вниз). 
- щелкнуть правой кнопкой мыши по дорожке, чтобы открыть контекстное меню (см рисунок ниже), которое 
может использоваться для пошагового смещения или перемещения выбранных событий. 
- перетащить выделенный диапазон событий влево или вправо, или чтобы скопировать этот диапазон 
перетащить его влево или вправо с нажатой клавишей Ctrl.  
 

 
 
Точное поведение будет определено тем, соединяются ли отдельные события контроллера непосредственно с 
отдельными нотами. В данном примере это имело бы место с событиями velocity, но не событиями изменения 
высоты тона.  
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Таким образом в прежнем случае (velocity) необходимо было бы переместить события в представлении 
виртуальной клавиатуры, а события velocity переместились бы с нотами. В последнем случае (с событиями 
изменения высоты тона), необходимо было бы переместить события на самой дорожке. 
 
13.10.3. Интеллектуальное меню дорожек 
 

Выпадающее меню дорожек использует маркеры, чтобы показать, какие дорожки уже 
существуют и содержат данные, и отображаются ли они в настоящее время или нет. В 
примере, показанном здесь, это относится к дорожкам Velocity, Pitch, Program, 
Bank/Program Select, Text Events и Breath. 
 
 
 
 
 
 
 
 
 

13.10.4. 14-битные дорожки и действия с ними 
 

Выпадающее меню дорожек включает полный спектр опций для 14-битных сообщений 
MIDI контроллеров. Они находятся в конце списка. Доступны действия для выбора 
любого типа сообщения для любой дорожки. Использование редактора действий 
подробно объяснено в Главе 15, но вкратце: 
 
1. В меню Actions MIDI редактора выберите опцию Show action list 
2. В списке действий выберите одно из действий CC: Set CC lane to (например, 
создайте дорожку 007 Volume 14-bit или дорожку CC lane to 007 Volume MSB). Теперь 
можно назначить горячую клавишу на это действие (см. Главу 15). Закройте редактор 
действий. 
3. После этого можно в любое время выбрать действие MIDI Editor CC lane и 
использовать горячую клавишу для использования этой дорожки для выбранного типа 
сообщения: существующие данные будут отображены, а новые данные можно 

вставлять и/или редактировать. 
 
13.10.5. Изменение размера дорожек по высоте 
 

Для изменения высоты дорожек доступны три опции. Для применения всех трех 
опций необходимо щелкнуть по хэндлу (как на рисунке) на границе “потолка” 
выше рассматриваемой дорожки, чтобы курсор изменился на вертикальную 
двухстороннюю черную стрелку. Затем можно переместить мышь вверх или вниз. 
Когда у вас только одна дорожка все три действия делают одно и то же. Когда 
отображены две или более дорожек, эти три действия будут вести себя по-
разному: 
 
 
 
 

Щелчок+перемещение границы: просто изменяет высоту выбранной дорожки. Увеличение секции дорожек 
уменьшит высоту представления виртуальной клавиатуры и наоборот. Другие дорожки остаются нетронутыми. 
Щелчок+перемещение границы с нажатой клавишей Shift: увеличивает/уменьшает высоту всех дорожек и 
регулирует высоту представления виртуальной клавиатуры соответственно. 
Щелчок+перемещение границы с нажатой клавишей Ctrl: регулирует высоту одной дорожки, оставляя другие 
дорожки нетронутыми. Кроме того, двойной щелчок по хэндлу любой открытой дорожки дискретно переключает 
масштаб дорожки. 
 

13.11. Навигация главного окна MIDI редактора 
 
Несколько меню и списки действий MIDI редактора включают опции точной навигации: их мы рассмотрим позже. 
Но сначала необходимо ознакомиться с инструментами "грубой" навигации. Горизонтальные и вертикальные 
полосы прокрутки в окне MIDI редактора используются для их предназначенных целей, а их соответствующие 
кнопки + и -  могут использоваться для вертикального и горизонтального масштабирования. Для этих целей 
также можно использовать и колесо мыши, действия этих контроллеров можно настроить в редакторе действий 
(см. Главу 15), но по умолчанию они следующие: 
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Колесо мыши: горизонтальное масштабирование  
Ctrl+Колесо мыши: вертикальное масштабирование 
Alt +Колесо мыши: горизонтальная прокрутка  
Ctrl+Alt+Колесо мыши: вертикальная прокрутка  
 
Горячие клавиши PageUp и PageDown могут использоваться для вертикального масштабирования, а кнопки + и 
- для горизонтального масштабирования. Все это можно изменить в редакторе действий, если пожелаете. 
 

13.12. Основные способы выбора нот и соответствующие манипуляции 
 
Несколько меню и контекстных меню MIDI редактора включают опции точного управления и редактирования 
нот, с которыми мы подробно познакомимся позже. Но для начала необходимо ознакомиться с основными 
инструментами быстрого и базового редактирования. 

 
Чтобы добавить ноту: нарисуйте ноту в области редактирования. 
 
 

Чтобы удалить ноту: дважды щелкните по ноте. 
Чтобы выбрать ноту для редактирования: щелкните по ноте. 

 
Чтобы выделить несколько нот: нарисуйте рамку правой кнопкой мыши вокруг 
нужных нот в области редактирования или правой кнопкой мыши выделите ноты 
на виртуальной клавиатуре. 
 
 
 
 

 
 
Чтобы добавить ноты к текущим выбранным нотам: нарисуйте рамку вокруг нужных нот с нажатыми 
клавишами Alt и Ctrl. 

 
Чтобы изменить продолжительность ноты: наведите мышь на начало или окончание ноты 
пока курсор не изменится на двухстороннюю черную стрелку и переместите мышь влево или 

вправо. 
Чтобы переместить ноту: захватите и переместите ноту в новую позицию, а затем отпустите кнопку мыши. 
 

13.13. Выделенная область, область лупа и интеллектуальное редактирование 
 
Чтобы определить позицию курсора, щелкните по шкале времени в окне MIDI редактора. Выделенная область и 
область лупа в пределах MIDI редактора будет вести себя в соответствии со статусом опции Loop points linked 
to time selection в главном меню REAPER. Дальнейшие описываемые действия предполагают, что эта опция не 
отмечена. Можно выделить область лупа, как и в главном окне REAPER по шкале времени MIDI редактора - они 
будут отображаться зеркально (см. рисунок ниже).  
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Можно также использовать шкалу времени главного окна REAPER, чтобы выделить и изменить область лупа. 

Кнопка  на транспортной панели MIDI редактора может использоваться для активирования/отключения 
опции зацикливания.  

 
Выделить область можно в области между секциями дорожек и секцией редактирования, когда 
курсор примет такой вид, как на рисунке справа. Заметьте, что выделенная область зеркально 
отражается и в области аранжировки REAPER (см. рисунок выше). Это облегчает 
интеллектуальное редактирование (см. Главу 7). Например, в пределах прикрепленного окна 
MIDI редактора вы можете работать с фрагментом MIDI клипа, который вы хотите скопировать 
или переместить в другой трек, а затем, все еще находясь в MIDI редакторе, отметить этот клип 

как выделенную область. После этого в области аранжировки вы можете щелкнуть по выделенной области с 
нажатой клавишей Ctrl и переместить эту область чтобы ее скопировать. Используя эту функцию, необходимо 
сначала решить, хотите ли вы активировать опцию Auto-select CC when moving / copying within time selection 
(автоматический выбор MIDI контроллера при перемещении/копировании в пределах выделенной области) из 
меню Options. 
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13.14. Главные меню MIDI редактора 
 
Данная глава представляет собой обзор опций главных меню MIDI редактора. Когда окно MIDI редактора 
прикреплено на панели Docker, главные меню скрыты, но доступ к их опциям можно получить щелчком правой 
кнопкой мыши по вкладке окна на панели Docker. 
 
13.14.1. Меню File 

 
Rename MIDI take (переименовать MIDI клип). 
Export to new MIDI file (экспортировать активный MIDI трек в MIDI 
файл). MIDI события обычно хранятся в самом файле проекта. 
Notation: Export as MusicXML: Доступна только в представлении 
музыкальной нотации. См. следующий параграф. 
 
 
 
 
 
 

 
Подменю Customize note names:  
 
Rename current note (переименовать текущую 
выбранную ноту). Альтернативно, чтобы 
переименовать ноту, дважды щелкните правой 
кнопкой мыши по ней в представлении виртуальной 
клавиатуры. Клавиша Tab используется для 
перемещения к следующей ноте, а Shift+Tab к 
предыдущей ноте. 

Load note names from file (загрузить названия нот из файла). В этом меню также отображаются недавно 
используемые файлы. При загрузке файла с нажатой клавишей Shift можно объединить импортированные 
названия с текущими названиями нот, а не заменить их. 
Save note names to file (сохранить название ноты в файл)  
Clear note names (очистить текущие названия нот) 

 
Подменю Customize note colors:  
 
Load color map from file (загрузить цветовую схему с файла)/Clear 
color map (use defaults) (очистить цветовую карту и использовать 

карту по умолчанию). Эти опции используются для импорта вашего собственного PNG файла цветовой карты 
или для восстановления карты по умолчанию. Подробнее о том, как создать файл цветовой карты на странице 
forum.cockos.com/showthread.php?t=78839 
Close Editor: закрывает окно MIDI редактора и отображает главное окно REAPER. 
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13.14.2. Меню Edit  
 
Undo (отмена последнего действия)  
Redo (возврат отмены последнего действия)  
Copy (копировать) 
Cut (вырезать) 
Paste/Paste preserving position in measure: 
Опция Paste вставляет событие в текущую 
позицию курсора. Если вырезано или скопировано 
несколько нот, эти ноты будут вставлены 
последовательно в текущей позиции курсора.  
Paste preserving position in measure (вставить 
ноты в следующий такт после позиции курсора, 
сохранив относительную позицию вставляемого 
клипа). Обратите внимание на то, что можно 
вырезать, копировать и вставлять между 
несколькими окнами MIDI редакторов, и в 
некоторые внешние приложения. 
Select all (выделить все события)  
Delete (удалить событие) 
Mute (мьютировать выделенные ноты). 
Insert note (вставить ноту в позиции курсора 
редактирования). 
Join notes (соединить выделенные ноты). 
Set note ends to start of next note (legato): 
примыкает окончания выбранных нот к началу 
следующих нот, подстраивая окончания всех нот в 
выбранном диапазоне. 
Quantize…: открывает одноименное диалоговое 
окно. Подробнее об этой функции в параграфах 

"Функция Quantize" и "MIDI инструменты". 
 

 
 
Подменю Quantize: 
 

 
 
Humanize: открывает одноименное диалоговое 
окно. Функция Humanize основана на внесении 
изменений в точную синхронизацию ритма/метра 
и параметра velocity, позволяя сделать MIDI звук 
менее “строгим” и более реалистичным. 
Расположенная также в меню Edit, эта опция 
доступна для назначения действий мыши. 
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Transpose: открывает одноименное диалоговое окно, которое может 
использоваться для перемещения всех или выбранных MIDI нот на 
конкретное количество полутонов с привязкой к тональности/ладу. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
13.14.3. Меню Navigate 
 
Это меню обеспечивает опции перемещения нот в любом направлении, на основе сетки или позиции нот: 
 

Move cursor left by grid (переместить курсор влево 
на одно деление сетки)/Move cursor up one 
semitone (переместить курсор вверх на один 
полутон)/Move cursor right by grid (переместить 
курсор вправо на одно деление сетки)/Move cursor 
down one semitone (переместить курсор вниз на 
один полутон)  
 
Доступно также несколько опций, которые могут 
использоваться для перехода и выбора нот, либо 
вместо, либо в дополнение к любому текущему 
выбору: 
 
Select note nearest cursor (выбрать ноту, ближайшую 
к курсору) 
Add note nearest cursor to selection (добавить ноту к 
выбору в ближайшей позиции курсора) 
Select previous note (выбрать предыдущую ноту) 
Select next note (выбрать следующую ноту) 
Select previous note with same pitch (выбрать 
предыдущую ноту той же высоты тона) 
Select next note with same pitch (выбрать 
предыдущую ноту же высоты тона) 
Select all notes with same pitch (выбрать все ноты с 
одинаковой высотой тона) 

Add previous note to selection (добавить предыдущую ноту к выбору) 
Add next note to selection (добавить следующую ноту к выбору) 
Move edit cursor to start of selection (переместить курсор редактирования в начало выбора) 
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13.14.4. Меню Options 
 
Dock window (прикрепить окно MIDI 
редактора на панель Docker). При 
этом главное меню MIDI редактора 
будет скрыто. Доступ к этому меню 
можно получить щелчком правой 
кнопкой мыши по вкладке окна на 
панели Docker. 
Sync editor transport to project 
transport (синхронизировать 
транспортную панель MIDI 
редактора с главной шкалой 
времени REAPER). 
Use the same grid division in 
arrange view and the MIDI editor: 
эта опция делает отображение в 
области аранжировки и MIDI 
Редакторе совместимыми друг с 
другом 
Chase MIDI note-ons in project 
playback: когда вы запускаете 
воспроизведение в любом месте 
проекта кроме как в самом начале 
проекта, есть риск, что события, 
которые начинаются 
непосредственно перед позицией 
воспроизведения могут быть не 
услышаны. Например, это может 

случиться при воспроизведении проекта с середины длинной ноты. Эта опция (которая по умолчанию 
активирована) это предотвращает. 
Подменю Time format for ruler, transport, event properties: формат времени для шкалы времени, 
транспортной панели, событий. Доступные значения Measures.Beats.100ths (такты. доли. сотые долей) и 
Measures.Beats.MIDI_ticks (такты. доли. MIDI тики). 
 

 
 
Подменю Snap Settings: подменю с опциями привязки: Snap notes/CC to grid (привязывать ноты/MIDI 
контроллеры к сетке), Soft-snap notes to other notes (мягко привязывать ноты к другим нотам), Always 
snap notes to the left (всегда привязывать ноты к левой позиции), Snap note ends to grid (привязывать 
окончания нот к сетке) и Snap notes relative to grid (привязывать ноты к сетке относительно). 
 

 
 
Подменю Note preview: подменю с опциями выбора способа прослушивания нот - Preview notes when 
inserting or editing (воспроизводить ноты при вставке и редактировании), Preview on velocity change (при 
изменении velocity), Preview on keyboard action (при нажатии на клавиши виртуальной клавиатуры) и/или 
Preview all selected notes that overlap with selected note (все выбранные ноты, которые накладываются на 
выбранную ноту). 
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CC events in multiple media items (события MIDI контроллеров в нескольких клипах): включает две опции - 
Draw and edit on all tracks (добавить и редактировать на всех треках) или Edit on all tracks (редактировать на 
всех треках). 
Drawing or selecting a note sets the new note length: переопределяет длительность ноты по умолчанию, 
установленную в меню Notes на транспортной панели. 
Allow MIDI note edit to extend the media item: если эта опция активирована, продолжительность клипа будет 
расширена при перемещении или копировании нот в пределах выделенная области. 
Auto-select CC when moving/copying within time selection: если эта опция активирована, при перемещении 
или копировании выделенной области она будет включать события MIDI контроллеров. 
Display 14-bit MSB/LSB CC data as a single entry: если эта опция активирована, 14-битные MSB/LSB данные 
MIDI контроллеров будут отображаться одним клипом (а не отдельными) в окне списка событий и свойствах 
Automatically correct overlapping notes (автоматически исправлять пересеченные ноты). 
Use F1-F12 as step sequencer: если эта опция активирована функциональные клавиши (F1 - F12) могут 
использоваться для ввода нот по полутонам, начиная с клавиши F1 и заканчивая клавишей F12. Стартовая 
тональная позиция клавиши F1 обозначается подсвеченной полоской. В примере на рисунке направо, стартовая 
тональная позиция для клавиши F1 - нота C6. В этом случае нажатие (например), клавиши F5 создаст ноту "ми". 
Перемещая подсвеченную полоску и курсор редактирования, а также используя функциональные клавиши для 
ввода нот, можно быстро создавать полноценные аранжировки. Обычно этот режим продвигает курсор согласно 
параметрам привязки. Это поведение можно обойти, удерживая клавишу Shift при нажатии функциональной 
клавиши. 
Use all MIDI inputs for step recording: активирует использование сигнала входного MIDI порта при пошаговой 
записи. 
MIDI editor mouse modifiers: открывает страницу модификаторов мыши в предварительных настройках, где 
можно выбрать действия, которые будут назначены на поведение мыши в различных контекстах. Подробнее об 
этом в этой главе и в Главе 15. 
Customize menus/toolbars: открывает одноименное окно. Подробности в Главе 15. 
 
13.14.5. Меню View 

 
Filter events, Quantize, Humanize, Transpose: в зависимости от 
выбранной команды открывает одноименное меню, которые 
обсуждались ранее в этой главе. 
Event properties: открывает диалоговое окно свойств ноты. Эта тема 
затрагивается далее в этой главе, наряду с темой "Контекстное меню 
ноты". 
 

 
 
Raw MIDI data: открывает окно, отображающее необработанные MIDI 
данные для текущего выбранного клипа. 
 

 
 
Mode: piano roll: выбор представления виртуальной клавиатуры. 
Mode: named notes: выбор представления маркированных нот.  
 

Заметка: эта опция работает только с VSTi инструментами, которые протоколируют маркировку нот, 
например, Fxpansion's BFD. Обратитесь на форум REAPER, чтобы проверить доступен ли плагин 
переименования нот для VSTi, который вы хотите использовать. Например, такой плагин доступен для 

EZDrummer. 
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Mode: event list: выбор представления сриска событий. 
Mode: musical notation: выбор представления музыкальной нотации 
Подменю Piano roll notes: включает опции Rectangles, Triangles и Diamonds, которые определяют вид нот в 
редакторе. Доступны также три опции - Show velocity handles on notes (отображать хэндлы velocity на 
нотах), Show velocity numbers on notes (отображать числовые значения velocity на нотах), Show note 
names on notes (отображать названия нот на нотах), Show velocity and names only on the active media 
item (отображать числовые значения velocity и названия нот только активных клипов). 
 

 
 
В примере, показанном здесь, отображены хэндлы velocity и названия нот. 
 

 
 
Подменю Color notes by: это подменю позволяет выбрать критерии, используемые для окраски нот. Доступные 
опции - Velocity, Channel, Pitch, Source (использовать цветовую карту), Track и Media item. Доступна также 
опция Show color selector in editor (отображать селектор цвета в редакторе) и опция Load color map from 
file (загрузить цветовую карту из файла), и Clear color map (очистить цветовую карту). 
 

 
 
Подменю Show/hide note rows: включает три взаимоисключающие опции, позволяя определить, какие нотные 
дорожки будут отображаться в редакторе. Show all note rows (показать все дорожки нот), Hide unused note 
rows (скрыть неиспользуемые дорожки нот), Hide unused and unnamed note rows (скрыть неиспользуемые и 
неименованные дорожки нот). Hide опции не совместимы с представлением виртуальной клавиатуры. 
 

 
 
 
Подменю Piano roll ruler: включает опции отображения или скрытия маркеров проекта, регионов проекта и/или 
темпомаркеров/маркеров музыкального размера на шкале времени представления виртуальной клавиатуры, 
выше шкалы, а темпомаркеры/музыкального размера можно отредактировать, дважды щелкнув по ним, а 
щелчок правой кнопкой мыши открывает контекстное меню. 
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Подменю Piano roll timebase: представление времени виртуальной клавиатуры. Представление времени 
виртуальной клавиатуры затрагивает только отображение MIDI нот и событий контроллеров и не влияет на их 
воспроизведение Доступные опции: 
 
Source beats: доли считываются от начала клипа; линейка проекта игноририруется. Отображается только одно 
повторение лупа. Доли отображены равномерно, независимо от изменений темпа проекта. 
Project beats: используется линейка проекта. Клип отображен целиком со всеми повторениями лупа. Доли 
отображены равномерно, независимо от изменений темпа проекта. 
Project time: используется линейка проекта. Клип отображен целиком со всеми повторениями лупа. Доли 
расположены с интервалами согласно изменениям темпа проекта. 
Project sync: дисплей идентичен дисплею Project time. Линейка MIDI Редактора сохраняет вертикальное 
выровнивание с линейкой проекта. 
 

 
 
Подменю Notation view options: различные опции, относящиеся к представлению музыкальной нотации. 
 

 
 
13.14.6. Меню Contents 

 
Track List/Media Item Lane: открывает 
соответствующее представление – список треков или 
дорожки клипов. 
Media item selection mirrors arrange view: если эта 
опция отмечена, выбор MIDI клипа в MIDI редакторе 
выберет этот клип в области аранжировки, и наоборот. 
One MIDI editor per: открывает подменю, где можно 
выбрать использование одного MIDI редактора на клип, 
трек или проект. Подробнее об этом в главе 
“Управление несколькими MIDI треками и клипами”. 
 
 

 

 
 
Behavior for «open items in built-in MIDI editor»: это подменю определяет поведение для действия «открыть 
клипы во встроенном MIDI редакторе»: Open the clicked item only (открыть только клип по которому 
щелкнули), Open all selected MIDI items (открыть все выбранные MIDI клипы), Open all MIDI items on the 
same track as the clicked item (открыть все MIDI клипы на том же треке, где был клип, по которому 
щелкнули) и Open all MIDI in the project (открыть все MIDI клипы проекта) 
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Options when using one MIDI editor per project: открывает подменю с различными опциями, которые 
определяют поведение REAPER при использовании одного MIDI Редактора на проект. Дополнительная 
информация в главе “Управление несколькими MIDI треками и клипами". 
 

 
 
Список треков/клипов проекта: перечисляет все треки, включающие MIDI клипы и аудиоклипы. Галочка 
указывает, что клип в настоящее время открыт и активен. Выберите клип из этого меню, чтобы открыть его в 
окне MIDI редактора, скрыв все остальные клипы: если при этом удерживать клавишу Shift, остальные клипы 
скрыты не будут. 
 
13.14.7. Меню Actions  
 

Включает две опции по умолчанию - Show action 
list (отобразить список действий) и Show recent 
actions (отобразить последние использованные 
действия). Show action list открывает окно 
Actions с автоматическим выбором секции MIDI 
Editor. Пользовательские действия и горячие 
клавиши играют важную роль в работе MIDI 
редактора. Если отмечена опция Show recent 

actions, меню действий будет перечислять недавно использованные действия, а также любые 
пользовательские действия или назначения клавиатуры, которые вы туда поместили. Эти опции можно 
выбирать из этого меню (см. рисунок направо). Далее в этой главе мы рассмотрим некоторые простые примеры 
использования списка действий. Редактор действий будет подробно рассматриваться в Главе 15. Наконец 
помните, что в REAPER широко применяются контекстные меню. 
Список действий нотного редактора также включает несколько опций выбора (Select): различные действия для 
выбора событий MIDI контроллеров в выделенной области, действия для выбора событий MIDI контроллеров 
под выбранными нотами, действия для выбора мьютированных нот и всех нот в такте, действия для выбора 
всех нот в позиции курсора высоты тона и действия для выбора следующей ноты тональной позицией выше или 
ниже. 
 

13.15. Создание и редактирование нот 
 
13.15.1. Введение 
 
MIDI клип может включать данные максимум 16 каналов. В MIDI редакторе можно отобразить и отредактировать 
все 16 MIDI каналов, либо в целях ограничения числа каналов использовать окно Filter Events или выпадающий 
список Channels. Если вы выберете опцию Channel из выпадающего списка Color, каждый канал будет 
окрашен в отдельный цвет, как в представлении виртуальной клавиатуры, так и на дорожке MIDI контроллеров. 
Интерфейс MIDI редактора по умолчанию - представление виртуальной клавиатуры (Piano Roll), позволяющее 
отобразить и отредактировать MIDI информацию. Ноты отображаются по вертикали согласно их значению на 
клавиатуре (тональная позиция), и по горизонтали согласно длительности каждой ноты и местоположения в 
пределах MIDI клипа или на шкале времени. 
 
13.15.2. Виртуальная клавиатура 
 

Виртуальная клавиатура обеспечивает визуальное представление тональных позиций нот 
и позволяет прослушивать ноты, без необходимости предварительного их ввода или 
редактирования. Нажатие на клавишу виртуальной клавиатуры отправляет 
соответствующее сообщение о MIDI ноте в MIDI инструмент, который подколочен к треку. 
Виртуальная клавиатура Reaper velocity-зависимая (на примере виртуальной клавиатуры 
Kontakt) - чем правее щелчок по клавише, тем больше значение velocity и наоборот. 
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13.15.3. Ввод/редактирование нот 
 
MIDI ноты можно записать с MIDI клавиатуры, импортировать из MIDI файла, или ввести в MIDI редакторе. 
 
13.15.3.1. Ввод/редактирование нот с использованием мыши 

 
Ноты можно нарисовать, щелкнув и не отпуская кнопку мыши 
перетащить мышь влево-вправо в представлении виртуальной 
клавиатуры. Если активирована привязка, продолжительность ноты 
будет привязана к ближайшей линии сетки (Grid Line) (и в зависимости 

от значения меню Straight в параметрах привязки).  
 

 
 
Ноты можно ввести двойным щелчком по представлению виртуальной клавиатуры (в месте, не занятом другой 
нотой). В этом случае продолжительность ноты определяется значением параметра сетки (Grid Setting). 
Ноты можно удалить двойным щелчком по ноте.  
 

Продолжительность ноты можно изменить, захватив край ноты.  
 
 
 
Захватив ноту, ее можно перетащить вверх-вниз и вправо-влево. Когда вы отпустите кнопку 
мыши, ноты будут помещены согласно параметрам привязки.  
 
 
 
 

Параметр Velocity ноты можно отрегулировать, захватив вершину ноты и переместив мышь 
вверх-вниз, точно так же, как и хэндл клипа в главном окне REAPER.  
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13.15.3.2. Контекстное меню представления Piano Roll 
  
Copy/Cut/Paste: стандартные опции редактирования 
Windows - Копировать/Вырезать/Вставить. 
Paste preserving position in measure (вставить ноты в 
следующий такт после курсора, сохранив относительную 
позицию вставляемого клипа (ов). 
Select all (выбрать все ноты в данном окне MIDI редактора) 
Delete (удалить все выбранные ноты) 
Mute (мьютировать все выбранные ноты или ноту) 
Insert note: это быстрый способ вставить ноты в позиции 
курсора согласно текущим значениям привязки.  
Split notes: разделить ноты в позиции курсора 
редактирования. 
Join notes: соединить все выбранные ноты, создав одну 
ноту на дорожке. 
Set note ends to start of next note (legato): объединяет 
окончание каждой ноты в выборе до начала следующей 
ноты в выборе. 
Select previous note/Select next note: выбрать 
предыдущую или следующую ноту вместо текущего выбора. 
Select previous note with same pitch (выбрать предыдущую 
ноту с той же высотой тона, что и текущая выбранная 
нота)/Select next note with same pitch (выбрать 
следующую ноту с той же высотой тона, что и текущая 
выбранная нота)/Select all notes with same pitch (выбрать 
все ноты ноту с той же высотой тона, что и текущая 
выбранная нота). 
Rename current note: позволяет переименовать ноту в 
представлении виртуальной клавиатуры под курсором. 
 

 
Note properties: атрибуты MIDI ноты можно 
отредактировать, введя значения в соответствующих 
текстовых областях: note (тональная позиция ноты), 
velocity, position (позиция по времени ноты), channel 
(канал), note off velocity (значение velocity сообщения 
отпускания ноты), length (длительность ноты). Чтобы 
внести относительные значения, можно использовать 
клавиши + или -. Например, для параметра note ввод 
значения +1o2 изменит тональную позицию ноты на одну 
октаву и два полутона вверх. 
 
 
 

 
Note channel (1-16): быстрый способ переключить канал для текущих выбранных нот. Например, выбор канала 
№8 гарантирует, что нота будет использовать канал 8 - и отправит эту ноту в канал №8 vsti или Midi 
инструмента. 
Note velocity (1-127): используется для изменения значения velocity ноты или нескольких выделенных нот, в 
пределах от 1 до 127. 
Notation: представляет собой ограниченное подменю с некоторыми музыкальными опциями нотации - Voice, 
Phase/slur, Articulation, Ornament и Note head. Они объяснены в следующей главе. Данные нотации можно 
отобразить на дорожках MIDI редактора. Они выбираются так же как и другие данные, такие как Velocity, Pitch, 
и т.д. 
 

13.16. Ввод/редактирование нот с использованием клавиатуры компьютера 
 
В контекстном меню ноты, вы заметите, что по умолчанию на большинство опций назначены горячие клавиши. 
Есть и другие горячие клавиши, которые в этом контекстном меню не отображаются. Некоторые наиболее 
полезные из них перечислены ниже. Ноты можно ввести в позиции курсора редактирования используя клавишу I 
или в позиции курсора мыши используя клавишу Insert. Длительность ноты будет определена единицей 
деления сетки (в области Grid Division). Позиция курсора редактирования на шкале времени регулируется при 
помощи следующих горячих клавиш: 
 
Чтобы переместить курсор редактирования вправо на одно деление сетки: стрелка вправо курсора 
клавиатуры или Ctrl + клавиша 6 на цифровой клавиатуре 
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Чтобы переместить курсор редактирования влево на одно деление сетки: стрелка влево курсора 
клавиатуры или Ctrl + клавиша 4 на цифровой клавиатуре 
Чтобы переместить курсор редактирования вправо на один пиксель: Shift +стрелка вправо или Ctrl+Alt + 
клавиша 6 на цифровой клавиатуре 
Чтобы переместить курсор редактирования влево на один пиксель: Shift +стрелка влево или Ctrl+Alt + 
клавиша 4 на цифровой клавиатуре 
 
Ноты могут быть перемещены с использованием следующих горячих клавиш: 
 
Чтобы переместить выбранную ноту(ы) вниз на октаву: Alt + клавиша 2 на цифровой клавиатуре 
Чтобы переместить выбранную ноту(ы) вниз на полутон: клавиша 2 на цифровой клавиатуре 
Чтобы переместить выбранную ноту(ы) вверх на октаву: Alt + клавиша 8 на цифровой клавиатуре 
Чтобы переместить выбранную ноту(ы) вверх на полутон: клавиша 8 на цифровой клавиатуре 
Чтобы переместить курсор редактирования влево на один пиксель: Alt + клавиша 4 на цифровой клавиатуре 
Чтобы переместить курсор редактирования влево на одно деление сетки: клавиша 4 на цифровой клавиатуре 
Чтобы переместить курсор редактирования вправо на один пиксель: Alt + клавиша 6 на цифровой клавиатуре 
Чтобы переместить курсор редактирования вправо на одно деление сетки: клавиша 6 на цифровой 
клавиатуре 
 
Отображение нот можно отфильтровать для каналов 1 - 10, используя горячие клавиши с Shift +1 по Shift +0. 
Горячая клавиша Shift+ ' удаляет фильтр и восстанавливает отображение всех нот. 
 
13.16.1. Использование клавиш F1-F12 в качестве пошагового секвенсора 
 
При выборе опции Use F1-F12 as step sequencer, для ввода нот могут использоваться функциональные 
клавиши F1-F12. Полутона октавы распределены от клавиши F1 (нижняя тональная позиция) до клавиши F12 
(высшая тональная позиция). Этот способ уже описывался в главе, посвященной меню Options MIDI редактора. 
Окно Note Properties: горячая клавиша Ctrl+F2 может использоваться для открытия окна Note Properties как 
альтернатива выбору соответствующей опции из контекстного меню. 
Выбор/редактирование нескольких нот: несколько нот можно выбрать щелчком по нотам с нажатыми 
клавишами Ctrl или Shift, нарисовав выделяющую рамку вокруг группы нот, или при помощи команды Select All 
(выделить все) (Ctrl+A). 
 
- тональную позицию всех выбранных нот можно отрегулировать перетаскиванием одной из выбранных нот. 
- длительность всех выбранных нот можно отрегулировать перетаскиванием края одной на выбранных нот. 
- параметр velocity всех выбранных нот можно отрегулировать перетаскиванием хэндла velocity одной из 
выбранных нот. 
 
Значение velocity по умолчанию для нот, созданных в MIDI редакторе принимается с последнего выбранного 
события - например, если значение velocity последнего выбранного равнялось 70, значение velocity для 
следующей созданной ноты будет также 70 и т.д. 
 

13.17. Транспозиция нот 
 
В качестве альтернативы использованию опции Edit > Transpose для транспозиции MIDI нот можно 
использовать горячие клавиши. Сначала выберите нужные ноты, а затем используйте следующие горячие 
клавиши: 
 
Чтобы транспонировать ноты вверх на октаву: Alt + клавиша 8 на цифровой клавиатуре 
Чтобы транспонировать ноты вверх на полутон: Ctrl + клавиша вверх курсора клавиатуры или клавиша 8 на 
цифровой клавиатуре 
Чтобы транспонировать ноты вниз на октаву: Alt + клавиша 2 на цифровой клавиатуре 
Чтобы транспонировать ноты вниз на полутон: Ctrl + клавиша вниз курсора клавиатуры или клавиша 2 на 
цифровой клавиатуре 
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13.18. Программные патчи General MIDI 
 
Вы уже знаете, что для изменения программы в пределах клипа 
можно использовать дорожку выбора банка и патча (MIDI 
контроллер Bank/Program Select). Стоит отметить, что REAPER 
включает файл GM. reabank (в папке Application 
Data\REAPER\Data), который может использоваться для выбора 
стандартных банков и патчей General MIDI. Пример показан на 
рисунке слева. Если банки General MIDI не доступны в 
выпадающем списке Bank, нажмите кнопку Load File, перейдите к 
папке Data REAPER и выберите файл GM. reabank. 
 
 
 
 
 
 
 
 
 

 
13.19. Функция Scrub для прослушивания MIDI материала 

 
В пределах представления виртуальной клавиатуры и представления 
маркированных нот MIDI материал можно прослушать перетаскиванием курсора 
редактирования вдоль шкалы времени. Эта функция схожа с функцией Scrub при 
прослушивании аудиоматериала: точное поведение функции Scrub будет 
определено параметрами страницы Options > Preferences > Audio > Playback. 
 

 

 

 

 
 
 
 

 
13.20. Режимы и представления MIDI редактора 

 
13.20.1. Режимы нот 
 
У MIDI редактора есть три режима, доступные из меню View: 
 
1. Представление виртуальной клавиатуры (Piano Roll View) - горячая клавиша Alt+1. 
2. Представление маркированных нот (Named Notes View) - горячая клавиша Alt+2. 
3. Список событий (Event List) - горячая клавиша Alt+3. 
 
Вплоть до этого момента единственным представлением, используемым в этом Руководстве пользователя, 
было представление виртуальной клавиатуры. Перед тем как перейти к исследованию других двух 
представлений, есть несколько моментов, которые вы могли бы счесть интересными. 
 
13.20.1.1. Представление маркированных нот  
 

В этом режиме дважды щелкнув правой 
кнопкой мыши по левой панели можно ввести 
псевдоним для ноты, как показано на рисунке.  
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Если в меню View вы отметили опцию Show 
note names on events, псевдонимы нот будут 
отображаться на самих фактических нотах, а 
также названия нот будут отображаться в 
представлении виртуальной клавиатуры, как 

показано на рисунке. В представлении маркированных нот в меню View доступны также опции Show all note 
rows (показать все дорожки нот) - опция по умолчанию, Hide unused note rows (скрыть неиспользуемые 
дорожки нот) и Hide unused and unnamed note rows (скрыть неиспользуемые дорожки нот и дорожки с 
неименованными нотами). Сокрытие неиспользованных нотных дорожек может облегчить навигацию MIDI 
редактора при работе с текущими нотами. Однако проблемы могут возникнуть в том случае, если вы затем 
захотите добавить или переместить ноты на пустые дорожки. Опция Hide unused and unnamed note rows 
(скрыть неиспользуемые и неименованные дорожки нот) может помочь вам обойти эти проблемы. Перед 
выбором последней опции потратьте время на именование нужных пустых дорожек, гарантируя, что эти 
дорожки будут доступны. 
 
13.20.1.2. Список событий 
 

  
 
Список событий отображает MIDI информацию о событиях в виде таблицы. В этом режиме можно использовать 
контекстного меню (как на рисунке выше) для, например, копирования, вырезания, вставки, удаления или 
мьютирования любых событий. Полное меню отображено на рисунке. Двойной щелчок по любому событию 
открывает его окно свойств (см. рисунок ниже).  
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Конечно же, информация 
диалогового окна свойств 
будет в значительной 
степени зависеть от типа 
события. Панель 
инструментов 
представления списка 
событий упрощена в 
отличии от таковой в других 
двух представлениях. 
Самая левая кнопка Filter 
используется также, как и в 
других двух представлениях 
для фильтрации только тех 
событий, которые вы хотите 
отобразить. Кнопка Add 
Event вставляет новое 
событие перед текущим 
выбранным событием, а 
кнопка Delete удаляет 
текущее выбранное 
событие. Четвертая кнопка 
прикрепляет/от стыковывает 
окно MIDI редактора на 
панель Docker. 

 
Примечание: если в меню Options активирована (по умолчанию) команда Display 14-bit MSB/LSB CC 
data as a single entry in event list view and event properties dialog 14-битные MSB/LSB данные MIDI 
контроллеров будут отображаться одним клипом, а не по отдельности. 

 
13.20.2. Типы отображения нот 
 
По умолчанию, тип отображения используемых в MIDI редакторе нот - прямоугольник. До этого момента этот 
тип использовался во всех примерах представления виртуальной клавиатуры и представления маркированных 
нот. Однако доступны еще два типа отображения нот, которые используются со звуками барабанов. Это 
треугольник и ромб. Чтобы выбрать тип отображения нот, перейдите View> Piano Roll Notes и выберите тип: 
Rectangle (прямоугольник), Triangle (треугольник) или Diamond (ромб). На рисунке ниже изображен пример 
использования типа треугольника вместо прямоугольника. 
 

 
 

13.21. Квантизация MIDI данных 
 
Термин Quantize относится к процессу выравнивания нот к точному значению. При этом программа перемещает 
каждую ноту в ближайшую позицию сетки, в соответствии с выбранным значением деления сетки. Функция 
Quantize доступна в меню Edit MIDI редактора выбором одноименной опции. При этом открывается диалоговое 
окно, показанное на рисунке ниже. В диалоговом окне Quantize Events в меню Settings доступны две опции: 
Use Grid (использовать установки сетки) и Manual (выбрать параметры вручную). Вскоре мы дойдем до 
опции Use Grid. На рисунке выше показан интерфейс диалогового окна, которое появляется при выборе опции 
Manual. Различные параметры квантизации объясняются ниже. Обратите внимание на опцию Bypass в верхнем 
правом углу окна. Если она не отмечена, результат при выборе различных параметров квантизации будет виден 
в реальном времени. Переключение этой опции позволяет сравнить результат до и после квантизации. 
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Первое меню Quantize: All Notes (все ноты), Selected 
Notes (выделенные ноты), All Events (все события), 
Selected Events (выбранные события).  
Второе меню Quantize работает в паре с опцией, 
выбранной в первом меню: Position (позиция), Position 
and Note End (позиция и окончание нот), Position and 
Note Length (позиция и нотная длительность), Note 
End Only (только окончания нот) или Note Length 
Only (только длительность нот).  
Слайдер Strength управляет точностью выравнивания 
нот. Чем ниже значение, тем меньше сетка 
примагничивает к себе ноты.  
Меню Grid и Length определяют, какие 
(под)разделения нот будут использоваться для 
квантизации. Эти меню работают в паре с опциями 
секции Allow notes to. Доступные типы сетки - straight, 
triplet, dotted, swing. Если выбран тип swing, 
необходимо будет также определить степень колебания 
сетки с помощью слайдера Swing strength. 
Опции Move left и Move right: если в меню Quantize 
выбрана опция Position, эти опции гарантируют, что 
каждая нота будет выровнена к началу или к окончанию 
нотной длительности, в зависимости от близости к этим 
позициям. Опция Move left будет выравнивать ноты 
только к началу, а опция Move right только к окончанию 

ноты. 
Опции Shrink и Grow: эти опции применяются в том случае, если в меню Quantize выбрана опция Length. 
REAPER будет удлинять или сокращать ноты, перемещая окончание каждой ноты. Можно активировать как по 
одной, так и обе эти опции. 
Секция Only quantize range: фейдеры позволяют определить процентный диапазон квантизации. Значение 
50% соответствует середине между линиями сетки. Значения больше 50% заметны только в том случае, если 
отключены опции Move left и Move right.  
Опция Fix Overlaps: если эта опция отмечена, это предотвращает наложение нот при квантизации. Если в 
меню Settings выбрана опция Use Grid, диалоговое окно Quantize Events примет вид как на рисунке ниже.  
 

 
 
Из меню Grid (внизу окна MIDI редактора, рядом с транспортной панелью) выберите длительность ноты, а 
затем выберите из соседнего меню выберите тип ноты. Необходимо также установить значение ноты в меню 
Notes которое принимает свое значение в зависимости от того, что выбрано в меню Grid. Альтернативно, 
можно выбрать любое другое значение из этого меню. При правильном использовании, значение swing может 
привести к более музыкально приятному результату. По сути вы определяете задержку в процентах, которая 
будет применена к слабым долям. Например, если вы применяете значение swing к четвертным нотам, 
половинные ноты затрагиваться этим значением не будут, а ноты между четвертями будут задержаны на 
определенную величину. Небольшие значения параметра swing (даже 5% или меньше) могут помочь 
предотвратить механичность музыки. Quantize - функция неразрушающая - т.е. этот процесс можно повернуть в 
любое время. Другие опции в меню Edit, использующие квантизацию: 
 
Quantize notes using last settings (выровнять ноты, используя последние сделанные настройки): диалоговое 
окно Quantize Events игнорируется, облегчая применение те же самых настроек квантизации к различным 
выборам нот. 
Quantize notes position to grid (выровнять позиции нот к параметрам сетки) 
Unquantize events: отменяет квантизацию и возвращает ноты в их предыдущее состояние. 
Freeze quantization for events: фиксирует квантизацию для всех текущих выбранных событий. Взгляните на 
рисунки.  
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На верхнем рисунке - две не выровненные выбранные ноты. На втором рисунке ниже они 
выровнены с перемещением их влево. На третьем рисунке они выровнены с 
перемещением их вправо. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Дополнительные опции квантизации доступны в списке действий MIDI редактора, включая квантизацию позиций 
нот к определенным нотным длительностям (делениям сетки), в пределах от 1/4 до 1/64. 
 

13.22. Функция Input Quantization 
 
Термин Input Quantization относится к процессу автоматического выравнивания MIDI нот при их вводе, 
например, с MIDI клавиатуры или через виртуальную клавиатуру REAPER и применяется на основе трека. 
Щелкните правой кнопкой мыши по индикатору уровня трека (на панели трека или на панели микшера) и 
выберите опцию Track Recording Settings из контекстного меню.  
 

 
 
В появившемся диалоговом окне необходимо отметить опцию Quantize track MIDI recording. Другие опции 
включают: 
 
- для квантизации можно использовать длительность нот (меню Quantize to). 
- опции позиции квантизации в меню positioning: Nearest value (ближайшее значение), Previous value 
(предыдущее значение) и Next value (следующее значение). 
- будут ли выравниваться окончания нот (опция Quantize note-offs). 
- степень квантизации (слайдер Quantization strength). Низкие значения обеспечивают более тонкие 
изменения, создавая более “живой” эффект. 



 Специально для сайта musicmanuals.ru  278 278 

- слайдер Swing. Диапазон значение между 0% и 100%. Этот параметр можно использовать для добавления 
небольшой задержки к нотам, которые не попадают на слабую долю. Лучший способ понять принцип работы 
этого параметра - поэкспериментировать с ним. 
- квантизация в пределах процентного диапазона (Quantize within). Эти фейдеры схожи с фейдерами Nearly 
Quantized и Far From Quantized диалогового окна Quantize Events (см. предыдущий параграф). 
 
Кроме того, секция Main (alt Recording) списка действий включает действия для: 
- переключения функции MIDI input quantize для всех треков, выбранный треков, или последнего затронутого 
трека. 
- активирования/отключения функции MIDI input quantize для всех треков, выбранный треков, или последнего 
затронутого трека. 
 

13.23. Функция Humanize 
 
Функция Humanize (из меню Edit MIDI редактора) 
может использоваться для внесения тонких 
изменений в MIDI клип, который слишком точен, 
слишком идеален. Например, живой пианист 
никогда не нажмет клавиши одинаково точно и 
синхронно. Диалоговое окно Humanize Notes может 
использоваться для внесения случайных изменений 
в синхронизацию и velocity текущего MIDI клипа, 
заставляя звучать его более "оживленно"! 
 
 
 
 
 

13.24. Клавиша F3 - аварийная кнопка 
 
Клавиша F3 может стать вашим лучшим другом, когда вы работаете в MIDI редакторе (и когда вы 
воспроизводите MIDI клипы в главной области аранжировки REAPER). Нажатие клавиши F3 отключает все ноты 
в выходном MIDI сигнале до тех пор, пока вы не остановите воспроизведение и не возобновите его. 
 

13.25. Использование MIDI редактора: основные действия 
 
В данном простом примере мы рассмотрим некоторые общие действия в MIDI редакторе REAPER. Цель этого 
примера не том, чтобы создать потрясающе блестящую музыкальную пьесу, а помочь вам ознакомиться с 
основными функциями MIDI редактора. Пошаговые инструкции предполагают, что вы используете платформу 
PC Windows. Пользователям платформы OS/X необходимо скорректировать некоторые шаги. 
 
Пример: 
 
1. Создайте новый проект. Добавьте один трек и активируйте его для записи, а также установите MIDI 
клавиатуру или виртуальную клавиатуру в качестве устройства ввода. 
2. Запишите приблизительно 20 или 30 секундный отрывок простой мелодии на канале #1. Ваш трек и клип 
будут выглядеть примерно так: 
 

 
 
3. На платформе Windows, откройте окно маршрутизации трека и добавьте выходной порт MIDI устройства 
Microsoft GS Wavetable SW Synth. 
4. Воспроизведите мелодию, которая должна играть звуком фортепьяно. 
5. Дважды щелкните по клипу, чтобы открыть его в MIDI редакторе. 

6. Убедитесь, что кнопки Track List  и Media Item Lane  на панели инструментов отключены – на 
данном этапе они не нужны 
7. Откройте меню Notes и выберите значение 1/2. 
8. Прокрутите колесо мыши вверх или вниз для установки предпочтительного горизонтального масштаба. 
Используйте клавишу Ctrl с колесом мыши, чтобы установить вертикальный масштаб. Должно быть что-то 
вроде этого: 
 



 Специально для сайта musicmanuals.ru  279 279 

 
 
8. Добавьте еще несколько нот в окне редактирования. Поэкспериментируйте с основными действиями мыши 
чтобы переместить эти ноты и изменить их длительность. Удалите те ноты, которые вам не нужны. 
9. Теперь установить горизонтальный масштаб так, чтобы видеть всю длину клипа. 
10. В меню CC Lane выберите MIDI контроллер Bank/Program Select. 
 

 
 
11. В самом начале песни, дважды щелкните по дорожке MIDI контроллеров. Выберите банк General MIDI и 
программу Church Organ. Нажмите OK. 
12. Возвратитесь к началу шкалы времени и воспроизведите мелодию. Теперь ваша мелодия должна играть 
звуками органа. 
13. Нарисуйте несколько длинных нот, как показано на рисунке ниже. Выделите их правой кнопкой мыши. 
 

 
 
14. Щелкните правой кнопкой по любой из выделенных нот и выберите опцию Note Channel из меню, а затем 
выберите канал #2. 
15. Дважды щелкните по дорожке MIDI контроллеров, в начале песни. Выберите General MIDI, Choir Aaahs и 
Channel 2. Нажмите OK. 
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16. Воспроизведите песню с начала. Теперь вы услышите орган с хором. Хор может показаться слишком 
громким. 
17. В меню CC Lane выберите MIDI контроллер 07 MSB Volume. 

18. На панели инструментов нажмите кнопку Filter  и отметьте Channel 2. Теперь слышен будет только 
хор. 
19. Щелкните на дорожке MIDI контроллеров, и удерживая кнопку мыши перетащите ее вдоль дорожки, рисуя 
низкий порог громкости, как показано на рисунке ниже. 
 

 
 
20. Отмените фильтр канала и восстановите все каналы. 
21. Откройте меню Color и выберите опцию Channel. 
22. Закройте MIDI редактор и сохраните файл. 
23. Воспроизведите файл. Теперь хор должен звучать намного тише. 
 

13.26. Пошаговая запись (Step Recording) 
 
Пошаговая запись - способ записи MIDI нот в пределах MIDI Редактора REAPER в пошаговом режиме. Вкратце, 
это выглядит так: сначал выбирается размер шага, т.е. длительность, затем вы наигрываете ноты на MIDI 
клавиатуре или используя функциональные клавиши F1-F12. После каждой добавленной ноты позиция 
перемещается к ожиданию следующей ноты с учетом выбранного шага (длительности). При необходимости 
можно изменить длительность при записи. Давайте рассмотрим этот процесс более пристально: 
 
1. В главном меню REAPER перейдите Insert > Virtual Instrument on new track. Выберите инструмент и 
нажмите OK. По умолчанию будет вставлен трек, который будет автоматически активирован для записи с 
активированным мониторингом входного сигнала. 
2. Откройте меню Input этого трека и выберите MIDI канал (или все каналы) для вашей MIDI клавиатуры. 
3. В области аранжировки "нарисуйте" (выделите область) продолжительность MIDI клипа. В главном меню 
перейдите Insert > New MIDI item, чтобы вставить MIDI клип. 
4. Откройте клип в MIDI Редакторе двойным щелчком по нему (по умолчанию) или в контестном меню выберите 
опцию Open in built-in MIDI editor. 
5. При использовании клавиатуры компьютера, активируйте пошаговую запись либо выбрав опцию Use all MIDI 

inputs for step recording из меню Options MIDI редактора, либо нажав кнопку  на панели инструментов 
MIDI редактора. 
6. Если хотите использовать клавиши F1 - F12, активируйте эту опцию в меню. После этого данные клавиши 
будут распределены на 12 полутонов октавы. В данном примере мы и будем использовать эти клавиши. Однако 
предпочтительней использовать все таки MIDI клавиатуру. 
7. Выберите длительность ноты (например, 1/4, 1/8) из выпадающего списка рядом с транспортной панелью 
MIDI редактора. 
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8. На виртуальной клавиатуре нажмите ноту (например, C4). Теперь это будет нота соответствующая клавише 
F1. Дальнейшие нажатые ноты выше первой будут соответствовать последующим клавишам F2-F12.  
9. Выбор другой ноты в представлении виртуальной клавиатуры MIDI редактора сбросит значение клавиши F1 
(и всех остальных функциональных клавиш соответственно). Эти инструкции обозначают основы пошаговой 
записи. В зависимости от используемого вами виртуального инструмента и от настроек вашей MIDI клавиатуры, 
возможно, вам придется перенастроить эти параметры. 
 

13.27. Работа с несколькими MIDI треками и/или MIDI клипами (общий обзор) 
 
Сделать MIDI клипы доступными для редактирования можно из области аранжировки, выбрав опцию Open in 
built-in MIDI editor из контекстного меню области. По умолчанию двойной щелчок по клипу имеет тот же самый 
эффект. Точное поведение REAPER здесь будет определено выбранной опцией в диалоговом окне Options > 
Preferences > Editing Behavior > MIDI Editor - см. также Главу 22. Здесь вы можете выбрать одну из трех опций 
- использовать отдельное окно MIDI редактора для каждого клипа (One MIDI editor per media item), один 
экземпляр редактора на трек (One MIDI editor per track) или один экземпляр редактора для всего проекта (One 
MIDI editor per project). Например, если вы выбрали опцию One MIDI editor per media item, каждый MIDI клип, 
по которому вы дважды щелкнули откроется в отдельном окне MIDI редактора. Если выбрана опция One MIDI 
editor per project, двойной щелчок по любому MIDI клипу откроет все MIDI клипы в одном окне MIDI редактора, 
а выбранным и активным клипом будет тот, по которому вы щелкнули. Если выбрана опция One MIDI editor per 
project, необходимо будет определить также, открывать ли только MIDI клип, по которому вы щелкнули (Open 
the clicked MIDI item only), отрыть все выбранные MIDI клипы (Open all selected MIDI items), открыть все MIDI 
клипы на том же самом треке (Open all selected MIDI items on the same track) или все MIDI клипы проекта 
(Open all MIDI in the project).  
 

 
 
В пределах MIDI редактора ваши настройки по умолчанию можно изменить в меню Contents. Треками и 

клипами можно управлять в MIDI редакторе, отобразив их дорожки (кнопка Media Item Lane ) и список 

треков (кнопка Track List ). Обе эти опции также доступны в меню Contents. На рисунке ниже приведен 
пример окна MIDI редактора, открытого с тремя MIDI треками, первый из которых включает три клипа. 
Активированы обе кнопки - Track List и Media Item Lane.  
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В MIDI редакторе каждый клип имеет три статуса - статус видимости (Visible), статус активности (Active) и 
статус редактирования (Editable). Visible означает, что клип и его ноты будут отображаться в окне MIDI 
редактора. Active означает, что клип может использоваться для вставки, копирования, вставки нот, и т.д. 
Editable означает, что действия редактирования мыши (перемещение, изменение длительности, и т.д.), и опции 
Quantize, Transpose и Humanize можно применять к нотам этого клипа. Активным может быть только один 
клип, но видимыми и редактируемыми могут быть сколько угодно клипов. Отметьте также, что: 
 
- клип может быть видим, но быть не редактируемым или не активным. Видимыми могут быть один или 
несколько клипов. 
- доступным для редактирования клип также может быть видимым, но не обязательно должен быть активным. 
Доступными для редактирования могут быть один или несколько клипов. 
- активный клип доступен для редактирования и видим. Активным может быть один и только один клип. 
 

Клип можно активировать в списке треков.  
 
 
 
 
 

Трек можно активировать в меню Contents, или используя выпадающее меню в конце транспортной панели. 
Если трек включает только один MIDI клип, этот клип будет активным. Если трек включает несколько клипов, все 
клипы будут видимы и доступны для редактирования, но только один клип будет активен. Окно Filter Events 
позволяет выбрать каналы для отображения и редактирования. Если вы отметите два или более каналов в этом 
окне, выпадающее меню каналов внизу MIDI редактора будет отображать лейбл “Multi” или “All”. 
Альтернативно, можно использовать выпадающее меню каналов для выбора опции “All”. Столбец MIDI в 
менеджере треков (Глава 12) может также использоваться для открытия/удаления клипов из MIDI редактора, и 
отображения/скрытия клипов в меню треков MIDI редактора. Треки можно отобразить/скрыть в списке треков, 
используя контекстное меню списка треков. 
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13.28. Управление несколькими MIDI треками и клипами 
 
13.28.1. Список треков 

Список треков (Track List) активируется одноименной кнопкой  на панели инструментов MIDI редактора, 
или из меню Contents. Щелкните правой кнопкой по области списка треков, чтобы открыть его контекстное 
меню.  

 
Здесь можно выбрать режим - автоматический (Automatic mode) 
и ручной (Manual selection mode). В автоматическом режиме, 
щелчок по имени клипа автоматически выбирает его и 
активирует, а также делает его единственным доступным для 
редактирования клипом. В ручном режиме, щелчок по имени 
клипа автоматически не активирует его, и при этом не 
затрагивается статус других клипов. В любом режиме можно 
всегда щелкнуть по значку make active любого клипа (зеленая 
стрелка, указывающая вниз), чтобы активировать его, или 
щелкнуть по зеленому значку замка, чтобы сделать его 
доступным для редактирования. Можно выбрать 
взаимоисключающие опции Selection linked to visibility 
(выбранные клипы будут видимыми) или Selection linked to 
editability (выбранные клипы будут редактируемыми). Видимые 
или доступные для редактирования треки автоматически 

добавляются к выбранным трекам. Две взаимоисключающие опции из меню Options MIDI редактора 
повторяются и здесь: это Draw and edit CC events on all tracks (прорисовывать и редактировать события 
контроллеров на всех треках) и Edit CC events on all tracks (редактировать события контроллеров на всех 
треках). Можно использовать опцию Choose which tracks appear in track list (выбрать треки, которые будут 
отображаться в списке треков), чтобы скрыть/отобразить нужные треки в списке треков.  

 
При выборе этой опции около каждого имени трека появляется символ X, который служит 
для отображения треков. В его затененном состоянии по умолчанию трек отображается, 
когда этот символ окрашен в красный цвет трек скрыт.  
 
 
 

Опция Show all tracks in track list восстанавливает отображение всех треков в списке треков. Наконец, можно 
выбрать опцию Show tooltips in MIDI track list (показать подсказки в списке MIDI треков). Команда Options 
when using one MIDI editor per project (которую также можно найти в меню Contents MIDI редактора) включает 
опции, которые позволяют определить поведение MIDI редактора при выборе и редактировании клипов). 
Переключаемые опции, относящиеся к выбору клипов: Active MIDI item follows selection changes in arrange 
view (активный MIDI клип следует за изменениями в выборе в области аранжировки), Media item selection is 
linked to visibility (выбор клипа привязывается к функции видимости) и Media item selection is linked to 
editability (выбор клипа привязывается к функции редактирования). 

 
На рисунке слева изображены три трека, включающие в общей 
сложности пять MIDI клипов. Трек Acoustic Guitar включает три клипа. 
Клип guitar break 1 является активным клипом: он также доступен для 
редактирования и видим. Клип guitar break 2 доступно для 
редактирования и видим, а клип guitar break 3 видим, но не доступен 
для редактирования. Клип acoustic bass доступен для 
редактирования и видим. Клип electric guitar не видим и поэтому не 
доступен для редактирования. Символ ромба налево от каждого имени 
трека открывает и закрывает список MIDI клипов на этом треке. 
Щелкните по любому имени клипа, чтобы выбрать его, или по любому 
имени трека чтобы выбрать все клипы на треке. Чтобы выбрать 

несколько клипов можно щелкнуть по ним с нажатой клавишей Ctrl. В автоматическом режиме первый клип в 
выборе будет активным, но это поведение можно изменить, нажав на значок “make active” любого другого 
клипа. Затем можно использовать другие значки, чтобы установить другие качества клипа - цвет значка или 
статус редактирования для всех выбранных клипов. Щелчок по маленькому цветному квадрату направо от 
имени клипа открывает цветовую палитру, которая может использоваться для выбора цвета для этого клипа на 
дорожке клипов. Столбец направо от палитры цветов – столбец кнопок “make active”. Щелкните по этому 
столбцу, чтобы сделать любой клип текущим для вставки событий (отображенные зеленой стрелкой). Это 
действие также автоматически делает клип видимым и доступным для редактирования. Щелкните по 
следующему столбцу направо от этого столбца, чтобы сделать любой клип видимым и доступным для 
редактирования, который обозначается зеленым значком открытого замка.  
Если содержимое не отображается, проверьте: 1) параметры прокрутки окна MIDI редактора, и 2) фильтр 
канала, убедившись, что нужный канал включен в фильтр.  
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Этот же зеленый значок может использоваться для переключения редактирования. Символ глаза направо от 
зеленого значка используется для переключения видимости любого клипа (или нескольких клипов) в MIDI 
редакторе. Серый/красный круг направо от символа глаза (для треков) служит для активирования статуса 
записи этого трека и используется вместе с кнопкой записи на транспортная панели в области аранжировки. 
Кнопка M направо от кнопки активирования записи служит для переключения статуса мьютирования отдельных 
треков или клипов. Кнопка S направо от кнопки M служит для переключения статуса солирования для любого 
трека. Для изменения текущих настроек MIDI редактора можно также использовать меню Contents (из главного 
меню MIDI редактора). В частности, вы можете: 
 
- использовать опцию One MIDI editor per (отдельное окно MIDI редактора для...) и выбрать Media item (клип), 
Track (трек) или Project (проект). 
- выбрав опцию One MIDI editor per project изменить настройки поведения “open items in built-in MIDI editor” 
(открыть клипы в MIDI редакторе) в следующие значения: clicked MIDI item only (только MIDI клипу, по 
которому щелкнули), all selected MIDI items (все выбранные MIDI клипы), all MIDI items on same track as 
clicked item (все MIDI клипы на том же треке, что и клип, по которому щелкнули) или all MIDI items in project 
(все MIDI клипы в проекте). 
 
Меню Contents также включает ряд переключаемых опций, которые будут применены, когда выделены все MIDI 
клипы в проекте: Only MIDI items on same track as active item are editable (только MIDI клипы на том же 
треке, что и активированный для редактирования клип), Clear editor when changing active MIDI item (shift 
toggles) (очистить редактор при смене активного MIDI клипа) и Close editor when active item is deleted in 
Arrange view (закрыть редактор при удалении активного клипа в области аранжировки). Подробнее о 
предварительных настройках MIDI параметров и опциях в Главе 22. Доступна также переключаемая опция 
Active MIDI item follows selection changes in Arrange view (активный MIDI клип следует за изменениями в 
области аранжировки). Это позволяет вам активировать любой MIDI клип, выбрав его в области аранжировки. 
 
13.28.2. Дорожка клипа 
 
Отображает MIDI клипы и их позицию в аранжировке. В автоматическом режиме, щелчок по любому клипу 
выбирает его и активирует. Как и в случае со списком треков, можно использовать горячую клавишу 
Ctrl+щелчок, чтобы выбрать несколько клипов.  

 
Отдельное контекстное меню клипа 
включает различные опции 
окрашивания клипов. 
 
 

13.29. Редактирование нескольких клипов 
 
Чтобы можно было отредактировать несколько MIDI клипов одновременно, необходимо сначала выбрать те 
клипы, которые вы хотите сделать доступным для редактирования, как объяснено в предыдущем параграфе. 
После этого можно выполнить типичные действия редактирования мыши, такие как копирование или 
перемещение, настройка velocity, растяжение по времени (stretching) и т.д. Список ниже представляет 
некоторые примеры применения различных задач MIDI редактирования. Предполагается, что к этому моменту 
вы знакомы с основами навигации MIDI редактора и способами редактирования, объясненными ранее в этой 
главе. Более того рекомендуется не экспериментировать с редактированием нескольких MIDI клипов, если вы 
не уверены в том, что справитесь с редактированием одного MIDI клипа. 

 
Совет: прежде, чем применить любую из нижеперечисленных задач редактирования в MIDI редакторе, 
проверьте настройки фильтра канала и убедитесь, что редактируемые ноты видимы! 
 

Чтобы переименовать трек/клип: дважды щелкните по имени в списке треков и отредактируйте его. 
Чтобы скопировать/переместить ноту (или несколько нот) в другой клип в пределах MIDI редактора: 
Убедитесь, что исходный клип (ы) доступны для редактирования. Выберите ноту(ы), нажмите Ctrl+C 
(копировать) или Ctrl+X (вырезать). Активируйте целевой клип. При необходимости поместите в нужную 
позицию курсор воспроизведения. Нажмите Ctrl+V (вставить). 
Чтобы скопировать/переместить ноту (или несколько нот) в другой клип в области аранжировки: Сделайте 
исходный клип (ы) доступным для редактирования в MIDI редакторе. Выберите ноту(ы), нажмите Ctrl+C 
(копировать) или Ctrl+X (вырезать). Выберите целевой клип в области аранжировки и активируйте его в MIDI 
редакторе, поместите в нужную позицию курсор воспроизведения. Нажмите Ctrl+V (вставить). 
Чтобы отредактировать мышью несколько нот в нескольких MIDI клипах: сделайте клипы доступными для 
редактирования. Выберите ноты и используйте мышь (например, чтобы перетащить ноты, захватите одну из 
выбранных нот или чтобы изменить длительность нот, захватив край одной из выделенных нот). 
Чтобы удалить несколько выбранных нот в нескольких клипах: сделайте клипы доступными для 
редактирования. Выберите ноты и нажмите клавишу Delete. 
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Чтобы мьютировать/размьютировать несколько выбранных нот в нескольких клипах: сделайте клипы 
доступными для редактирования. Выберите ноты и нажмите Alt +M или используйте опцию Mute events из 
меню Edit. 
Чтобы изменить свойства нескольких выбранных нот: сделайте клипы доступными для редактирования. 
Выберите ноты и нажмите Ctrl+F2. Сделайте изменения, и нажмите OK. 
Чтобы применить функции Quantize, Humanize, Transpose к нескольким клипам: сделайте нужные клипы 
доступными для редактирования. Выделите ноты и выберите нужную команду из меню Edit. 
Чтобы отрегулировать velocity выбранных нот в нескольких клипах: откройте дорожку velocity и сделайте 
клипы доступными для редактирования. Выделите нужные ноты. Захватите верхний край любой их выбранных 
нот, чтобы отрегулировать velocity всех выделенных нот. 
Чтобы отредактировать данные MIDI контроллеров нескольких MIDI клипов: отобразите дорожку MIDI 
контроллеров и сделайте клипы доступными для редактирования. Выберите нужные события и выполните 
необходимое редактирование мышью или через диалоговое окно свойств события. 
Чтобы отобразить/скрыть все MIDI клипы на треках в списке треков: щелкните (для выбора одного трека) 
или используйте горячую клавишу Shift +щелчок (для выбора нескольких треков) на символе ромба налево от 
имени трека в списке треков. 
Чтобы отобразить/скрыть все треки/MIDI клипы в трек-папке: щелкните по символу круга налево от имени 
трек-папки в списке треков. 
 

13.30. Модификаторы мыши в MIDI редакторе 
 
Диалоговое окно Mouse Modifier можно открыть через команду Options > MIDI editor mouse modifiers. Там 
можно настроить точное поведение мыши при работе в MIDI редакторе. Есть несколько областей MIDI 
редактора, где можно изменить поведение мыши: MIDI note (MIDI нота), MIDI note edge (окончание MIDI ноты), 
MIDI CC lane (дорожка MIDI контроллеров), MIDI CC event (событие MIDI контроллеров), MIDI Source loop 
and marker (луп и маркеры MIDI источника), MIDI ruler (шкала времени), MIDI marker/region lanes (дорожки 
MIDI маркеров/регионов), MIDI piano roll (виртуальная клавиатура) и MIDI editor (MIDI редактор). В 
большинстве случаев отдельные контексты также доступны для поведения щелчка левой кнопкой мыши, 
щелчка левой кнопкой мыши+перетаскивание и двойного щелчка. Можно определить поведение мыши, когда 
она используется в любом из этих контекстов. Например, горячую клавишу Shift +Alt+щелчок левой кнопкой 
мыши можно назначить для переключения статуса мьютирования ноты. Подробнее о модификаторах мыши, 
включая модификаторы мыши в MIDI редакторе в Главе 15. 
 

13.31. Список действий MIDI редактора 
 
Список действий MIDI редактора REAPER позволяет назначить горячие клавиши на любую опцию, действие или 
последовательность действий, включая те, которые не отображаются в меню MIDI редактора. Подробнее об 
этом в Главе 15. Список действий открывается командой Show actions list из меню Actions.  
 

 
 
Первое, что необходимо заметить, что список действий содержит множество назначаемых действий, которые не 
отображаются в меню REAPER. Это означает, что вы можете назначить свои собственные горячие клавиши для 
любого из этих действий, и даже для последовательности действий. Обратите внимание на рисунке выше, что 
при использовании списка действий MIDI редактора, вы можете назначить MIDI команды и действия на клавиши 
так, чтобы поведение этих клавиш в MIDI редакторе отличалось от их поведения в главном окне REAPER.  
Вы видите, что их довольно много, и что некоторые уже назначены на клавиши. Можно назначить и ваши 
собственные клавиши на другие действия. Давайте возьмем простой пример. При работе с MIDI редактором 
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важно выбирать ноты быстро и легко. Если в области фильтра списка действий ввести add note, то будут 
показаны только те действия, которые включают эти символы. Одно из этих действий - Add next note to 
selection (добавить следующую ноту к уже выбранным). На это действие можно назначить горячую клавишу, 
например, клавишу N. 
 
Пример: 
 
1. С любым MIDI клипом, открытым в MIDI редакторе, перейдите Actions > Show actions list. 
2. Щелкните по действию Add next note to selection. 
3. Нажмите кнопку Add. 
4. В окне Keyboard или MIDI Input нажмите на букву N. Нажмите OK. Теперь эта клавиша назначена на это 
действие. 
5. Закройте список действий. 
6. Щелкните по любой ноте, чтобы выбрать ее. Теперь нажмите клавишу N несколько раз. Каждый щелчок будет 
добавлять следующую ноту к уже выбранным. После этого можно переместить эти ноты вместе, или присвоить 
им другой канал, удалить их или выполнить любое другое действие редактирования. В Главе 15 вы увидите, что 
редактор действий позволяет сделать намного больше, чем этот простой пример. Например, вы можете: 
 
- объедините в цепочку любую последовательность действий так, чтобы эту последовательность можно было 
выполнить нажатием одной клавиши. 
- добавить действия и пользовательские действия на панель инструментов MIDI редактора и/или в меню 
действий MIDI редактора и/или любую из команд меню MIDI редактора REAPER (File, Edit, Navigate. Options, и 
т.д.) 
- команды MIDI редактора (такие как Edit -> Delete events, Edit → Insert note, Edit → Quantize, Navigate → 
Select next note, Options → Correct overlapping notes when editing, и т.д.) можно найти в списке действий. 
Кроме того, доступно несколько сотен очень точных действий, которые не отображаются в меню. Таблица ниже 
включает некоторые из них. 
 

Категория/группа Примеры назначаемых действий MIDI редактора 

Выбор нот/событий 

- выбрать все ноты с тем же значением (Select all notes with same 
note value)   
- выбрать ноты, ближайшие к курсору редактирования (Select note 
nearest to edit cursor) 
- выбрать все мьютированные ноты (Select all muted notes) 
- добавить следующую/предыдущую ноту к уже выбранным (Add 
next/previous note to selection)  
- добавить ноту, ближайшую к курсору редактирования к уже 
выбранным (Add note nearest edit cursor to selection)  
- выбрать/снять выбор со всех событий MIDI контроллеров 
(Select/unselect all CC events)  
- выбрать/снять выбор со всех событий MIDI контроллеров на 
последней дорожке, по которой щелкнули (Select/unselect all CC 
events in last clicked lane)  
- выбрать все ноты в выделенной области (Select all notes in time 
selection)  
- выбрать все ноты, начиная с выделенной области (Select all notes 
starting in time selection)  
- выбрать все события MIDI контроллеров в выделенной области 
(несколько вариаций) (Select all CC events in time selection) 

Активирование клипа/трека 

- активировать следующий/следующий 
видимый/предыдущий/предыдущий видимый MIDI клип (Activate 
next/next visible/previous/previous visible MIDI item) 
- активировать следующий/следующий 
видимый/предыдущий/предыдущий видимый MIDI трек (если открыто 
несколько клипов/треков) (Activate next/next 
visible/previous/previous visible MIDI track (if multiple items/tracks 
are open) 

Управление дорожками 
непрерывных MIDI контроллеров 

- следующая/предыдущая дорожка (Next/previous CC lane) 
- устновить дорожку в качестве …дорожки (Set CC lane to xxx) 

Дисплей канала 

- показать только канал … (Show only channel xx) 
- показать только следующий/предыдущий канал (Show only 
next/previous channel) 
- подключить канал … (Toggle channel xx) 
- окрасить ноты/непрерывные MIDI контроллеры канала (Color 
notes/CC by channel) 

Действия сетки - установить тип сетки (Set grid type (straight, dotted, triplet, swing) 
- настроить смещение сетки (Adjust swing grid strength 
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(CC/mousewheel) 

Вставка/редактирование/управление
/перемещение/транспозиция нот 

- окрасить ноты по значению velocity/каналу/клипу/используя 
цветовую карту/пользовательский цвет трека (Color notes by 
velocity/channel/media item custom color/using colormap/by track 
custom color)  
- удалить все ноты/лишние ноты меньше по длительности от 1/128 до 
1/8 (Delete all notes/trailing notes less than [1/128 to 1/8] note in 
length)  
- удлинить/укоротить на один пиксель/одно деление сетки 
(Lengthen/shorten one grid unit/one pixel)  
- залиговать ноты с сохранением начальной позиции 
нот/относительного расстояния между нотами (Make notes legato, 
preserving note start times/relative note spacing)  
- переместить ноты вверх/вниз на одну октаву/полутон 
(транспозиция) (Move notes down/up one octave/semitone 
(transpose)  
- переместить ноты влево/вправо на один пиксель/одно деление 
сетки (Move notes left/right one grid unit/one pixel)  
- инвертировать выбранные/все ноты (Invert selected/all notes) 
- обратить выбор выделенных/всех нот (Reverse selected/all notes)  
- инвертировать голоса в аккорде (Invert chord voicings)  
- редактировать velocity нот на +/- 01/10 (Edit note velocity +/- 01/10)  
- установить длительность нот к делению сетки/двойному делению 
сетки/половине деления сетки (Set note length to grid 
size/double/half) 
 - установить длительность для следующей вставляемой ноты к сетке 
(Set length for next inserted note to grid) 
- обрезать левый/правый края нот к курсору редактирования (Trim 
left/right edge of notes to edit cursor)  
- вставить ноты длительностью от 1/128 до 1 (Insert note [1/128 to 1] 
note length)  
- продлить окончание ноты до начальной позиции следующей ноты 
(Set note ends to start of next note)  
- установить позицию ноты к курсору редактирования (Set note 
position to edit cursor)  
- разделить ноты относительно сетки (Split notes on grid) 
-копировать/вырезать/дублировать ноты в пределах выделенной 
области (Copy/cut/duplicate notes within time selection)  
- подогнать ноты к границам выделенной области (Fit notes to time 
selection) 
- вставить события в активные клипы независимо от источника клипа 
(это позволяет копировать клипы из нескольких выделенных клипов в 
один клип) (Paste events into active media item regardless of source 
media item) 

Область лупа/выделенная область 

- граница лупа: установить начальную/конечную границы (Loop point: 
set start/end point)  
- удалить границы лупа (Remove loop point)  
- удвоить/разделить наполовину длины лупа (Double/halve loop 
length)  
- установить выделенную область под выбранные ноты (Set time 
selection to selected notes)  
- удалить выделенную область (Remove time selection)  
- удалить границы выделенной области/лупа (Remove time and 
loop point selection)  
- переместить курсор к началу/окончанию области лупа/выделенной 
области (Move cursor to start/end of loop/time selection) 

Перемещение курсора 

- переместить курсор вперед на длительность от 1/128 до 1 (Cursor 
advance [1/128 to 1])  
- переместить курсор вперед на длительность от 1/32T до 1/4T 
(Cursor advance [1/32T to 1/4T]) 
- переместить курсор влево/вправо на один такт 
- переместить курсор в начпло/конец текущего такта 

Текстовые события 

- выравнять текстовые события к нотам (Align lyric events with 
notes)  
- импортировать текстовые события для выбранных нот из файла 
(Import lyrics for selected noted from file)  
- вставить/редактировать текстовые события в первой выбранной 
ноте (Insert/edit text/lyric event at first selected note)  
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- выбрать следующее/предыдущее текстовое событие (Select 
next/previous lyric event)  
- сдвинуть текстовые события назад/вперед на одну ноту (Shift lyric 
events backward/forward one note) 

Модификаторы мыши 

- доступны действия для выбора поведения модификаторов мыши 
"щелчок левой кнопкой мыши+перетаскивание" в пределах MIDI 
редактора для каждой категории событий MIDI контроллеров,  
- щелчок левой кнопкой мыши+перетаскивание на дорожке MIDI 
контроллеров,  
- щелчок правой кнопкой мыши+перетаскивание в окне MIDI 
редактора,  
- щелчок левой кнопкой мыши+перетаскивание краев нот,  
- щелчок левой кнопкой мыши на ноте, - щелчок левой кнопкой 
мыши+перетаскивание нот,  
- щелчок левой кнопкой мыши в представлении виртуальной 
клавиатуры,  
- щелчок левой кнопкой мыши+перетаскивание в представлении 
виртуальной клавиатуры,  
- щелчок левой кнопкой мыши и щелчок левой кнопкой 
мыши+перетаскивание на шкале времени.  

 
13.32. Оперативное MIDI редактирование 

 
Чтобы использовать оперативный редактор (In-line Editor) для любого MIDI клипа, сначала выберите клип, а 
затем либо нажмите клавишу E, либо щелкните правой кнопкой мыши по клипу и перейдите Open items in 
Editor > Open items in In-line Editor.  
 

 
 
Оперативный редактор отображается только при достаточной высоте трека. Основной MIDI редактор REAPER 
рекомендуется для серьезного и всестороннего редактирования MIDI клипов. Однако некоторые типичные 
задачи можно выполнить и в оперативном редакторе. Это позволяет отредактировать MIDI клип, не покидая 
главного окна. Оперативный редактор включает упрощенное представление виртуальной клавиатуры, а 
содержимое дорожек MIDI контроллеров будет определяться последней выбранной дорожкой, когда клип был 
открыт в MIDI редакторе. Если MIDI дорожка в MIDI редакторе не выбиралась, будет использоваться дорожка 
Velocity по умолчанию. Границу между областью редактирования и дорожкой MIDI контроллеров можно 
отрегулировать мышью так же, как в MIDI редакторе.  
Щелчок правой кнопкой по области редактирования отобразит меню с опциями редактирования оперативного 
редактора. Подробно они перечислены в Главе 22, а суммарно следующие типы опций и действий 
поддерживаются в пределах оперативного редактора: 
 
- действия редактирования нот мышью, включая изменение длительности, velocity, использования рамки 
выделения, перемещения, удаления и вставки. 
- большинство опций меню Edit и меню View MIDI редактора, включая функции Quantize и Humanize.  
 
При работе в оперативном редакторе, будут применяться любые горячие клавиши и пользовательские 
действия, которые вы определили в основном MIDI редакторе наряду с любыми действиями по умолчанию. 
Например, клавиши PageUp и PageDown будут масштабировать по вертикали в и пределах оперативного 
редактора. Пользовательские действия MIDI редактора можно выполнить и в пределах оперативного редактора. 
Оперативный редактор также включает маленькую панель инструментов в верхнем правом углу. Слева направо 
это следующие инструменты: 
 

 
 
- переключаемый инструмент перемещения MIDI контроллеров с событиями: служит той же самой цели, что и 
его эквивалент в окне MIDI редактора. 
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- инструмент Show/Hide (символ лупы): переключает между функциями Show all note rows (показать все 
дорожки нот), Hide unused note rows (скрыть неиспользуемые дорожки нот) и Hide unused and unnamed 
note rows (скрыть неиспользуемые и неименованные дорожки нот). 
- инструмент Item Style: переключает типы отображения нот между прямоугольником, треугольником и ромбом. 
- инструмент Vertical Scroll/Zoom: щелкните и удерживая кнопку мыши переместите мышь вертикально вверх 
или вниз для вертикальной прокрутки и влево/вправо для вертикального масштабирования. Двойной щелчок по 
этому инструменту масштабирует все содержимое клипа 
- инструмент X: закрывает оперативный редактор и восстанавливает нормальное отображение MIDI клипа. 
 
Помните также, что большинство задач редактирования клипа, функции и действия, которые мы рассматривали 
в Главе 7, могут быть также применены к MIDI клипам в целом. Например, в области аранжировки клипы можно 
перетащить, разделить, копировать, мьютировать, сгруппировать, и т.д. Плагины можно добавлять 
непосредственно к цепочке эффектов клипа. Выбор MIDI клипа в области аранжировки и щелчок по клавише F2 
отобразит окно Item Properties клипа, где можно изменить тональную позицию, скорость воспроизведения, 
активировать/снять область лупа и выполнить другие действия. 
 

13.33. Копирование MIDI клипов в области аранжировки 
 
Когда вы копируете MIDI клип в области аранжировки, то в зависимости от ваших предварительных настроек и 
каким образом происходит копирование будет один из двух результатов:  
 
Первый: новый клип будет создан как новый экземпляр исходного клипа и будет использовать те же самые 
исходные данные, что и оригинал. В этом случае любые изменения, внесенные в этот клип, будут применены к 
исходным данным, и тем самым к другому клипу. Это может понадобиться в том случае, если вы хотите, 
например, продублировать мелодию, басовую партию или барабанный паттерн всюду по проекту. Все еще 
работая над партией, вам, возможно, понадобится внести изменения в эти клипы, и вы хотите сделать так, 
чтобы при внесении этих изменений в любой клип, они будут автоматически применены ко всем остальным.  
В альтернативном сценарии новый MIDI клип становится отдельным самостоятельным клипом, и вы можете 
независимо отредактировать любой клип, не затрагивая другой. По умолчанию, когда вы копируете и 
вставляете клипы, используя меню или горячие клавиши (такие как Ctrl+Shift+C и Ctrl+V), применяется 
первый вариант развития событий. Клипы также добавляются в диалоговое окно Project Media Bay (см. Главу 
12), где они перечислены в качестве объединенных MIDI клипов. Чтобы изменить это поведение по 
умолчанию, перейдите Options > Preferences > Media > MIDI и отключите опцию Pool MIDI source data when 
pasting or duplicating media items (см. также Главу 22).  
 

 
 
После этого клипы будут по умолчанию скопированы в качестве отдельных клипов. Обратите внимание на то, 
что новый клип MIDI пула никогда не создается, если текущий MIDI клип разделен. Отметьте также, что по 
умолчанию MIDI клипы, добавленные в проект из окна Project Media Bay, не объединяются.  
Поведение по умолчанию копирования клипов перетаскиванием мышью зависит от настроек модификатора 
мыши в контексте Media item drag. По умолчанию, применяются следующие действия перетаскивания MIDI 
клипов: 
 
Перетаскивание: перемещает клип, игнорируя выделенную область 
Ctrl+перетаскивание: копирует клипв качестве отдельного клипа 
Shift+Ctrl+Alt+перетаскивание: копирует клип, объединив исходные MIDI данные. 
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Полный список модификаторов мыши вы найдете на странице Options > Preferences > Editing Behavior > 
Mouse Modifiers. Необходимо выбрать опцию Media item left drag из списка контекстов. Можно изменить 
любые назначения. Подробнее об этом в Главе 15.  

 
Можно удалить статус объединения любого отдельного MIDI клипа и преобразовать 
его в дискретный клип. Для этого либо отобразите окно свойств исходного клипа 
(Ctrl+F2 или через контекстное меню), и нажать Un-pool this item, либо щелкните по 
значку статуса объединения клипа (см. рисунок слева). 
 
 

13.34. Объединение MIDI клипов 
 
Иногда возникает необходимость объединить несколько MIDI клипов вместе. Например, для создания одного 
клипа, чтобы его зациклить или просто, чтобы можно было отредактировать эти клипы как один клип, или для 
экспорта MIDI данных в качестве одного MIDI файла. Например, у вас может быть несколько MIDI клипов, 
которые вы хотите экспортировать вместе одним файлом. Трек, показанный на рисунке ниже, мог бы стать 
этому примером.  
 

 
 
Вы можете выделить все клипы (легче всего нарисовав рамку выделения правой кнопкой мыши), и объединить 
их, щелкнув правой кнопкой мыши по любому клипу из выбранных и выбрать опцию Glue items из контекстного 
меню.  
 

 
 
Затем можно дважды щелкнуть по объединенному клипу, чтобы открыть MIDI редактор, откуда можно 
экспортировать объединенный клип одним MIDI файлом (File > Export to new MIDI file). 
 

13.35. Страница предварительных настроек MIDI 
 
Чтобы определить предварительные настройки MIDI, перейдите Options > Preferences > Media> MIDI. 
Подробнее об этом в Главе 22, но на данный момент стоит отметить следующее: 
 
- вы можете определить, в качестве чего будут создаваться новые MIDI клипы по умолчанию (Create new MIDI 
items as) - в качестве клипов REAPER (по умолчанию) (MIDI items (in project, recommended) или в качестве 
MID файлов (MID files). 
- вы можете определить, как будут интерпретироваться действия редактирования, примененные к 
импортированным MID файлам (Import existing MIDI files as) - т.е. применять ли редактирования только к 
клипу в проекте REAPER (MIDI items (in project, recommended) или также к исходному файлу на диске (MID 
file reference). 
- вы можете определить поведение по умолчанию для импортированных мультиканальных MIDI файлов 
(Import multichannel MIDI files) - как мультиканальные MIDI файлы на одном треке (As a multichannel item on 
a single track), как одноканальные клипы на нескольких треках (As single-channel items on multiple tracks), 
или всегда запрашивать действие (Always prompt when importing multichannel MIDI). 
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13.36. Вывод MIDI сигнала напрямую на внешний синтезатор 
 

Выходной MIDI сигнал любого трека или нескольких треков можно направить 
непосредственно во внешний аппаратный синтезатор вместо (или также) мастер-
канала. Щелкните правой кнопкой по кнопке ROUTE трека, выберите MIDI output 
из меню, затем выберите имя устройства и каналы. Дополнительно, можно 
отключить маршрутизации выходного сигнала в посыл мастер-трека. 
 
 
 
 

 
13.37. Экспорт MIDI проекта 

 
В области аранжировки опция File> Export Project MIDI может использоваться для экспорта либо MIDI проекта 
целиком, либо выбранных клипов или треков в рамках этого проекта в один MIDI файл. Пример такого проекта 
показан на рисунке ниже.  
 

 
 
Проект включает шесть треков с MIDI событиями (с разными каналами для каждого трека), заключенные в 
трек-папку, цепочка эффектов которой включает виртуальный инструмент. Однако опции, показанные здесь, 
требуют небольшого разъяснения.  
 

Можно экспортировать весь проект (Entire project) 
или только текущую выделенную область (Time 
selection only). Можно включить все клипы в 
рамках проекта (All), или только выбранные треки 
(Selected tracks only) или только выбранные 
клипы (Selected items only). В данном примере 
были выбраны все MIDI клипы. Можно объединить 
различные MIDI треки в один MIDI трек или 
экспортировать в мультитрековый MIDI файл. 
Доступны также опции Embed project tempo/time 
signature changes (встроить изменения 
темпа/музыкального размера) и/или Export 
project markers as MIDI markers or cues 
(экспортировать маркеры проекта как MIDI 
маркеры или метки). Последняя опция включает 
дополнительную опцию Only export project 
markers that begin with # (экспортировать 
только маркеры проекта, которые начинаются с 
символа #). 
 
 
 

13.38. MIDI маршрутизация, MIDI шины и ReWire 
 
Возможности MIDI маршрутизации REAPER можно расширить при помощи MIDI шин. По умолчанию MIDI треки 
могут включать до 16 MIDI шин, каждая из которых включает 16 MIDI каналов. Отсылая MIDI данные с одного 
трека в другой, вы можете определить шину/комбинацию каналов как для трека-источника, так и для трека-
адресата, а не просто канал. Эти опции доступны в выпадающих меню в окне MIDI посыла/адресата (рисунок 
ниже).  
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MIDI данные, отправленные с одного трека в другой таким образом, можно непосредственно направить в 
любой VST или AU синтезатор в цепочке эффектов этого трека. Для этого щелкните правой кнопкой мыши по 
кнопке “2 Out” плагина и выберите MIDI шину из меню MIDI Input (рисунок ниже).  
 

 
 
Это же контекстное меню может использоваться для назначения выходного MIDI сигнала в любую шину и/или 
назначить выходной аудиосигнал синтезатора на любой канал или каналы трека. Когда у трека присутствуют 
MIDI контроллеры громкости и панорамы, перемещение фейдеров громкости/панорамирования в пределах 
окна маршрутизации генерируют события MIDI контроллеров CC7/CC10 соответственно. Если кнопка MIDI 
маршрутизации посыла активирована, эти события MIDI контроллеров отсылаются в трек-адресат.  
Пользователям технологии ReWire может быть интересно знать, что MIDI данные, направленные таким 
образом, могут отправить по ReWire, используя любую перестановку шин/каналов. Для получения 
дополнительной информации об использовании ReWire с REAPER, см. Главу 17. 
 

13.39. Плагин ReaControlMIDI 
 
Плагин Cockos ReaControlMIDI может использоваться с любым 
MIDI треком и позволяет отредактировать различные MIDI 
параметры на этом треке. Плагин можно вставить в цепочку 
эффектов трека, или щелкнуть правой кнопкой мыши по имени 
или номеру трека и выбрать опцию Show ReaControlMIDI for 
Selected Tracks из меню. Можно использовать несколько 
экземпляров этого плагина на одном треке для отправки 
различных MIDI сообщений в различные каналы. Это позволяет, 
например, отправить управляющие сообщения в синтезатор или 
виртуальный инструмент, помещенный после плагина 
ReaControlMIDI в цепочку эффектов. Большинство хостов 
включают MIDI треки со специфическими MIDI контроллерами, 
такими как выбор банка/программы, MIDI параметр громкости и 
панорамы, и т.д. REAPER вместо этого использует плагин 
ReaControlMIDI, который включает панель для любого MIDI 
трека. Это дает вам дополнительную гибкость, так как можно 
вставить несколько экземпляров или вставить плагин в любой 
точке цепочки эффектов, как для трека в целом, так и для 
отдельных клипов. Достойные внимания опции плагина 
ReaControlMIDI: 
 
Load File: можно загрузить reabank файл REAPER или файл 
определений инструментов Cakewalk .ins, а затем выбрать 
комбинацию банка/программы. 
Control Change: из выпадающих меню можно выбрать до пяти 
элементов MIDI контроллеров. Любой и все элементы, доступны 
для дорожек MIDI контроллеров в MIDI редакторе. 
Опция Show Log открывает журнал MIDI действий, в который вы 
можете включить любое из действий control change, sysex, all-
notes-off и/или meta-message. 

ReaControlMIDI также обеспечивает механизм создания огибающих трека непрерывного MIDI контроллера, 
обеспечивая автоматизацию любого из слайдеров MIDI контроллеров плагина. Автоматизация будет 
объяснена в Главах 18 и 19. Можно также назначить контроллеры панели трека и/или панели микшера для 
управления их различными параметрами. Подробно это объясняется в Главе 12. 
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13.40. Некоторые другие MIDI плагины 
 
REAPER включает неплохой набор плагинов, которые можно поместить в цепочку эффектов любого MIDI 
трека, или непосредственно в цепочку эффектов любого MIDI клипа. Большинство из них (IX серии) записаны и 
разработаны Филипом Консэдайном. Основные шаги вставки и использования эффектов трека, объяснены в 
главе "Основы использования эффектов трека". Если в окне Add FX ввести слово midi в области фильтра (как 
показано на рисунке ниже), вы увидите список доступных MIDI эффектов.  
 

 
 
Ниже перечислены некоторые JS MIDI эффекты, поставляемые с REAPER. 
 
MIDI_CCRider: LFO-управляемый генератор MIDI контроллеров 
MIDI_DuplicateFilter: блокирует дублирование нот. 
MIDI_KeyMap: утилита назначения MIDI клавиш. 
MIDI_KeySnap: хороший обман для плохих пианистов. 
MIDI_Router: маршрутизатор событий с одного канала в другой. 
MIDI_Tool и MIDI Tool II: интересные опции для событий MIDI нот. 
midi_transpose: транспонирует ноту или нескольких нот. 
MIDI_Variant: основанный на паттернах, рандомизатор. 
MIDI_Velocifier II: основанный на паттернах модификатор velocity. 
midi_velocitycontrol: Используется для изменения и управления velocity MIDI трека. 
MIDI_Wobulator: LFO-управляемый вобулатор автоматического изменения высоты тона. 
sequencer_megababy: потрясающий секвенсор паттернов (см. далее в этой главе). 
Synthesis/midi_drumseq: используйте этот барабанный секвенсор с вашими любимыми патчами. 
 
Эти плагины можно сделать куда более мощными, используя огибающие автоматизации, которые можно 
применить к любому из их параметров. Подробнее об огибающих автоматизации в Главе 18. Дополнительная 
информации об использовании этих и других MIDI плагинов на странице 
http://www.cockos.com/wiki/index.php/Jesusonic_Effects_Documentation#MIDI 
 

13.41. Управление высотой тона MIDI клипов с помощью плагина ReaVoice 
 
Плагин ReaVoice может использоваться с записанным вокальным треком для создания многоголосий путем 
изменения высоты тона. Как и в случае с многими другими плагинами, ReaVoice может использоваться 
разными способами. В этом параграфе мы рассмотрим всего один пример. После вы можете 
поэкспериментировать с возможностями этого плагина для себя. Процедура использования ReaVoice: 
 
1. Запишите вокальный трек. 
2. Вставьте новый трек ниже вокального трека. 
3. Создайте посыл с вокального трека в новый трек. По крайней мере на начальной стадии, это должно быть 
Pre FX. 
4. Введите слово ReaVoice в окне эффектов нового трека. 
5. Активируйте для записи этот трек. Установите вашу MIDI клавиатуру в качестве устройства ввода и 
активируйте мониторинг входного сигнала. 
6. Мьютируйте все треки кроме этих двух. 
7. Воспроизведите песню. При этом наиграете на клавиатуре, экспериментируя до тех пор, пока не найдете 
соответствующий диапазон нот. 
8. Решите, что вы хотите сыграть, нажмите клавишу W, чтобы возвратиться к началу песни, а затем нажмите 
Ctrl+R, чтобы сделать запись. По окончании остановите запись. 
9. Если у вас нет MIDI клавиатуры, можно использовать либо виртуальную клавиатуру REAPER, либо ввести 
ноты в MIDI редакторе. 
10. При необходимости можно записать несколько копий и выбрать Play All Takes для клипов MIDI трека. 
11. После окончания записи можно использовать MIDI редактор и подкорректировать выполненную работу. 
 
Пример: 
 
На данном примере мы рассмотрим функционал плагина ReaVoice. 
 
1. Откройте файл All Through The Night.rpp и сохраните его под именем All Through The Night 
REAVOICE.rpp. 
2. Мьютируйте все треки кроме трека Vox. 
3. Переместите трек Vox наверх, выберите его и нажмите Ctrl+T, чтобы вставить новый трек. Теперь трек Vox 
- трек #1, а новый трек - трек #2. 

http://www.cockos.com/wiki/index.php/Jesusonic_Effects_Documentation#MIDI
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4. Именуйте новый трек MIDI Vox. 
5. Отобразите окно маршрутизации MIDI трека Vox и добавьте новый адресат Pre FX на Audio 1/2 из трека 
Vox. 
6. Вставьте плагин ReaVoice в окно эффектов этого трека. На данный момент установите его настройки как 
показано на рисунке ниже. Обратите внимание в частности на значения параметров Max voices и Sustain. 
 

 
 
7. В MIDI треке Vox вставьте пустой MIDI клип около отметки 13 секунд до приблизительно метки 50 секунд. 
Это должно совпасть с первым вокальным отрывком на треке Vox. 
8. Дважды щелкните по отрывку, чтобы открыть его в MIDI редакторе. 
9. Создайте паттерн нот, как на рисунке ниже. 
 

 
 
10. При воспроизведении песни, убедитесь, что эти два вокальных трека солируются.  
11. В MIDI редакторе нажмите Ctrl+A, чтобы выделить все события. 
12. Нажмите Ctrl+F2, чтобы отобразить диалоговое окно Note Properties. 
13. В области Note введите +2 (как показано на рисунке ниже), а затем нажмите OK. Это транспонирует все 
выделенные ноты на тон вверх. 
 

 
14. Поэкспериментируйте с другими параметрами. По окончании сохраните файл. 
15. Теперь поэкспериментируйте с настройкой некоторых параметров ReaVoice 
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13.42. Плагин JS: IX/MIDI_Router 
 

Этот плагин можно вставить в 
цепочку эффектов трека. Он 
используется для 
перенаправления MIDI данных с 
одного канала в другой. Можно 
отправить либо ноты, либо не 
ноты, или то и другое. 
 
 
 
 
 
 
 
 

13.43. Маршрутизация обратной связи с MIDI треками 
 
Мы уже упомянули (Глава 2), что параметры проекта REAPER позволяют использовать маршрутизацию 
обратной связи. Необходимо активировать эту опцию, если вы хотите направить выходной MIDI сигнал с 
одного трека в другой, а затем выходной аудиосигнал со второго трека направить назад в первый трек. 
 

13.44. Синхронизация виртуальной клавиатуры с областью аранжировки проекта 
 

Рассмотрим пример того, как 
можно синхронизировать 
представление виртуальной 
клавиатуры MIDI редактора с 
проектом.  Как мы это 
сделали: 
 
1. Мы записали перкуссионный 
инструмент в формате wav и, 
используя stretch маркеры, 
динамическое разделение, 
или любую другую функцию, 
отредактировали этот клип 
так, чтобы ноты располагались 
точно так, как нам надо. 
2. Создали новый пустой MIDI 
клип и открыли его в MIDI 
редакторе. 
3. Там же перешли View > 
Piano roll timebase > Project 
sync. 
4. Щелкнули правой кнопкой 
мыши по строке заголовка и 
выбрали опцию Dock Window. 

5. Щелкнули по значку восклицательного знака в левом нижнем углу панели Docker и отключили опцию Attach 
docker to main window. 
6. Щелкнули по значку восклицательного знака в левом нижнем углу панели Docker и выбрали опцию Set 
opacity, 75%. Теперь мы можем переместить окно MIDI редактора и поместить его над ранее записанным 
треком: это поможет нам визуально использовать MIDI редактор при добавлении нот нашего следующего 
перкуссионного инструмента. 
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13.45. Функция Scale Finder 
 

Область аранжировки REAPER включает функцию, которую 
пользователи MIDI могут счесть полезной - Scale Finder. Эта функция 
может использоваться для определения лада и тональности любых 
выбранных нот. Чтобы открыть окно Scale Finder, перейдите View > 
Scale finder. Ноты можно ввести с компьютерной клавиатуры или через 
MIDI-устройство (включая виртуальную MIDI клавиатуру). Сэмпл reascale 
файла (поставляемый с REAPER) может использоваться с функцией 
Scale Finder, или можно нажать кнопку внизу этого окна и использовать 
опцию Load, чтобы импортировать файл по вашему выбору. Доступна 
также опция использования нот, которые в настоящее время выбраны в 
MIDI редакторе. 
 
 
 
 
 
 

 
13.46. Секвенсор MegaBaby 

 
MegaBaby – это секвенсор паттернов, который может использоваться для игры на MIDI синтезаторе под 
программным управлением. Данная глава предназначена для ознакомления относительно новых 
пользователей с концепцией секвенсирования паттернов, вместе с простым примером того, как это можно 
использовать. Вне этого примера исследуйте и экспериментируйте для себя! Мы начнем с пошагового 
примера, а затем продолжим исследовать секвенсор Baby более подробно. 
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Пример: 
 
1. Создайте новый файл и вставьте один трек. 
2. Откройте цепочку эффектов трека и добавьте плагин JS: MIDIsequencer_megababy. 
3. Чтобы использовать Секвенсор Baby необходим синтезатор. Можно использовать любой, но для данного 
примера возьмем ReaSynth. На данный момент оставьте его параметры в значениях по умолчанию, кроме 
параметра Volume, значение которого установите приблизительно в -15 дБ. Если громкость окажется слишком 
низкой, можно позже ее увеличить. 
4. Вставьте плагин JS: Utility/limiter и установите параметр max vol в значение -3.0 дБ. 
5. Выберите плагин Sequencer Baby. Некоторые его основные контроллеры показаны на рисунке выше. 
6. Нарисуйте в нескольких местах (например, как на рисунке) несколько нот (нотный паттерн). 
7. Нажмите кнопку Play на транспортной панели REAPER. Этот паттерн будет воспроизводиться раз за разом. 
8. Остановите воспроизведение. Изменитесь значение параметра Steps per beat на 8 и воспроизведите 
паттерн снова. Обратите внимание, что темп паттерна стал быстрее. 
9. Измените значение параметра Steps per beat на 2. Обратите внимание, что темп паттерна замедлился. 
Установите назад значение 4. 
10. Измените значение параметра Sequence length на 24. Последовательность стала более 
продолжительной. Нарисуйте еще несколько нот. 
11. Щелкните по номеру 1 выше сетки паттернов (но ниже контроллеров параметров). Появился новый экран: 
здесь можно создать другой паттерн. Создайте его! 
12. Теперь удерживая клавишу Alt, нажмите на кнопку номера 1. Обратите внимание на то, что цвет заголовка 
столбца изменился. 
13. Воспроизведите паттерны. Теперь эти два паттерна (0 и 1) объединены в цепочку. В цепочку можно 
объединить до 16 паттернов. 
14. При необходимости сохраните файл. 
15. Можно также записать выходной сигнал синтезатора в качестве аудиоклипа. Для этого активируйте трек 
для записи, выберите Record output из контекстного меню кнопки record arm, а затем нажмите Ctrl+R. 

 
Примечание: четыре дорожки ниже области сетки паттерна могут использоваться для установки 
значений модуляции, громкости, панорамы и/или экспрессии для отдельных нот или любой 
последовательности нот. Щелкните, чтобы создать огибающую: щелкните правой кнопкой по любому 

узлу, чтобы удалить его, щелкнуть правой кнопкой чтобы удалить всю огибающую. На рисунке ниже показан 
пример с панорамой. 
 

 
 
Примеры горячих клавиш Секвенсора Baby: 
 
Щелчок левой кнопкой мыши+перетаскивание: рисование новые нот/стирание текущих. 
Щелчок правой кнопкой мыши+перетаскивание: прослушивание нот без их прорисовки. 
Shift +Ctrl+Alt+щелчок левой кнопкой мыши+перетаскивание: развернутая прорисовка нот/стирание 
текущих. 
Ctrl+щелчок левой кнопкой мыши+перетаскивание: настройка velocity нот. 
Shift +щелчок левой кнопкой мыши+перетаскивание: смещение начальной позиции нот. 
Ctrl+щелчок левой кнопкой мыши/Ctrl+щелчок правой кнопкой мыши: разделение напополам шагов на 
доли, замедление/удвоение шагов на доли, убыстрение. 
Щелчок левой кнопкой мыши на номере паттерна: выбор номера паттерна. 
Ctrl+щелчок правой кнопкой мыши на номере паттерна: очистка паттерна. 
Alt +щелчок левой кнопкой мыши на номере паттерна: установка окончания цепочки паттернов. 
 
Более полный список горячих клавиш можно отобразить щелчком по кнопке Edit плагина. 
 
13.47. Использование сообщений MIDI контроллеров для управления пресетами эффектов 

 
Это продвинутая тема и поэтому не рекомендуется для неопытных пользователей. Сообщения Bank/Program 
Select могут использоваться для программного переключения пресетов любых эффектов на любом треке при 
воспроизведении в режиме реального времени. Это можно сделать с использованием специальных MIDI 
клипов, которые помещаются в тот же самый трек в качестве клипов, содержащих эффекты, пресеты которых 
вы хотите автоматизировать. Процедура может показаться немного сложной, поэтому приготовьтесь уделить 
время на изучении этой функции, пока вы к ней не привыкните. 
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1. После записи клипа вставьте нужные эффекты в цепочку эффектов трека и импортируйте нужную 
библиотеку пресетов. Для этого нажмите кнопку + направо от меню пресетов и выберите опцию Import preset 
library (.rpl). 
 

2. Теперь доступные пресеты можно открыть из меню пресетов. В данном 
примере отображена библиотека пресетов по умолчанию для плагина ReaDelay, 
но вы можете открыть библиотеку для любого плагина. Ненужные пресеты можно 
удалить и/или создать и сохранить ваши собственные, если пожелаете. 
Соответствующие опции можно найти в том же самом контекстном меню 
пресетов, которое вы использовали в шаге 1. Если вы изменили меню пресетов, 
рекомендуется экспортировать библиотеку пресетов с новым именем. 
 
 
 
 
 
 

 
3. В рамках данного примера мы будем использовать фабричный набор пресетов ReaDelay, показанный на 
рисунке выше. 
4. Теперь необходимо создать reabank файл патча/банка. Фактически это обычный текстовый файл, но его 
необходимо разметить определенным способом, и он должен быть сохранен с расширением reabank. Для 
этого можно использовать любой текстовый редактор. 
5. Джоэл Сэмпсон создал на своем веб-сайте превосходное и всестороннее руководство в формате PDF на 
пять страниц, объясняющее на примере каждый аспект использования reabank файлов и процесс их создания. 
Общие инструкции будут приведены ниже, но строго рекомендуется загрузить и изучить руководство The Art 
of Reabanks, который можно загрузить со страницы www.djemberecords.com/reaper.html 
6. Пример reabank файла для библиотеки по умолчанию пресетов плагина ReaDelay показан ниже.  
 

 
 
В данном случае для создания файла использовался Блокнот. Обратите внимание на комментарии в шагах 7 
и 8. 
7. Строка bank - первая строка в файле, которая определяет номера выбора банка старшего байта (MSB) и 
младшего байта (LSB), затем идет имя банка. Можно установить оба номера в 0. 
8. Каждая последующая строка включает для каждого пресета его номер патча (начиная с 0) и его имя, 
которое идентично имени в меню пресетов эффектов. Однако при необходимости можно использовать другие 
имена, поскольку процесс выбора основан на номере патча. 
9. По окончании сохраните файл и закройте текстовый редактор. Разумно сохранять файл по адресу 
\ApplicationData\REAPER\Data или в эквивалентной папке (в зависимости от используемой платформы - 
Windows или OS/X версии) - но решать конечно же вам. 
10. Запустите REAPER и откройте цепочку эффектов соответствующего трека. Выберите эффект и из меню 
preset + выберите опцию Link to MIDI program change и выберите канал (например, 16). Это сделает 
управление MIDI сообщениями отличающимся от любых других. 
11. В контекстном меню трека отметьте опцию Enable track free item positioning. Активируя свободное 
расположение клипов, вы можете поместить два или более клипов друг под другом на том же самом треке. 
12. Выберите трек, который содержит клип с плагином эффекта, пресетами которого вы хотите управлять. 
Выделите область, которая включает этот клип. Теперь из меню Insert выберите опцию New MIDI item, чтобы 
создать пустой MIDI клип рядом (параллельно) с текущим клипом. Результат показан на рисунке ниже: 
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13. Откройте пустой MIDI клип в MIDI редакторе и убедитесь, что отображена дорожка Bank/Program Select. 
14. В точке, где вы хотите внести свое первое автоматизированное изменение пресета, дважды щелкните по 
дорожке Bank/Program Select. 
15. В одноименном диалоговом окне нажмите Load File. Перейдите к файлу, который вы сохранили в шаге 9 и 
выберите его, а затем нажмите Open. 
16. Банк пресетов будет загружен. Откройте выпадающий список Program и выберите нужный пресет (см. 
рисунок ниже).  
 

 
 
Обязательно выберите тот же самый канал, который вы назначили в шаге 10. Нажмите OK. 
17. Повторите шаг 16 нужное количество раз, чтобы создать необходимое количество автоматизированных 
изменений пресета. 
18. Теперь можно увидеть изменения программы, отображенные на дорожке MIDI контроллеров в MIDI 
редакторе (см. рисунок ниже). 
 

 
 
19. Воспроизведите песню. Теперь ваши пресеты плагина ReaDelay будут автоматически изменятся согласно 
вашим инструкциям! 
 

13.48. Собственные имена для MIDI нот и MIDI контроллеров 
 
Вы можете назначить ваши собственные имена на MIDI ноты и MIDI контроллеры и сохранять результаты 
работы в текстовый файл, который затем можно импортировать в любой MIDI проект, используя командe File > 
Note names > Load note names from file. Файл-образец включен в REAPER и вы можете отредактировать этот 
файл или создать ваш собственный файл, используя любой текстовый редактор. Чтобы выбрать этот файл-
образец перейдите Options > Show REAPER resource path, затем дважды щелкните по папке 
MIDINoteNames. В этой папке файл будет называться note_name_sample.txt. Щелкните правой кнопкой мыши 
по этому файлу и выберите команду Edit из контекстного меню, чтобы открыть его в вашем текстовом 
редакторе по умолчанию. Содержимое файла-образца показано на рисунке ниже.  
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Символ # в начале каждой строки означает, что это только комментарий для иллюстрации, который будет 
проигнорирован REAPER. Для создания собственного имени, просто напечатайте дополнительные строки в 
отображенном формате (без символа #). Пример этого показан на рисунке ниже.  
 

 
 
Вы можете также удалить любые строки комментариев, которые вам не нужны. Сохраните файл и закройте 
текстовый редактор. Теперь этот файл можно импортировать в любой проект, используя способ, описанный в 
главе "Основные меню MIDI редактора". 
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14. Музыкальная нотация и редактор нотации REAPER 
 

14.1. Краткое введение в нотацию 
 
В широком смысле термин "нотация" может быть применен к любой системе, которая использует письменные 
символы для обозначения музыкальных нот. Однако на практике термин “нотация” часто используется по 
отношению к современной нотации на нотном стане. Нотация была придумана для отображения европейской 
классической музыки, но в наше время она широко используется для музыкального обозначения большинства 
жанров. В данной главе мы сфокусируемся на редакторе нотации REAPER (Note Editor), который 
используется для записи и редактировании современной нотации на нотном стане. Практика записи нотации 
также известна под термином оркестровка (scoring). Ниже мы рассмотрим некоторые основные элементы и 
терминологию нотации: 
 

 
 
Нотный стан (staff) - сетка из пяти линий, на которой записывается нотация. Если MIDI клип записан с 
использованием клавиатуры или создан вручную в MIDI редакторе, открытый в редакторе нотации, этот клип 
будет автоматически отображен в нотации. В пределах редактора нотации эту оркестровку можно 
отредактировать или добавить к ней другую. Нотный стан разделен на такты (measures). Количество долей 
(beats) в такте определяется музыкальным размером (time signature). На левой стороне нотного стана ставится 
ключ (clef). Для скрипичного ключа (treble clef) первая (самая нижняя) линия нотного стана соответствует ноте 
ми (E), далее по возрастанию ноты между линиями и на линиях обозначаются F (фа), G (соль), A (ля), B (си), C 
(до), D (ре), E (ми), и F (фа). Басовый ключ (bass clef) использует тот же самый музыкальный алфавит, но с 
другими нотами -  G (соль), A (ля), B (си), C (до), D (ре), E (ми), F (фа), G (соль), и A (ля). Если нота должна быть 
отображена выше или ниже нотного стана, для нее используются добавочные линии (ledger line).   

 
Для обозначения нот и соответствующих пауз используются различные 
символы.  
 

 
На рисунке также можно заметить лиги, связывающие ноты одной высоты тона для увеличения 
длительности ноты (ties). Направо от ключа (если позволяет тональность) расположены ключевые знаки (key 
signature) и музыкальный размер (time signature). Ключевые знаки определяют тональность. Музыкальный 
размер определяет количество долей в такте и длительности этих долей. Например, в размере 4/4 - четыре 
доли в такте, а каждая доля соответствует четвертной ноте. В размере 3/4 каждой доле соответствует также 
четвертная нота, но в такте 3 доли.  
 

Наконец на рисунке можно заметить паузы (Rests), которые обозначают 
период тишины в такте, соответствуют длительностям нот и обозначается 
специальными символами. 
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14.2. Редактор нотации REAPER: беглый взгляд 
 
Единственное и самое важное - редактор нотации REAPER это интегрированная составляющая MIDI редактора, 
а не автономный модуль. Любые вносимые изменения в MIDI клип будут отображаться в каждом из этих 
представлений. У такой архитектуры есть свои значительные преимущества: 
 
- если вы знакомы с работой в, скажем, представлении виртуальной клавиатуры, то знакомство с редактором 
нотации значительно сократит ваше время. Более того не благоразумно пытаться работать в редакторе 
нотации, не изучив сначала MIDI редактор, и особенно представление виртуальной клавиатуры. 
- действия редактирования (такие как перемещение, копирование или изменение нот) можно выполнять в 
любом удобном для вас представлении. Результат этих действий будет отражаться (и слышится) также в любом 
представлении. 
 
Различные представления MIDI редактора можно выбрать из меню View: 
 
Mode: piano roll (Alt 1): представление виртуальной клавиатуры 
Mode: named notes (Alt +2): представление маркированных нот 
Mode: event list (Alt +3): представление списка событий 
Mode: musical notation (Alt +4): представление музыкальной нотации 
 

 
 
Посмотрите на рисунок выше. Это довольно простой MIDI клип, который, возможно, был импортирован из MIDI 
файла, записанного с использованием клавиатуры, или созданного в MIDI редакторе REAPER в представлении 
виртуальной клавиатуры или в редакторе нотации. MIDI клип на рисунке показан в представлении виртуальной 
клавиатуры (выше) и в редакторе нотации (ниже). Когда вы переключаетесь между представлениями, вы видите 
те же самые ноты.  
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Можно также заметить, что общий интерфейс MIDI редактора остается тем же (например, меню и панели 
инструментов). В любом из этих двух представлений, показанных здесь, ноты можно свободно добавлять, 
удалять или перемещать. Обратите внимание на то, что MIDI клип может быть отображен только в одном из 
представлений (например, только в режиме отображения музыкальной нотации или только в режиме 
виртуальной клавиатуры, но не в обоих сразу), хотя различные клипы могут быть открыты одновременно в 
различных представлениях в отдельных экземплярах MIDI редактора. Отметьте также, что способы, 
используемые при работе в различных представлениях, по мере возможности, те же самые. Например, 
двойной щелчок используется для вставки новой ноты. Щелчок правой кнопкой мыши+перетаскивание 
используется для выделения серии нот (выделяющая рамка). С выделенными нотами можно выполнить 
различные действия редактирования, такие как удаление, перемещение, копирование, квантизация и так далее. 
Как вы заметите далее в этой главе, редактор нотации также включает дополнительные функции, которые 
являются специфическими именно для оркестровки. Во-первых, давайте на мгновение возвратимся к нашему 
простому примеру.  
 

 
 
В данном случае мы добавили еще несколько нот в представлении виртуальной клавиатуры (на рисунке они 
выделены). Когда мы переключимся на редактор нотации, мы увидим, что эти ноты выделены и там.  
 

 
 
Таким образом процесс работы и переключение между различными режимами является интегрированным.  
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Если вы работаете с проектами, которые включают несколько треков с MIDI клипами и/или с несколькими MIDI 
клипами на одном треке, важно, чтобы вы поняли использование опций управления MIDI редактора (включая 
режим отображения музыкальной нотации), которыми можно обработать эти клипы. Если возникла 
необходимость, вернитесь к Параграфам с 13.26 по 13.28. 
 

14.3. Открытие MIDI клипов в редакторе нотации 
 

На странице Options > Preferences > Editing Behavior > MIDI 
Editor можно определить, как будет открываться MIDI редактор 

- для каждого клипа, для каждого трека, или для всего проекта.  
 
В режиме музыкальной нотации зачастую полезно иметь открытыми все MIDI клипы.  
 

На той же самой странице можно определить поведение, когда вы 
открываете MIDI клип в MIDI редакторе двойным щелчком или используя 
опцию Open in built-in editor. Доступные опции - открыть только клип, по 
которому щелкнули, открыть все выбранные MIDI клипы, открыть все MIDI 
клипы на том же самом треке или открыть все MIDI клипы в проекте.  
 

14.4. Редактор нотации REAPER: более пристальный взгляд 
 
Режим отображения музыкальной нотации можно выбрать в меню View MIDI редактора, и должна быть 
отмечена опция Track List в меню Contents. Это необходимо, помимо прочего, для определения клипов, 
которые видимы и дополнительно доступны для редактирования, а также клипов, которые должны 
использоваться при вставке нот (см. Параграф от 13.26 до 13.28). Прежде, чем вы начнете работать в редакторе 
нотации необходимо убедиться, что вы правильно понимаете функционал списка треков.  
 

 
 
На рисунке выше показан трек-папка с синтезатором, вставленным в ее цепочку эффектов и три дочерних 
трека, каждый включающий MIDI клип. Все три открыты одновременно в редакторе нотации. Взглянув на панель 
справа, вы можете заметить, что все три клипа видимы в этом окне. Первым из них - в настоящее время 
выбранный как редактируемый, и он же выбран для вставки любых новых нот. Давайте сначала рассмотрим 
некоторые моменты, которые можно здесь увидеть: 
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- если видимы несколько треков, их имена отображаются налево от нотного стана. Имена треков и клипов 
отображаются на панели списка треков справа. Щелчок по имени трека (в нотации или на панели трека) делает 
этот трек целевым для вставки событий и делает клипы на этом треке доступными для редактирования. 
- ноты, не доступные в настоящее время для редактирования отображаются серым (затененным) цветом. 
- обратите внимание на две области в верхнем левом углу дисплея, чуть ниже панели инструментов.  
Если вы наведете мышь на любую ноту, в этих областях будет отображаться временная позиция и высота тона 
этой ноты. 
- темп отображается выше и правее от музыкального размера. 
- направо от страницы в конце каждой пары строк нотного стана расположен курсор высоты тона в форме 
небольшого серого треугольника. Он показывает текущую высоту тона, которая будет применена, например, при 
вставке нот. Знак альтерации (диез или бемоль) появится около него, если высота тона не соответствует 
текущей клавише. Этот символ можно перемещать, захватив его мышью.  
 
Теперь давайте рассмотрим некоторые другие функции: 
 

 
 
- чуть ниже первого нотного стана добавлен текст. 
- динамические оттенки (в данном примере, crescendo, forte-fortissimo, dimuendo) были созданы и 
отображаются выше нотного стана. 
- присутствует выделенная область и отдельная область лупа. Возможно, это изначально было сделано в 
области аранжировки, но их можно также отредактировать в режиме нотации. Например, захватив 
соответствующие желтые хэндлы мышью, можно отрегулировать начальные и конечные точки лупа. 
- некоторые ноты окрашены в цвет. Это в настоящие время выбранные ноты. Цвет зависит от выбранной опции 
- канал, velocity, высота тона и т.д. Выбор цвета для velocity может оказаться особенно полезным, так как в 
нотации (в противоположность представлению виртуальной клавиатуры) нет другого способа отобразить 
velocity. 
 

14.5. Опции меню View редактора нотации 
 
Меню View в MIDI редакторе включает опции, специфические для редактора нотации: 

 
Proportional (musical) note spacing: если эта опция 
отмечена будет применяться пропорциональный 
ранжир, а не абсолютный (как в представлении 
виртуальной клавиатуры). Как видно на рисунке 
слева, абсолютный ранжир (верхнее изображение) 
обеспечивает равномерное разделение сетки, а ноты 
на сетке размещаются в их абсолютных позициях. С 
пропорциональным ранжиром (изображение ниже) 
сетка настроена так: ноты большей длительности не 
должны превышать их фактической временной части 
такта, а сетка имеет тенденцию сужаться, ноты 
меньшей длительности не сжимаются в их 
фактическое временное пространство, а сетка 
расширяется соответственно. 
 
 
 
 
 
 

 
Continuous view always, regardless of zoom level: эта переключаемая опция определяет, как ваша нотация 
будет отображаться в MIDI редакторе: подробнее об этом в Параграфе 14.7. 
Minimize ties for all notes by default (минимизировать лиги для всех нот по умолчанию) 



 Специально для сайта musicmanuals.ru  306 306 

Automatically double dot notes (автоматически добавлять к ноте две точки) 
Automatically triple dot notes (автоматически добавлять к ноте три точки) 
Display pedal events: эта переключаемая опция определяет, будут ли отображаться события педали. 
Bracket tracks by folder: если эта опция отмечена слева от партитуры будет образована скобка, указывающая 
на дочерние треки определенной трек-папки. 
Color note heads: определяет будут ли окрашеваться головки нот в соответствии с выбранной опцией (View > 
Color notes by). 
Automatically detect triplets: опция автоматического определения триолей. Триоли и мультиоли будут 
обсуждаться позже в этой главе. 
Automatically voice overlapping notes: выбор голоса (Voicing) позволяет расположить ноты аккорда по-
разному, изменяя звук. Доступна опция автоматического выбора голоса (automatic voicing) наложившихся нот. 
Show project tempo changes: эта переключаемая опция определяет, будут ли изменения темпа проекта 
отображаться выше партитуры в редакторе нотации. 
Key signatures: позволяет определить способ управления знаками альтерации. Доступные режимы: Key 
signature change affects all tracks (изменения знаков альтерации затронет все треки) и Transposing display 
affects key signatures (транспозиция затронет знаки альтерации). 
Display quantization: дисплейная квантизация нот. Значение по умолчанию - 1/16, но можно установить в 1/64, 
1/32 или 1/8. 
Display quantization, Minimum note length: дисплейная квантизация нот с минимальной длительностью. 
Значение по умолчанию - 1/64, но можно установить в 1/256, 1/128, 1/32, 1/16 или 1/8. Две вышеперечисленные 
опции не затрагивают базовый MIDI материал. Эти параметры определяют только отображение нот на дисплее. 
Чтобы лучше понять функционал этих двух опций, их нужно рассматривать вместе. Дисплейная квантизация нот 
гарантирует, что в целях лучшего отображения все кроме самых коротких нот будут округлены к любому 
выбранному значению. Дисплейная квантизация нот с минимальной длительностью позволяет отобразить ноты 
с более короткими длительностями. независимо от квантизации отображения нот. Например, если дисплейная 
квантизация нот будет установлена в значение 1/16, а минимальная длительность ноты в 1/64 (по умолчанию), 
ноты длиннее или короче 1/16 будут отображаться как 1/16, ноты длиннее или короче 1/8 будет отображаться 
как 1/8 и так далее. Тем не менее можно отобразить ноты короче 1/16, такие как 1/32 или 1/64. 
 

14.6. Основные действия выбора нот и задачи MIDI редактора 
 
Основные действия выбора нот и задачи MIDI редактора обсуждались в Главе 13, включая опции меню Edit. 
Кроме более очевидных опций и действий, есть несколько горячих клавиш с использованием мыши и 
клавиатуры компьютера. Большинство действий мыши в представлении виртуальной клавиатуры будут также 
работать и в режиме отображения музыкальной нотации. 
 
14.6.1. Масштабирование и прокрутка  
 
Ознакомьтесь с контроллерами масштабирования и прокрутки в MIDI редакторе. В дополнение к различным 
кнопкам и слайдерам в окне MIDI редактора, полезны следующие действия мыши и клавиатуры: 
 
Колесо мыши: горизонтальное масштабирование (знак + на цифровой клавиатуре, знак - на цифровой 
клавиатуре)  
Ctrl+Колесо мыши: вертикальное масштабирование (Page Up, Page Down) 
Alt+Колесо мыши: горизонтальная прокрутка (Alt +стрелка влево, Alt +стрелка вправо)  
Ctrl+Alt+Колесо мыши: вертикальная прокрутка (Alt +стрелка вверх, Alt +стрелка вниз) 
 
14.6.2. Общие задачи 
 
Ниже перечислены общие задачи, которые могут использоваться как в представлении виртуальной клавиатуры, 
так и в представлении музыкальной нотации: 
 
Чтобы удалить ноту или несколько нот: нарисуйте выделяющую рамку и нажмите клавишу Delete. 
Чтобы переместить ноту или несколько нот: нарисуйте выделяющую рамку и перетащите выбор в новую 
позицию. 
Чтобы скопировать ноту или несколько нот: нарисуйте выделяющую рамку и перетащите выбор с нажатой 
клавишей Ctrl в новую позицию. 
 
14.6.3. Список действий 
 
Список действий MIDI редактора включает опции режима нотации, а также несколько действий не в пределах 
меню, специфические для режима нотации, например: 
 
Notation: Hide selected notes (Нотация: скрыть выбранные ноты) 
Notation: Unhide all notes (Нотация: отобразить все скрытые ноты) 
Notation: Select all notes in staff (Нотация: выделить все ноты на нотном стане) 
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Notation: Minimize ties for all notes by default (Нотация: минимизировать лиги для всех нот по умолчанию) 
Notation: Toggle minimize ties for selected notes (Нотация: переключить минимизацию лиг для всех 
выбранных нот) 
Notation: Identify chords on editor grid (Нотация: идентифицировать аккорды на сетке редактора) 
Notation: Remove all chord notation (Удалить всю аккордовую нотацию) 
 
Такие опции как эти можно активировать/отключить. Можно также назначить собственные горячие клавиши на 
любые действия или добавить их в меню MIDI редактора или на панели инструментов. Подробнее список 
действий рассматривается в Главе 15. 
 
14.6.4. Страница Mouse Modifiers: действия по умолчанию 
 

REAPER включает большое количество действий мыши по 
умолчанию, которые можно модифицировать под конкретного 
пользователя на странице Options > Preferences > Editing 
Behavior > Mouse Modifiers. Для этого сначала выберите контекст 
MIDI piano roll, затем контекст щелчка (left click, left drag или 
double click). После этого дважды щелкните по модификатору 
(например, по Shift +Ctrl или Ctrl+Alt), чтобы отобразить список 
опций. На рисунке слева показаны настройки по умолчанию для 
действия контекста double click контекста MIDI piano roll. Можно 
выбрать любой модификатор (например, Ctrl+Double click) и 
назначить его на любое действие. Ниже перечислены 
модификаторы мыши и музыкальной нотации по умолчанию для 
контекста MIDI piano roll. Модификаторы мыши MIDI редактора 
рассматривались в Главе 13, а подробнее в Главе 15. 

 
14.6.4.1. Left Click (щелчок левой кнопкой мыши) 
 
Действие по умолчанию: снимает выбор всех нот и перемещает курсор редактирования. 
Ctrl: снимает выбор всех нот и перемещает курсор редактирования, игнорируя привязку. 
Alt: снимает выбор всех нот. 
Shift +Alt: вставка нот, игнорируя привязку. 
Shift +Ctrl+Alt: вставка нот. 
 
14.6.4.2. Left Drag (щелчок левой кнопкой мыши+перетаскивание) 
 
Действие по умолчанию: вставка нот, расширение или изменение высоты тона. 
Shift: вставка нот, игнорируя привязку, расширение или изменение высоты тона. 
Ctrl: копирование выбранных нот. 
Alt: удаление нот. 
Shift +Alt: добавление (рисование) нот, игнорируя привязку. 
Ctrl+Alt: добавление (рисование) прямой линии нот. 
Shift +Ctrl+Alt: добавление (рисование) нот и аккордов. 
 
14.6.4.3. Double click (двойной щелчок) 
 
Действие по умолчанию: вставка нот. 
Shift: вставка нот, игнорируя привязку. 

 
Дважды щелкнув по любому элементу в 
столбце Behavior можно выбрать из списка 
альтернативные действия, если таковые 
доступны (см. рисунок слева), или открыть 
список действий и выбрать другое действие.  
 
 
 
Необходимо также убедиться, что вы 
понимаете цель остальных контроллеров MIDI 
редактора, особенно расположенных внизу 
окна, направо от транспортной панели (Grid, 
Notes, Scale и т.д.). Например, выпадающий 
список Notes устанавливает длительность по 
умолчанию для новых вставляемых нот. 
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14.7. Специфические задачи и функции редактора нотации 
 
Прежде, чем мы углубимся в изучение возможностей редактирования в режиме нотации, приостановимся на 
некоторых важных моментах: 
 
- если в одном экземпляре редактора нотации у вас открыто несколько MIDI клипов, необходимо открыть список 
треков (Contents > Track list). Это позволит вам убедиться, что любой клип, с которым вы хотите продолжить 
работу, по крайней мере, будет доступен для редактирования, и, для большинства действий, выбран в качестве 
цели для вставки событий. Один из простейших способов этого добиться - сделать его единственным видимым 
клипом (см. рисунок ниже). 
 

 
 
- в пределах списка треков MIDI редактора можно использовать щелчок левой кнопкой мыши с нажатой 
клавишей Ctrl по любому имени трека, чтобы свернуть трек или щелчок левой кнопкой мыши с нажатой 
клавишей Alt, чтобы свернуть все остальные треки. 
- у каждого MIDI клипа может быть/или отсутствовать свой собственный знак альтерации. Если для клипа знак 
альтерации не определен, он возьмет знак альтерации с предыдущего клипа на этом же треке. Если на этом же 
самом треке предыдущего клипа нет и знак альтерации не определен, у клипа знака альтерации не будет. 
- непосредственно сами MIDI ноты затрагиваются только несколькими специфическими опциями редактора 
нотации, включая удаление и вставку нот, и выбор мультиолей. Остальные действия, такие как вставка 
артикуляций, текстовки, динамических оттенков, и т.д. затрагивают только то, что нарисовано на странице, а не 
сами фактические MIDI ноты. 
- щелчок правой кнопкой мыши на шкале времени (которая отображает количество тактов) обеспечивает доступ 
к общему контекстному меню MIDI редактора. 
 
14.7.1. Как отображается партитура 
 
Когда рассматривается только один трек, нотация по умолчанию отображается в виде страницы, где отчет идет 
слева направо и с начала до конца, если конечно вы не масштабировали партитуру так, чтобы отображалось 
меньше одного полного такта. Когда отображается неполный такт или несколько треков, дисплей становится 
непрерывным, с отчетом всегда только слева направо. Меню View MIDI редактора включает переключаемую 
опцию Notation view options> Continuous view always. Если она отмечена, дисплей будет прокручиваться 
непрерывно независимо от масштабирования. 
 
14.7.2. Опции редактирования MIDI трека/такта 
 

 
Изменение ключа по умолчанию (default clef): Чтобы изменить ключ по умолчанию, щелкните правой кнопкой 
мыши по вертикальной черте в начале такта и выберите опцию Default clef из меню. 
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Доступные значения: Treble + Bass, Treble, Bass, Alto, Tenor, Treble -8, Treble +8, Treble+15, Bass -8, Bass-15, 
Percussion или Percussion (one staff line), Chart. Последняя опция создает нотоносец не с нотами, а с 
маркировкой долей, аккордов и другой нотации. 
 

Дисплейное транспонирование: октавы и полутоны (См. также 
Опции Транспонирования): опция Transpose display может 
использоваться для дисплейного транспонирования нот на треке 
вверх/вниз до 3 октав и/или 11 полутонов. Опция затрагивает только 
непосредственно само отображение нот, а не фактические MIDI ноты. 
Щелкните правой кнопкой мыши в начале такта и перейдите 
Transpose display > Octaves/Semitones. По октавам (Octaves) можно 
транспонировать в диапазоне от +3 до -3. По полутонам (Semitones) 
можно транспонировать в диапазоне от +11 до -11. Можно 
транспонировать комбинацией октав и полутонов, используя эту опцию 
дважды. Опция Clear из этого же меню используется для сброса 

транспонированных нот в их предыдущие позиции. 
 

Дисплейное транспонирование: инструменты 
(См. также Опции транспонирования). Чтобы 
транспонировать ноты определенного инструмента, 
выберите опцию Transpose instruments из меню 
Transpose display, а затем выберите инструмент. 
Часть опций транспонирования инструментов 
продемонстрирована на рисунке слева. Например, 
чтобы транспонировать ноты кларнета, вы бы 
выбрали +3 Eb. Важно понять, что дисплейное 
транспонирование само по себе не изменяет 
фактические MIDI данные. Тем не менее есть опция 
дисплейного транспонирования, которое затрагивает 
знаки альтерации. Мы вернемся к ней в конце этого 
списка. Опция Clear из этого же меню используется 
для сброса транспонированных нот в их предыдущие 
позиции. 
 
 
 

Дисплейная квантизация: эта опция может 
использоваться для изменения ваших Глобальных 
параметров квантизации (опция также доступна из меню 
View > Notation view settings) или для изменения 
различных параметров квантизации на основе трека. См. 
также Параграф "Опции меню View редактора нотации". 
 
 
 
 

 
Изменение ключа: Чтобы вставить новый ключ в начале такта, щелкните правой кнопкой мыши по такту и 
выберите опцию Change clef, а затем выберите ключ из списка. Выбор в этом списке совпадает с выбором в 
меню Default clef. Чтобы удалить ключ, щелкните правой кнопкой мыши и выберите опцию Delete из меню 
Change clef. 
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Изменение темпа/музыкального размера/ритмического 
паттерна: чтобы вставить изменение музыкального размера в 
начале любого такта, щелкните правой кнопкой мыши и выберите 
опцию Change tempo/time signature/rhythm pattern из меню. Эта 
опция открывает диалоговое окно (на рисунке слева), где можно 
внести необходимые изменения. Здесь же можно изменить 
текущий темп, музыкальный размер и/или ритмический паттерн. 
Для подтверждения нажмите OK. 
 
 
 
 
 
 
 
 
 
 
 
 

Изменение знаков альтерации: используйте эту опцию из 
контекстного меню для вставки изменений знаков альтерации 
в начале такта.  
 
 
 
 
 
 
 
 
 

 
Опции параметров проекта: после опций такта (Measure settings) в 
меню следуют две переключаемые опции параметров проекта для 
отображения изменений темпа проекта (Show project tempo changes) 
и отображения знаков альтерации в виде бемолей в до мажоре 
(Display accidentals as flats in C major). 

 
Удаление знака альтерации: щелкните правой кнопкой мыши по знаку 
альтерации и перейдите Change key signature > Delete key signature в 
контекстном меню. 
 
 
 

 
Последняя группа элементов в этом меню 
включает шесть переключаемых опций:  
 
Key signature changes affect all tracks 
(изменения знаков альтерации затрагивают все 
треки),  
Transposing display affects key signatures 
(дисплейная транспозиция затрагивает знаки 
альтерации),  

When transposing display, show transposed semitones below key sigs (при дисплейной транспозиции, 
показать транспонированные полутоны ниже знаков альтерации),  
Disable transposing display (отключить дисплейную транспозицию). 
Show project markers (показать маркеры проекта) 
Show project regions (показать регионы проекта) 
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14.7.3. Общие опции и действия редактирования 
 

Щелчок правой кнопкой мыши почти в любом месте за исключением 
ноты или элемента открывает общее меню с опциями редактирования 
нотации. Эти опции включают типичные общие опции редактирования 
(Копирование, Вырезание, Вставка, и т.д.), а также четыре 
специфические команды представления нотации: 
 
Dynamics (вставить динамику) 
Insert lyric (вставить текст) 
Tuplet (вставить мультиоль) 
Pedal (вставить сообщения педали) 
Voice (вставить голос) 

Hide Notes (скрыть ноты) 
Chords (аккорды) 
 
Эти опции будут объяснены ниже. 
 
Dynamics (вставка динамики): щелкните по нотному стану, чтобы переместить курсор редактирования в эту 
позицию. Щелкните правой кнопкой и выберите Dynamics из меню.  
 
В открывшимся меню выберите динамический оттенок: 
 

Text - напечатайте свое собственное обозначение 
Crescendo (крещендо) - постепенное повышение громкости 
Dimuendo (диминуэндо) - постепенное понижение 
громкости 
pppp (пианиссимо-пианиссимо) - насколько возможно тихо 
ppp (пиано-пианиссимо) - очень, очень тихо 
pp (пианиссимо) - очень тихо 
p (пиано) - тихо 
mp (меццо пиано) - умеренно тихо 
m (меццо) - умеренно 
mf (меццо форте) - умеренно громко 
f (форте) - громко  
ff (фортиссимо) - очень громко 
fff (форте-фортиссимо) - очень, очень громко 
ffff (фортиссимо-фортиссимо) - насколько возможно громко 
 
Пример отображения динамики показан на рисунке ниже. 

 

 
 
 Динамические оттенки - всего лишь исполнительные инструкции: они не затрагивают сами фактические MIDI 
данные. 
 
Изменение динамики: чтобы изменить динамический оттенок с одного в другой (например, с pp в ppp), 
щелкните правой кнопкой по динамическому оттенку и выберите другой оттенок из меню. Чтобы изменить 
динамический оттенок с одного в текст, дважды щелкните по динамическому оттенку, введите текст и нажмите 
Enter. 
 
Вставка пользовательской нотации: из контекстного меню перейдите Text/Custom > Custom Notation, 
введите имя в области Name, выберите символ и нажмите OK. Нотация с вашим название также автоматически 
добавляется в меню Text/Custom для последующего выбора. 

 
Расширение/сужение вилки крещендо или диминуэндо: наведите курсор мыши 
на начало или на конец элемента так, чтобы курсор мыши изменился на 
двухстороннюю стрелку. Перетащите мышь влево/вправо по усмотрению. 
 
 
 

Удаление динамического оттенка: щелкните по динамическому оттенку и нажмите клавишу Delete. 
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Перемещение динамического оттенка или текста: наведите мышь на середину элемента, а затем щелкните и 
перетащите элемент в его новую позицию. 

 
Вставка текста: щелкните по нотному стану, чтобы 
переместить курсор редактирования в эту позицию. 
Щелкните правой кнопкой мыши и в контекстном меню 
выберите опцию Insert lyric. Введите текст и нажмите OK. 
 
 
 
 
 
 
 
 

 
Удаление текста: Щелкните по текущему тексту и нажмите клавишу Delete. 

 
Редактирование текста: щелкните правой кнопкой мыши по 
тексту и в окне изменения текста внесите изменения, а затем 
нажмите клавишу Enter. Чтобы переместить текст, его можно 
перетащить. Текст можно также отредактировать в режиме 
списка событий (как, впрочем, и другие события), 
 
 
 
 
 
 
 

Вставка последовательного текста: введите первую часть 
текста в окне редактирования текста, а затем нажмите 
Forward. В окне редактирования текста нажмите Forward, 
чтобы переместить курсор, а затем введите вторую часть 
текста в окне. Повторите этот процесс нужное количество 
раз, а затем нажмите OK. Кнопка "Back " может 
использоваться для обратного перемещения по тексту, 
например, чтобы его отредактировать. 
 
 
 
 
 

Вставка мультиолей: мультиоль - ритмическая фигура из произвольного 
количества нот, равная по общей длительности двум или четырем нотам того же 
написания. Если какая-либо длительность делится на 5 нот (например, четверть 
на 5 шестнадцатых), образуется группа, называемая квинтолью (обозначается 
над группой цифрой 5 или пропорцией 5: 4); если длительность делится на 6 нот, 
образуется секстоль (обозначение - 6 или 6: 4) и т. д. К этому типу ритмических 
фигур относится также триоль (triplet; обозначение - 3 или 3: 2, иногда 3: 4).  
 
 
 
 
 
 
 

 
Чтобы вставить мультиоль, определите позицию курсора редактирования, щелкните правой кнопкой мыши и 
перейдите Tuplet > Create tuplet.  
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При этом также появляется диалоговое окно Create tuplet. По умолчанию определена для вставки триоль (3:2), 
но вы можете изменить ее по усмотрению. Можно также выбрать длительность ноты в пределах от 1/128 до 1/2 
и назначить ее на любой выбранный канал. Другая опция состоит в изменении позиций нот.  
Нажмите Create, чтобы создать скобку мультиоли в качестве отдельного элемента на нотном стане, который 
можно перетаскивать по усмотрению. После этого диалоговое окно Create tuplet меняется на диалоговое окно 
Edit tuplet. Мультиоли затрагивают фактические MIDI события, например, меняя исходную позицию ноты или ее 
длительность. Ноты будут привязываться к окончаниям мультиолей при их редактировании. Например, триоль 
четвертной ноты, начинающаяся в начале такта, будет охватывать первые две доли такта и включать окончание 
на долях 2/3, и окончание на долях 4/3 (каждая тройка четвертной ноты продолжительностью 2/3, так как триоль 
включает 3 ноты в продолжительность, которая обычно равняется 2). Вы можете также изменить тип мультиоли 
после ее создания: например, триоль четвертной ноты можно переключить на дуоль; компонентные ноты не 
изменятся, но сама триоль сократится. Типичные мультиоли - это 2:3 (дуоль), 3:2 (триоль), 4:3, 5:4, 6:4. 
Например, четвертная нота может быть разделена на три (триоль), пять (квинтоль), шесть (секстоль) или семь 
(септоль) частей. Однако диалоговое окно Edit Tuplet позволяет определить любое разделение.  
 

Где необходимо, будут автоматически добавлены паузы для пропущенных нот в мультиоли. 
Паузы обозначаются символом длительности паузы.  
 
 

 
Перемещение, изменение или редактирование мультиолей: чтобы переместить 
мультиоль, просто перетащите ее в другую позицию. Чтобы изменить мультиоль, 
щелкните правой кнопкой мыши по мультиоли, выберите опцию Edit tuplet из меню, 
внесите изменения и нажмите Apply. 
 
 
 
 
 
 
 
 
 

 
Удаление мультиолей: Чтобы удалить мультиоль, щелкните правой кнопкой мыши по мультиоли и выберите 
опцию Remove tuplet из меню. 
 

Понимание и управление мультиолями: если 
активирована опция Automatically detect 
triplets, триоли будут распознаваться 
автоматически. Автоматически распознанные 
триоли будут окрашены в серый цвет. Если вы 
переместите или измените автоматически 
распознанную триоль (не компонентные ноты, а 

саму скобку триоли), триоль останется до тех пор, пока вы не удалите ее вручную.  
 
Опции контекстного меню текущей мультиоли: Edit (редактировать мультиоль), Tuplet note length 
(длительность нот мультиоли) и Remove tuplet (удалить мультиоль). Мультиоли можно добавлять и 
присоединять к выбранным нотам при их вставке. Эта тема будет затронута в следующем параграфе. 
 
Педализация: в контекстном меню в подменю Pedal доступны две опции педализации - Engage pedal (педаль 
нажата) и Release pedal (педаль отпущена). Также доступна опция отображения/скрытия нотации педали. 

 
Добавление гармонии (голосов): подменю 
Voice может использоваться для выбора опций 
All notes in default voice, All notes in high 
voice или All notes in low voice. Способ 
конфигурации нот в указанный голос 
объясняется в следующем списке. 
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Скрытие нот: опция Hide Notes может использоваться для скрытия нот в 
любой указанной октаве. Это полезно для скрытия клавиш переключения 
или других событий, не предназначенных для исполнения музыки. 
Выберите эту опцию из контекстного меню, затем выберите нужную 
октаву из раскрывающего меню. Потом, выберите определенную ноту из 
списка или выберите опцию Hide octave, чтобы скрыть все ноты в этой 
октаве. Повторите те же шаги, чтобы отобразить любую в настоящее 
время скрытую ноту. Чтобы сбросить отображение всех в настоящее 
время скрытых нот, выберите опцию Unhide all notes из меню. 
 
 
 
 
 
 

14.8. Работа с нотами и с несколькими выбранными нотами 
 
Некоторые специфические опции представления нотации доступны из собственного контекстного меню этого 
представления. Выберите ноту (или серию нот) и щелкните правой кнопкой мыши, чтобы отобразить это меню. 
Музыкальная теория выходит далеко за пределы объема данного Руководства пользователя. Тем не менее, для 
тех, кто хочет узнать об этом больше, информация в списке ниже может служить отправной точкой в 
ознакомлении некоторых из этих терминов. 

 
Знаки альтерации: знаки альтерации (диезы и бемоли) являются 
инструкцией повышения или понижения высоты тона ноты на 
полтона. Выберите ноту, щелкните по ней правой кнопкой мыши и 
выберите опцию Accidental из меню. Затем можно выбрать знак 
альтерации из выпадающего меню. Различные значения, конечно, 
будут зависеть от различных нот. Последняя опция этого меню, 
Default notation for accidentals in C major, может принимать 
значения Sharp (диез) или Flat (бемоль). Действия перемещения нот 
будут перемещать ноту, а не только изменять ее позицию на дисплее. 
Если нота интерпретирована двояко (например, до диез или ре 
бемоль), меню предложит выбор. Это действие затронет не 

фактическую MIDI ноту, а только знак альтерации. 
 
Направление штилей нот: Доступные значения: Stem up (штили вверх), Stem down (штили вниз), Default 
stem direction (направление штилей по умолчанию). 

 
Ребро, объединяющее ноты: щелкните правой кнопкой мыши по выбранной ноте и 
перейдите Beam > Beam notes together, чтобы объединить ноту под ребром. Опция 
Do not beam notes может использоваться для удаления объединения под ребром. 
Это позволит вам разбить "зареброванные" ноты для улучшения отображения 
намеченного ритма. Например, если четыре шестнадцатые ноты объединены ребром, 
но формулируются как 1+3, вы можете начать новое ребро на второй ноте. 

Заключительная опция в этом меню - Default beaming, которая возвращает ноты в значение по умолчанию. 
 

Лига, связывающая ноты одной высоты тона для 
увеличения длительности ноты/ноты с точками: 
Эти опции меню могут использоваться с серией нот. 
Щелкните правой кнопкой мыши по серии нот, затем 
перейдите Dot/Tie > Minimize ties, чтобы 

минимизировать количество лиг в серии нот. Здесь же доступна опция Minimize ties for all notes by default 
(минимизировать лиги для всех нот по умолчанию). Опции для нот с точками - Double dot if possible (две 
точки, если возможно), Triple dot if possible (три точки если возможно) и Do not double or triple dot note (не 
две и не три точки). 
 

Мультиоль: подробнее о мультиолях смотрите в предыдущем параграфе 
"Общие опции и действия редактирования". Мультиоли можно также определить 
в качестве атрибута серии нот. Например, можно установить три ноты в качестве 
мультиоли, а REAPER приложит все усилия, чтобы выяснить правильное 
начало, конец, продолжительность мультиоли, основываясь на позициях нот, 
игнорируя их изменения. Для этого выделите серию нот, в контекстном меню 
перейдите Tuplet > Create tuplet, а затем введите нужные значения в 
диалоговом окне Edit tuplet. Результат ваших действий не всегда может 
совпадать с задуманным: поэтому, вы можете использовать способ, 

объясненный в параграфе "Общие опции и действия редактирования". 
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Выбор голоса: ноты можно установить в Верхний голос (High voice) или 
Нижний голос (Low voice). Для этого выберите ноты, а затем щелкните 
правой кнопкой мыши по выбранным нотам и перейдите Default voice > High 
voice или Default voice > Low voice в контекстном меню. Ноты в выбранном 
голосе будут сгруппированы и объединены ребром, а штили у них будут 
отличаться от штилей других нот для визуальной идентификации отдельных 
музыкальных партий. Таким же образом голос можно выбрать и для недавно 
вставленной ноты. В подменю Voice этого же меню (или из общего 
контекстного меню редактирования), вы можете выбрать команды Select all 

notes in high voice (выделить все ноты верхнего голоса) или Select all notes in low voice (выделить все 
ноты нижнего голоса). Для нот верхнего голоса выше отображаются артикуляции: для нот нижнего голоса 
артикуляции отображаются ниже. Отметьте также, что выпадающий список Color включает опцию окрашивания 
нот выбранного голоса, а выпадающий список Voice определяет голос для вставленных нот. 
 

Фразировка/фразировочная лига: кривая линия, объединяющая ноты 
во фразу, известна как фразирововчная лига. Чтобы определить 
фразировку, сначала выберите ноты, а затем перейдите Phrase/slur > 
Make phrase/slur в контекстном меню. Типичная фразировка 
обозначается кривой линией (лигой), как показано на рисунке, но можно 

выбрать и другую фразировку (slide, bend, or hammer/pull), перейдя Phrase/slur > Technique в контекстном 
меню ноты. Фразу можно отредактировать, переместив ее метки. Чтобы выбрать все ноты во фразировке, 
щелкните по любой ноте в этой фразировке, а затем щелкните правой кнопкой мыши и перейдите Phrase/slur > 
Select all notes in phrase/slur. Опция Remove phrase может использоваться для удаления фразировки серии 
нот. 
 

Ключ: используйте эту опцию для перемещения ноты или серии 
нот из скрипичного ключа в басовый или наоборот. 
 
 
 

Октава: Используйте эту опцию для перемещения серии нот за пределы нотного стана вверх или вниз на 1, 2 
или 3 октавы. Это еще одна опция, не затрагивающая непосредственно сами MIDI ноты. Очень высокие или 
очень низкие ноты (далеко от нотного стана) можно таким образом подвинуть поближе к нотному стану, не 
затрагивая их высоту тона. 
 

Артикуляция: артикуляции используются для указания способа звукоизвлечения 
отдельных нот в пределах фрагмента - например, Акцент или Стаккато. Опции этого 
меню продемонстрированы на рисунке справа. Это всего лишь инструкции, 
артикуляции не затрагивают фактические MIDI события. Поддерживается до двух 
артикуляций и один штрих на ноту. 
 
 
 
 

Орнаментика: используйте эту опцию для вставки орнаментики на или 
после выбранной ноты или на каждой ноте в серии нот. Доступные 
опции: форшлаг (Grace note), Тремоло (Tremelo) Трель (Trill), 
Мордент с верхней вспомогательной нотой (Upper Mordent) и 
Мордент с нижней вспомогательной нотой (Lower Mordent). Форшлаг 
- мелодическое украшение, состоящее из одного или нескольких звуков, 
предшествующих какому-либо звуку мелодии, и исполняющееся за счёт 
длительности последующего звука (как правило). Форшлаг обозначается 
мелкой нотой, записанной перед основной. Форшлаги затрагивают 
фактические MIDI события. Трель (обозначенный tr) один из наиболее 
употребительных мелизмов; быстрое чередование двух соседних нот, 
отстоящих на секунду, большую или малую. Первая нота называется 
главной и по отношению к гармонии — гармонической, вторая — 
вспомогательной. Обычно вспомогательная нота стоит выше главной. 
Snap - привязка струн к грифу. Pluck - щипок на струнном инструменте. 
Up bow и down bow также относятся к струнным инструментам: up bow 
- вести смычок вверх или влево и down bow вести смысок вниз или 

вправо. Орнаментику можно удалить, щелкнув правой кнопкой мыши по ноте или серии нот и выбрать опцию 
Remove ornament из контекстного меню. 
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Головка нот: можно изменить изображение головок нот от 
стандартного эллиптического символа до любого из доступных. 
Щелкните правой кнопкой мыши по любой ноте или серии нот и 
перейдите Note head > Selected notes (only) (только выбранные ноты) 
или All notes at selected pitch (все ноты выбранной высоты тона). 
Затем можно выбрать графическое изображение головки нот из 
приблизительно 20 доступных. 
 
 
 
 
 

 
Эти опции используются для изменения позиции (Edit displayed 
note position) или длительности  (Edit displayed note length) 
выбранной ноты (нот) смещением вправо или влево. Здесь же 
доступна опция удаления текущих смещений (Clear display 
offset). 

 
Аккордовая нотация: чтобы идентифицировать и 
нотировать базовый аккорд, сначала выберите ноты, а 
затем щелкните правой кнопкой мыши по выбранным 
нотам и выберите опцию Chord notation из контекстного 
меню. Если аккорд идентифицирован, он отобразится 
опцией меню (как на рисунке справа, Gmaj). Щелкните по 
этому лейблу для подтверждения. После этого название 
аккорда будет отображено в партитуре. На примере, 
показанном на рисунке, было идентифицировано 
несколько аккордов как Dmaj или как Gmaj. Есть также 
опция Other для ввода аккордов вручную. Это меню также 
включает переключаемое действие Identify chords on 
editor grid (идентифицировать аккорды на сетке 
редактора). 
 
 

 
Примечание: наряу с возможностью выбора лада (мажор, минор, и т.д.) в выпадающем меню MIDI 
редактора, Вы можете также выбрать команду Load из этого же меню и импортировать ваш собственный 
.reascale файл, который может использоваться для определения ваших собственных звукорядов и 

аккордов. Файл sample.reascale включен в REAPER. 
 
Скрытие нот: используйте эту опцию, чтобы скрыть в настоящие время 
выбранные ноты. Чтобы отобразить скрытые ноты, выберите опцию Unhide all 
notes из того же меню. 
 

 
Внизу контекстного меню нот есть секция с несколькими командами меню Edit 
MIDI редактора - Copy, Cut, Paste, Select all, Delete, Insert note, и т.д. 
Диалоговое окно Note properties объясняется в Главе 13. 
 
 
 
 
 
 
 
 
 
 

 
Примечание: нотация, создаваемая в представлении музыкальной нотации также будет отображаться в 
списке событий (см. Главу 13). 
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14.9. Экспортирование и импортирование нотации в формат MusicXML 
 
14.9.1. Эксопртирование нотации в формат MusicXML и PDF 
 
В настоящее время невозможно распечатать вашу музыкальную партитуру непосредственно из REAPER. 
Однако вы можете экспортировать свою партитуру в формат MusicXML, который может считываться 
программами Finale, Sibelius, MuseScore, Forte, Cubase и многими другими программами. 
 
1. Откройте партитуру в MIDI редакторе REAPER и выберите редактор нотации. 
2. Перейдите File > Notation: Export (PDF, MusicXML) 
3. Оставьте директорию по умолчанию или выберите другую. Введите имя файла. 
4. Выберите опцию score-partwise или score-timewise (см. примечание ниже). 
5. Нажмите кнопку Save. 
 
Различие между опциями partwise и timewise заключается в приоритетах, которые применяются в 
расположении элементов партий аранжировки и тактов. Если партитура содержит несколько партий, каждая из 
которых содержит один или несколько тактов, опция score-partwise организует партитуру с элементами партий 
наверху иерархии. Опция score-timewise реверсирует эту иерархию. Если вы не уверены в выборе, оставьте 
параметры как есть. Обратите внимание, что экспорт в формат MusicXML в PEAPER поддерживает 
мультислойную музыку. 
 
14.9.2. Импортирование нотации в формат MusicXML 
 

Вы можете импортировать XML-файл (например, который 
сделан в MuseScore), перетащив его из проводника в 
область аранжировки REAPER. При этом доступны 
несколько опций: 
 
Expand the MIDI tracks (распределить MIDI треки в 
эквивалентном количестве треков REAPER) 
Import the MIDI tempo map to the project tempo 
(импоритровать темпокарту в темпокарту проекта)  
 
 

Import MIDI markers (импортировать MIDI маркеры) (если таковые имеются) to project markers (в карту 
маркеров проекта) 
 
REAPER будет импортировать в проект этот файл как MIDI клип, который можно будет открыть в MIDI 
Редакторе и отредактировать как и любой другой MIDI клип. 
 

14.10. Создание панели инструментов редактора нотации 
 
Если вы использовали другое программное обеспечение для редактирования нотации, вы можете обнаружить, 
что в REAPER не хватает специализированной инструментальной панели нотации. Поэтому вы можете начать с 
нуля и создать вашу собственную панель, добавляя в нее те опции, действия и команды, которые являются 
самыми важными для вас. Как это сделать, объяснено в Главе 15. Все что вам нужно, можно найти в списке 
действий MIDI редактора. 
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15. Пользовательские настройки: действия, модификаторы 
мыши, меню и панели инструментов 

 
15.1. Введение 

 
Пользовательская настройка - ключ к раскрытию реальной мощи REAPER и способ заставить программу 
работать на вас. Чем дольше вы пользуетесь программой, тем больше пользы вы извлекаете из возможности 
пользовательских настроек ее многочисленных функций. Даже непрофессиональные пользователи 
согласятся, что не зря потратили время по крайней мере на настройку некоторых модификаторов мыши и 
горячих клавиш REAPER. Обо всем об этом мы поговорим в данной главе. К настоящему моменту вы должны 
были уже столкнуться с некоторыми опциями и предварительными настройками REAPER, и вполне вероятно, 
что вы возможно уже изменили некоторые из них под свою деятельность в Reaper. В этой главе речь пойдет о 
следующих аспектах применения пользовательских настроек: 
 
Действия (Actions): в REAPER широко распространено применение горячих клавиш. Кроме того, программа 
подразумевает сотни действий, которые вы не найдете ни в одном из ее меню, действия, которые могут 
помочь вам в решении любой задачи. Кроме того, вы можете выстроить целые последовательности действий, 
создавая свои собственные команды, напускающиеся нажатием одной клавиши. 
Модификаторы мыши (Mouse Modifiers): мышь в REAPER используется для выполнения множества 
действий, с некоторыми из которых вы уже встречались (например, перемещение и копирование клипов и 
выделение области, и создание области лупа), с некоторыми из них вы еще не встречались (например, 
редактирование огибающих автоматизации). Некоторые из этих действий вы будете использовать часто, 
некоторые реже, а некоторые очень редко или вообще не будете использовать. Любое из этих действий можно 
изменить. 
Меню (Menus): большинство меню в REAPER доступны для пользовательского редактирования. Наиболее 
важные для вас опции можно переместить наверх списка меню. Опции, которыми вы никогда не пользуетесь, 
можно просто скрыть. В меню можно даже добавлять ваши собственные действия и опции! 
Панели инструментов (Toolbars): панель инструментов REAPER может выглядеть непривлекательно с ее 
однотипным набором всего лишь с четырнадцатью инструментами. Но знаете ли вы, что на панель 
инструментов можно добавлять ваши собственные инструменты, а также создавать ваши собственные 
дополнительные панели инструментов? Все это будет затронуто в данной главе. Не пожалейте времени на 
изучение этой темы и с вас окупится сполна. 
 

15.2. Основы действий REAPER 
 

Прежде чем мы заглянем внутрь редактора действий 
REAPER, чтобы исследовать мир горячих клавиш, 
пользовательских действий, назначений на внешние 
аппаратные контроллеры и многое другое, стоит 
ознакомиться с парой полезных ресурсов.  
Опция Key bindings and mouse modifiers в меню Help 
открывает в вашем веб браузере список всех текущих 
горячих клавиш и модификаторов мыши. Этот список 
включает систему поиска и его можно распечатать.  
Опция Action list as HTML в том же меню Help открывает в 
вашем веб браузере список всех доступных действий 
REAPER, на любое из которых можно назначить горячую 
клавишу и/или объединить с другими действиями в вашу 
собственную последовательность действий. Этот список 
также включает систему поиска и его можно распечатать.  
 
 

 
Прежде чем кинуться к принтеру, примите во внимание, что эта информация 
также содержится в пределах самого редактора действий, и в редакторе 
также доступна система поиска. Чтобы открыть редактор действий перейдите 
Actions > Show action list, или просто нажмите клавишу ?. 
 
 
 

Опция ReaScript documentation: плагин ReaScript будет объяснен позже в этой главе и в Главе 24. Вкратце, 
ReaScript элементы могут использоваться для расширения функциональности REAPER. Несколько образцов 
скриптов можно найти и загрузить со страницы stash.reaper.fm/tag/Scripts. Эти скрипты необходимо поместить 
в подпапку Scripts в директории REAPER системной папки Applications data. После этого скрипты можно 
выбрать и запустить в редакторе действий REAPER, нажав на кнопку Reascript Load. 
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15.3. Интерфейс редактора действий (окно Actions) 
 
Максимальную пользу от редактора действий REAPER можно получить в том случае, если перед его 
использованием потратить немного времени на изучение его интерфейса, структуры и навигации. 
 

 
 
Область Filter: здесь вы можете отфильтровать список отображаемых действий, введя любую текстовую 
строку. Например, на примере ниже в области Filter была введена строка track height в результате чего 
список был отфильтрован для отображения только тех действий, которые относятся к изменению высоты 
трека: 
 

 
 
Обратите внимание, что, если на действие назначена горячая клавиша, она отображается налево от действия 
в столбце Shortcut. Например клавиша ! (клавиша 1 в русской раскладке) назначена на действие View: 
Expand selected track height, minimize others (максимизировать высоту выбранного трека, минимизировав 
высоту остальных треков), а горячая клавиша Ctrl+Shift+Mousewheel назначена на действие Adjust 
selected track heights (отрегулировать высоту выбранных треков). В втором примере фильтр 
использовался для перечисления всех действий, касающихся новых треков (была введена строка new track).  
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Единственное из этих действий на которое в настоящее время назначена горячая клавиша - Track: Insert new 
track (вставить новый трек) (Ctrl+T). 
 
Кнопка Clear: очищает любой текущий фильтр и восстанавливает список всех действий. 
 
Кнопка Find shortcut: используется для идентификации назначения конкретной горячей клавиши на какое-
либо действие. Щелчок по этой кнопке открывает окно запроса, где предлагается ввести клавишу или 
затронуть MIDI-контроллер.  
 

 
 
Тему MIDI-контроллеров мы рассмотрим позже в этой главе. Если вводимая клавиша уже используется, будет 
отображено ее назначение.  
 

 
 
На примере выше, мы пытались найти, есть ли действия, назначенные на горячие клавиши с буквой S. Если 
вы хотите найти сочетание выбранной буквы с клавишей-модификатором, необходимо нажать модификатор, 
например, в данном случае Shift, а затем в окне запроса ввести букву - в данном случае S. В данном примере 
такая комбинация нашлась для действия Item: Split item at time selection. Во втором примере ниже 
аналогичным образом мы искали действие с комбинацией Ctrl+A: 
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Если для клавиши или комбинации клавиш введенная клавиша не существует, 
появляется сообщение Shortcut not found (комбинация не найдена). 
 
 
 
 
 
 
 
 

 
Заголовки столбцов/ключи сортировки: столбец State указывает на статус переключаемого действий on 
(активно) или off (не активно). По умолчанию действия перечислены в алфавитном порядке их названий. 
Щелчок по заголовку столбца Shortcut позволяет отсортировать список. Например, наверху списка вместо 
назначений будут отображаться специальные символы и цифры (см. рисунок ниже).  
 

 
 
Повторный щелчок по заголовку столбца позволяет инвертировать порядок сортировки. Щелкните по 
заголовку столбца Description, чтобы восстановить список в алфавитный порядок. 
 

Меню Section: список действий разделен на разделы, перечисленные в этом 
меню. Main - это раздел, который используется большую часть времени 
(например, когда вы работаете в области аранжировки). Есть разделы, 
например, для действий и горячих клавиш в среде браузера клипов (Media 
Explorer) или в среде MIDI редактора (MIDI Editor) и т.д. Если вы откроете окно 
Actions c одного из этих мест, Список действий автоматически перечислит 
действия, относящиеся к этой среде. Альтернативно, можно выбрать и любой 

другой раздел в этом меню. 
Кнопка Run: щелкнув в списке по названию действия и нажав эту кнопку можно запустить любое действие, не 
зависимо от того, назначена ли для него горячая клавиша или нет. Если в главном меню Actions REAPER 
отмечена опция Show recent actions, любые действия, которые вы запускаете кнопкой Run в течении 
текущего сеанса, будут добавлены в меню Actions REAPER и оттуда их можно запустить в дальнейшем в этом 
сеансе. Когда вы закроете REAPER, эти действия будут удалены из меню. 
 
Кнопка Run/Close: эта кнопка по функционалу схожа с кнопкой Run, но запуская действие, она закрывает окно 
Actions. 
 
Кнопка Close: закрывает окно Actions. 
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Опция Remember last action filter: если эта опция отмечена 
(из контекстного меню окна Actions), REAPER будет 
запоминать редакции области фильтра и применять их в 
следующий раз, когда окно будет открыто окно Actions, даже 
в другом сеансе. 
 
 
 
 
 
 

Опция Show action IDs: эта опция отображает/скрывает в списке действий столбец Command ID, 
отображающий ID номер действия REAPER. 
 

 
Окно Actions включает основные особенности других окон REAPER. Например, символ булавки  (в верхнем 
правом углу окна) может использоваться для сохранения окна Actions поверх остальных окон или окно 
Actions можно прикрепить на панель Docker (из его контекстного меню). 
 

В окне Actions доступно контекстное меню, показанное на рисунке слева. Две 
переключаемые команды - Remember last action filter (когда список закрыт и 
позже открыт вновь) - (Помнить последний фильтр действий), и/или Close 
after action on double-click/enter (Закрыть после выбора действия двойным 
щелчком/нажатием клавиши Enter). Следующие три действия предназначены 
главным образом в помощь сценаристам скриптов и разработчикам - Show 
action IDs (Показать ID действия), Copy selected action command ID 
(Скопировать ID команды выбранного действия) и Copy selected action text 
(скопировать текстовый вариант выбранного действия). Наконец, 
последние переключаемые команды - Dock Action window in Docker 

(Пристыковать окно Actions на панель Docker) и Close window (Закрыть окно). 
 
В окне Actions вы заметите несколько других функций, включая дополнительные кнопки, некоторые из 
которых в настоящее время не доступны. Очень скоро мы доберемся и до них. 
 

15.4. Создание новой горячей клавиши 
 
Давайте на примере панели Docker создадим новую горячую клавишу. Введите в области фильтра слово 
attach, и вы увидите, что у действия View: Attach/unattach Docker to/from main window горячая клавише пока 
не назначена. Аналогично, если вы используете кнопку Find shortcut и вводите в окне запроса букву Q в 
нижнем регистре, вы обнаружите что у этой буквы в настоящее время нет назначенного действия.  
 

 
 

Кстати, REAPER не позволит вам случайно изменить текущие 
клавиатурные назначения. При попытке использовать клавишу, 
которая уже назначена в другом месте, появится сообщение как на 
рисунке налево. При попытке назначить букву U в нижнем регистре 
на действие появилось бы сообщение как на рисунке. После этого 
вы могли бы изменить назначение для этой клавиши или оставить 
ее как есть. 
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Пример: 
 
1. Из меню Actions выберите опцию Show action list. 
2. Давайте посмотрим, можем ли мы использовать клавишу Q для прикрепления на панель Docker. В окне 
запроса Find shortcut введите букву Q в нижнем регистре. Вы увидите сообщение Shortcut not found. Тем не 
менее мы знаем, что это клавиатурное сочетание доступно. Нажмите OK, чтобы закрыть это окне запроса. 
3. Введите в области фильтра слово attach, а затем выберите из списка действие View: Attach/unattach 
Docker to/from main window. 
4. Нажмите кнопку Add, чтобы открыть окно Keyboard or MIDI Input (на рисунке ниже).  
 

 
 
В этом окне снимите галочку с опции Automatically close window on key/MIDI input. Это уменьшит 
вероятность того, что вы назначите неправильную клавишу по ошибке. 
5. Введите букву q в нижнем регистре. Теперь вы увидите букву Q в области Shortcut (см. рисунок выше). 
6. Нажмите OK. Теперь эта горячая клавиша назначена. 
7. Закройте окно Actions. 
8. Теперь можно использовать клавишу Q для прикрепления/открепления панели Docker к/из главного окна. 
 

15.5. Удаление текущей горячей клавиши 
 
Удалить текущую горячую клавишу довольно легко. Например, вы хотите удалить горячую клавишу, которую 
вы только что назначили на действие View: Attach/unattach Docker to/from main window: 
 
1. В списке действий найдите и выберите действие View: Attach/unattach Docker to/from main window, 
горячую клавишу которого вы хотите удалить. Текущая горячая клавиша (клавиши) будет отображена чуть 
ниже списка. (см. рисунок ниже). 
 

 
 
2. Щелкните по горячей клавише (в данном примере, это буква Q). 
3. Нажмите кнопку Delete. 
 

15.6. Изменение текущего клавиатурного назначения 
 
Процедура изменения текущего клавиатурного назначения состоит из двух действий - создания новой горячей 
клавиши и удаления текущей. Давайте возьмем в качестве примера назначение клавиш стрелка вверх и 
стрелка вниз курсора клавиатуры на действия Track: Go to previous track и Track: Go to next track вместо 
горячих клавиш по умолчанию Ctrl+Alt+Up и Ctrl+Alt+Down. 
 
1. Найдите и выберите действие Track: Go to previous track. 
2. В области Shortcuts for selected action выберите горячую клавишу Ctrl+Alt+Up (см. рисунок ниже). 
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3. Нажмите клавишу Delete, чтобы удалить эту горячую клавишу. 
4. Нажмите Add, чтобы отобразить окно Keyboard or MIDI Input. 
5. Нажмите клавишу со стрелкой вверх (см. рисунок ниже), а затем нажмите OK. 
 

 
 
6. В окне запроса если вы хотите переназначить текущее назначение на действие View: Zoom in horizontal, 
нажмите OK. Вы все еще сможете использовать клавишу + цифровой клавиатуры для горизонтального 
масштабирования. 
7. Используйте шаги 1-6, чтобы изменить горячую клавишу Ctrl+Alt+Down для действия Track: Go to next 
track на клавишу со стрелкой вниз. 
 

15.7. Исключенные действия 
 
По мере обзора списка действий вы заметите, что некоторые действия сопровождаются префиксом 
«deprecated». Это означает, что такие действия больше не считаются пригодными м не поддерживаются. 
Рекомендуется их не использовать. Главная причина, по которой они до сих пор находятся в списке действий, 
заключается в том, чтобы ваш текущий собственный макрос действий, которые используют эти действия, не 
был испорчен. 
 

15.8. Примеры возможных простых назначений 
 
Большинство продвинутых пользователей полагают, что горячие клавиши - самый быстрый, эффективный и 
продуктивный способ работы с REAPER. В особенности это имеет место для часто повторяемых действий, 
которые иначе заняли бы много времени, манипулируя мышью. Горячие клавиши - чрезвычайно важная 
функция REAPER. По мере продвижения по этому руководству пользователя, и по мере приближения к 
пониманию REAPER, вы обнаружите, что доступны все типы действий, на которые можно назначить горячие 
клавиши, включая сотни действий, которые не встречаются ни в каких меню. Ниже приведены некоторые 
примеры задач, для которых вы могли бы счесть нужным назначение горячих клавиш в разделе Main. 
 
Track: Toggle bypass FX for currently selected track (переключение статуса обхода эффектов для 
текущего выбранного трека): клавиша B 
Track: Toggle bypass FX for all tracks (переключение статуса обхода эффектов для всех треков): Ctrl+B 
Track: View FX chain for current track (отображение цепочки эффектов текущего трека): Ctrl+F 
Track: View routing for current track (отображение маршрутизации текущего трека): клавиша I 
Track: View envelopes for current track (отображение огибающих текущего трека): клавиша K 
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15.9. Горячие клавиши в процессе записи 
 
REAPER очень широко использует горячие клавиши во многих, многих областях. В этом параграфе мы 
рассмотрим создание собственных горячих клавиш для упрощения процесса записи. Возьмем простой пример, 
в котором создадим две горячие клавиши. По мере обретения опыта, вы можете рассмотреть для себя более 
продвинутые примеры. Когда вы останавливаете запись, REAPER по умолчанию спрашивает, хотите ли вы 
сохранить или удалить новые клипы. Раздел Main (alt recording) в меню Section дает возможность обойти 
этот запрос, назначив горячие клавиши для опций, которые вы используете чаще всего - Save All (сохранить 
все) и Delete All (удалить все).  
 
1. В редакторе действий выберите раздел Main (alt recording). См. рисунок ниже. 
 

 
 
2. В области фильтра введите stop save. Вы должны увидеть в списке действие Transport Stop (save all 
recorded media). 
3. Щелкните по этому действию. 
4. Нажмите Add и введите букву S в нижнем регистре, а затем нажмите OK. 
5. Очистите область фильтра, а затем введите stop del 
6. Щелкните по действию Transport: Stop (DELETE all recorded media). 
7. Нажмите Add, а затем введите букву D в нижнем регистре, чтобы назначить эту горячую клавишу на 
клавишу D. Нажмите OK. 
8. Очистите область фильтра. 
9. Закройте окно Actions. 
10. Убедитесь, что опция Use alternate keyboard section when recording на странице Options > Preferences > 
General > Keyboard отмечена. 
 

 
 
11. Нажмите OK, чтобы закрыть окно Preferences. 
 
С этого момента каждый раз, когда вы будете записывать, клавиши S или D будут использоваться для 
остановки записи с автоматическим сохранением или удалением новых записанных клипов. Клавишу Enter 
можно все еще использовать для отображения окна запроса. Помните также, что, если вы ничего не 
записываете, клавиши S и D принимают свои функции по умолчанию. Например, клавиша S будет 
использоваться для разделения клипа в области аранжировки. 
 

15.10. Горячие клавиши для MIDI редактора 
 
Редактирование - одна из областей, где назначение горячих клавиш на действия может быть особенно 
полезным, и нигде более как при использовании MIDI редактора. Не пожалейте времени на ознакомление со 
списком действий раздела MIDI Editor и вам воздастся сполна. Обратите внимание на разделы редактор 
списка MIDI событий (MIDI Event List Editor) и оперативный MIDI редактор (In-line MIDI Editor). Способы 
назначения горячих клавиш на действия изменения или удаления текущих назначений, и т.д. аналогичны 
используемым в разделе Main. По этой причине этот параграф не включает пошаговых примеров. Тем не 
менее ниже перечислены некоторые примеры действий, которые вы могли бы счесть полезными при работе в 
MIDI редакторе. Особая благодарность Susan G за помощь в составлении этих действий. 
 
Управление нотами 
Вставка нот определенной длительности: Insert note [range from 1/128 to 1/2 to whole note]. 
Легато нот: Set note ends to start of next note. 
Транспозиция нот: Edit: Move notes up/down one octave/semitone. 
Изменение длительности нот в небольших приращениях: Edit: Lengthen/Shorten notes one grid unit/pixel. 
Настройка velocity нот: Edit: Note velocity +/-01, 10. 
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Отображение только тех нот, которые соответствуют определенным критериям: Filter: Toggle filter 
on/off. 
Управление каналами 
Назначение канала для новых нот и событий: Action: Set channel for new events to 01 ...16. 
Отображение всех или определенных каналов: Channel: Show all/only/toggle channels 01 … 16. 
Изменение канала выбранных нот: Edit: Set notes to channel 01 ... 16. 
 
Управление курсором/сеткой 
Продвижение курсора вперед на длительность ноты: Cursor: advance … [range from 1/128 ... to whole note]. 
Перемещение курсора на определенное значение: Edit: Move edit cursor right/left by grid/measure/pixel. 
Изменение деления сетки: Grid: Multiply grid size by... or Grid: Set division to. 
 

15.11. Горячие клавиши для браузера клипов 
 

Если вы интенсивно работаете с импортированными сэмплами и т.д., уделите 
время на изучение следующих действий, доступных в пределах браузера 
клипов: 
 
Действия браузера (Browser): используются для навигации по вашим папкам. 
Например, по умолчанию клавиша Backspace приведет вас к родительской папке 
(относительно текущей папки). 

Действия предварительного прослушивания (Preview): используются для множества задач, включая 
воспроизведение, паузу, останов, вкл/откл функции зацикливания, различные типы перемотки, остановки 
прослушивания при вставке клипа и многие другие. 
Действия подгонки темпа (Tempo match): включают вкл/откл функции подгонки темпа. 
 

15.12. Назначение действий на колесо мыши 
 
Действия можно назначить как на колесо мыши непосредственно, так и с использованием дополнительных 
клавиш-модификаторов. Например, это может пригодиться в том случае, например, если вы хотите, чтобы 
поведением по умолчанию колеса мыши была прокрутка, а не масштабирование. Ниже перечислены 
назначения колеса мыши по умолчанию: 
 
Только колесо мыши: View: Zoom horizontally 
С клавишей Ctrl: View: Zoom vertically 
С клавишей Alt: View: Scroll horizontally 
С клавишей Ctrl+Alt: View: Scroll vertically 
С клавишей Ctrl+Shift: View: Adjust selected track heights 
 
Опять же, способ изменения назначений на эти действия по сути тот же самый что и предыдущие. 
Предположим, например, что вы хотите использовать колесо мыши для горизонтальной прокрутки (Scroll 
horizontally). 
 
1. В списке действий (раздел Main) найдите действие View: Scroll horizontally. 
2. В области Shortcuts for selected action выберите Alt + Mousewheel и нажмите кнопку Delete. 
3. Нажмите кнопку Add, а затем покрутите колесо мыши. Строка Mousewheel появится в области Shortcuts 
окна Keyboard or MIDI Input, а потом в области Shortcuts for selected action, как показано на рисунке ниже. 
 

   
 
4. Нажмите OK. 
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15.13. Экспорт и импорт наборов горячих клавиш 
 

Кнопка  в левом нижнем углу окна Actions может использоваться для сохранения или загрузки 
любых ваших наборов назначений. Экспортируемые назначения по умолчанию сохраняются в качестве 
ReaperKeyMap файла в папку KeyMaps директории Application Data\REAPER. Эту функцию можно также 
использовать для копирования назначений с одного компьютера в другой.  
 

Опции меню кнопки Import/export: 
 
Import: импортирует набор горячих клавиш из текущего 
ReaperKeyMap файл. 
Export all: экспортирует все текущие назначения 
горячих клавиш в ReaperKeyMap файл. 
Export selected items: экспортирует в ReaperKeyMap 
файл только выделенные клипы. 
Restore all shortcut binding to factory defaults: 

удаляет пользовательские назначения и восстанавливает все значения REAPER по умолчанию. 
ReaperKeyMap файлы можно также включить в экспорт/импорт параметров конфигурации (см. Главу 22). 
 

15.14. Создание макросов пользовательских действий 
 
При желании, вы можете назначить определенную последовательность действий на одну горячую клавишу. По 
сути, количество действий, которые можно назначить на одну клавишу или комбинацию клавиш 
неограниченно. Процесс назначения нескольких действий на одну горячую клавишу известен как "создание 
пользовательского действия" или "макрос". При просмотре списка действий, некоторыми элементами вы могли 
бы быть несколько озадачены. Например, вы могли бы задаться вопросом, кому нужно такое действие, как 
Item: Select item under mouse cursor (выбрать клип  под курсором мыши), когда, конечно же, легче просто 
щелкнуть по клипу.  
 
Зачастую, в случае с такими действиями как это, ответ следующий - настоящая мощь подобных действий не в 
использовании их самостоятельно, а в сочетании с другими действиями. 
 
Чтобы создать новый макрос: нажмите кнопку New. Введите имя макроса. 
Чтобы добавить действия в макрос: перетащите действие из списка действий или дважды щелкните по 
действию. 
Чтобы изменить порядок действий: захватите и переместите вверх/вниз действие по списку. 
Чтобы удалить действие из макроса: щелкните по действию в списке действий макроса и нажмите кнопку 
Remove. 
Чтобы добавить макрос в главное меню действий: активируйте опцию Show in actions menu. 
Чтобы объединить макрос в одну точку undo: активируйте опцию Consolidate undo points. 
Чтобы сохранить макрос: нажмите OK. 
Чтобы назначить горячую клавишу на макрос: выберите макрос в списке действий и нажмите Add. 
Чтобы отредактировать текущий макрос: выберите макрос в списке действий и нажмите Edit. 
Чтобы скопировать текущий макрос: выберите макрос в списке действий и нажмите Copy. 
Чтобы запустить текущий макрос: используйте горячую клавишу (если таковая назначена) или выберите 
макрос из меню действий REAPER (если эта опция активирована), или выберите макрос в списке действий и 
нажмите Run. 
Чтобы удалить текущий макрос: выберите макрос в списке действий и нажмите Delete. 
 
Давайте возьмем простой пример. Обычно, чтобы разделить клип необходимо его выбрать, поместить курсор 
редактирования в нужную позицию, а затем нажать клавишу S. Создав макрос мы можем объединить эту 
последовательность действий в одну клавишу. 
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Пример: 
 

 
 
1. В редакторе действий нажмите кнопку New. В окне Create Custom Action введите имя, например, Split 
under mouse. 
2. В списке действий на левой панели найдите действие View: Move edit cursor to mouse cursor. Дважды 
щелкните по этому действию. 
3. В списке действий на левой панели найдите действие Item: Select item under mouse cursor. Дважды 
щелкните по этому действию. 
4. В списке действий на левой панели найдите действие Item: Split items at edit or play cursor. Дважды 
щелкните по этому действию. 
5. Активируйте опцию Consolidate undo points. 
6. Нажмите OK. Вы возвратитесь к главному списку действий с новым выделенным пользовательским 
действием. 
7. Нажмите кнопку Add и введите букву C в нижнем регистре, чтобы назначить эту горячую клавишу на ваш 
макрос. Нажмите OK. 
8. Закройте редактор действий. 
9. Наведите курсор мыши на любой клип и нажмите клавишу C. Клип будет разделен в этой точке. Один из 
разделенных клипов будет все еще выделен. Если это поведение вам не нравится, можно отредактировать 
макрос. 
10. Откройте редактор действий, найдите ваш макрос Split under mouse и выберите его. Нажмите кнопку Edit. 
Добавьте в конец этого макроса действие Item: Unselect all items. Нажмите OK. 
11. Теперь повторно просмотрите макрос. На этот раз макрос разделит клипы, ничего не выделяя. 
 
Это всего лишь один из примеров макросов. Дополнительную информацию о макросах можно найти в ветке 
The Useful Macro Thread Q&A, Tips, Tricks and How To на форуме forum.cockos.com. 
 

15.15. Макросы MIDI редактора 
 
Если вы часто в своей работе используете MIDI редактор, вы должны были понять, что это та среда, в которой 
можно использовать макросы, ускоряющие и упрощающие процесс редактирования. Примеры ниже 
демонстрируют, насколько макрос может быть простым и полезным, за что отдельное спасибо пользователю 
Bevosss: 
 
Navigate: select next note right with same note value (Навигация: выбор следующей ноты с таким же 
значением)/Navigate: move edit cursor to start of selection (навигация: перемещение курсора 
редактирования к началу выделенной области): найти следующую ноту с тем же значением, как и текущая, 
выделить ее и переместить курсор редактирования к началу этой ноты. 
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Navigate: select previous note right with same note value (навигация: выбор предыдущей ноты с таким же 
значением)/Navigate: move edit cursor to start of selection (навигация: перемещение курсора 
редактирования к началу выделенной области): найти предыдущую ноту с тем же значением, как и текущая, 
выделит ее и переместить курсор редактирования к началу этой ноты. 
Edit: Select all (редактирование: выделить все)/Remove selected duplicate events (удалить выделенные 
копии событий)  
Edit: Unselect all (редактирование: снять выделение): этот макрос удаляет все продублированные события 
из текущего клипа. 
Grid: Set grid division to 1 (сетка: установить деление сетки в значение 1(целая нота)/Edit: Insert note at 
edit cursor (редактирование: вставить ноту в позицию курсора редактирования)/Edit: Unselect all 
(редактирование: снять выделение): создать и вставить ноту длительностью одна целая. Эта длительность и 
будет значением деления сетки.  
 

15.16. Импорт скриптов 
 

В целях более продвинутого пользовательского 
программирования, выходящего за рамки 
объединения действий в цепочку, в REAPER 
можно импортировать пользовательские скрипты, 
которые вы, возможно, записали или получили от 
других пользователей и которые призваны 
расширить функциональность программы. 
Скрипты, доступные для импорта: Python, EEL и 

Lua.  
 
Для пользователей Windows: если у вас есть доступ к действиям, записанным в скрипте Python, 
необходимо установить этот скрипт на компьютер, и активировать плагин ReaScript на странице Options > 
Preferences  Plug-ins > ReaScript. В противном случае, соответствующие контроллеры списка действий могут 
быть недоступны. Тема записи скриптов выходит за рамки данного Руководства пользователя, хотя вкратце с 
этим можно ознакомиться в Главе 24. Подробнее об этом на веб-странице 
www.cockos.com/reaper/sdk/reascript/reascript.php. 
Документацию по плагину ReaScript также можно открыть в меню Help, выбрав команду HTML Lists. 
 

15.17. Метадействия 
 
Метадействия - это особые действия, которые совершенствуют ваш макрос действий, например для 
повторения того же самого макроса определенное количество раз без необходимости нажимать одну и ту же 
горячую клавишу. Эта техника может оказаться полезной в таком примере, когда необходимо перетащить 
маркер в начале каждого куплета сонга. При согдании макроса, вы не знаете, сколько раз нужно будет 
повторить действия - у некоторых сонгов может быть два или три куплета, у других пять или шесть. Это 
прекрасный пример того, когда вы можете использовать метадействие. REAPER включает две команды 
метадействий: 
 
Action: prompt to continue / Action: prompt to go to action loop start 
 
Пример: 
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Взгляните на пример сверху. Если вы создаете этот макрос и назначаете ему горячую клавишу (например, 
Ctrl+Shift+K), вы можете использовать его следующим образом: выберите любой трек, который состит из 
разных клипов, и поместите курсор воспроизведения в начало шкалы времени. После этого вы можете 
активируйте макрос. Курсор переместится в начало первого клипа выбранного трека и переместит маркер в 
эту точку. Затем последует запрос, хотите ли вы продолжить (см. рисунок ниже).  
 

 
 
Если вы нажмете Enter или Yes, курсор воспроизведения переместится в начало следующего клипа, вставит 
там маркер и поступит следующий запрос. Если вы нажмете No, действие макроса остановится. 
 
 

15.18. Модификаторы мыши 
 
Мы уже много раз сталкивались со страницей Mouse Modifiers в предварительных настройках REAPER. Эту 
страницу можно использовать для изменения любых модификаторов мыши REAPER по умолчанию и также 
для добавления ваших собственных модификаторов. Некоторые моменты, которые нужно иметь в виду: 
 

Клавиши модификаторы: пользователи Windows могут 
использовать любую из следующих клавиш модификаторов, 
в любой комбинации, для любого действия колеса мыши: 
Shift, Ctrl, Alt, Win.  
Пользователи Mac могут использовать любую из следующих 
клавиш модификаторов в любой комбинации: Shift, 
Command, Option, Control 
Меню Contexts: меню Contexts на странице Mouse 
Modifiers в предварительных настройках перечисляет 
контексты, в которых вы можете использовать мышь и для 
которых вам могут понадобится модификаторы (см. рисунок 
ниже). Когда вы выбираете элемент из этого меню, 
отображаются текущие назначения мыши для этого 
контекста.Для большинства контекстов вы найдете 
несколько вариаций, в зависимости от точного типа 
действия мыши. Например, отдельные модификаторы мыши 
могут быть применены к клипу в зависимости от того, 
является ли применяемое действие мыши простым щелчком 
левой кнопкой мыши (который по умолчанию выбирает 
клип), щелчком левой кнопкой мыши+перетаскивание 
(который по умолчанию перемещает клип), или двойным 
щелчком (который по умолчанию открывает MIDI клипы в 
MIDI редакторе или отображает свойства для аудиоклипов). 
Некоторые контексты (например, Arrange view) также 
включают щелчок средней кнопкой мыши (кнопка колеса 
мыши). Не все контексты будут вам полезны, а некоторых 

вам не понадобятся никогда. Например, если вы никогда не работаете с MIDI, различные MIDI контексты вряд 
ли будут вам интересны и полезны. Процедура настройки модификаторов мыши REAPER: 
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1. Перейдите на страницу Options > Preferences > Mouse Modifiers. 
2. Разверните меню Context и выберите нужный контекст, для которого появится список текущих 
модификаторов. На рисунке ниже показан пример для контекста Media item edge left drag. 
 

 
 
3. В столбце Modifier, дважды щелкните по модификатору, который вы хотите изменить. Появится список с 
предложенными действиями, которые вы могли бы назначить на этот модификатор. После этого вы можете: 
 
✔ Выбрать любой элемент из этого списка 
✔ Выбрать опцию No Action, чтобы отключить модификатор 
✔ Выбрать элемент, отмеченный маркером, чтобы восстановить действие REAPER по умолчанию для этого 
модификатора 
✔ Для некоторых элементов (включая элементы двойного щелчка), используйте список действий, чтобы 
открыть редактор действий так, чтобы можно было назначить одно из действий REAPER или одно из 
собственных пользовательских действий на этот контекст. 
 
4. Нажмите Apply, чтобы применить ваши изменения. 
5. Повторите шаги с1 по 4 по мере необходимости. По окончании нажмите OK, чтобы закрыть окно 
Preferences. 
 
Если возникли проблемы, нажмите кнопку Import/Export, а затем выберите опцию Restore modifiers to factory 
defaults in this context. Это вернет оригинальные модификаторы REAPER на этот контекст. Примеры ниже 
призваны помочь вам в понимании функционирования модификаторов мыши REAPER и как можно извлечь 
максимальную пользу из их использования. Не переживайте, если не все из этих примеров покажутся не 
актуальными для вас в данный момент: сфокусируйтесь на технике. Давайте предположим, что есть 
определенные действия, которые вы часто используете в REAPER. Например, это: 
 
- создание пустых MIDI клипов на треках. 
- slip-редактирование клипов. 
- добавление эффектов к клипам. 
- переключение статуса мьютирования клипов. 
- установка и удаление границ лупа. 
 
Примеры: 
 
Этот пример проведет вас по вышеупомянутым действиям в порядке их перечисления. 
 
1. Перейдите Options > Preferences > Mouse Modifiers. 
2. В левом меню Contexts выберите опцию Track, а в правом меню выберите left drag. Обратите внимание на 
назначения мыши по умолчанию для действий Draw a copy of selected items (создать копию выбранных 
клипов). Заметьте, что модификаторы Alt и Shift+Alt в настоящий момент не назначены. 
3. Дважды щелкните по модификатору Alt в столбце Modifier. Появится список возможных действий. 
4. В этом списке щелкните по действию Draw an empty MIDI item (создать пустой MIDI клип), чтобы 
назначить это действие на модификатор Alt. Маленькая точка, рядом с этим действием указывает, что это 
пользовательское изменение, которое вы внесли сами. 
5. Нажмите Apply, чтобы применить действие. 
6. Теперь в левом меню Contexts выберите опцию Media item edge, а в правом меню выберите left drag. 
Предположим, что мы хотим сделать действие Move item edge ignoring snap (переместить край клипа 
игнорируя привязку) новым поведением по умолчанию при перетаскивании края клипа. 
7. Дважды щелкните по модификатору Default action и выберите действие Move item edge ignoring snap из 
меню. Теперь дважды щелкните по модификатору Shift и выберите опцию Move item edge из меню. 
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8. Нажмите Apply. Эти два действия поменялись местами. 
9. Теперь в левом меню Contexts выберите опцию Media item, а в правом меню выберите double-click. 
Появятся модификаторы для этого контекста. Предположим, мы хотим создать действие, которое может 
использоваться для открытия окна цепочки эффектов клипа, и мы хотим назначить модификатор Shift+Ctrl 
для этого действия. 
10. Дважды щелкните по модификатору Shift +Ctrl, чтобы отобразить меню. В этом меню выберите опцию 
Action List, чтобы открыть редактор действий. Если вы работали с ранними примерами в этой главе, это будет 
вам знакомо! Найдите действие Show FX chain for item take (показать цепочку эффектов копии клипа) и 
выберите его. Щелкните по Select/Close, чтобы возвратиться к окну Mouse Modifiers. Нажмите Apply. (см. 
рисунок ниже). 
 

 
 
11. Повторите эту процедуру, чтобы назначить действие Item properties: Toggle items mute (свойства клипа: 
переключение статуса мьютирования клипа) на модификатор Shift +Win. Нажмите Apply. 
12. Наконец, мы можем добавить действие к контексту Ruler double-click так, чтобы модификатор Shift 
удалял любые текущие точки лупа. 
13. В левом меню Contexts выберите опцию Ruler, в правом меню выберите double-click. Дважды щелкните 
по модификатору Shift в столбце Modifier и выберите опцию Action List из меню.  
Найдите действие Loop Points: Remove loop points (точки лупа: удалить точки лупа), выберите его, а затем 
нажмите Select/Close и нажмите Apply. 
14. Закройте окно Preferences. 
 
Если вы не хотите сохранять все вышеперечисленные назначения, нажмите кнопку Import/Export и выберите 
опцию Reset modifiers to factory default in all contexts. 
 

Помните! Когда вы назначаете действия на модификаторы мыши, вы не ограничены использованием 
собственных действий. При условии, что вы установили расширения SWS, можно использовать любое 
из этих действий. Можно также использовать любые пользовательские действия, которые вы создали 

сами. 
 
Примечание: когда вы выберете контекст модификатора мыши, в некоторых случаях опция, 
относящаяся к этому определенному контексту, будет отображена чуть ниже списка поведений. 
Смотрите внимательно. Например, и для контекстов Track и Media items можно определить, должна 

ли область имени клипа (выше самого клипа) рассматриваться как часть клипа или как пустая область. 
 

Совет для пользователей OS X: рядом с кнопкой Import/Export вы найдет опцию Swap cmd/opt, 
которая может использоваться для обмена назначений на клавиши Cmd и Opt между собой для 
текущего выбранного контекста модификатора мыши. 

 

 
 

15.19. Сохранение и загрузка настроек страницы Mouse Modifier 
 

Настройки страницы Mouse Modifier можно сохранить и 
загрузить, используя кнопку Import/Export. Настройки 
можно сохранить/загрузить только для текущего контекста, 
или для всех контекстов (см. рисунок ниже). 
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15.20. Модификаторы мыши в MIDI редакторе 
 
Тема использования модификаторов мыши в MIDI редакторе заслуживает отдельного параграфа. Нигде более 
как здесь это правдиво при редактировании событий MIDI нот и MIDI контроллеров. В MIDI редакторе доступно 
большое количество действий. Один из примеров - контекст MIDI note left click (щелчок левой кнопкой мыши 
по MIDI ноте). (см. рисунок ниже).  
 

 
 
При частом использовании MIDI редактора, главное не торопиться и понять, какие из этих действий являются 
наиболее полезными для вас. Например, можно переназначить клавишу модификатор Alt, которая будет 
использоваться вместе с щелчком на ноте, чтобы ее удалить (как на рисунке выше). Заметьте, что в 
дополнение к другим действиям, перечисленным в меню, можно открыть список действий и выбрать действие 
там (опция внизу меню Action List). Помните, что в пределах MIDI редактора все действия в категориях Action 
List MIDI Editor и MIDI Event List Editor (включая любые собственные пользовательские действия) доступны 
для назначения в качестве модификаторов мыши в большинстве контекстов. Контексты модификаторов мыши 
MIDI редактора: 
 
MIDI note left drag 
MIDI note double click 
MIDI note edge left drag 
MIDI note double click 
MIDI CC event left drag 
MIDI CC lane left drag 
MIDI CC event double-click 
MIDI CC lane double-click 
MIDI source loop end marker left drag 
MIDI ruler left click 
MIDI ruler left drag 
MIDI ruler double-click 
MIDI marker/region lanes left drag 
MIDI piano roll left drag, MIDI piano roll double-click 
MIDI editor right drag 
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Давайте вкратце рассмотрим некоторые из тех областей в пределах MIDI редактора, где можно изменить 
поведение мыши. На рисунке ниже показаны действия по умолчанию для контекстов MIDI note left drag, MIDI 
piano roll left drag и MIDI ruler left drag.  
 

 
 

 
 

 
 
В большинстве случаев для поведения щелчка левой кнопки мыши (left click), щелчка левой кнопкой 
мыши+перетаскивание (left drag) и двойного щелчка (double-click) доступны отдельные контексты. Можно 
определить поведение мыши в любом из этих контекстов. В пределах большинства контекстов вы найдете 
несколько различных типов действий мыши. Например, при работе с MIDI нотами, потребуются различные 
действия, когда (скажем) нота будет перетаскиваться или при двойном щелчке по ней. Таким образом, на 
странице Mouse Modifier можно выбрать не только контекст, но и тип действия мыши. Давайте рассмотрим 
всего два примера: действия по умолчанию для контекстов MIDI note left drag (первый рисунок выше) и MIDI 
piano roll left drag (второй рисунок выше). По умолчанию большинство действий уже назначены. Например, 
простое перетаскивание MIDI ноты (или нескольких нот) по умолчанию переместит ноту (ноты), тогда как 
перетаскивание с нажатой клавишей Ctrl скопирует их. По мере просмотра списка действий некоторые из них 
становятся довольно интересными. Например, выделение рамки правой кнопкой мыши с нажатой горячей 
клавишей Shift+Alt растянет выделенные ноты по времени горизонтально так, как при арпеджировании нот. 
Простое действие щелчок+перетаскивание в пустой области представления виртуальной клавиатуры 
сначала нарисует ноту, а затем расширит ее по мере перемещения мыши. Различные клавиши могут 
использоваться с этим действием для назначения других действий. Например, удерживая клавиши Ctrl и Alt 
при перетаскивании нарисует прямую линию нот между отпусканием кнопки мыши и нажатием кнопки мыши.  
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Есть в списке и не назначенные клавиши. Щелкните по любой из них для отображения списка действий, 
которые можно использовать. Этот способ можно также использовать для изменения любых текущих 
назначений. На третьем рисунке выше - действия по умолчанию, которые назначены на контекст MIDI ruler left 
drag. При частом использовании MIDI редактора главное не торопиться в исследовании доступных контекстов. 
Также внимательно рассмотрите назначения на контекст MIDI editor right drag. 
 
 

15.21. Пользовательская настройка меню REAPER 
 
Главное меню REAPER и большинство контекстных меню можно отредактировать несколькими способами: 
 
- удалить опции, которые вы никогда не используете. 
- изменить порядок перечисления опций. 
- добавить ваши собственные действия в текущее меню. 
 
Чтобы открыть и отобразить интерфейс собственного меню, перейдите Options> Customize menus/toolbars. 
Откроется окно Customize menus/toolbar, которое по умолчанию отображает меню File.  
 

 
 
Список ниже суммирует основные задачи, которые могут быть выполнены в этом окне. Символ & перед буквой 
означает, что эту букву можно назначить для выбора этой опции. В самом меню буква будет подчеркнута. 
Таким образом, в примере выше, когда вы отображаете главное меню File REAPER, буква N с опцией New 
project (создать новый проект) будет подчеркнутой, и поэтому вы можете использовать клавишу N для 
выбора опции New project. 
 
Чтобы выбрать меню для редактирования: откройте выпадающий список (в верхнем левом углу окна) и 
выберите нужное меню. 
Чтобы изменить название текущей выбранной опции главного меню: выберите опцию, нажмите кнопку 
Retitle. Введите новое имя и нажмите Enter. 
Чтобы удалить опцию из текущего выбранного пользовательского меню: выберите опцию в левом столбце 
(один щелчок). Щелкните по ней правой кнопкой мыши и выберите команду Remove from или нажмите кнопку 
Remove ниже панели пользовательских меню. 
Чтобы изменить позицию опции в пользовательском меню: в левом столбце, перетащите опцию вверх/вниз 
в нужную позицию, или в левом столбце выберите опцию, которую вы хотите переместить, затем нажмите 
Ctrl+X, затем щелкните по позиции, куда вы хотите ее поместить и нажмите Ctrl+V. 
Чтобы скопировать опцию с одного меню главного уровня в другое: выберите первое главное меню из 
выпадающего списка меню. Выберите нужную опцию и нажмите Ctrl+C. Выберите второе главное меню из 
выпадающего списка меню. Щелкните в нужной позиции в специализированном окне (левая) панель, и 
нажмите Ctrl+V. 
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Чтобы добавить действие REAPER или пользовательское действие в текущее 
пользовательское меню в качестве новой опции: в левом столбце щелкните по опции, 
выше которой вы хотите вставить ваше пользовательское действие. Нажмите кнопку 
Add, а затем выберите опцию Action из меню. Выберите вашу опцию из списка, а 
затем нажмите кнопку Select. 
 
 
 

Чтобы переименовать опцию в пользовательском меню: в левом столбце выберите опцию, нажмите 
Rename, а затем введите новое имя и нажмите Enter. 
Чтобы добавить разделитель в текущее пользовательское меню: в левом столбце щелкните по опцию, 
выше которой вы хотите вставить разделитель. Нажмите кнопку Add, а затем выберите опцию Separator из 
меню. 
Чтобы добавить лейбл в текущее пользовательское меню: в левом столбце щелкните по опции, выше 
которой вы хотите вставить лейбл. Нажмите кнопку Add, а затем выберите опцию Label из меню. 
Чтобы добавить подменю в текущее пользовательское меню: в левом столбце щелкните в позиции, где вы 
хотите вставить подменю. Нажмите кнопку Add, затем выберите Submenu. введите имя и нажмите Enter. 
Чтобы сохранить изменения, внесенные в текущее пользовательское меню: нажмите кнопку Save. 
Чтобы восстановить текущее меню или все пользовательские меню в их настройки по умолчанию: 
нажмите кнопку Reset, а затем выберите опцию Reset Current Menu или Reset All Menus. 
Чтобы экспортировать текущее пользовательское меню или все меню в файл ReaperMenuSet: нажмите 
кнопку Export, выберите опцию Export All или Export Current, а затем введите имя и нажмите Save. 
Чтобы заменить текущее пользовательское меню или все меню, ранее сохраненными меню в файле 
ReaperMenuSet: нажмите кнопку Import, затем выберите нужный файл и нажмите кнопку Open. Можно также 
перетащить файл ReaperMenu и ReaperMenuSet в REAPER из проводника. 
Чтобы включить меню по умолчанию REAPER в ваши пользовательские меню: отметьте опцию Include 
default menu as submenu (в верхнем правом углу окна). В особенности это рекомендуется в том случае, если 
вы удаляете какие-либо опции по умолчанию из меню. 
 
Пример: 
 
В данном примере мы рассмотрим, как добавить действие в меню REAPER в качестве новой опции, и как 
удалить ненужную опцию, а также изменим порядок некоторых опций. Как и в случае со многими другими 
примерами в этом Руководстве пользователя основной целью необходимо считать не актуальность примера, а 
порядок выполнения действий редактирования. Предположим, что проводите большую работу с маркерами, и 
требуется перенумеровать маркеры по порядку на шкале времени быстро и легко без необходимости 
использовать горячую клавишу. В этом случае можно добавить действие в контекстное меню шкалы времени. 
При этом можно также удалить опцию Insert empty space in selection (вставить пробел в выбор) 
(предполагая, что ради данного примера, эта опция вам не пригодиться): 
 
1. Перейдите Options > Customize menus/toolbars. 
2. Разверните меню и выберите опцию Ruler/arrange context. 
3. Щелкните по любой из опций в этом меню - например, по Set selection to items. 
4. Нажмите кнопку Add, а затем выберите опцию Action, чтобы открыть окно редактора действий. 
5. В области фильтра введите mark renum. Это должно найти действие Markers: Renumber all markers in 
timeline order. 
6. Выберите это действие, а затем нажмите Select/close. Окно Actions закроется, и вы будете возвращены к 
окну Customize menus/toolbars. Теперь это действие добавлено в меню и выбрано (см. рисунок ниже). 
 

 
 
7. С этой выбранной опцией, нажмите кнопку Rename. 
8. Введите: Renumber markers и нажимает Enter. 
9. Чтобы переместить эту опцию выше в меню, захватите и перетащите ее выше опции Zoom selection. 
10. Теперь выберите опцию (вниз по списку) Insert empty space in selection. Нажмите кнопку Remove, чтобы 
удалить ее из меню. 
11. Убедитесь, что опция Include default menu as submenu отмечена. 
12. Нажмите кнопку Save, а затем Close. 
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13. Создайте На шкале времени беспорядочно несколько маркеров. 
14. Теперь щелкните правой кнопкой по шкале времени (см. рисунок ниже). Выберите опцию Renumber 
markers из меню: ваши маркеры будут перенумерованы. 
 

 
 
15. Заметьте внизу этого контекстного меню опцию Default menu: Ruler/arrange context, которая может 
использоваться для доступа к оригинальному контекстному меню. 
16. Если вы хотите вернуть это меню в его оригинальное состояние, откройте окно Customize menus/toolbars 
и с все еще выбранной опцией Ruler/arrange context, нажмите кнопку Reset, а затем Reset current 
menu/toolbar to default. Нажмите кнопку Save, затем Close. 
 

15.22. Пользовательская настройка панелей инструментов REAPER 
 
Пользовательская настройка главных панелей инструментов REAPER (включая панелей инструментов MIDI 
редактора) значительно облегчает работу в REAPER и позволяет оптимизировать интерфейс REAPER под 
ваши предпочтения. Например, вы можете: 
 
- удалить любой значок/команду по умолчанию, которые вам не нужны. 
- назначить команду или действие на любой существующий значок. 
- назначить команду или действие на новый значок. 
- назначить собственное действие или собственный макрос на новый или текущий значок. 

 
Процедура пользовательской настройки панелей 
инструментов схожа с таковой при настройке 
пользовательских меню и выполняется в том же 
диалоговом окне Customize menus/toolbars, которое 
можно отобразить щелчком правой кнопкой мыши по 
пустой области панели инструментов или выбрав 
опцию Customize menus/toolbars из меню Options. В 
окне Customize menus/toolbars выберите опцию Main 
Toolbar или одну из панелей инструментов MIDI View в 
меню, расположенном в верхнем левом углу окна. 
Плавающие панели инструментов мы рассмотрим 

позже в этой главе. Список ниже суммирует основные задачи, выполняемые в этом окне. После списка 
приведен пример добавления собственного элемента на панель инструментов. В качестве такого примера, мы 
будем использовать действие View: Toggle master track visible. 
 
Чтобы изменить название панели инструментов REAPER: выберите панель инструментов в меню. Нажмите 
кнопку Retitle, введите новое имя и нажмите OK. 
Чтобы удалить элемент из панели инструментов: щелкните либо по названию элемента в левой панели, 
либо по самому значку на дисплее чуть выше командных кнопок окна. На рисунке ниже выбрана кнопка Enable 
Metronome (активировать метроном). Нажмите кнопку Remove. 
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Чтобы добавить новое действие или команду на панель инструментов: в области настройки панели 
инструментов (левая панель) выберите элемент, перед которым вы хотите добавить свой элемент. Нажмите 
кнопку Add. В окне Actions в списке действий выберите команду или действие REAPER, или свой скрипт или 
действие. Нажмите кнопку Select/Close. 
Чтобы добавить разделитель между двумя элементами панели инструментов: в области настройки панели 
щелкните правой кнопкой мыши по второму из этих элементов и выберите опцию Add separator из меню. 
Чтобы изменить значок любого элемента панели инструментов (включая элемент, который вы уже 
добавили): щелкните правой кнопкой мыши по значку в дисплее значка внизу окна Customize Menus/Toolbars, 
чуть выше кнопок. В окне Select toolbar icon выберите значок, а затем закройте окно Select toolbar icon. 
Чтобы изменить действие, назначенное на кнопку на панели инструментов: в области настройки панели, 
выберите элемент, который вы хотите изменить. Щелкните правой кнопкой мыши по этому элементу и 
выберите опцию Change action. Затем выберите действие и нажмите Select/Close. 
Чтобы заменить значок панели инструментов текстом: щелкните правой кнопкой мыши по элементу в 
списке измененных панелей на левой панели. Выберите опцию Text Icon из меню, введите текст и нажмите 
OK. 
Чтобы изменить позицию элемента на панели инструментов: захватите его и переместите по списку вверх 
или вниз в списке измененных панелей. Для этого также можно использовать горячие клавиши Ctrl+X/Ctrl+V, а 
также опции Cut и Paste контекстного меню. 
Чтобы закрыть окно Customize Menus/Toolbar, не сохраняя изменения: нажмите кнопку Close. В окне запроса 
нажмите кнопку No. 
Чтобы сохранить панель инструментов с вашими изменениями: нажмите кнопку Save. 
Чтобы восстановить панель инструментов в ее статус по умолчанию: нажмите кнопку Reset. Выберите 
опцию Reset Current Menu/Toolbars to Defaults из меню. Для подтверждения нажмите кнопку Yes. 
 

 
 
Чтобы экспортировать текущую пользовательскую панель инструментов или все панели 
инструментов/меню в файл ReaperMenuSet: нажмите кнопку Export, выберите опцию Export All или Export 
Current, а затем введите имя и нажмите кнопку Save (см. также примечание ниже). 
Чтобы заменить текущую пользовательскую панель инструментов или все панели инструментов/меню, 
ранее сохраненными из файла ReaperMenuSet: нажмите кнопку Import, затем выберите нужный файл и 
нажмите кнопку Open. (см. также примечание ниже). 
 

Примечание: файл ReaperMenuSets можно включить при экспорте/импорте конфигурации параметров 
REAPER. См. Главу 22. 
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Пример: 
 
1. Щелкните правой кнопкой по области панели инструментов (но не на инструменте) и выберите опцию 
customize toolbars из контекстного меню. 
 

 
 
2. Щелкните по последнему элементу панели инструментов (Enable locking), а затем нажмите кнопку Add, 
чтобы открыть список действий. 
3. Найдите действие View: Toggle master track visible. Выберите его, а затем нажмите кнопку Select/close. 
Теперь этот элемент добавлен в список элементов панели инструментов. На дисплее значков он будет 
маркирован примерно, как “Tog Mast”. 
 

 
 
4. Перетащите этот элемент вверх или вниз по списку в любую удобную для вас позицию. 
5. Если вам не нравится текстовая метка Tog Mast, щелкните правой кнопкой по элементу в списке и выберите 
опцию Change icon (чтобы выбрать значок) или Text icon (чтобы ввести другую текстовую метку). Если вы 
выбрали опцию Text icon, можно также выбрать опцию Double width toolbar button для улучшения 
отображения текста. 
 

 
 
6. Нажмите кнопку Save, а затем Close. Если вы не хотите сохранять значок, перейдите к окну Customize 
menus/toolbars и просто удалите его. 
 

Совет: команда Position toolbar может использоваться для изменения позиции или открепления в 
плавающее окно главной панели инструментов: посмотрите следующий параграф. 
 

 
15.23. Создание дополнительных пользовательских панелей инструментов 

 
В REAPER можно отобразить до 16-ти общих и до 8-ми MIDI дополнительных панелей инструментов, которые 
можно настроить по вашему усмотрению. При выборе элементов этих панелей вы можете одним щелчком 
обеспечить доступ к вашим наиболее важным командам и действиям. Чтобы отобразить любую панель 
инструментов щелкните правой кнопкой по пустой области главной панели инструментов и выберите опцию 
Open toolbar, а затем выберите нужную панель инструментов. Отобразить можно любое доступное 
количество панелей. По умолчанию каждая панель инструментов включает один значок, маркированный “Edit 
Me”. Чтобы изменить его, необходимо настроить панель инструментов (см. ниже). Каждое окно панели можно 
перетащить, изменить и поместить в любом месте вашего экрана. Окно можно прикрепить поверх остальных 
окон (используя символ булавки). Щелкните правой кнопкой мыши по пустой области любой пользовательской 
панели инструментов, чтобы отобразить меню, как на рисунке ниже. Доступные опции этого меню: 
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Switch toolbar: выбрать другую панель инструментов и заменить ею предыдущую в ее местоположении. 
Open toolbar: открыть другую панель инструментов. 
 

Position toolbar: прикрепить панель инструментов на главной 
панели инструментов, поверх главного окна, на панели Docker 
(об этом чуть позже), или в плавающее окно. 
Customize toolbars: открыть окно Customize menus/toolbars 
для внесения пользовательских изменений любой панели 
инструментов. По умолчанию для редактирования будет 
выбрана текущая отображаемая панель. 
 
 

Можно добавить команды в каждую или любую из этих панелей по усмотрению. Чтобы выбрать другую панель 
для редактирования после того, как вы открыли окно Customize menus/toolbars, раскройте меню в верхнем 
левом углу окна Customize menus/toolbars. Следующий список суммирует основные опции редактирования: 
 
Чтобы изменить название любой вкладки панели инструментов: выберите панель в окне Customize 
Menus/Toolbars, нажмите кнопку Retitle, а затем введите новое имя и нажмите кнопку OK. 
Чтобы добавить действие или команду на пользовательскую панель инструментов: нажмите кнопку Add, 
чтобы отобразить список действий. Выберите команду или действие и нажмите кнопку Select. 
Чтобы отредактировать название пользовательской кнопки панели инструментов: щелкните правой 
кнопкой по элементу по пользовательской панели (слева) и выберите опцию Text Icon. Введите текст и 
нажмите OK. 
Чтобы назначить значок вместо текста на пользовательскую кнопку панели инструментов: щелкните 
правой кнопкой по элементу в пользовательской панели (слева) и выберите опцию Change Icon. Выберите 
нужный значок, а затем закройте окно Select Toolbar Icon. 
Чтобы удалить элемент из пользовательской панели инструментов: выберите элемент в 
пользовательской панели (слева) и нажмите Remove. 
Чтобы изменить порядок значков на пользовательской панели инструментов: перетащите элементы вверх 
или вниз по списку. 
Чтобы сохранить пользовательскую панель инструментов: нажмите кнопку Save в окне Customize 
Menus/Toolbars. 
Чтобы экспортировать пользовательскую панель инструментов: нажмите кнопку Export и выберите опцию 
Export current menu/toolbar to. Введите имя и нажмите Save. 
Чтобы импортировать пользовательскую панель инструментов: нажмите кнопку Import, выберите файл и 
нажмите Open. 
Чтобы прикрепить/отстыковать плавающую панель инструментов: щелкните правой кнопкой по 
плавающей панели. выберите Dock floating toolbar, а затем выберите одну из трех опций. 
 
Пример ниже иллюстрирует пользовательские панели инструментов, используемые для облегчения доступа к 
различным скринсетам треков и окон. 
 
Пример: 
 
1. В окне Customize menus/toolbars выберите панель Floating toolbar 1. 
2. Нажмите кнопку Retitle и введите текстовую строку Screen Sets. Нажмите Enter. 
3. Нажмите кнопку Add, чтобы открыть список действий. Выберите действие Screenset: Load window set #04, 
а затем нажмите Select. 
4. В окне списка действий выбирают действие Screenset: Load window set #03 и опять нажмите Select. 
5. Повторите шаг 4 необходимое количество раз для выбора других действий, необходимых для этой панели 
инструментов. 
6. Выберите действие Screenset: Load track view #01 и нажмите Select/close. 
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7. Если необходимо, перетащите любой из этих элементов вверх или вниз по списку, чтобы упорядочить их по 
вашему усмотрению. 
8. Если необходимо, удалите лишние элементы на этой панели инструментов. 
9. Щелкните правой кнопкой по каждому элементу и выберите опцию Text icon. Введите название, например, 
Track Set 1 и активируйте опцию Double width toolbar button. 
10. Сохраните и закройте окно Customize menus/toolbars по окончании. 
 

15.24. Создание умных инструментов (Smart Tools) 
 
Если до REAPER вы пользовались другим хостом (Cubase, Pro Tools или Sonar), вы могли привыкнуть к неким 
«умным» инструментам, которые помогают в решении различных задач редактирования, таких как разделение, 
удаление или мьютирование элементов. При необходимости можно создать ваши собственные умные 
инструменты, которые будут похожи на те, которые вы использовали в других хостах. Список действий 
включает подходящие для этого действия, например, Item: Split Item Under Mouse Cursor. Кроме того, вы, 
возможно уже создали собственные пользовательские действия, например, для выбора и мьютирования или 
удаления элементов. Без активирования («armed») любой инструмент, ссылающийся на курсор мыши будет 
бесполезен в виду того, что при щелчке по этому инструменту курсор мыши будет расположен на панели 
инструментов, а не на медиаэлементе. Используя умные инструменты эту проблему можно решить.  
 

Чтобы создать умный инструмент для любого 
фабричного или пользовательского действия, 
сначала необходимо назначить это действие на 
панель инструментов в виде кнопки, как было 
объяснено в предыдущем параграфе. В данном 
примере мы создали кнопку Split Item Under Mouse 

Cursor. Чтобы использовать эту кнопку в качестве умного инструмента: 
 
1. Щелкните правой кнопкой по инструменту. Если вы чуть задержите мышь, отобразится всплывающая 
подсказка. Наведите курсор мыши на любой медиаэлемент, и курсор отобразится с литерой A. 
 

 
 
2. Щелкните левой кнопкой по (в данном примере) в точной позиции элемента, где вы хотите применить 
действие. В данном случае элемент под курсором мыши будет разделен. Если инструмент активирован, он 
остается подготовленным до тех пор, пока вы его не деактивируете. Для этого, щелкните правой кнопкой по 
активированному инструменту или нажмите клавишу Esc сразу после его использования. 
 

Совет: размер плавающей панели инструментов можно изменить, захватив ее правый нижний угол 
(маленькая точечная треугольная область). Если вы хотите ограничить размер значков, активируйте 
опцию Don't scale toolbar buttons above 1:1 (не изменять размер кнопок панели инструментов выше 

соотношения 1:1) на странице Options > Preferences > Appearance. Там же доступна опция Don't scale 
toolbar buttons below 1:1 (не изменять размер кнопок панели инструментов ниже соотношения 1:1). 
 

15.25. Панель Docker для панелей инструментов 
 
Если у вас несколько собственных панелей инструментов, панель Docker для панелей инструментов (далее - 
просто "панель Docker") может оказаться полезной для быстрого доступа к этим панелям, не создавая 
загромождения на экране. Панель Docker представляет собой набор вкладок и облегчает переключение 
между различными панелями инструментов, единовременно отображая при этом содержимое только одной 
панели инструментов. В дополнение к этому панель Docker можно прикрепить в любую из вкладок главной 
панели Docker REAPER. На примере ниже пользователь создал восемь пользовательских панелей 
инструментов и прикрепил их все на панель Docker: 
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Чтобы отобразить панель Docker перейдите View > Toolbar docker. Обратите внимание, что набор панелей 
инструментов (позиции инструментов) по умолчанию сохраняются со скринсетами. Следующий список 
суммирует основные функции панели Docker: 
 
Чтобы добавить открытую панель инструментов на панель Docker панели инструментов: щелкните 
правой кнопкой по пустому месту панели инструментов и выберите опцию Position toolbar In toolbar docker. 
Чтобы удалить панель инструментов из панели Docker панели инструментов: на панели Docker щелкните 
правой кнопкой по вкладке с именем панели инструментов и перейдите Position toolbar > Close toolbar. 
Чтобы заменить одну панель инструментов на панели Docker другой: на панели Docker щелкните правой 
кнопкой по вкладке с именем панели инструментов и выберите опцию Switch toolbar, а затем выберите 
нужную панель инструментов. 
Чтобы отобразить содержимое панели инструментов: на панели Docker щелкните по вкладке с именем 
панели инструментов. 
Чтобы прикрепите панель Docker для панелей инструментов к основной панели Docker: щелкните по 
символу ! (восклицательный знак) на левом конце панели Docker панели инструментов и выберите любую из 
четырех опций прикрепления панели Docker – внизу (bottom), наверху (top), слева (left) или справа (right). На 
примере выше, панель была прикреплена наверху. 
Чтобы отстыковать панель Docker панели инструментов с основной панели Docker: щелкните по значку ! 
(восклицательный знак) на левом конце прикрепленной панели Docker и снимите галочку с опции Attach 
Toolbar Docker to main window. 
 

15.26. Использование аппаратных контрогллеров с REAPER 
 
Внешний аппаратный контроллер, такой как Behringer BCR2000 или Novation Nocturn может использоваться 
для управления некоторыми действиями REAPER. Аналогичным образом вы также можете использовать 
педали и другие контроллеры на MIDI клавиатуре. Примерами таких действий могут служить громкость и 
панорама трека, определение статуса мьютирования и солирования, активирование, запуск и остановка 
записи, и возможность физически отобразить транспортную панель REAPER для таких функций, как 
Воспроизведение, Останов, Пауза, Перемотка, и т.д. Конечно, необходимо ознакомиться со специфическими 
характеристиками конкретного устройства, включая процесс инсталляции, настройки параметров и т.д. 
Очевидно, что это выходит за рамки данного Руководства пользователя.  
Необходимо также знать, что у различных управляющих устройств различные возможности и различные 
программные приложения.  
Не все внешние аппаратные контроллеры могут использоваться для управления всеми действиями, и даже те 
контроллеры, которые позиционируются как устройства, совместимые с использованием непрерывных MIDI 
контроллеров. Очевидно, это подробный анализ и сравнение всех этих устройств также выходит за рамки 
данного руководства пользователя. Тем не менее, все внешние контроллеры можно разделить на две 
основные категории: 
 
- устройства, которые могут быть распознаны REAPER как специфические и индивидуально именованные 
внешние аппаратные контроллеры. 
- универсальные устройства без специфического распознавания, но которые могут, тем не менее, 
использоваться в качестве внешнего аппаратного контроллера. 
 

 
 
Если у вас есть управляющее устройство одного из типов, перечисленных на рисунке выше, для начала 
ознакомьтесь с его документацией. Затем, инсталлируйте устройство и его драйверы на ваш компьютер в 
соответствии с инструкциями производителя. Затем выберите это устройство на странице Options > 
Preferences> Control Surfaces. Конечно, за дополнительной информацией об устройстве необходимо 
обратиться на веб-сайт производителя. Дополнительную информацию можно также найти на одном из онлайн-
форумов REAPER. Перейдите Options > Preferences > Control Surfaces и нажмите кнопку Add, чтобы 
отобразить список доступных устройств (см. рисунок выше). Обратите внимание, что список включает 
устройства, поддерживающие протокол OSC (Open Sound Control). Если вы намереваетесь работать с таким 
устройством, обязательно ознакомьтесь с его особенностями и документацией.  
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Если вы выберете эту опцию из списка, последующий экран даст вам возможность определить имя устройства 
и конфигурацию паттернов, включая такие опции, как LogicTouch или LogicPad, или указать REAPER 
записать сэмпл файла конфигурации (по умолчанию). Этот файл будет включать назначения по умолчанию и 
различные соответствующие комментарии. Необходимо также определить номер порта (для передачи 
сообщений) и IP-адреса и для хоста, и для самого устройства.  
 

 
 
Подробности о работе REAPER с протоколом OSC и файлом Default.ReaperOSC на странице 
http://www.cockos.com/reaper/sdk/osc/osc.php. Остальные (не OSC) управляющие устройства, даже если они не 
перечислены в этом списке, вы можете установить и использовать в том случае, если они поддерживают 
эмуляцию одного из перечисленных устройств, (например, могут эмулировать устройства HUI или Mackie). 
Опять же необходимо ознакомиться с документацией изготовителя на его веб-сайте. Во всяком случае 
убедитесь, что в окне Control Surface Settings вы выбираете правильные опции для вашего устройства. 
Показанный ниже один из примеров таких настроек с устройством Novation Nocturn. Однако этот пример не 
является моделью для использования с каким-то конкретным продуктом.  
 

 
 
Можно установить несколько устройств. Например, одновременно можно использовать и Frontier AlphaTrack, 
и Frontier Tranzport. Но это возможно только в том случае, если каждое из этих устройств установлено 
правильно. Необходимо проконсультироваться с документацией продуктов по поводу инсталляции и как этот 
внешний аппаратный контроллер (контроллеры) могут использоваться с REAPER. Если вашего устройства в 
списке распознанных внешних аппаратных контроллеров нет, и оно не способно эмулировать ни один из 
элементов этого списка, его можно-таки использовать с REAPER. Пример такого продукта - Behringer 
BCR2000. Как только этот контроллер будет инсталлирован и настроен на вашем компьютере, он появится в 
списке MIDI-устройства REAPER. В зависимости от конкретного продукта и драйверов, эти устройства могут 
появиться в списке с их собственными именами или просто как USB Audio Device. Установите эти устройства 
в качестве MIDI-устройств (MIDI Device), наиболее вероятно только в качестве устройства входного сигнала 
(Input Only) в большинстве случаев только для управления сообщениями. Пример такого устройства показан 
на рисунке ниже.  
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Двойной щелчок по имени устройства открывает диалоговое окно Configure MIDI Input. Дальнейшие ваши 
действия будут зависеть от самого устройства. Этот способ можно также применить для использования вашей 
MIDI клавиатуры в качестве MIDI-контроллера (в зависимости от того, поддерживает ли клавиатура эту 
функцию). Как только это устройство будет инсталлировано, можно назначить любое действие, 
поддерживающее управление непрерывными MIDI контроллерами на один из регуляторов, фейдеров, кнопок 
или управляющего устройства. Процедура схожа с назначением действий на клавиши вашей клавиатуры 
компьютера. Откройте список действий из меню REAPER. Выберите действие, нажмите кнопку Add, а затем 
вместо того, чтобы нажать клавишу на клавиатуре, затроньте контроллер внешнего аппаратного контроллера 
и нажмите OK. Пример показан на рисунке ниже - в данном случае мы назначаем регулятор, который будет 
использоваться для настройки громкости трека #1. 
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16. Плагины REAPER в действии 
 

16.1. Что такое плагины? 
 
C REAPER поставляется всесторонний ассортимент плагинов - более 200, включая плагины компании 
Jesusonic и VST плагины Rea от компании Cockos. В этой главе мы познакомимся с некоторыми из них. В 
рамках данного руководства мы рассмотрим только базис, чтобы вы поняли для чего предназначены плагины 
и как они работают. Вне этого контекста вы можете изучить их более досконально. Плагины - это программное 
обеспечение, которое используется для управления и формирования звука при воспроизведении клипов на 
ваших треках. Вот некоторые простые примеры использования плагинов: 
 
- заставить запись вокала звучать лучше, более живо. Плагины могут добавить объем, теплоту и блеск к 
подобным трекам. 
- сгладить пики и провалы в громкости трека и сделать звучание трека более ровными. 
- добавить дополнительный объем к треку или даже целому миксу, как будто трек был записан в церкви или 
концертном зале, а не в старой скучной студии. 
 

16.2. Три закона плагинов 
 
Прежде чем вы начнете использовать плагины, запомните эти три закона, исключений для которых нет! 
 
1. Лучше не использовать плагин вообще, чем использовать его не умело. 
2. Никогда не судите о качестве плагина по его пресетам. Пресеты отражают всего лишь чье-то представление 
о звучании, а не качество плагина и его потенциал.  
3. Никогда не судите о качестве плагина по его стоимости. Некоторые плагины бесплатны. Стоимость 
некоторых их них достигает нескольких тысяч долларов. Некоторые из бесплатных плагинов достаточно 
низкого качества, другие просто превосходны. 
 

16.3. Пять типов плагинов 
 
В особенности если вы плохо знакомы с цифровым аудио, когда вы погрузитесь в мир плагинов, вы можете 
растеряться в огромном выборе плагинов. Учитесь поэтапно в процессе. По сути есть пять типов плагинов (но 
есть и главное исключение к этим пяти плагинам, которого мы коснемся позже). Вот эти пять типов: 
 
- плагины для формирования звука: затрагивают частоту (высота тона) трека (треков). Пример - эквалайзер. 
- плагины, основанные на задержке: дилей, хорус и ревербератор. 
- плагины, изменяющие громкость: определяют общую громкость или воспринимаемую громкость вашего трека 
(треков). Примеры - компрессоры и лимитеры. 
- плагины для маршрутизации: не формируют звук как таковые, но используются для задач маршрутизации. 
Саму маршрутизацию мы подробнее обсудим в Главе 17. 
- аналитические плагины: отображают информацию, но не изменяют сам звук трека. 
 
А теперь про вышеупомянутое исключение. Некоторые плагины могут охватить несколько из вышеназванных 
категорий, выполняя одновременно несколько задач. Один из таких примеров - мультиполосный компрессор 
(Multiband Compressor), который включает характеристики как эквалайзера, так и компрессора. 
 

16.4. Контроллеры плагинов 
 
Контроллеры плагина можно отрегулировать любым из четырех основных способов: 
 
- наведите курсор мыши на фейдер и прокрутите колесо мыши. Используйте при этом клавишу Ctrl для более 
точного изменения значения параметра. Если вы не хотите использовать этот способ (из опасения внесения 
случайных изменений), можно активировать опцию Ignore mousewheel on all faders (игнорировать колесо 
мыши при наведении мыши на фейдер) на странице Options > Preferences > Editing Behavior > Mouse. 
- щелкните по фейдеру и перетащите мышь. Используйте клавишу Ctrl для более точного изменения значения 
параметра. Если при этом удерживать клавишу Alt, когда вы отпустите кнопку мыши, контроллер возвратится 
в его исходную позицию. 
- щелкните по фейдеру, а затем используйте клавиши со стрелками вверх/вниз курсора клавиатуры. 
- щелкните по области значения параметра и введите значение (на рисунке ниже в следующем параграфе эти 
области расположены направо от каждого из трех горизонтальных фейдеров). 
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16.5. Эффекты формирования звука: плагин ReaEQ 
 
Большинство плагинов формирования звука (так или иначе) попадают под категорию эквалайзеров (EQ). Это 
довольно странно, так как они используются чтобы подчеркнуть (или завуалировать) определенные частоты. 
ReaEQ - главный эквалайзер Reaper. Есть и другие эквалайзеры JS, но ReaEQ все же самый мощный и гибкий.  
 
Пример: 
 
1. Откройте проект All Through The Night.RPP и сохраняют его под именем All Through The Night EQ.RPP. 
2. Данный пример затронет только вокальный трек, который является превосходным инструментом для 
демонстрации эквалайзера. Солируйте трек Vox. 
3. Отобразите окно эффектов, нажмите кнопку Add и добавьте плагин VST Cockos: ReaEQ. Заметьте, что по 
умолчанию плагин 4-полосный (с четырьмя пронумерованными вкладками). 
 

 
 
4. Воспроизведите песню. Пока играет песня, выберите вкладку Band 4 и поверните фейдер Gain влево 
приблизительно на - 35 dB. Заметьте, каким глубоким стал вокал. Дважды щелкните по фейдеру, чтобы 
возвратить его в центральную позицию. 
5. Выберите вкладку Band 2. Постепенно уменьшите значение фейдера Gain приблизительно до - 14 dB. 
Заметьте, каким металлическим и даже бездушным стал вокал. Дважды щелкните по фейдеру, чтобы 
возвратить его в центральную позицию. Теперь увеличьте значение фейдера Gain приблизительно до +3 dB. 
Вокал теперь зазвучал приятнее, объемнее и теплее. Выберите вкладку Band 3 и установите параметр 
Frequency приблизительно в значение 4200. Понаблюдайте, что произойдет, если отрегулировать фейдер 
Gain между значениями +3.5 и - 3.5. По окончании дважды щелкните по фейдеру, чтобы возвратить его в 
значение 0.0. Сохраните файл. То, что мы делали называется регулировка частот. Это большая тема и все что 
необходимо знать об эквалайзере выходит за рамки данного руководства.  
 
Точное деление спектра частот в некоторой степени произвольно. Ниже приведен один из примеров 
разделения спектра частот: 
 
Низкий низ (16 - 60 Hz): эти частоты скорее чувствуются, чем слышатся. 
Низкие частоты (60 - 250 Hz): среда обитания басового тона ритм-секции. Небольшое подчеркивание этого 
частотного диапазона может сделать звук более объемным, но, если переборщить с контроллером Gain звук 
может стать гулким. 
Средние частоты (250 - 2000 Hz): слишком много усиления на этих частотах создает ощущение, что вы 
сделали запись с другого конца телефона. Если копия звучит грязно, попробуйте вырезать этот диапазон. 
Верхний диапазон средних частот (2000 - 4000 Hz): часто хитрая область. Слишком много усиления на этих 
частотах может вызвать усталость при прослушивании. Понизьте усиление этого диапазона в миксе, в то 
время как небольшое повышение усиления на вокальных треках поможет выделить вокал. 
Диапазон частот присутствия (4000 - 6000 Hz): основной диапазон прозрачности и присутствия для 
инструментальных и вокальных треков. Небольшое усиление выделит инструмент или вокал в миксе. 
Понижение усиления может сгладить вокал или инструмент в миксе. 
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Диапазон высоких частот (6000 - 16000 Hz): слишком много усиления производит резкий, стекловатый 
эффект. Недостаточное усиление сделает звук тусклым и “тяжелым”. 
 
Итак, мы знаем, что частота измеряется в герцах (и килогерцах), и что мы можем повысить или понизить 
громкость на любом уровне для формирования звука. Уровень звука непосредственно измеряется в 
децибелах. Необходимо понять еще два термина: первый - ширина полосы (band width). Ширина полосы 
плагина ReaEQ измеряется в октавах. Сужение полосы означает, что вы поднимаете или понижаете звук в 
очень небольшой части спектра относительно выбранной частоты. Расширение полосы означает, что вы 
будете работать над более широкой частью спектра.  

 
Пример отличия в том, как может формировать звук сужение (наверху) и расширение 
(внизу) полосы показан на рисунке слева.  
 
 
 
 
 
 
 
 
 
 
 
 

 
Если вы отобразите меню Type, вы увидите, что есть несколько типов полос. Некоторые обычно используемые 
типы: 
 
Band: громкость поднимается или понижается на любой стороне частоты, диапазон определяется шириной 
полосы. Иногда этот тип называется “peaking filter”. 
Low/High Pass: фильтр частот выше/ниже установленной частоты. 
Low/High Shelf: понижает/повышает усиление ниже/выше установленной частоты. 
Pass and Shelf: в большинстве случаев (если не вообще) используется с очень низкими или очень высокими 
частотами. Можно добавить или удалить полосы, используя кнопки Add band и Remove band соответственно. 
 

Совет: не забывайте, что можно создать контроллеры трека и/или огибающие автоматизации для 
этого или любого другого плагина, нажав на кнопку Param в окне плагина - подробнее об этом в Главе 
12. 

 
16.6. Эффекты, основанные на задержке: дилей 

 
Этот тип эффектов включает плагины ревербератора, дилея и хоруса. Звуку необходимо время, чтобы 
преодолеть любое расстояние, а такие поверхности как стены и потолки создают отражения, которые делают 
звуковые паттерны еще более сложными и живыми. Эффекты, основанные на задержке, используют 
несколько приемов и способов искусственного моделирования этого поведения, обеспечивая таким образом 
более “живой” звук. Но будьте осторожны. Слишком много подобных эффектов может испортить хороший звук. 
 
Delay (ms): отрезок времени между исходным звуком и слышимым задержанным звуком. 
Feedback: степень задержанного сигнала, который будет возвращен в саму задержку. Это помогает сделать 
задержку не просто эхом. 
Mix in (dB): общий уровень на выходе. 
Output wet (dB): выходной уровень Post FX сигнала (с или после эффекта). Понижение этого уровня 
относительно выходного уровня сигнала без эффекта (Output dry) делает эффект более тонким. 
Output dry (dB): выходной уровень сигнала без (до) эффекта.  
 
В данном примере мы будем использовать плагин JS: Delay/Delay, чтобы добавить небольшую задержку в 
инструмент Bouzouki. 
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Пример: 
 
1. Отключите кнопку Solo трека Vox, и активируйте кнопку Solo трека Bouzouki. Откройте окно эффектов 
трека Bouzouki и добавьте плагин JS: Delay/delay. 
2. Воспроизведение песню. Поэкспериментируйте с параметрами эффекта и найдите подходящий звук. Для 
ввода небольших значений задержки, таких как 0.2 мс, легче это сделать в области значений, чем 
использовать фейдеры. 
3. Отключите кнопку Solo трека Bouzouki, а затем при необходимости вносите другие корректировки. 
4. Сохраните файл. 

 
Примечание: плагин ReaDelay - более мощная альтернатива плагину JS Delay. В частности, он 
позволяет создавать многоступенчатую задержку, каждая из ступеней которой включает ее 
собственные индивидуальные параметры задержки и панорамы. 

 
16.7. Плагины для изменения громкости: лимитер 

 
В следующем примере мы рассмотрим плагин изменения громкости JS: LOSER: masterLimiter. Его можно 
добавить в окно эффектов мастер-трека, чтобы выполнить две задачи сразу. Сначала может показаться, что 
они противоречат друг другу, но они не: 
 
- поднимают общую громкость микса,  
  но в то же время...  
- препятствуют клиппированию микса.  
 
Мы будем использовать плагин JS: Loser/masterLimiter, который включает следующие контроллеры и 
параметры: 
 

 
 
Threshold: уровень, при котором будут применены остальные параметры лимитера. Это может показаться 
парадоксальным, но чем ниже порог, тем выше будет воспринимаемая общая громкость. При понижении 
порога, повышается общая громкость песни до определенного предела. 
Look Ahead: параметр упреждения лимитера. Это помогает сгладить внезапные пики. 
Attack: определяет, насколько быстро сработает лимитер при увеличении сигнала. 
Release: определяет, насколько быстро лимитер восстановится после пика. 
Limit: определяет максимальную громкость, которая не может быть превышена. 
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Пример: 
 
1. Откройте окно эффектов мастер-трека и вставьте плагин JS: LOSER/masterLimiter. 
2. Воспроизведите песню, настройте параметры. 
3. При понижении значения параметра Threshold, громкость станет выше, но максимум (предел) громкости 
никогда не будет превышен. 
4. При понижении значения параметра Limit, громкость песни становится ниже. 
5. Чем больше вы понижаете параметры Threshold и Limit, тем больше вы сжимаете динамику песни - 
громкость остается почти постоянной, а уровни измерителей громкости перемещаются по минимуму. 
Правильное использование лимитера призвано несколько сгладить пики и провалы, не оказывая негативного 
влияния на динамику песни.  
 

16.8. Аналитические плагины: GFXAnalyzer 
 
На рисунке слева изображен плагин JS: 
Analysis gfxanalyzer. Вставьте его в 
цепочку эффектов любого трека (или 
цепочку эффектов мастер-трека) и при 
воспроизведении проекта он отобразит 
информацию относительно уровня 
выходного сигнал в различных частотах. 
Это может иногда помочь, например, в 
идентификации частот, которым 
необходимо уделить внимание. Три 
плагина Cockos - ReaEQ, ReaFir и 
ReaXComp - включают аналитический 
дисплей, схожий с показанным на 
рисунке, который является частью их 
стандартного интерфейса. 
 
 
 
 
 
 
 
 

16.9. Использование пресетов эффектов 
 
Если вы удовлетворены результатами ваших настроек, можно сохранить их в пресет и применить в 
следующий раз, когда вы захотите использовать этот плагин на другом треке: 
 
1. Нажмите кнопку + выше выбранного плагина JS Delay/delay. 
2. Выберите опцию Save preset из меню. 
 

 
 
3. Введите имя и нажмите OK.  
 
Чтобы сохранить параметры в качестве параметров по умолчанию для этого плагина, когда он будет 
использоваться в будущем, выберите опцию Save preset as default из того же меню.  
Чтобы импортировать текущую библиотеку пресетов, выберете опцию Import preset library. 
Чтобы экспортировать ваши пресеты в файл (в целях резервирования или использования на другом 
компьютере), выберите опцию Export preset library.  
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Чтобы выбрать текущий пресет (из ранее сохраненных или импортированных, или которые 
поставляются с плагином), вставьте плагин в окно эффектов трека, отобразите меню пресетов (см. ниже) и 
выберите нужный пресет. 
 

 
 
Добавив плагин в цепочку эффектов пресет можно выбрать в браузере эффектов. Щелкните правой кнопкой 
по названию плагина и из контекстного меню выберите Presets, а затем выберите нужный пресет из списка. 
 

 
 

16.10 Эффекты, основанные на задержке: плагин ReaVerb 
 

ReaVerb - это VST плагин, который 
поставляется с REAPER. 
Ревербератор - это эффект, 
основанный на задержке, а плагин 
ReaVerb является сверточным 
ревербератором, который создает 
иллюзию пространства. Данная 
глава познакомит вас с основами 
использования плагина ReaVerb. 
Большинство ревербераторов 
пытается моделировать 
акустическую среду определенного 
пространства или помещения. 
Однако необходимая для этого 
математика достаточно сложна, 
поэтому только немногие плагины 
могут приблизиться к 
моделированию реальных 
акустических пространств. 
Плагины ревербераторов 
различаются не только по 
качеству, но и по применению. 
Сверточный ревербератор может 
предоставить бюджетную 
реалистичную реверберацию. 
Сверточный ревербератор 
использует импульсные 
характеристики реальных 
акустических пространств. Это 
делается сначала созданием 
сигнала в необходимой 

окружающей среде и затем записью результата. ReaVerb даже совершенствует эту концепцию, позволяя не 
только использовать записанные импульсы реальной окружающей среды для создания реверберации, но и 
использовать параметры для более традиционных способов реверберации, чтобы затем еще больше 
изменить звук. Чтобы использовать сверточный ревербератор, необходим набор импульсных характеристик. В 
сети вы найдете все, что хотите.  
В этом примере используются файлы, загруженные со страницы http://www.voxengo.com/impulses/ которые 
сохранены в папке, которую мы создали и именовали C:\Program Files\REAPER\Reverb Impulses\Voxengo\ 
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Пример: 
 
1. Откройте проект All Through The Night.RPP и сохраните его под именем All Through The Night 
REVERB.RPP 
2. Добавьте новый трек после последнего трека и именуйте его Reverb Bus. 
3. Создайте адресаты в этот трек со всех инструментальных треков и трека Vox. Позже это позволит вам 
запитать разные уровни сигнала, панорамируемые как нужно, с различных треков в шину ревербератора. 
4. Отобразите окно эффектов шины ревербератора. 
5. Добавьте плагин ReaVerb в окно эффектов шины. 
6. Постепенно уменьшите уровень параметра Wet приблизительно до -60, а уровень параметра Dry 
приблизительно до -0.5, как показано на рисунке выше. Мы начнем с добавления небольшой реверберации, а 
затем увеличим ее как нужно. 
7. Нажмите кнопку Add, затем кнопку File. Это позволяет вам добавить файл в начало цепочки шины. 
Перейдите к папке с вашими файлами импульсов и выберите импульс. В данном примере мы будем 
использовать импульс St Nicolaes Church.wav 
 

 
 
8. Нажмите кнопку Open, чтобы вставить этот файл в плагин ReaVerb. 
9. Воспроизведите проект. В окне трека уменьшите уровень фейдера Volume шины ревербератора 
приблизительно до -10 dB. уменьшите уровень фейдера Volume мастер-трека приблизительно до - 6 dB. 
Можно поднять уровень позже, если пожелаете. 
10. В окне плагина ReaVerb поднимите уровень фейдера Wet пока не добьетесь нужной реверберации. Скорее 
всего это будет значение в районе -10 dB. Если необходимо, солируйте шину, чтобы можно было 
идентифицировать эффект более четко. 
11. Теперь мы можем использовать контроллеры плагина ReaVerb для настройки реверберации. Фейдер Pre-
reverb смещает хвост реверберации, задерживая сигнал, который отсылается в генератор хвоста 
ревербератора. Попробуйте покрутить этот параметр для себя. 
12. Чтобы добавить дополнительные контроллеры в цепочку шины ревербератора, нажмите кнопку Add и 
выберите опцию Trim/Gain/Stretch. Эти контроллеры используются для растяжения по времени импульса 
(делая его длиннее), добавления некоторой зернистости или укорачивания импульса (делая его короче). 
Лучший способ понять это - поэкспериментировать! 
13. Теперь снова нажмите кнопку Add и добавьте опцию Filter (LP/HP). Это добавит контроллеры фильтра 
высоких и низкие частот, которые могут использоваться для предотвращения добавления в импульс 
реверберации слишком низких и/или слишком высоких частот. 
 

 
 
14. Когда вы настроили нужный звук, можно сохранить этот набор параметров в пресет, который можно 
использовать в других проектах. Для этого нажмите кнопку +, выберите опцию Save preset, именуйте пресет и 
нажмите OK. Заметьте, что при работе с плагином ReaVerb, вы можете: 
 
- изменить порядок модулей в цепочке реверберации (перетаскиванием модулей). 
- снять флажок с области налево от имени модуля, чтобы обойти этот модуль. 
 

Совет: при внесении изменений в параметры плагина ReaVerb может понадобится сначала 
остановить, а затем перезапустить воспроизведение для применения этих изменений. 
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Параметры плагина ReaVerb: 
 
Echo generator: генерирует эхо. Полезен для "заполнения пробелов" импульса или создания затухания эха. 
High/low pass filter: блокирует импульс выше или ниже определенной точки. 
Normalize: нормализует уровень импульса до значения 0 dBFS. 
Reverse: инвертирует реверберацию. Изящный эффект для вокалов, гитарных соло и вступлений/окончаний 
песни. 
Trim/Gain/Stretch: укорачивает или удлиняет импульс, добавляет некоторую зернистость. 
File: используется для вставки импульса. Количество вставляемых импульсов неограниченно! 
Max FFT: FFT фильтры - сложная математическая тема. Подробности ищите на Google! Между тем, изменение 
размера выборки (FFT size) влияет на процессор. Если вы не уверены в выборе значения, оставьте выбор по 
умолчанию. 
ZL: опция активирования нулевой задержки. Полезна при мониторинге уровня реверберации. 
LL: опция использования дополнительный потока для улучшения быстродействия с низкой задержкой. При 
рендеринге можно найти, что лучшие результаты получаются с отключенными опциями ZL и LL. 
Set all: применяет вышеперечисленные параметры быстродействия ко всем экземплярам плагина ReaVerb в 
текущем проекте. 
 

16.11. Управление громкостью с помощью компрессии: плагин ReaComp 
 
Ранее в этой главе, мы познакомились с лимитером. Поскольку ограничение может быть резким, зачастую на 
отдельных треках предпочтительней использовать компрессор. Простой лимитер активируется внезапно и 
жестко, тогда как компрессор может активироваться куда более мягко. На трех рисунках ниже изображена одна 
и та же сигналограмма сначала при записи, затем с применением к ней лимитера, и с применением 
компрессора.  
 

 
 
Заметьте, что на исходной сигналограмме перепады громкости достаточно значительные. Применение 
лимитера может приподнять тихие фрагменты, но общий эффект будет слишком громким и по сути искоренит 
динамику песни. На третьем рисунке вместо лимитера был использован компрессор. Трек больше не 
клиппируется и заметно больше динамики. Программные компрессоры варьируются от простых до сложных. 
Мы сконцентрируемся всего на пяти основных терминах. Они важны для понимания, как использовать 
компрессию.  
 
Threshold: Это громкость, при которой запускается компрессор. Например, если вы установите порог скажем, 
в значение -10dB, то сигнал ниже этого порога сжат не будет. 
Ratio: определяет степень компрессии. Например, соотношение 2:1 гарантировало бы, что для каждых 2 
децибел превышенной порог громкости, звук будет увеличен только на 1 децибел. Куда более жесткое 
соотношение 12:1 означало бы, что для каждых 12 децибел превышенной порог громкости, звук будет 
увеличен только на 1 децибел. 
Gain: громкость трека после компрессии. Контроллер усиления в ReaComp называется Wet. 
Limit Output: опция предотвращения превышения выходного сигнала компрессора 0 dB. 
Bypass: флажок в правом верхнем углу, рядом с кнопкой UI, который можно использовать для активирования 
статуса обхода, позволяя оценить поведение плагина. 
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Пример: 
 
1. Откройте файл All Through The Night.RPP и сохраните его под именем All Through The Night COMP.RPP 
2. Активируйте кнопку Solo трека Bouzouki. Посмотрите на пиковые уровни клипа. Вы видите, что сначала 
громкость более-менее устойчива, но последние 30 секунд песни она значительно повысилась. 
3. Воспроизведите трек с 55-секунды приблизительно 15 сек, а затем остановите воспроизведение. 
Попробуйте применить небольшую компрессию, приблизительно с порогом в -12 или -13 dB. 
4. Отобразите окно эффектов этого трека. 
5. Вставьте плагин VST: ReaComp (Cockos). 
6. Зациклите последние 20 секунд инструмента. 
7. Поэкспериментируете с параметром Threshold (вертикальный фейдер слева) и параметром Ratio. Отметьте 
опцию Limit Output. Вероятнее всего, вас удовлетворит результат с порогом в -16 dB и соотношением 4:1 или 
5:1 (см. рисунок выше). 
8. Теперь сохраните файл. 
 

16.12. Плагины LOSER’s Transients 
 

При умелом обращении 
компрессор может 
обогатить трек или микс, 
а при неумелом 
обращении он может 
принести больше вреда, 
чем пользы. Если вы не 
слишком уверены в 
использовании 

компрессора, обратите внимание на плагин LOSER’s Transients Killer. Это простой компрессор (по большей 
части лимитер) всего лишь с двумя параметрами - Threshold и Ratio. Порог (Threshold) определяет 
громкость, при которой начинается компрессия, а соотношение (Ratio) определяет степень компрессии. 
Попробуйте добавить плагин LOSER's Transient Controller сразу после плагина LOSER’s Transients Killer, 
чтобы добавить к треку, трек-папке или миксу параметры Sustain и/или Attack. 
 

16.13. Плагин Liteon's De-Esser 
 
Liteon's De-Esser- специальный компрессор, цель которого заключается в устранении свистящих/шипящих 
звуков из вокальных треков. Это комбинация highpass или bandpass фильтра, сфокусированных на 
определенной частоте вкупе с компрессором для устранения свистящих/шипящих звуков. Активировав опцию 
Monitor, вы можете использовать контроллер Frequency для определения степени шипения, а затем 
отключить опцию Monitor. Свистящие/шипящие звуки мужского вокала, вероятнее всего будут распознаны в 
районе 4500 Hz, а свистящие/шипящие звуки женского вокала приблизительно в районе 6500 Hz - но эти 
показатели могут меняться в зависимости от индивидуальности исполнителя.  
Параметр Bandwidth определяет ширину частотного диапазона, к которому будет применена компрессия. 
Параметры Threshold, Ratio и Gain работают так же, как и в типичном компрессоре. 
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16.14. Управление громкостью с помощью шумоподавителя 
 
Пороговые шумоподавители (Noise Gates) используются для подавления шума в паузах между полезным 
сигналом, например, между фразами вокалиста. Зачастую, при записи вокального трека, появляются участки 
тишины, например, между запевами. По крайней мере, вы хотите, чтобы они были тишиной! Однако вы могли 
заметить, что при воспроизведении в этих периодах раздражающие звуки были записаны на низком уровне. 
Пороговый шумоподавитель можно настроить на обнаружение этих звуков и их фильтрации. Как и компрессор, 
пороговый шумоподавитель может быть достаточно простым или более сложным. На данный момент мы 
сфокусируемся только на основных контроллерах порогового шумоподавителя: 

 
Threshold: определяет 
минимальный уровень, 
ниже которого запускается 
шумоподавитель. 
Attack: определяет, 
насколько быстро 
запустится гейт. Слишком 
короткий период атаки 
может обрезать 
естественное затухание 
звука. 
Hold: определяет, сколько 
времени гейт будет 
оставаться открытым после 
того, как сигнал упадет 
ниже порога 
Release: определяет, 
насколько быстро гейт 
закроется после того, как 
сигнал упадет ниже порога. 
Давайте возьмем пример, 
используя проект All 
Through The Night 
COMP.RPP 
 
 

Пример: 
 
1. Активируйте кнопку Solo трека Vox. 
2. Воспроизведите песню с точки незадолго до окончания первого запева. Если послушать внимательно 
(особенно через наушники), можно услышать некоторые нежелательные звуки в тихих фрагментах. Конечно, 
вы можете увидеть это на индикаторе уровня трека. 
3. Откройте окно эффектов этого трека и добавьте плагин Cockos VST ReaGate. 
4. Воспроизведите песню еще раз. Отрегулируйте фейдер Threshold (первый слева) до уровня чуть выше 
того, при котором индикатор порога достигает максимума в тихих фрагментах. Это заблокирует звук - 
визуальное подтверждение вы увидите на индикаторе уровня справа, который будет бездействовать. 
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5. Вероятнее всего, значения по умолчанию для параметров Attack, Hold и Release вы найдете вполне 
подходящими, но если хотите поэкспериментируйте с настройкой этих параметров. 
6. Теперь сохраните файл. Только что мы рассмотрели простой пример использования порогового 
шумоподавителя. Пороговые шумоподавители могут использоваться для создания определенных эффектов и 
используются во многих применения (в случае с ударной установкой можно обрезать взаимопроникновение 
сигналов микрофонов). 
 

16.15. Эффекты Sstillwell Chorus и Delay 
 
Если у вас когда-нибудь была акустическая гитара, вы, вероятно, знаете, что такое эффект хоруса. Возможно 
иногда вы использовали хорус-педаль, чтобы ваша гитара звучала более объемно и богато, почти как две или 
больше гитар. REAPER включает несколько эффектов хоруса. Мы рассмотрим плагин Sstillwell's 
Chorus_Stereo.  
 

 
 
Этот плагин использует схожие принципы эффекта дилея, с которым мы встретились ранее. Но у хоруса много 
дополнительных контроллеров, наиболее важным из которых является параметр Number of Voices 
(количество голосов). Здесь же вы найдете контроллеры wet/dry mix и опцию обхода, которые могут быть 
очень полезными. Другие эффекты хоруса/дилея от компании Sstillwell включают моноэффект Chorus, 
Delay_Pong (создающий эффект дилея с эффектом пинг-понга между левым и правым динамиками), а также 
эффект Delay_Tempo (простой дилей эффект). Для достижения действительно необычного эффекта дилея 
попробуйте поэкспериментировать с плагином remaincalm's floaty delay. 
 

16.16. Шумоподавление (Noise Reduction) с плагином ReaFir 
 
ReaFir - многоцелевой динамический эффект, который может функционировать как эквалайзер, компрессор, 
нойз гейт (Noise Gate), и больше. В данном примере мы рассмотрим, как плагин ReaFir может использоваться 
для шумоподавления (Noise Reduction). Потребность в шумоподавлении может возникнуть, когда вроде бы на 
хорошем треке присутствует некоторый нежелательный фоновый шум. Этот может быть, например, шипение 
или гул, или звук кондиционера. Плагин ReaFir может использоваться для удаления таких звуков из ваших 
треков в режиме реального времени. Но для этого необходимо сначала определить фрагмент на треке 
(возможно, секунду или два), где отдельно присутствую эти нежелательные шумы. Вероятнее всего это будет 
в самом начале трека. 
 
Пример и процедура: 
 
1. Вставьте плагин ReaFir в окно эффектов трека, содержащего записанные клипы с нежелательным шумом. 
2. Поместите курсор воспроизведения в начало отрывка, содержащего только нежелательный шум. 
3. Установите плагин ReaFir в режим Subtract. 
4. Установите режим редактирования (edit mode) в значение Precise. 
5. Отметьте опцию Automatically build noise profile. 
6. Воспроизведите трек только на время отрывка, содержащего шум, а затем остановите воспроизведение. 
7. Вы увидите, что ReaFir создал профиль нежелательного шума, который будет отмечен красной линией (как 
на рисунке ниже). 
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8. Теперь снимите флажок Automatically build noise profile. 
9. Верните курсор воспроизведения в начало песни и воспроизведите песню. 
10. Теперь вы можете обнаружить, что по ходу воспроизведения песни, шум, который вы определили в 
качестве профиля в шагах с 1 по 5 удален из сигнала. 

 
Примечание: возможно, вы могли быть немного озадачены относительно того, когда использовать 
нойз гейт, и когда шумоподавитель, такой как ReaFir. Ответ обычно достаточно прост. 
Шумоподавление подходит для удаления фонового шума, довольно постоянного, такого как 

электрический гул, тогда как нойз гейт лучше использовать в контексте случайного шума, такого как дыхание 
вокалиста. 
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16.17. Многополосная компрессия с плагином ReaXComp 
 

 
 
Применимо к мастер-треку, многополосная компрессия может оказаться полезным инструментом для 
добавления объема, теплоты и громкости вашему заключительному миксу. Насколько применять 
многополосную компрессию - тема, которая выходит за рамки данного руководства. Функция многополосного 
компрессора – применение различных уровней компрессии к различным полосам частот, что позволяет 
формировать звук куда более точно, чем при применении типичного компрессора. По умолчанию плагин 
ReaXComp - 4-х полосный. Диапазон полос 0-200 Гц, 200 Гц-1,000 Гц, 1,000 Гц-5,000 Гц и выше 5,000 Гц. Тем 
не менее, вы можете добавить дополнительные полосы или удалить лишние. Можно также изменить частоты 
полос. Например, если вы увеличиваете основную частоту полосы #1 до 250 Гц, эта частота автоматически 
становится и стартовой частотой для полосы #2. Если вы прежде не пользовались многополосным 
компрессором, рекомендуется начать его использование с осторожностью. 
 
Пример: 
 
1. Откройте один из проектов All Through The Night. 
2. Вставьте плагин ReaXComp в окно эффектов мастер-трека. 
3. Воспроизведите проект с начала. 
4. Скорее всего на данном этапе плагин ReaXComp не будет иметь никакого эффекта на звук. 
5. Активируйте опцию Solo current band. 
6. По ходу воспроизведения песни, выберите по очереди каждую из четырех вкладок - 1, 2, 3 и 4. Это позволит 
вам услышать отдельно каждый из 4-х частотных диапазонов. 
7. Теперь отключите опцию Solo current band. Отключите опцию Auto makeup gain для каждой из четырех 
полос. Если бы опция Auto makeup gain осталась активированной, громкость микса увеличивалась бы после 
внесения и других изменения. 
8. По ходу воспроизведения песни, отрегулируйте порог (threshold) для каждой полосы до уровня чуть ниже 
пиков каждой полосы. Пример этого показан на рисунке ниже. 
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9. Установите соотношение (Ratio) по умолчанию 2:1. Попробуйте увеличить соотношение для каждого из 
порогов приблизительно до 4:1. Если вы обнаружите, что это сделало звук слишком сжатым, понизьте 
соотношение назад к значению 2:1. Помните, это - пример, не модель использования! 
10. Даже сейчас, с такими достаточно консервативными настройками, можно заметить разницу между звуком с 
активированным плагином ReaXComp и когда плагин в статусе обхода (bypass). 
11. При необходимости можно поэкспериментировать с различными другими контроллерами, особенно с 
параметром Knee, который определяет насколько внезапно или постепенно будет применена компрессия. 
12. Можно также поэкспериментировать с параметром Gain, как для отдельных полос, так и для общего микса, 
но не переусердствуйте. 
 
Несколько советов по использованию ReaXComp: 
 
- не используйте слишком много полос. Слишком много независимо сжатых полос могут заставить ваш микс 
звучать несвязным. Многие лучшие звукоинженеры при мастеринге используют только три полосы. 
- тщательно слушайте изменения звука при настройке различных параметров - они все взаимосвязаны. 
- параметр Attack определяет отрезок времени с момента превышения сигналом порога до активирования 
компрессора. 
- параметр Releases определяет отрезок времени с момента понижения сигналом порога до отключения 
компрессора. 
- попробуйте отрегулировать параметры Attack и Release так, чтобы компрессор активировался и отключался 
незаметно. 
- первоначально используя многополосный компрессор на мастер-треке, желательно использовать только 
параметр Gain, чтобы компенсировать понижение громкости в виду компрессии, а не усиливать сам сигнал. 
Исключением здесь могла бы быть ситуация, когда одну полосу необходимо отрегулировать относительно 
остальных полос. 
- зачастую желательно вставить лимитер (например, LOSER’s Master Limiter) после многополосного 
компрессора в цепочку эффектов. 
- другое использование многополосного компрессора направлено на компрессию конкретной частоты в 
пределах трека, например, использовать многополосный компрессор в качестве де-эссера или де-поппера в 
вокальном треке. 
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16.18. Плагин LOSER’s TimeDifference Pan 
 

Среди обилия JS 
плагинов, которые 
поставляются (или 
доступны для 
использования) с 
REAPER, плагин LOSER’s 
TimeDifference Pan 
определенно заслуживает 
особого упоминания. 
Плагин прост в 

использовании, но достаточно эффективен. Иногда вам может показаться, что записанный вами трек звучит 
довольно узко. Если вы захотите несколько обогатить этот трек, можно продублировать его и сместить 
дубликат на несколько миллисекунд от оригинала, но с другой панорамой. В конечном миксе, это приведет к 
тому, что звук одного инструмента будет звучать так, как будто бы звучат два инструмента одновременно. 
Плагин LOSER’s TimeDifference Pan эффективно решает эту задачу с куда меньшей затратой времени и что 
не маловажно с минимальной нагрузкой на процессор. Если вы захотите поэкспериментировать с этим 
плагином, лучший пример трека для этого - Bouzouki проекта All Through The Night.RPP. 
 

16.19. Плагин LOSER’s Exciter 
 

Плагин LOSER’s Exciter - 
простой способ вернуть 
прозрачность и 
искристость в унылый 
микс. Отдельные 
инструменты должны 
обрабатываться на их 
собственных треках. 
Однако вы можете 
захотеть добавить 
некоторую живость и к 
общему миксу, поместив 

икскайтер в начало или ближе к началу цепочки эффектов мастер-трека. Параметры плагина: 
 
Frequency - частота, выше которой будет добавлена искристость. Попробуйте поэкспериментировать в 
диапазоне приблизительно 2000-4500 Гц. Возможно в некоторых случаях придется повысить диапазон для 
улучшения результатов. 
Clip Boost - степень повышения громкости выше указанной частоты. Выбирайте значение с осторожностью. 
Harmonics - количество гармоник, которое будет добавлено в микс (не переборщите с этим параметром).  
 
Еще один схожий плагин - JS: SStillwell/Exciter. 
 

16.20. Плагин SSTillwell's HugeBooty 
 
Простой плагин, который 
может использоваться 
для увеличения низких 
частот на любом треке. 
Сначала попробуйте 
установить нужную 
частоту, а затем 
постепенно увеличивать 
значения параметров 
Drive и Mix. 
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16.21. Некоторые необычные плагины JS 
 
16.21.1. Плагин Utility/bufsave 
 

 
 
Помещенный в начало цепочки эффектов (или, в случае с MIDI треками, сразу после синтезатора), а также в 
конце цепочки, этот плагин привносит обратную связь в цепочку (см. пример выше). Доступно до 100 
буферных слотов. Используйте один и тот же слот для обоих экземпляров плагина на том же самом треке и не 
используйте один и тот же слот в других треках. Эффекты, которые можно поместить между двумя 
экземплярами bufsave, могут быть такими простыми эффектами, как дилей или, как показано на рисунке, 
целая последовательность эффектов. Остальные четыре фейдера управляют аудиопотоком и определяют 
отдельно для каждого экземпляра плагина уровни "источник в буфер микс", "буфер в буфер микс", "буфер в 
целевой микс" и "источник в целевой микс". В частности, источник в буфер микс функционирует в качестве 
управления обратной связью. При работе с параметром feedback будьте осторожны. В качестве меры 
предосторожности, изначально установите оба фейдера buffer mix немного влево. Затем можно медленно 
переместить их вправо. Интересные звуки можно получить, используя более одной пары плагинов bufsave в 
цепочке эффектов, где каждая пара назначается на ее собственный уникальный слот. 
 
16.21.2. Плагин JS: Thunderkick 

 
Плагин добавляет к треку 
громоподобный звук. Его 
можно использовать с 
бочкой или синтезатором, 
или даже с 
электрическим басом.  
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16.21.3. Плагин JS: Tonegate 
 

Тон генератор, 
добавляющий 
синусоидные, 
прямоугольные или 
шумовые тоны. Более 
интересных эффектов 
можно добиться с 
использованием 
контроллеров Dynamic 
pitch и fade in/fade out 
response. Изначально 
предназначенный для 
использования с бочкой 
или малым барабаном, 
плагин тем не менее 
удивительно 
универсален. Попробуйте 
этот плагин, например, с 
электрогитарой! Сначала 
поэкспериментируйте с 

фейдером Frequency и опциями Waveform, а затем с другими контроллерами. Подробнее об этом и других 
плагинах JS на сайте remaincalm.org. 
 

16.22. Некоторые плагины эффектов гитары 
 
Есть целый ряд плагинов от компании Jesusonic, специально разработанных для формирования звука гитары.  
В общем и целом, они функционируют практически так же, как и гитарные педали (стомпы): 
 
JS Convolution Amp/Cab Modeler/JS Convolution Dual Amp modeler: Позволяет выбрать симулятор 
усилителей таких фирм, как Fender или Marshall со множеством параметров. Double версия этого плагина 
позволяет выбрать различные лево-правые динамики! 
JS Chorus: форма волны проходит через серию задержек, временные параметры которых медленно 
модулируются. Звук хоруса формируется прежде всего параметрами Length, Number of Voices, и Rate. 
JS Distortion: этот плагин искажает форму и частотный контент формы волны. Степень искажения 
определяется преимущественно параметрами Gain и Hardness. 
JS Flanger: эффект флэнжера достигается смешиванием сигнала с задержанной собственной копией, при 
постоянном изменении временных параметров задержки. Эффект флэнжера регулируется параметрами Delay 
Length, Rate и Feedback. 
JS 4-Tap Phaser: четыре параметра стереофейзера включают Rate (Hz), Range (Min and Max), и Feedback. 
JS Wah-Wah: эффект Wah-Wah - это фильтр с параметрами Position, Top Resonance, Bottom Resonance и 
Filter Distortion. 
JS Tremolo: эффект тремоло достигается изменением низких частот в огибающей амплитуды звука с 
помощью параметра Frequency (Hz) и Amount (dB). 
 
Мы не предполагаем, что вы захотите использовать все эти эффекты одновременно, но, если вы 
действительно используете большую часть из них, эффект будет совокупный. Порядок применения этих 
эффектов определяет звук выходного сигнала. В качестве отправной точки, один из возможных 
последовательностей показан ниже. 
 
Фильтр (например, Wah-Wah или Phaser) 
Компрессор 
Дисторшн 
Эквалайзер 
Эффект тональных изменений (например, Vibrato) 
Модулятор (например, Flange или Chorus) 
Контроллер уровня (например, Tremelo или Limiter) 
Эффект Эхо (например, Reverb) 
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16.23. Некоторые другие JS плагины REAPER 
 
Этот параграф предоставляет обзор некоторых плагинов компании Jesusonic, поставляемых с REAPER.  
 
JS Channel Polarity Control: четыре значения: Normal Phase, Invert Left, Invert Right или Invert Both. 
JS Channel Router w/Polarity: стереофазоинвертор с добавлением выбора входных и выходных каналов. 
Плагин может использоваться, например, для создания более полного, более яркого звука с одного монотрека. 
JS Digital Drum Compressor: фирменный компрессор для использования с Digital Drums. 
JS LOSER/Simple Peak-1 Limiter: простой пиковый ограничитель с одним контроллером Threshold. Плагин 
может использоваться для препятствования клиппирования отдельного трека. 
 

JS Goniometer: поместите этот плагин в конце цепочки эффектов 
стереотрека, трек-папки или мастер-трека, и вы будете видеть 
визуальное представление перемещения звука в пределах 
стереополя. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
JS Stereo Enhancer: используется для создания эффекта расширения стереополя стереотрека, трек-папки, 
шины или мастер-трека. Функционирует за счет регулировки ширины панорамы высоких и низких частот 
независимо, и определения точки пересечения между двумя частотами. Другие LS плагины манипуляции со 
стереополем: MDA Pseudo Stereo и Stereo Width. 
JS Waveshaping Distortion: простой в использовании дисторшн. 
 

JS Meters/tuner: вставьте этот 
плагин в новый трек и активируйте 
трек для записи, а затем настройте 
гитару. 
 
 
 
 
 
 
 
 
 
 
 

 
JS Meters/vumeter: Вставьте этот плагин в любой трек, если захотите контролировать его уровни. 
JS Tonifier: интересный плагин, создающий звуковые эффекты смещая высоту тона или частоту. 
 

JS Ozzifier Chorus: 
особенно хорош для 
удвоения вокальных 
треков. 
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JS Downward Expander: противоположность компрессора! Может вернуть динамику миксу, который звучит 
сверх сжатым. Функционирует за счет уменьшения громкости сигнала, когда он падает ниже заданного порога. 

 
JS RBJ Highpass/Lowpass: 
фильтр высоких частот и низких 
частот, добавляемые к треку или 
мастер-треку. 
 
 
 
 
 
 

 
JS Bad Buss Mojo Waveshaper: 
необычный нелинейный 
waveshaper. Используйте в 
частности параметры nonlinearity, 
knee и mod. 
 
 
 
 
 
 
 
 
 
 
 
 

JS Louderizer: простой плагин с двумя контроллерами для увеличения громкости трека или микса. 
JS Pitch Shifter 2: один из многих плагинов, который может использоваться для изменения высоты тона. 
JS FFT Peak-Following Filter: позволяет создавать эффекты типа autowah, по существу регулируя 
центральные частоты и ширину фильтра. Чем ближе друг к другу значения параметров min и max center 
frequency и чем ниже значение параметра octave width, тем более существенный будет эффект. 
JS DC Filter: плагин для удаления постоянной составляющей. 
JS Volume Adjustment: простой плагин для увеличения или уменьшения громкости. Поместите его в начало 
цепочки эффектов, чтобы отрегулировать громкость трека или клипа до применения эффектов. 
JS Phase Rotator: еще один очень простой плагин для регулирования фазы трека или клипа. 
 
Более 200 плагинов Jesusonic поставляются с REAPER. Для получения дополнительной информации 
перейдите на страницу wiki.cockos.com/wiki/index.php/Category: Jesusonic, 
 

16.24. Управление параметрами эффектов на лету 
 
Если у вас есть аппаратный контроллер такой как (но ни в коем случае обязательно) Presonus Faderport, 
можно на лету назначить контроллер на параметр VST эффекта: 
 
 1. В списке действий найдите действие Adjust last touch FX parameter. 
 2. На панели Shortcuts for selected action нажмите кнопку Add. 
 3. Затроньте нужный регулятор на вашем контроллере. 
 4. Назначьте другие действия по усмотрению и нажмите OK. 
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16.25. Бриджинг и режим запуска VST плагина 
 
Если вы запускаете 64 битную версию REAPER и хотите использовать более старые 32-битные плагины, 
необходимо использовать бриджинг. По умолчанию REAPER попытается сам решить для каждого плагина -
требуется бриджинг или нет (Options > Preferences > Plug-ins > Compatibility).  
 

 
 
Однако для любого плагина эту установку можно переопределить, щелкнув правой кнопкой по плагину в 
браузере эффектов и в контекстном меню Run as выбрать одну из трех опций, которые позволяют определять 
бриджинг плагина: 
 
Separate process: все бриджинные плагины, для которых выбрана эта опция, будут охвачены одним 
процессом, вне основного процесса Reaper. Преимущество этой опции заключается в уменьшении нагрузки на 
процессор, недостаток - если один плагин в процессе бриджинга вызовет ошибку, это вызовет ошибку всех 
остальных плагинов. 
Dedicated process: эта опция помещает каждый бридженный плагин в отдельный собственный процесс 
бриджинга. Преимущество этой опции заключается в препятствовании тому, чтобы ошибочный плагин 
разрушил весь бридж, недостаток - увеличение общей нагрузки на процессор. 
Native only: опция по умолчанию; плагины запускаются с основным процессом Reaper.  
Бриджинг может служить другой полезной функции. Даже при том, что он прежде всего предназначается для 
использования с 32-битными плагинами, вы можете также бриджить (скорее всего, с использованием опции 
Dedicated process) и 64-битные плагины. Получается эффект брандмауэринга REAPER против любых 
отрицательных воздействий, которые могли потенциально явиться результатом ошибочного 64битного 
плагина.  
 
Embed bridge UI: определяет, будет ли отображаться интерфейс бридженного плагина в окне цепочки 
эффектов (или в плавающем окне) или будет отображаться в отдельном окне (Windows / OSX). 
 
Помните! Нельзя хранить 32-битные плагины в одной папке с 64-битными плагинами. 
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16.26. Пресеты сторонних плагинов 
 
В REAPER можно использовать сторонние VST и DirectX плагины таких фирм, как Sonitus, Wave Arts, Sony, и 
других. Большинство из этих плагинов поставляются со множеством пресетов. Доступ к ним меняется в 
зависимости от таких факторов как собственный интерфейс плагина и тип плагина. В этом параграфе мы 
рассмотрим три примера. С помощью этой информации можно выяснить местоположение пресетов любого 
плагина. 
 
Пример 1: 
 

Этот пример для популярного 
DirectX плагина Phase от 
компании Sonitus. В данном 
случае интерфейс плагина 
включает собственную секцию 
Presets. Щелчок по ней (как на 
рисунке слева) отображает меню с 
пресетами. Здесь можно также 
сохранить ваши собственные 
пресеты. Заметьте, что можно 
также пользоваться собственной 
библиотекой пресетов REAPER. 
Доступ к этой библиотеке можно 
получить щелчком по маленькой 
кнопке + налево от кнопки Param. 
Это особенно полезно в том 
случае, когда вы работаете с 
плагинами, у которых нет их 
собственного менеджера 

пресетов. 
 
 
Пример 2: 

 
Этот пример для VST плагина TWest, от компании STEADY Pro. 
У этого плагина нет собственного менеджера пресетов. Однако, 
как и в случае с другими плагинами можно использовать 
программный VST интерфейс REAPER для создания и 
управления собственными пресетами. 
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Пример 3: 
 

Этот пример для Direct X плагина Vibrato 
от компании Sony. В данном случае 
щелчком по стрелке меню Preset в 
Reaper собственные пресеты не 
отображаются, а отображаются только 
созданные вами пресеты. В этом 
примере щелкните правой кнопкой по 
любой свободной области интерфейса 
плагина, чтобы отобразить список 
фабричных пресетов. 
 
 
 
 
 
 
 
 
 
 
 
 

 
16.27. Скрытие интерфейса VST плагинов 

 
Иногда может понадобиться скрыть интерфейс VST плагина и вместо этого отобразить 
его параметры в виде простого ряда фейдеров. Делается это с помощью кнопки UI 
интерфейса плагина REAPER. Щелчок по этой кнопке отображает плагин и его 
контроллеры в более простом формате. Ниже приведен пример использования плагина 
Terry West VST Voc-EQ PRO ST. Вам может нравиться этот плагин, но не нравиться его 
регуляторы. Некоторые люди считают, что управлять регуляторами довольно трудно 
мышью. В этом случае вы можете нажать кнопку UI (см. позицию курсора мыши), и 

превратить интерфейс в такой вот:  
 

 
 
В универсальном интерфейсе REAPER каждым параметром управляет горизонтальный фейдер. На странице 
Options > Preferences > Plug-ins > VST доступна также опция Default VST to generic UI (instead of plug-in UI) 
(универсальный интерфейс vst плагина вместо собственного интерфейса плагина). 
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17. Примеры маршрутизации в REAPER 
 
Данная глава, главным образом, предназначена для достаточно опытных пользователей хостов и открывает 
некоторые куда более интеллектуальные аспекты маршрутизации REAPER, которые, вероятно, отличаются от 
тех, что вы пробовали до этого. Но даже если вы абсолютный новичок, нелишним и вам будет ознакомиться с 
данным материалом.  

 
Примечание: некоторые рисунки, используемые в этой главе, сделаны на основе темы по умолчанию 
REAPER 4. Действия и шаги в примерах, тем не менее, равнозначны и для темы REAPER 5. Кроме 
того, тема по умолчанию REAPER 5 включает дополнительную функцию кнопки маршрутизации трека 

на панели трека. Эта функция отображается для каждого трека одним, двумя или тремя небольшими 
“световыми индикаторами”, каждый из которых можно включить/отключить. Первый из них указывает, 
активирована ли опция посыла master/parent; второй указывает, есть ли у этого трека адресаты; третий (как 
показано на рисунке ниже) указывает, есть ли у этого трека посылы. Для отображения подсказки, наведите 
курсор мыши на кнопку. 
 

 
 

17.1. Управляемое взаимопроникновение (bleed) сигналов 
 
Термин Bleed используется в тех случаях, когда материал, предназначенный для записи на один трек, 
проникает в другой материал. Обычно это происходит в следующих случаях: 
 
- когда одновременно записывается несколько вокалистов или инструментов на отдельные микрофоны. 
Например, когда вы записываете артиста, одновременно поющего и играющего на акустической гитаре в 
отдельные микрофоны для голоса и гитары. При этом вы можете обнаружить, что часть сигнала с микрофона 
вокала проникнет в микрофон гитары, и наоборот. 
- при записи наслоением, когда сигнал в наушниках настолько громкий, что микрофон, используемый для 
записи, фактически захватывает часть этого сигнала с наушников. Если, например, у вокалиста есть привычка 
при записи вокала прижимать к уху только один из наушников, убедитесь, что фонограмма или микс с вокалом 
направлены именно в этот наушник. К счастью, гибкая маршрутизация REAPER упрощает этот процесс.  
 

На рисунке слева, выходной сигнал с мастер-трека направлен в 
оба динамика, но только в один наушник.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Другой тип взаимопроникновения сигналов который мы назовем проникновение сигналов при живой записи, 
может иметь свои преимущества. Если все микрофоны размещены правильно, это может создать более 
теплый, более объемный и более естественный звук, чем если бы мы достигали этого эффекта при записи 
наслоением. Проблема в том, что, у метода записи "все сразу" также есть свои серьезные недостатки. 
Например: 
 
- невозможно «вклиниться» и перезаписать определенный отрывок, чтобы исправить вокальную фразу или 
несколько тактов гитары. Необходимо каждый раз записывать весь трек заново. 
- ограничены опции микширования. Например, если необходимо добавить эффект присутствия или сжать 
вокальный трек, эти эффекты нужно будет применить и к проникающему сигналу гитары на том же самом 
треке. Вот где возможности маршрутизации REAPER могут оказаться столь полезными. Вот что нужно 
сделать: 
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- используйте запись наслоением, чтобы гарантировать, что каждый трек записан чисто. 
- используйте маршрутизацию REAPER, чтобы добавить проникновение сигналов именно там, где вы хотите, 
перед или после эффектов в цепочке эффектов. 
 
Пример: 
 
Данный пример демонстрирует простую маршрутизацию для создания управляемого эффекта 
взаимопроникновения сигналов. 
 
1. Откройте файл All Through The Night.RPP и сохраните его под именем All Through The Night BLEED.RPP 
2. Мьютируйте трек Bouzouki. Для чистоты эксперимента, здесь мы не будем использовать этот трек. 
 

3. Выберите трек Vox, щелкните правой кнопкой 
по контроллеру Volume и установите количество 
каналов трека (опция Track channels) в 4. 
 
 
 
 
 
 
 

4. Отобразите окно эффектов трека Vox. Добавьте любой ревербератор. В данном случае мы будем 
использовать плагин ReaVerbate, поставляемый с REAPER. 

 
5. После вставки плагина настройте его параметры по усмотрению. 
Нажмите кнопку 2 in 2 out и отметьте только выходные каналы 3 и 4 (см. 
рисунок ниже). 
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6. Откройте окно маршрутизации трека Vox. Добавьте 
посылы с трека Vox (исходные стереоканалы 3/4) в 
обои треки гитары (каналы 1/2), как показано на рисунке 
ниже. Панорамируйте их влево и вправо 
приблизительно на 70% соответственно, громкость 
выставите около -15dB и выберите опцию Post FX. Эти 
значения гарантируют, что вокальный трек будет 
слышен четко по центру, в то время как его 
реверберация будет панорамирована влево и вправо. 
7. Воспроизведите проект с отключенной опцией 
Master/Parent send трека Vox. Отрегулируйте уровни 
посыла трека Vox в обои треки гитары так, чтобы трек 
Vox можно было слышать очень отдаленно. 
8. Активируйте опцию Master/Parent send трека Vox и 
воспроизведите проект еще раз. Возможно, необходимо 
будет отрегулировать некоторые параметры 
ревербератора и/или уровни посыла. Трек Vox должен 
звучать более объемно и более богато, чем прежде. 
9. Сохраните файл. 
 
Теперь попробуйте это! 
Удалите ревербератор из трека Vox. Удалите посылы с 
трека Vox в треки гитары. Создайте новый трек с 
названием Vox Reverb и вставьте в этот трек любой 
ревербератор. Создайте посыл с трека Vox в трек Vox 
Reverb. Создайте посылы с трека Vox Reverb в оба 
трека гитары и выберите опцию Post FX. 
Воспроизведите проект, настроив уровни параметров 
Send, Pan и Volume как нужно. Отключите опцию 

master/parent send трека Vox Reverb, и почувствуйте разницу. 
 

17.2. Разделение по каналам 
 

Данный пример познакомит вас с функцией REAPER, 
которая возможно откроет больше возможностей 
микширования, чем любой другой аспект: это 
способность создавать и использовать несколько 
каналов. Звучит не очень интересно и не захватывает? 
Это концепция не легка для начального понимания, 
поэтому мы возьмем максимально простой пример, 
чтобы понять ее. У вас есть записанный трек 
акустической гитары. К настоящему моменту вы должны 
уже иметь общее представление, по крайней мере, о 
том, как сформировать звук гитары с помощью 
эквалайзера или сделать трек более объемным с 
помощью дилея. Но в данном примере, мы собираемся 

приблизиться к другому уровню: мы можем разделить записанный трек на различные полосы частот, скажем, 
на три разных спаренных канала, и возможно панорамировать различные частоты по-разному, или добавить 
задержку только на один канал (т.е., на один выбранный частотный диапазон). Почему мы хотели бы это 
сделать? Данный конкретный пример возможно вам пригодиться, а возможно и нет. Но способность создавать 
и использовать каналы таким образом открывает множество творческих возможностей микширования и 
редактирования. Мы начнем с данного примера, потому что он достаточно прост на практике. После этого мы 
рассмотрим более сложный пример. 
 
Пример: 
 
1. Откройте файл All Through The Night.RPP и сохраните его под именем All Through The Night Channels. 
RPP 
2. Мы (в рамках данного примера) собираемся работать только с треком Gtr Body. Мьютируйте все остальные 
треки (щелкнув по кнопке Mute этого трека с нажатой клавишей Alt). 
3. Теперь мы создадим три трека - давайте назовем их «фантомные треки» - чтобы отразить каждую из трех 
полос, на которые мы собираемся разделить наш трек Gtr Body. Создайте эти треки и маркируйте их Low, 
Medium, и High.  
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4. Откройте окно маршрутизации трека Gtr Body. 
Установите количество каналов в 6 и создайте посылы к 
каждому из только что созданных трех треков. 
5. Направьте аудиосигнал с каналов 1/2 в каналы 1/2 трека 
Low, каналы 3/4 в каналы 1/2 трека Medium и каналы 5/6 в 
каналы 1/2 трека High (см. рисунок выше). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Усложним? Откройте матрицу маршрутизации. 
7. Теперь откройте окно эффектов трека Gtr Body и вставьте плагин JS LOSER/3BandSplitter. 
8. Установите первый фейдер Frequency приблизительно в значение 200 Hz и второй приблизительно в 
значение 2000 Hz. 
 

 
 
9. Солируйте трек Low и воспроизведите проект. Заметьте, что вы слышите только низкие частоты. 
10. Нажмите кнопку Solo трека Medium с нажатой горячей клавишей Alt+Ctrl. Заметьте, что теперь вы 
слышите только средние частоты. 
11. Нажмите кнопку Solo трека High с нажатой клавишей Alt+Ctrl. Заметьте, что теперь вы слышите только 
высокие частоты. 
12. Поэкспериментируйте с настройкой фейдеров в плагине 3 Band Splitter и воспроизведите проект. 
Обратите внимание как изменился звука. После этого установите фейдеры в значения по умолчанию. 
13. Теперь выберите трек Medium, откройте его окно эффектов и добавьте плагин JS: Guitar/chorus. 
Отрегулируйте параметры плагина по усмотрению. 
14. Теперь отключите солирование всех солируемых треков, размьютируйте любые мьютированные треки. 
Вероятно, вы захотите постепенно уменьшить громкость исходного трека Gtr Body приблизительно в значение 
- 6 dB, а трека Bouzouki приблизительно в значение - 10 dB (или вообще мьютировать). 
15. Внесите дальнейшие корректировки в параметры Delay Chorus. Пример (и только пример) показан ниже. 
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16. Поэкспериментируйте с панорамой трех полос для создания более объемного звука. 
17. Сохраните файл.  
 
Среди плагинов, поставляемых с REAPER, есть несколько, которые могут использоваться для манипуляций с 
каналами, включая разделитель на четыре полосы (как на рисунке ниже) и разделитель на пять полос. 
 

 
 

17.3. Объемный и богатый вокал с плагином ReaDelay 
 
Следующий пример показывает, как можно объединить мощные возможности разделения по каналам REAPER 
с плагином ReaDelay для создания простого эффекта обогащения скудного вокала - все на одном треке! 
Рисунок ниже иллюстрирует, как это будет сделано. Поток сигналов создает следующий эффект: 
 

 
 
- создается сайдчейн, который запитывается в плагин ReaDelay для обогащения исходного звука и его 
наполнения. 
- плагин ReaComp используется для некоторой компрессии к основному вокалу. 
- затем задержанные сигналы смешиваются с исходным сигналом и применяется дальнейшая компрессия.  
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При необходимости можно применить дополнительные эффектов к: 
 
- исходной необработанной записи. 
- сайдчейну и задержанному сигналу. 
- заключительному миксу необработанного и сайдчейн (задержанного) сигналов вместе. 
 
Обратите внимание на порядок плагинов в цепочке эффектов: если вы изменяете порядок, изменяется и 
результат! Эта проблема будет исследована более подробно в дальнейших примерах. 
 
Пример: 
 
1. Откройте файл All Through The Night.RPP и сохраните его под именем All Through The Night READELAY. 
Rpp. 
2. Солируйте трек Vox. В рамках данного примера мы будем работать только с одним этим треком. 
3. Отобразите окно маршрутизации трека Vox и установите количество каналов в 4. 
4. Откройте окно эффектов трека. Если в цепочке эффектов есть какие-либо плагины, удалите их. 
5. Теперь вставьте плагин ReaDelay в цепочку эффектов. 

 
6. Нажмите кнопку 2 In 2 Out, чтобы отобразить матрицу подключений. 
Оставьте значение входных каналов (Inputs) как есть (каналы 1 и 2), и 
отметьте выходные каналы (Outputs) так: Channel 3 (Left) and Channel 4 
(Right), и только эти два канала (как показано на рисунке слева). 
 
 
 
 
 
 
 
 
 
 
 
 

7. Нажмите кнопку Add Tap, чтобы добавить вторую страницу. 
8. На странице 1 установите параметр Delay Length (time) приблизительно в значение 3.5 ms, а параметр 
musical length в значение 0. 
9. На странице 1 установите параметр Pan приблизительно в значение 50% Left. Это отображается на 
фейдере значением -0.5. См. рисунок ниже. 
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10. На странице 2 установите параметр Delay Length (time) приблизительно в 6-7 ms, а параметр musical 
length в значение 0. 
11. На странице 2 установите параметр Pan приблизительно в значение 50% Right. Это отображается на 
фейдере значением 0.5. 
12. Убедитесь, что обе страницы активированы и что ни на один из не отмечена опция Solo active tap. 
13. Установите значение параметра Wet приблизительно в значение -9 dB, а параметр Dry приблизительно в 
значение -2 dB. Поскольку мы еще не добавили канальный микшер, вы не услышите эффекта задержки. 
14. Вставьте плагин ReaComp в цепочку эффектов. Оставьте параметры Main Inputs/Outputs как есть - 
Channel 1 (Left) и Channel 2 (Right). 
15. Установите параметр Ratio приблизительно в значение 6:1. Отрегулируйте параметр Threshold так, чтобы 
для более громких отрывков выходной сигнал понижался приблизительно на 6 или 7 dB. 
16. Теперь мы можем объединить наши каналы, чтобы смешать задержанный сигнал со сжатым сигналом. 
Вставьте плагин JS: IX/Mixer_8xS_1xS в цепочку эффектов (после плагина ReaComp). 
17. Первые два фейдера поверните так, как на рисунке, другие фейдеры по усмотрению (см. рисунок ниже). 
 

 
 
18. Добавьте другой экземпляр плагина ReaComp после микшера. Отрегулируйте параметры по усмотрению. 
19. Воспроизведите файл, регулируя громкость трека по усмотрению. Сравните вокальный звук с эффектами, 
поочередно активируя и отключая их. С активированными эффектами, вокал должен располагаться как бы над 
миксом. 

 
Примечание: в данном примере порядок, в котором применялись эффекты очень важен. Здесь 
задержанные сайдчейн сигналы не проходят компрессор, поэтому в итоге эти сигналы сохраняют 
больше своей исходной динамики. 
 
Совет: Когда вы копируете эффекты или цепочку эффектов (включая способ перетаскивания) с одного 
трека в другой, количество каналов и настройки окна Plug-in Pin Connector будут включены и 
скопированы с эффектами. Точно так же, когда эффекты перетаскиваются в клип, количество каналов 

будет увеличено по мере необходимости. 
 

17.4. Маршрутизация перетаскиванием 
 
Вышеупомянутый пример использует метод маршрутизации перетаскиванием, т.е. создание посыла, 
перетаскивая кнопку Route трека-источника на трек-адресат. Давайте более пристально взглянем на окно 
маршрутизации перетаскиванием и его контроллеры.  
 

 
 
Два слайдера могут использоваться для регулирования громкости и панорамирования посыла, управляя 
поведением выходного сигнала на треке-адресате. Здесь есть кнопки mute, phase invert, и mono/stereo, а 
также выпадающее меню для выбора типа посыла.  
Кнопку MIDI можно использовать для посыла MIDI данных, вместо аудиоданных: в этом случае вы сможете 
задать другие MIDI параметры, такие как каналы-источники и каналы-адресаты. Последняя кнопка может 
использоваться для выбора режима автоматизации (см. Главу 18) 
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17.5. Разделение по каналам и изменение высоты тона 
 
Вы уже видели, как плагин ReaPitch может использоваться, например, для создания гармоний исходя из 
ведущего вокального трека. Теперь вы увидите, как разделяя вокальный трек на несколько каналов можно 
создать целый вокальный ансамбль с различными эффектами и плагинами, применяемыми к различным 
частям гармонии. Это особенно полезно, например, в том случае, если вы хотите применить компрессор к 
голосам перед их тональным понижением, чтобы сгладить их и разместить позади ведущего вокала. Блок-
схема ниже демонстрирует эту концепцию.  
 

 
 

Примечание: установите вспомогательные входные каналы в оба экземпляра ReaComp в значение 
none, используйте основные входные порты для управления этими компрессорами. 
 

Таким образом: 
 
- вокальный трек назначается на шесть каналов. 
- вставляются два экземпляра плагина ReaPitch, а сигнал с каналов 1 и 2 запитывается в оба из этих каналов. 
- выходной сигнал с двух экземпляров ReaPitch направляется через каналы 3 и 4 и 5 и 6 соответственно на 
два отдельных экземпляра ReaComp. 
-  в каждом случае, необходимо будет определить каналы 3 и 4 (ReaComp 1) и каналы 5 и 6 (ReaComp 2) в 
качестве источника входного сигнала для компрессоров. Вспомогательные входные каналы (aux) не 
задействуются, а выходные каналы должны совпасть с входными каналами. 
- выходной сигнал с двух компрессоров отсылается в один экземпляр ReaEQ, как и исходный сигнал каналов 1 
и 2. Для этого необходимо сделать входным каналом 1 каналы 1, 3 и 5 в ReaEQ, входными каналами 2 должны 
быть каналы 2, 4 и 6. 
- отсылая три различных аудиопотока непосредственно в ReaEQ мы исключаем необходимость в канальном 
микшере. Однако при этом усложняется настройка относительных уровней громкости этих трех аудиопотоков.  
В данном примере вы могли бы использовать отдельные экземпляры плагина JS utility Volume в каждой 
цепочке. 
- эти три потока объединены в ReaEQ, с которого они запитываются в фейдер громкости, а затем в мастер-
трек.  
 
Этот способ может использоваться, например, в тех случаях, когда вы хотите использовать более 16 каналов, 
которые могут быть обработаны любым из плагинов микшера. Фактически можно использовать до 64 каналов. 
Опять же, важен порядок эффектов в цепочке. Одна из возможных стратегий заключается в том, чтобы 
вставить эффекты в обратном порядке их каналов. Критическим фактором является размещение тех 
эффектов, которые и принимают их входной сигнал из и направляют их выходной сигнал в каналы 1/2 после 
любых эффектов, выходной сигнал которых направляется в сайдчейн каналы (такие как 3/4 или 5/6). 

 
Совет: если вы забываете создавать нужные каналы трека прежде, чем загрузить плагины в цепочку 
эффектов трека, можно все еще добавить их "на лету". Для этого просто щелкните по маленькой 
кнопке + в левом нижнем углу окна Plug-in Pin Connector (как на рисунке ниже). 
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17.6. Типы посылов REAPER 
 
Каждый посыл определяется одним из трех типов - Post-Fader (Post-Pan), Pre- Fader (Post-FX), или Pre-FX. 
Тип по умолчанию - Post-Fader (Post-Pan), но его может изменить на странице предварительных настроек 
(страница Options > Preferences > Track/Sends defaults). В аудиопотоке различные типы посылов отсылают 
аудиосигнал на различных этапах. Например, громкость посыла Post-Fader (Post-Pan) будет затронута 
изменениями, внесенными в исходный фейдер громкости трека. Pre-Fader (Post FX) посыл не будет затронут 
изменениями, внесенными в исходный фейдер громкости трека. Pre-FX посыл не будет затронут никакими 
эффектами в исходной цепочке эффектов трека. См. также блок-схемы в конце Главы 6. 
 

17.7. Дакинг аудиопотока 
 
Следующий пример иллюстрирует, как использовать технику sidechain для создания эффекта, известного как 
дакинг (ducking). Проще говоря, это то, что происходит, когда компрессор устанавливается так, чтобы 
гарантировать, что громкость на одном треке автоматически понижается каждый раз, когда громкость на 
другом треке поднимается. Это может пригодиться, например, при работе с бочкой и басом. В данном примере 
мы будем использовать треки Bouzouki, Guitar и Vocal в нашем демонстрационном проекте, только для того, 
чтобы показать вам, как достигнуть этого эффекта. Эффект «дакинг» мы будем использовать так, чтобы 
гарантировать, что суммарная громкость инструментов будет автоматически понижаться каждый раз при 
появлении сигнала с трека Vocal. Это поможет приподнять вокальный трек немного над миксом. Для этого, мы 
будем использовать мультиканальную маршрутизацию вместе с компрессором ReaComp. Диаграмма ниже 
иллюстрирует концепцию того, как мы будем использовать сайдчейн для достижения эффекта «дакинг». 

 
Пример: 
 
1. Откройте проект All Through The Night.RPP и сохраните его под именем All Through The Night DUCK.RPP. 
2. Удалите все треки кроме треков Gtr Body, Gtr Neck, Vox и Bouzouki. Отрегулируйте громкость и панораму 
этих треков по усмотрению. 
3. Если необходимо, измените порядок треков так, чтобы трек Vox был первым треком, трек Gtr Body вторым 
треком, трек Gtr Neck третьим треком и трек Bouzouki четвертым треком. 
4. На панели треков выберите трек Vox и нажмите Ctrl+T, чтобы вставить новый трек после этого трека. 
Именуйте новый трек Instrument Submix. 
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5. Щелкните по значку папки, чтобы сделать этот трек трек-папкой. Сделайте трек Bouzouki последним треком 
в трек-папке. 
6. Необходимо добавить еще два канала в трек-папку Instrument Submix так, чтобы он мог получать сайдчейн 
сигнал с трека Vox. Щелкните правой кнопкой по фейдеру громкости этого трека, а затем установите 
количество каналов в 4 (как показано на рисунке ниже). 
 

 
 
7. Теперь нужно создать сайдчейн, чтобы позволить другому инструментальному треку и треку Instrument 
Submix распознать уровень сигнала трека Vox. 
8. Перетащите кнопку ROUTE трека Vox на кнопку ROUTE трека Instrument Submix. Это создаст посыл и 
откроет окно контроллеров для этого посыла. Оставьте тип посыла по умолчанию - Post Fader, Post Pan и 
установите каналы адресаты в 3/4 (как показано на рисунке ниже). 
 

 
 
9. Затем, откройте окно эффектов трек-папки Instrument Submix. Вставьте плагин Cockos VST: ReaComp 
(Cockos). 
10. Заметьте, что этот плагин включает элемент Detector input - контроллер с помощью которого мы 
устанавливаем управление уровнем трека Vox, а не уровнем трека Bouzouki. Detector input включает две 
основные опции - Main Input и Auxiliary Input. 
11. Необходимо гарантировать, что опция Main Input будет определена в качестве клипа на треке Submix 
(каналы 1 и 2), а опция Auxiliary Input определена в качестве потока, прибывающего из трека Vox на каналы 
3 и 4. 
12. Нажмите кнопку 4 In 2 Out и установите следующие значения Main Input L - Receive from Channel 1, Main 
Input R - Receive from Channel 2, Auxiliary Input L - Receive from Channel 3, and Auxiliary Input 4 - Receive 
from Channel 4. Настройки, показанные на рисунке ниже, по всей вероятности, будут настройками по 
умолчанию. 
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13. Теперь откройте выпадающий список Detector Input и выберите Auxiliary Input L + R (рисунок ниже).  
 

 
 
Это гарантирует, что компрессия будет применена к инструментальному миксу в ответ на изменения громкости 
поступающего сигнала с каналов 3/4 с трека Vox. Когда громкость голоса превысит порог, инструментальный 
микс будет сжиматься. 
14. Теперь воспроизведите проект. Отрегулируйте параметр Threshold (первый вертикальный фейдер) так, 
чтобы во время звучания вокала индикатор уровня громкости достиг максимума выше уровня фейдера. 
15. Отрегулируйте фейдер Ratio по усмотрению. Вероятнее всего, значение будет где-нибудь между 4:1 и 6:1. 
Понаблюдайте за светящейся красной полосой налево от индикатора выходного сигнала. Она указывает на 
степень сокращения на треке подмикса. На рисунке ниже это значение -2.5 db. 
16. Отметьте, что происходит здесь: сигнал громкости с одного трека (вокала) инициирует применение 
компрессора инструментальной трек-папки. 
17. Сохраните файл. 
 
На рисунке ниже показаны возможные настройки компрессора, которые могли бы подойти в данном случае. 
Описанный выше пример призван не выпятить компрессию, а инициировать небольшую компрессию пиков 
инструментального микса, чтобы обеспечить место для вокала. 
 

 
 

Совет: быстрый способ создать сайдчейн с одного трека в другой - перетащить кнопку ROUTING этого 
трека непосредственно в окно плагина трека-адресата. 
 

17.8. Использование VCA группировки для управления громкостью трека 
 
В Главе 5 мы познакомились с возможностями VCA группировки REAPER. Кроме того, есть VCA плагины 
компании JS, которые позволяют использовать один трек для управления громкостью любого другого трека 
или несколько треков. JS Utility VCA плагины позволяют вам сделайте это без необходимости создавать 
группы или трек-папки, позволяя управлять громкостью любого из выбранных треков. Они просты в 
использовании и обеспечивают дополнительную гибкость. Необходимо два плагина - один для управления 
мастер-треком, другой для каждого дочернего трека, которыми управляет мастер-трек. В данном примере мы 
будем использовать собственные плагины JS REAPER: 
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Пример: 
 
1. Откройте файл All Through The Night и сохраните его под именем All Through The Night JSVCA. Добавьте 
пустой трек в проект. Именуйте этот трек VCA Master. 
2. Добавьте плагин JS: Utility/vca_master в цепочку эффектов этого трека. Как вы видите на рисунке ниже, у 
плагина только один параметр - Volume. 
 

 
 
3. Добавьте плагин JS: Utility/vca_slave в первый из треков, громкостью которых вы хотите управлять, Т.е. 
трек Gtr Neck. У этого плагина также простой интерфейс. Этот плагин должен быть последним в цепочке 
эффектов трека. 
4. Теперь необходимо создать посыл с управляющего трека в этот дочерний трек. Самый легкий способ 
сделать это - просто перетащить кнопку ROUTE управляющего трека на панель дочернего трека.  
При этом откроется окно контроллеров посыла (как на рисунке ниже). Убедитесь, что вы выбрали сайдчейн 
каналы дочерних треков (на рисунке это каналы 3/4) в качестве адресатов посыла. 
 

 
 
5. Повторите шаги 3 и 4 для трека Gtr Body. После этого трек Gtr Body будет управляться плагином 
vca_master на мастер-треке VCA. 
6. Теперь можно использовать фейдер Volume плагина vca_master для управления громкостью всех дочерних 
треков. Не лишним будет добавить контроллер параметра на панель трека. Для этого, в окне плагина нажмите 
сначала кнопку Param, затем кнопку Show in track controls. Это позволит вам управлять параметром не 
открывая окно эффекта (см. рисунок ниже).  
 

 
 
Другая опция заключается в добавлении огибающей автоматизации для этого контроллера. 
 
7. Чтобы отобразить контроллер параметра трека на панели микшера, просто активируйте опцию Show FX 
parameters when size permits в контекстном меню микшера. Для получения дополнительной информации см. 
Главу 11. 
8. Отметьте также, что на параметр Volume трека VCA master control можно также назначить огибающую 
автоматизации. Для получения дополнительной информации об огибающих автоматизации см. Главу 18. 

 
Примечание: плагины Witti VCA: плагины Witti VCA схожи с версиями плагинов JS REAPER, основное 
различие заключается в добавлении выпадающих списков, которые позволяют вам легко выбрать пару 
каналов для посылов и адресатов. Используя различные перестановки посылов и адресатов, вы можете 

установить несколько экземпляров плагина VCA master control. Они могут использоваться независимо друг от 
друга для управления громкостью различных выбранных треков. 
 
 
 
 
 



 Специально для сайта musicmanuals.ru  379 379 

17.9. Мультиканальные VSTi плагины 
 
Возможно эти функции для настройки мультиканальных VSTi плагинов вы будете использовать только один или 
два раза, но определенно они заслуживают потраченного на их изучение времени. Это даст вам куда большее 
понимания внутренних процессов REAPER по сравнению с простой загрузкой шаблона трека. 
 
Пример 1: Спаренные аудиотреки: 
 
1. Щелкните правой кнопкой по пустой области панели трека, и выберите из меню опцию Insert virtual 
instrument on new track. 
2. В окне браузера эффектов дважды щелкните по нужному инструменту. В данном примере используется  
8-канальная версия синтезатора Grizzly (4 стереоканала), но вы можете использовать любой мультиканальный 
инструмент по усмотрению. 
 

3. В окне подтверждения о выборе 
соответствующего количества треков, созданных 
для конкретного выбранного инструмента (см. 
рисунок слева) нажмите Yes. 
 
 
 
 
 
 
 
 

4. REAPER вставит инструмент в цепочку эффектов исходного трека, именует его и активирует для записи, а 
также создаст все дополнительные треки. 
 

 
 
 
5. Теперь у вас есть трек с одним входным MIDI каналом для VSTi наряду с четырьмя треками с выходными 
аудиоканалами. Обратите внимание, что в данном примере: 
 
- каналы 1/2 с трека #1 направлены в трек #2, каналы 3/4 в трек #3, каналы 5/6 в трек #4 и каналы 7/8 в трек #5. 
- выходной сигнал с трека #1 в мастер-трек не отсылается. 
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6. Теперь вы готовы к загрузке ваших инструментов (в данном примере, выбрана ударная установка). 
 
Пример 2: Раздельные MIDI треки: 
 
Если вы хотите, чтобы для каждого выходного канала VSTi был отдельный MIDI трек, рассмотрите способ, 
описанный ниже. Здесь мы также будем использовать синтезатор Grizzly. 
 
1. Создайте новый трек и дайте ему имя. Откройте окно эффектов трека и добавьте нужный VSTi в цепочку 
эффектов трека. 
2. В окне эффектов в меню Options выберите опцию Build 16 channels of MIDI routing to this track. 
3. Теперь у вас есть отдельный MIDI трек для каждого канала. Выходной MIDI канал каждого из этих 16 треков 
отсылается в трек, в который вы изначально вставили VSTi. Доступно несколько опций, которые помогут вам 
управлять этим набором треков. Например, можно поместить MIDI треки в одну трек-папку, именовать ее, 
окрасить треки и скрыть их в микшере. Активировать ввод с клавиатуры для отдельных MIDI треков: 
 
- убедитесь, что трек с VSTi не активирован для записи. 
- выберите все 16 MIDI треков. 
- щелкните правой кнопкой мыши по кнопке Record Arm и активируйте кнопку Input Monitoring для всех 16 
треков. 
- для каждого трека, установите входной MIDI канал, от 1 до 16. 
 
 

17.10. Использование родительских каналов 
 
Родительские каналы определяют установку каналов 
дочернего трека, к которому каналы направляются на его 
родительском треке. Например, в восьмиканальной трек-
папке, включающей два дочерних трека по четыре канала 
на каждом, вы могли бы направить один выходной канал 
одного из дочерних треков в каналы 1-4 трек-папки, а 
другой в каналы 5-8 трек-папки. Это дало бы вам 
аудиосигнал на всех восьми каналах родительского трека. 
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17.11. Параллельная обработка эффектов канальными микшерами 
 

Параллельная обработка эффектами состоит из 
разделения сигнала на отдельные цепочки и 
применение различных эффектов отдельно к этим 
цепочкам вместо применения одного эффекта за другим 
в одной цепочке. Ранее в этой главе эта техника 
использовалась с вокалами. Данный параграф 
продвигает эту идею далее, включая дополнительные 
каналы и позволяя установить панораму, а также 
уровень громкости для управления каждым каналом по-
отдельности. Мы будем использовать плагин IX/Mixer 
8xM-1xS, который раскрывает дополнительные 
возможности для разделения и маршрутизации 
аудиосигнала через различные каналы, а затем 
микширования их назад в итоге, чтобы создать 
действительно креативные звуки и эффекты. Основное 
различие между этим микшером и тем, который вы 

использовали ранее - работа с отдельными моноканалами. Пример ниже иллюстрирует, как этот микшер может 
устанавливаться и использоваться. После ознакомления с этим примером вы сможете использовать этот 
микшер для собственных проектов. 
 
Пример: 
 

 
 
В данном примере мы направим выходной сигнал с одного инструментального трека по отдельности в эффекты 
Distortion и Reverb, а затем смешаем необработанные и обработанный сигналы вместе, панорамируя их как 
нужно - и все это в пределах одного единственного трека и не используя шины. Для этого мы будем 
использовать плагин IX Mixer 8xM вместе с некоторыми другими плагинами поставляемые с REAPER. Блок-
схема в начале параграфа концептуально иллюстрирует, чего мы собираемся достичь: мы запустим сигнал 
параллельно в два эффекта. При этом мы обеспечим отдельную обработку каждого эффекта перед 
микшированием. Это отличается от типичной цепочки эффектов, которая обрабатывает эффекты 
последовательно. 
 
1. Откройте файл All Through The Night. RPP и сохраните его под именем All Through The Night IX MIX. Rpp 
2. Мы будем работать только с треком Bouzouki. Солируйте этот трек. 
3. Откройте окно маршрутизации трека Bouzouki. Установите количество каналов трека в 6, а затем закройте 
окно. 
4. Откройте окно эффектов этого трека. Если в этом треке присутствуют какие-либо эффекты, удалите их. 
5. Вставьте плагин JS: Guitar Distortion. Прежде всего, установите параметры плагина примерно, как на рисунке 
выше, но обратите внимание на примечание ниже. 

 
Примечание: в данном случае, в шаге 5 необходимо отрегулировать параметры плагина прежде чем вы 
откроете и будете использовать окно pin connector. Это вызвано тем, что вы не сможете услышать или 
контролировать любой выходной сигнал, посланный в каналы 3 и 4 потом, когда добавите канальный 

микшер в цепочку эффектов. 
 
6. Убедитесь, что входной сигнал поступает только с каналов 1 и 2, а выходной сигнал направлен только на 
каналы 3 и 4 (см. на рисунок выше). 
7. Теперь вставьте плагин ReaVerbate в цепочку эффектов трека Bouzouki. 
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8. Выберите пресет, отрегулируйте уровни параметров wet/dry по усмотрению, а затем выберите опцию Output 
to Channels 5/6 (см. рисунок ниже). 
 

 
 
9. Теперь вставьте плагин JS: IX/Mixer_8xM-1xS в конец цепочки эффектов трека Bouzouki. 
10. Воспроизведите песню и поэкспериментируйте с уровнями громкости и панорамированием различных 
каналов. Поэкспериментируйте с параметрами эффектов. Один из возможных результатов показан на рисунке 
ниже. 
 

 
 
11. Отключите солирование трека Bouzouki. Отрегулируйте фейдер трека, чтобы смикшировать его в общий 
микс. По окончании сохраните файл.  
 
Это очень простой пример. Фактически у вас может быть до четырех отдельных цепочек эффектов, 
функционирующих параллельно в пределах этого трека. В связи с этим очень легко перемещать эффекты с 
одной цепочки в другую, всего лишь изменяя ее выходные каналы. 
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17.12. Еще один пример параллельной обработки эффектов 
 
Пример, рассмотренный выше, демонстрирует простейшую параллельную обработку эффектов. 
Экспериментируя с этой функцией можно точно сформировать ваши звуки так, как вы хотите. Можно, например, 
добавить дополнительные плагины в ваши цепочки и/или использовать более шести каналов. После этого все 
три потока смешиваются вместе, используя канальный микшер. Пример: каналы 1 и 2: - исходный сигнал, 
необработанный сигнал. Каналы 3 и 4: дисторшн затем компрессор. Каналы 5 и 6: эквалайзер, затем 
ревербератор. 
 

17.13. Разделение каналов и параллельная обработка с эффектами копии клипа 
 
Примеры, используемые в этой главе, включают работу с плагинами в цепочках эффектов трека. Однако, не 
забывайте, что любые отдельные клипы или копии могут также иметь свою собственную цепочку эффектов, 
конкретно вставленную в этот клип или копию. Эффекты копии клипа подробно объясняются в Главе 6: если 
коротко, можно выбрать любые клипы и нажать Shift+E, чтобы создать цепочку эффектов для данного клипа. 
Если для трека, включающего клип, было определено необходимое количество каналов, разделение каналов и 
параллельная обработка эффектов могут быть применены к отдельным клипам точно таким же образом, как 
объяснено в этой главе. 
 

17.14. Отправка выходного сигнала эффектов в другой трек 
 
Возможности маршрутизации 
REAPER позволяют направить 
выходной сигнал эффектов 
непосредственно с одного трека 
в другой (или другие). 
Возможности здесь почти 
безграничны: вот всего один 
простой возможный пример. В 
данном примере трек 1 включает 
несколько эффектов. Первый из 
них - ReaDelay, выходной сигнал 
которого направлен в другую 
пару каналов, кроме 1/2 (в 
данном случае 3/4). Используя 
способ маршрутизации 
перетаскиванием, этот выходной 
сигнал можно затем направить 
непосредственно на каналы 1/2 

(или любые другие каналы) любого другого трека или треков. Обратите внимание на то, что, пока их выходной 
сигнал направлен на каналы 1/2, другие эффекты будут применены только к треку 1. 
 

17.15. Другие плагины маршрутизации канала (краткий обзор) 
 
Список плагинов Jesusonic и Cockos для REAPER - впечатляющий и постоянно увеличивается. Список ниже 
предоставляет обзор некоторых доступных плагинов маршрутизации канала. Данный параграф познакомит вас 
с некоторыми другими плагинами (не используемых в примерах), которые специально предназначены для 
использования в многоканальной окружающей среде маршрутизации. Очевидно, что эти плагины должны 
использоваться только на треках, у которых больше одной определенной пары каналов. 
 
IX Switcher: утилита переключения каналов. Параметр Output Source используется для выбора одного из 
четырех спаренных входных каналов, которым необходимо управлять. 
IX Switcher 2: вариант утилиты IX Switcher. Параметр Output Source используется для выбора одного из 
четырех спаренных входных каналов, которым необходимо управлять, а фейдеры Level позволяют 
отрегулировать усиление независимо для каждой пары. 
IX SwitchMitch: утилита для кроссфейдинга, которая позволяет запитать до четырех пар входных каналов на 
две шины, а затем смикшировать эти шины на выходные каналы 1+2. Адресат для каждого из четырех 
объединенных входных каналов можно установить в значение Off, A, B, или A+B. 
IX PhaseAdjustingRouter: принимает сигнал с пары входных каналов и изменяет фазу согласно выбранному 
режиму. Затем измененный сигнал выводится на выбранные выходные каналы. Таким образом могут быть 
изменены только выбранные выходные каналы, так, например, сигнал, полученный с входных каналов 1+2, и 
выведенный на каналы 3+4, будет все еще присутствовать в его исходной форме в выходных каналах 1+2. 
Параметр Input позволяет выбрать спаренные каналы, используемые для входного сигнала. Параметр Phase 
Mode может быть установлен в значение No Change, Invert Left Channel Only, Invert Right Channel Only или 
Invert Both Channels. Параметр Output выбирает выходные каналы. 
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17.16. Интерфейс маршрутизации REAPER 
 

При использовании мультиканальных треков, посылов и 
адресатов (как во многих примерах в этой главе), 
необходимо держать матрицу маршрутизации всегда на 
виду. Матрицу маршрутизации можно использовать для 
внесения изменений в любой посыл и адресат, или для 
определения количества каналов, требуемых для любого 
трека. Щелкните правой кнопкой по любому имени трека 
(как показано на рисунке слева), чтобы открыть окно 
маршрутизации трека и изменить количество каналов 
трека или отрегулировать параметры любого посыла или 
адресата, связанного с этим треком.  
 
 
 
 
 
 
 
 
 
 
 

 
Щелкните правой кнопкой по 
адресату/посылу любого пересечения в 
матрице маршрутизации, чтобы 
отрегулировать любой из параметров этого 
посыла или адресата (как показано на 
рисунке слева).  
 
 
 
 
 
 
 
 

 
Щелкните по любому свободному пересечению в матрице маршрутизации, чтобы создать посыл/адресат в этой 
точке. Помните, конечно, что можно также создавать, удалять и управлять посылами и адресатами на панели 
трека и панели микшера. В любом случае можно нажать кнопку ROUTING любого трека, чтобы отобразить окно 
маршрутизации этого трека, или щелкнуть правой кнопкой по кнопке ROUTING и использовать вспомогательное 
выпадающее меню и легко добавить посыл или адресат. 
 

Совет: посылы можно скопировать в матрице маршрутизации с одного трека в другой. Например, если 
вы создали посыл из трека 1 в шину эффектов трека 6, можно просто создать подобные посылы из 
других треков, перетащив этот посыл вверх и вниз по столбцу матрицы. 
 
Заметьте также, что в матрице маршрутизации три типа посылов представлены тремя различными 
символами. Это Pre Fader (Post FX), Post Fader (Post Pan) и Pre FX. В каждом случае индикатор 
указывает на уровень громкости посыла.  
 
 

 
17.17. Плагин ReaSamplomatic и шаблон ReaDrums 

 
На данном примере мы рассмотрим плагин ReaSamplomatic, поставляемый с REAPER вместе с шаблоном 
трека ReaDrums, созданным пользователем jamester. Этот шаблон можно загрузить с REAPER Stash на сайте 
REAPER. После загрузки шаблона его необходимо скопировать в вашу папку Track Templates. Для 
пользователей XP это папка C:\Documents and Settings\User Name\Application Data\REAPER\TrackTemplates. 
Шаблон время от времени изменяется, поэтому загруженная версия может не совпадать с используемой в 
описании. Но это не важно. Кроме того, в демонстрационных целях в данном примере мы будем использовать 
MIDI редактор, но, если у вас есть клавиатура, можно использовать и ее. 
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Пример: 
 

 
 
1. Создайте новый пустой проект и сохраните его под именем ReaDrums Example.RPP 
2. Щелкните правой кнопкой по области панели трека, и выберите из меню опцию Insert track from template, а 
затем шаблон ReaDrums. Заметьте, что трек будет вставлен с восемью отдельными именованными 
экземплярами плагина ReaSamplOmatic5000, вставленного в его цепочку эффектов. 
3. Обратите внимание, что каждый экземпляр ReaSamplOmatic5000 сконфигурирован по-разному: Kick, Snare, 
Perc 1, Perc 2, Perc 3, Perc 4, HH Cl, HH Op. В левом нижнем углу можно выбрать MIDI канал для каждого 
сэмпла. Значение по умолчанию 0, что означает все каналы. В данном примере малый барабан (Snare) 
установлен на канал #1. На рисунке также вставлен аудиосэмпл. Это - следующий шаг! 
4. Откройте браузер клипов - Ctrl+Alt+X - и выберите папку с вашими сэмплами. 
5. В окне эффекта ReaDrums выберите элемент Kick. Из окна браузера клипов REAPER можно перетащить 
мышью нужный сэмпл в окно ReaSamp в черную область выше кнопки Browse. Альтернативно, можно либо 
использовать кнопку Browse плагина, чтобы сделать выбор, либо выбрать любой существующий клип в 
области аранжировки и нажать Import item from arrange.  
Или можно нажать кнопку [list], чтобы открыть окно для создания списка сэмплов, который можно отсортировать 
по имени файла или по значениям RMS или peak. 
6. Теперь повторите этот процесс для остальных семи экземпляров ReaSamp, для каждого вставив 
соответствующий сэмпл. При необходимости переименуйте любой из экземпляров ReaSampl-Omatic5000. 
7. Заметьте, что каждый экземпляр ReaSamplOmatic5000 использует различные значения параметров Note 
start и Note end. Это позволяет нотам (и любым другим событиям) различных инструментов совместно 
использовать один MIDI клип. 
8. Убедитесь, что трек ReaDrums не активирован для записи. Сохраните файл. 
9. Выделите на шкале времени первые 10 секунд или около этого. С выбранным треком ReaDrums перейдите 
Insert > New MIDI Item, чтобы вставить MIDI клип. 
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10. Дважды щелкните по этому клипу, чтобы открыть MIDI редактор. Перейдите View > Piano Roll Notes > 
Triangle и View > Mode > Named notes.  
Для каждого сэмпла его номер строки будет соответствовать его параметрам ReaSamplOmatic5000 Note start и 
Note end. Например, в этом случае малый барабан (показанный выше) будет строкой 37. 
11. Запишите несколько нот, как на рисунке ниже. Не копируйте этот паттерн, а сделайте простую собственную 
композицию. 
12. Закройте MIDI редактор и сохраните ваш файл. 
 

 
 
13. При необходимости можно также использовать маршрутизацию каналов REAPER, чтобы отослать 
различные части в различные треки, где можно добавить эффекты, отрегулировать панораму, громкость, и т.д. 
Давайте предположим, что мы хотим применить некоторые эффекты к бочке и малому барабану 
индивидуально. Щелкните правой кнопкой по фейдеру громкости трека ReaDrums и установите количество 
каналов в 4. Мы начнем с одного или двух. 
13. Нажмите Ctrl+T дважды, чтобы добавить еще два трека. Именуйте первый из них Kick, второй Snare. 
14. На треке ReaDrums установите количество каналов в 4 и создайте посыл в новый трек Kick (используя 
канал 3) и в трек Snare (используя канал 4). 
15. Откройте окно эффектов трека ReaDrums. 
16. Выберите первый экземпляр ReaSamplomatic5000 Kick. Установите оба VST в Outs to Channel 3. 
17. Выберите экземпляр Snare ReaSamplomatic5000 и установите оба VST в Outputs to Channel 4. 
18. Воспроизведите проект. Заметьте, что сигнал с треков Kick и Snare перенаправлен в их соответствующие 
треки. Теперь вы можете вставить любые эффекты в окно эффектов этих треков. Сохраните файл. 
19. Если вы добавляете дополнительные каналы к исходному треку ReaDrums, можно повторить этот эффект 
для любых других ударных инструментов. 
 

Совет: если вы загрузили шаблон трека ReaDrums Rack с форума REAPER, вы обнаружите, что в этом 
шаблоне все отдельные треки, наряду с их маршрутизацией, уже сконфигурированы. 
 

ReaSamplOmatic5000 - очень мощный и гибкий компонент программного обеспечения. Его возможности и 
применение распространяются далеко за пределы простого примера, обрисованного в общих чертах выше, и 
вне объема данного Руководства пользователя. Например: 
 
- у каждого экземпляра ReaSamplOmatic5000 есть свой собственный независимый набор контроллеров 
(volume, pan, pitch bend, attack, sustain, release, decay, и т.д.). 
- изменения, внесенные в параметры attack, delay, sustain и/или release будут представлен графически (в виде 
огибающих), которые наносятся на сигналограмму сэмпла в окне ReaSamplOmatic5000. 
- контроллер Max Voices может использоваться для выбора количества голосов от 1 до 16. Однако, если вам 
нужны больше 16-ти голосов, можно ввести любой номер до 128. Это, например, позволяет 
ReaSamplOmatic5000 использоваться с райд тарелками. Заметьте также, что количество активных голосов 
отображается во время воспроизведения рядом со значением параметра. 
- для большинства контроллеров можно создать огибающие автоматизации в области аранжировки и/или 
управлять ими используя модуляцию параметров. Эти темы подробно объясняются в Главе 17 и Главе 18. 
Reasamplomatic5000 может показаться сложным для новичков и требует общего понимания спецификации MIDI 
и понятия сэмплирования. 
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17.18. Round-Robin мультисэмплинг 
 
Опция round-robin вместе с параметром Probability может использоваться для определения, как будет 
воспроизводить какой-либо данный плагин звук с какой-либо данной ноты. Например, в значении 100% плагин 
будет воспроизводить каждую ноту. В значении 50% плагин будет игнорировать каждую вторую ноту. Это может 
использоваться для внесения вариаций в ваши сэмплированные звуки. Рассмотрим пример, где используется 
отдельный трек для каждого ударного инструмента - бочка, малый барабан, и т.д. На рисунке ниже показана 
простая аранжировка трека Snare, с двумя экземплярами плагина ReaSampllOmatic5000, каждый из которых 
включает отдельный сэмпл малого барабана.  
 

 
 
Для обоих экземпляров активированы опции Round-Robin и Remove played notes from FX chain MIDI stream. 
Параметр Probability экземпляра Snare1 установлен в значение 50%, а для экземпляра Snare2 в значение 
100%. Это гарантирует, что при воспроизведении каждый из этих двух экземпляров (и таким образом два 
сэмпла) будут использоваться поочередно. Если бы в этом примере у вас было три сэмпла, а не два, то 
параметр Probability был бы установлен в значение 33% (1 в 3), 50% (1 в 2) и 100% (1 в 1) соответственно. Для 
четырех сэмплов эти значения были бы 25% (1 в 4), 33% (1 в 3), 50% (1 в 2) и 100% (1 в 1), и так далее. 
Возможны и более сложные вариации. Например, плагин JS: MIDI/midi_choke может использоваться вместе с 
плагином ReaSamplOmatic5000 чтобы определить, как будет воспроизводиться звук с данной ноты. Пример это 
иллюстрирующий можно найти здесь: http://forum.cockos.com/showpost.php?p=1278385&postcount=28. Диаграмма 
ниже показывает различные значения параметра Probability при использовании различного количества 
сэмплов. Опция Remove played notes from FX chain в любом случае должна быть активирована на всех 
экземплярах кроме последнего. 
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17.19. MIDI маршрутизация: MIDI каналы, посылы трека и MIDI шины 
 
17.19.1. Запись через MIDI каналы 
 
Если играя на вашей MIDI клавиатуре вы не слышите звука, исходящего из REAPER, (предполагая, что 
клавиатура включена и подсоеденена к вашему компьютеру или к звуковой карте), скорее всего имеет место 
одно (или несколько) нижеперечисленных обстоятельств: 
 
- MIDI клавиатура не установлена в REAPER. Подробнее об этом в главе "Конфигурация MIDI параметров". 
- Канал, используемый вашей клавиатурой в качестве выходного MIDI канала, не соответствует каналу, 
выбранному на треке REAPER в качестве входного MIDI канала. Иногда это упоминается как несоответствие 
каналов. 
- Трек REAPER не активирован для записи. 
- Мониторинг входного сигнала не активирован 
 
Практически все, кроме некоторых самых дешевых MIDI клавиатур, позволяют выбрать канал для 
использования в качестве выходного MIDI канала. Большинство используют по умолчанию канал №1. 
Обратитесь к документации вашей по вопросу выбора MIDI канала (от 1 до 16) в качестве выходного.  
 

 Чтобы выбрать MIDI канал в качестве входного, 
сначала щелкните правой кнопкой мыши на панели 
управления трека по области, показанной на рисунке 
слева. Затем необходимо выбрать (из меню) входной 
MIDI канал, затем устройство (на представленном 
рисунке ниже, это Audiobox), затем выбрать канал или 

все каналы (all channels).  
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Мониторинг входного сигнала можно активировать из 
того же меню. Запись активируется щелчком на 
красной кнопке слева от имени трека. В некоторых 
инструментальных плагинах (например, в Kontakt или 
SampleTank) вы можете выбрать любой канал из 16 
MIDI каналов для каждого загруженного инструмента: 
Обратитесь за подробностями к руководству 
пользователя плагина. То же самое касается 
некоторых плагинов эффектов (например, от 
MeldaProduction, где MIDI может использоваться для 
автоматизации параметров плагина). Подробности в 
главе "Чек-лист записи MIDI с MIDI клавиатуры". 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
17.19.2. Маршрутизация с MIDI каналами 

 
 В главе "Основы маршрутизации REAPER" объясняются 
посылы трека в REAPER. На данном этапе можете 
обратиться к этой главе. Те же самые принципы 
применяются при маршрутизации как аудио, так и MIDI 
данных из одного трека в другой. Вы можете отсылать 
данные из любого канала (или всех каналов) на одном 
треке в любой канал (или все каналы) на другом треке. 
На рисунке ниже, маршрутизация перетаскиванием (от 
кнопки Routing посыла трека в трек-адресат на панели 

управления трека) используется для посыла MIDI данных из трека 4 канала 3 в трек 5 канал 1. Обратите 
внимание: аудиопосыл установлен в значение None. 
 
17.19.3. MIDI шины 
 
VSTi плагины могут принимать MIDI сигнал на любом из 16 MIDI каналов. Однако вы не можете установить 
плагин на принятие (функция «listen to») MIDI данных на определенном канале. Один из способ это обойти 
заключается в использовании MIDI шин. Вы можете отсылать MIDI данные с клавиатуры на определенный канал 
на треке, а затем отсылать его оттуда в MIDI шину на треке с VSTi плагином и отсылать данные в этот VSTi 
плагин, выбрав MIDI шину для входного сигнала. Вы можете также направить MIDI сигнал на конкретный канал, 
или оставить канал без изменений а затем сконфигурировать плагин на получение MIDI сигнала на этой 
выбранной шине. Таким образом использование MIDI шин открывает дополнительные опции роутинга. MIDI 
данные можно отсылать и получать через любой канал на любой из 16 MIDI шин, пронумерованных от 1 до 16: 
MIDI данные из этой шины можно непосредственно отправть в инструментальный плагин на другом треке. 
Отметим некоторые моменты, которые необходимо иметь в виду: 
 
- MIDI шина 1 используется плагином MIDI Control Path для посылов MIDI канала и по умолчанию для входного 
канала инструментального плагина. 
- Плагины MIDI управления, такие как ReaControlMIDI и MIDItoReaControlPath могут принимать MIDI данные из, и 
отсылать данные в MIDI шину. VSTi плагины могут получать MIDI данные из MIDI шины, но на выходе 
генерируют аудиосигнал. 
- Любое количество комбинаций трека/канала можно отсылать данные в MIDI шину. 
- Данные из MIDI шины можно отослать в различные VSTi плагины на том же самом треке, или опосредственно 
в VSTi плагины на других треках. На рисунке ниже приведен относительно простой пример. Здесь мы имеем 
четыре трека, которые содержат MIDI данные и трек синтезатора, который содержит два VSTi плагина. 
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Мы можем создать посылы и любого трека данных в, скажем, шину 2 трека 5, выбрав посыл из диалогового окна 
Шину 2 в качестве адресата выходного сигнала и любой канал. В данном примере мы отсылаем из трека 1 
канал 4 в канал 4 (2/4) шины 2. Теперь предположим, что мы также создали посыл из трека 2 в шину 2 и из 
обоих треков 3 и 4 в шину 3. В последнем случае оба посыла направлены в тот же самый канал, канал 1 (т.е. 
3/1). Теперь мы можем открыть цепочку эффектов трека 5 и выбрать первый синтезатор. Щелкните на кнопке 
“2”, затем на кнопку I/O, затем кнопка MIDI Input позволяет нам выбрать MIDI шину 2, как показано на рисунке. 
Теперь мы можем отослать MIDI сигнал из шины 3 в другой синтезатор на этом треке. Для этого просто 
повторите вышеописанный процесс с этим синтезатором, выбрав MIDI шину 3 в качестве входного MIDI канала 
вместо MIDI шины 2. Мы можем усложнить этот пример, добавив другой трек с другим синтезатором. Давайте 
предположим, что мы хотим добавить данные с обеих MIDI шин в этот синтезатор. Выбрав B2 и B3 
соответственно в качестве источника посыла мы гарантируем, что все каналы в этих шинах задействованы. Они 
отосланы в шину 4 на треке-адресате (трек 6). Теперь очень легко установить MIDI шину 4 в качестве источника 
входного MIDI сигнала для синтезатора на треке 6. 
 

17.20. Дальнейшая маршрутизация сигнала VSTi плагина 
 
Тот же самый способ, который использовался ранее (Отправка выходного сигнала 
эффектов в другой трек) может использоваться для отправки выходного сигнала VSTi 
инструмента перед эффектами в другой трек, также оставляя эффекты на VSTi треке. 
Доступно множество возможностей, в том числе и следующий пример:  
щелкните по кнопке pin connector (маркированной “X out”, где X это количество 
каналов трека), и создайте дополнительную пару выходных каналов к еще двум 
каналам (в данном примере, это каналы 5/6). Затем можно создать посыл с каналов 
5/6 VSTi трека в другой трек. Выходной сигнал VSTi инструмента будет теперь 
направлен без эффектов трека в другой трек, а также (в данном примере) с 
эффектами трека в VSTi трек-хост. 
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17.21. Surround панорамирование с плагином ReaSurround 
 

 
 
Объемный звук - это сложная тема и подробное ее описание выходит бы за рамки данного Руководства 
пользователя. Возможности создания объемного звука в REAPER можно найти в трех главных областях: 
 
1. Способность записи в мультиканальном формате. Этот метод объясняется в Главе 3. 
2. Возможность маршрутизации каналов REAPER. 
3. Плагин ReaSurround. 
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Таким образом вот вопросы, касающиеся REAPER, о которых необходимо знать для создания surround звука: 
 
Запись: запишите каждый трек, используя параметры, наиболее подходящие для этого трека. Например, для 
ведущего вокала вы можете использовать двухканальный трек с одним входным монопортом (один микрофон). 
Для фортепьяно можно сделать стереозапись с двумя микрофонами. Для объемных звуков можно предпочесть 
четырехканальный трек с четырьмя входными каналами для четырех микрофонов. 
 
Маршрутизация: REAPER включает различные параметры маршрутизации. Например, можно добавить плагин 
ReaSurround в каждый трек отдельно, где сигнал с каждого из этих треков направлен непосредственно в 
мастер-трек. Другая опция состоит в том, чтобы создать посылы со всех треков в одну шину для микширования 
объемного звука и использовать в этой шине один экземпляр плагина ReaSurround, отключив прямые посылы с 
отдельных треков в мастер-трек. Этот способ обеспечивает большую гибкость и управления. Также необходимо 
будет сконфигурировать маршрутизацию выходных портов мастер-канала так, чтобы гарантировать, что из 
мастер-трека на surround динамики отсылался правильный сигнал. Возможный пример этой маршрутизации 5.1 
surround звука показан на рисунке ниже. 
 

 
 
Плагин ReaSurround: плагин ReaSurround, как и любой другой плагин, может быть вставлен в цепочку 
эффектов трека из браузера эффектов. В данном примере мы предполагаем, что вы выбрали метод вставки 
плагина ReaSurround в каждый трек. Обратите внимание на следующее: 
 
- необходимо поместить плагин ReaSurround в цепочку эффектов трека, зачастую в конец цепочки. Однако 
если, например, вы используете многоканальный эффект задержки, его вы скорее всего захотите поместить 
после плагина ReaSurround. 
- после вставки плагина ReaSurround выберите одну из опций из списка Setup (выше слева). Выберите ту же 
самую опцию для всех треков. Уровни входного сигнала и позицию можно установить и зафиксировать. 
- при выборе опции в списке Setup, автоматически в трек добавляются правильное количество выходных 
каналов. В данном примере, выбраны 5.1 surround, таким образом, треку выделено шесть каналов. 
- на рисунке ниже, двухканальный трек с моноклипом (Vox Mix) с двумя входными каналами, каждый с его 
собственным фейдером (который может быть установить в значение Gain или LFE), а также параметрами solo 
и mute. Чтобы переименовать порт, дважды щелкните по нему. 
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- поскольку выбран формат 5.1 surround, доступно шесть выходных каналов. Заметьте, что эти каналы могут 
солироваться и/или мьютироваться в любой комбинации. У каждого из них также есть его собственный фейдер: 
который также можно установить в значение Gain или Influence. 
 

 
 
- используйте коннекторы других эффектов трека, чтобы направить выходной сигнал этих эффектов в 
различные каналы по усмотрению. 
- необходимо также вставить плагин ReaSurround в конец цепочки эффектов мастер-трека. Чтобы 
сконфигурировать входные каналы, можно перетащить их по дисплею. Кроме того, в окне плагина ReaSurround 
есть два дополнительных набора контроллеров.  
 

Три выпадающих списка Edit и их соответствующие регуляторы могут 
использоваться в качестве контроллеров любыми тремя доступными элементами, 
как на рисунке ниже. Это контроллеры: Left/Right, Back/Front, Low/High, Back 
Left/Front Right, Front Left/ Back Right, Expand/Contract, Rotate, LFE Send, 
Diffusion Level and Diffusion Bias.  
 
 
 
 
 
 
 
 
 

Доступна также опция Lock input channel positions and levels (зафиксировать уровни и позицию входных 
каналов). Три фейдера Space size могут использоваться для настройки трех измерений surround окружения: 
Width, depth и height, а четвертый фейдер функционирует в качестве контроллера масштабирования. 
Контроллеры Inputs и Outputs могут использоваться для мьютирования, солирования и/или настройки 
параметров Gain или Low Frequency Effects (для входных каналов) или параметров Gain или Influence (для 
выходных каналов). На примере ниже, плагин Surround Panner вставлен в “нормальный” двухканальный трек с 
записанным моноклипом. Таким образом Surround Panner находит и отображает только два входных канала. 
Поскольку выбран формат 5.1 surround в качестве режима окружения, входной сигнал с двух каналов можно 
направить в шесть каналов. См. также Главу 21 и Параграф "Рендеринг в формат Surround". 
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17.22. Индикаторы уровня мультиканальных треков 
 

Когда трек включает больше 2-х каналов, можно выбрать на каком количестве 
треков (на всех или на каналах 1 и 2) будут отображаться индикаторы уровня 
громкости трека (на панели трека и панели микшера). Выберите (на панели трека 
или на панели микшера) трек или несколько треков, а затем в главном меню 
REAPER перейдите Track > Multichannel Track Metering. Это переключаемая 
опция: чтобы убрать мультиканальное измерение из трека, просто выберите трек 
и выберите эту опцию еще раз. На рисунке ниже эта опция отключена для 
первого трека и активирована для второго. 
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17.23. Маршрутизация в/из других приложений по ReWire 
 
Все примеры, которые мы рассматривали до сих пор, включали маршрутизацию аудио или MIDI данных в 
пределах REAPER. Теперь мы рассмотрим маршрутизацию вашей музыки в/из других приложений. 
Пользователи интерфейса ReWire обрадуются, узнав, что REAPER поддерживает протокол ReWire (версии 2.6). 
ReWire - это технология, совместно разработанная компаниями Propellerhead Software и Steinberg, которая 
позволяет приложениям совместно использовать аудио, MIDI данные и данные синхронизации. Аудио и MIDI 
данные передаются между двумя приложениями в режиме реального времени, позволяя использовать функции 
в каждом приложении, как будто они там и были. Функциональность ReWire автоматически инсталлируется с 
REAPER на платформе OS X. Пользователя Windows необходимо убедиться при установке REAPER, выбран 
протокол ReWire, и он активирован на странице Choose components мастера установки REAPER в секции 
Additional functionality. В сеансе ReWire первое приложение функционирует в качестве хоста, а второе в 
качестве подчиненного приложения. Адресаты и посылы подчиненного приложения передаются через хост-
приложение. REAPER может использоваться как в качестве хоста, так и в качестве подчиненного приложения. 
Подробная информация о протоколе ReWire на странице http://www.propellerheads.se/technologies/rewire/. 
Система ReWire использует микшеры, панели и устройства. Микшеры - хост-приложения, которые обычно 
функционируют в качестве секвенсора на одном конце и в качестве финального миксдауна на другом конце. 
Устройство - это динамически подключаемая библиотека, которая только производит звук, но не имеет никакого 
собственного пользовательского интерфейса. Панель - графический интерфейс для настройки параметров 
одного устройства. Например, вы можете использовать REAPER в качестве вашего микшера, а Propellerhead 
Reason в качестве вашего синтезатора. В этом случае Reason обеспечил бы устройство и панель в REAPER, 
который может затем отсылать MIDI опции, синхронизируя и смешивая выходной сигнал Reason в его 
собственные цепочки эффектов. ReWire может использоваться с любым треком (треками) в рамках проекта 
REAPER. Откройте цепочку эффектов трека и выберите опцию ReWire из списка плагинов (левый столбец). 
После этого в правом столбце откроется список всех ReWire активированных приложений, установленных на 
вашем компьютере. Выберите приложение (“подчиненное”), которое вы хотите использовать - например, это 
может быть ReWire Ableton Live, Rewire Reason или (как в данном примере) ReWire FLStudio.  
 

Выбор активированного ReWire 
приложения откроет интерфейс 
этого приложения. Протокол ReWire 
можно использовать для отсылки 
MIDI данных в дочернее 
приложение (как показано на 
примере выше), направить 
аудиосигнал из дочернего 
приложения в REAPER или 
направить MIDI данные из 
дочернего приложения в REAPER. 
По умолчанию темп обоих 
приложений устанавливается 
хостом ReWire. Однако в окне 
ReWire REAPER доступна опция. 
позволяющая дочернему 
приложению устанавливать темп. 
 
 
 
 
 
 
 
 
 
 
 

 
Примечание: REAPER можно открыть в "подчиненном" режиме: Меню Старт > Все программы или 
сначала открыть хост-приложение и выбрать REAPER в качестве подчиненного приложения. Вы можете 
также (как на OSX, так и на Windows) подключить ReWire REAPER к себе, выбрав Rewire REAPER из 

окна Add FX. Дополнительная информация об использовании ReWire с REAPER на странице 
'wiki.cockos.com/wiki/index.php/ReWire. 
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17.24. Знакомство с функцией ReaRoute 
 
ReaRoute - уникальная функция REAPER, которая обеспечивает другие способы совместного использования 
данных (аудио и MIDI) в режиме реального времени с другими приложениями. Подробно функция ReaRoute 
охватывается в Главе 24. 
 

17.25. Управление REAPER через интерфейс веб-браузера 
 
Вы можете использовать свой мобильный телефон или планшет в качестве внешнего устройства управления 
REAPER, например чтобы сделать запись треков, воспроизвести их, солировать или мьютировать треки, и так 
далее, используя интерфейс веб-браузера REAPER! Убедитесь, что компьютер с установленным REAPER 
находится в сети. Откройте любой проект или начните новый. Откройте страницу Control/OSC/web на странице 
предварительных настроек. Нажмите Add, и в меню Control surface mode выберите Web browser interface, 
чтобы открыть диалоговое окно, отображенное на рисунке ниже.  
 

 
 
В данном примере выбрана опция basic.html из меню Default interface: это - простой интерфейс, поставляемый 
с REAPER. Если вы предпочитаете графический интерфейс, попробуйте опцию index.html. Другие опции 
доступны в выпадающем меню, или в меню Built-in pages. Выбранный вами интерфейс определяет среди 
прочего, вид и компоновку интерфейса и какие задачи REAPER вы будете (или не будете) выполнять в вашем 
веб-браузере. Вы можете сохранить любые созданные вами интерфейсы и загрузить их из папки User pages. 
Нажмите Apply Settings. Обратите внимание на точный код Access URL, отображенный на экране. Откройте 
любой браузер (например, Chrome или Safari) на вашем телефоне или планшете и введите этот код доступа в 
его строке поиска. Появится экран, схожий как на рисунке ниже (но обратите внимание на примечания ниже).  
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Четыре главных кнопки - Play, Stop, Record и Abort record. Ниже перечислены ваши треки, начиная с мастер-
трека. Отдельные треки можно активировать для записи, мониторить или мьютировать. Щелкните на любом 
треке, чтобы увидеть его параметры как показано на рисунке ниже.  
 

 
 
Слева расположен вертикальный фейдер громкости и другие контроллеры трека (кнопки Mute, Solo, и т.д.) 
Нажимают X, чтобы возвратиться к главному экрану. Файл интерфейса HTML включает языки 
программирования HTML, CCS и JavaScript, которые определяют то, что вы видите на своем телефоне и 
поведение. В самых лучших традициях REAPER пользователи могут разработать свои собственные скрипты 
для собственного интерфейса мобильной сети, или сделать их доступными для других пользователей. 
Заглядывайте на страницу REAPER Stash время от времени! 
 

Примечания: с некоторыми системами Windows, вам, возможно, придется вручную настроить 
некоторые параметры. В данном примере, 8080 - это номер порта. На большинстве систем Windows он 
предопределен как открытый, но вы можете использовать большее число, например, 9 000. Если это 

так, необходимо получить доступ к вашим параметрам файерволл на Windows, чтобы открыть используемый 
порт и дать входящий и исходящий доступ REAPER. Вы можете отметить флажок Use rc.reaper.fm. Это запишет 
ваш локальный IP и обеспечит постоянную ссылку, которая будет всегда перенаправляться к вашему 
локальному IP, даже если он изменится. Просто следуйте инструкциям на экране. 
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18. Автоматизация с огибающими 
 

18.1. Суть автоматизации 
 
Автоматизация - функция, позволяющая записывать, редактировать, сохранять и загружать изменения 
параметров микширования и эффектов. При записи автоматизации все вносимые вами изменения в параметры 
микширования и эффектов сохраняются в виде данных автоматизации. В простейшей своей реализации, 
например, автоматизация позволяет увеличить громкость солирующего инструмента во время конкретной 
сбивки или фрагмента, или добавить немного присутствия или теплоты к случайной фразе на вокальном треке, 
чтобы выделить ее в общем миксе. Пример простой огибающей (для параметра громкости) показан на рисунке 
ниже.  
 

 
 
В данном примере огибающая расположена ниже клипа, а на панели трека ниже контроллеров трека 
расположена панель огибающей с ее собственными контроллерами. При воспроизведении такого трека его 
громкость будет изменяться в зависимости от контура огибающей. Рассмотрим другой пример (на рисунке 
ниже).  
 

 
 
Здесь та же самая огибающая расположена на этот раз не на ее собственной дорожке, а поверх клипа. У этих 
двух режимов отображения огибающей есть как свои преимущества, так и недостатки. Первый режим облегчает 
редактирование огибающей, но занимает дополнительное место на экране. Второй режим занимает меньше 
места на экране, но усложняет редактирование огибающей. Режим отображения ваших огибающих зависит от 
опции Show new envelopes in separate envelope lanes на странице Options > Preferences > Editing Behavior > 
Envelope Display. Если она отмечена огибающие будут располагаться на своих собственных дорожках, если 
эта опция не отмечена огибающие будут располагаться поверх клипа. Однако, помните, что режим отображения 
текущей огибающей можно изменить в любое время. REAPER поддерживает два основных типа автоматизации 
– с применением огибающих параметров микширования и параметров эффектов и модуляцию параметров. В 
данной главе мы рассмотрим создание и использование огибающих параметров микширования. Модуляция 
параметров будет рассматриваться в Главе 19. 
 

18.2. Способы автоматизации с огибающими 
 
Различные режимы автоматизации в REAPER по сути обеспечивают доступ к двум основным способам 
использования огибающих для автоматизации проектов. Это запись автоматизации и создание огибающих 
вручную. 
 

 
 
Запись автоматизации: при записи автоматизации, REAPER запоминает ваши действия с контроллерами, 
например, поворот регулятора громкости во время воспроизведения проекта. Есть три режима записи 
огибающих - Write, Touch и Latch. Позже мы вернемся к ним. 
 
Создание огибающих вручную: в качестве альтернативы использования регуляторов для создания 
огибающих, можно сформировать их вручную. Это обеспечивает достаточно высокий уровень управления 
проектом. Можно нарисовать огибающие вручную, добавить к ним узлы и использовать мышь для перемещения 
этих узлов вверх или вниз. Созданные таким образом огибающие будут вести себя точно так же, как и 
записанные. Для создания и редактирования огибающих этим способом используется режим Trim/Read.  
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При необходимости можно записать огибающие, скажем, в режиме Latch, а затем отредактировать их в режиме 

Trim/Read. Выбранный текущий режим отображается на кнопке  трека. В последующих параграфах мы 
рассмотрим различные режимы автоматизации более подробно. У обоих способов использования огибающих 
есть свои преимущества, и вы можете использовать любую комбинацию режимов на различных треках в 
проекте. Как с записанной, так и с ручной автоматизацией огибающих, вполне возможно (и довольно легко) 
отредактировать инструкции автоматизации впоследствии или удалить их в целом. 
 

18.3. Окно огибающих трека 
 
Огибающими любого трека можно управлять из окна огибающих этого трека. Чтобы открыть это окно нажмите 

кнопку Envelopes/Automation  либо на панели трека, либо на панели микшера.  
 

 
 
Это окно можно использовать, например, для: 
 
- выбора режима автоматизации для трека. 
- создания огибающей (например, громкости, панорамы или мьютирования для трека или посыла). 
- отображения или скрытия огибающей. 
- активирования/деактивирования огибающей для записи. 
 
Кроме того, это окно включает кнопки для таких глобальных опций, как отображение/скрытие всех огибающих на 
этом треке. Об этом подробнее мы поговорим в последующих параграфах. Область Highlight может 
использоваться для облегчения поиска. Например, введите слово volume в области Highlight и будут выделены 
все клипы, имя которых включает слово volume. В этом окне также перечисляются любые плагины, которые 
были помещены в цепочку эффектов трека.  
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В данном примере это плагин ReaComp. 
Щелкните по символу  рядом с именем 
плагина, чтобы открыть список параметров 
плагина, для которых можно создать 
огибающие.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Примеры этого мы рассмотрим вскоре. Если флажок Show last touched FX parameters only (показать только 
последний редактируемый параметр эффекта) отмечен, это может помочь предотвратить перенасыщение 
экрана лишними деталями. 

 
Совет: по умолчанию горячие клавиши V и P могут использоваться для переключения отображения 
огибающих параметров Volume и Pan соответственно. 
 

18.4. Огибающие трека и посыла 
 
Ниже перечислены огибающие автоматизации, которые по умолчанию доступны для всех треков и посылов. 
Огибающие для эффектов будут рассмотрены позже. 
 
Volume (громкость трека): управляет громкостью выходного сигнала трека, после, например, любого клипа или 
примененного эффекта трека и устанавливает уровень сигнала, который отсылается в мастер-трек. 
Pan (панорама трека): управляет панорамой трека: сигнал отсылается после примененных эффектов трека в 
мастер-трек. 
Width (ширина стереополя трека): управляет шириной стереополя: сигнал отсылается после примененных 
эффектов трека в мастер-трек. 
Volume (Pre FX) (громкость трека Pre FX): управляет громкостью трека перед примененными эффектами или 
фейдерами трека. Эквивалентна контроллеру Gain, который можно найти в некоторых микшерах. 
Pan (Pre FX) (панорама трека Pre FX): управляет панорамой трека перед примененными эффектами или 
фейдерами трека. 
Width (Pre FX) (ширина стереополя трека Pre FX): управляет шириной стереополя перед примененными 
эффектами или фейдерами трека. 
Mute (мьютирование трека): мьютирует трек и принимает только два состояния - On и Off. 
Send Volume (громкость посыла): управляет громкостью сигнала трека, посланного в трек-адресат. 
Особенность применения будет частично определяться типом посыла: Post Fader (Post Pan), Post FX или Pre 
FX. 
Send Pan (панорама посыла): управляет панорамой сигнала трека, посланного в трек-адресат. Особенность 
применения будет частично определяться типом посыла: Post Fader (Post Pan), Post FX или Pre FX. 
Send Mute (мьютирования посыла): мьютирует посыл и принимает только два состояния - On и Off. 
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18.5. Запись автоматизации 
 
Чтобы записать огибающую: 
 

 
- на панели микшера или на панели трека, нажмите кнопку  чтобы открыть окно огибающих трека. Кнопка 
Envelopes/Automation отображает текущий выбранный режим автоматизации для этого трека. В данном 
примере это режим Trim. 
- выберите клип, который вы хотите автоматизировать, и убедитесь, что флажки Visible (показать огибающую) 
и Arm (активировать огибающую для записи) отмечены. 
- выберите режим Write. 
- закройте окно огибающих. 
- поместите указатель текущей позиции в нужное место проекта. 
- воспроизведите проект. Во время воспроизведения отрегулируйте нужный контроллер. По окончании 
остановите воспроизведение. 

- щелкните правой кнопкой мыши по кнопке  этого трека и выберите режим Trim/Read или Read. 
- воспроизведите проект. Слушайте и смотрите! Если вы выбрали режим Read, фейдеры будут поворачиваться 
в соответствии с записанной вами ранее автоматизацией.  
 
Обратите внимание: вместо того, чтобы открыть окно огибающих, можно щелкнуть правой кнопкой по кнопке 

 и выбрать режим из контекстного меню (см. рисунок ниже). 
 

 
 

Совет: если на странице Options > Preferences> Automation активирована опция Automatically add 
envelopes when tweaking para in automation write modes, то при выборе режима записи автоматически 
будет создана огибающая при редактировании соответствующего контроллера трека или параметра 

эффекта во время воспроизведения. 
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Пример записи автоматизации: 
 
1. Откройте проект All Through The Night. RPP и сохраните его под именем All Through The Night AUTO.RPP. 
Мы собираемся добавить огибающую автоматизации к треку Bouzouki, чтобы немного увеличить его громкость 
в отрезке между первым и вторым запевами. 
2. Используя мышь, увеличьте высоту трека Bouzouki. Это не критично, но облегчит обзор ваших действий. 
3. Вставьте плагин JS: Utility/Limiter в мастер-трек и установите порог в значение -2.0. Это поможет 
предотвратить клиппирование. Поместите указатель текущей позиции чуть раньше окончания первого 
вокального фрагмента приблизительно на 40-й секунде. 

4. Теперь нажмите кнопку  трека Bouzouki. Отметьте флажок Volume и флажки Visible и Armed. 
Выберите режим Write (см. рисунок ниже). 
 

 
 
5. Закройте окно огибающих. Заметьте, что фейдер громкости этого трека окрашен в красный цвет, создана 
огибающая громкости на ее собственной панели, а кнопка  также окрашенная в красный цвет 
отображается лейблом Write. 
6. Воспроизведите проект с отметки приблизительно 48 секунд в течение приблизительно 15 секунд.  
В инструментальном отрывке мышью поверните вверх именно фейдер громкости трека Bouzouki (но не фейдер 
громкости огибающей) приблизительно на три децибела. Удерживайте фейдер в этой позиции, а затем в конце 
инструментального проигрыша поверните фейдер вниз в его исходное положение. Остановите 
воспроизведение. 
7. Щелкните правой кнопкой мыши по кнопке  трека Bouzouki и выберите опцию Automation Mode: Read 
из контекстного меню. Масштабируйте часть проекта приблизительно с 45-й секунды по 65-ю секунду. 
8. Область фейдера громкости этого трека теперь будет окрашена в зеленый цвет, а огибающая автоматизации 
должна четко прорисовываться (см. рисунок ниже). 
 

 
 
9. Воспроизведите проект. Заметьте, что фейдеры громкости этого трека (в обоих представлениях – в области 
аранжировки и в микшере) будут автоматически перемещаться, отображая изменения громкости в соответствии 
с записанными вами действиями. Сохраните файл. 

 
Примечание: чтобы активировать автоматизацию, необязательно выбирать режим Read. В режиме 
Trim/Read, автоматизация будет применена также, но без видимого перемещения фейдеров.  
 

В вышеупомянутом примере это позволило бы управлять громкостью трека при воспроизведении, вручную 
регулируя его фейдер громкости. Подробнее о различных режимах автоматизации далее в этой главе. 
 
 
 
 
 
 
 
 



 Специально для сайта musicmanuals.ru  403 403 

18.6. Опции редактирования узлов огибающей 
 

Щелкните правой кнопкой по кнопке  на главной панели инструментов для доступа к опциям, которые 
помогут определить поведение огибающей.  
 

 
 
Эти опции также доступны на странице Options > Envelope points. Опция Move envelope points with media 
items (перемещать узлы огибающей с клипом) должна быть отмечена в том случае, если вы хотите, чтобы при 
перемещении или копировании клипа его огибающая следовала за ним. Будьте осторожны при использовании 
опции Envelope point selection follows time selection. Если она отмечена при перетаскивании любого из узлов 
в этой области будут перемещаться все узлы в пределах выделенной области. Если вы хотите переместить 
только один узел (или несколько выбранных узлов) в пределах выделенной области, убедитесь, что эта опция 
не отмечена. Граничные узлы (Edge points) могут использоваться для облегчения визуализации при 
перемещении группы узлов в пределах выделенной области: отметьте опцию Add edge points when moving 
envelope points (добавить граничные узлы при перемещении узлов огибающей), выделите область, выберите 
опцию Select all points in time selection (выбрать все узлы в выделенной области), а затем перетащите 
(влево или вправо) любой узел огибающей в рамках выделенной области. Опция Reduce envelope point data 
when recording or drawing automation должна быть отмечена в том случае, если REAPER создает лишние 
узлы, когда, например, вы записываете данные автоматизации, используя мышь или внешний аппаратный 
контроллер. Чтобы сократить количество узлов записанной огибающей: 
 
1. Выберите (щелкните) по огибающей. 
2. Выделите область в пределах которой будут выбраны все узлы. Можно также увеличить масштаб. 
3. Щелкните правой кнопкой по огибающей. 
4. Из меню выберите опцию Reduce Number of Points (сократить количество узлов). 
5. Выберите (вероятно) опцию Points in time selection only (только узлы в пределах выделенной области) или 
(возможно) опцию All Points (все узлы). 
6. Поворачивайте фейдер, пока отображаемое в области вправо количество узлов не будет соответствовать 
нужному. Пример показан на рисунке ниже. 
7. Нажмите OK. 
 

 
 

18.7. Запись автоматизации мьютирования 
 
Рассмотрим способ автоматизации кнопки Mute трека для автоматического мьютирования нежелательных 
фрагментов трека: 
 

- нажмите кнопку  трека, чтобы отобразить окно огибающих. 
- выберите огибающую Mute и режим Write. Закройте окно огибающих. 
- кнопка Envelopes/Automation теперь отображает лейбл Write, а активированная кнопка Mute подсвечена 
красным цветом. Обратите внимание (ниже), как это выглядит, когда установлен режим Write. 
 



 Специально для сайта musicmanuals.ru  404 404 

 
 
- теперь воспроизведите трек Vox. Во время воспроизведения нажмите кнопку Mute трека в начале или в конце 
любых фрагментов, которые должны быть мьютированы. 
- по окончании остановите воспроизведение. Режим автоматизации для этого трека должен автоматически 
измениться на Trim/Read (если эта настройка по умолчанию не была изменена на странице Options > 
Preferences > Editing Behavior > Automation). 
 

 
 
На рисунке ниже в нужном месте мьютирован вокальный трек. Выбран режим Read. При воспроизведении трека 
цвет кнопки Mute изменяется на красный при мьютировании фрагментов. 
 

 
 

18.8. Режимы автоматизации 
 
Режим автоматизации можно выбрать несколькими способами: 
 
- выберите режим из окна огибающих. 

- щелкните правой кнопкой мыши по кнопке  и выберите режим из контекстного меню. 
- на панели трека щелкните правой кнопкой мыши по любой дорожке автоматизации и выберите режим из 
контекстного меню. 
- в главном меню перейдите Track > Set track automation mode (или щелкните правой кнопкой по номеру трека 
и выберите эту опцию из контекстного меню). Список ниже суммирует пять доступных режимов автоматизации: 
 
Trim/Read: текущая огибающая функционирует, но контролеры на экране не перемещаются. Поначалу режим 
Trim/Read может показаться странным, но он действительно приносит пользу. В этом режиме можно 
использовать контроллеры трека для глобальных изменений, но при этом перемещения фейдеров не 
записываются. Например, редактирование фейдера громкости трека в этом режиме будет изменять громкость 
трека в целом относительно изменений огибающей. 
Read: текущая огибающая функционирует и перемещаются контроллеры "активированных" клипов, но любые 
вносимые вами изменения не записываются и не запоминаются. 
Latch: записываются и запоминаются любые вносимые вами изменения и на текущих огибающих трека 
создаются новые узлы. Изменения начинаются с начала редактирования параметра и запоминаются до тех пор, 
пока не остановится воспроизведение. 
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Latch Preview: этот режим позволяет опробовать изменения параметров (например, уровня громкости или 
позиции панорамирования), фактически не вписывая эти изменения в сами огибающие. После того, как вы 
будете удовлетворены результатом, можно применить действие записи этих изменений в огибающую 
(огибающие). Поскольку понимание этой концепции поначалу может быть затруднительно, мы рассмотрим ее в 
отдельном параграфе позже. 
Touch: схож с режимом Latch, но изменения в узлы огибающей прекращают записываться тогда, когда вы 
прекращаете их редактировать. Тем не менее, при использовании MIDI-контроллера, можно обнаружить, что 
режим Touch функционирует так же, как и режим Latch. 
Write: текущие параметры записываются и запоминаются в виде узлов редактирования, наряду с любыми 
вносимыми вами изменениями в параметры для "активированных" клипов во время воспроизведения. В этом 
режиме ранее записанные огибающие для "активированных" клипов будут перезаписаны. Опция After recording 
automation in write mode на странице Options > Preferences > Editing Behavior > Automation позволяет 
выбрать режим после записи автоматизации в режиме Write. По умолчанию это режим Trim/Read. (См. рисунок 
выше). 

 
Когда вы находитесь в режимах Latch, Touch или Write, огибающую можно 
активировать/отключить кнопкой Arm Record на ее собственной дорожке 
автоматизации.  
 

 
Помните также, что после использования режимов Write, Latch или Touch, необходимо переключиться на 
режимы Read или Trim/Read, чтобы препятствовать дальнейшей случайной записи автоматизации. Для 
редактирования только что созданной огибающей в режимах Latch, Touch или Write на странице Action list 
доступно несколько действий, которые позволяют применить параметры огибающей (или огибающих) и вставить 
их в начало проекта, в конец проекта или применить к выделенной области. Чтобы отобразить полный список 
этих действий введите Auto write в область фильтра списка действий. Рассмотрим пример.  
 

 
 
У этого трека есть огибающая громкости в режиме Trim/Read. Обратите внимание на позицию курсора. 
Предположим, что мы хотим установить последний фрагмент в тот же самый уровень громкости. На втором 
рисунке мы выбрали режим записи и отметили как выделенную область фрагмент огибающей, которую мы 
хотим изменить.  
 

 
 
Наконец, мы применяем действие Automation: Write current values for all writing envelopes to time selection. 
Огибающая в этом фрагменте теперь установлен в нужный уровень. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 Специально для сайта musicmanuals.ru  406 406 

18.9. Режим Latch Preview 
 
Этот режим позволяет опробовать изменения параметров (например, уровень громкости или позиция 
панорамирования), фактически не вписывая эти изменения в сами огибающие. После того, как вы будете 
удовлетворены результатом, можно применить действие записи этих изменений в огибающую (огибающие).  
Давайте начнем с относительно простого примера. 
 
Пример: 

 
1. В данном примере у нас есть песня 
с инструментальной сбивкой. Мы 
хотим увеличить громкость 
инструмента в сбивке, но насколько? 
(Для простоты иллюстрации 
остальные инструментальные треки 
скрыты). Мы выделили область и 
добавили огибающую громкости к 
треку и вставили два узла в начало и в 
конец сбивки. 

 
2. При воспроизведении песни, мы 
регулируем контроллер громкости до 
нужного уровня (в данном случае до 
+2.17dB). При этом заметьте, что сама 
огибающая еще не затронута. 
 
 
 
 
 
3. Теперь мы открываем Список 
действий (Actions > Show action list) и 
выбираем действие Automation: Write 
current values for actively-writing 
envelopes to time selection. Теперь 
ниши изменения внесены 
непосредственно в огибающую. 
 
 
 

 
Наконец (на рисунке не показано) мы можем сбросить автоматизацию трека в режим trim/read. Режим Latch 
Preview можно использовать с несколькими огибающими трека, или на нескольких треках. Опции "write to" 
можно применить кроме как к выделенной области. Принимая это во внимание ниже приведена сводка 
основных доступных действий. Помните, что эти действия можно назначить на горячие клавиши, панели 
инструментов и/или в меню (см. Главу 16). 
 
Set automation mode actions (установить действия для режима автоматизации) 
Automation: Set track automation mode to latch preview (Автоматизация: активировать режим latch preview для 
текущего трека)  
Automation: Set all tracks automation mode to latch preview (Автоматизация: активировать режим latch preview 
для всех треков) 
Global automation override: All automation in latch mode (применить глобальные опции автоматизации: вся 
автоматизация устанавливается в режим latch) 
Automation write actions (применить действия записи автоматизации): 
Automation: write current values for actively-writing envelopes to [entire project or time selection] (Автоматизация: 
применить текущие значения к активированным для записи огибающим) 
Automation: write current values for actively-writing envelopes from cursor to [entire project or first touch position or start 
of project] (Автоматизация: применить текущие значения к активированным для записи огибающим с 
позиции курсора до - конца проекта (entire project), первой затронутой позиции (first touch position) или до 
начала проекта (start of project) 
Automation: write current values for all writing envelopes [from cursor to end project or from cursor to start of project or 
to time selection] (Автоматизация: применить текущие значения ко всем огибающим с позиции курсора до 
конца проекта (from cursor to end project), до начала проекта (from cursor to start of project) или до выделенной 
области (to time selection). 
Automation: Clear [track or all track] envelope latches  
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18.10 Глобальная опция автоматизации (Global Automation Override) 
 

Кнопка Global Automation Override (Global Auto)  на транспортной панели может использоваться для 
применения глобальных опций к вашим огибающим. Щелкните правой кнопкой мыши по этой кнопке для доступа 
к меню со следующими опциями: 
 

Toggle bypass on/off for all envelopes (вкл/откл обход 
всех огибающих). 
Select a single automation mode (such as Trim/Read or 
Read) for all tracks (выбор единственного режима 
автоматизации для всех треков). 
Toggle display of all active envelopes (показать все 
активные (активированные для записи) 
огибающие). 
 
 
 
 
 
 

 
Глобальная опция может быть отменена командой No global override. После этого каждый трек будет 
возвращен индивидуально в его предыдущее состояние с его изначальным отдельным режимом автоматизации 
и сброшенными настройками обхода. 
 

18.11. Контроллеры панели огибающих 
 
Фейдер на панели огибающей используется для записи автоматизации (в режимах Write, Latch или Touch), 
отображения изменений автоматизации (в режиме Read) или редактирования значений параметров для трека в 
целом или выбранного сегмента огибающей (в режиме Trim/Read). В теме оформления по умолчанию это - 
регулятор. Когда у трека есть другие огибающие, которые не отображаются на дорожках, можно щелкнуть по 
имени огибающей (на рисунке это – огибающая громкости), и выбрать из списка другую огибающую, которая 
заменит текущую. Остальные контроллеры - это переключатель статуса обхода Bypass, и рядом с ним кнопка 
Hide/Clear (для скрытия огибающей, перемещения ее на дорожку клипа или удаления вообще). У огибающих 
параметров эффектов могут быть и другие контроллеры, например, для активирования модуляции параметра 
или активирования режима Learn (см. далее в этой главе и в Главе 19). 
 

 
 

18.12. Редактирование огибающих вручную 
 
В качестве альтернативы записи автоматизации для назначения и формирования ваших огибающих, можно 
использовать мышь непосредственно в пределах дорожки огибающей. Это особенно полезно, например, в том 
случае, когда, наблюдая сигналограмму вы видите пик, который необходимо отредактировать. Среди типичных 
действий, которые вы будете использовать для этого: 
 
Shift +щелчок для добавления узлов к огибающей. 
Ctrl+щелчок+перетаскивание для прорисовки узлов огибающей и кривых. 
Щелчок+перетаскивание для свободного перемещения сегментов или узлов огибающей в любом 
направлении. 
 
Первое из этих действий выполняется щелчком на огибающей с нажатой клавишей Shift, а третье простым 
щелчком. Эти действия можно изменить на странице Options > Preferences > Mouse Modifier (в контекстах 
Envelope points и Envelope segment). В данном примере мы предположим, что действие 
Щелчок+перетаскивание используется для редактирования сегментов, а действие Shift+щелчок для 
добавления узлов. На примере, описанном ниже, вы будете использовать мышь для редактирования громкости 
трека Bouzouki в коротком инструментальном отрывке между вторым и третьим запевами. Затем вы нарисуете 
кривую автоматизации вокального трека. Данный пример предполагает, что поведение редактирования мышью 
по умолчанию установлено, как было описано выше. 
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Пример: 
 
1. Наведите мышь на огибающую, чуть раньше второго инструментального проигрыша. Это будет в районе 1-й 
минуты 36-й секунды. Мышь изменится на вертикальную двухстороннюю стрелку. 
 

 
 
2. Щелкните по огибающей, удерживая клавишу Shift, чтобы создать узел. 
3. Повторите это трижды как показано на рисунке ниже так, чтобы у вас было два узла до сбивки и два узла 
сразу после нее. 
 

 
 
4. Теперь наведите мышь в любом месте между вторым и третьим узлом. Щелкните и удерживая мышь, 
перетащите мышь вверх, чтобы увеличить громкость этой огибающей, как показано на рисунке ниже. 
 

 
 
5. Сохраните файл. 
6. Откройте окно огибающих трека и убедитесь, что для этого трека выбран режим автоматизации Read, 
выбрана огибающая громкости (Volume) и для отмечены опции Visible и Arm. 
7. Воспроизведите трек. 
8. Заметьте, что громкость трека Bouzouki будет постепенно увеличиваться в инструментальных фрагментах и 
понижаться после них. 
9. Теперь выберите трек Vox и нажмите клавишу V, чтобы отобразить огибающую громкости для этого трека. 
Масштабируйте фрагмент приблизительно с 1-й минуты 0 секунд до 1-й минуты 19 секунд. Давайте сделаем 
этот фрагмент немного громче. 
10. Наведите мышь чуть выше огибающей в отметке 1:00. Нажмите клавишу Ctrl. Курсор мыши изменится на 
карандаш. Удерживая клавишу Ctrl перетащите мышь приблизительно на отметку 1:19 (см. выше права), а 
затем отпустите кнопку мыши. Тем самым вы нарисовали изменения в огибающей громкости. 
 

 
 
11. Помните, что любые дополнительные узлы, которые вставлены таким образом, могут быть удалены, 
используя опцию Reduce number of points. 
12. Сохраните файл. 
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18.12.1 Опции Amplitude scaling и Volume fader scaling  
 
Щелкните правой кнопкой по огибающей громкости для вызова контекстного меню, которое включает опцию 
Volume envelope scaling (в опции Envelope defaults).  
 

 
 
Доступные значения - amplitude scaling (по умолчанию) и fader scaling, каждое из которых приведет к разным 
результатам. В случае с опцией amplitude scaling, результат будет ополовинен, например, громкость вдвое 
меньше, тогда как в случае с опцией fader scaling, высота огибающей будет соответствовать фейдеру трека. 
Опция fader scaling облегчает редактирование огибающей на низких уровнях громкости. Изменение 
предварительных настроек огибающей после добавления узлов затронет уровень звука, произведенный этой 
огибающей. Поменять опции от amplitude scaling до volume fader scaling можно на странице Options > 
Preferences> Project > Track/Send Defaults. Необходимо также ознакомиться с различными опциями страницы 
Preferences > Editing Behavior > Envelope Display (см. Главу 22). 
 

18.13. Использование мыши при редактировании огибающих 
 
В предыдущем параграфе мы рассмотрели некоторые примеры работы с огибающими, но есть множество 
других способов и приемов с использованием мыши для манипуляций и управления огибающими и их узлами. 
Список ниже представляет сводку наиболее важных из них. Полный список действий можно найти на странице 
Mouse Modifiers. 
 
Чтобы выбрать все узлы огибающей в пределах выделенной области: выделите область именно на дорожке 
огибающей (а не на самой огибающей). 
Чтобы нарисовать и сформировать огибающую в ручном режиме: перетащите мышь с нажатой клавишей Ctrl 
в любом месте выше или ниже самой огибающей 
Чтобы добавить узел: щелкните по огибающей с нажатой клавишей Shift 
Чтобы удалить узел: щелкните по узлу с нажатой клавишей Alt 
Чтобы выбрать несколько узлов: щелкайте по узлам с нажатой клавишей Ctrl 
Чтобы выбрать все узлы огибающей: щелкните по любому узлу, а затем нажмите Ctrl+A 
Чтобы выбрать все узлы в пределах рамки выделения: щелкните по узлу, а затем нарисуйте рамку выделения 
(щелчок правой кнопкой мыши+перетаскивание) в нужной части огибающей. Отпустите кнопку мыши. 
Чтобы применить опцию огибающей к нескольким узлам: выберите узлы, щелкните правой кнопкой мыши по 
любому из выбранных узлов и выберите нужную опцию из контекстного меню 
Чтобы переместить узел или несколько узлов: захватите и перетащите любой узел из выбранных. 
Чтобы точно отрегулировать вертикальную позицию узла: захватите узел с нажатыми клавишами Ctrl+Alt и 
переместите мышь 
Чтобы переместить узел огибающей только вертикально или горизонтально: щелкните по узлу и 
удерживая кнопку мыши, нажмите клавиши Ctrl и Shift, а затем перетащите узел огибающей вертикально или 
горизонтально. 
Чтобы сбросить узел в центр (по умолчанию): дважды щелкните по узлу 
 
Большинство этих действий по умолчанию можно изменить на странице Options > Preferences > Editing 
Behavior > Mouse Modifiers. 
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18.14. Модификаторы мыши для редактирования огибающей 
 

На странице Mouse Modifiers доступно несколько контекстов - 
Envelope lane (left click), Envelope segment (left drag), Envelope 
point (left drag), Envelope segment (double-click) and Envelope 
point (double-click). Например, если вы часто вручную 
добавляете узлы к огибающим, вы можете изменить контекст 
Envelope double-click с действия Reset point to default value 
(сбрасывать узел в его значение по умолчанию) в действие 
Envelope: Insert new point at current position (вставить новый 
узел в текущей позиции щелчка). Если вам удобнее 
регулировать узлы огибающей горизонтально, можно 
назначить действие Move envelope point horizontally 
(перемещать узлы огибающей горизонтально) вместо 
простой команды Move envelope point (перемещать узлы 

огибающей). Кроме того, по умолчанию двойной щелчок по панели управления огибающей выделит все узлы 
огибающей. Это поведение также можно изменить. Подробнее о модификаторах мыши в Главе 15. 
 

18.15. Управление отображением огибающих автоматизации 
 
REAPER включает диапазон гибких опций для определения того, как будут отображаться ваши огибающие 
автоматизации. Для любого трека (или треков) вы можете: 
 
- отобразить все огибающие автоматизации на их собственных отдельных дорожках 
- отобразить все огибающие автоматизации поверх клипов 
- отобразить только некоторые огибающие на их дорожках, а другие поверх клипов 
- отобразить только некоторые огибающие и скрыть остальные 
- окрыть все огибающие автоматизации. 
 

 
 
На рисунке выше вы видите три огибающие. - для панорамы, громкости трека и громкости посыла в шину 
эффектов. Огибающая панорамы отображается поверх клипа. Остальные две на их собственных дорожках. 
Опция Draw faint peaks in automation envelope lanes (фоном отобразить сигналограмму на дорожках 
огибающих) на странице Options > Preferences > Peaks/Waveforms активирована. Список ниже обобщает эти 
опции. Необходимо также обратить внимание на опцию When adding volume/pan envelopes, apply trim to 
envelope and reset trim (при добавлении огибающих громкости/панорамы применять обрезку огибающих) на 
странице Options > Preferences > Editing Behavior > Automation. Наиболее правильное решение - установить 
эту опцию в значение Never, чтобы гарантировать, что огибающая будет помещена строго вертикально по 
центру дорожки автоматизации, оставляя таким образом соответствующее место выше и ниже огибающей для 
ее редактирования вручную. 
 
Чтобы скрыть отдельную огибающую: щелкните правой кнопкой мыши по огибающей и выберите опцию Hide 
Envelope из меню или на панели огибающей нажмите кнопку Hide/Clear и выберите опцию Hide Envelope. 

Чтобы отобразить скрытую огибающую: нажмите кнопку  на панели трека и отметьте флажок Visible 
для этой огибающей. 
Чтобы изменить отображенную огибающую на конкретной дорожке: на панели трека щелкните правой 
кнопкой мыши выше названия огибающей и выберите другой параметр из списка. 
Чтобы переместить огибающую с ее собственной дорожки на дорожку клипа: щелкните правой кнопкой 
мыши по огибающей и снимите флажок Show envelope in lane или нажмите кнопку Hide/Clear на панели 
огибающей и выберите опцию Move to media lane. 
Чтобы переместить огибающую с дорожки клипа на ее собственную дорожку: щелкните правой кнопкой 
мыши по огибающей и отметьте флажок Show envelope in lane  
Чтобы отобразить все видимые огибающие на их отдельных дорожках: на панели трека щелкните правой 

кнопкой мыши по кнопке  и выберите опцию Show all visible track envelopes to media lane из меню. 
Чтобы отобразить все видимые огибающие поверх их клипов: на панели трека щелкните правой кнопкой 

мыши по кнопке  и выберите опцию Show all visible track envelopes to media lane из меню. 
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Чтобы отобразить все активные огибающие: на панели трека щелкните правой кнопкой мыши по кнопке 

 и выберите опцию Show all active track envelopes или откройте окно огибающих и нажмите кнопку Show 
all active. 

Чтобы скрыть все огибающие: на панели трека щелкните правой кнопкой мыши по кнопке  и выберите 
опцию Hide all track envelopes или откройте окно огибающих и нажмите кнопку Hide all. 

 
В окне огибающих перечисляются все 
потенциальные огибающие для этого трека. 
Активные огибающие отображаются галочкой 
напротив их названия. Потенциальная 
огибающая - это огибающая, которая скрыта и 
не активирована (т.е. флажки Visible и Arm не 
отмечены), тогда как активная огибающая - это 
та, которую вы фактически используете (т.е. 
флажки Visible и Arm отмечены). На рисунке 
слева у трека могло бы быть до десяти 
огибающих, по одной для каждого из 
перечисленных элементов. Однако фактически 
используется только три активные огибающие - 
громкости, панорамы и громкости посыла трека. 
Из них мы приняли решение сделать только 
первые три видимыми. Если бы нужно было 
добавить плагины (такие как дилей, эквалайзер 
или компрессор) к этому треку, мы сразу 
создали бы дополнительные потенциальные 
огибающие. 

 
18.16. Контроллеры панели огибающих 

 
У огибающей, которая отображается на ее собственной дорожке, могут быть свое поведение и опции, которые 
можно изменить на панели трека, используя фейдер, кнопки и контекстное меню. Например: 
 
- в режиме Trim/Read горизонтальный фейдер используется для поднятия или понижения огибающей по всей 
ее длине или только выделенной области. Например, если нет выделенной области, перемещение фейдера 
огибающей панорамирования заставит панораму для всего трека переместиться влево (оставляя 
относительное перемещение текущих узлов). В случае с активной выделенной областью огибающая 
редактировалась бы только в пределах этой выделенной области. 
- используйте кнопку BP для переключения статуса обхода (Bypass).  
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Щелчок правой кнопкой по названию огибающей на панели трека открывает меню со следующими опциями: 
 

 
 
- список всех доступных огибающих для этого трека (стандартные параметры трека и посыла плюс любые 
параметры эффектов). Выберите один из них, чтобы изменить огибающую, отображенную на этой дорожке. 
- различные опции отображения/скрытия огибающей. 
- список режимов автоматизации: это один из способов изменить режим автоматизации трека. 
 

18.17. Управление огибающими 
 
Контекстные меню Envelope Point и Envelope Segment включают опции управления огибающими. Какое из этих 
меню появится, зависит от того, куда вы наведете курсор мыши - на реальный узел или на сегмент, когда 
нажимается правая кнопка мыши. В списке ниже опции меню Envelope Point обозначены литерой (P). 
 

Set point value (P): открывает диалоговое окно Set Envelope 
Point Value, которое может использоваться для изменения 
значений, позиции и/или формы текущего узла. 
Дополнительно, можно установить опцию Double Click (на 
странице Options > Preferences > Mouse Modifiers > Envelope 
Point) в значение Open envelope point editor (двойным 
щелчком открыть редактор узла огибающей) 
 
 
 
 

Set point shape (P): изменяет форму текущего узла. Доступно шесть форм - Linear, Square, Smooth, Fast Start, 
Fast End и Bezier. Вскоре мы рассмотрим их более подробно 
Set shape for selected points: позволяет выбрать форму для нескольких выбранных узлов огибающей. 
Set envelope default point shape: устанавливает форму для будущих узлов.  
Select all points: выделяет все узлы текущей огибающей 
Unselect all points: снимает выделение со всех узлов текущей огибающей 
Select all points in time selection: если в настоящий момент выделена область, будут выбраны все узлы на 
этой огибающей в пределах выделенной области. 
Copy points: копирует все узлы в текущем выборе в буфер обмена 
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Примечание: чтобы применить опцию к нескольким выбранным узлам огибающей, щелкните правой 
кнопкой мыши по огибающей с нажатой клавишей Shift. Это гарантирует, что выбранные узлы будут 
оставаться выбранными, когда будет отображено контекстное меню. 

 
Cut points: удаляет все выбранные узлы и помещает их в буфер обмена 
Delete point (P): удаляет узел огибающей 
Delete selected points: удаляет все текущие узлы огибающей 
Delete points in time selection: если в настоящее время выделена область, будут удалены все узлы в пределах 
этой выделенной области. На рисунке ниже показаны несколько узлов до и после использования этой опции. 
 

 
 
Invert selected points: инвертирует все выбранные узлы относительно их нейтральной позиции. Например, 
если узел огибающей панорамы был установлен в значение влево на 50%, то после применения этой опции 
значение изменится на 50% вправо. 
Reset select points to zero/center: сбрасывает все выбранные узлы в их нейтральную позицию. На рисунке 
ниже показано несколько узлов до и после использования этой опции 
 

 
 
Reduce number of points: позволяет сократить количество узлов огибающей в пределах выделенной области 
или в огибающей в целом. 
Arm envelope for recording: переключает статус активирования огибающей 
Show envelope in lane: переключаемая команда, позволяющая переместить огибающую в или из ее 
собственной дорожки 
Hide envelope: скрывает огибающую, но сохраняет ее активной 
Bypass Envelope: переключает статус обхода огибающей. 
Clear/Delete Envelope: удаляет все узлы огибающей и возвращает ее в прямую горизонтальную линию. При 
этом поступит запрос и на удаление самой огибающей. 
 

18.18. Формы огибающей 
 
Огибающие могут принимать одну из шести форм - Linear, Square, Slow Start/End, Fast Start, Fast End или 
Bezier. Чтобы изменить форму огибающей, щелкните правой кнопкой мыши по узлу огибающей, выберите 
опцию Set Point Shape, а затем нужную форму из меню. Рисунки ниже иллюстрируют эти формы.  
 

 
 
Формы кроме Square лучше всего подходит для градуированных параметров, таких как громкость и панорама. 
Форма Square лучше всего подходит для элементов с переключаемыми параметрами - такими как обход или 
мьютирование, чтобы гарантировать точный переход в нужном узле. Форму огибающей по умолчанию можно 
установить на странице Options > Preferences> Project> Track/Send Defaults. 
 

18.19. Огибающие в шаблонах трека 
 
Каждый раз при сохранении трека (или нескольких треков) в качестве шаблона трека (опция Track > Save tracks 
as track template) доступна опция Include envelopes in tenplate (включить  огибающую в шаблон). 
 

18.20. Предварительные параметры огибающих 
 
Предварительные настройки огибающих REAPER находятся в несколько различных категориях страницы  
Options > Preferences. Подробнее они будут объяснены в Главе 22. Между тем на данном этапе стоит обратить 
внимание на следующую: страницы Options > Preferences > Appearance включают много полезных опций для 
улучшения отображения ваших огибающих. В частности, обратите внимание на следующие: 
 
Show solid edge on time selection highlight (страница Appearance): делает границы выделенной области 
более четкими. 
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Show guide lines when editing (страница Appearance): облегчает редактирование. 
Draw faint peaks in automation lanes (Страница Peaks/Waveforms): помогает привязать позицию огибающей 
на ее собственной дорожке к уровню громкости трека. 
Fill automation envelopes (страница Appearance): делает тусклыми цвета в области ниже огибающей. 
Страница Options > Preferences > Editing Behavior > Automation (см. Главу 22) является другим важным 
местом с опциями огибающих. Например, опция Automatically add envelopes when tweaking parameters in 
automation write mode позволяет создавать огибающие на лету, без необходимости выбирать нужные 
параметры из меню. Будьте осторожны, при активировании этой опции - огибающие могут быть созданы с 
нежелательными для вас опциями!  
 
Наконец, несколько опций страницы Options > Preferences > Project > Track/Send Defaults имеют также 
отношение к огибающим: 

 
Будут ли огибающие (такие как огибающие 
панорамы и громкость) автоматически 
отображаться для любых новых треков. 

 
Выбор формы огибающей при добавлении новых узлов. 
 
 
 
 
 
 

 
Какой режим автоматизации будет выбран по 
умолчанию для новых треков и должны ли 
новые огибающие быть автоматически 
активированы. 
 
 

 
18.21. Использование панели инструментов огибающих 

 
В Главе 15 подробно объясняется как создать собственные 
панели инструментов. Если вы часто работаете с 
огибающими, есть область, где можно достигнуть реального 
прироста производительности. На рисунке изображена 
простая панель инструментов огибающей, которую вы 
можете создать. Перечисленные ниже действия 
соответствуют каждому из значков на рисунке. 
 

Автоматизация: установить режим автоматизации трека в Trim/Read 
Автоматизация: установить режим автоматизации трека в Write 
Автоматизация: установить режим автоматизации трека в Touch 
Автоматизация: установить режим автоматизации трека в Touch/Read 
Огибающая: добавить 4 узла огибающей в выделенной области 
Огибающая: удалить все узлы в выделенной области 
Огибающая: очистить огибающую (удалить узлы и сделать огибающую прямой линией) 
Огибающая: снять выделение со всех узлов 
Огибающая: отобразить все видимые огибающие на дорожках треков 
Огибающая: отобразить все огибающие для всех треков 
Огибающая: скрыть все огибающие для всех треков 
Огибающая: отобразить все огибающие для треков 
Огибающая: скрыть все огибающие для треков 
Global automation over-ride: без переопределения (установить режимы автоматизации на трек) 
Global automation over-ride: вся автоматизация в режиме Trim/Read 
Global automation over-ride: вся автоматизация в режиме Read 
 
Однако, это всего лишь пример. Одни и те же опции и действия для разных пользователей могут иметь разные 
значения в плане полезности. Здесь все на откуп именно конкретному пользователю. 
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18.22. Перемещение и копирование огибающих с клипами 
 

Вы можете выбрать, перемещать ли и 
копировать огибающие 
автоматизации с клипами или нет с 
помощью опции Move envelope 
points with media items. Доступ к 
этой опции можно получить щелчком 
правой кнопкой мыши по кнопке 
Envelope на главной панели 
инструментов REAPER, или выбрав 
опцию Envelope points из меню 
Options REAPER. Чтобы назначить 

действие переключения этой опции, можно использовать редактор действий. 
 
- если эта опция отключена, огибающие с клипами перемещаться или копироваться не будут. 
- если эта опция активирована, огибающие будут перемещаться или копироваться с клипами. 
 
Пример этого иллюстрирован на рисунке ниже.  
 

 
 
Выделенная часть клипа на верхнем треке копируется в трек ниже, используя способ Ctrl+перетаскивание. 
Можно также определить, хотите ли вы добавить граничные узлы (Add edge points) - новые узлы огибающей в 
начале или в конце выделенной области при перемещении или копировании клипа. Обратите внимание, что 
мало того, что огибающая копируется с клипом, также активирована опция отображения направляющих линий, 
которые визуально облегчают размещение копируемого клипа. 
 

18.23. Автоматизация с огибающими Trim Volume 
 
Trim Volume - специальный тип огибающих, которые могут использоваться для точной настройки огибающей 
громкости трека. Это могло бы иметь место, например, если вы хотите поэкспериментировать с различными 
уровнями громкости прежде, чем применить их к огибающей громкости. Некоторые моменты, которые 
необходимо отметить, о TV огибающих: 
 
- это не огибающая контроллера трека: она не соответствует никакому контроллеру трека и, следовательно, не 
может быть активирована для записи или записана в режимах write, touch или latch. 
- в то время как можно использовать TV огибающую самостоятельно, т.е. без огибающей громкости, такая 
практика обычно не рекомендуется. 
 
Как и в случае с другими функциями автоматизации, функции TV огибающих мы рассмотрим на простом 
примере. 
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Пример: 
 

На первом рисунке добавлена огибающая 
громкости, чтобы понизить уровень 
голоса в части песни. Однако при 
воспроизведении мы обнаруживаем, что, 
возможно, случайная фраза или слово, 
немного спрятаны позади 
инструментального микса. Однако мы 
довольны этим миксом и не хотим 

изменять его или сжимать. 
 
Далее добавлена огибающая Trim 
Volume, которая далее регулирует 
громкость этого трека (как показано на 
рисунке слева).  
 
 
 
 
 
 
 

На данном этапе вы могли бы сказать. “Задание выполнено!”, но вместо этого вы могли бы продвинуться на шаг 
вперед, например, для того, чтобы закрепить изменения, сделанные в огибающей Trim Volume 
непосредственно в огибающей громкости трека. Для этого в REAPER предусмотрены следующие два действия: 
 
Track: Apply trim envelope to volume envelope, clear trim envelope (Трек: применить изменения Trim Volume 
огибающей непосредственно к огибающей громкости с последующей очисткой Trim Volume огибающей). 
Track: Apply volume envelope to trim envelope, clear volume envelope (Трек: применить изменения Trim 
Volume огибающей непосредственно к огибающей громкости с последующей очисткой огибающей громкости). 
 

 
 
В вышеупомянутом примере вы могли бы выполнить первое из этих действий, что привело бы к результату, 
показанному на рисунке выше. Trim Volume огибающую после этого можно либо удалить, либо использовать 
для дальнейших внесений изменений в огибающую громкости. 
 

18.24. Блокировка огибающих 
 
Если вы уверены, что добились правильных огибающих, их можно 
заблокировать, чтобы предотвратить случайные изменения или 
удаление. Горячая клавиша Shift +L (или щелчок правой кнопкой 

мыши по кнопке  на панели инструментов) открывает окно Lock 
Settings (см. рисунок слева). В этом окне можно выбрать опции Item 
envelopes (огибающие клипа) и/или Track envelopes (огибающие 
трека), наряду с любыми другими нужными вам опциями 
блокирования. Эти параметры можно изменить в любое время. 
Обратите внимание на то, что блокирование будет применено только в 
том случае, если вы активировали опцию Enable locking - горячая 
клавиша для которой - L. 
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18.25. Автоматизация параметров сгруппированных треков 
 

Если вы создали группировку треков, в которых вы определили 
отношения между различными параметрами, можно 
гарантировать, что эти отношения будут сохранены (или нет, по 
вашему усмотрению) при записи огибающих автоматизации. 
Делается это с использованием столбца Automation Mode 
группы в матрице группировки трека. Когда сами параметры трека 
сгруппированы, статус режима автоматизации для каждого трека 
в группе можно установить в значение master, slave или в оба. 
Рассмотрим пример. В каждом случае группировка схожа с 
группировкой в файле All Through The Night GROUPS.RPP. Если 
вы прошли ранее через эти примеры, вы без труда можете 
открыть файл All Through The Night GROUPS.RPP. 
 
 

 
Пример: 
 

 
 
В данном примере оба трека гитары в плане режима автоматизации установлены как в статус master, так и в 
статус slave, и активированы огибающие громкости обоих треков (обозначенные цветной круговой кнопкой 
налево от имени огибающей громкости). Любой из этих треков можно установить в режим Write, Touch или (как 
в данном примере), в режим Latch, а другие изменятся соответственно. Любые перемещения автоматизации 
будут записаны в оба трека (как на рисунке выше). Если бы огибающая автоматизации была активирована 
только на одном из треков, то автоматизация записывалась бы только на этом треке, а не в другом. 
 

18.26. Автоматизация с посылами трека 
 
Автоматизацию можно применить к другим контроллерам, кроме громкости и панорамы, например, к 
параметрам эффектов и посылов. В данном примере мы создадим посыл, а затем используем огибающую для 
управления этим посылом. 
 
Пример: 
 
1. Во-первых, мы собираемся создать шину эффектов, а затем используем огибающую для изменения уровня 
сигнала, посланного в эту шину с каждого из треков гитары. 
2. Создайте новый трек и именуйте его FX Bus. Отобразите цепочку эффектов этого трека и вставьте плагин JS 
Guitar/chorus. Закройте окно эффектов. 
3. Выберите трек Gtr Body и перетащите кнопку ROUTE этого трека на трек шины, чтобы создать посыл и 
отрегулировать уровни громкости и панорамы посыла как показано на рисунке ниже. 
 

 
 
4. Выберите трек Gtr Neck и откройте окно маршрутизации этого трека. Создайте посыл на шину эффектов и 
установите громкость посыла в -10dB, а панораму на 65% вправо. 
 
5. Теперь откройте окно огибающих для трека Gtr Body. Установите режим в значение Trim/Read. Заметьте, что 
для ваших посылов теперь доступны огибающие. Убедитесь, что выбрана огибающая FX Bus Send Volume, и 
отмечены флажки Visible и Arm. 
 



 Специально для сайта musicmanuals.ru  418 418 

 
 
6. Закройте это окно. Теперь дорожка огибающей для этого посыла должна быть видима на треке Gtr Body. 
7. Наведите мышь на любую часть огибающей, перетащите мышь вниз до значения приблизительно -12dB. 
8. Теперь давайте увеличим эффект хоруса, начав незадолго до второго запева. 
9. Добавьте узел приблизительно на 60-ти секундной отметке (Shift+щелчок). Добавьте другой узел 
приблизительно на отметке 2:30. 
10. Наведите мышь на огибающую сразу после второго узла и перетащите мышь до значения приблизительно -
7dB. Отпустите мышь. 
 

 
 
11. Установите режим автоматизации для этого трека в Read. Воспроизведите песню. Если вы считаете, что 
эффекта хоруса слишком много, наведите мышь на огибающую, в районе приблизительно 1:30, щелкните и 
удерживая левую кнопку мыши перетащите огибающую немного вниз. 
12. Теперь повторите шаги с 5 по 10 для трека Gtr Neck. 
13. Не забудьте сохранить файл. 
 

18.27. Автоматизация с параметрами эффектов 
 
Огибающие автоматизации можно создать для любых параметров почти любого JS, VST, VSTi, DX или DXI 
плагина, добавленного к цепочке эффектов любого трека или копии клипа. Данный параграф главным образом 
сфокусирован на эффектах трека, хотя те же самые способы могут быть применены для эффектов 
копий/клипов. Например, огибающие автоматизации можно использовать для изменения уровня компрессии 
трека ударных, или добавить теплоту к вокальной копии там, где это необходимо. Есть три основных способа 
создания огибающих для параметров ваших эффектов: 
 
- выберите параметры, для которых вы хотите добавить огибающие из окна огибающих. Возможно, для этого 
нужно будет щелкнуть по маленькой кнопке + рядом с именем плагина, чтобы отобразить список его 
автоматизируемых параметров. 
- щелкните правой кнопкой по свободной области любой текущей дорожки огибающей на панели трека и 
выберите нужный клип из меню параметров эффектов. В этом меню будут перечислены все автоматизируемые 
параметры для всех плагинов в цепочке эффектов трека (см. рисунок ниже). 
 



 Специально для сайта musicmanuals.ru  419 419 

 
 
- третий способ заключается в создании огибающей параметра из собственного окна плагина. Скорее это самый 
эффективный способ, потому что во многих случаях, это будет той окружающей средой, в которой вы, 
вероятнее всего, будете работать, когда решите создать огибающую.  
 
Процедура: 
 
1. Щелкните по нужному параметру. 
2. Нажмите кнопку Param, а затем выберите опцию Show track envelope из меню. Таким образом можно 
автоматизировать большинство эффектов, но помните, что особенно с некоторыми более старыми плагинами 
это может не работать. 
 

 
 
Пример: 
 
1. Откройте окно цепочки эффектов трека Vox. 
2. Добавьте в цепочку плагин JS LOSER/4BandEQ. Установите уровень параметра Frequency в 180. 
3. Солируйте трек Vox и воспроизведите песню. 
4. При этом удерживая клавишу Alt мягко увеличьте уровень громкости Low (верхний фейдер). Заметьте, как 
изменяется звук, который становится теплее. Отпустите мышь, и уровень сбросится назад в значение 0.0. 
5. Давайте добавим огибающую автоматизации для увеличения этого уровня для фразы All Through The Night 
в конце песни, приблизительно в отметке 2:14. Это сделает фразу теплее, но и громче. Поэтому, в целях 
компенсации мы должны будем добавить и другую огибающую для понижения громкости. 
6. Отрегулируйте масштаб трека Vox по горизонтали и по вертикали так, чтобы можно было четко видеть 
область, с которой вы будете работать. 
7. Щелкните по фейдеру Low dB эквалайзера, а затем нажмите кнопку Param. Выберите опцию Show track 
envelope из меню. Появится огибающая. Если вы не изменяли предварительные настройки по умолчанию, 
огибающая отобразится на своей дорожке. 
8. Отметьте как выделенную область последнюю часть песни. Используйте регулятор на панели трека чтобы 
приподнять эту огибающую в выделенной области приблизительно на 6 dB. 
9. Со все еще выделенной областью, используйте этот же самый фейдер чтобы понизить огибающую громкости 
приблизительно на 2 dB. 
10. Воспроизведите файл. Сохраните его. 

 
Совет 1: чтобы автоматически создать огибающую для любого параметра эффектов, отрегулированного 
на лету во время воспроизведения, перейдите Options > Preferences > Editing behavior > Automation и 
активируйте опцию Automatically add envelopes when tweaking parameters in automation write modes, 

а затем установите режим автоматизации трека в Touch, Latch или Write. 
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Совет 2: чтобы добавить управление для любого параметра эффектов на панели контроллеров трека, 
просто отметьте флажок UI в окне огибающих трека. Это позволит вам создавать или изменять 
огибающие на лету без необходимости открывать окно эффектов. 

 

 
 

Совет 3: Используя горячие клавиши Shift+Ctrl+перетаскивание для копирования эффектов с одного 
трека или клипа в другой, любой и все огибающие параметров эффектов, связанные с этими 
эффектами, будут скопированы также. 

 
18.28. Автоматизация параметров эффектов в режиме Learn 

 
При использовании REAPER с внешним аппаратным контроллером, таким как Behringer BCR2000, последний 
можно использовать в режимах Write, Latch или Touch для создания огибающих автоматизации параметров 
эффектов. Использовать можно регуляторы, фейдеры или кнопки (сообразно цели). Каждое устройство разное, 
поэтому ниже приведен только один из возможных примеров: 
 
1. В окне плагина щелкните по параметру, затем нажмите кнопку Param, а затем кнопку Learn. 
2. Затроньте кнопку, регулятор или фейдер на управляющем устройстве. В области Command появится 
подтверждающее сообщение. 
3. Выберите режим контроллера: обычно это опции absolute или одна из relative опций. Проконсультируйтесь с 
документацией устройства: если сомневаетесь, попробуйте для начала опцию Absolute.  
Для сглаживания операции выберите опцию Soft takeover. Также доступен режим Toggle, который позволяет 
переключать активирование параметров эффектов в одном представлении. 
 

 
 
4. Дополнительно, выберите опцию Enable only when effect configuration is focussed. Это позволит назначить 
тот же самый контроллер на другой параметр в другом плагине. 
5. В диалоговом окне MIDI/OSC Learn настройте управление на внешним устройстве, выберите опцию Arm 
envelope for selected parameter и нажмите OK. В зависимости от параметра теперь можно использовать 
управляющее устройство для записи изменений параметра в огибающей во время воспроизведения проекта.  
В режиме Trim/Read можно использовать управляющее устройство, чтобы вручную настроить параметр - см. 
Главу 12. 
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18.29. Автоматизация VST плагинов с помощью сообщений непрерывных MIDI 
контроллеров 

 
В зависимости от используемого устройства, есть два других способа отсылки сообщений непрерывных MIDI 
контроллеров для автоматизации параметров VST плагинов: 
 
1. Посыл сообщений непрерывного MIDI контроллера с MIDI источника (например, с MIDI клавиатуры, MIDI 
трека, плагина ReaControlMIDI или эффектов, которые выводят эти сообщения непосредственно в VST плагин.  
В некоторых VST плагинах сообщения непрерывных MIDI контроллеров, привязываются к определенным 
контроллерам, например, плагин Alpha от LinPlug, в других, например, AmpliTube, SampleTank 2 и Kontakt, 
назначения присваиваются. 
2. Посыл сообщений непрерывного MIDI контроллера с MIDI источника в плагин MIDItoReaControlPath (S&M).  
При этом в путь автоматизации Reaper вводятся сообщения непрерывного MIDI контроллера и далее в трек 
огибающей параметра VST, для которого использовалась функция MIDI Learn для отображения сообщений MIDI 
контроллера на этой огибающей. Подробнее об этом плагине на странице forum.cockos.com/showthread.php? 
t=43741. 
 

18.30. Автоматизация параметров эффектов на лету 
 
Если отмечена опция Automatically add and arm envelopes when tweaking parameters in automation write modes на 
странице Options > Preferences > Editing Behavior > Automation, то для любого трека установка режимов Write, 
Latch или Touch создаст огибающую автоматизации при установке значений параметров во время 
воспроизведения. Эту функцию можно использовать с внешним аппаратным контроллером. Обратите внимание 
на то, что любые изменения в параметрах, которые сделаны на экране мышью, будут применены, как и любые 
изменения, сделанные с использованием внешнего аппаратного контроллера. Будьте осторожны, так вы можете 
закончить тем, что создадите целую "кучу" нежелательных огибающих! 
 

Примечание: по окончании записи огибающих автоматизации таким образом, режим автоматизации 
изменится на Read или Trim/Read, в противном случае каждый настраиваемый вами параметр создаст 
другую огибающую, хотите ли вы это или нет. 

 
18.31. Автоматизация параметров эффектов клипов и копий клипов 

 
На отдельные клипы и копии можно назначить их собственные огибающие громкости, панорамы, высоты тона и 
мьютирования. Один из способов сделать это - щелкнуть правой кнопкой по клипу, выбрать опцию Take, а затем 
выбрать нужную огибающую из меню.  
 

Альтернативно, нажмите кнопку Envelope клипа (если она видима), и сделайте выбор 
из меню. Кнопки, которые будут отображаться можно выбрать на странице Options > 
Preferences > Appearance > Media. 
 
 
 

 
18.31.1. Огибающие клипов 
 

На рисунке слева, к клипу добавлена огибающая панорамирования, 
используя опцию Take > Take pan envelope. Клип панорамируется 
сначала дальше от центра, а затем назад ближе к центру. Огибающую 
можно отредактировать добавлением узлов, их перемещением, и так 
далее, точно так же, как любую другую. Можно щелкнуть правой кнопкой по 
любому узлу или сегменту огибающей копии, чтобы получить доступ к 

контекстным меню. Можно также создать различные огибающие для различных копий того же самого клипа. 
 
18.31.2. Огибающие нескольких копий 

 
На рисунке слева, к обоим копиям добавлены отдельные огибающие 
панорамы для последнего запева песни, с различными эффектами. 
Комбинация различных значений панорамы и плагин ReaVerbate, 
добавленный в одну из копий, могут сделать интересным вокальный 
эффект, если для этого клипа активирована опция Play all takes (в 
свойствах клипа). Чтобы скопировать огибающие копии клипа с 
одного клипа в другой на том же самом треке, используйте горячую 

клавишу Ctrl+перетаскивание кнопки огибающей. Чтобы переместить огибающие, используйте горячую 
клавишу Alt+перетаскивание кнопки огибающей.  
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Отображение/скрытие этих кнопок можно активировать на странице Options > Preferences > Appearance > 
Media > Media item buttons > Automation envelopes. 
 
18.31.3. Огибающие параметров эффектов копии 
 
Параметры эффектов, добавленных к отдельным копиям, можно также автоматизировать. Их можно 
отредактировать вручную, с помощью узлов, добавляемых вручную в режиме Trim/Read, или записанных в 
режимах Write, Latch or Touch. Процедура ручного редактирования или записи огибающих параметров 
эффектов клипов/копий являются по сути тем же самым, что процедура, используемая с параметрами 
эффектов трека. Параметры для автоматизации можно выбрать одним из двух способов: 
 
- из окна Envelopes for takes клипа, которое отображается нажатием кнопки Automation envelopes (если 
таковая видима), или при выборе опции Take > Take envelopes, или 
- отобразить цепочку эффектов трека (Shift +E), выбрать нужные эффекты, а затем выбрать огибающую 
нужного параметра из меню кнопки Param. Обратите внимание, что режим Learn также поддерживается. 

 
Советы: любую цепочку эффектов можно скопировать с клипа в другой клип, перетащив эффекты от 
цепочки эффектов первого клипа во второй клип. Можно скопировать всю цепочку, перетащив кнопку FX 
клипа. Огибающие можно скопировать с клипа в другой клип, перетащив кнопку Envelopes. 

 
Напоминание! какие кнопки клипа вы хотите видеть, можно выбрать на странице Options > Preferences 
> Appearance > Media. 
 

 
 

18.32. Автоматизация посылов с аппаратного устройства 
 
Если вы используете посыл аппаратного устройства с каким-либо из ваших треков, вы обнаружите, что можно 
автоматизировать громкость, панораму и мьютирование этих посылов. Эти элементы появятся в окне 
огибающих трека как показано на рисунке ниже.  
 

 
 
В данном примере у нас есть посыл с трека Vox на выходной канал аппаратного устройства. Мы можем создать 
огибающую для управления громкостью этого посыла.  
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Мы можем пойти и дальше - использовать перемещения фейдера для формирования этой огибающей, но не 
используя режим Write для всех других огибающих, которые мы, возможно, также создали. Это может быть 
сделано из окна маршрутизации трека. Взгляните на снимок экрана ниже.  
 

 
 
Режим автоматизации установлен в Touch из окна маршрутизации только для этой одной огибающей.  
Теперь вы могли бы воспроизвести трек, регулируя фейдер посыла выходного сигнала аппаратного устройства 
в окне, как на рисунке выше, для настройки уровня громкости посыла и создания вашей огибающей. То же 
самое можно сделать и с огибающими посыла трека. 
 

18.33. Автоматизация автоматизации 
 

Не забывайте о мощных возможностях списка действий 
REAPER. Например, если есть задача автоматизации или 
последовательность задач, которые вы используете часто, 
для выполнения этой последовательности можно назначить 
горячую клавишу. Например, предположим, что для 
текущего трека нужно часто отображать и выбирать, 
готовую для автоматизации огибающую громкости, а затем 
выбирать режим автоматизации Write для этого трека. Вы 
могли бы использовать опцию Actions > Show action list, 
чтобы открыть окно действий и создать собственное 
действие, схожее как на рисунке слева. Вы могли бы 
назначить горячую клавишу на это пользовательское 
действие или добавить его на одну из ваших панелей 
инструментов. Обратитесь к Главе 15 для получения 
дополнительной информации о пользовательских 
действиях, горячих клавишах и пользовательских панелях 
инструментов. 

 
18.34. Действия управления огибающими 

 
В Главе 15 вы познакомились с некоторыми действиями REAPER, и как можно использовать редактор действий 
и список действий для назначения этих действий на горячие клавиши и/или на пользовательские панели 
инструментов. Этот список включает очень много действий для управления огибающими, включая фиксацию 
огибающих, переключения статуса активности различных огибающих, и выбора определенных огибающих. 
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18.35. Автоматизация метронома 
 
Вы можете автоматизировать поведение 
Метронома - например, чтобы заставить его 
звучать только в определенное время. Для этого 
просто создайте новый трек и используйте опцию 
Insert > Click Source, чтобы вставить клип в ваш 
файл. Затем можно рассматривать этот трек 
щелчка, как и любой другой трек - например для 
добавления огибающей мьютирования, чтобы 
приглушить определенные фрагменты и так 
далее. Чтобы изменить любое из свойств трека 
щелчка, щелкните правой кнопкой по треку и 
выберите опцию Source Properties из меню. 
Например, можно изменить параметры BPM или 
использовать собственные сэмплы для создания 
долей. 
 
 
 
 
 
 
 
 

 
18.36. Огибающие темпа/музыкального размера и скорости воспроизведения 

 
В Главе 10 вы изучили, как изменить музыкальный размер и/или темп в рамках проекта. Другой (и возможно 
более интуитивный) способ сделать это - использовать огибающую темпа/музыкального размера. Чтобы 
отобразить эту огибающую в главном окне аранжировки REAPER: 
 
1. Перейдите View > Tempo envelope из главного меню REAPER. 
 

2. Установите режим автоматизации для мастер-трека в Read.  
 
 
 
 
 
 
 

 
Диапазон огибающей темпа (bpm) можно установить на странице Options > Preferences > Editing Behavior > 
Envelope Display (Глава 22). Когда отображена темпокарта, огибающая появляется на мастер-треке в области 
аранжировки. Эту огибающую можно изменить разными способами, как и любую другую - добавить узлы, 
переместить, удалить, отрегулировать их, и т.д. Однако огибающая мастер-темпа не может быть изменена в 
ручном режиме. Кроме того, редактирование нескольких узлов сразу на этой огибающей заставит каждый узел 
быть отрегулированным пропорционально, а не постоянное значение BPM. С каждым узлом огибающей 
вставляется и маркер темпа/музыкального размера на шкале времени - редактирование их значений будет 
иметь тот же самый эффект что и при редактировании узлов огибающей, и, если вы перемещаете их, а затем 
перемещаете узлы огибающей вместе с ними (и наоборот). Список действий REAPER также включает действие 
Adjust entire envelope tempo, которое открывает диалоговое окно, обеспечивающее опции настройки всей 
огибающей по процентам или установкой количеством ударов в минуту.  
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Можно также добавить к мастер-трек огибающую скорости воспроизведения, которая может использоваться для 
автоматического изменения скорости воспроизведения проекта. Эта огибающая применяется ко всем трекам, 
как к аудио, так и к MIDI. Для этого: 
 
1. Нажмите кнопку Envelopes мастер-трека. В окне огибающих мастер-трек отметьте элемент Playrate. 
Убедитесь, что этот клип отмечен и как видимый и как активированный. 
2. Закройте окно. 
 

18.37. Автоматизация клипов 
 
Функция клипов автоматизации в REAPER позволяет определить огибающую автоматизации целиком или часть 
огибающей (включая огибающие видеопроцессора) в качестве клипа, а затем впоследствии применить эту 
автоматизацию к любому клипу или клипам в том же самом или любом другом проекте. Сама концепция не 
сложная, но на практике есть множество опций и вариаций способов, которыми вы можете ее применить. 
Прежде чем изучить эти опции, давайте начнем с рассмотрения практического примера с использованием 
низкочастотного осциллятора для формирования огибающей. 
 
Пример: 
 
Данный пример представлен для ознакомления вас с базовой концепцией автоматизации клипов. 
 
1. Во-первых, мы импортируем сэмпл в новый трек. Затем мы копируем зацикленный сэмпл так, чтобы паттерн 
повторялся нужное количество раз (как показано на рисунке ниже). 
 

 
 
2. Теперь мы хотим добавить низкочастотный осциллятор к этому клипу. Для этого мы сначала выбираем клип и 
добавляем огибающую громкости. 
3. Затем мы выделяем фрагмент, охватывающий оригинальный сэмпл. Затем, мы щелкаем правой кнопкой 
мыши по огибающей и переходим Automation items > New automation item (как показано на рисунке ниже). 
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Тем самым создается клип автоматизации (с заголовком внизу). Мы щелкаем правой кнопкой мыши по 
заголовку и выбираем Properties, чтобы открыть одноименное диалоговое окно. Далее мы настраиваем 
параметры по усмотрению (пример показан ниже). Тем самым создаются узлы и определяется форма 
огибающей. По окончании закрываем окно. 
 

 
 
4. Мы можем захватить только правую границу заголовка клипа (внизу самого клипа) и расширить 
автоматизацию до конца клипа, как показано на рисунке ниже.  
 

 
 
Теперь наш клип автоматизации включает (в данном случае) четыре идентичных сегмента. Изменения в любом 
из сегментов автоматически отразиться теми же самыми изменениями в других трех сегментах. Эти изменения 
могли бы быть, например, ручным редактированием или внемением изменений в свойства автоматизации 
клипа, включая параметры LFO. Далее объясняется автоматизация клипов и ее использование более подробно. 
Следует иметь в виду, что работая с клипами автоматизации применяются типичные действия Windows, 
например, щелчок для выбора, Ctrl+щелчок для выделения фрагмента, и Shift+щелчок для выбора серии 
смежных клипов. 
 

Примечание: автоматизация клипов не используется с огибающими темпа. 
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18.37.1. Термин Low Frequency Oscillation (LFO) 
 
LFO - электронный сигнал (обычно ниже 20 Гц), который используется для создания ритмичного пульса. Он 
может использоваться для модулирования синтезаторов и аудиоматериала в производстве электронной 
музыки, например, для создания таких эффектов, как тремоло, фазировка и вибрато. Контроллеры LFO: 
 
LFO Shape: форма LFO. Значения: None, Parametric, Triangle, Shape или Square. 
Frequency: количество появляющейся формы в клипе. 
Baseline: поднимает или понижает базовую линию огибающей. 
Amplitude: определяет глубину модуляции: чем выше амплитуда, тем больше кривая. 
Контроллеры Skew: эти контроллеры изменяют интенсивность каждого возникновения формы в клипе. 
 
18.37.2. Работа с клипами автоматизации 
 
Чтобы создать новый пустой клип автоматизации на огибающей: выделите область, щелкните правой 
кнопкой мыши в рамках этой области на огибающей и перейдите Automation items> New automation item или 
захватите область ниже огибающей и перетащите ее слева направо с нажатой клавишей Alt. 
Чтобы создать новый клип автоматизации при записи автоматизации в огибающую: на странице 
Preferences > Editing behavior > Automation отметьте опцию Always create new automation item when writing 
automation. 
Чтобы вставить ранее сохраненный клип автоматизации на огибающую: щелкните правой кнопкой мыши на 
огибающей и перейдите Automation items > Load > Load. Выберите имя клипа и нажмите Open. 
Чтобы добавить LFO к клипу автоматизации и/или изменить другие свойства: дважды щелкните по 
заголовку клипа (в конце клипа) и в диалоговом окне Automation Item Properties выберите форму LFO и 
настройте другие параметры по необходимости. По завершеню закройте диалоговое окно. 
Чтобы сконвертировать текущую огибающую в клип автоматизации: добавьте узлы к огибающей. Выделите 
область, щелкните правой кнопкой мыши на огибающей в рамках этой области и перейдите Automation items> 
New automation item. 
Чтобы сконвертировать клип в обычный сегмент огибающей: щелкните правой кнопкой мыши на заголовке 
клипа и выберите опцию Delete automation item preserve points. 
Чтобы деактивировать огибающую вне клипа автоматизации: щелкните правой кнопкой мыши на 
огибающей и отметьте опцию Disable envelope outside automation items. 
Чтобы отредактировать клип автоматизации: добавьте, переместите, удалите узлы и т.д. точно так же как и 
с любой огибающей. Чтобы изменить LFO и другие параметры, дважды щелкните по заголовку клипа, чтобы 
открыть окно Automation Item Properties. 
Чтобы присвоить имя или переименовать клип: откройте окно Automation Item Properties и введите имя. 
Чтобы переместить клип автоматизации: захватите заголовок клипа и переместите клип влево или вправо 
или вверх/вниз в другую огибающую, на том же самом или другом треке или клипе. 
Чтобы переместить содержимое клипа: при перетаскивании заголовка клипа влево или вправо удерживайте 
клавишу Alt. 
Чтобы скопировать клип автоматизации в другое местоположение: удерживайте клавишу Ctrl (чтобы 
скопировать необъединенный клип) или Ctrl+Alt (чтобы скопировать объединенный клип) при перетаскивании 
заголовка в место назначения на том же самом или на другую огибающую на любом треке или выбранном 
клипе, затем перетащите заголовок клипа в нужное местоположение с нажатой клавишей Alt. 
Чтобы удалить из пула клип автоматизации: в контекстном меню улипа выберите опцию Remove from pool. 
Чтобы использовать клипы автоматизации с параметрами эффекта: вставьте эффект (например, 
компрессор) в цепочку эффектов и добавляет огибающую параметра обычным способом. Создайте и примените 
клипы как обычно. 
Чтобы расширить/скопировать содержимое клипа автоматизации: захватите правую границу клипа и 
перетащите ее вправо или захватите левую границу и переместите ее влево. 
Чтобы расширить клип автоматизации, собирая текущие узлы: захватите правую границу клипа и 
перетащите ее вправо или захватите левую границу и переместите ее влево с нажатой клавишей Ctrl. 
Чтобы объединить клипы автоматизации вместе: с нажатой клавишей Ctrl щелкайте по заголовкам нужных 
клипов. Щелкните правой кнопкой мыши по любому заголовку выбранных клипов и выберите опцию Glue. Клипы 
будут объединены в один клип, который будет также включать любые части огибающей между объединенными 
клипами. Ниже приведен пример до и после. 
 

 
 



 Специально для сайта musicmanuals.ru  428 428 

Чтобы зациклить / снять зацикливание клип: в диалоговом окне Automation Item Properties используйте 
опцию Loop. 
 

Чтобы растянуть / сократить клип: захватите правую границу 
клипа и перетащите ее вправо или захватите левую границу и 
переместите ее влево с нажатой клавишей Alt. 
Чтобы сохранить клип автоматизации: щелкните правой кнопкой 
мыши по заголовку клипа и выберите Save, введите имя и нажмите 
Save. 
Чтобы удалить клип автоматизации: щелкните правой кнопкой 
мыши по заголовку клипа и выберите опцию Delete. 
Чтобы мьютировать клип автоматизации: щелкните правой 
кнопкой мыши по заголовку клипа и выберите опцию Mute (опция 
переключаемая). 
Чтобы разделить клип в позиции курсора: щелкните правой 
кнопкой мыши по заголовку клипа и выберите опцию Split. 
 
 
 

 
Чтобы продублировать клип автоматизации в качестве объединенного: щелкните правой кнопкой мыши по 
заголовку клипа и выберите опцию Create pooled duplicate. Любые шаги редактирования, примененные к 
любому клипу в пуле будут применены ко всем клипам в пуле. 
Чтобы продублировать клип автоматизации в качестве не объединенного: щелкните правой кнопкой мыши 
по заголовку клипа и выберите опцию Create unpooled duplicate. При этом каждый клип может быть 
отредактирован независимо от других в пуле. 
 

Чтобы использовать несколько клипов автоматизации одновременно на той же 
самой огибающей: при создании нескольких клипов автоматизации и перетаскивая их 
в разных направлениях, вы можете создать ситуации, когда два или более клипов 
автоматизации можно использовать одновременно на той же самой огибающей. 
 

 
Примечания: 
- Чтобы проигнорировать привязку при выполнении любых вышеупомянутых действий перетаскования, 
удерживайте также клавишу Alt. 

- Основное различие между объединенными и необъединенными клипами заключается в том, как они ведут 
себя при редактировании. Необъединенный клип абсолютно независим и может быть отредактирован не 
затрагивая другой клип. Изменения, внесенные в любой объединенный клип, с другой стороны, будут 
применены ко всем клипам в этом пуле. Однако, …. 
- При редактировании объединенных клипов через диалоговое окно Automation Items Properties, изменения, 
внесенные в параметры All pooled copies box будут применены ко всем клипам в пуле. Доступна также опция 
Baseline/amplitude to affect pooled copies.  
Другие изменения, внесенные в окне Automation Items Properties будут применены только к отдельному 
отредактированному клипу. 
- Если опция Move envelope points with media item (меню Options) активирована, то при вырезании, 
копировании вставе, перемещении, дублировании и т.д. клипа любая автоматизация, примененная к нему, 
будет перемещена вместе с клипом.  
Если часть клипа включает только часть автоматизации клипа, только эта часть будет перемещена или 
скопирована с автоматизацией клипа. 
- Там, где присутствует автоматизация клипов в регионах, она будут перемещен и скопирована с регионами. 
 
18.37.3. Предварительные параметры для клипов автоматизации, действия, модификаторы 
мыши, опции в меню Options и браузер клипов 
 
18.37.3.1. Предварительные параметры автоматизации клипа 
 
Разделы Editing Behavior > Automation и Editing Behavior > Envelope Display на странице предварительных 
параметров (Глава 22) включают опции клипа автоматизации, позволяющие управлять зацикливанием, 
поведением объединенных клипов и основным поведением огибающей. 
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18.37.3.2. Действия для клипов автоматизации 
 
Список действий включает различные команды для клипов автоматизации и действия: 
 
Options: Loop new automation items by default. (опция переключаема) 
Options: Always create new automation items when writing automation 
Options: Automation item baseline /amplitude edits affect pooled copies 
Options: Automation items connect to the underlying envelope on both sides 
Options: Automation items connect to the underlying envelope on the right side 
Options: Automation items do not connect to the underlying envelope 
Options: Reduce envelope data when recording or drawing automation 
Options: Remove points from underlying envelope when creating automation items 
Options: Trim content behind automation items when editing 
Envelope: Add edge points to automation item 
Envelope: Enable /disable envelope outside of automation items (AIs) 
Envelope: Enable /disable envelope outside of AIs for all envelopes on selected track 
Envelope: Enable /disable envelope outside of AIs for all envelopes in project 
Envelope: Enable/disable envelope outside of AIs for all visible track envelopes 
Envelope: Mute automation items 
Envelope: Glue automation items 
Envelope: Set loop points to automation item 
Envelope: Set time selection to automation item 
Envelope: Split automation items 
Envelope: Toggle automation item loop. 
 
Кроме того, все команды в списке выше доступны в качестве действий в редакторе действий REAPER, и как 
таковые могут быть назначены на горячие клавиши, ярлыки на панели инструментов и/или собственные меню. 
Подробности в Главе 15. Другие действия для опций не входящие в меню включают переключаемые действия 
для управления основным поведением огибающей. 
 
18.37.3.3. Модификаторы мыши для клипов автоматизации 
 
Модификаторы мыши для клипов автоматизации включают контексты Automation item (left drag, double-click), 
и Automation item edge (left drag). Эти контексты включают все действия мыши, перечисленные выше, а также 
некоторые дополнительные опции. Вы можете изменить назначения модификаторов мыши по умолчанию по 
вашему усмотрению. На странице предварительных настроек модификаторов мыши доступна опция Edits affect 
all pooled items at the same position. Кроме того, модификатор Envelope lane контекста left drag включает 
несколько действий и опции для рисования копий выбранных клипов автоматизации. 
 
18.37.3.4. Меню Options 
 
Кроме того. главное меню Options включает четыре переключаемые опции для определения взаимодействия 
клипов автоматизации с огибающими: 
 
Bypass underling envelope outside of automation items (per project) 
Do not attach to the underlying envelope 
Attach to the underlying envelope on right side 
Attach to the underlying envelope on both sides. 
 
18.37.3.5. Браузер клипов 
 
Клипами автоматизации можно управлять из браузера клипов как и другими клипами. Просто перейдите к 
правильной директории, щелкните правой кнопкой мыши по имени любого клипа и выберите из меню опции 
вставки в проект (см. рисунок ниже). 
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19. Автоматизация с модуляцией параметров 
 

19.1. Концепция 
 
Модуляция параметров лучше всего реализована в более продвинутых микшерах. Данная глава является 
вводной частью, и неизбежно (в виду сложности темы) вызовет трудности понимания у новичков. Модуляция 
параметров поднимает возможности маршрутизации REAPER, разделения каналов, автоматизацию и сайдчейн 
на новый уровень. Модуляция параметров в ее самой простой реализации означает использование уровня 
громкости трека или одного, или более параметров эффектов для управления поведением одного или более 
параметров эффектов на том же самом треке или на другом треке или в ряде треков. Понимание сути этой 
функции прояснится после рассмотрения нескольких примеров. Один относительно простой пример коснется 
применения эффекта хоруса к трекам Bouzouki или Guitar. Предположим, что мы хотим изменить уровень 
присутствия эффекта (wet level) хоруса на протяжении всего трека. Мы могли бы, конечно, достигнуть этого с 
использованием огибающих автоматизации. Однако это может оказаться достаточно трудоемким занятием с 
частым редактированием огибающих. Давайте разовьем эту идею. Мы можем определить отношения между 
громкостью инструмента и уровнем присутствия эффекта хоруса так, чтобы с повышением уровня громкости 
уменьшалась степень присутствия эффекта в миксе и наоборот. Вместо того, чтобы создать серию огибающих 
для хоруса, мы можем использовать модуляцию параметров так, чтобы хорус автоматически отвечал в режиме 
реального времени на изменения громкости. Кстати, этот конкретный пример может создать интересный 
эффект пространства и расстояния инструмента. Изменения такого эффекта как хорус очень заметны для 
человеческого уха. Данный пример призван показать принцип использования модуляции параметров. Затем от 
вас будет зависеть где и как применять полученные знания в ваших собственных миксах. 
 

19.2. Интерфейс 
 
Во-первых, необходимо определиться с несколькими основными терминами. При выборе модулируемого 
параметра сначала вы увидите окно, как на рисунке ниже. В данном примере мы собираемся применить 
модуляцию параметров для управления порогом (threshold) компрессора вокального трека. Это начальное окно 
включает пять основных опций: 
 

 
 
Enable parameter modulation, baseline value: должна быть отмечена для применения модуляции параметров. 
Если опция не отмечена модуляция обходится (статус bypass). 
Фейдер baseline value: определяет начальное значение управляемого параметра. Вскоре мы рассмотрим 
пример использования этого контроллера. На данном этапе оставьте этот фейдер как есть (полностью влево). 
Audio control signal (sidechain): выбор этой опции открывает окно, которое используется для выбора трека 
(или треков) аудиосигнал которых будет использоваться для управления модулируемым параметром и способ 
применения модуляции. Вскоре мы также рассмотрим пример использования этого параметра. 
LFO: Эта опция позволяет вам использовать сигнал низкочастотного осциллятора для генерации тона (формы 
волны), который будет управлять модулируемым параметром. Наиболее вероятно (но не обязательно) эта 
опция будет использоваться в случаях модуляции параметров синтезатора. 
Link from MIDI or FX parameter: эта опция позволяет вам привязать (сделать ссылку) один параметр эффекта 
(на треке или клипе) к другому. Примером может служить ситуация, когда при более сильной компрессии трека 
или клипа, к эквалайзеру добавляется некоторое присутствие для компенсации потери динамики. Другой 
пример – при регулировании wet/dry баланса эффекта задержки для добавления дополнительной задержки, 
позиция панорамирования задержанного сигнала будет перемещаться автоматически. Возможности 
действительно безграничны. MIDI ссылки на события будут рассматриваться отдельно в конце этой главы. 
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19.3. Выбор параметра для модуляции 
 
Модуляция может применяться к параметрам эффектов трека и/или с эффектов копий/клипов. На примере окна 
модуляции параметра ниже отмечены только опции Enable parameter modulation и Audio control signal. 
Список ниже включает описание основных параметров и описывает их функции и область применения. Затем 
мы рассмотрим некоторые примеры, показывающие как может использоваться модуляция параметров. 
 

 
 
Enable parameter modulation, baseline value: опция активирует/отключает модуляцию для данного параметра. 
Фейдер Baseline value ниже устанавливает значение по умолчанию модулируемого параметра. Однако, если 
для этого параметра есть огибающая автоматизации, именно эта огибающая будет определять исходное 
значение (baseline value), а параметр Enable parameter modulation будет проигнорирован. 
Audio control signal (sidechain): активирует/отключает управление параметра аудиосигналом канала, 
выбранного в меню Track audio channel. 
Меню Track audio channel: выбор канала (каналов) - например, 1/2 или 3/4 аудиосигнал которых будет 
использоваться для управления указанным параметром. Доступные каналы будут зависеть от того, сколько их 
было до этого определено для конкретного трека. В большинстве случаев вы будете использовать каналы 1 + 2. 
Это гарантирует, что параметром будет управлять аудиосигнал его собственного трека. Однако, как вы увидите 
вскоре, можно выбрать и другой источник, кроме 1 + 2, если вы хотите, чтобы параметром эффекта на одном 
треке управлял аудиосигнал с другого трека. Последний пример может стать примером модуляции параметров 
с использованием функции сайдчейн. 
Фейдеры Attack и Release: эти два фактора определяют скорость применения изменений к параметру на 
уровне входящего сигнала. По функционалу они схожи с одноименными параметрами компрессора. Чем больше 
значение параметра Attack, тем медленнее параметр будет отвечать на изменения громкости в аудиоканале-
источнике. Чем ниже значение параметра Release, тем быстрее будет применяться модуляция после 
понижения громкости. Более высокая скорость будет удерживать модуляцию дольше. Обобщая, чем выше 
значение параметров Attack и Release, тем более постепенным будет отклик модуляции параметра. Чем ниже 
значения этих параметров, тем более чувствительный (грубый) и непосредственный будет отклик. 
Фейдеры Min Volume и Max Volume: определяют диапазон, в пределах которого сигнал аудиоканала трека 
будет использоваться для изменения параметра эффекта. Например, на рисунке выше, рассматриваемый 
параметр (chorus wet mix) на рассматриваемом треке (трек Bouzouki) будет управляться аудиосигналом 
каналов 1 и 2 только тогда, когда его громкость будет находиться в пределах диапазона от - 24 dB до - 0.53 dB. 
Если или, когда сигнал тише значения -24 dB или громче значения - 0.53 dB, модуляция параметров фактически 
будет установлена в статус обхода. 
Фейдеры Strength и Direction: определяют источник и интенсивность отношений между входящим 
аудиосигналом и управляемым параметром. Например, в значении 100% с отмеченной опцией Positive при 
увеличении или уменьшении входящего аудиосигнала значение управляемого параметра будет также 
увеличиваться или уменьшаться пропорционально.  
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В значении 50% с отмеченной опцией Positive отношения будут более скромными. Аналогично, в значении 
100% с отмеченной опцией Negative при увеличении входящего аудиосигнала, значение управляемого 
параметра будет уменьшаться в той же самой пропорции, и наоборот. В значении 50% с отмеченной опцией 
Negative отношения будут более умеренными. В значении 0% эффект будет абсолютно нейтрален. 
Диаграмма Audio Control Signal Shaping: этот графический контроллер помогает сформировать поведение 
изменяемого параметра. Например, если параметр Direction будет установлен в Positive, перемещение 
маленького красного хэндла (в центре диагональной линии) на диаграмме в правый нижний угол приведет к 
более скромным увеличениям значения изменяемого параметра. С другой стороны, перемещение этого хэндла 
в верхний левый угол приведет к более заметным увеличениям значения изменяемого параметра. Не 
беспокойтесь, вскоре мы рассмотрим подробный пример. 
 

19.4. Выбор модулируемого параметра 
 
Чтобы выбрать модулируемый параметр эффекта: 
 
1. Откройте окно огибающих трека и нажмите кнопку + любого плагина, чтобы отобразить список его 
контроллеров. 
2. Нажмите кнопку Mod любого параметра, который будет модулироваться аудиосигналом. Затем вы увидите 
маленький флажок рядом с лейблом Mod этого элемента в окне огибающих (как показано на рисунке ниже). 
 

 
 
3. Закройте окно огибающих трека. 
 
Или: 
 
1. Откройте окно эффектов трека или клипа. 
2. Щелкните по контроллеру параметра, который вы хотите модулировать. 
3. Нажмите кнопку Param в окне плагина, а затем выберите опцию Parameter modulation из меню (как показано 
на рисунке ниже).  
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Обратите внимание (справа) на имя последнего затронутого параметра, т.е. параметра, к которому будет 
применена модуляция - оно отображается затененным наверху меню кнопки Param. 
 

19.5 Модуляция параметров под управлением аудиосигнала 
 
В первом примере мы добавим хорус в цепочку эффектов трека, а затем будем использовать аудиосигнал этого 
трека для управления плагином. 
 
Пример: 
 
1. Откройте файл All Through The Night и сохраните его под именем All Through The Night MOD1. 
2. Отрегулируйте фейдеры трека по усмотрению. Как пример - установите громкость трека Vox в значение -0.5 
db, панораму установите по центру, трек Guitar Body в значение 0 db, панораму на 55% влево, трек Guitar Neck 
в 0 db, панораму на 63% вправо и трек Bouzouki в значение -4 db, панораму на 15% влево. 
3. Солируйте трек Bouzouki. В данном примере это единственный трек, который нам нужен. 
4. Вставьте плагин JS: Delay/delay_chorus в цепочку эффектов трека Bouzouki, и отрегулируйте его параметры 
как на рисунке ниже. 
 

 
 
5. Щелкните по регулятору Output Wet (Chorus) (dB) плагина. Заметьте, что в настоящее время он установлен в 
значение 0.0. 
6. Нажмите кнопку Param, а затем выберите опцию Parameter Modulation/MIDI link из меню. В окне модуляции 
параметра Output Wet отметьте опцию Audio control signal и в меню Track audio channel выберите 1+2. 
Воспроизведите трек. 
7. Изначально значение регулятора Wet плагина (справа от кнопки 2 in 2 out) было установлено в значение 
100%, как показано на рисунке. Однако, по мере регулирования фейдера Baseline value (в окне модуляции), во 
время воспроизведения трека, значение регулятора Wet в окне плагина Chorus также будет изменяться. 
Установите значение регулятора Wet приблизительно в 50%. 
8. Установите различные элементы в окне модуляции параметра как показано на рисунке ниже и 
воспроизведите трек.  
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Заметьте, что значение элемента wet chorus будет постепенно понижаться в более громких нотах и 
фрагментах и повышаться в более тихих нотах и фрагментах. 
9. Теперь поэкспериментируйте! Заметьте, что: 
 
- перемещение фейдеров Attack и Release влево приведет к более резкому перемещению фейдера wet chorus.  
- перемещение фейдеров Attack и Release вправо приведет к более сглаженному перемещению фейдера wet 
chorus. 
- при перемещении фейдера Strength вправо, значение фейдера wet chorus будет постепенно убавляться в 
более громких нотах и подниматься в более тихих.  
- при перемещении фейдера Strength влево поведение фейдера wet chorus будет инвертироваться. 
- перемещение фейдера Min Volume влево будет понижать порог, при котором применяется модуляция 
параметров. Перемещение фейдера вправо поднимет порог. 
 
10. Когда вы закончите экспериментировать, установите параметры как на рисунке. 
11. Теперь инструмент будет становиться громче по ходу песни. Воспроизведите песню со снятым статусом 
солирования трека Bouzouki. К концу песни степень хоруса к треку Bouzouki уменьшится. 
12. Теперь воспроизведите песню снова. Захватите хэндл на диаграмме и перетащите его в нижний правый 
угол. Заметьте, что перемещения фейдера wet chorus теперь становятся менее заметными. 
13. Теперь перетащите хэндл в верхний левый угол диаграммы (как показано на рисунке ниже).  
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Заметьте, что перемещения фейдера wet chorus теперь становятся более ощутимыми, а уровень параметра 
wet mix достигает нижних значений. 
14. По окончании верните диаграмму в ее более раннюю позицию (как показано в шаге 10). Сохраните файл. 
 

19.6. Использование формы сигнала низкочастотного осциллятора с модуляцией 
параметров 

 
Теперь давайте немного позабавимся и попробуем использовать форму сигнала низкочастотного осциллятора 
для дальнейшего применения модуляции параметров. Отключите опцию Audio control signal и отметьте опцию 
LFO. Начните с настроек, показанных на рисунке ниже.  
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Выбор опции Tempo Sync должна помочь в достижении довольно безопасного результата! Фейдер Speed 
управляет частотой повторения сигнала. Фейдер Strength определяет степень применения сигнала 
низкочастотного осциллятора. Можно также отрегулировать параметр Phase. Как и в предыдущих примерах, 
параметр Direction можно установить в значение Negative, Centered и Positive. Обратите внимание также на 
кнопку Learn phase, которая может использоваться для назначения управления в MIDI или OSC устройстве. 
Сравните, как теперь звучит трек с активированной и отключенной опцией Enable parameter modulation. Если 
вы работали с низкочастотным осциллятором вы можете быть чуть более предприимчивым. В противном 
случае, просто сохраните файл под именем All Through The Night MOD1 LFO. 
 

19.7. Использование модуляции параметров для динамической компрессии 
 
В следующем примере мы будем использовать модуляцию параметров для динамического регулирования 
параметров компрессии вокального трека так, чтобы порог автоматически регулировался в более громких 
фрагментах. Это даст вам более детальное управление компрессором, которое в противном случае было бы 
невозможным. 
 
Пример: 
 
1. Откройте файл All Through The Night MOD1 и сохраните его под именем All Through The Night MOD1A. 
2. Панорамируйте трек Vox по центру и установите его громкость приблизительно в - 0.5 dB. 
3. Вставьте плагин ReaComp в цепочку эффектов трека Vox. 
4. Установите параметр Threshold приблизительно в -24 и параметр Ratio около 4:1. Установите параметр 
Knee приблизительно в 15 dB. Установите параметр Wet gain приблизительно в +1.6dB. 
5. По ходу воспроизведения песни, отрегулируете параметры по усмотрению. Один из возможных примеров 
настройки показан на рисунке ниже. 
 

 
 
6. По ходу воспроизведения трека, вы можете почувствовать, что местами компрессия корректна, а местами 
чрезмерна. Это - то, когда мы можем использовать собственный уровень громкости трека для управления его 
параметрами. В данном примере мы сделаем это только с параметром Threshold, но это можно также сделать 
и параметром Ratio, если пожелаете. 
7. Щелкните по фейдеру Threshold. 
8. Нажмите кнопку Param плагина. 
9. Из меню выберите опцию Parameter modulation/MIDI link. 
10. Обратите внимание на пример настроек на рисунке ниже, и отрегулируйте ваши параметры соответственно 
по ходу воспроизведения песни. Обратите также внимание на примечания ниже. 
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11. В частности обратите внимание на то, что параметры Attack и Release, форма кривой и громкость помогают 
препятствовать тому, чтобы параметр Threshold был отрегулирован слишком радикально. 
12. Сохраните и закройте файл по окончании. 
 

Примечания: настроив параметр Min Volume в окне модуляции параметра в тот же самый уровень, что 
и параметр Threshold в окне плагина мы гарантируем, что модуляция параметра будет применена 
только тогда, когда достигнет своей максимальной громкости. Значение параметра Strength в 33% 

означает, что для каждых превышенные 3 dB минимальной громкости, порог будет поднят приблизительно на 1 
dB. 

 
Примечание: при использовании модуляции параметров, необходимо тщательно настраивать 
различные параметры. Иногда даже малейшее изменение параметра могут значительно изменить 
результат. Если поначалу как вам кажется вы не достигли результата, поэкспериментируете с начальной 

настройкой параметров. 
 

19.8. Режим Bypass 
 
Каждый раз, когда вы создаете модуляцию, в 
окне модуляции параметра рядом с его 
именем добавляется небольшая область, 
которая может использоваться для 
активирования любой из ваших модуляций 
параметров или установки их в режим 
обхода (bypass mode). В противном случае 
вы можете сделать это из собственного окна 
модуляции параметра. В данном примере 
(на рисунке слева), показаны настройки 
модуляции для параметра Threshold, 
который активирован. Кроме того, обратите 
внимание на то, что щелчок по лейблу Mod 
элемента, где модуляция параметров уже 
существует, откроет окно (даже если 
модуляция параметра в настоящий момент 
отключена) в котором можно просмотреть 
и/или отредактировать параметры. 
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19.9. Модуляция параметров под управлением параметрами 
 
Привязав параметры можно использовать динамические изменения в одном параметре эффекта, чтобы 
непосредственно управлять другим. В следующем примере мы привяжем параметр Gain эквалайзера трека с 
параметром Threshold компрессора так, чтобы каждый раз, когда порог компрессии будет немного поднят, 
автоматически добавлялось немного теплоты. 
 
1. Откройте файл All Through the Night MOD1A и сохраните его под именем All Through the Night MOD1B. 
2. В цепочку эффектов вокального трека добавьте плагин ReaEQ (после плагина ReaComp). Выберите полосу 2 
(Band 2). Установите параметр Frequency приблизительно в 180 Hz, параметр Bandwidth приблизительно в 
2.00 octave и параметр Gain в 0.0 dB. 
3. В окне плагина ReaEQ щелкните по полосе 2 контроллера Gain, затем нажмите кнопку кнопка Param и 
выберите опцию Parameter modulation/MIDI link, чтобы открыть окно модуляции параметра. Выберите опцию 
Link from MIDI or FX parameter. 
4. Щелкните по большой кнопке ниже опции Link from MIDI or FX parameter и перейдите ReaComp > Thresh 
(как показано на рисунке ниже). 
 

 
 
5. Прежде, чем воспроизвести песню, отрегулируйте фейдер Baseline value так, чтобы параметр Gain на полосе 
2 плагина ReaEQ вернулся в значение 0 dB. 
6. Установите фейдер Offset в значение 10%, а фейдер Scale в значение +100% (см. также описания ниже). 
7. Воспроизведите песню и сохраните файл. 
 
В наших первых двух примерах (Параграфы 19. 5 и 19. 6) модуляция параметров использовалась для создания 
настоящего драматического эффекта. В последних двух примерах (Параграфы 19. 7 и 19. 9), эффект куда более 
тонкий. Два контроллера Offset и Scale могут использоваться для управления степенью, с которой управление 
параметра (в данном примере это параметр Threshold компрессора) изменяет управляемый параметр (в 
данном случае это параметр Gain полосы эквалайзера). Фейдер Offset повышает (вправо) или понижает (влево) 
значение изменяемого параметра в процентах. Фейдер Scale охватывает диапазон от -100% до +100%.  
В значении -100% отношения между параметром управления (параметр Threshold компрессора) и 
управляемым параметром (параметр Gain полосы 2 эквалайзера) будут 100% отрицательные: усиление 
эквалайзера будет изменяться зеркально поднятию порога. В значении +100% отношения будут на 100% 
положительными, т.е. противоположными. 
Если вы хотите управлять всем диапазоном целевого параметра, просто установите слайдер Baseline [B] влево 
(0%), Параметр Offset [O] в 0% и Scale [S] в 100%. Чтобы управлять только частью диапазона целевого 
параметра, в первую очередь, представьте диапахон процентном соотношении. Например, рассмотрим 
параметр усиления частотной полосы эквалайзера с диапазоном от -24 дБ до +24 дБ, и вы хотите управлять 
значением между -12dB и +12dB. Процентный диапазон будет соответственно от 25% до 75%. Убедитесь, что 
вы видите целевой параметр в интерфейсе эффекта и окне модуляции параметра, и установите значение 
параметр Scale [S] временно в 0%. Переместите слайдер Baseline [B]  на 25% вправо, и вы должны увидеть, что 
целевой параметр изменился на -12dB. Теперь установите параметр Scale в 50% (который составляет в 
процентном соотношении 75% - 25%). Вот именно. Необязательно регулировать параметр Offset (зачастую он 
вам и не будет нужен). Его можно использовать для смещения диапазонп вверх или вниз. Обратите внимание, 
что фактическое изменение определяется процентами параметра Offset умноженным на процент параметра 
Scale. Давайте посмотрим на следующие значения - [B] = 50%, [O] = 0% и [S] = 25%. Это приведет к диапазону 
от 50% до 75%. Если теперь мы установим параметр [O] в -40% диапазон изменится с 40% в 65%, изменения 
будут следующие: [O] x [S], который составляет -40% X 25% = -10%). 
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Модуляция параметров - очень мощная функция. В вышеупомянутом примере вы могли добавить управление 
для другого параметра Gain эквалайзера (возможно на полосе 3), управляемого на этот раз непосредственно 
аудиосигналом трека. Другой пример - использование, скажем, порога одного компрессора для управления 
непосредственно порогом другого компрессора, независимо от управления аудиосигналом трека. 
 

19.10. Модуляция параметра с огибающей 
 
Когда для модулируемого параметра активирована огибающая автоматизации, исходное значение будет 
определено именно этой огибающей, а не фейдером Baseline value в окне модуляции параметра. При этом 
фактически применяемое исходное значение изменяется самостоятельно (согласно огибающей) по ходу песни. 
Это может привести к некоторым интересным результатам. В данном примере мы добавим огибающую для 
управления параметром Gain полосы 2 эквалайзера ReaEQ. Нажатием кнопки Modulate на дорожке огибающей 
мы можем открыть окно модуляции параметра и выполнить необходимые шаги, чтобы гарантировать, что 
усиление эквалайзера автоматически будет отвечать на изменения громкости аудиосигнала на этом треке.  
В данном примере, когда огибающая будет понижена сразу после текущей позиции курсора воспроизведения 
будет также понижено и исходное значение модулируемого параметра. 
 

 
 

19.11. Модуляция параметров под управлением функции сайдчейн 
 
Этот пример знакомит вас с другим применением модуляции параметров. В данном случае мы будем 
использовать аудиосигнал с одного трека (вокальный трек) для формирования звука инструментального 
подмикса (т.е., трек-папки с несколькими инструментами). Это будет сделано так, чтобы инструменты отходили 
на второй план во время исполнения вокала. 
 
Пример: 
 
1. Откройте файл All Through The Night MOD1 и сохраните его под именем All Through The Night MOD2. 
2. Удалите или установите в обход плагин задержки в цепочке эффектов трека Bouzouki. 
3. Вставьте новый трек после вокального трека. Именуйте этот трек Instruments и превратите его в трек-папку. 
Поместите три инструментальных трека в этот трек-папку, как показано на рисунке ниже. 
 

 
 
4. Вставьте плагин ReaComp в цепочку эффектов трека Bouzouki. Это нужно только для того, чтобы громкость 
этого инструмента увеличивалась достаточно значительно по ходу песни. Мы хотим немного "спрятать" этот 
трек. 
5. Установите параметр Threshold приблизительно в -15dB, а параметр Ratio приблизительно в 4:1. 
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6. Выберите трек-папку Instruments и откройте ее окно маршрутизации. Установите количество каналов трека в 
4 и добавьте адресат с каналов 1/2 трека Vox на каналы 3/4 трек-папки Instruments. 
7. Откройте окно эффектов трек-папки Instruments и вставьте плагин JS: SStillwell/exciter. Он будет 
использоваться для небольшого украшения инструмента. 
8. Настройки, схожие с таковыми на рисунке ниже определенно украсят инструменты, возможно больше, чем вы 
хотели бы. Тем не менее в рамках данного примера эти настройки должны быть точно, как на рисунке ниже. 
 

 
 
9. Теперь мы собираемся использовать модуляцию параметров, чтобы гарантировать, что аудиосигнал 
вокального трека будет понижать уровень параметра Mix экскайтера. Это придаст эффект плавания вокала над 
инструментами. 
10. Щелкните по контроллеру Mix %, затем нажмите кнопку Param и выберите опцию Parameter 
modulation/MIDI link из меню. 
11. В окне модуляции параметров отметьте опции Enable parameter modulation и Audio control signal 
(sidechain). Переместите фейдер Baseline value приблизительно на одну треть вправо. 
12. В меню Track audio channels выберите 3/4 и установите параметр Direction в Negative. 
13. Отрегулируйте другие параметры так, чтобы вокал выделялся над инструментами. 
14. Одно из возможных решений этого примера показано на рисунке ниже. 
15. Сохраните файл по окончании. 
 

 
 

19.12. Использование MIDI ссылок для модуляции параметров 
 
MIDI данные можно также использовать для управления модуляцией параметров. Например: 
 
- с плагина ReaControlMIDI вживую или записанные в виде огибающей автоматизации. 
- с данных/событий, вводимых или записанных на дорожку MIDI контроллеров в MIDI редакторе. 
 
Например, вы можете использовать огибающую автоматизации для записи изменений громкости плагина 
ReaControlMIDI, а затем использовать эту огибающую для управления другим параметром эффекта, например, 
параметром Ratio компрессора.  
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Другой пример - использование дорожки MIDI контроллеров в MIDI редакторе для записи изменений панорамы 
инструмента, а затем настройки wet/dry баланса микса эффекта, такого как дилей для изменения параметра 
Delay length согласно позиции панорамирования. Мы начнем с рассмотрения этих двух примеров, а затем 
можно свободно исследовать любую из многих доступных возможностей. В целях упрощения обоих примеров 
мы будем использовать простой бесплатный синтезатор DSK Virtuoso, хотя можно использовать и любой 
другой. 
 
 
Пример 1: Управление плагином ReaComp с плагина ReaControlMIDI: 
 
1. Создайте новый проект, добавьте один инсерт в цепочку эффектов трека плагина ReaControlMIDI, а затем 
добавьте синтезатор. 
2. В области аранжировки вставьте новый MIDI клип приблизительно 30 секундной длины, откройте MIDI 
редактор и наиграйте простую мелодию. 
3. Внесите любые изменения в параметры синтезатора. 
4. Откройте окно плагина ReaControlMIDI. Убедитесь, что активирована секция Control Change. 
 

 
 
5. Щелкните по регулятору громкости (чтобы сделать его последним затронутым элементом), затем нажмите 
кнопку Param (наверху диалогового окна) и выберите опцию Show track envelope. 
6. Запишите или создайте вручную огибающую, схожую с таковой как на рисунке ниже: 
 

 
 
7. В конце цепочки эффектов добавьте плагин ReaComp. 
8. Воспроизведите трек. Установите параметр Ratio приблизительно в 4:1 и регулирует параметр Threshold так, 
чтобы компрессор срабатывал в более громких фрагментах. Верните курсор к началу трека. 
9. Щелкните по контроллеру Ratio, а затем нажмите кнопку Param. Из меню выберите опцию Parameter 
modulation/MIDI link. 
10. В диалоговом окне (как на рисунке ниже) выберите опцию Link from MIDI or FX parameter. Нажмите кнопку и 
выберите ReaControlMIDI:Volume. 
 

 
 
11. У двух контроллеров, Offset и Scale те же самые функции, что в примерах ранее в этой главе. Точно 
отрегулируйте контроллер Offset, чтобы возвратить параметр Ratio плагина ReaComp приблизительно в 4:1. 
12. Воспроизведите трек. Отрегулируйте контроллер Scale так, чтобы достигнуть плавного перемещения 
контроллера Ratio по мере увеличения и уменьшения громкости музыки. 
13. Сохраните файл как PMMIDI. Не закрывайте его.  
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Пример 2: управление плагином ReaDelay непосредственно с дорожки MIDI контроллеров:  
 
Для данного примера можно создать отдельный проект или, как мы собираемся сделать здесь, добавить его к 
текущему файлу PMMIDI. 
 
14. Откройте MIDI клип в MIDI редакторе. Добавьте дорожку для контроллера MSB Pan Position и нарисуйте в 
нужных событиях кривую вправо, потом влево, потом в центр дважды или боле, как показано на рисунке ниже. 

 
 
15. В цепочку эффектов вставьте плагин ReaDelay непосредственно перед плагином ReaComp. Установите оба 
параметра length (time) и length (musical) в 0.0. Установите параметр Feedback приблизительно в -50.0 dB. 
16. Щелкните по контроллеру Length (time), чтобы затронуть его, затем нажмите кнопку Param и перейдите MIDI 
link > CC > MSB Pan Position. 
17. В диалоговом окне Parameter Modulation/Link щелкните по большой кнопке и перейдите MIDI > CC > MSB 
Pan Position. 
 

 
 
18. Отрегулируйте параметры Offset и Scale так, чтобы добиться гладкого увеличение и уменьшение параметра 
delay length по мере смещения панорамы вправо и назад (по ходу воспроизведения песни). 
19. Сохраните файл! 
 
19.12.1. Еще о MIDI ссылках 
 
В наших двух примерах мы создали MIDI ссылки в одном случае данные плагина ReaControlMIDI, в другом 
события дорожки Midi контроллера в MIDI редакторе. Давайте рассмотрим другие возможности. Вы видели это 
меню, когда вы создавали ссылки в более ранних примерах: 
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 Можно создать ссылку с любых типов 
событий, показанных справа. Для событий 
CC 14-bit или CC используйте подменю для 
определения типа события (это может быть 
любой дорожкой MIDI контроллеров в MIDI 
редакторе). Для событий note или 
aftertouch, можно выбрать любую ноту. 
Другие опции - события pitch, program 
change или channel pressure. В том числе 
можно сделать так, чтобы модуляция 
параметров применялась только к 
указанной шине или каналу. 
 
 
 
 
 
 
 
 

19.13. Еще о некоторых применениях модуляции параметров 
 
Этот параграф познакомит вас только с некоторыми основными примерами, чтобы помочь вам понять суть 
модуляции параметров в REAPER и способы ее использования. При этом мы только скользнем по поверхности. 
В данном примере главное, что нужно помнить: 
 
- c модуляцией параметров сигнал любого трека может использоваться для управления параметрами любого 
другого трека. Например, сигнал с аудиотрека может использоваться для управления параметрами синтезатора, 
а выходной сигнал синтезатора может использоваться для управления аудиотреком. 
- если вы знакомы с работой синтезаторов и низкочастотных генераторов, вы, возможно, знакомы с различными 
типами форм волны. Эти формы LFO можно использовать для модуляции параметров. Эти возможности могут 
вывести вас далеко за пределы вводного примера, используемого ранее в этой главе. 
 

 
 
- другие применения модуляции параметров ограничиваются только вашими запросами, вашей креативностью и 
воображением. Например, с этой техникой вы можете использовать аудиосигнал с одного трека (или группы 
треков) для управления определенными параметрами шумоподавителя на другом треке (или треках). 

 
Совет: ваши окна модуляции параметра и их параметры будут автоматически сохранены с любыми 
цепочками эффектов и/или шаблонами трека, которые вы создаете. 
 

19.14. Управление параметрами эффектов в окне Project Bay 
 
В Главе 12 мы познакомились с окном Project Bay, включая вкладку FX Bay, которое может использоваться для 
управления и организации различных треков, клипов и эффектов. Окно Project Bay также включает вкладку FX 
Parameters Bay, которое может помочь вам в управлении различными функциями параметров эффектов, 
обсуждаемых в этой главе (и где-то еще). С одного этого интерфейса можно управлять контроллерами трека, 
огибающими, модуляцией параметров и назначениями с внешнего аппаратного контроллера всеми 
параметрами всех активных треков, копий клипов и эффектами мастер-трека. Вкладка FX Parameters 
расположена рядом с вкладкой FX Project Bay, отображенной опцией View> Project Media/FX и показанной на 
рисунке ниже.  
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Эта вкладка включает стандартные функции окна Project Bay, объясненные в Главе 12, включая (где 
необходимо) различные опции кнопок Action и Options, и опции контекстных меню.  
В данном примере мы будем фокусироваться исключительно на тех аспектах, которые являются 
непосредственными для управления параметрами эффектов. Каждый раз при добавлении любой из этих опций 
к любому параметру эффектов (например, с отдельного окна эффектов, или с вкладки эффектов), они будут 
автоматически добавлены во вкладку FX Parameters Bay. В вышеупомянутом примере, параметр Gain полосы 
2 плагина ReaEQ трека 1 использует модуляцию параметров: параметр отображается в столбце Mod, который 
также указывает, что параметр находятся под управлением сигналов управления звуком (ACS). Столбец Details 
говорит нам, что другой параметр этого плагина, Gain полосы 4 привязан к параметру Gain полосы 2. Столбец 
Envelope указывает, что два параметра плагина ReaDelay на треке 5 активированы и активны огибающие 
автоматизации. Контроллеры двух параметров плагина ReaComp трека 2 добавлены на панель контроллеров 
трека (обозначены точками в этом столбце), и один параметр плагина хорус (трек 3) имеет и контроллер трека и 
активированную огибающую. В столбце Learn отображенных параметров нет, указывая что нет параметров 
управляемых с внешнего аппаратного контроллера. Список ниже суммирует действия и опции вкладки 
Parameter FX Bay: 
 
Чтобы управлять или изменить настройки текущего параметра: щелкните правой кнопкой по имени плагина 
и сделайте выбор из меню. Для эффектов трека это опции Show in track controls, Add a track envelope, 
Parameter modulation и Learn (для привязки к внешнему аппаратному контроллеру). Для эффектов клипа/копии 
— это опции Track envelope и Learn. 
Чтобы управлять или изменить различные параметры тех же самых эффектов: щелкните правой кнопкой 
по имени плагина и выберите из меню (как на рисунке ниже) опцию Other FX parameters. Выберите опцию в 
подменю, а затем выберите нужный параметр из списка. 
 

 
 
Чтобы управлять или изменить параметр эффектов, используемых в проекте, но еще не измененных: 
выберите вкладку FX Bay (НО не FX Parameter Bay), затем щелкните правой кнопкой по эффекту. Выберите FX 
parameters из меню, затем из списка FX Parameters выберите опцию в подменю, а затем выберите нужный 
параметр из списка. 
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20. Работа с видео в REAPER 
 
Начиная с версии 5.0, возможности видео REAPER были значительно улучшены и расширены. Вкратце, вот что 
вы можете: 
 
- выполнять такие простые задачи редактирования, как удаление, перемещение или копирование фрагментов 
видео. 
- редактировать звуковую дорожку текущего видео. 
- добавить в видео новый звук. 
- добавить различные визуальные эффекты в видео трек, например, затемнение и появление. 
- редактировать или объединять содержимое нескольких видеофайлов в один, с дополнительным 
использованием эффектов, таких как кроссфейдинг. 
- использовать огибающие автоматизации для управления видеоэффектами. 
- конвертировать результат проекта в новый видеофайл. 
 
В данной главе подробно будут объяснены только те аспекты, которые относятся к управлению звуком в 
REAPER, функциям редактирования и управления проектами. Мы начнем с рассмотрения нескольких 
практических примеров, затем вплоть до конца главы мы будем рассматривать такие технические аспекты, как 
параметры и предварительные настройки видео. Позже в этой главе мы рассмотрим процесс работы с видео, но 
сначала мы рассмотрим обработку видео в REAPER. 
 

20.1. Простое редактирование видео 
 

 
 
REAPER можно использовать для редактирования звуковой дорожки ваших видеофайлов в форматах MOV, 
WEBM, AVI, MPG, VLC, MP4 и WMV. Видеофайлы можно импортировать с использованием опции Insert > Media 
File, или просто перетащить файл в окно аранжировки REAPER. Кроме того, можно использовать опцию Track > 
Insert Track from Template, чтобы импортировать данные из EDL файла. Опция View > Video Window 
(Ctrl+Shift+V) используется для отображения окна просмотра видео, которое можно прикрепить на панель 
Docker. Для пользователей Windows воспроизведение видео обеспечивается кодеком Direct Show, для 
пользователей OS X используется кодек Quick Time. Вы можете отредактировать исходную звуковую дорожку 
и/или добавить дополнительные аудиотреки и клипы к текущей звуковой дорожке (как показано на рисунке 
выше). Меню Options окна просмотра видео (на рисунке ниже) включает несколько полезных опций: 

 
Dock: позволяет прикрепить/открепить окно просмотра видео на 
панель Docker. 
Full screen: переключаемая опция, которая используется для 
разворачивания окна просмотра видео в полноэкранный режим. 
Чтобы отобразить меню Options в полноэкранном режиме, 
щелкните правой кнопкой мыши в любом месте окна. 
Preserve video aspect ratio: в активированном состоянии 
гарантирует, что независимо от изменения размеров окна 
просмотра видео будет сохраняться формат отображения видео в 
пропорциях. 
Resize video window to original video size: позволяет изменить 
размер окна просмотра видео под размер исходного файла. 
Video item properties: открывает окно свойств видеоклипа. 

Пример 1: 
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Скачайте демонстрационные проекты со страницы http://www.cockos.com/~glazfolk/VideoExamples.zip. Архив 
включает две папки - Wildlife и Zebras. Видеоклипы имеют формат MOV. Если видеоклипы не отображаются в 
REAPER, необходимо установить кодек VLC или просто установите бесплатный плеер VLC Media Player. В 
демо клипах качество видео на таком уровне, чтобы свести время и размер загрузки к минимуму. В первом 
примере мы начнем с выполнения некоторых основных и простых задач редактирования, а потом рассмотрим 
добавление эффектов. 
 
1. Откройте проект Zebras.RPP, который включает видео приблизительно 45 секунд. Давайте его немного 
сократим. Во-первых, сохраним проект под именем ZebrasDemo. RPP. 
2. Убедитесь, что в меню Options отмечена опция Ripple editing for all tracks. 
3. Щелкните по клипу Zebras .mov, чтобы выбрать его. 
4. В области аранжировки выделите область приблизительно с 8 секунды до 20 секунды. Щелкните правой 
кнопкой по клипу и выберите опцию Cut selected area of item. Нажмите Esc, чтобы снять выделенную область. 
5. Теперь давайте добавим музыкальную звуковую дорожку. Поверните фейдер громкости на треке Zebras 
полностью вниз. 
6. Откройте либо проводник системы, либо браузер клипов REAPER и перетащите с папки Zebras файл 
morning.mp3 в проект в новый трек. Сократите аудиотрек под продолжительность видеофайла. Сохраните 
файл и воспроизведите его. 
7. При необходимости добавьте трек в этот проект. На этом треке запишите небольшой разговорный 
комментарий, а затем используйте огибающие громкости так, чтобы речь выделялась на фоне музыки. Проект 
будет выглядеть примерно так как на рисунке ниже 
 

 
 
8. Сохраните файл, но не закрывайте его. 
 
Теперь пойдем дальше и добавим видеоэффекты. Видеоэффекты REAPER можно вставить в цепочку 
эффектов копии клипа или трека.  
 

20.2. Видеоэффекты 
 
Пример 1 (продолжение): 
 
9. Нажмите кнопку FX видеотрека Zebras. В окне добавления эффектов убедитесь, что на левой панели 
отмечена опция All Plugins. На правой панели щелкните по Video processor затем нажмите OK. Вместо окна со 
стандартным знакомым интерфейсом плагина вы увидите нечто другое. В настоящее время эффект еще не 
добавлен. 
10. Давайте добавим заголовок. Из списка пресетов выберите Title overlay. Это может выглядеть немного 
странным (см. рисунок ниже). 
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11. Первый черный столбец отображает контроллеры параметров. Они определяют размер, появление и 
позицию текста. 
12. Второй столбец содержит фактический EEL код, используемый для создания эффекта. Заметьте, что окно 
просмотра видео в настоящее время отображает текст This is a title, который также отображается на панели 
окна эффектов. Щелкните по этой области и введите Text=” Zebras"; (вводите только текст между кавычками), а 
затем нажмите Ctrl+S, чтобы сохранить результат. Текст в окне просмотра видео изменится. 
13. Теперь давайте добавим эффекты. Щелкните сначала по регулятору text height этого эффекта, затем 
нажмите кнопку Param, а затем отметьте опцию Show track envelope. Добавьте узлы и отрегулируйте эту 
огибающую как на рисунке ниже. 
 

 
 
14. Установите регулятор Y position в значение 0.07. Воспроизведите видео. Теперь текст будет помещен 
выше, начиная с маленького и постепенно увеличиваясь. 
15. Давайте предположим, что мы хотим отобразить заголовок только в течение 10 секунд или около этого. Для 
этого нужно добавить огибающую обхода (bypass). 
16. Нажмите кнопку Automation видеотрека Zebras (маркированная “trim”). Под заголовком text overlay 
отметьте флажок Bypass. Закройте окно: огибающая обхода будет отображена ниже трека. 
17. В отметке 10 секунд или около, добавьте узел к этой огибающей и перетащите его вверх, как показано на 
рисунке ниже. 
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18. Сохраните файл и воспроизведите видео. 
19. Теперь давайте добавим визуальный эффект. В цепочку эффектов видеотрека Zebras добавьте еще один 
экземпляр плагина video processor. 
20. Выберите пресет Horizontal wipe. Этот пресет включает всего лишь один контроллер wipe pos. 
21. Сохраните файл и воспроизведите его. Заметьте, что теперь видна только половина изображения в окне 
просмотра видео: другая половина затенена! 
22. Это мы можем устранить с помощью огибающей автоматизации. Добавьте огибающую как для этого трека, 
так и для параметра wipe pos эффекта Horizontal wipe. 
23. Сформируйте эту огибающую, как показано на рисунке ниже: необязательно точно располагать узлы, как на 
рисунке. 
 

 
 
24. Сохраните файл и воспроизведите видео. Теперь изображение будет прокручиваться вправо к концу видео. 
 

Примечание 1: когда вы изменяете код видеоэффекта, вы изменяете его только для данного 
экземпляра, а не сам код. Если вы ошиблись или запутались, просто удалите плагин из цепочки 
эффектов, повторно вставьте его и начните снова. 

 
Примечание 2: нажатие кнопки F1 в окне пресетов кода открывает окно справки, которое включает 
список параметров, используемых этим пресетом. 
 

20.3. Работа с несколькими видеотреками 
 
Есть один важный факт, который вы должны принять к сведению прежде чем вы начнете работать над 
проектами с несколькими видеотреками. В отличие от чисто аудиопроектов, при работе с несколькими 
видеотреками порядок треков является значимым. REAPER обрабатывает видеотреки и клипы по-другому в 
отличие от обработки аудиотреков и клипов. С видео другая ситуация складывается не в последнюю очередь 
из-за того, что у вас может быть несколько видеотреков, которые конкурируют между собой за одно окно 
просмотра видео. По умолчанию, если проект включает несколько видеотреков, в окне просмотра видео при 
воспроизведении будет отображен клип (клипы) только одного из этих треков. Какой это будет трек зависит от 
назначения приоритета. Список ниже суммирует применение приоритета. Однако важно быть уверенным (как вы 
убедитесь в примерах позже в этом параграфе), что при помощи эффектов переходов и огибающих 
автоматизации можно переопределить поведение по умолчанию и назначить клип (ы), которые будут 
отображаться в определенный момент при воспроизведении. 
 
- видео обрабатывается по восходящей. Трек с цифрой ниже будет иметь приоритет над треком с цифрой 
выше. Например, если трек 1 и трек 2 и будут содержать видеоклипы, то без использования огибающих и 
эффектов во время воспроизведения в окне просмотра видео будет отображаться только видеоконтент трека 1. 
Мастер-трек обрабатывается последним. 
- подобная иерархия работает на треках с несколькими видеоклипами и там, где используется свободное 
расположение клипов. Таким образом, по умолчанию в окне просмотра видео будут отображен контент только 
самого нижнего клипа. 
- там, где используются видеоэффекты, видеоэффекты на треке обрабатывают результат с видеоэффектами 
отдельных клипов.  
 
На странице Video окна Project Settings доступна опция Video item Visibility, которая позволяет инвертировать 
порядок обработки видеоданных. Видеоэффекты можно вставить в любое из трех мест - непосредственно в 
видеоклип, в видеотрек или в отдельный трек видеоэффектов. В зависимости выбора места, результат может 
разниться. В следующем примере мы будем использовать проект с тремя видеотреками. Если вы загрузили и 
разархивировали сэмплы, включенные в архив VideoExamples.7z, там вы найдете папку Wildlife с двумя 
проектами - Wildlife1 и Wildlife2. Проект Wildlife1 будет использоваться для практических упражнений, а проект 
Wildlife2 - результат по завершению. Папка Wildlife2 также включает дальнейший проект с большим 
количеством примеров (Wildlife3). 
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Пример 2: 
 
Сначала мы рассмотрим проект с некоторыми простыми действиями редактирования и добавленными 
видеоэффектами. После этого мы сможем обсудить, как мы этого добились. Откройте файл Wildlife2 и 
воспроизведите видео с самого начала. В особенности обратите внимание, что: 
 
- на странице Video свойств проекта (Alt+Enter) отмечена опция Items in lower numbered tracks replace higher 
(клипы треков с цифрой ниже будут иметь приоритет над клипами треков с цифрой выше). 
- присутствует анимированный заголовок. 
- есть три видеотрека, которые отредактированы таким образом, что в начале и в конце фильма они 
воспроизводились по одному последовательно, а в середине они то появляются, то исчезают. 
- дополнительный трек (Track 1) содержит не клипы, а только различные видеоэффекты. 
- время от времени используются другие визуальные эффекты. 
 
Давайте посмотрим, как это было сделано, начиная с трека 1 (Video FX). 
 
Редактирования трека 
 

 
 
К видеотрекам применилось простое редактирование с инструментом Slip. Поскольку треки были обработаны 
по возрастающей (приоритетом), при воспроизведении вы сначала увидите только слонов (трек 4), затем только 
зебр (трек 3), а затем только антилоп (трек 2). 
 
Заголовок 

 
Поместите курсор воспроизведения в самое начало 
видео. В цепочку эффектов трека 1 добавлен 
видеоэффект с пресетом title overlay, а текст был 
изменен на Morning in Africa. Некоторые значения 
параметров изменились от их значений по 
умолчанию, особенно параметры text height (0.9), Y 
position (1) и text bright (0.37). Последний 
параметр скрывает текст, делая его одним цветом с 
фоном. Были добавлены огибающие, чтобы 
сначала постепенно выделить текст, делая его 
видимым (параметр text bright), затем, чтобы 
перенести текст через экран в центр (x pos), а 
затем, чтобы постепенно заставить его исчезнуть. 
Огибающая bypass гарантирует, что заголовок 
будет удален целиком в отметке 13 секунд или 
около этого. 

 
Совет: чтобы помочь вам в понимании цели различных параметров, в любое время можно щелкнуть в 
окне с кодом пресета и нажать клавишу F1 для получения дополнительной информации (см. рисунок 
ниже). При необходимости можно отредактировать эти значения параметра непосредственно в 

кодировке. Это мы сделаем в следующем примере. 
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Эффект кроссфейдинга 

 
В цепочку эффектов трека 1 был добавлен второй 
экземпляр видеоэффекта с пресетом Crossfade 
through inputs. Огибающая bypass гарантирует, 
что кроссфейдинг будет применяться только в 
отрезке приблизительно 20 секунд посреди 
фильма. Скорость кроссфейдинга определяется 

множителем который устанавливает значение параметра project time. Чем выше это значение, тем быстрее 
скорость кроссфейдинга. В данном примере выбрано значение по умолчанию от 0.5 до 0.2 (см. рисунок слева) 
 
Эффект масштабирования 
 
В цепочку эффектов трека Elephant был добавлен экземпляр видеоэффекта с пресетом track 
opacity/zoom/pan. Огибающая масштабирования используется для уменьшения масштаба этого трека в самом 
конце. 
 

 
 
Пример 3: 
 
Этот пример, проект Wildlife3, использует те же самые исходные медиафайлы, но включает некоторые другие 
эффекты. На рисунке ниже показана часть области аранжировки с этим файлом. Воспроизведите это видео с 
начала, а затем мы рассмотрим, что было добавлено. 
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- главный заголовок теперь расположен по центру окна просмотра видео, он крупнее, и постепенно проявляется 
вначале перед исчезновением. Затем он вновь появляется в конце и постепенно исчезает. 
- заметно больше эффектов на антилопах. На 10-й секунде изображение пискилезируется, а затем изображение 
постепенно восстанавливается перед применением эффекта освещения. 
- у зебр есть свой собственный заголовок трека, Time for a drink, который появляется в течение нескольких 
секунд в конце видео. А теперь давайте посмотрим, как все это было сделано. 
 
Главный Заголовок: не требует дальнейших объяснений. 
Эффект сценического освещения трека Antelope: эффект сценического освещения был добавлен в цепочку 
эффектов видеотрека Antelope. Применены стационарные значения параметров. 
Пиксельный эффект трека Zebra: в цепочку эффектов трека Zebra добавлен видеоэффект с пресетом 
pixelate a portion of the image с пятью управляемыми параметрами (регуляторами), любые из которых можно 
настроить и/или автоматизировать. Вместе, первые четыре определяют расположение (горизонтальное и 
вертикальное) и размер (ширина и высота) области, которая будет пикселизирована. Пятый контроллер 
определяет размер каждого пикселя. Для этого плагина были добавлены огибающие pixelsize и bypass. 
Огибающая bypass гарантирует, что пиксельный эффект будет появляться только в течение нужных нескольких 
секунд. Огибающая pixelsize начинается со значения 0 и резко повышается приблизительно до значения 50%, а 
затем постепенно снова убавляется до значения 0. 
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20.4. Контроллеры параметров видео эффекта 
 

Видеоэффект включает стандартные функции аудиоплагинов REAPER, 
которые объяснялись в Главе 6 этого Руководства пользователя. 
Например, кнопка + может использоваться для сохранения и загрузки 
ваших собственных пресетов. В пределах цепочки эффектов трека 
щелкните сначала по любому регулятору эффекта, затем нажмите 
кнопку Param эффекта и выберите одну из опций - add a parameter 
control to the TCP (добавить контроллер параметра на панель 
трека), add a track envelope (добавить огибающую трека), use 
parameter modulation (использовать модуляцию параметра) или 
используйте функцию Learn для назначения управление на контроллер. 
В пределах цепочки эффектов клипа можно добавить огибающую 
автоматизации или получить доступ к функции Learn. 

 
20.5. Пресеты видеоэффекта (примеры) 

 
Количество и многообразие доступных пресетов видеоэффекта REAPER постоянно обновляются и улучшаются. 
На момент написания данной главы доступны следующие пресеты:  
 
Track opacity/zoom/pan  
Item fades affect video  
De-interlace  
2 x 2 input matrix  
Vignette  
Horizontal wipe  
Faded top  
Matrix crossfade  
Crossfade thru inputs 
Image overlay 
Matrix of recent frames 
Stage lighting 
Title text overlay 
Pixelate 
YUV multiplier/desaturation 
Show motion (subtract last frame) 
Simple source chroma-key 
Cheap brightness/contrast 
Equirectangular 360 panner 
Blitter feedback 
 
В данном руководстве в некоторых примерах используются некоторых из вышеперечисленных эффектов. Со 
временем можно ожидать увеличения количества эффектов на странице REAPER stash.  
 
Примеры видеоэффектов: 
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20.6. Видеоформаты 
 
Цель данного параграфа - познакомить вас с некоторыми фундаментальными понятиями, чтобы по крайней 
мере вы могли чувствовать себя уверенней на данном этапе. Параграф ни в коем случае не охватывает все, что 
в конечном итоге необходимо знать. Видеофайлы содержат видео и другие данные с их собственными 
атрибутами, такими как частота кадров (frame rate), размер пикселей (pixel dimension) и аудиоканалы (audio 
channels). Различные форматы могут использоваться для получения, сохранения, редактирования и 
распространения этих данных. Различные форматы характеризуются использованием видеоконтейнера и 
кодека. 
 
20.6.1. Атрибуты видео сигнала 
 
Как всегда, когда мы имеем дело с аудио и видео, чем выше качество (характеристики), тем больше размер 
файла! В частности, видеохарактеристики включают: 
 
Frame size: размер видеокадра, измеряемый в пикселях, обычно в пределах диапазона от 160 (ширина) 120 
(высота) до 1920х1080 (Full HD). 
Frame rate: частота кадров - скорость, с которой сначала захватывается, а потом воспроизводится каждый кадр. 
Каждый кадр содержит неподвижное изображение. Человеческий глаз начинает видеть движение при частоте 8 
кадров в секунду (кадр/сек). Движение начнет казаться гладким на уровне 24 кадр/сек и выше. Американский 
стандарт частоты кадров для 720 HD (1280х720 пикселей) составляет 59.94 кадр/сек, зачастую поднятую до 60 
кадр/сек. 
Aspect ratio: соотношение сторон - ширины к высоте, которое может быть выражено как в целых числах, 
например, 16х9, или в десятичном исчислении, например, 1.78:1. Соотношение 16х9 используется в 
широкоэкранном телевидении. 
Bit rate: скорость передачи данных, например, от файла к экрану, которая обычно измеряется в мегабитах в 
секунду (mps). В качестве примера скорость передачи данных Blu-ray HD видео составляет 20 Мбит/с, 
стандартное качество DVD составляет приблизительно 6 Мбит/с.  
Audio sample rate: частота сэмплирования записанного звука. Подробнее этот параметр обсуждался в Главе 2 
и Главе 3. 
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20.6.2. Контейнеры 
 
Контейнеры - это файлы, которые содержат видео (и другие соответствующие) данные. Типичные типы 
расширений контейнеров - MOV и AVI. Различные контейнеры имеют различную поддержку форматов видео и 
аудиосжатия, субтитров, и так далее. Например, несколько форматов контейнеров поддерживают несколько 
аудиопотоков, другие поддерживают только один. Совсем немного можно узнать о видеофайле из одного только 
его формата контейнера. Для этого щелкните правой кнопкой по видеоклипу в REAPER и выберите опцию 
Source properties из контекстного меню. Пример показан на рисунке ниже. При рендеринге видео в REAPER 
(см. Главу 20) доступны форматы - AVI, QT/MOV/MP4, MKV и WEBM. 
 

 
 
20.6.3. Кодеки 
 
Если контейнер — это хранилище данных файла, то кодек (кодер/декодер) - это способ фактического 
кодирования этих данных.  Важные характеристики кодеков обеспечивают качество видео, показатели 
производительности (такие как скорость компрессии/декомпрессии, поддержка профилей, опции, поддержка 
разрешения, и так далее). Некоторые кодеки бесплатны, другие - нет. Поскольку исходные видеофайлы очень 
большого размера, одним из наиболее важных аспектов видеокодеков является сжатие размера файла. Более 
того большая часть бытовой стандартной записывающей аппаратуры записывает видео в сжатом, а не в 
исходном (raw) видеоформате. При рендеринге в REAPER, выбор кодека в основном будет зависеть от 
выбранного формата контейнера. 
 

20.7. Советы по обработке видеоданных в REAPER 
 
1. Для пользователей Windows: если видеофайл не воспроизводится в REAPER, возможно у вас не установлен 
нужный кодек для этого формата видео. Кодеки свободно доступны в Интернете. Загрузите и установите кодек 
VLC со страницы http://vlc-codec-pack.en.lo4d.com. Кроме того, после этого воспроизведение видео будет 
обрабатываться кодеком VLC, а не Direct Show. 
2. Страница Options > Preferences > Media > Video/Rex/Misc включает опцию определения ваших собственных 
приоритетов видеодекодека. Если вы ошиблись в выборе, у вас есть опция Reset to defaults (сбросить в 
значения по умолчанию). 
 

20.8. Параметры и предварительные настройки видео в REAPER 
 
Горячая клавиша Alt+Enter открывает диалоговое окно параметров проекта. Перейдите на вкладку Video.  
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Здесь можно выбрать частоту кадров (frame rate) из выпадающего списка или ввести собственное значение. 
Дополнительно, можно ввести предпочтительный размер видео (preferred video size). Если эта область 
останется незаполненной, будет предпринята попытка использовать размер активного воспроизводимого 
видеоклипа. Если проект включает видеоклипы с одинаковыми размерами, эти параметры устанавливать 
необязательно. Если же проект включает видео с разными разрешениями, рекомендуется установить эти 
параметры.  
Параметр Video item visibilty определяет порядок, в котором обрабатываются виделклипы.  
Опция Items in lower numbered tracks replace higher (клипы треков с цифрой ниже будут иметь приоритет 
над клипами треков с цифрой выше) соответствует подходу, применяемому в большинстве программ 
редактирования видео, но вы можете выбрать и опцию Items in higher numbered tracks replace lower (клипы 
треков с цифрой выше будут иметь приоритет над клипами треков с цифрой ниже). Параметр video 
colorspace включает опции: auto, 1420/YV12, YUY2 или RGB. Режимы YUY2 и 1420/YV12 хранят данные более 
эффективно, чем режим RGB и обеспечивают сжатие файла почти без потерь (однако обратите внимание на 
примечания ниже). Опция Auto гарантирует, что какое бы ни было цветовое пространство будет использоваться 
исходное кодирование клипа. YV12 - режим, используемый большинством современных кодеков (таких как h264, 
или MPEG4, или MPEG2 или WEBM), который самый быстрый, так как позволяет избежать преобразования 
цветового пространства. Режим YUY2 схож с режимом YV12, но используется реже и обеспечивает лучшее 
цветовое разрешение (в виду использования меньшего количества субсэмплирования для яркости и цветности). 
RGBA - абсолютно другой режим, который соответствует пикселям вашего экрана. Не эффективно 
конвертировать из режимов YV12 или YUY2 в режим RGBA, а обработка видеокадров в режиме RGBA 
медленнее. При использовании режима RGBA хромакейные функции подсветки будут использовать другой 
алгоритм. Фактически, в режиме RGBA все будет выглядеть немного другим.  
Другие параметры - переключаемые опции Always resize video sources to preferred video size (всегда 
изменять размер видеоисточников под выбранный размер видео), Always resize output to preferred video size 
(всегда изменять размер видео на выходе под выбранный размер видео), Use high quality filtering when 
resizing (использовать при изменении размера высококачественную фильтрацию), и Preserve aspect ratio 
(letterbox) when resizing (сохранять формат изображения при изменении размера). Использование опции 
Always resize video to preferred video size может упростить использование определенных эффектов, но и 
может быть менее эффективным (так как другие эффекты могут управлять изменением размеров как часть их 
собственной обработки). При рендеринге в файл рекомендуется выбрать опцию Always resize output to 
preferred video size. Это гарантирует, что выбранная ширина/высота будет применена к видеофайлу на 
выходе. На рисунке ниже показана секция страницы предварительных настроек Media > Video/Rex/Misc.  
 

 
 
Активирование опций 1420/YV12 и YUY2 обеспечивает улучшает видеоизображение, однако если вы 
столкнулись с проблемами воспроизведения эти опции можно отключить.  
Использование опции EVT может улучшить качество видео на системах Windows 7 и Vista.  
Можно отредактировать список Video decoder priority list, чтобы изменить порядок приоритетов. По умолчанию 
формат самый высокий приоритет назначен на кодек VLC. Чтобы улучшить синхронизацию воспроизведения 
отредактируйте опции Video output delay. Доступна также опция отключения пиков с высоким разрешением. 
Активирование опции Video window follows edits гарантирует, что окно просмотра видео будет 
синхронизировано с точкой поиска, когда клипы будут перемещены или изменены. Можно выбрать такое 
поведение, что при перемещении аудиоклипов окно просмотра видео отображало содержимое в позиции 
курсора мыши, в начале аудиоклипа или смещении привязки аудиоклипа. Диалоговое окно Video file item 
properties (доступ к которому можно получить при выборе опции Source properties из контекстного меню клипа) 
включает опции Ignore audio и для обработки Hi-res peaks. Доступна также опция Copy audio settings to all 
video sources.  
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Кроме того, опция File > Render может использоваться для экспортирования видео из REAPER - см. Главу 21. 
На странице wiki.cockos.com/wiki/index.php/Video_Support можно найти подробную информацию о работе с 
видеофайлами в REAPER. 
 

20.9. Советы при работе с видео 
 
Если вы новичок в области редактирования видео, советы ниже могут вам помочь. Эти советы включают ссылки 
на многие инструменты и функции REAPER (браузер клипов, скринсеты, менеджер треков, маркеры и регионы), 
которые объяснены в разных главах данного Руководства пользователя. Конечно, эти советы обобщены. В то 
время как они предназначены, чтобы помочь вам, скорее всего у вас будут собственные соображения по 
редактированию видео. 
 
1. Для хранения видеофайлов необходимо большое количество дискового пространства. Однако, даже если вы 
намереваетесь распространять ваши работы по Интернету, возможно через YouTube, необходимо записать и 
отредактировать материал (видео и аудио) в высоком качестве, а затем использовать кодеки без потерь для 
конвертирования файлов для распространения. Для этого доступно много бесплатных программ, таких как 
MediaCoder, Quick Media Converter и Super Video Converter. 
2. Прежде чем вы начнете редактирование, организуете весь ваш материал. Файлы могут быть разбросаны по 
различным SD-картам, жестким дискам, USB картам, и т.д. Соберите все ваши исходные материалы в одном 
месте на жестком диске, где вы используете REAPER. Создайте папку для проекта и различные подпапки для 
ваших клипов. Если необходимо переименуйте различные исходные файлы по вашему усмотрению и в нужном 
порядке. Делайте бэкап после каждого сеанса редактирования. 
3. Создайте файл проекта в REAPER. Проверьте настройки проекта, особенно параметры видео. Определите 
нужный формат шкалы времени: помните, что доступны форматы Hours: minutes: Seconds: Frames и Absolute 
Frames. Сконфигурируйте окна скринсетов под редактирование видео, помня, например, что окно просмотра 
видео можно прикрепить на панель Docker, что браузер клипов доступен для управления и доступа к вашим 
исходным материалам, а менеджер треков доступен для управления вашими треками. 
4. Импортируйте ваши видеофайлы в проект. Любые видеокопии за пускающиеся параллельно друг другу (т.е. 
одновременно) должны быть помещены на отдельные треки. Последовательные клипы могут быть помещены 
на одном трек. 
5. Используйте маркеры и регионы для управления клипами в проекте.  
6. Если необходимо заменить звуковую дорожку видеоклипа отдельным аудиоклипом, откройте окно свойств 
видеоклипа, нажмите кнопку Properties и отметьте флажок Ignore audio. Заменяющий аудиоклип должен быть 
помещен на отдельный трек. 
7. Добавьте эффекты переходов и текстовые заголовки. 
8. Отредактируйте аудиодорожку и/или добавьте любой новый аудиоматериал. 
9. По окончании, сконвертируете проект в один файл. Простой пример такого проекта показан на рисунке ниже. 
Он включен в папку Wildlife2 с вашими сэмплами. 
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21. Экспортирование файлов, миксдаун и рендеринг 
 

21.1. Введение 
 
Есть три основных инструмента для извлечения ваших завершенных проектов или треков из REAPER, 
например, для финального релиза или для последующей обработки в другом месте: 
 
Объединение треков: предобработка выходных сигналов треков (игнорируя, например, эффекты трека и 
панорамирование). Используйте этот инструмент, например, для предоставления файлов другим 
пользователям, которые будут их микшировать/мастерить. 
Рендеринг в файл: постобработка выходного сигнала вашего материала (включая, например, все эффекты и 
панорамирование). Используйте этот инструмент для создания финального микса ваших песен, готовых к 
релизу. 
Пакетное конвертирование файлов/клипов: конвертирование нескольких файлов на любом этапе проекта в 
другой формат - например, конвертирование аудио в MP3 для рассылки по интернету или SFX для игр в 
монофайл с 22 кГц. 

 
Примечание: некоторые иллюстрации области аранжировки, используемые в этой главе основаны на 
теме и цветовой схеме по умолчанию REAPER 4. Тем не менее информация и инструкции верны и 
корректны для темы REAPER 5. 

 
21.2. Пакетное конвертирование файлов 

 
Несколько треков можно сконвертировать в другой формат, например, из WAV в MP3. Это можно сделать одним 
действием, используя пакетный конвертер REAPER, доступ к которому можно получить через опцию File > 
Batch file/item converter в главном меню. При этом откроется одноименное диалоговое окно (на рисунке ниже).  
 

 
 
Сделайте следующее: 
 
1. В области аранжировки выберите клипы, которые будут сконвертированы, затем нажмите кнопку Add, а затем 
Add selected media items, или 
2. Нажмите кнопку Add, затем Add files, выберите файлы и нажмите Open. 
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3. Чтобы удалить любой файл из выбора, щелкните по его имени в окне Batch file/item converter, а затем 
нажмите кнопку Remove. Чтобы очистить весь выбор, нажмите кнопку Clear. 
4. Определите конечную папку для конвертируемых файлов или отметьте опцию Use source file directory 
(папка с исходниками). Если оставить область File name незаполненной, имена сконвертированных файлов 
будут соответствовать именам исходников (в столбце Output). В противном случае введите ваши собственные 
имена. Для этого можно использовать текст и/или любой из доступных универсальных символов. В 
вышеупомянутом примере используется имя трека и номер трека. Обратите также внимание на примечание об 
универсальных символах ниже. 
5. Выберите значение source (как в источнике) в области Sample rate и Channels чтобы использовать эти 
значения для конвертируемых файлов. Но эти значения можно изменить по вашему усмотрению. 
6. Дополнительно, можно отметить опцию Use FX. В этом случае необходимо также нажать кнопку FX chain и 
выбрать нужный эффект (эффекты), например, лимитер. Если выбрана опция Use FX, можно также определить 
длину хвоста эффектов в миллисекундах (Tail size). 
7. Выберите нужный формат для конвертируемых файлов (например, MP3, OGG, FLAC) и настройте параметры 
выбранного формата. В зависимости от формата могут быть доступны опции дизеринга (Dither) и/или 
фильтрации шума (Noise Shaping). 
8. По окончании всех настроек нажмите кнопку Convert All. При этом откроется окно File Conversion. 
 

 
 
Примечание по универсальным символам: использование универсальных символов включает 
индивидуальную информацию в имени каждого конвертируемого файла. Например, если в имени файла 
присутствует $project, в имя каждого конвертируемого файла будет включено имя проекта. Включение 

символа слэш влево \ между универсальными символами создает подпапку. Например, при рендеринге 
отдельных треков, если имя конечного файла содержит $project\$track, будет создана отдельная подпапка для 
каждого трека. 
 

21.3. Объединение и последующее экспортирование 
 
Представим ситуацию, что вы работаете над своим проектом совместно с другим пользователем. Например, вы 
хотите отослать проект вокалистке, которая должна добавить бэк вокал к вашей песне. Что, если эта певица 
живет далеко? Вы можете отослать ей ваш RPP файл вместе со всеми файлами клипов. Но что, если она не 
пользуется REAPER? Возможно, она пользуется другой программой или у нее вообще нет хоста, и она должна 
будет записать бэк вокал в коммерческой студии. В этом случае файлы клипов необходимо сначала 
объединить, а затем экспортировать.  
 

 
 
Посмотрите на пример выше. В данном примере трек Vox состоит из трех клипов, каждый из которых это 
сконвертированный фрагмент песни. Если бы мы должны были отослать медиафайлы (в общей сложности 
шесть) другому пользователю, то для него было бы затруднительно их упорядочить. В этом случае нам помогут 
объединение и последующее экспортирование. Это подразумевает создание новых аудиофайлов, по одному 
файлу на трек. После того как эти новые файлы будут вставлены в другой хост, каждый из них будет установлен 
в начало отсчета, по одному на трек, каждый в корректном местоположении для дальнейшего микширования. 
 
1. В зависимости от того, что вы хотите объединить, выделите область и/или выберите треки. 
2. В главном меню перейдите File > Consolidate/Export Tracks. 
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3. Отметьте соответствующие опции Entire project (весь проект), Time selection (материал в пределах 
области выделения), Custom selection (выборочно), а затем опции All (все) или Selected tracks (выбранные 
треки). 
4. Решите, хотите ли вы, чтобы параметры Sample rate (частота сэмплирования) и Channels (номер каналов) 
были определены автоматически (Auto) или определите их сами. 
5. Выберите режим ресэмплирования (Resample Mode). 
6. Определите формат (Consolidate to) и битрейт (Bit depth) - WAV, AIFF, DDP, FLAC, MP3, OGG Vorbis, Опус 
OGG, Видео LCF или WavPack. В данном примере был выбран формат WAV. 
7. Определите необходимые параметры выбранного формата. Например, для файлов WAV необходимо 
выбрать разрядность (bit depth) и определить, хотите ли вы использовать BWF данные, включая маркеры и 
регионы, и как поступать с MIDI данными. Если сомневаетесь, обратитесь к человеку, которому вы будете 
отправлять объединенные файлы. 
8. Определите папку-адресат (Output directory) для объединенных файлов. Определите, хотите ли вы обновить 
(update) проект с новыми объединенными файлами. 
9. Определите имя нового проекта (или оставьте по умолчанию). Нажмите Process. 
 

Примечание: будьте осторожны при использовании опции Embed project tempo (встроить темп 
проекта). Эта опция добавляет темпотэг ACID в аудиофайл, который может интерпретироваться любой 
программой распознавания темпа, растягивая и сжимая по времени аудиофайл, когда вы этого не 

хотите.  
 
На рисунке показан пример проекта после объединения, по одному клипу на трек. После этого очень просто 
импортировать эти четыре клипа в любой хост, а затем перезаписать бэк вокал. 
 

Примечание: чтобы объединить файлы в формат MP3, нужен правильный файл кодека Lame для 
вашей платформы и версии REAPER. Например, для Windows XP или Vista это lame_enc.dll. Для 
Windows 64 бит это будет либо libmp3lame.dll, либо lame_enc64.dll. Файл необходимо поместить в 

папку C:\Program Files\REAPER. Аналогично, для рендеринга видео необходим также кодек, например, 
Ffmpeg.dll. Этот кодек находится в папке REAPER Plugins. 
 
При объединении клипов, параметры и свойства клипа (например, огибающие и эффекты копии, тональная 
настройка клипа) будут включены в выходные файлы, а свойства трека (например, эффекты трека) нет. Чтобы 
применить цепочку эффектов трека, огибающие трека, и т.д. к выходным файлам, необходимо использовать 
диалоговое окно Render to File, выбрав опцию Stems (selected tracks) из выпадающего списка Render. 
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21.4. Рендеринг проекта 
 
Опция File > Render выполняет несколько различных функций. Одна общая функция - рендеринг финального 
проекта в отдельный стереофайл. Предположим, что вы закончили запись, завершили редактирование, 
добавили эффекты и автоматизацию, расположили в нужном порядке треки, и хотите создать конечный продукт 
для релиза. Если хотите аудиофайл в формате audio CD, вам будет нужен один 16-битный wave стереофайл 
для каждой песни на компакт-диске. Если вы хотите распространять ваш материал по сети, скорее всего, вы 
захотите создать серию стереофайлов в формате MP3. Безотносительно выбранного формата, каждый проект в 
конечном итоге необходимо сконвертировать в один файл. Для этого используется опция File > Render 
(Ctrl+Alt+R). Одноименное диалоговое окно (на рисунке ниже) включает различные опции.  
 

 
 
Необходимо выбрать папку (Directory) и имя файла (File name): при необходимости используйте кнопку 
Browse. Другой выбор будет зависеть от конечной папки. А теперь рассмотрим опции диалогового окна Render 
to File более подробно. 
 
Source: выберите опцию Master mix для объединить весь материал в отдельный файл, опцию Stems для 
рендеринга выбранных треков в отдельные файлы, или опцию Master mix+stems для объединения двух 
предыдущих опций. Функция Stem rendering объяснена в Главе 6. Остальные опции - Region render matrix 
(будет объяснена позже в этой главе) или Selected media items (выбранные клипы). 
Кнопка Presets: используйте эту кнопку для сохранения ваших настроек в пресет или для загрузки ранее 
сохраненного пресета. Пресет может включать параметры Render bounds и Output, Options и Output format 
или All settings. Сохраненные параметры будут автоматически добавлены в меню Presets. 
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Bounds: доступные значения: Custom time range (необходимо ввести значения в областях ниже), Entire project 
(весь проект), Time selection (необходимо выделить область в области аранжировки), Custom time range 
(введите значения начала и окончания в диалоговом окне), или Project regions (выбирается в менеджере 
регионов/маркеров или в матрице рендеринга регионов). Если вы выберете значение Entire project и у вас есть 
маркеры =START и =END, эти маркеры будут использоваться для определения начала и окончания проекта при 
рендеринге соответственно. 
Directory: введите имя конечной папки или используйте кнопку Browse для поиска нужной папки.  
Кнопка Wildcards: используется для автоматического включения информации в имя выходного файла, 
например, имя или номер трека, имя региона, имя проекта и/или метки даты и времени. 
Sample Rate: диапазон значений 8000 - 192000, в зависимости от выходного формата (output format) и других 
факторов. Некоторые примеры будут рассмотрены в списке после этого списка опций. 
Channels: выбор канала. Доступные значения: mono, stereo или значения для мультиканального формата. 
Кнопка-меню для выбора скорости рендеринга: Full-speed Off-line (по умолчанию) - самый быстрый рендеринг. 
Остальные значения: 1 x offline, online, online (idle) and offline x 1 (idle). 
Флажок Use project sample rate: если этот флажок отмечен при обработке, при микшировании и обработке 
эффектов/синтезаторов будет использоваться частота сэмплирования проекта. Если сомневаетесь оставьте 
флажок отмеченным. 
Resample mode: режим ресэмплирования. Различные значения обеспечивают компромисс между скоростью и 
качеством. Значение по умолчанию - 192. 
Tracks with only mono media to mono files: если этот флажок отмечен, моноканальный рендеринг будет 
автоматически применен к трекам, в которых все клипы моно или клипы с параметрами моно. 
Multichannel tracks to multichannel files: опция, обеспечивающая рендеринг мультиканальных треков в 
многоканальные файлы. Пример будет рассмотрен позже. 
Master mix Dither/Noise Shaping: опция доступна не со всеми форматами и обычно используется при 
рендеринге 24-битного (или выше) аудиоматериала в 16-битный WAV формат для формата audio CD. 
Обеспечивает более сглаженный переход к более низкой частоте сэмплирования в процессе рендеринга. 
Output format: выходной формат. Доступные значения: WAV, AIFF, audio CD image, DDP, FLAC, MP3, OGG 
Vorbis, OGG Opus, video (Ffmpeg/libav encoder), video (GIF), or WavPack lossless compression. 
Специфические параметры форматов: для определенного формата доступны несколько специфических 
параметров. Например, для формата WAV или AIFF, необходимо настроить параметр bit depth, для формата 
FLAC необходимо настроить параметр FLAC encoding depth и data compression, для формата MP3 
необходимо выбрать режим битрейта (например, variable или constant) и фактический битрейт (bitrate), и так 
далее. При рендеринге в WAV файл, можно также определить, должны ли быть включены или нет маркеры и 
регионы в выходной файл (файлы). Для формата WAV также доступна опция Include project filename in BWF 
description, которая ассоциирует сконвертированные файлы с исходным проектом - подробнее об этом в Главе 
12. Для WAV файлов доступна также опция встраивания темпа проекта. 
Silently increment filenames: предотвращает от случайной перезаписи текущего файла: если используется 
текущее имя файла, к имени будет добавлен номер по возрастанию, такой как 001. 
Add rendered items to new tracks: если этот флажок отмечен, сконвертированный файл (файлы) будут 
добавлены в проект в качестве новых треков. 
Save copy of project to outfile.wav.RPP: если этот флажок отмечен, REAPER создаст завершенную копию 
времени и даты файла проекта, точно сохранив все настройки при рендеринге. 
Кнопки Open render queue/Add to render queue: эти кнопки используются при пакетном рендеринге, который 
будет обсуждаться позже. 
Render x files: конвертирует проект в один или несколько файлов, в зависимости от опций. 
Флажок Delay queued render to allow samples to load: решает проблемы, которые могут быть вызваны 
необходимостью загрузки сэмплов (особенно большого размер) перед рендерингом. 
Save changes and close: сохраняет параметры и закрывает диалоговое окно рендеринга, не конвертируя 
файлы. 
 
21.4.1. Примеры рендеринга проекта 
 
DVD Audio Soundtrack: 
Sample Rate: 48000 HZ, Channels: Stereo, Higher Quality 
Output format: WAV format, 24 bit 
 
CD Audio: 
Sample Rate 44100 HZ, Channels: Stereo, Higher Quality 
Output format: WAV format, 16 bit 
 
Apple Mac:  
Формат AIFF. Предпочтительные настройки будут меняться в зависимости от отдельных обстоятельств. 
 
Web Site/Web Audio: 
Sample Rate 44100 HZ, Channels: Stereo, Higher Quality 
Output format: MP3 format 
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Остальные опции могут измениться по ходу изменения размера файлов и времени загрузки против качества 
звука, но типичный выбор это CBR (Constant Bit Rate) 96 или 128, Joint Stereo, Quality High 
 
Monkey’s Audio: используйте этот формат для сжатия без потерь в 16 или 24 бит. 
 
Audio CD Image (Cue/Bin): требования такие же, что и для формата CD Audio. Эта опция может 
использоваться для записи вашего сконвертированного выходного сигнала непосредственно на компакт-диск 
или для создания графического файла на жестком диске для использования с другой программой для прожига 
CD дисков. Можно определить использование маркеров/регионов для выбора треков.  
 
Многоканальные треки: подробно мы рассматривали разделение каналов и создание мультиканальных треков 
в другом месте этого Руководства пользователя, особенно в Главе 17. У вас могут быть треки, которые вы 
хотите экспортировать в мультиканальный формат, возможно для использования с другой программой. Сначала 
выберите треки на панели треков, а затем откройте диалоговое окно Render to file и выберите следующие 
опции: 
 
Channels: количество каналов, например, 4 
Render stems (selected tracks) to similarly named files (рендеринг выбранных треков в схожие по имени файлы). 
Render multichannel tracks to multichannel files (рендеринг мультиканальных треков в мультиканальные 
файлы). 
Add items to new tracks in project when finished (добавить клипы в новые треки в проект после завершения). 
 

 
 
На рисунке выше изображен 4-х канальный трек (трек 1) сконвертированный в мультиканальный формат (трек 
2). 
 

Совет: список действий включает действия File: Render project using the most recent render settings 
(рендеринг проекта с использованием последних выбранных параметров) и File: Add project to render 
queue using most recent render (добавить проект в очередь рендеринга, используя последние выбранные 

параметры). Если на эти действия назначить горячие клавиши или поместить их кнопки на панель 
инструментов, они могут использоваться для рендеринга проекта без необходимости каждый раз открывать 
диалоговое окно File > Render. 
 
 

21.5. Рендеринг финальной песни 
 
При рендеринге финальной песни, выбор выходного формата, вероятно, будет зависеть от цели рендеринга, 
например, для прожига на CD или распространения в сети. Однако есть несколько советов, которые вы можете 
принять к сведению, и которые одинаково применимы к обоим сценариям. В вашей записи перед началом песни 
можно вставить несколько секунд тишины. Если вы не хотите включать этот период тишины в 
сконвертированный материал, выполните следующие шаги перед рендерингом: 
 
1. Поместите курсор воспроизведения в точку, откуда начнется рендеринг. Нажмите Shift +M, чтобы создать 
маркер в этой точке. Именуйте этот маркер Start (рисунок ниже) 
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2. Поместите курсор воспроизведения в точку, где закончится рендеринг. Нажмите Shift +M, чтобы создать 
маркер в этой точке. Именуйте этот маркер End. 
3. С активированной опцией привязки границ лупа к выделенной области, дважды щелкните по линии маркера 
(выше шкалы времени) в любом месте между двумя маркерами. Это выделит область между ними. 
4. Из главном меню REAPER перейдите File > Render. 
5. Выберите выходной формат и настройте остальные опции по усмотрению, но обязательно выберите опцию 
Time selection из выпадающего списка Render Bounds. Настройки, показанные в начале Параграфа 18.4, 
подошли бы для создания CD audio файла. Настройки, показанные на рисунке ниже подошли бы для создания 
MP3 файла. Обратите внимание, что для формата MP3 некоторые опции (например, dither и noise shape) не 
доступны. 
 

 
 
6. Помните, что можно использовать маркеры =START и =END в рамках проекта для определения начальной и 
конечной позиции соответственно. 
7. Когда будете готовы, нажмите кнопку Render 1 file в этом диалоговом окне для запуска процесса рендеринга. 
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21.6. Пакетный рендеринг 
 
У вас может быть несколько песен, которые вы хотите сконвертировать по окончании проекта. Таким образом 
можно двигаться дальше пока REAPER конвертирует эти песни, и затем возвратиться к ним позже: 
 
21. 6.1. Рендеринг каждого проекта 
 
1. Откройте проект и перейдите File > Render. 
2. Настройте различные параметры и выберите нужные опции, как было объяснено в предыдущих параграфах.  
3. Не нажимайте кнопку Render1 File. Вместо этого нажмите кнопку Add to Render Queue. Когда вы добавляете 
файл в очередь, он сохраняется как есть в этой же временной позиции. Если вы вносите какие-либо 
дальнейшие изменения в файл, который вы хотите включить, необходимо удалить файл из очереди, а затем 
добавьте его назад. 
4. Диалоговое окно будет закрыто, и вам покажется, что ничего не произошло. Сохраните и закройте файл. 
 
21.6.2. Пакетный рендеринг очереди проектов 
 
Когда вы выполняете рендеринг файлов в очереди, каждый файл будет сконвертирован в отдельный файл 
согласно настройкам и опциям, которые вы определили для каждого файла индивидуально при конфигурации 
пакета. 
 
1. В главном меню REAPER перейдите File > Show Render Queue. 
2. В открывшимся диалоговом окне (рисунок ниже) будут перечислены все файлы в очереди рендеринга (в 
данном примере четыре). 
 

 
 
3. Если необходимо удалить какой-нибудь элемент из списка, выберите его и нажмите Remove Selected. 
4. Используйте горячую клавишу Ctrl+щелчок для создания подгруппы элементов, которые будут 
сконвертированы и нажмите Render Selected либо просто нажмите кнопку Render All чтобы выполнить 
рендеринг всех элементов в очереди, каждый элемент в отдельный файл. Отобразится область Rendering to 
File после окончания рендеринга и удалении его из очереди. 
5. По окончании закройте диалоговое окно Queued Renders. 
 

21.7. Рендеринг выбранных клипов 
 
 Опция Selected media items в выпадающем списке Render может 
использоваться для конвертирования любого клипа или нескольких 
выбранных клипов.  
 
 
 
 
Процедура: 
 

1. Выберите нужный клип, или несколько клипов в области аранжировки. 
2. Откройте диалоговое окно File > Render. 
3. Выберите опцию Selected media items из выпадающего списка Render. 
4. Выберите нужный формат и другие параметры. 
5. Нажмите Render xx files чтобы начать процесс рендеринга или Add to render queue чтобы добавить клипы в 
очередь. 
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21.8. Рендеринг регионов 
 

 
 
Данный параграф предполагает, что вы понимаете суть, назначение и функционал регионов в REAPER. 
Подробнее о регионах в Главе 9. 
 
Процесс рендеринга регионов использует три возможные окна: Render to File, Region/Marker Manager и Region 
Render Matrix. В большинстве случаев у вас не будет необходимости использовать все три окна сразу, но это 
поможет вам в понимании того, как эти три окна интегрируются. Вы можете выбрать и конвертировать любую 
комбинацию треков и регионов по вашему усмотрению. В диалоговом окне Render to File можно активировать 
использовать таких метасимволов, как $region и $track в именах выходных файлов. Чтобы открыть матрицу 
маршрутизации регионов: 
 
- в главном меню перейдите View > Region Render Matrix, или 
- нажмите кнопку Render Matrix в окне Region/Marker Manager. 
- в диалоговом окне Render to File выберите опцию Region render matrix из выпадающего списка Render, а 
затем нажмите кнопку Region Matrix (см. рисунок ниже). 
 

 
 
Чтобы помочь вам понять функционал матрицы, рассмотрим пример - простой проект из четырех треков.  
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Песня состоит из трех регионов - Verse 1, Verse 2 и Verse 3 (см. рисунок выше). В первом столбце (Verse 1) 
отмечен только master mix (первая строка заголовка). Это привело бы к рендерингу региона Verse 1 в один 
файл, который будет мастер миксом всех треков. Во втором столбце (Verse 2) отмечены не строки заголовков, а 
два трека (Vox и Harmony Vox). Это привело бы к каждому файлу для каждого из этих двух треков, 
конвертируемых для этого региона. В третьем столбце (Verse 3) отмечены два заголовка (master mix и all 
tracks). Это привело бы к образованию пяти файлов, конвертируемых для этого региона - мастер микса всех 
треков плюс отдельные файлы для каждого из четырех треков. Выбор регионов можно сделать как в матрице 
рендеринга регионов, так и в менеджере регионов/маркеров - в обоих все будет обновляться автоматически. 
Пример этого показан на рисунке ниже: 
 

 
 
Контекстное меню этого окна показано на рисунке ниже.  
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Опции: Render master mix for all regions (рендер мастер микса для всех регионов), Render all tracks for all 
regions (рендер всех треков для всех регионов) и Render master mix and all tracks for all regions (рендер 
мастер микса и всех треков для всех регионов). В матрице рендеринга регионов можно открыть диалоговое 
окно Render to File, нажав кнопку Render. В данном примере можно выбрать различные опции, формат, и т.д. 
Если вы хотите создать подпапки, используйте бэк слэш в имени файла.  Если в имени файла вы будете 
использовать $project\$region-$track, выходные файлы будут включать имя проекта, имя региона и имя трека с 
файлами каждого региона, помещаемыми в его собственную отдельную подпапку. Строка $project\$track-
$region в имени включала бы в файл название проекта, имя трека и имя региона, с отдельной подпапкой для 
каждого трека. По окончании выберите опции Render xx files, Add to render queue или Save changes and 
close. 
 

21.9. Запись Audio CD диска с REAPER 
 
Есть по крайней мере две ситуации, для которых вы могли бы хотеть записать свой материал непосредственно 
на Audio CD диск. 
 
1. Вы записали несколько песен. Каждая смикширована и сконвертирована в ее собственный стерео wave файл. 
И теперь вы хотите записать все песни на Audio CD диск потреково. 
2. У вас есть живая запись, включающая один непрерывный трек. Вы хотите разделить его на отдельные треки, 
а затем прожечь их на Audio CD диск.  
 
В обоих случаях процедура схожа с некоторыми незначительными различиями в конфигурации проекта. 
 
21.9.1. Подготовка к записи CD диска нескольких файлов 
 
1. Запустите REAPER и создайте новый проект. Нажмите Ctrl+Alt+X, чтобы открыть браузер клипов, а затем 
перейдите к папке, содержащей сконвертированные стерео wave файлы. 
2. Дважды щелкните по очереди по каждому из файлов, которые вы хотите включить в проект прожига. REAPER 
добавит каждый файл в проект на отдельные треки. 
3. Обратите внимание, что каждый клип помещается сразу после другого клипа без паузы. Необязательно 
смещать любой из них, чтобы создать паузы на диске. Это можно сделать автоматически. 
4. Теперь необходимо вставить маркер, чтобы указать, начало каждого трека. Для этого:  
5. Во-первых, убедитесь, что привязка отключена. Установите курсор в начале проекта. Нажмите Shift+M, чтобы 
создать и отредактировать маркер в этой точке. Убедитесь, что имя маркера начинается с символа # (как 
показано на рисунке ниже). 
 

 
 
6. Теперь переместите курсор в начало следующей песни. Снова добавьте маркер, и снова убедитесь, что имя 
маркера начинается с символа #. 
7. Повторите вышеописанные шаги в начале каждой песни, как показано на рисунке ниже: 
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8. Сохраните файл проекта. 
9. Следуйте инструкциям ниже для записи CD диска.  
 
21.9.2. Подготовка к прожигу CD диска одной непрерывной записью 
 
1. Если запись была сделана в REAPER, откройте проект. В противном случае, создайте новый проект и 
используйте браузер клипов, чтобы импортировать запись, используя описанный выше метод. 
2. Клип разделять необязательно. REAPER позаботится об этом при записи CD. Однако необходимо будет 
указать начало каждого трека на CD. 
3. Во-первых, убедитесь, что привязка отключена. Установите курсор в самом начале проекта. Нажмите Shift+M, 
чтобы создать и отредактировать маркер в этой точке. Убедитесь, что имя маркера начинается с символа #. 
4. Теперь переместите курсор в начало следующей песни. Снова добавьте маркер, и снова убедитесь, что имя 
маркера начинается с символа #. 
5. Повторите вышеописанные шаги для каждой песни, как показано на рисунке ниже: 
 

 
 
6. Сохраните файл проекта. 
7. Следуйте инструкциям ниже для записи CD диска. 
 
21.9.3. Запись CD диска 
 
1. Перейдите File > Render и выберите следующие опции и параметры для записи CD: 
 
Sample rate: 44100  
Channels: Stereo  
Render: Master Mix  
Render bounds: Entire project  
Output format: Audio CD Image (CUE/BIN Format)  
Track Mode: Markers define new tracks  
Отметьте опцию Burn CD Image after render  
Отметьте опцию Only use markers starting with #.  
 
Если в вашей цепочке эффектов мастер-трека нет плагинов дизеринга, можно отметить опции Dither и/или 
Noise Shape. 
 
2. В случае первого из наших двух примеров (с отдельными клипами на различных треках), вы можете 
определить паузу в 2 секунды (Lead in silence for tracks of 2000 ms). 
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3. Нажмите кнопку Render и ожидайте завершения операции рендеринга. 
4. По завершении, откроется страница параметров Burn Audio CD Image. 
5. Выберите нужный метод записи, который будет зависеть, например, от таких факторов, как операционная 
система. Если сомневаетесь выберите cdrecord/cdtools как показано на рисунке ниже. 
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6. Отметьте опцию Eject CD when done. Решите, хотите ли вы сохранить или удалить файлы образа по 
завершению. Вероятнее всего, образ стоит сохранить, по крайней мере, на данный момент. Если у вас возникли 
какие-либо проблемы с записью самого CD диска, вы можете использовать образ с другой программой для 
прожига CD диска, например, Nero или Toast. 
7. Вставьте пустой CD диск в CD-привод. 
8. Нажмите Burn CD. 
9. Ожидайте, пока отображается надпись Burning in progress. 
10. По окончании CD диск будет извлечен. Нажмите Close, чтобы закрыть все сообщения на экране. Вместо 
того использования маркеров для определения начала ваших треков, вы можете, при необходимости создать 
отдельный регион для каждого CD трека и использовать опцию define tracks (other areas ignored). На диск 
будет записан только тот материал, который включен в ваши регионы. Другая опция состоит в том, чтобы 
записать содержимое проекта одним треком (One track). 
 

 
 

Совет: прежде, чем выполнить рендеринг непосредственно на диск необходимо убедиться, что клипы, 
которые вы записываете, имеют формат 16 bit 44100 Hz. Есть много способов конвертирования клипов в 
этот формат. Проще сделать это на странице Project Settings. После этого в рамках проекта можно 

склеить любые текущие клипы, в то время как любые клипы, которые вы затем будете импортировать, будут 
автоматически сконвертированы в этот формат. 
 

21.10. Сохранение живого выходного сигнала на диск 
 
Используя опцию File > Save live output to disk (bounce) можно экспортировать живой выходной сигнал на 
диск. Эта опция схожа с опцией File > Render, за исключением того, что, тогда как опция Render работает в 
режиме off line, опция Export Live to Disk работает в режиме реального времени. Изменения в настройки 
можно вносить на лету в процессе рендеринга. Поместите курсор воспроизведения в начало фрагмента, 
который вы хотите сохранить и перейдите File > Save live output to disk.  
 

 
 
Определите папку для сохранения, имя файла, формат, и т.д. Доступны опции включения маркеров/регионов и 
маркеров/регионов с символом # в именах конвертируемых файлов. Опция Save output only when playing or 
recording обеспечивает остановку конвертирования при остановке воспроизведения/записи по запросу 
пользователя. Позже можно продолжить конвертирование. Опция Stop saving output on first stop гарантирует, 
что конвертирование закончится тогда, когда будет остановлено воспроизведение или запись. Маловероятно, 
что вы захотите активировать обе эти опции одновременно. По окончании настроек, нажмите кнопку Start для 
старта конвертирования. После этого выбор опции Save live export to disk (bounce) из меню File завершит 
процесс конвертирования.  
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21.11. Использование пресетов 
 

Параметры рендеринга можно сохранить 
в пресеты. Нажмите кнопку Presets (в 
диалоговом окне Render to File), чтобы 
открыть соответствующее меню. Ваши 
пресеты будут автоматически добавлены 
в соответствующее меню (см. рисунок 
слева). 
 
 
 
 
 
 

21.12. Рендеринг в Surround формат 
 
При конвертировании проекта в surround формат, большинство параметров будет установлено, как и любого 
другого проекта. Одно важное различие - необходимо будет выбрать правильное количество каналов. В 
примере, показанном на рисунке ниже - проект для формата 5.1 surround, поэтому выбраны 6 каналов. REAPER 
сконвертирует этот проект в отдельный мультиканальный файл. Возможно, вам будет необходимо 
сконвертировать мультиканальный файл в мульти монофайла, которые требуют кодеки DTS и Dolby. В REAPER 
это сделать не легко, но есть много хороших сторонних инструментов, например, Wave Agent - 
http://www.sounddevices.com /products/waveagent.html. 
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21.13. Рендеринг видеопроекта 
 
Процесс рендеринга видеопроекта схож с рендерингом аудиопроектов, но с меньшим количеством опций и 
параметров, которые ориентированы на видео. Большинство опций диалогового окна File > Render служат той 
же самой цели, что и для аудиопроектов и не нуждаются в дальнейшем обсуждении. Важные различия можно 
найти в секции Output format. Video(GIF) - опция, которая применяется в том случае, если проект не содержит 
аудиоматериала, но в большинстве случаев необходимо выбрать опцию Video (libav/FFmpeg encoder). После 
этого необходимо выбрать формат контейнера: AVI, QT/MOV/MP4, MKV или WEBM. Выбор видеокодека (Video 
codec) и аудиокодека (Audio codec) будет зависеть от выбранного формата контейнера. Это позволит 
сконвертировать аудиоконтент в выбранном формате. Можно выбрать размер (от 320 x 240 (QVGA) до 1920 x 
1080 (Full HD) и частоту кадров (от 24 до 30) из списка (см. рисунок ниже). Доступны также опции Keep source 
aspect ratio (оставить параметры соотношения источника) и Get width/height/ framerate from current video 
item (использовать параметры текущего видео). При использовании опции Video (libav/FFmpeg encoder) 
используется кодеки Video codec VP8 и Audio codec VORBIS. Остальные опции были объяснены раньше. Это 
такие опции как Add to render queue (отсрочить рендеринг) или Render file (рендеринг в режиме реального 
времени). 
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22. Предварительные настройки и другие параметры REAPER 
 

22.1. Введение 
 
Неоднократно в этом руководстве мы встречались с предварительными настройками и параметрами. В данной 
главе мы обсудим другие способы использования предварительных настроек REAPER и других параметров, для 
конфигурации программы под конкретные требования. И пусть вас не пугает обилие опций. В большинстве 
случаев вы, вероятнее всего, будете рады оставить настройки программы как есть по умолчанию. Не все опции 
и предварительные настройки будут охвачены в этой главе. Если вам нужна подробная информация о каких-
либо предварительных настройках и параметрах REAPER, посетите REAPER WIKI или форумы REAPER. 
 

22.2. Страница Options > Preferences > General 
 

 
 
Большинство параметров на странице General попадают в одну из следующих категорий (секций): 
 
Секция General settings 
 
Меню Language: выберите из меню любой доступный язык или опцию запроса (promt on load) на выбор языка 
при загрузке REAPER. Изменения будут внесены после перезапуска Reaper. Дополнительные языковые пакеты 
можно скачать по ссылке Download language packs. Кнопки Import configuration/Export configuration: эти 
кнопки могут использоваться для объединения, сохранения и экспортирования различных параметров и 
конфигураций в специальный файл ReaperConfigZip, или для импортирования параметров из этого ранее 
сохраненного файла (подробнее об этом в следующем параграфе). 
 
Секция Undo settings  
 
Эти параметры объяснены в Главе 2 и в конце этой главы. 
 
Секция Startup settings  
 
Меню Open projects on startup (открыть проекты при запуске программы) включает опции Last active project 
(последний активный проект), Last project tabs (последние вкладки проектов, т.е. все проекты, которые были 
открыты, когда REAPER был закрыт в последний раз), New project ignoring default template (новый проект, 
игнорируя шаблон по умолчанию), New project (новый проект) или Prompt (запрос). При выборе опции Prompt 
при запуске Reaper поступит запрос на выбор одной из вышеперечисленных опций.  
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Другие опции:  
 
Show splash screen on startup (показать заставку при запуске),  
Automatically check for new versions of REAPER (автоматически проверять новую версию программы), 
Create new project tab when opening media (создать новую вкладку проекта при открытии клипа) из 
проводника (Windows) или поисковика (OS X),  
Check for multiple instances when launching: если эта опция не отмечена можно запускать несколько 
экземпляров REAPER одновременно. 
Maximum projects in recent project list: определяет максимальное количество файлов, отображаемых в меню 
File > Recent projects (последние открытые проекты). Кнопка Clear the list позволяет очистить этот список. 
Warn when Reaper's memory use reaches (предупреждать, если память Reaper превышает… мегабайт): 
предлагаемые значения - 1800 для 32-битной версии и 3800 для на 64-битной версии REAPER. 
Кнопка Advanced UI System Tweaks: открывает окно с дополнительными опциями настройки интерфейса, 
включая масштабирование элементов интерфейса (Scale Ul elements of track/mixer panels, transport, etc. by), 
например, значков и панелей, которые мы обсудим позже в этой главе. 
 

 
 
22.2.1. Кнопки Import Configuration и Export Configuration 
 
Кнопка Export configuration может использоваться для экспортирования любой комбинации ваших параметров в 
специальный файл ReaperConfig.Zip. Кнопка Import configuration может использоваться для импортирования 
ранее сохраненных настроек обратно в REAPER. Можно просто перетащить файл ReaperConfig.zip из 
проводника или поисковика в окно аранжировки REAPER с последующим запросом на подтверждение. Для 
включения в файл ReaperConfig.zip может быть выбрана любая комбинация нижеследующих элементов, 
перечисленных в левом столбце окна (см. рисуногк выше): 
 
Конфигурация (Configuration) 
Цветовые схемы (Color themes) 
Пресеты плагинов (Plug-in presets) 
Цепочки эффектов (FX Chains) 
JS эффекты (JS FX) 
Шаблоны проектов и треков (Project and track templates) 
Разные данные (Miscellaneous data) 
Курсоры и клавиатурные схемы (Cursors and key maps) 
Меню и панели инструментов (Menus and toolbars) 
Действия и горячие клавиши (Actions and key bindings) 
Наборы меню (Menu sets) 
Канальные схемы (Channel mappings) 
Скрипты (ReaScripts) 
Языковые пакеты (Language Packs) 
Базы данных браузера клипов (Media Explorer Databases) 
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Во втором (правом) столбце перечисляются соответствующие файлы выбранных клипов в левом столбце.  
На примере выше, выбрана категория Конфигурация (Configuration). После выбора нажмите кнопку Save для 
сохранения файла. Выбор параметров импорта/экспорта тесно связан с отдельными опциями импорта/экспорта, 
которые доступны в пределах многих различных клипов REAPER. Например, чтобы экспортировать только ваши 
действия и горячие клавиши вы, скорее всего, будете использовать кнопку Import/Export в окне Actions. Если с 
другой стороны вы хотите экспортировать ваши действия и горячие клавиши наряду с другими параметрами, 
например, наборы меню, цепочки эффектов и скрипты (ReaScripts) чтобы, например, импортировать их в 
REAPER на другом компьютере, вы, вероятнее всего, будете использовать окно Export configuration. 

 
Совет: не лишним было бы создать файл ReaperConfig.zip, который включал бы все вышеупомянутые 
категории, и сохранить резервную копию этого файла на отдельном носителе на случай системного 
сбоя. 

 
22.2.2. Страницы Options > Preferences > Paths и Options > Preferences > Keyboard/Multitouch 
 
В пределах категории General доступны еще две страницы - Paths и Keyboard/Multitouch. 
 
22.2.2.1. Страница Paths  
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Здесь вы можете определить (по-отдельности) пути по умолчанию, которые будут использоваться для 
сохранения новых проектов (Default path to save new projects), файлов рендеринга (Default render path (if left 
empty the current project directory, if any. will be used), записанного материала (Default recording path, when 
project is unsaved and no recording path is configured), и/или для хранения пик файлов – пик-файлы хранят 
информацию о том, как отображать сигналограммы. Пик файл делает открытие сигналограммы почти 
мгновенным и позволяет значительно сократить время, затрачиваемое на обработку сигнала, для 
альтернативного хранения пик-файлов (Use alternate peak cache path for the following paths (multiple paths 
separated by semicolons). Последняя опция будет доступна только в том случае, если отмечена опция Store all 
peak caches in alternate path на странице Options > Preferences > Media. Если путь для файлов рендеринга не 
задан, будет использоваться директория проекта. Для файлов рендеринга можно установить относительный 
путь. Например, если вы определили папку Mixes в качестве пути к файлам рендеринга по умолчанию, эта 
папка появится как папка по умолчанию в диалоговом окне File > Render. Если вы примете эту папку по 
умолчанию при рендеринге, в директории проекта будет создана подпапка с тем же именем. Например, если у 
вас проект с назвнием Hello сохранен в папке C:\REAPER Projects\Hello, то сконвертированный файл (файлы) 
для этого проекта будут помещены в папку C:\REAPER Projects\Hello\Mixes. Альтернативно, если в качестве пути 
к файлам рендеринга по умолчанию вы зададите, например, путь C:\Mixes, то этот путь будет использоваться в 
качестве абсолютной директории для сконвертированных файлов, независимо от того, где расположен сам 
проект. 
 
22.2.2.2. Страница Keyboard/Multi-touch 
 

 
 
Эта страница состоит из двух основных секций - Keyboard и Multitouch. Секция Keyboard включает опцию 
Commit changes to some edit fields after 1 second of typing (внести изменения в некоторые области 
редактирования после 1 секунды печатания). Если эта опция отмечена, можно вручную ввести скорость 
воспроизведения в соответствующей области на транспортной панели без необходимости нажимать кнопку 
Enter.  
Use alternate keyboard section when recording: позволяет использовать для записи горячие клавиши основного 
меню. 
Prevent ALT key from focussing main menu: активирование этой опции снимет фокус с главного меню, когда 
будет нажата клавиша Alt. Можно щелкнуть по двум ссылкам в этом окне, чтобы открыть редактор действий 
(Assign keyboard shortcuts) или открыть веб-браузер со списком горячих клавиш (View keyboard shortcuts).  
 
Cекция Multitouch позволяет настроить поведение сенсорной панели Multi-touch или схожей с ней, если 
таковая у вас имеется. Сопутствующие опции доступны на странице Options > Preferences > General > 
Keyboard и не забудьте заглянуть в документацию вашего устройства. 
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22.3. Страница Options > Preferences > Project 
 
Страница основных предварительных настроек проекта REAPER (Options > Preferences > Project) в некотором 
смысле менее интересна, чем две ее подстраницы. Тем не менее, она также включает некоторые полезные 
элементы: 
 

 
 
- опция, позволяющая определить файл проекта, который будет использоваться в качестве шаблона по 
умолчанию при запуске новых проектов (When creating new projects, use the following project file as a 
template). 
- подтверждать сохранение каждый раз при создании нового проекта (Prompt to save on new project). Это 
может послужить полезным напоминанием, если вы хотите использовать отдельную подпапку для проекта и его 
медиафайлов. 
- открывать окно свойств проекта при создании нового проекта (Open properties on new project). Это может 
послужить удобным напоминанием, например, если необходимо установить музыкальный размер проекта или 
представление времени, которое отличается от таковых по умолчанию. 
- предупреждать, если при открытии проекта не найдены некоторые файлы (Prompt when files are not found on 
project load). Потеря файлов может произойти, например, при удалении более старого проекта, который 
остался в списке Recent Projects. 
- показать статус загрузки файла проекта и заставку REAPER при загрузке проекта (Show load status and 
splash while loading projects). 
- сохранять ссылки на файл проекта с относительными (дополнительными) путями (Save project file references 
with relative pathnames). Это может быть полезно, например, если проект будет перемещен с одного диска на 
другой. 
- использовать команду File > Save As для сохранения текущего файла или создать несколько версий (When 
overwriting project file, rename old project to .rpp-bak >Keep multiple versions). 
- автоматически создавать файл резервной копии (RPP-BAK) из предыдущей сохраненной версии проекта при 
ее пересохранении, а если так, то добавлять временную метку в этот файл (When overwriting project file, 
rename old project to rpp-bak > Timestamp backup). Активирование этих опций может послужить в качестве 
предохранения и помочь вам вернуть данные, например, при повреждении проекта. 
- автоматически сохранять проекты и, если так, то через какой интервал, который по умолчанию составляет 15 
минут, а также при каких обстоятельствах: когда не активирована запись (when not recording), когда 
останавливается запись (when stopped) и каждый раз (any time). 
 

 
 
- включить историю отмен при автосохранении проекта (Keep undo historits). Эта опция будет применяться 
только в том случае, если на странице Options > Preferences > General отмечена опция Save undo history with 
project files (in .RPP-UNDO file). 
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22.3.1. Страница Options > Preferences > Project > Track/Send Defaults 
 
На этой странице вы найдете две группы параметров по умолчанию - для треков (Tracks) и посылов (Sends). 
 

 
 
22.3.1.1. Секция Tracks  
 
Track volume fader default gain: уровень фейдера громкости для новых треков. Значение по умолчанию 0.0 dB. 
Default visible envelopes: позволяет определить огибающие трека (например, огибающую громкости или 
панорамы), которые будут автоматически отображаться в новых треках. 
Default envelope point shape: форма огибающих (например, Linear) для новых треков. 
Default automation mode: режим автоматизации (например, Trim/Read) для новых треков. 
Default track height in new projects: высота панели трека. Доступные значения: small (маленькая), medium 
(средняя) и large (большая). 
Show in mixer: отображать новые треки в микшере. 
Main (parent) Send: активировать посыл в мастер-трек (треки высшего уровня) или в родительскую папку 
(дочерние треки) для новых треков. 
Free item positioning: активировать свободное расположение клипов (FIPM) для новых треков. 
Record-arm: автоматически активировать новые треки для записи. 
Record config: нажатие этой кнопки открывает страницу с параметрами записи для новых треков. 
 
Здесь вы можете определить будет ли активирован мониторинг, выбрать тип записи - входной сигнал (аудио 
или MIDI) или выходной сигнал, источник входного сигнала по умолчанию.  
 
Опция Scaling for new volume envelopes позволяет активировать соотношение огибающих громкости к 
амплитуде (Amplitude scaling) или фейдеру громкости (Volume fader scaling). 
 
22.3.1.2. Секция Sends/Track Hardware Outputs 
 
Send default gain: уровень громкости фейдера для посылов нового трека. 
Hardware output default gain: уровень фейдера громкости для новых посылов с внешнего устройства. 
Sends/hardware output default mode: тип посыла (например, Post fader/Post pan). 
Sends … by default: включить ли по умолчанию посылы аудио или MIDI, или те и другие. 
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22.3.2. Страница Media Item Defaults 
 
Страница Media Item Defaults включает следующие опции: 
 

 
 
- применять автоматический фейдинг в новых клипах, и если так, то какой продолжительности он должен быть 
(Create automatic fade-in/fade-out for new items, length). 
- накладывать ли клипы друг на друга и создавать ли кроссфейдинг при разделении клипов, и если так, то какой 
продолжительности (Overlap and crossfade items when splitting, length). 
- форма фейдинга и кроссфейдинга по умолчанию (Default fade-in/fade-out shape). 
- должен ли щелчок правой кнопкой мыши по одной стороне кроссфейдинга (фейдинга) изменять только эту 
сторону (используя клавишу Shift для переключения) (Right-click on crossfade sets fade shape for only one 
side of the crossfade (shift toggles). 
- разрешить автоматический фейдинг и кроссфейдинг параметра velocity для MIDI нот (Enable automatic fade-
in/fade-out and autocrossfade for MIDI note velocity). 
- зацикливать источник импортированных клипов (Loop source for imported items) и/или новых MIDI клипов 
(Loop source for new MIDI items) и/или записанных клипов (Loop source for recorded items) и/или склеенных 
клипов (Loop source for glued items). 
- должна ли запись выделенной области в режиме auto-punch автоматически создавать область лупа (Time 
selection auto-punch audio recording creates loopable section). 
- обрезать содержимое вслед за клипами при редактировании (Trim content behind media items when editing) 
 

22.4. Конфигурация аудиопараметров и другие настройки 
 
Мы уже упоминали (Глава 1) страницу Options > Preferences > Audio Device, а сейчас стоит обсудить эту тему 
чуть подробнее. Две важные проблемы в мире обработки цифрового аудио касаются таких параметров, как 
buffers (размер буферов) и latency (задержка). Понимание значений этих терминов поможет вам в достижении 
оптимальных настроек для вашей системы.  
 
Правильное понимание термина «размер буфера» очень важно в вопросах достижения наилучшего 
быстродействия (отклика) вашего аудиоинтерфейса. Если размер буфера слишком мал, могут появиться 
щелчки и обратные отсчеты (щелчки наоборот). Если размер буфера слишком велик, при мониторинге входного 
сигнала в наушниках появится задержка, особенно с программными синтезаторами. Цель настройки размера 
буфера состоит в том, чтобы достигнуть компромисса между наименьшей задержкой и не допущения 
искажений. Оптимальная настройка зависит от нескольких аспектов, не в последнюю очередь из которых 
являются используемый вами аудиоинтерфейс (PCI звуковая карта, firewire или USB-устройство), 
характеристики вашего компьютера, а также какое программное обеспечение вы используете. Некоторые 
плагины могут также увеличить задержку, даже более вероятнее, чем другие причины. Присмотритесь к тому, 
что происходит, когда вы работаете в хосте. При воспроизведении ваших треков, идет непрерывный поток 
данных с жесткого диска и/или с оперативной памяти в вашу звуковую карту. Среди прочего аудиокарта 
конвертирует цифровые данные в аналоговую форму так, чтобы их можно было отослать и услышать через 
ваши динамики или наушники. При записи происходит обратный процесс - поступающий аналоговый аудиопоток 
конвертируется в цифровой формат так, чтобы его можно было сохранить на жесткий диск. При перезаписи 
звука, оба этих действия происходят одновременно. Более того, при мониторинге входного сигнала, 
записываемый трек или треки фактически поступают в компьютер в аналоговой форме, конвертируются в 
цифровую форму, обрабатываются, а затем конвертируются назад в аналоговую форму, возвращаясь как есть 
обратно в ваши наушники.  
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Теперь о задержке. Побороть задержку легче, если само аудиоустройство поддерживает мониторинг входного 
сигнала. В этом случае входящий записываемый аудиопоток направляется назад в ваши наушники, прежде чем 
он достигнет компьютера. И как будто бы этого мало, помните, что Windows выполняет и другие задачи 
одновременно с вашей записью. Чтобы поверить в это, достаточно открыть Диспетчер задач и посмотреть на 
страницу «Процессы». Это - то, что мы подразумеваем под термином многозадачность. Так каким же образом 
Windows справляется с этой многозадачностью? Все дело в распределении ресурсов между этими задачами. 
Чтобы поддержать стабильность аудиопотока, для него выделяется небольшой объем памяти. Это и 
называется «буферами». Таким образом, при воспроизведении аудио, Windows передает вашей звуковой карте 
только порцию аудиоматериала, который в свою очередь звуковая карта передает с постоянной скоростью на 
внешний усилитель. Если буферы опустошаются прежде чем Windows загрузит очередную порцию 
аудиоматериала, возникает проблема. Тот же самый принцип применяется, но в обратном порядке при записи. 
И опять же, когда вы записываете наложением или наслоением, или используете мониторинг входного сигнала 
REAPER, оба эти действия выполняются одновременно. Если размер буфера будет слишком мал, произойдет 
прерывание аудиопотока, сопровождаемое щелчками, треском и в некоторых случаях даже выпадением (когда 
воспроизведение и/или запись просто внезапно и неожиданно останавливается). Для решения этой проблемы 
обычно достаточно увеличить размер буферов. Однако установка слишком большого размера буферов 
порождает долгое ожидание данных в конце буферов, прежде чем они смогут быть обработаны. Именно тогда 
появляется задержка, например, задержка звука между нажатием клавиши на клавиатуре и слышимым звуком в 
наушниках. ASIO драйверы обеспечивают наименьшую задержку, в отличие от остальных типов драйверов. Как 
правило, предпочтительный порядок использования типов драйверов таков – ASIO > WDM > DirectX > MME. Вот 
именно в таких случаях важность кнопки ASIO Configuration на странице Options > Preferences > Audio > 
Device трудно переоценить (при условии, конечно, что вы используете именно ASIO драйверы). Чем меньше 
размер буфера, тем больше нагрузка на процессор вашего компьютера. Таким образом, после внесения 
изменений в размер буфера, проверьте быстродействие процессора на индикаторе производительности 
REAPER. Как правило, низкие уровни задержки действительно необходимы только для записи, а не тогда, когда 
вы только воспроизводите аудио. Поэтому, если вы обнаружили, что ваш процессор приближается к его 
предельным значениям быстродействия, увеличьте размер буфера вашей аудиокарты.  
 
Наконец, несколько слов о термине «частота дискретизации». Этот параметр также затрагивает быстродействие 
процессора. Увеличение значения от 44100 до 88200 удваивает нагрузку на процессор. На эту тему всегда не 
мало дебатов, но по факту только у немногих из нас такой слух, который может в действительности распознать, 
был ли трек записан в значении 44100 или в значении 88200. При желании, можете себя проверить . Другой 
важный аспект конфигурации параметров на странице Audio – это настройки подстраницы Options > 
Preferences > Audio > MIDI Device. Эта тема подробно обсуждалась в Главе 1. 
 

22.5. Страница Options > Preferences > Audio 
 
Эта страница включает опции и параметры для конфигурации вашего активного (подключенного) 
аудиоустройства. Вероятно, большинство пользователей захотят оставить, по крайней мере, первую половину 
этих параметров как есть и забыть про них, но на всякий случай: 
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Close audio device when stopped and application inactive: если эта опция отмечена, параллельно с Reaper 
можно открыть и другие аудиопрограммы (например, Sound Forge) и легко переключаться между ними. 
Close audio device when inactive and tracks are record armed: если эта опция не отмечена, и, если у вас есть 
активированные для записи треки, REAPER не будет совместно использовать ваше аудиоустройство с другими 
программами. 
Close audio device when stopped and active: если эта опция отмечена REAPER автоматически закроет 
аудиоустройство, если аудио активно и не воспроизводится. 
Warn when unable to open audio/MIDI devices: активирование этой опции может потенциально помочь вам 
выявить причину при появлении проблем с аппаратным интерфейсом. 
Tiny fade out on playback stop/Tiny fade in on playback start: эти опции могут помочь предотвратить щелчки. 
 
Секция Channel naming/mapping включает опции назначения смысловых имен (псевдонимов) вашим входным 
и выходным аудиоустройствам (Input/Output channel name aliasing/remapping). Подробнее об этом в Главе 1. 
Show nonstandard stereo channel pairs (отображать нестандартные канальные пары, например Канал 2/Канал 
3 и т..д) 
Default metronome output: позволяет выбрать выходной канал для метронома. 
 
Заметьте, что страница предварительных настроек Audio > Device обсуждалась в Параграфе 1.12, а страница 
предварительных настроек Audio > MIDI Device в Параграфе 1.15. 
 
22.5.1. Страница Options > Preferences > Audio > Mute/Solo 
 

 
 

Можно автоматически мьютировать любой трек или 
только мастер-трек по достижении указанного предел 
в dB. Эта опция может помочь защитить ваш слух, 
ваши клолнки и вашу звуковую карту! Третяя опция 

позволяет отключить автоматическое мьютирование.  
Можно также сбросить параметры автоматического мьютирования на старте воспроизведения (Reset on 
playback start). Активирование опции Do not process muted tracks и/или Reduce CPU use of silent tracks 
during playback может уменьшить нагрузку на процессор. 
Solos defaults to in-place solo: в активированном состоянии при солировании трека, наряду с этим треком вы 
услышите сигнал с любых других треков, на которые отправлен посыл с этого трека. Отключение этой опции 
гарантирует, что вы услышите только сигнал солирующешго трека. Так или иначе щелчок на кнопке Solo с 
нажатой клавишей Alt будет переключать состояние этой опции по умолчанию. 
Solo in front позволяет воспроизводить другие треки в фоновом режиме, когда солируются один или несколько 
треков. Это может помочь вам увеличить контекст прослушивыаемых треков. Сама функция 
активируется/отключается в меню Options: здесь же вы можете установить предпочтительный уровень в dB для 
фонового материала. 
Последняя опция Parent and hardware sends is unsoloed when a soloed in place track sends to another soloed 
track. 
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22.5.2. Страница Options > Preferences > Audio > Buffering 
 

 
 
При рассмотрении вопросов оптимизации аудиоустройств, необходимо обратить внимание на страницу Options 
> Preferences > Audio > Buffering. Опция Disable media buffering for tracks that are selected (отключить 
буферинг для выбранных треков) может оказаться полезной при использовании сторонних плагинов, которые 
плохо отвечают на буферизацию. Если вы не подкованы технически, настоятельно рекомендовано оставить 
большинство этих опций как есть. Если ваш компьютер мультипроцессорный, следующие опции могут оказаться 
полезными:  
Anticipative FX processing обладает преимуществами как для мультипроцессорной системы, так и для 
однопроцессорных систем. На однопроцессорных системах это делает REAPER более терпимым к низким 
значениям задержки интерфейса (и более стойким к плагинам, которые увеличивают блочно-ориентировочную 
обработку, например, ReaVerb и ReaFir). Активация этой опции может оптимизировать задержку. Однако опция 
Allow on tracks with open MIDI editors может увеличить задержку при воспроизведении. На некоторых 
системах на платформах Windows 8 или OS X Mavericks, активирование опции Use new alternate worker thread 
scheduling может привести к улучшению быстродействия. Нажатие кнопки Advanced Disk I/O Options 
обеспечивает доступ к опциям, которые вы видите на рисунке ниже. Если вы не уверены в своих действиях 
лучше оставить эти настройки как есть. Любые вносимые вами изменения будут применены после перезапуска 
проекта. 
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22.5.3. Страница Options > Preferences > Audio > Playback 
 

 
 
22.5.3.1. Секция Playback settings 
 
Stop/repeat playback at end of project (остановить/повторить воспроизведение по окончании проекта) 
Stop playback at the end of a loop if repeat is disabled (остановить воспроизведение в конце области лупа если 
функция повторения отключена) 
Scroll the view to edit cursor on stop (при остановке воспроизведения прокрутить окно в позицию курсора 
редактирования) 
Don't auto-scroll view when enable when viewing other parts of project (не прокручивать автоматически окно, 
когда фокусированы другие части проекта) 
Run FX after stoping (активировать эффекты после остановки воспроизведения): помогает оценить хвосты 
эффектов, основанных на задержке, таких как ревербератор или хорус. 
Send MIDI note-offs when unrecord-arming a track (отослать сообщения о снятии ноты при отключении 
активирования трека для записи) 
Reset MIDI CC/Pitch (сбросить MIDI сообщения непрерывных контроллеров/высоты тона) - при старте 
воспроизведения (playback start), остановке воспроизведения (playback stop), воспроизведении/пропуске 
области лупа (playback loop/skip). 
 
22.5.3.2. Секция Scrub/jog Settings  
 
Включает опции управления воспроизведением в режимах Scrub/Jog. Например, здесь можно определить 
скорость воспроизведения в режимах Scrub/Jog (Limit Scrub/jog rate to). Опция Only play selected tracks when 
scrubbing/jogging позволяет использовать эти режимы только для выбранных треков. Обратите также 
внимание на опцию Continuous scrolling (непрерывная прокрутка) в меню Options. Поведение мыши в 
режимах Scrub/Jog можно определить на странице Options > Preferences > Editing Behavior > Mouse 
Modifiers. 
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22.5.4. Страница Options > Preferences > Audio > Seeking 
 

 
 
Seek playback when clicked (переместить курсор воспроизведения в указанную позицию). При щелчке по 
любому месту шкалы времени (Top ruler), на пустой области треков (Empty areas of tracks) и/или на пустой 
области ниже треков (Empty area below tracks). Отключение любой из вышеперечисленных опций позволит 
"рисовать" в области аранжировки (например, на шкале времени выделить область лупа или в пустой области 
между треками выделить область), не затрагивая текущее воспроизведение. 
Seek on loop points change (переместить курсор воспроизведения при изменении границ лупа) и/или Only 
when repeat is enabled (переместить курсор воспроизведения при изменении границ лупа только если 
активирована функция повторения) 
Seek playback when an item is moved/sized/fade adjustment (переместить курсор воспроизведения при 
перемещении клипа, изменении его размеров, редактировании фейдинга). 
Playback position follows project timebase (time or beats) when changing tempo: определяет, будет ли 
позиция воспроизведения следовать за представлением времени проекта при изменении темпа. 
Do not change playback position immediately when seeking (smooth seek): позволяет продолжить 
воспроизведение до конца назначенного количества тактов (Play to end of more measures before seeking), или 
до следующего маркера проекта, конца региона, перед измененной позиции курсора воспроизведения (Play to 
next project marker, end of current region, or start of next region, before seeking). 
 
22.5.5. Страница Options > Preferences > Audio > Recording 
 
Опции этой страницы подробно обсуждались в Главе 3. 
 
22.5.6. Страница Options > Preferences > Audio > Loop Recording 
 
Эта страница определяет поведение REAPER ведет при записи в режиме зацикливания. 
 

 
 
In Loop recording, discard incomplete first or last takes if at least one full loop was recorded: предотвращает 
раздражающие и нежелательные частично сохраняемые копии, которые могли бы быть вызваны, если бы вы 
чуть замедлились в остановке записи. Опция Threshold for complete take определяет порог (по умолчанию 90% 
от продолжительности лупа) продолжительности записи лупа до ее окончания. 
MIDI overdub/replace recording always creates selection-length media item: активирование этой опции 
гарантирует, что длина выделенной области будет соответствовать длине MIDI клипа. 
When recording and looped, add recorded media to project: гарантирует, что клипы не будут добавлены в 
проект до тех пор, пока запись не будет остановлена. Дополнительно, можно создать новые файлы для каждого 
записанного лупа (Create new files on loop). 
At each loop: гарантирует, что записанные клипы будут добавляться на лету после прохождения каждого цикла. 
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22.5.7. Страница Options > Preferences > Audio > Rendering 
 
Опции на этой странице довольно специфичны. Если вы не уверены в понимании этих опций, оставьте их как 
есть: 
 

 
 
Block size to use when rendering (размер блока, который будет использоваться при конвертировании 
сэмплов). Если сомневаетесь оставьте эту опцию не отмеченной. 
Limit apply FX/render stems to realtime (good for some plug-ins) (активировать предварительную обработку 
эффектов). Это может привести к улучшению быстродействия мультипроцессорных систем (по умолчанию 
опция отмечена). 
Limit apply FX/render stems to realtime (good for some plug-ins) (ограничить применение эффектов/стэм 
рендеринг в реальном времени). По умолчанию опция не отмечена. 
Process all tracks during stem render (some hardware-based plugins may need this) (обрабатывать все 
треки, включая соответствующие мьютированные и/или не солируемые треки при рендеринге). Опция 
замедляет рендеринг, но для некоторых плагинов это может оказаться полезно. 
Default tail length (продолжительность хвоста эффектов при рендеринге). Для всего проекта (Rendering 
stems for full project via action) и/или выделенной области (Rendering stems for time selection via action). 
When freezing, render the entire track length if there are track or per-take FX: включать ли в рендеринг весь 
трек, если он есть или есть эффекты копии. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 Специально для сайта musicmanuals.ru  486 486 

22.6. Страница Options > Preferences > Appearance 
 
Главная страница Appearance позволяет вам задать различные параметры, которые помогут определить вид 
вашего интерфейса REAPER, в особенности панели трека и микшера. Ниже пределах сводка некоторых опций: 
 

 
 
Cекция Appearance settings 
 
Tooltips for Ul elements (использовать подсказки) для таких элементов интерфейса, как кнопки и фейдеры, 
клипы и огибающие (Tooltips for items/envelopes), и т.д.: если использовать, можно определить 
продолжительность любой задержки перед отображением подсказки (Tooltip delay). 
Play cursor width (ширина (в пикселях) курсора воспроизведения). Значение по умолчанию - 1 пиксель. 
Minimum pixels between ruler text labels: максимальное расстояние (в пикселях) между текстовыми метками 
линейки времени. 
Show last undo point in menu bar (показывать последнее событие отмены (Undo) в строке меню (сразу 
после меню Help): если эта опция отмечена, щелчок по отображенному действию откроет окно Undo History. 
Show guide lines when editing (показывать рекомендации при редактировании).  
Solid edge on time selection highlight/Solid edge on loop selection (применять выделение границ к 
выделенной области и/или к области лупа). 
Don’t scale toolbar buttons below 1:1/Don’t scale toolbar buttons above 1:1 (ограничивать размер кнопок на 
панели инструментов): если эти опции отмечены при изменении размеров главной или плавающей панели 
инструментов кнопки не будут становиться меньше или больше. 
Frameless floating toolbar windows (включить окна плавающих панелей инструментов в кадры). 
Pixels between items on adjacent tracks (размер в пикселях между смежными треками) - т.е., между нижней 
границей одного клипа и верхней границей клипа ниже. Высокие значения могут облегчить определение 
выделенной области. 
Maximum number of lanes, when showing overlapping items in lanes (максимальное количество дорожек, 
которые будут использоваться при отображении совмещенных клипов). Более низкое значение может 
помочь предотвратить загромождение экрана. 
 
Секция Envelopes 
 
Filled automation envelopes (использовать закрашенные огибающие автоматизации): если эта опция 
отмечена область ниже огибающей будет окрашена, что позволяет сделать ее форму более различимой. Если 
отмечена опция Filled envelopes when drawn over media, эту опцию можно отключить. 
Horizontal grid lines in automation lanes (показать горизонтальные линии сетки на дорожках автоматизации). 
Grid line Z order – отображать линии сетки: над клипом (over items), сквозь клип (through items) или под 
клипом (under items). 
Show dotted grid lines – отображать линии сетки пунктиром 
Marker line Z order – отображать линии маркеров: над клипом (over items), сквозь клип (through items) или под 
клипом (under items) 
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22.6.1. Страница Options > Preferences > Appearance > Media 
 
В основном опции на этой странице разделены на две основные секции - Media item appearance и Media item 
buttons.  
 

 
22.6.1.1. Секция Media item labels 
 
Display media item take name (отображать имена копий клипа) и/или высоту тона/скорость воспроизведения 
клипа (Display media item pitch/playrate if set) и/или усиление (Display media item gain if set): если отмечена 
одна из этих опций можно выбрать где отображать надписи - над клипами, а не в пределах клипов (Draw labels 
above the item, rather than within the item). Если последняя опция отмечена, можно также определить (кроме 
тех случаев, когда высота клипа меньше, чем высота надписи) - Except when the media item height is less 
than the label height. Если последняя опция отмечена надпись будет перемещена во внутреннюю часть клипа, 
когда высота дорожки клипа будет меньше, чем высота надписи, но также и больше, если отмечена опция (Hide 
labels when the media item take lane height is less than). Можно также решить, использовать ли цветной фон 
для облегчения прочтения надписей (Draw labels over solid background for easier reading) и показывать ли 
надписи, когда края клипа не видны (Show labels for items when item edges are not visible). Вторая из этих 
опций гарантирует, что надписи останутся видимыми при прокрутке проекта мимо начала клипа. Можно также 
определить, как будут отображаться данные скорости/высоты тона (Item take rate/pitch) - например, в типичном 
отображении, сокращены, или в цифровой форме. 
 
22.6.1.2. Секция Media item buttons  
 
В основном опции этой секции спаренные - Locked/Not locked, Muted/Not muted, Per take FX/No FX, 
Automation envelopes/No active envelopes, Notes/No notes, Item Properties, Pooled MIDI, Grouped items. 
Выберите, какие из этих кнопок будут отображаться выше или ниже клипов. 
Hide buttons when take lane height is less than xx pixels (скрыть кнопки если высота дорожки клипа меньше … 
пикселей) 
Item volume control (выбор контроллера громкости клипа): Handle (+0.0 dB is top of item) (хэндл +0.0 dB 
наверху клипа), Handle (+0.0 dB is center of item) (хэндл +0.0 dB по центру клипа), или Knob (регулятор). 
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22.6.2. Страница Options > Preferences > Appearance > Peaks/Waveforms 
 
Эта страница включает опции, определяющие тип прорисовки сигналограмм и вид самих сигналограмм.  
 

 
 
22.6.2.1. Секция Audio peak/waveform appearance 
 
Можно задать, будет ли прорисовываться сигналограмма для клипов (Display peaks for media items) и/или 
будет ли прорисовываться сигналограмма при записи (Display while recording). Вы можете также выбрать 
опцию, чтобы не показывать прорисовку для невыбранных треков (Only display peaks for tracks that are 
selected) и/или мьютированных/не солируемых треков (Only display peaks for tracks that are soloed or not 
muted).  
 
Antialising - технический термин. Подробную информацию можно узнать из сети, но, если коротко, 
активирование этой функции может дать вам более точное представление: отключение этой функции может 
ускорить прорисовку.  
 
Единственная роль опций edges - косметическая. Отметьте эти опции, например, в том случае, если вам 
нравятся ограниченная (с границами) прорисовка при использовании пользовательских цветов. Эти опции могут 
игнорироваться установленной цветовой темой.  
Automatically scale MIDI notes/drum MIDI (автоматически масштабировать MIDI ноты/ноты барабанных партий 
чтобы подогнать их под отображение клипа в области аранжировки).  
Draw waveform zero lines above peaks/waveforms (прорисовывать нулевую линию сигналограммы выше самой 
сигналограммы) и Fill waveforms to zero line (заполнить сигналограмму до нулевой линии).  
Опция Scale peaks by pre-fx volume/pan envelopes должна быть активирована в том случае, если вы хотите, 
чтобы прорисовка сигналограммы на ваших клипах была отрегулирована согласно любым изменениям 
огибающей громкости в режиме pre FX. Заметьте также, что при достаточном масштабировании можно выбрать 
вид сигналограммы: Dots and lines, Filled samples, Outlined samples, Stepped samples и Smooth.  
Если опция Draw faint peaks in folder tracks активирована, выходной сигнал дочерних треков трек-папки будут 
отображаться в виде сигналограмм на дорожке трек-папки в области аранжировки.  
Опция Sample level waveform view определяет вид сигналограмм при таком масштабировании, когда можно 
определить отдельные сэмплы - например, dots and lines, filled, outlined, stepped или smooth. 
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22.6.2.2. Секция Custom colors  
 
Опции Tint media item waveform peaks (окрасить прорисовку сигналограмм клипов) или Tint item background 
(окрасить фон клипов) можно применить к цвету треку, цвету клипа или цвету копии. Если активированы 
больше одной из этих опций, то у самого низкого уровня будет приоритет. Таким образом, будет приоритет 
цвета копии над цветом клипа, который в свою очередь будет иметь приоритет над цветом трека. Обратите 
внимание на то, что некоторые темы могут игнорировать эту группу опций. Можно также задать необходимую 
насыщенность оттенка (tint strength), которая будет использоваться для фона клипов, в диапазоне значений от 
0 до 4, где 2 - значение по умолчанию. Также в этой секции доступна опция Automatically color any recording 
pass that adds takes to existing media items (автоматически окрашивать любой проход записи, добавляющий 
копии к текущему клипу). Это может помочь прояснить отображение при работе с несколькими копиями. 
 
22.6.3. Страница Options > Preferences > Appearance > Fades/Crossfades 
 

 
 
Эти опции обеспечивают более детальное управление фейдингом и кроссфейдингом клипов. Можно задать 
минимальную ширину в пикселях (width) клипа и/или высоту (Tall), необходимую до того, как будет 
отредактирован фейдинг. Можно включить или отключить редактирование мышью (Allow mouse to target) 
кривых фейдинга (fade-in/out curve) и/или начальных и конечных точек фейдинга (fade start/end line). 
Можно решить, при каких обстоятельствах вы хотите или не хотите, чтобы были отображены хэндлы фейдинга и 
хэндлы редактирования кроссфейдинга (Show fade-in/out handle/Show crossfade handle). Можно указать, 
хотите ли вы, чтобы использовалась цветовая тема редактора кроссфейдинга (When editing crossfades with 
the mouse, use crossfade editor theme colors). 
 
22.6.4. Страница Options > Preferences > Appearance > Track Control Panels 
 
Опции панели управления трека включают: 
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Set track label background to custom track colors (использовать пользовательские цвета трека в качестве 
цвета фона на метках трека (на панели трека и на панели микшера)  
Tint track panel backgrounds (окрашивать фон панели трека (на панели трека и на панели микшера). Эти две 
опции могут игнорироваться некоторыми цветовыми темами. 
Align TCP controls when track icons are used (приспосабливать компоновку контроллеров панели трека при 
использовании значков трека). 
Track grouping indicators (использовать индикаторы группировки трека (ленты или линии) 
 
Следующие четыре элемента на этой странице в секции VU meters определяют частоту обновления индикатора 
громкости (Meter update frequency (Hz), скорость затухания индикатора (Meter decay (dB/sec), минимальное 
значение индикатора (Meter minimum value (dB) и максимальное значение индикатора (Max value (dB). Если у 
вас нет серьезного основания изменять эти опции, оставьте их как есть. Есть и другие опции, которые 
совместно определяют вид ваших индикаторов трека. Особенно интересные из них: 
Show dB scales on track meters/Show dB scales on rec-armed track meters: если эти опции отмечены значения 
громкости на индикаторах будут отображаться в цифровом виде.  
Если отмечена опция Sticky clip indicators, пики индикатора уровня громкости будут маркированы полосками, 
которые будут оставаться видимыми в пиковых значениях какое-то время.  
Показывать активность параметра MIDI velocity (Show MIDI velocity on track VU) и/или активность выходного 
MIDI сигнала на индикаторе громкости трека (Show MIDI output activity on track VU).  
Reset meter peak indicators on play/seek (сбрасывать пиковые значения индикатора при 
воспроизведении/переходе в указанную позицию): отключите эту опцию, чтобы оставить текущий пиковый 
уровень отображенным при возобновлении воспроизведения. 
Track meters display pre-fader levels (показать на индикаторах трека pre-fader уровни) 
Опции секции Volume/pan faders могут использоваться для ограничения настраиваемого диапазона фейдеров 
громкости (Volume fader range) и/или фейдеров панорамирования. Верхний диапазон громкости можно 
установить в 0 dB или выше. Меню shape определяет форму фейдера громкости: например, если вы выбрали 
значение Linear dB 1.0, фейдер становится логарифмической кривой так, чтобы линейное перемещение 
производило постоянную кривую в децибелах. Можно также задать, должны ли фейдеры панорамирования 
отображаться в пределах от 100%L до 100%R или от -90 dB до +90 dB (Pan fader unit display). 
 

22.7. Страница Options > Preferences > Editing Behavior 
 
Страница Editing Behavior включает опции, затрагивающие редактирование проектов REAPER. Давайте 
рассмотрим некоторые наиболее полезные опции: 
 

 
 
Определите поведение курсора редактирования, а именно какое из действий должно перемещать и как курсор 
редактирования: Move edit cursor to start of time selection on time selection change (переместить курсор 
редактирования в начало выделенной области при изменении этой области),  
Move edit cursor when pasting/inserting media (переместить курсор редактирования в место вставки клипа 
при его копировании или вставки извне), Move edit cursor to end of recorded items on record stop 
(переместить курсор редактирования в конец записанного клипа при остановке записи) 
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Link loop points to time selection (привязывать ли по умолчанию выделенную область с областью лупа). 
Clear time selection when edit cursor moves on click in arrange view (снять выделение области, когда курсор 
редактирования перемещается при щелчке в окне аранжировки)/Clear loop points on click in ruler (снять 
область лупа при щелчке на линейке времени). Например, если вы захотите щелкнуть по линейке времени с 
целью изменить позицию курсора редактирования, то вы, вероятно, не захотите, чтобы область лупа снималась 
автоматически. 
Опции масштабирования: Vertical zoom center (центр вертикального масштабирования) со значениями - 
Track at center of view (трек в центре окна), Top visible track (верхний видимый трек), Last selected track 
(последний выбранный трек), Track under mouse cursor (трек под курсором мыши). Horizontal zoom center 
(центр горизонтального масштабирования) со значениями - Edit or play cursor (курсор редактирования или 
воспроизведения), Edit cursor only (только курсор редактирования), Centre of view (центр окна), Mouse 
cursor (курсор мыши). Выбор значения Mouse cursor в обеих опциях гарантирует, что при масштабировании, 
то, что располагается под курсором мыши, останется на экране. В секции Transient detection (определение 
транзиента) можно настроить чувствительность и порог щелчком по кнопке Adjust sensitivity в процентах в 
отрывшемся диалоговом окне. С помощью опции Locked item ripple editing behavior можно определить 
поведение REAPER, если при редактировании в режиме Ripple Editing есть заблокированные клипы. 
Доступные опции - Locked items interrupt ripple (ripple редактирование прерывается на первом 
заблокированном клипе, но, может быть завершено, повторив это действие нужное количество раз, чтобы 
выбрать клипы для ripple редактирования), Locked items interrupt ripple per-track (схожа с предыдущей 
опцией, но основывается на базе трека, а не на базе клипа), Locked items unaffected by ripple 
(заблокированные клипы редактируются в обычном порядке, а другие клипы редактируются в режиме Ripple 
Editing), Locked items are affected by ripple (lock ignored) (все клипы в выборе редактируются в режиме 
Ripple Editing, включая заблокированные клипы). 
Allow dual trim (edit shared media item edges) only if both items are selected (разрешить двойную обрезку - 
отредактировать края обоих клипов только если оба клипа выделены) 
Должны ли границы кроссфейдинга оставаться совмещенными при редактировании границ фейдинга 
(Crossfades stay together during fade edits when trim content behind media items is enabled). 
Удалять ли автоматически пустые треки, созданные при перетаскивании клипов ниже последнего трека 
(Automatically delete empty tracks created by dragging items below the last track and back). 
Должно ли смещение начальной точки активной копии затрагивать смещение всех копий (Dragging the source 
start offset of the active take adjusts the offset for all takes). 
If no items are selected, some split/trim/delete actions affect all items at the edit cursor (если нет выбранных 
клипов, некоторые действия разделения/обрезки/удаления затронут все клипы в позиции курсора 
редактирования): если эта опция не отмечена, и если нет выбранных клипов, щелчком по клавише S будут 
разделены все клипы. 
 
22.7.1. Страница Options > Preferences > Editing Behavior > Envelope Display 
 
Эта страница включает опции отображения огибающих. 
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Volume envelope range (диапазон в децибелах, в пределах которого могут быть отрегулированы огибающие 
громкости). Значения от -inf... +0dB до -inf... +24dB. 
Per-take pitch envelope range (диапазон в полутонах для огибающих высоты тона копии), а также будут ли 
привязываться огибающие высоты тона копии к определенному значению (snap). 
Project tempo map envelope display min (диапазон отображения в ударах в минуту для огибающей мастер 
темпа проекта). 
Show new envelopes in separate envelope lanes (показать по умолчанию новые огибающие на отдельных 
дорожках огибающих). 
When drawn over media, overlap envelopes if each is less than (при прорисовке поверх клипа, накладывать ли 
огибающие, если каждая из них меньше, чем x пикселей по высоте). Активирование этой опции может создать 
визуальный эффект нагромаждения, но обеспечивает дополнительную высоту для редактирования узлов 
огибающей. 
When adding envelopes, set the focus to the envelope (установить ли фокус на новых огибающих при их 
добавлении). Эта опция автоматически выбирает огибающие для редактирования и т.д. 
Envelope point selection follows time selection for the active envelope (выделять ли узлы огибающей с 
выделением области). 
Prevent mouse edits of single envelope points from moving past other points (Предотвратить 
редактирования мышью одних узлов огибающей от перемещения мимо других узлов) 
First click on unselected envelope can insert a point (depends on mouse modifier settings) (будет ли первый 
щелчок по невыбранной огибающей вставлять узел): проверьте также настройки модификаторов мыши. 
Automatically show affected envelopes when moving media items across tracks (показать ли автоматически 
огибающие при перемещении по трекам). 
Changing envelope in lane (должно ли изменение огибающей, отображенной на какой-либо дорожке скрыть 
огибающую, которая располагалась там ранее или переместить ее на дорожку клипа). 
Automatically add edge points when editing (автоматически добавлять граничные узлы при редактировании) 
со значениями Multiple points (нескольких узлов), Media items (клипов), Ripple editing or inserting time (в 
режиме ripple editing).  
Transition time for automatically created envelope edge point (время перехода для автоматически созданных 
граничных узлов огибающей). Чем больше значение, тем более сглажен переход. 
Use relative mouse edits for (использовать ли относительное редактирование мышью только для 
масштабируемых фейдером огибающих громкости (fader-scaled volume envelopes), или также и для других 
огибающих (other envelopes). Обратите внимание на то, что относительное редактирование мышью 
обеспечивает дополнительное разрешение оси Y, за счет узлов огибающей не следующих за курсором мыши. 
 
22.7.2. Страница Options > Preferences > Editing Behavior > Automation 
 

 
 
Automation recording return speed (возвратная скорость записи автоматизации) т.е. время, потраченное 
огибающей для возврата к ее предыдущему значению, используя действия для записи изменений огибающей. 
Action transition time (время перехода автоматизации): применяется при использовании текущего значения 
записи для действий записи огибающей. 
Automatically add envelopes when tweaking parameters in automation write modes (добавлять ли 
автоматически огибающие при настройке любых параметров с активированным режимом записи). Это 
облегчает создание огибающих, но означает, что с активированным режимом записи невозможно будет 
отрегулировать любые параметры, не создавая для них огибающих. 
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Display read automation feedback from hidden envelopes (отобразить ли обратную связь автоматизации в 
режиме read из скрытых огибающих). Например, если у вас есть скрытая огибающая громкости, то 
активирование этой опции позволит фейдеру громкости автоматически перемещаться с изменениями по 
громкости, даже при том, что огибающая скрыта, активируя тем самым режим read. 
Reduce envelope point data when recording or drawing automation Allow writing automation to hidden 
envelopes (в режиме записи, активировать ли запись автоматизации скрытых огибающих).  
Отметьте эту опцию, если вы уверены в том, что делаете: в противном случае вы рискуете внести случайные 
изменения в огибающие. 
Reduce envelope point data when recording or drawing automation (сократить ли данные узлов огибающих 
при записи или при перетаскивании автоматизации). Если эта опция не отмечена, это может привести к 
увеличению количества создаваемых узлов. 
When recording automation and stopped (при записи остановки автоматизации, добавить ли дополнительную 
точку перед позицией редактирования, перед и после позиции редактирования, или не добавлять). 
When recording automation and stopped (при записи автоматизации и последующей остановки) со 
значениями Add additional point before edit position (добавить дополнительный узел перед позицией 
редактирования), Do not add additional points (не добавлять дополнительные узлы), Add points before and 
after edit position (добавить узел до и после позиции редактирования). 
When adding volume/pan envelopes, apply trim to envelope and reset trim (при добавлении огибающей 
громкости/панорамы применять обрезку к огибающей и сбрасывать обрезку). Доступные значения Always 
(всегда), In read/write mode only (только в режимах read/write), Never (Никогда). Выбор значения Never может 
облегчить ручное редактирование таких огибающих (оставляя для вас больше места выше и ниже огибающей). 
After recording automation in write mode, on repeat/seek/stop (после записи автоматизации в режиме write, на 
повторе/перемещени к выбранной позиции/остановке переклоючиться в) с дальнейшим выбором режима из 
меню. 
Reset latch state when looping (сбрасывать ли статус latch при зацикливании во время воспроизведения). 
 
Секция Automation items 
 
Insert new automation item when writing automation and underlying envelope enabled (вставить новый елип 
автоматизации в процессе записи автоматизации и активировать наложение огибающей) 
Loop new automation items by default (зацикливать новые клипы автоматизации по умолчанию) 
Editing baseline/amplitude in properties dialog affects pooled copies (редактирование базовой 
линии/амплитуды в диалоговом окне свойств затрагивает объединенные копии) 
Pool source data when pasting automation items (объединять в пул данные источника при вставке клипов 
автоматизации)   
When copying with media items (также при копировании клипов) 
Trim content behind automation items when editing or writing automation (обрезать контент вслед за 
клипами автоматизации при редактировании или записи автоматизации) 
 
22.7.3. Страница Options > Preferences > Editing Behavior > Mouse  
 
Опции на странице Mouse используется для определения поведения мыши в REAPER. Давайте рассмотрим 
некоторые наиболее полезные из них: 
 

 
 
Mouse wheel targets (цель применения колеса мыши) со значениями Window under cursor (окно на которое 
наведен курсор мыши) и Window with focus (окно под фокусом).  
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Последнее значение, например, позволяет вам использовать колесо мыши для регулирования параметров 
открытого окна эффектов, без необходимости сначала щелкнуть по окну, чтобы сфокусировать его. Фокус может 
оставаться на микшере или окне аранжировки, или где-нибудь еще, где вы были прежде, а клавиша Esc, 
например, может использоваться для снятия выделения с области, а не для закрытия окна эффектов. 
Ignore mousewheel on all faders (игнорировать колесо мыши на всех фейдерах). Отключение этой или любой 
из последующих двух опций позволяет использовать колесо мыши для регулирования фейдеров на панели 
трека и/или на транспортной панели и/или контроллеров эффектов. 
Ignore mousewheel on track panel faders (игнорировать колесо мыши на фейдерах панели трека). 
Ignore mousewheel on transport edit fields (игнорировать колесо мыши на областях редактирования 
транспортной панели). Если эта опция не отмечена, можно редактировать текстовые области, такие как BPM и 
Play rate с помощью прокрутки колеса мыши по области.  
Mousewheel moves transport time selection by beats (alt toggles) (колесо мыши перемещает выделенную 
область по долям при наведении курсора мыши на область выбора времени на транспортной панели и с 
нажатой клавишей Alt) 
Treat scroll messages from some laptop trackpads as mousewheel (рассматривать ли сообщения прокрутки 
некоторых трекпэдов ноутбуков в качестве колеса прокрутки мыши). 
Use pen/tablet safe mode (не изменять позицию курсора мыши при редактировании регуляторов и т.д.) 
Mouse click/edit in track view changes track selection (будет ли щелчок по фейдерам громкости/панорамы 
трека или по его кнопкам приводить к выбору этого трека). Если эта опция не отмечена можно регулировать 
фейдеры трека, и т.д. не изменяя выбор трека. 
Edit track names on single click (otherwise doubleclick required) (чтобы отредактировать имя трека, нужно 
щелкнуть один раз). Если эта опция не отмечена, для того, чтобы отредактировать имя трека необходимо 
дважды щелкнуть по области. 
Если отмечена опция Mouse click/edit in track view changes track selection, выбор трека будет следовать за 
выбором клипа. 
Если отмечена опция Mouse click below the last track clears media item selection можно щелкнуть и 
перетащить над треком (или между треками), чтобы отрегулировать начальные и конечные точки выделенной 
области, не затрагивая выбор клипов. 
Allow modifying edges of time selection over items in tracks: позволяет переместить границы выделенной 
области по треку (или между треками), не затрагивая выбранных клипов. 
Allow resizing ruler by dragging bottom edge: отключите эту опцию, если вы не хотите чтобы высоту шкалы 
времени можно было бы изменить вручную. 
 
Кроме того, для пользователей OS X доступна опция Ctrl left click emulates right click (щелчок с нажатой 
клавишей Ctrl эмулирует щелчок правой кнопкой мыши). Однако лучше использовать параметры системы для 
активирования щелчка правой кнопкой мыши.  
 
Страница Options > Preferences > Editing Behavior > Mouse Modifiers подробно затронута в Главе 15 и в 
других местах. 
 
22.7.4. Страница Options > Preferences > Editing Behavior > MIDI Editor 
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Flash MIDI editor keys on track input: если эта опция отмечена, при поступлении сообщений MIDI note-on (нота 
нажата), на виртуальной клавиатуре MIDI редактора соответствующие клавиши будут подсвечиваться. 
RBN friendly MIDI editor settings: позволяет MIDI редактору быть совместимым с авторской MIDI разработкой 
RBN (RockBand). Например, события текста будут присоединяться только к играемым нотам. 
Horizontal grid lines in CC lanes: активирует отображение горизонтальных линий сетки на дорожках MIDI 
контроллеров. 
Events per quarter note when drawing in CC lanes (события на четвертную ноту при прорисовке событий на 
дорожках непрерывных MIDI контроллеров). 
One MIDI editor per (один экземпляр MIDI редактора) со значениями media item (для каждого клипа), track (для 
каждого трека), project (для всего проекта). 
Behavior for open items in built-in MIDI editor (поведение по умолчанию для открытых клипов во встроенном 
MIDI редакторе) со значениями Open the clicked MIDI item only (открыть только MIDI клип, по которому 
щелкнули), Open all selected MIDI items (открыть все выбранные MIDI клипы), Open all MIDI on the same track 
(открыть все MIDI клипы только на выбранном трека), Open all MIDI in the project (открыть все MIDI клипы 
в проекте). 
 
Если выбрана опция One MIDI editor per project становятся доступными четыре дополнительные опции: 
 
Active MIDI item follows selection change in arrange view (активный MIDI клип следует за изменением выбора 
в области аранжировки). Эта опция также доступна, если выбрана опция One MIDI editor per track. 
Media item selection is linked to visibility (выбор клипа привязан к статусу видимости (visibility) и/или Selection 
is linked to editability (выбор клипа привязан к статусу редактируемости (editability). 
Only MIDI items on same track as the active items are editable (для редактирования доступны только MIDI 
клипы на том же самом треке в качестве активных). 
Close MIDI editor when the active item is deleted in arrange view (закрыть MIDI редактор при удалении из 
области аранжировки активного клипа). 
 
Double-click outside the bounds of any media item to extend the nearest media item (двойной щелчок за 
пределами границ любого клипа расширяет ближайший клип) 
Opacity for notes/CC in inactive media items (затененность для нот/непрерывных MIDI контроллеров в 
неактивных клипах). Чем выше значение, тем более затененные будут эти ноты. 
Default note color map (цветовая схема нот по умолчанию): позволяет задать вашу собственную цветовую 
схему нот по умолчанию. 
 

22.8. Страница Options > Preferences > Media 
 
Страница Options > Preferences > Media включает параметры настройки клипов. 
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Секция Media settings  
 
When inserting multiple media items (при вставке нескольких клипов) со значениями Prompt user 
(предоставить выбор пользователю), Insert in one track (advancing time) (вставить в один трек), Insert 
across tracks (распределить по трекам), Decide automatically (by looking at lengths) (автоматически в 
зависимости от продолжительности). 
Copy inserted media items to project media directory (копировать вставленные клипы в папку media проекта). 
Automatically name unnamed tracks on media import (автоматически именовать неназванные трека при 
импортировании клипов). 
 
Секция Waveform media peak cache settings 
 
Generate peak caches (создавать пик-файл). 
Desired cache resolution (точность прорисовки сигналограммы)  
Put new peak files in peaks/subfolders relative to media (поместить новые пик-файлы в подпапку клипа).  
Store peak caches in alternate path (хранить пик-файлы в альтернативной папке), которая устанавливается 
на странице Options > Preferences > General > Path. 
Always generate spectral peak information (автоматически генерировать информацию о пиках спектра) 
Automatically rebuild peaks (автоматически перестраивать пики) 
Automatically rebuild peaks if necessary when enabling spectral peaks (автоматически перестраивать пики 
если необходимо при активировании спектрального дисплея) 
 
Секция Media item editing settings 
 
Media item volume adjustment range (диапазон громкости клипов). Доступные значения от -inf до 0 dB или -inf 
до +6 dB. 
Duplicate take FX when splitting (дублировать эффекты копии при разделении). Определяет, будут ли 
автоматически копироваться какие-либо текущие эффекты в цепочке эффектов клипа в новые клипы, которые 
создаются при разделении исходного клипа. 
 
22.8.1. Страница Options > Preferences > Media > MIDI 
 

 
 
MIDI octave name display offset (название MIDI октавы включает обозначение смещения): по умолчанию нота 
«до» средней октавы (MIDI нота #60) маркирована C4. При смещении, скажем, на значение -1 она будет 
обозначаться C3 и так далее. 
Allow trim of MIDI items when splitting (разрешить обрезку MIDI клип при разделении). При этом добавляется 
сообщение note-off для любой ноты, охваченной точкой разделения при разделении MIDI клипа. 
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Pool MIDI source data: эта опция обсуждалась и объяснялась в Главе 13. Клипы, созданные или 
импортированные как MIDI клипы REAPER (опция Create new MIDI items as MIDI items) эффективнее 
редактировать в MIDI редакторе. MIDI файлы (опция Create new MIDI items as MID files) более совместимы 
между приложениями. При необходимости можно создать новые MIDI клипы как MIDI клипы REAPER, а потом 
экспортировать их в файл.  
Ticks per quarter note for new MIDI items (сколько тиков должно приходиться на четвертную ноту для новых 
MIDI клипов). Значение по умолчанию 960, что соответствует 2 тикам на микросекунду в значении 120 bpm.  
Importing multichannel MIDI files (при импортировании мультиканального MIDI файла) со значениями Always 
prompt when importing multichannel MIDI (всегда спрашивать), As a multichannel item on a single track (в 
качестве мультиканального клипа на один трек), As a multichannel item on multiple tracks (в качестве 
мультиканального клипа на несколько треков). 
Always prompt to import tempo from MIDI files with simple tempo maps (всегда спрашивать при 
импортировании темпа из MIDI файлов с простой темпокартой). 
Snap time signature change events to whole bars when importing MIDI files (при импортировании MIDI файлов 
привязывать изменения событий музыкального размера к целому такту)  
Snap tempo change events to whole beats when importing MIDI files (при импортировании MIDI файлов 
привязывать изменения событий темпа к целым долям). 
Character set for exported .MID text events: текстовые MIDI события можно экспортировать в формат Latin-1, 
UTF-8 или ASCII (7-bit). 
 
22.8.2. Страница Options > Preferences > Media > Video/REX/Misc 
 

 
 
Опции секции Video объяснены в Главе 20. Оптимальные настройки будут зависеть в основном, от платформы, 
которую вы используете (например, Windows 7), а также от видеокарты и используемого формата. 
Опции секции REX включают: 
Import REX file contents (импортировать контент REX файлов как) со значениями Always prompt when 
importing REX items (всегда спрашивать), Seat slices that dynamically adjust to tempo changes (разложить 
на слайсы, которые динамически подходят под изменения темпа), A single loopable media item (одним 
зацикленным клипом).  
REX slice tails (хвосты REX слайсов) со значениями Preserve all slice tails (сохранять все хвосты), Chop all 
but, the final slice tail (обрезать все, кроме последнего), Chop only the final slice tail (обрезать только 
последний), Chop all slice tails (обрезать все). 
Media with embedded tempo information/When importing media: здесь вы можете определить, как будут 
обрабатываться импортированные клипы со встроенным темпом со значениями Always prompt when importing 
media with embedded tempo (всегда спрашивать), Adjust media to project tempo (подогнать темп клипа под 
темп проекта), Import media at source tempo (импортировать темп клипа в качестве источника). 
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22.9. Options > Preferences > Plug-ins 
 

 
Если активированы опции Automatically resize FX windows up/Automatically resize FX windows down, то при 
просмотре цепочки эффектов трека, окно эффектов будет изменяться автоматически под текущий выбранный 
эффект.  
Set foreground to floating windows when selected (поместить на передний план плавающее окно эффектов 
при выборе). Плавающие окна эффектов будут автоматически помещены поверх, если новые создаваемые окна 
эффектов будут автоматически определяться как плавающие (опция Auto-float newly created FX windows), и, 
если окна эффектов будут автоматически открываться для эффектов, добавленных из контекстных меню 
панели трека и панели микшера (опция Auto-open FX windows after quick-add). 
Auto-dock new FX chain windows (автоматически прикреплять новые окна эффектов на панель Docker) и Auto-
open FX add dialog when opening empty track FX chain (автоматически открывать диалоговое окно добавления 
эффектов при открытии пустой цепочки эффектов трека).  
Если активированы две опции - Auto-position new floating FX windows и Auto-position new FX chain windows, 
REAPER попытается найти оптимальную позицию для плавающих окон эффектов и/или для окон цепочек 
эффектов соответственно, а не располагать их каскадом друг на друге.  
Если отмечена опция Only allow one FX chain window open at a time (одновременно открывать только одно 
окно цепочки эффектов), можно также определить Open track FX window on track selection change 
(открывать окно эффектов трека при выборе другого трека) и/или Only if any FX window is open (только 
если открыто любое окно эффектов). 
Show current track FX in FX button right-click menu (показать текущий эффект трека в контекстном меню 
кнопки FX). Это позволяет открывать эффекты непосредственно этой кнопкой. Сколько эффектов должны быть 
перечислены в списке Recent контекстного меню определяется опцией Recently Added list max. 
Наконец, можно применить область фильтра эффектов, которая будет применена ко всем представлениям, 
использующим браузер эффектов (например, если область фильтра будет включать метку NOT sonalksis, 
плагины этой фирмы отображаться не будут). Эта область служит дополнением к любой области фильтра, 
которую вы непосредственно применяете в браузере эффектов. 
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22.9.1. Options > Preferences > Plug-ins > Compatibility 
 

 
 
Главные опции этой страницы касаются VST бриджинга и применения файерволла и могут помочь защитить 
REAPER от отказа в результате использования нестабильного плагина.  
Опция VST bridging/firewalling: Automatic bridging будет применять бриджинг, если программа посчитает это 
необходимым. Другие значения - In separate plug-in process (как отдельная обработка плагина), ln dedicated 
process per-plugin (специальная обработка на каждый плагин), Only native (disable bridging) (не применять 
бриджинг). 
 
22.9.2. Options > Preferences > Plug-ins > VST 
 

 
 
Мы уже обсуждали (в Главе 1) как определять местоположение и как активировать VST плагины. Секция VST 
Compatibility включает несколько дополнительных опций управления поведением ваших VST плагинов.  
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Можно, например, определить, как должны обрабатываться уведомления об автоматизации параметров VST 
плагинов (опция Parameter automation notifications) со значениями Ignore when window not open 
(игнорировать, если окно не открыто), Ignore when not from UI thread (игнорировать, если не с 
интерфейса), Ignore all notifications (игнорировать все уведомления), и Process all notifications 
(обрабатывать все уведомления). Другие настройки в этой категории, вероятно, будут зависеть от плагинов, 
которые вы используете. В данном контексте для отдельных плагинов просто невозможно дать сколько-нибудь 
значащих общих рекомендаций. Возможно, Вам придется поэкспериментировать в этом направлении. Справку 
об определенной опции внизу страницы можно получить, наведя на нее курсор мыши.  
Особого внимания (для пользователей MIDI) заслуживают опции Don't flush synthesizer plug-ins on stop/reset 
и Don't send note-offs or pitch reset messages on stop/reset (не посылать сообщения note-offs или pitch reset 
при остановке/сбросе). 
 
22.9.3. Options > Preferences > Plug-ins > ReWire/DX 
 

 
 
Опции секции ReWire включают:  
ReWire mixer support (act as ReWire mixer, show ReWire devices in plug-in browser (ReWire поддержка 
микшера. Функционирует в качестве ReWire микшера, отображая ReWire устройства в браузере плагинов) 
Auto-open panels when opening ReWire devices (автоматически открывать панели при открытии ReWire 
устройств) 
Run FX on stop when ReWire devices are active (запускать эффекты при остановке, когда ReWire устройства 
активны) 
Check for ReWire mixer/device on startup (and automatically enter slave mode if present) (проверить на 
наличие ReWire микшеров/устройств при запуске REAPER и если таковые будут найдены автоматически 
перевести REAPER в режим slave)  
Нажатием кнопки ReWire slave project settings открывается диалоговое окно с параметрами проекта в режиме 
Slave. 
DirectX (DX) плагины по умолчанию активированы (опция Enable DX plug-ins отмечена). Можно принудительно 
определить сканирование DX плагинов при запуске REAPER (Scan DX plug-ins on startup (not required) 
Можно также вручную отсканировать новые DX плагины нажатием кнопки Scan for new DX plug-ins. 
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22.9.4. Options > Preferences > Plug-ins > ReaScript 
 

 
 
Эта тема обсуждается в Главе 24. 
 
22.9.5. Options > Preferences > Plug-ins > ReaMote 
 

 
 
Эта тема кратко обсуждается в Главе 24. 
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22.10. Пользовательские настройки интерфейса 
 
Щелчок по кнопке Advanced UI/System tweaks на странице Options> Preferences> General открывает 
диалоговое окно с дополнительными опциями настройки интерфейса REAPER: 

 
Custom splash screen image: выберите 
BMP или PNG файл который будет 
использоваться в качестве заставки при 
запуске REAPER. 
Use large window frames (использовать 
широкие рамки окон). 
Scale UI Elements (масштабировать 
элементы интерфейса, например, кнопки 
на панелях инструментов). Это может 
быть полезно, если вы работаете с очень 
высоким разрешением экрана. 
Allow track envelope/routing windows to 
stay open: выберите эту опцию, если 
хотите, чтобы окно маршрутизации трека и 
окно огибающих не закрывались 
автоматически, когда они используют 
фокус. 
Опции секции Advanced system and 
multiprocessing tweaks помогают 
определить поведение REAPER при 
использовании с мультипроцессорными 
системами. Они считаются 
экспериментальными, поэтому 
используйте их с осторожностью. 

 
HiDPI mode (Windoes 8.1+): доступные опции - Unaware, Aware, Multi-monitor aware или DPI ignorant. 
 

22.11. Управление проектом и файлом 
 
Вы уже видели, что, при сохранении проекта REAPER доступна опция создания подпапки для этого проекта и 
опция копирования, перемещения и сохранения всех медиафайлов проекта в эту подпапку. Использование этой 
опции облегчает отслеживание вашей работы. Однако, скорее всего, вы обнаружите, что, по мере развития 
проекта, копятся такие клипы, как бракованные треки или удаленные клипы, которые больше не требуются. Эти 
лишние клипы можно легко удалить, используя опцию File > Clean Current Project Directory. 
Местоположение текущей папки проекта отображено чуть ниже строки заголовка Project Directory Cleanup.  
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При необходимости можно нажать кнопку Explore, чтобы просмотреть содержимое папки. Заметьте, однако, что 
в окне Project Directory Cleanup перечислены все файлы в директории проекта, но не принадлежащие 
текущему проекту. Чтобы выбрать любой файл, просто щелкните по его имени. Чтобы выбрать несколько 
файлов, щелкайте по файлам с нажатой клавишей Ctrl. Чтобы выбрать все файлы в списке, щелкните сначала 
по первому файлу, а затем щелкните по последнему файлу с нажатой клавишей Shift. После этого вы можете 
удалить эти файлы с жесткого диска или отослать их в корзину (Send files to recycle bin). После выбора нужной 
опции нажмите кнопку Remove Selected Files, чтобы удалить файлы. Не забывайте регулярно делать 
резервную копию проекта на внешний носитель. 
 

22.12. Настройка индикатора производительности 
 
Вы можете настроить отображение информации на индикаторе производительности, выбрав элементы из 
контекстного меню (см. рисунок ниже): 
 

 
 
CPU Graph  
CPU Use  
Disk Use 
RAM Use  
Free System RAM  
FX CPU use 
 
Список элементов можно отсортировать, щелкнув по любому заголовку столбца. Если установлен и 
активирован плагин ReaMote (см. Главу 24), индикатор производительности будет включать дополнительный 
столбец ReaMote. Индикатор производительности можно прикрепить на панель Docker. 
 

Примечание: элемент RT ("Real Time") CPU измеряет время процессора, используемого аудиопотоком, 
обслуживающим звуковое устройство. Так как он измеряет отдельный поток, отражается только 
процессорное время, используемое одним ядром, и позволяет вам отследить запас времени в 

обработке. Если у вас есть активированные эффекты (и небольшое количество активированных для записи 
треков), индикатор RT CPU обычно будет показывать довольно низкие значения, поскольку большинство 
операций будет выполняться асинхронно, позволив оперативному потоку быстро объединять эти операции. 
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22.13. Параметры окна Undo History 
 
Как уже обсуждалось (Глава 2), страница Options> Preferences> General позволяет настроить поведение окна 
истории отмен (Undo History). В частности, 
 
Добавить точки отмены для выбора клипов/треков/огибающих и/или перемещений курсора (Maximum undo 
memory use). 
Хранить историю отмен с проектами (Save undo history with project files (in RPP-UNDO file). 
Разрешить загружать истории отмен (Allow load of undo history). 
Сохранить несколько путей восстановления, если это возможно (Store multiple redo paths when possible (can 
use a lot of RAM). 
 
Эти функции можно найти на странице Options> Preferences> General> секция Undo Settings. Если отмечена 
опция Store multiple redo paths where possible, во время текущего сеанса работы, окно Undo History можно 
использовать в любое время, чтобы вернуться в предыдущую точку, а любые действия, выполненные с этой 
точки, будут сохранены в качестве дополнительных к уже сохраненным действиям.  
REAPER будет помнить оба пути независимо друг от друга. Кроме того, каждый раз, когда вы будете 
возвращаться к этому вопросу, будет создан альтернативный путь отмены. Пример продемонстрирован на 
рисунке ниже.  
 

 
 
Выделенное действие Add FX to Chain отмечено символом (*2). Это означает, что в дополнение к исходному 
набору действий, доступно еще два пути истории отмены, где мы дважды возвращались в эту точку. Щелкнув 
правой кнопкой мыши в указанном на рисунке месте, мы можем выбрать путь отмена, который мы хотим 
загрузить, позволяя нам восстановить эти опции и действия. 
Если отмечены опции Save undo history with project files и Allow load of undo history, эта история отмены 
будет все еще доступна в следующий раз, когда вы будете использовать этот проект, даже если вы с тех пор 
закрыли REAPER и выключили компьютер. 
 

22.14. Сброс настроек REAPER в фабричные параметры 
 
Настройки и конфигурацию REAPER можно сбросить из меню кнопки Пуск на Windows. 
 
1. нажмите кнопку Пуск, затем перейдите Все Программы. 
2. Щелкните по REAPER, затем по REAPER (reset configuration to factory defaults). 
 

 
 
Перед этим не лишним будет сделать резервную копию текущих настроек. 
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22.15. Некоторые другие опции REAPER 
 
Ниже перечислены элементы меню Options. Многие из них обсуждались в другом месте этого Руководства 
пользователя. Во большинстве случаев функции этих опций очевидны: 
 

Record modes (режимы записи): см. Главу 3 
Auto-crossfade media items when editing 
(применять автоматический кроссфейдинг 
клипов при редактировании). 
Trim content behind media items when 
editing (применять обрезку контента позади 
клипа при редактировании) 
Show all takes in lanes (отображать все 
копии на дорожках) 
Take lane behavior (поведение дорожек 
копий): показать или скрыть пустые дорожки 
копии. Разрешить/запретить выбор пустых 
дорожек копии. 
Show overlapping media items in lanes 
(показать совмещенные клипы на дорожках). 
Ripple editing: принимает три значения - 
отключить (off), применить к текущему треку 
(per track) или применить ко всем трекам (all 
tracks). 
Item grouping enabled (применить 
группировку треков). 
Snap/Grid (привязка/сетка): активировать 
привязку (enable snapping), показать сетку 
(show grid), открыть окно параметров 
привязки/сетки (snap/grid settings). 
Locking (блокировка); вкл/выкл и доступ к 
параметрам. 
Metronome/preroll (метроном/функция 
preroll). 
Envelope points (узлы огибающей): 
подменю опций также доступно щелчком 
правой кнопкой мыши по кнопке огибающей. 
Loop points linked to time selection (область 
лупа привязывается к выделенной области). 
Automatically scroll view during playback 
(автоматическая прокрутка окна при 
воспроизведении). 
Continuous scrolling (непрерывная 
прокрутка) - Если эта опция отмечена, 
курсор воспроизведения остается в 
середине экрана при воспроизведении и 
прокрутки клипов. 
 
Smooth seeking (сглаженный переход к 

выбранной точке). 
External Timecode Synchronisation (синхронизация с внешним временным кодом). 
Show REAPER resource path (показать папку с файлами ресурсов REAPER в проводнике). 
Customize menus/toolbars (пользовательская настройка меню/панелей инструментов). 
Themes (темы). 
Layouts (компоновки): подменю компоновок треков и микшера, в зависимости от текущей темы. 
Preferences (предварительные настройки). 
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23. Использование REAPER с другими приложениями и 
устройствами 

 
23.1. Что такое ReaRoute? 

 
ReaRoute - ASIO драйвер, который позволяет отправить аудиопоток из Reaper в любое другое подключенное 
ASIO приложение и из этого устройства обратно в Reaper. ReaRoute устанавливается на вашей системе только 
в том случае, если в процессе установки REAPER вы отметили драйвер ReaRoute ASIO. Эту опцию можно 
найти в диалоговом окне Setup страницы Additional Functionality > Choose Components (на рисунке ниже).  
 

 
 
Если вы не отметили эту опцию при последней установке REAPER, просто переустановите программу, на этот 
раз убедившись, что отметили эту опцию. При установке ReaRoute, драйвер ReaRoute ASIO появляется в 
списке ASIO драйверов для других приложений в вашей системе. 

 
Примечание: некоторые пользователи сообщают о проблемах с собственными ASIO драйверами после 
установки драйвера ReaRoute. Если вы испытываете проблемы с родными ASIO драйверами после 
установки этого драйвера, удалите REAPER, а затем переустановите его, не отмечая эту опцию. 

 
После установки ReaRoute, можно обмениваться аудиопотоками между REAPER и другими 
аудиоприложениями. Это могут быть, например, другие хосты, такие как Cubase или Ableton Live, или Sonar или 
автономный синтезатор, такой как Cakewalk Project 5. Вкратце, основные шаги таковы: 
 
- сконфигурируйте другое приложение для работы с ReaRoute. 
- либо отправьте аудиопоток из REAPER в другой хост и запишите его трек за треком в рамках этого 
приложения, - либо отправьте аудиопоток с другого хоста в REAPER, на этот раз в виде серии подмиксов. Затем 
можно применить функции REAPER к этому проекту. 
- либо используйте автономный синтезатор, например, Project 5 вместе с REAPER. 
 

23.2. Конфигурация приложений для работы с ReaRoute 
 
Прежде чем можно будет использовать любое аудиоприложение с REAPER через ReaRoute, необходимо 
правильно сконфигурировать звуковые параметры этого приложения. Обычно это занимает один или два шага. 
Во-первых, в качестве предпочтительного драйвера необходимо использовать ReaRoute ASIO, во-вторых 
необходимо сконфигурировать различные входные и выходные каналы для обмена аудиопотоками между 
приложением и REAPER. С некоторыми приложениями второй шаг не требуется. Способ конфигурации будет 
меняться в зависимости от приложения, но всегда будет задействована страница настроек аудиопараметров 
Audio Settings (или схожая с ней). В списке ниже приведены некоторые примеры. Они действительны на 
момент их описания, но возможно программы время от времени могут изменяться. 
 

Примечание: перед конфигурацией или использованием любого приложения для использования с 
ReaRoute, необходимо убедиться, что: 
- установлен драйвер ReaRoute ASIO 

             - REAPER открыт и минимизирован. 
 
Ableton Live 
 
1. Перейдите Options > Preferences > Audio. 
2. Установите опцию Driver Type в значение ASIO. 
3. Установите опцию Audio Device в ReaRoute ASIO. 
4. Нажмите Input Config, затем щелкните по каждому входному каналу, который вы хотите активировать, а 
затем нажмите OK. 
5. Нажмите Output Config, затем щелкните по каждому выходному каналу, который вы хотите активировать, а 
затем нажмите OK. 
6. Закройте окно Preferences. 
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FL Studio:  
 
1. Перейдите Options > Audio Settings.  
2. Установите опцию Output в значение ReaRoute ASIO 
3. Закройте окно Audio Settings. 
 
Project 5:  
 
1. Перейдите Options > Audio > Audio Driver Selection  
2. Установите опцию Outputs в значение ReaRoute ASIO  
3. Установите опцию ReaRoute Client в значение REAPER 1 (ASIO)  
4. Нажмите OK. 
 
Sonar:  
 
1. Перейдите Options > Audio и установите опцию Advanced Driver Mode в значение ASIO. Нажмите OK. 
2. Перейдите Options > Audio > Drivers и отключите все текущие драйверы (input и output) 
3. Перейдите Options > Audio > Advanced и установите опцию Device в значение ReaRoute ASIO (8 in, 8 out). 
Нажмите OK 
4. Перейдите Options > Audio > Drivers и активируйте все ReaRoute драйвера. Нажмите OK. 
 

Примечание для Sonar: вышеперечисленные инструкции действительны для программы Sonar версии 
8.5. Некоторые более ранние версии Sonar требуют выхода из программы и ее перезагрузки, прежде 
чем определенные изменения параметров будут применены. В виду этого вы не сможете завершить все 

вышеперечисленные шаги сразу - можно попробовать закрыть и вновь открыть программу после каждого шага, 
прежде чем перейти к следующему. 
 
Tracktion: 
 
1. Щелкните по вкладке Settings. 
2. Из меню Wave Device выберите ReaRoute ASIO. 
3. Щелкните один раз по красному лейблу disabled для каждого канала, который вы хотите использовать, 
который изменится на зеленый цвет. 
4. По окончании щелкните по вкладке Projects. 
 

23.3. Передача аудиопотока из REAPER в хост 
 
Данный пример пригодится вам, скажем, для использования одного из плагинов другого хоста на одном или 
нескольких треках. Если вы знакомы с этим хостом достаточно хорошо и уже сконфигурировали его для 
использования с ReaRoute, обратите внимание на следующие рекомендации: 
 
1. Откройте REAPER. Важно, чтобы вы открыли REAPER перед хостом. 
2. Откройте проект, который вы хотите использовать. Для каждого трека, который вы хотите использовать, 
создайте аппаратный выходной канал с маршрутизацией на каналы ReaRoute. 
3. Откройте хост (например, Sonar, Cubase, Ableton Live) и создайте в нем новый проект. 
4. Вставьте в новый проект в хосте один новый трек для каждого трека, который вы хотите передать из REAPER. 
Для каждого трека входной порт должен быть установлен эквивалентно выходному каналу в REAPER. 
Например, если в REAPER в качестве выходного канала трека вы установили ReaRoute Channel 1, то 
соответствующий новый трек в хосте должен быть установлен в Left ReaRoute ASIO ReaRoute REAPER Channel 
1. 
5. В хосте начните запись. В пределах REAPER воспроизведите песню. 
6. Остановите оба приложения по окончании песни. 
7. По окончании сначала закройте хост, а затем закройте REAPER. Необходимо всегда помнить - открывая 
первым REAPER, закрывайте его последним. 
 
В большинстве случаев легче и быстрее импортировать файлы непосредственно из Reaper в хост. Тем не 
менее есть такие ситуации, когда вместо этого выгоднее использовать ReaRoute. Например: 
 
- бывает не легко правильно расположить все треки. Некоторые могут начинаться и заканчиваться в разное 
время. Другие могут включать большое количество коротких клипов, что затруднит их импортирование по 
частям. 
- некоторые треки могут быть комбинацией MIDI клипов и аудиоклипов. Большинство приложений не позволяют 
смешивать аудио и MIDI материал на одном треке и поэтому все они перенаправляются как аудиоклипы. 
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23.4. Передача аудиопотока из хоста в REAPER 
 
Рассматривая тот же самый пример, на этот раз мы собираемся использовать ReaRoute для передачи 
открытого проекта в Sonar в REAPER. 
 
1. Откройте REAPER и создайте новый проект. Добавьте нужное количество треков. 
2. Назначьте в качестве входных портов на эти треки каналы ReaRoute по усмотрению (см. рисунок ниже). 
Активируйте эти треки для записи. 
 

 
 
3. Откройте хост. В этом хосте откройте рабочий проект и назначьте выходные каналы треков в соответствии с 
каналами ReaRoute. 
4. В хосте, добавьте на эти треки любые эффекты по усмотрению. Воспроизведите песню в хосте и настройте 
ваши эффекты. 
5. По готовности начните запись в REAPER, а затем воспроизведите песню в хосте с самого начала. 
6. По окончании остановите и воспроизведение, и запись. 
 

23.5. Использование REAPER с внешним синтезатором 
 
ReaRoute может использоваться в целях обеспечения доступа к функциональности внешнего синтезатора при 
работе с REAPER. Для успешного рассмотрения данного вопроса вы должны обладать знанием практического 
применения синтезатора. Прежде чем продолжить, убедитесь, что драйверы ReaRoute ASIO установлены и 
программа внешнего синтезатора сконфигурирована для работы с ними. 
 
1. Откройте REAPER. Откройте текущий проект, или создайте новый и вставьте трек. 
2. Активируйте этот трек для записи. Активируйте мониторинг входного сигнала и установите входной канал 
трека как стерео. Назначьте пару каналов ReaRoute (вероятно, это буду каналы 1 и 2) на этот входной канал. 
3. Откройте программу синтезатора и выполните все необходимые подготовительные шаги. 
4. Направьте выходной аудиосигнал с той же самой пары каналов ReaRoute, которые вы выбрали в шаге 2. 
5. В REAPER убедитесь, что курсор помещен в нужную позицию. Нажмите кнопку Record. 
6. Начните играть на синтезаторе, а REAPER будет записывать ваше исполнение в wav файл. 
7. По окончании сохраните вашу работу. 
 

23.6. Синхронизация с внешними устройствами 
 
При использовании REAPER с внешним устройством, необходимо убедиться, что Reaper синхронизирован с 
этим устройством, и принять его временной код, например, когда нужно, чтобы REAPER функционировал как 
подчиненное устройство по отношению к другому хосту. Чтобы синхронизировать REAPER с временным кодом 
внешнего устройства: 
 
- щелкните правой кнопкой мыши по кнопке Play на транспортной панели. 
- в меню Use input выберите входной сигнал. Доступные типы синхронизации: ASIO Positioning Protocol, MTC 
и SPP. 
 

- сконфигурируйте остальные параметры 
и закройте диалоговое окно. 
- чтобы воспроизвести REAPER в 
синхронизации с поступающим 
временным кодом, щелкните правой 
кнопкой мыши по кнопке Play на 
транспортной панели с нажатой клавишей 
Alt. Это переключаемая функция. 
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23.6.1. Типы синхронизации REAPER 
 
ASIO Positioning Protocol: создает синхронизацию с внешним устройством с сэмпловой точностью, т.е. у 
временного кода временных ячеек как у частоты дискретизации проекта. Протокол требует наличия у вашего 
аппаратного устройства драйверов ASIO 2.0. 
Linear Time Code (LTC): этот код совпадает с кодом SMPTE и основан на временных параметрах, используя 
часы: минуты: секунды: кадры. 
MIDI Time Code (MTC): это код также основан на временных параметрах, используя часы: минуты: секунды: 
кадры. По сути это простое преобразование кода SMPTE, которое передается через MIDI кабель. 
Song Position Pointer (SPP): этот способ основан на тактах, долях и подразделениях долей. Информация 
передается наряду с данными MTC кода, каждые шесть тиков. Для некоторых устройств это все, что вам будет 
нужно. 
 
Опции активирования/отключения синхронизации с внешним временным кодом и опции изменения параметров 
также доступны в контекстном меню транспортной панели REAPER и в главном меню Options. Из любого из 
этих меню можно перейти External Timecode Synchronization > Synchronization enabled или External 
Timecode Synchronization > Stynchronization settings. Обе эти опции можно назначить на действие в списке 
действий REAPER.  
 
23.6.2. Отправка данных Clock/SPP из REAPER на внешнее MIDI устройство 
 
Чтобы отправить данные Clock/SPP из REAPER на внешнее MIDI-устройство прейдите на страницу Options > 
Preferences > MIDI Devices, дважды щелкните по имени выходного MIDI устройства и в диалоговом окне 
Configure MIDI Output отметьте опцию Send clock/SPP to this device. Здесь же доступна опция Open device in 
low latency/low precision mode. 
 

 
 

23.7. Создание и отправка временного кода 
 
Опция Insert > SMPTE LTC/MTC Timecode Generator (из главного меню) может использоваться для отправки 
временного кода синхронизации REAPER на внешнее устройство. Эта опция вставляет на текущем треке клип, 
которые используются для генерации временного кода. Щелкните правой кнопкой мыши по клипу и выберите 
опцию Source properties из контекстного меню. Откроется диалоговое окно как на рисунке ниже.  

 
Выберите опцию Send audio (LTC) или Send MIDI (MTC) 
и сконфигурируйте соответствующие параметры по 
усмотрению. 
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23.8. REAPER как подчиненное устройство к программному MIDI секвенсору 
 
REAPER может функционировать как подчиненное устройство по отношению к программному MIDI секвенсору 
(такому как Temper), а также к фактическому аппаратному устройству. Так же вам понадобится программа 
виртуального MIDI соединения, например, такая достаточно популярная MIDI Yoke, пример с которой приведен 
ниже: 
 
1. Используйте MIDI Yoke для конфигурации виртуального MIDI соединения для отправки MIDI сигнала из 
другой программы в REAPER. 
2. Запустите REAPER. Перейдите Preferences > Audio > MIDI Devices. Щелкните правой кнопкой мыши по MIDI-
устройству, маркированному In from MIDI Yoke: 1 (или схоже) и выберите Enable input for control messages. 
3. Щелкните правой кнопкой мыши по кнопке Play на транспортной панели и отметьте опцию Enable 
synchronization to timecode (см. рисунок ниже). Начните воспроизведение, запись, или то и другое. 
 

 
 
Выберите нужный входной MIDI сигнал (в данном случае MTC: In from MIDI Yoke 1). Когда вы закроете это 
диалоговое окно, на кнопке Play появится маленький символ замка и всплывающая подсказка slave to 
timecode.  
 

 
 
После этого щелчок по кнопке Play будет означать, что все готово к передаче и ожидается синхронизация 
входного сигнала. 
4. Во внешней программе добавьте MIDI трек и направьте его выходной сигнал на тот же самый виртуальный 
кабель MIDI Yoke, какой вы использовали для входного сигнала в REAPER. Возможно, необходимо будет 
активировать код Send MTC (Midi Time Code) в этой программе. Ваши конкретные следующие действия в 
любой данной программе будут, конечно, зависеть от ее собственных функций, интерфейса и возможностей. 
 

23.9. Функция ReaMote 
 
ReaMote - функция удаленного управления эффектами в 
REAPER. Она позволяет создавать любую цепочку эффектов в 
проекте обрабатываемую на отдаленной машине по вашей 
локальной сети. Это полезно в том случае, если вы хотите 
добавить мощность процессора к проекту (для запуска 
различных эффектов), без необходимости апгрейда процессора 
вашего основного хоста. Для этого необходимо установить 
ReaMote, установить REAPER и плагины на подчиненных 
машинах. Для пользователей OS X можно установить ReaMote, 
когда REAPER уже установлен, перетащив значок ReaMote на 
значок папки Applications. Для пользователей Windows 

убедитесь при установке REAPER, опция ReaMote отмечена (Choose components > Additional functionality) в 
мастере установки. Запустите ReaMote в режиме slave на подчиненной машине, затем подключите ReaMote на 
странице Предварительных настроек REAPER на значение master и настройте необходимые параметры! 
Подробнее о функции ReaMote на странице wiki.cockos.com/wiki/index.php/ReaMote. 



 Специально для сайта musicmanuals.ru  511 511 

23.10. REAPER и NINJAM 
 
NINJAM - инновационная программа, которая позволяет музыкантам сотрудничать через Интернет в режиме 
"fake time". Программа соединяется с центральным сервером, где участники могут совместно использовать 
информацию, и могут записывать как локальные, так и удаленные каналы каждого "сеанса" (только аудио).  
В REAPER есть функция импортирования этих записанных файлов сеансов, позволяя вам редактировать их и 
микшировать. Режим "fake time" означает, что некоторые исполнители будут слышать задержанную версию их 
исполнения. Подробнее о программном обеспечении NINJAM или о загрузке копии на странице 
www.cockos.com/ninjam. Подробнее об использовании NINJAM с REAPER на странице 
wiki.cockos.com/wiki/index.php/NINJAM Documentation 
 

23.11. Язык сценариев ReaScript 
 
ReaScript - язык сценариев, обеспечивающий кастомизацию REAPER, выходящую далеко за пределы 
предлагаемого редактора действий. С ReaScript можно не только создавать более мощные и сложные макросы, 
но и создавать собственные дополнительные опции. Чтобы использовать ReaScript, вы должны обладать 
достаточным знанием языка сценариев, такого как EEL, Lua или Python. EEL и Lua встраиваются в REAPER. 
Python можно загрузить на странице Options > Preferences > Plug-ins > ReaScript (как на рисунке ниже).  
 

 
 
ReaScript - язык не для всех, так как он требует соответствующих навыков в программировании, а таких людей 
меньшинство. Подробнее о ReaScript можно узнать из руководства ReaScript documentation из Меню Help 
REAPER, и щелчком по опции View ReaScript Help на странице Options > Preferences > Plug-ins > ReaScript. 
Также посетите страницу http://www.cockos.com/reaper/sdk/reascript/reascript.php. На странице Options > 
Preferences > External Editors можно также выбрать внешний редактор для записи и редактирования скриптов. 
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24. Проблемы с REAPER и поиск их решений 
 
Данная глава нацелена помочь вам в разрешении проблем, с которыми иногда сталкиваются новички. 
 

24.1. Проблемы с вводом/выводом сигнала 
 

Проблема Диагностика и возможные решения 

При воспроизведении, я не слышу аудиотрек, даже 
при том, что индикатор уровня громкости трека 
активен 

Вероятнее всего, проблема либо в маршрутизации, 
либо в настройках вашей звуковой карты или в 
конфигурации внешнего аудиооборудования  
 
Маршрутизация: 
- убедитесь, что выходной сигнал трека направлен в 
мастер-трек. 
- убедитесь, что выходной сигнал с мастер-трека 
направлен на выходные порты вашей звуковой 
карты, к которой подсоединены динамики или 
наушники 
 
Настройки звуковой карты: 
Используя программное обеспечение вашей 
звуковой карты убедитесь, что: 
 
- выходной сигнал на мьютирован, или громкость 
находится на достаточном уровне. 
- выходной сигнал не направлен в другие выходные 
порты внешнего устройства. 
 
Настройка внешнего оборудования: 
- убедитесь, что усилитель подключен к тем же 
самым выходным портам звуковой карты, куда 
приходит выходной сигнал с мастер-трека.  
- убедитесь, что все работает (подключено) и 
выставите соответствующий уровень громкости.  
- используя Диспетчер устройств Windows 
убедитесь, что устройство активировано и 
функционирует правильно 
 
Совет: чтобы помочь вам определить где именно у 
вас неисправность, можно попробовать открыть и 
воспроизвести любой wave файл в другом 
аудиоприложении. 
 

  

Я получаю сообщение об ошибке, что MIDI-
устройство не может быть открыто 

Устройство может быть не подключено или может 
использоваться другой программой. 
  
- проверьте, что устройство подключено и включено.  
- проверьте, не используется ли другой программой 
это же самое MIDI-устройство.  
- проверьте, не открыт ли случайно REAPER 
дважды. 

При воспроизведении, я не слышу аудиотрек и не 
реагируют индикаторы уровня громкости трека 

Вероятнее всего, проблема будет определенно 
связана с этим треком или клипом, особенно если у 
вас другие проекты воспроизводятся корректно.  
 
- убедитесь, что трек не мьютирован.  
- убедитесь, что клип не мьютирован (щелкните 
правой кнопкой мыши по клипу и выберите опцию 
Item Properties – Свойства клипа).  
- в окне эффектов трека убедитесь, что нет никаких 
эффектов, которые могут мьютировать трек.  
- проверьте не установлен ли фейдер громкости 
трека в слишком низкое значение 

При воспроизведении, я не слышу некоторые или 
все эффекты трека 

Проблема может скрываться в Окне эффектов трека 
или в собственном окне плагина, или та и там. 
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- убедитесь, что окно эффектов трека не 
установлено в режим обхода.  
- убедитесь, что отдельные эффекты не 
установлены в режим обхода. Это может 
встретиться в окне цепочки эффектов или в 
собственном окне некоторых плагинов. 
- проверьте параметры Wet/Dry плагина (где 
таковые есть) - не выбрано ли значение 100% Dry. 

При воспроизведении, я слышу щелчки, выпадение 
отчетов, заикание или выпадение сигнала 

Вероятнее всего, это означает, что вы пытаетесь 
воспроизвести этот проект при очень низком для 
вашей системы значении задержки. Скорее всего это 
является следствием использования большого 
количества ресурсоемких эффектов, таких как 
Ревербератор. Попробуйте следующее:  
 
- посмотрите, можно ли перестроить микс так, чтобы 
использовать меньше ресурсоемких плагинов, 
например, применив больше шин эффектов для 
совместного использования эффектов на нескольких 
треках.  
- если вы используете высокие значения частоты 
дискретизации, например, 88200 или 176400, 
попробуйте снизить это значение, например, до 
44100.  
Это уменьшит нагрузку на процессор, и вы, скорее 
всего не почувствуете разницу в качестве звука.  
- рассмотрите увеличение размера буфера. Это 
увеличит задержку, но она не должна стать 
проблемой при воспроизведении. Перейдите на 
страницу Options > Preferences> Audio Device и 
нажмите кнопку ASIO Configuration для доступа к 
программным настройкам вашей звуковой карты. 
Увеличьте размер буфера, возможно до 1280 
samples. - Проверьте настройки на странице Audio 
Buffering предварительных настроек, особенно 
параметры FX processing/multiprocessing.  
- будьте готовы поэкспериментировать с 
параметрами Render ahead size и с 
соответствующими опциями 

При воспроизведении, клиппируется мастер-трек и 
появляются искажения, при том, что уровень 
громкости трека довольно низкий 

Это может возникнуть в результате проблем 
маршрутизации, например, когда трек или треки 
направленны в мастер-трек несколькими 
различными маршрутами одновременно.  
 
- проверьте матрицу маршрутизации 

При воспроизведении, аудиосигнал звучит 
клиппированным, при том, что само клиппирование 
нигде не отображается 

Это могло быть вызвано проблемой маршрутизации, 
или некоторыми эффектами или комбинацией 
эффектов, которые могли бы искажать звук.  
- проверьте матрицу маршрутизации, и убедитесь, 
что трек или треки на направлены непосредственно 
на тот же самый выходной аппаратный аудиопорт, 
что и мастер-трек. Если это не причина проблемы, 
отключите все эффекты, а потом активируйте их по 
одному - так вы сможете выявить проблемным 
плагин 

Когда я пытаюсь воспроизвести импортированный 
MIDI трек, звук не слышен 

Это может быть вызвано проблемой с 
маршрутизацией, звуковой картой или неправильной 
конфигурацией. Кроме того, это может быть вызвано 
специфической проблемой с MIDI. Это встречается, 
когда трек назначен на неправильное выходное MIDI 
устройство или программный синтезатор.  
 
- при использовании аппаратного MIDI устройства, 
откройте окно маршрутизации трека и убедитесь, что 
трек назначен на это MIDI устройство.  
- если вы не используете аппаратное MIDI 
устройство, откройте окно эффектов трека и 
вставьте программный синтезатор по усмотрению 
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Когда я пытаюсь сделать запись аудио, ничего не 
записывается 

Проблема здесь может быть связана либо с 
настройками REAPER, либо с конфигурацией 
внешнего устройства.  
 
- убедитесь, что трек активирован для записи.  
- убедитесь, что трек назначен на правильный 
входной порт, который доступен и активирован на 
странице Options > Preferences > Audio Device.  
- убедитесь, что в меню Options выбран правильный 
режим записи (обычно, это Normal).  
- убедитесь, что активирована опция Record Input.  
- или, если вы выбрали опцию Record Output, 
проверьте окно эффектов и убедитесь, что нет 
эффектов, которые могли бы мьютировать выходной 
сигнал трека. 
- убедитесь, что микрофон или инструмент, 
предназначенные для записи, подсоединены к 
правильному входному аудиопорту.  
- если микрофон требует фантомного питания, 
убедитесь, что оно включено.  
- проверьте микшер (внешний микшер, микшер 
звуковой карты, или то и другое) и убедитесь, что 
входной сигнал направлен правильно и не 
мьютирован 

У меня не хватает мощности процессора для 
воспроизведения моего проекта 

Почти наверняка это вызвано тем, что вы пытаетесь 
использовать больше эффектов, чем может 
обработать ваш хост.  
 
- используйте Индикатор производительности, чтобы 
определить, на каких треках используются наиболее 
ресурсоемкие эффекты. Затем щелкните правой 
кнопкой по клипам этих треков и либо выберите 
опцию Apply FX to items as new take, либо Apply FX 
to items as new take (Mono). 

 
24.2. Проблемы с интерфейсом REAPER 

 
Проблема Диагностика и возможные решения 

Когда я нажимаю Пробел (или другой транспортный 
контроллер), ничто не происходит 

Это происходит, когда фокус настроен на другое 
окно, такое как матрица маршрутизации или 
открытое диалоговое окно. Возможны два решения: 
 
- сфокусируйте другое представление, например, 
представление треков или микшер прежде, чем 
нажать клавишу, или используйте внешнее MIDI 
устройство, такое как BCR2000 и назначьте 
транспортные функции на его кнопки. После этого 
кнопки внешнего устройства будут функционировать 
независимо от фокуса любого представления или 
окна 

Когда я пытаюсь поместить курсор редактирования в 
точную намеченную мной позицию, он немного 
смещается 

Может быть активирована привязка. Если так, в 
меню Options отключите опцию Enable Snapping 

Когда я пытаюсь выделить область, границы области 
смещаются от намеченных позиций 

Может быть активирована привязка. Если так, в 
меню Options отключите опцию Enable Snapping 

Я добавляю к треку огибающую громкости или 
панорамы, но при воспроизведении 
соответствующий фейдер не перемещается 

Убедитесь, что выбран режим автоматизации Read и 
огибающая активирована для записи. 

Я записываю несколько копий на треке, но 
отображается только последняя 

Чтобы отобразить все копии трека, в меню Options 
отметьте опцию Show All Takes in Lanes или чтобы 
отобразить другую копию, кроме последней, 
щелкните правой кнопкой по клипу и выберите 
опцию Take из контекстного меню 

Когда я максимизирую трек, отображается не тот 
трек 

Проверьте настройки Vertical Zoom Behavior на 
странице Options > Preferences > Editing Behavior. 
Вероятно, необходимо выбрать значение Last 
Selected Track 
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Когда я увеличиваю масштаб по горизонтали, курсор 
редактирования исчезает из представления, и я 
теряю местоположение 
 

Проверьте настройки Horizontal Zoom Behavior на 
странице Options > Preferences > Editing Behavior. 
Вероятно, необходимо выбрать значение Edit Cursor 
or Play Cursor 

Я пытаюсь открыть окно, например, Big Clock или 
Performance Meter, но оно не появляется на экране 

Иногда это может происходить из-за изменений, 
внесенных в настройки дисплея Windows.  
Есть два основных способа это устранить. 
Используйте Блокнот Windows, чтобы 
отредактировать файл reaper.ini в папке 
C:\Documents and Settings\User Name\Applications 
Data\REAPER. Это должно быть предпринято только 
в том случае, если вы уверены в своих действиях. 
Например, если потеряно окно Big Clock, удалите 
только эту секцию файла reaper.ini, сохраните его, 
закройте его, а затем перезапустите REAPER. 
Например, на рисунке файл reaper.ini, с удаленной 
секцией Big Clock отображается курсивом: 
 
[flac encoder defaults] 
default_size=12 
default=63616C661000000005000000AB 
[bigclock] 
wnd_vis=1 
wnd_left=967 
wnd_top=600 
wnd_width=426 
wnd_height=137 
time_mode=0 
[namecache] 
Analog_In_1_Delta_1010__1_=In 1 
 
Более безопасно - просто переименовать этот файл, 
например, в reaper.old. Это возвратит все 
предварительные настройки и опции в их исходное 
состояние по умолчанию при следующем запуске 
REAPER 

Окно Undo History приводится в беспорядок с 
выбором каждого клипа и трека 

Перейдите Options > Preferences > General и 
отключите опцию Create Undo points for item/track 
selection 

 
24.3. Проблемы с режимами записи и мониторингом 

 
По началу может быть затруднительно понять, как различные режимы записи REAPER (доступные в меню 
Options) и опции мониторинга (в контекстном меню кнопки arm record трека) могут использоваться вместе для 
получения различных результатов. Таблицей ниже я обязан Джону Беркику (John Bercik) за предоставленный 
мне материал: 
 

Режим записи Опции мониторинга Поведение 

Record Mode: Normal 
 

Monitor input активирована/Monitor 
track media when recording 
отключена 

При остановке: мониторинг 
только входящего сигнала 
При воспроизведении: 
непрерывный мониторинг 
текущего и входящего сигнала 
При записи: мониторинг только 
входящего сигнала 

Monitor input (Tape Auto Style) 
активирована/Monitor track media 
when recording отключена 

При остановке: мониторинг 
входящего сигнала 
При воспроизведении: 
мониторинг только текущего 
сигнала 
При записи: мониторинг текущего 
и входящего сигнала 

Monitor input активирована/Monitor 
track media when recording 
активирована 

При остановке: мониторинг 
входящего сигнала 
При воспроизведении: 
непрерывный мониторинг 
текущего и входящего сигнала 
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При записи: мониторинг текущего 
и входящего сигналов вне 
автозаписи, только входящего 
сигнала в пределах автозаписи 

Monitor input (Tape Auto Style) 
активирована/Monitor track media 
when recording активирована 

При остановке: мониторинг 
входящего сигнала 
При воспроизведении: 
мониторинг текущего сигнала, 
затем только входящего сигнала в 
пределах автозаписи 
При записи: мониторинг текущего 
сигнала, затем только входящего 
сигнала в пределах автозаписи 

Record Mode: Time Selection Auto 
Punch 

Monitor input активирована/Monitor 
track media when recording 
отключена 

При остановке: мониторинг 
входящего сигнала 
При воспроизведении: 
непрерывный мониторинг 
текущего и входящего сигнала 
При записи: мониторинг текущего 
и входящего сигналов вне 
автозаписи, затем только 
входящего сигнала в пределах 
автозаписи 

Monitor input (Tape Auto Style) 
активирована/Monitor track media 
when recording отключена 

При остановке: мониторинг 
входящего сигнала 
При воспроизведении: 
мониторинг только текущего 
сигнала 
При записи: мониторинг только 
текущего сигнала вне автозаписи, 
затем только входящего сигнала в 
пределах автозаписи 

Monitor input активирована/Monitor 
track media when recording 
активирована 

При остановке: мониторинг 
входящего сигнала 
При воспроизведении: 
непрерывный мониторинг 
текущего и входящего сигнала 
При записи: мониторинг текущего 
и входящего сигналов в пределах 
автозаписи и вне ее 

Monitor input (Tape Auto Style) 
активирована/Monitor track media 
when recording активирована 

При остановке: мониторинг 
входящего сигнала 
При воспроизведении: 
мониторинг только текущего 
сигнала 
При записи: мониторинг текущего 
сигнала вне автозаписи, затем 
текущего и входящего сигналов в 
пределах автозаписи 

Record Mode: Auto Punch Selected 
Items 

Monitor input активирована/Monitor 
track media when recording 
отключена 
 

При остановке: мониторинг 
входящего сигнала 
При воспроизведении: 
непрерывный мониторинг 
текущего и входящего сигнала 
При записи: мониторинг текущего 
и входящего сигналов вне 
автозаписи, затем запись и 
мониторинг входящего сигнала в 
выбранных клипах 

Monitor input (Tape Auto Style) 
активирована/Monitor track media 
when recording отключена 

При остановке: мониторинг 
входящего сигнала 
При воспроизведении: 
мониторинг только текущего 
сигнала 
При записи: мониторинг только 
текущего сигнала вне автозаписи, 
затем запись и мониторинг 
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входящего сигнала в выбранных 
клипах 

Monitor input активирована/Monitor 
track media when recording 
активирована 

При остановке: мониторинг 
входящего сигнала 
При воспроизведении: 
непрерывный мониторинг 
текущего и входящего сигнала 
При записи: мониторинг текущего 
и входящего сигналов вне 
автозаписи, затем запись и 
мониторинг входящего сигнала в 
выбранных клипах 

Monitor input (Tape Auto Style) 
активирована/Monitor track media 
when recording активирована 

При остановке: мониторинг 
входящего сигнала 
При воспроизведении: 
мониторинг только текущего 
сигнала, затем только входящего 
сигнала в пределах автозаписи 
При записи: мониторинг текущего 
выбранного клипа (клипов), затем 
запись и мониторинг входящего 
сигнала в выбранных клипах 
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25. Основные контекстные меню REAPER 
 
Вы уже видели, насколько важны контекстные меню в REAPER. Доступ к контекстным меню осуществляется 
щелчком правой кнопкой мыши в определенном месте. Конкретное меню будет зависеть от точного места, где 
расположен курсор мыши во время щелчка правой кнопкой мыши. Большинство этих контекстных меню были 
уже объяснены в предыдущих главах. Здесь же мы рассмотрим только основные. 
 

25.1. Контекстное меню панели трека 
 
Доступ к этому меню можно получить щелчком правой кнопкой мыши по имени трека или его номеру, или в 
любом свободном от контроллеров месте панели трека. 

 
Insert new track (вставить новый трек после 
текущего выбранного трека). 
Insert new track at end of track list (вставить 
новый трек после последнего трека в проекте). 
Insert virtual instrument on new track (вставить 
новый трек с открытым окном выбора vst 
инструмента для этого трека). 
Insert track from template (вставить новый трек, 
основанный на текущем шаблоне). 
Save tracks as track template (сохранить 
выделенные треки в качестве шаблона трека). 
Remove tracks (удалить выбранные треки). 
Duplicate tracks (дублировать выбранные треки 
и расположить их ниже). 
Render/freeze tracks (рендеринг/freeze треков) - 
включает подменю с опциями stem рендеринга. 
MIDI track controls (контроллеры MIDI трека) - 
включает подменю со следующими опциями: 
 
- Show MIDI track control panel (показать панель 
управления MIDI трека) 
- Link track volume/pan to all MIDI channels 
(привязать громкость/панораму трека ко всем 
каналам трека) 
- Link track volume/pan to [specified] MIDI 
channel (привязать громкость/панораму трека к 
выбранному каналу трека) 
Do not link track volume/pan to MIDI (не 
привязывать громкость/панораму трека к MIDI) 
Lock track controls (заблокировать контроллеры 
трека)  
Enable track free item positioning (активировать 
режим свободного расположения клипов). 
Automatic record-arm when track selected (при 
выборе трека автоматически активировать его 
для записи). 
 
Multichannel track metering: если трек включает 

более 2-х каналов отобразить их на индикаторе трека. 
Track Manager (show/hide tracks) (открыть окно менеджера треков). 
Track color (выбрать цвет для трека). 
Track icon (выбрать иконку для трека). 
Set track timebase (установить представление времени для трека). 
Set track automation mode (выбрать режим автоматизации для трека). 
Track performance options (опции производительности трека). 
Set track layout (выбрать компоновку треков). 
Envelopes: открывает подменю с опциями управления огибающими. 
Track grouping parameters: открывает окно с опциями группировки треков. 
Track grouping enabled (активировать группировку треков). 
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25.2. Контекстное меню пустой области списка треков 
 
Доступ к этому меню можно получить щелчком правой кнопкой мыши по пустой области ниже списка треков в 
Области треков. 
 

Insert new track (вставить новый трек ниже текущего 
выбранного трека). 
Insert multiple tracks (вставить несколько треков 
сразу). 
Insert virtual instrument on new track (вставить 
новый трек для VST инструмента наряду с 
несколькими выходными портами при 
необходимости). 

Insert track from template (вставить новый трек на основе выбранного шаблона). 
Show master track (показать мастер трек). 
 

25.3. Контекстное меню шкалы времени и линейки 
 
Доступ к этому меню можно получить щелчком правой кнопкой мыши по любой из следующих областей: 
 
- по линейке или шкале времени выше первого трека. 
- по пустой области выше линейки. 
- по пустой фоновой области представления треков. 
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Remove selection (снять выделение с области). При этом сами клипы не удаляются. 
Zoom selection (масштабировать выделенную область). 
Set selection to items (выделить область, которая соответствует области, охватывающей выбранные клипы). 
Extend selection to next transient in items (расширить выделенную область до следующего трензиента в 
клипе). 
Insert marker (вставить маркер). При этом открывается диалоговое окно добавления маркера в текущей 
позиции курсора. 
Create region from selection (создать регион из выделенной области). 
Insert tempo/time signature marker (вставить маркер темпа/музыкального размера в текущей позиции курсора). 
Remove all markers from time selection (удалить все маркеры из выделенной области). 
Set project tempo from time selection (установить темп проекта, основываясь на темпе выделенной области). 
Create measure from time selection (создать такт с размером выделенной области). 
Crop project to selection (обрезать проект до границ выделенной области). 
Insert empty space in selection (вставить пустое место, равное выделенной области во все треки в текущем 
проекте). 
Remove contents of selection (moving later items) (удалить текущую выбранную область с ее контентом и 
объединить последующие за ней клипы, без промежутка независимо от того, был ли активирован режим ripple 
editing). 
Paste (вставить ранее вырезанный или скопированный клип в текущий трек в текущую позицию курсора). 
Split items at cursor (разделить выбранный клип (ы) в текущей позиции курсора). Если нет выделенных 
клипов, разделены будут все клипы. 
Split items at time selection (разделить текущий выбранный клип (ы) по границам выделенной области). Если 
нет выделенных клипов, разделены будут все клипы. 
Select All (выделить все клипы). 
Copy selected area of items (скопировать выделенную область вместе с ее контентом в буфер обмена). 
Copy loop of selected area of items (скопировать выделенную область как луп). 
Minutes:Seconds.Measures.Beats/Minutes:Seconds.Measures.Beats.Measures.Beats (minimal).Measures.Beats 
(minimal)/Minutes:Seconds.Seconds.Samples.Hours:Minutes:Seconds:Frames.Frames. Эти шесть опций 
взаимозаменяемы. Выберите любую, чтобы установить единицу измерения, используемую для линейки. 
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25.4. Контекстное меню клипа 
 
Доступ к этому меню можно получить щелчком правой кнопкой мыши по любому клипу. Если выбрано несколько 
клипов, опция, выбранная из этого меню, будет применена ко всем этим клипам. 
 

 
 
Item settings: открывает одноименное подменю. 
Item properties: открывает диалоговое окно свойств клипа. 
Source properties: открывает диалоговое окно свойств источника клипа. 
Group: открывает одноименное подменю с опциями группировки/разгруппировки выбранных клипов. 
Take: открывает одноименное подменю с опциями управления копиями. 
Comps: открывает одноименное подменю с опциями управления компиляциями. 
Item and take colors: открывает подменю с опциями управления цветом. 
Item processing: открывает одноименное подменю с опциями обработки клипа. 
Stretch markers: позволяет добавить/привязать или удалить stretch маркеры. 
Open items in editor: открывает подменю с опциями открытия выбранного клипа/клипов (или их копий) в 
редакторе, выбранном на странице Options > Preferences > External Editors. 
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Open in built in MIDI editor (открыть выбранный MIDI клип в MIDI редакторе REAPER” с несколькими опциями). 
Apply track FX to items as new take (применить эффекты трека к клипам в качестве новых копий)/Apply track 
FX to items as new take (mono output) (применить эффекты трека к клипам в качестве новых копий с 
моновыходом)/Apply track FX to items as new take (multichannel output) (применить эффекты трека к клипам в 
качестве новых копий с мультиканальным выходом)/ Apply track FX to items as new take (MIDI Output) 
(применить эффекты трека к клипам в качестве новых копий с MIDI выходом). 
Render items as new take (сконвертировать выбранные клипы с эффектами в новые копии). 
Reverse items as new take (изменить выбранные клипы или клипы на новые копии). 
Glue items/Glue items within time selection (склеить выбранные клипы в один новый клип). 
Move items to new subproject (переместить выбранные клипы в новый подпроект). 
Copy items (скопировать клипы)/Copy selected area of items (скопировать выбранные клипы в качестве 
выделенной области)/Copy loop of selected area of items (скопировать выделенные клипы в качестве области 
лупа). 
Cut items (вырезать клипы)/Cut selected area of items (вырезать клипы в качестве выделенной области). 
Paste (вставить содержимое буфера обмена в текущий выбранный трек в текущей позиции курсора). 
Remove items (удалить выбранные клипы из проекта). 
Trim items to selected area (обрезать клип до границ текущей выделенной области). 
Nudge/set items (открывает одноименное диалоговое окно). 
Split items at cursor (разделить текущий выбранный клипы в текущей позиции курсора) 
Split items at prior zero crossing (разделить текущий выбранный клип в последней нулевой точке пересечений 
перед текущей позицией курсора). 
Split items at time selection (разделить текущий выбранный клип по границам выделенной области на шкале 
времени). 
Heal splits in items (удалить разделения и объединения клипов). 
 

25.5. Подменю контекстного меню клипов 
 
Несколько опций контекстного меню клипа включают важные подменю, такие как Item settings, Take, Comp, 
Item and take colors и Item processing. 
 
23.5.1. Опции подменю Item settings 
 

Mute (мьютировать)/Loop item source (зациклить 
источник клипа)/Play all takes (воспроизвести все 
копии)/Lock item (заблокировать клип). Эти опции 
можно также изменить в диалоговом окне Item 
Properties. Доступны также значки, которые могут 
использоваться для блокировки или мьютирования 
клипа. 
Item notes: открывает одноименное окно для внесения 
текстовых заметок о клипе. 
Invert phase (инвертировать фазу клипа). 
Loop section of item source (зациклить область с 
выбранными клипами). 
Preserve pitch when changing playrate (при 
изменении скорости воспроизведения сохранять 
высоту тона клипа). 
Reverse active take (реверсировать текущую 
активную копию). 
Take channel modes (выбрать канальный режим 
копии). Доступно несколько взаимозаменяющих опций 
- Normal, Reverse stereo, Mono (downmix), Mono 
(left), Mono(right). Можно также выбрать вашу 
собственную моно или стереопару копии. Значение по 
умолчанию - Normal. 
Set item timebase (установить представление 
времени клипа). Доступны четыре 
взаимозаменяющиеся опции: Project/track (по 
умолчанию), Time, Beats (position, length, rate) или 
Beats (position only). 
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25.5.2. Опции подменю Item colors and Take colors  
 

Set items to (выбрать цвет для клипа) - значения: 
Custom Color (пользовательский цвет), Random Color 
(случайный цвет), One Random Color (один случайный 
цвет) или Default Color (цвет по умолчанию). 
Set active takes to (выбрать цвет для активной копии) 
значения: Custom Color (пользовательский цвет), 
Random Color (случайный цвет), One Random Color 
(один случайный цвет) или Default Color (цвет по 
умолчанию). 
 
 
 
 

 
25.5.3. Опции подменю Take 

 
Next take (перейти к следующей копии)/Previous take 
(перейти к предыдущей копии). 
Delete active take (удалить активную копию). 
Crop to active take (удалить все копии, кроме 
текущей активной). 
Duplicate active take (дублировать текущую 
активную копию). 
Lock to active take (блокировать текущую активную 
копию). 
Show FX chain for active take (открыть окно цепочки 
эффектов текущей активной копии). 
Remove FX for active take (удалить все эффекты из 
цепочки текущей активной копии). 
Take envelopes: открывает окно огибающих для 
копии, где можно добавить огибающие 
автоматизации к параметрам копии. 
Explode all takes to new tracks (разложить все копии 
на новые треки)/Explode all takes (in place) 
(разложить все копии на текущем треке)/Explode all 
takes (разложить все копии по порядку). 
Implode items across tracks into takes/Implode 
items on same track into takes (создать один трек с 
копией для каждого выбранного клипа, где клип 
выбраны на нескольких треках, или создать один 
трек с копией для каждого выбранного клипа, где все 
клип выбраны на том же самом треке). 
Paste to takes in items (вставить к копиям в 
выбранных клипах). 
Take lane 1, Take lane 2, и т.д. (активировать 
выбранную копию). 
 
 

25.5.4. Опции подменю Comps 
 
Save as new comp (сохранить выбранные копии в качестве новой 
компиляции). 
Remove active comp from list (удалить текущую компиляцию из 
подменю Comp). 
Crop list to active comp (удалить из подменю все компиляции кроме 
текущей). 
Move active comp to top lane (переместить выбранные копии активной 
компиляции наверх дорожки клипа). 

Saved comp names: там, где компиляции именованы, они перечислены и могут быть активированы выбором их 
из меню Comps). 
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25.5.5. Опции подменю Item processing 
 

 
 
Normalize items (нормализовать все выбранные клипы, независимо друг от друга). 
Normalize items (common gain) (нормализовать по мере возможности все выбранные клипы с одним и тем же 
коэффициентом усиления). 
Dynamic split items: открывает одноименное диалоговое окно с опциями динамического разделения. 
Quantize item positions to grid (выровнять позиции выбранных клипов к параметрам сетки). 
Move items to source preferred position (переместить клипы в их оригинальную позицию). 
Implode items across tracks into items on one track (собрать выбранные клипы в один трек). 
Auto-reposition items in free positioning mode (установить статус выбранных клипов в режим свободного 
позиционирования). 
Explode multichannel audio or MIDI items to new one channel items: если клип мультиканальный, эта опция 
создает дополнительный новый монотрек для каждого используемого канала. Если это будет MIDI клип, он 
будет разложен на MIDI каналы. 
Explode MIDI items by note row (pitch) (разложить MIDI клипы по нотам вместо каналов). 
Convert active take MIDI to in-project event (конвертировать активную MIDI копию в событие проекта). 
Convert active take MIDI to file (ghost copyable) (конвертировать активную MIDI копию в файл). 
Import media cues as project markers (конвертировать текущие метки в импортированном клипе в маркеры 
REAPER). 
Propagate take/items to similarly named active takes/items on tracks (скопировать свойства и функции клипа 
(такие как эффекты, фейдинги, огибающие) в другие схожие копии клипа на треке). 
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25.6. Контекстное меню кнопки Record Arm 
 

Доступ к этому меню можно получить щелчком 
правой кнопкой мыши по кнопке Record Arm или 
индикатору уровня громкости любого трека. 
 
Monitor Input (активировать мониторинг входного 
сигнала)/Monitor Input (Tape Auto Style) (см. 
Параграф 3.14)/Monitor track media when recording 
(активировать мониторинг при записи)/Preserve 
PDC delayed monitoring in recorded items (см. 
Параграф 3.27): первые две из этих опций 
взаимозаменяющиеся. Если функция мониторинга 
входного сигнала поддерживается вашей 
аудиокартой, необходимости в выборе любой из 
этих двух первых опций нет. 
Record: input (audio or MIDI): в большинстве 
случаев, для типичной записи аудиопотока вы 
будете использовать опцию Record: input. 
Record: MIDI overdub/replace: открывает подменю с 
опциями режимов записи MIDI - MIDI overdub, MIDI 
replace, MIDI touch-replace и MIDI latch-replace. 
 
 
Record: output: открывает подменю с опциями 
записи выходного сигнала - multichannel latency 

compensated, multichannel, stereo latency compensated, stereo, mono latency compensated, mono или MIDI. 
Record input (force format): открывает подменю с опциями принудительной записи входного сигнала - force 
mono, force stereo, force multichannel и force MIDI. 
Record: disable (input monitoring only) (активировать только мониторинг входного сигнала без записи). 
Input: Mono: открывает подменю с опциями выбора входного монопорта вашей звуковой карты. 
Input: Stereo: открывает подменю с опциями выбора входного стереопорта вашей звуковой карты. 
Input: 8 channel: позволяет установить до 8 входных каналов в зависимости от возможностей вашего 
аудиоустройства. 
Input: MIDI: открывает подменю с опциями выбора MIDI-устройства и каналов 
Input: None (отключить запись входного сигнала). 
Automatic record-arm when selected (автоматически активировать трек для записи при его выборе). 
Track recording settings: открывает одноименное диалоговое окно с опциями выбора формата записи и/или 
параметров квантизации для выбранного трека. 
Track input FX chain: открывает браузер эффектов для выбора эффекта, который будет использоваться при 
записи входного сигнала. 
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25.7. Контекстное меню огибающих 
 
Доступ к этому меню можно получить щелчком правой кнопкой мыши по любому текущему узлу огибающей. 
Щелчок правой кнопкой мыши по самой огибающей, а не по узлу открывает схожее меню, но вместо опций 
редактирования узлов, таких как Set point value и Set point shape, вы найдете опцию Create new point 
(создать новый узел).  
 

Envelope defaults: для каждого типа огибающей, 
устанавливает форму по умолчанию. 
Create new point (создать новый узел в текущей 
позиции курсора). 
Set point value: открывает диалоговое окно с 
опциями определения различных значение 
отдельного узла, и, при необходимости позиции и 
формы. 
Set point shape: позволяет задать любую из шести 
доступных форм для текущего узла. 
Set shape for selected points (выбрать форму для 
всех выбранных узлов). 
Select all points (выделить все узлы огибающей). 
Unselect all points (отменить выбор всех узлов 
огибающей). 
Select all points in time selection (выбрать все 
узлы огибающей в пределах выделенной области). 
Copy points (копировать текущие выбранные узлы 
в буфер обмена). 
Cut points (вырезать текущие выбранные узлы 
огибающей в буфер обмена). Горячая клавиша 
Ctrl+V используется для вставки скопированных 
или вырезанных узлов в позиции курсора. 
Delete point (удалить узел огибающей). 
Delete selected points (удалить все текущие 
выбранные узлы огибающей). 
Delete points in time selection (удалить все узлы 
текущей огибающей в пределах выделенной 
области). 
Invert selected points (инвертировать текущие 
выбранные узлы огибающей). 
Reset points to zero/center (сбросить текущие 
выбранные узлы огибающей в “нейтральные” 

значения). 
Reduce number of points: открывает диалоговое окно Reduce Points, с опциями сокращения количества узлов 
либо в огибающей в целом, либо только в выделенной области. 
Arm envelope for recording (активировать огибающую для записи, например, чтобы записать изменения 
автоматизации). 
Show envelope in lane (показать огибающую на ее собственной дорожке). 
Hide envelope (скрыть огибающую, сохраняя его активированной). Скрытые огибающие можно восстановить, 
используя окно огибающих. 
Bypass envelope (установить статус обхода огибающей). 
Clear or remove envelope (удалить все узлы текущей огибающей). Тут же последует запрос на удаление 
самой огибающей. 
 
Щелчок правой кнопкой мыши по фоновой области любой дорожки огибающей на панели трека откроет 
контекстное меню с тремя наборами опций: 
 
 
Existing available envelopes: используется для изменения огибающей на данной дорожке. 
Envelope management: опции отображения/скрытия, активирования для записи всех огибающих на данном 
треке, или опции перемещения всех видимых огибающих на дорожки или за их пределы. 
Automation mode: режим автоматизации для данного трека. 
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25.8. Контекстное меню транспортной панели 
 
Доступ к этому меню можно получить щелчком правой кнопкой мыши на транспортной панели. Более узко 
специфические меню доступны щелчком правой кнопкой мыши по элементам транспортной панели. Например, 
щелчок правой кнопкой мыши на кнопке Record открывает меню с тремя опциями выбора режима записи. 
Щелчок правой кнопкой мыши на фейдере Playrate открывает одноименное подменю. 
 

Jump to marker: открывает вспомогательное 
меню маркеров. Чтобы перейти к маркеру 
щелкните по нему в списке. 
Playrate: открывает подменю с опциями 
настройки скорости воспроизведения (с 
сохранением высоты тона и без сохранения) и 
установки диапазона фейдера Playrate. 
Transport: открывает подменю с опциями, 
эквивалентными кнопкам транспортной панели. 
External timecode Synchronization: 
используется для синхронизации временного 
кода REAPER с внешним устройством. 
Automatically scroll view during playback 
(автоматически прокручивать окно, следуя за 
курсором при воспроизведении). 
Continuous scrolling (активировать 
непрерывную прокрутку). 
Smooth seeking (seeks at end of measure): 
если эта опция отмечена, при нажатии кнопок 
Stop/Pause на транспортной панели курсор 
воспроизведения будет перемещен в конец 
такта. 
Chase MIDI note-ons in project playback: если 
эта опция отмечена, события будут 
обрабатываться перед воспроизведением 
Stop playback at end of loop if repeat playback 
is disabled (останавливать воспроизведение в 
конце области лупа если функция Repeat на 
транспортной панели отключена). 
Record mode: normal / Record mode: time 
selection auto punch / Record mode: auto-punch 
selected items: выбор режима записи, которые 
подробно объяснялись в Главе 3. Эти опции 
взаимозаменяющиеся. 
Use ruler time unit: гарантирует, что единица 
измерения времени, выбранная для линейки, 
также будет использоваться на транспортной 
панели. Альтернативно, можно выбрать одну из 
опций, описанных ниже. 
Minutes: Seconds/ Measures.Beats/Minutes: 
Seconds/ Measures.Beats/ Measures.Beats 
(minimal)/Minutes: 
Seconds/Seconds/Samples/Hours: Minutes: 
Seconds: Frames/Absolute Frames: выбор 
единицы измерения для транспортной панели. 

Эти опции взаимозаменяющиеся. 
Show playrate control (показать контроллер playrate на транспортной панели), 
 
Show time signature (показать музыкальный размер на транспортной панели). 
Show play state as text (показать состояние воспроизведения в текстовом виде на транспортной панели). 
Center transport controls (расположить контроллеры в центре транспортной панели). 
Dock transport in docker (прикрепить транспортную панель на панели Docker). 
Dock transport in main window (прикрепить транспортную панель в главном окне REAPER). 
Docked transport position (открывает подменю с четырьмя опциями позиционирования транспортной панели, 
когда она прикреплена в главном окне REAPER). 
Hide transport (скрыть транспортную панель). Чтобы восстановить ее, нажмите Ctrl+Alt+T. 
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25.9. Контекстное меню матрицы маршрутизации 
 
Доступ к этому меню можно получить щелчком правой кнопкой мыши по пустой фоновой области матрицы 
маршрутизации. Опции, главным образом, определяют элементы, которые будут отображаться в матрице. 
Точный набор элементов будет изменяться в зависимости от продвижения ваших проектов. Правильный выбор 
может предотвратить нагромождение экрана и облегчить работу с матрицей. 

 
Matrix mode: режим матрицы - маршрутизация, группировка или 
матрица регионов. 
Show as destination: определяет, какие элементы будут 
отображены в качестве адресатов для посылов в строке 
заголовка. 
Show as sources: определяет, какие элементы будут 
отображены в качестве источника посылов в левом столбце. 
Dock routing window in docker (прикрепить окно матрицы 
маршрутизации на панель Docker). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
25.10. Контекстное меню матрицы группировки 

 
Доступ к этому меню можно получить щелчком правой кнопкой мыши по пустой фоновой области матрицы 
группировки. 

 
Matrix mode: режим матрицы - маршрутизация, группировка или 
матрица регионов. 
Show individual group details: определяет отображение отдельных 
деталей (Vol, VCA, Pan, и т.д.) для каждой группы или только суммарно 
для матрицы группировки. 
Dock routing window in docker (прикрепить окно матрицы группировки 
на панель Docker). 
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25.11. Контекстное меню окна эффектов 
 
Доступ к этому меню можно получить щелчком правой кнопкой мыши в окне цепочки эффектов любого трека. 

 
Add FX: открывает окно добавления 
эффектов. 
Replace FX: открывает 
одноименное окно, позволяя 
заменить выбранные эффекты 
другими эффектами. 
FX chains: открывает подменю с 
опциями загрузки и сохранения 
цепочки эффектов, включая опции 
сохранения текущей цепочки 
эффектов в качестве цепочки по 
умолчанию для новых треков и 
опции загрузки цепочки эффектов 
по умолчанию в данный трек или 
клип. 
Freeze track: открывает подменю с 
опциями функции Freeze. 
Copy all FX (скопировать все 
эффекты в цепочке в буфер 
обмена). 
Copy selected FX (скопировать 
текущий выбранный эффект в 
буфер обмена). 
Cut selected FX (вырезать текущий 
выбранный эффект в буфер 
обмена). 
Paste FX (вставить скопированные 
или вырезанные эффекты из 
буфера обмена в текущее окно 
эффектов). 
Remove selected FX (удалить все 

выбранные эффекты из текущего окна эффектов). 
Remove all FX (удалить все эффекты из текущего окна эффектов). 
Toggle selected FX bypass (установить для всех текущих выбранных эффектов статус обхода). 
Toggle selected FX offline (установить для всех текущих выбранных эффектов статус offline). 
Rename FX Instance: позволяет назначать собственное имя для данного экземпляра плагина. 
Window float selected FX: позволяет сделать окна эффектов плавающими. 
Send all keyboard input to plug-in (отсылать все нажатия на клавиши в плагин). 
Build multichannel routing for output of selected FX (создать мультиканальный/мультитрековая маршрутизация 
для выбранного эффекта для использования с мультиканальными VST инструментами и Dx инструментами). 
Build 16 channels of MIDI routing to this track (создать 16 канальная маршрутизация (там, где это позволяет 
плагин для использования мультиканальными VST инструментами и Dx инструментами). 
Dock FX window in docker (прикрепить окно эффектов на панель Docker). 
Close FX window (закрыть окно эффектов). 
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25.12. Контекстное меню браузера клипов 
 
Доступ к этому меню можно получить щелчком правой кнопкой мыши по любой свободной области в этом окне. 
Это меню совпадает с меню Options браузера клипов. Кроме того, щелчок правой кнопкой мыши по имени 
любого клипа откроет его собственное контекстное меню (см. рисунок ниже). 
 

Open project (открыть проект)/Open project 
in new tab (открыть проект в новой вкладке). 
Insert into project (вставить в выбранный трек 
в позиции курсора воспроизведения). 
Insert at time selection (stretch/loop to fit) 
(вставить в выбранный трек в выделенную 
область и подогнать через растяжение по 
времени/зацикливание). 
Insert into project on a new track (вставить в 
позиции курсора воспроизведения в новый 
трек). 
Insert as take in selected items: добавляет 

выбранный клип в браузер клипов к выбранному клипу в области аранжировки в качестве новой копии. 
Use as media source for selected items: заменяет текущий источник клипа в текущий выбранный в области 
аранжировки. 
Use as media source for selected item (stretch/loop to fit): заменяет текущий источник клипа, в текущий 
выбранный в области аранжировки и подогнать его через растяжение по времени/зацикливание. 
Preview (прослушать клип). 
Show in Explorer/Finder (показать выбранный файл в проводнике (PC) или поисковике (Mac). 
 

25.13. Контекстное меню поточного MIDI редактора и контекстное меню MIDI редактора 
 
Щелчок правой кнопкой мыши в пределах Поточного MIDI редактора открывает его контекстное меню. Опции 
меню - подмножество некоторых команд меню MIDI редактора и объяснены подробно в Главе 13. Первая секция 
(от опции Insert note at edit cursor до опции Note channel) содержит те же самые опции, что и контекстное 
меню MIDI редактора. Опция Note channel открывает подменю для выбора каналов с 1 по 16. Вторую секцию 
(от опции Quantize events до опции Set note ends to start of next note) можно найти в меню Edit в главном 
меню MIDI редактора. Опция View открывает подменю, схожему с опцией View в главном меню MIDI редактора. 
Остальные опции можно найти в главном меню MIDI редактора.  
 
25.13.1. Главное контекстное меню MIDI редактора  
 
Щелчок правой кнопкой мыши по строке заголовка MIDI редактора (или на вкладке, если окно прикреплено на 
панель Docker) открывает меню с опциями его главного меню. Опции сгруппированы так: File > Edit > Navigate 
> View > Actions > Navigate и подробно объяснены в Главе 13.  
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25.13.2. Контекстное меню области редактирования MIDI редактора  
 

Щелчок правой кнопкой мыши по области 
редактирования MIDI редактора открывает меню 
по большей части с опциями редактирования нот. 
Некоторые из этих опций (например, Copy, Cut) 
будут доступны только в том случае, если 
выделено несколько нот. Большинство других 
опций продублировано в меню Edit. Кроме того, 
доступно несколько удобных опций для нескольких 
выделенных нот, такие как Select previous note 
with same note value (выбрать предыдущую ноту 
с тем же самым значением), Select next note with 
same note value (выбрать следующую ноту с 
тем же самым значением) и Select all notes with 
same note value (выбрать все ноты с тем же 
самым значением). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 


